Contents

Chapter 1. Introduction

Carlson Registration .................................................. 2
Obtaining Technical Support ....................................... 2
Setting Up a Project .................................................. 3
New/Startup Wizard .................................................. 4
Command Entry ........................................................ 6
Layer and Style Defaults ............................................ 7
Carlson File Types .................................................... 7
Standard Report Viewer .............................................. 10
Report Formatter Dialog ............................................. 12
Instruction Manual and Program Conventions ................. 24
License Agreement ..................................................... 25
About Carlson TakeOff ............................................... 28

Chapter 2. File Menu

New ........................................................................... 31
Open .......................................................................... 32
Close ......................................................................... 32
Save .......................................................................... 32
Save As ....................................................................... 32
Plot ............................................................................ 33
PDF ............................................................................ 37
Output Layouts to PDF ............................................... 37
Merge PDF Files ......................................................... 38
Save Layout Layers ..................................................... 39
Restore Layout Layers ................................................ 39
Drawing Utilities ........................................................ 40
Recover ...................................................................... 40
Audit ......................................................................... 40
Translate Layers ........................................................ 40
3DSolid and Polymesh Converter ................................. 41
Remove XData .......................................................... 42
Remove Civil 3D Custom Objects .................................. 42
Remove Reactors ....................................................... 42
Remove Groups ........................................................ 43
Erase by Closed Polyline ................................................. 103
Erase Outside ............................................................. 104
Move .............................................................................. 104
Copy .............................................................................. 104
    Standard Copy .......................................................... 104
    Copy To Layer ........................................................... 104
Offset ............................................................................ 105
    Offset ...................................................................... 105
    Offset To Layer .......................................................... 105
    Offset to Area ............................................................. 106
    Multiple Offsets .......................................................... 106
    Median Offset ............................................................. 107
    Variable Offset ........................................................... 108
    Buffer Offset ............................................................. 108
Explode ........................................................................... 109
    Standard Explode ......................................................... 109
    Block Explode .............................................................. 110
Trim .............................................................................. 110
Extend ............................................................................ 110
    Extend To Edge ............................................................. 110
    Extend to Intersection ................................................... 110
    Extend by Distance ........................................................ 111
Break ............................................................................. 113
    by Crossing Polyline ...................................................... 113
    Polyline at Specified Distances ...................................... 114
    Select Object, 2nd Point ............................................... 114
    Select Object, Two Points .............................................. 115
    At Intersection ............................................................. 115
    At Selected Point .......................................................... 115
Rotate ............................................................................ 115
    By Bearing ................................................................. 115
    Standard Rotate .......................................................... 116
Standard Scale ............................................................... 116
Align .............................................................................. 116
    2D Align .................................................................... 116
    Standard Align ............................................................ 118
Text .............................................................................. 118
    Edit Text ................................................................... 118
Chapter 5. Draw Menu

Line .................................................. 180
2D Polyline ......................................... 180
3D Polyline ......................................... 185
Circle .................................................. 189
Symbols ................................................. 190
Insert Drawing ....................................... 192
Write Block .......................................... 193
Text Wizard .......................................... 194
Text ...................................................... 195
Hatch .................................................... 195
<table>
<thead>
<tr>
<th>Curves</th>
<th>199</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Tangents, Radius</td>
<td>199</td>
</tr>
<tr>
<td>2 Tangents, Arc Length</td>
<td>199</td>
</tr>
<tr>
<td>2 Tangents, Chord Length</td>
<td>199</td>
</tr>
<tr>
<td>Best Fit Curve</td>
<td>200</td>
</tr>
<tr>
<td>3 Point</td>
<td>201</td>
</tr>
<tr>
<td>PC, PT, Radius Point</td>
<td>201</td>
</tr>
<tr>
<td>PC, Radius, Chord</td>
<td>201</td>
</tr>
<tr>
<td>3D Arc</td>
<td>202</td>
</tr>
<tr>
<td>Hatch Wizard</td>
<td>202</td>
</tr>
<tr>
<td>Raster Image</td>
<td>203</td>
</tr>
<tr>
<td>Place Image by World File</td>
<td>206</td>
</tr>
<tr>
<td>Closed Polyline By Interior Text</td>
<td>206</td>
</tr>
<tr>
<td>Shrink-Wrap Entities</td>
<td>206</td>
</tr>
<tr>
<td>Sequential Numbers</td>
<td>208</td>
</tr>
<tr>
<td>Building Envelope Polyline</td>
<td>210</td>
</tr>
<tr>
<td>Drawing Annotation</td>
<td>211</td>
</tr>
<tr>
<td>Distance with Leader</td>
<td>211</td>
</tr>
<tr>
<td>Label Arc</td>
<td>211</td>
</tr>
<tr>
<td>Curve - Arrow</td>
<td>213</td>
</tr>
<tr>
<td>Special Leader</td>
<td>214</td>
</tr>
<tr>
<td>Change Polyline Linetype</td>
<td>214</td>
</tr>
<tr>
<td>Polyline to Tree Line</td>
<td>216</td>
</tr>
<tr>
<td>Title Block</td>
<td>216</td>
</tr>
<tr>
<td>Barscale</td>
<td>218</td>
</tr>
<tr>
<td>North Arrow</td>
<td>218</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6. Digitize Menu</th>
<th>220</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablet</td>
<td>221</td>
</tr>
<tr>
<td>Tablet On</td>
<td>221</td>
</tr>
<tr>
<td>Tablet Off</td>
<td>221</td>
</tr>
<tr>
<td>Tablet Calibrate</td>
<td>221</td>
</tr>
<tr>
<td>Save Tablet Calibration</td>
<td>222</td>
</tr>
<tr>
<td>Load Tablet Calibration</td>
<td>223</td>
</tr>
<tr>
<td>Digitizer Settings</td>
<td>223</td>
</tr>
<tr>
<td>Digitize Existing</td>
<td>224</td>
</tr>
<tr>
<td>Digitize Design</td>
<td>224</td>
</tr>
<tr>
<td>Digitize Other</td>
<td>225</td>
</tr>
<tr>
<td>Digitize Point</td>
<td>225</td>
</tr>
<tr>
<td>Clear Strata Surface</td>
<td>367</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Draw Strata Cut Depth Contours</td>
<td>367</td>
</tr>
<tr>
<td>Erase Strata Cut Depth Contours</td>
<td>368</td>
</tr>
<tr>
<td>Draw Strata Cut Color Map</td>
<td>368</td>
</tr>
<tr>
<td>Erase Strata Cut Color Map</td>
<td>368</td>
</tr>
<tr>
<td>Draw Strata Surface</td>
<td>368</td>
</tr>
<tr>
<td>Erase Strata Surface</td>
<td>369</td>
</tr>
</tbody>
</table>

**Chapter 11. Trench Menu**

- Input Trench From Polyline | 371
- Create Trench Network Structure | 372
- Edit Trench Network Structure | 374
- Spreadsheet Trench Editor | 375
- Remove Trench Network Structure | 375
- Find Trench Network Structure | 376
- Import Trench Network Data - Sewer Network | 376
- Import Trench Network Data - Utility Network | 376
- Export Trench Network Data | 376
- Trench Network File Backup | 377
- Plain View Label Settings | 377
- Draw Trench Network - Plan | 379
- Draw Trench Network - Profile | 379
- Draw Trench Network Centerline | 382
- Input-Edit Trench Template | 383
- Draw Typical Trench Template | 384
- Define Pipe Groups | 385
- Trench Subgrade Areas | 386
- Trench Network Quantities | 387
- Trench Quantities By Profiles | 390
- Report Trench Network | 390

**Chapter 12. Roads Menu**

- Input-Edit Centerline File | 393
- Polyline to Centerline File | 402
- Draw Centerline File | 402
- Centerline Report | 403
- Centerline conversion | 404
  - Import Centerline | 404
  - Import TDS RD5 File | 404
Contents

Station Polyline/Centerline ........................................... 405
Label Station-Offset .................................................. 413
Offset Point Entry ..................................................... 418
Calculate Offsets ...................................................... 420
Quick Profile From Surfaces ........................................ 422
Create Profiles ......................................................... 424
  Profile From Existing Surface ................................. 424
  Profile From Design Surface .................................. 424
  Design Road Profile ............................................... 425
  Quick Profile from Screen Entities ........................ 426
  Profile from Screen Entities .................................. 427
  Profile from TIN or Grid ......................................... 428
  Profile from 2D Polyline ......................................... 429
  Profile from 3D Polyline ......................................... 430
  Profile from Points on Centerline ............................ 431
Profile Utilities ....................................................... 432
  Profile To 3D Polyline ........................................... 432
  Profile To Points .................................................. 433
  Profile Slope Report ............................................... 434
  Pipe Depth Summary ............................................... 436
  Profile Report ...................................................... 438
Input-Edit Profile File .............................................. 439
Quick Section ........................................................ 444
Input-Edit Section Alignment ..................................... 445
Create Sections ........................................................ 447
  Sections From Existing Surface ............................... 447
  Sections From Design Surface ................................ 448
  Sections from Screen Entities ................................. 448
  Sections from Grid or FLT File ................................. 450
  Sections from Polylines .......................................... 450
  Sections From Polylines On Section Grids - By Layer .... 451
  Sections from Points ............................................ 452
Import Sections ......................................................... 453
Section Utilities ...................................................... 454
  Sections to 3D Polylines ........................................ 454
  Sections to Points ................................................ 455
  Section Report ..................................................... 456
Mass Haul Analysis .................................................. 459
Chapter 15. Inquiry Menu

- List ................................................................. 752
- Point ID ......................................................... 753
- Layer ID ......................................................... 753
- Calculator ...................................................... 754
- Curve Info ...................................................... 755
- Angle Info ....................................................... 756
- Polyline Info ................................................... 757
- Block Data Report ............................................ 757
- Display Last Report ......................................... 759
- Text File To Report Formatter ............................. 759
- Surface Inspector ............................................. 759
- Surface Report ............................................... 760
- Drawing Inspector ........................................... 761
- Layer Inspector ............................................... 763
- Layer Report .................................................. 763
- List Elevation .................................................. 764
- Distance Report .............................................. 764
- Angle/Distance ............................................... 764
- Inverse ......................................................... 766
- Label Angle ..................................................... 768
- Polyline Report ............................................... 768
- Story Stake From Surface Entities ....................... 770
- Story Stake By Points/Polyline ............................ 771
- Area Defaults .................................................. 772
- Area by Lines & Arcs ........................................ 777
- Area By Inverse ............................................... 778
- Area by Interior Point ....................................... 779
- Area by Closed Polylines ................................... 780
- Area Table Defaults ......................................... 781
- Area Descriptions ............................................ 784
  - Tag Area Descriptions ..................................... 784
  - Identify Area Descriptions .............................. 785
  - Untag Area Descriptions ................................. 785

Contents xvi
Introduction

– Website: http://www.carlsonsw.com
– Phone: 1-606-564-5028
– Email: support@carlsonsw.com
Carlson Registration

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name, Carlson serial number and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

Fax: This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

Internet: Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

Enter pre-authorized change key: If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.

Register Later: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsw.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

Obtaining Technical Support

via Discussion Groups

- Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
- You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.
via Electronic Mail

- The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

- Phone: (606) 564-5028
- Fax: (606) 564-6422

via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

- Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.

Setting Up a Project

Over 200 program settings can be specified in the Configure command under the Settings menu. These values are used to initialize Carlson program options when opening a new or existing drawing. Among these settings is the coordinate point number format, file and printer output options and settings for each module.

To set the drawing defaults, edit the template drawing (.DWT file). This drawing is loaded when new drawings are created. In the template drawing you can set the layers and AutoCAD /IntelliCAD variables. For example you could create your standard layers and set variables as you like such as BLIPMODE off. For Carlson, the drawing template should be set to Carlson##.dwt where the ## is the AutoCAD version number. For Carlson running in AutoCAD 2007, the template name is Carlson07.dwt. The Carlson template is located in the Carlson support directory (i.e. C:\Carlson2008\SUP\Carlson07.dwt). To customize the template, run the OPEN command and choose the drawing template. In the Select File dialog, set the type of file to Drawing Template (DWT) instead of regular drawings (DWG). Then make your changes and SAVE the drawing as Carlson##.dwt.

When starting a new drawing, one of the first steps is to run Drawing Setup under the Settings menu. Drawing Setup sets the drawing scale, the unit mode as either English or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure. When a drawing is saved, the Drawing Setup variables are saved with the drawing.

In Carlson, the text style height should be set to zero. The Carlson routines will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson will draw the text with a height of 5 (50 * 0.1). Then when the drawing is plotted at 1"=50', the text will be 0.1 inches. Use the STYLE command to set the text style height to zero.

The Set Data Directory command in the Settings menu can be used to specify the directory for the project data files. By default the drawing is stored in the Carlson WORK directory and the data files are stored in the DATA directory. The drawing file is the (.DWG) file. The data files are the coordinate (.CRD) file, profile (.PRO) file, grid (.GRD) file and other Carlson data files. In Configure>Project/Data Folders, there is an op-
tion to store all data files in the directory of the drawing. With this option active all the files for the drawing C:\Carlson2008\Work\JOB500\JOB500.dwg would be stored in C:\SCAD2006\WORK\JOB500.

Another level of file management is the automatic project file recall. Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE, SAVEAS, or QSAVE command, Carlson writes a settings file that contains all the active data file names. Then when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same directory as the drawing file and has the same name as the drawing with a .INI extension. For example, a drawing survey.dwg would have a settings file called survey.ini. You can turn off the INI files with the Save Drawing INI Files option in Configure under General Settings.

New/Startup Wizard

The New command is used for starting a new Carlson drawing. This page describes this New command and the Startup Wizard, along with the Carlson variables, associated with it.

Built into this routine is a Startup Wizard that can step you through and make the new Carlson drawing setup process easier. For creating a new drawing in Carlson, the Startup Wizard guides you through starting and setting up the drawing. This wizard is optional, and can be turned on or off in the Configure > General Settings command, which is part of the File pulldown. There is also a dialog box option, shown and mentioned below, that allows you to disable this feature. You can also exit out of the Startup Wizard at any time.

When the New drawing command is executed, you first get the standard Select template dialog box. While there are many templates to choose from, and there is an Open option, typically you want to go with choosing the Carlson drawing template (CARLSON17.DWT). The drawing template will set of some basic drawing parameters such as default layer names.

![Select template](image)

After selecting the template, the Carlson Startup Wizard begins by opening the New Drawing Wizard dialog box.
This dialog is used to set the drawing name and scale. The first step to do is set the drawing (.DWG) name by picking the Set button. This brings up the file selection dialog. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. To select an existing folder, pull down the Save in field to select a folder or drive, click the Move Up icon next to the Save in field and/or the pick the folder name from the list. To create a new folder, pick the Create New Folder icon to the right of the Save in field. Then type in the drawing name in the File name field and click the Save button.

After setting the drawing name, you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Notice that at the lower left corner of the New Drawing Wizard dialog there is an option to Skip Startup Wizard Next Time. Typically, you would leave this option unchecked, as the Wizard is a handy tool for new drawing setup. Now click the Next button.

The next startup dialog sets the Data Path and CRD File. The Data Path is the folder where Carlson will store the data files such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information. The coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate (.CRD) file. The new option will erase any point data that is found in the specified CRD file. The existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.
The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. The Current CRD File option is a popular one to choose for bringing in coordinates. If the None option is set, then the Startup Wizard is finished.

Once point data has been imported from the data collector, text/ASCII file or CRD file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

**Pulldown Menu Location:** File

**Keyboard Command:** new

**Prerequisite:** None

**Command Entry**

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the command prompt. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. Screen menu items are shown in the screen menu (typically on the right side of the screen). The screen menu can be toggled off and on inside of the AutoCAD Options dialog. The Pulldown menus are the primary method for Carlson command selection. Each section of this manual shows the pulldown menu which contains the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.

Command availability depends on which menu is loaded. Carlson menus have a mixture of both Carlson and CAD commands. This allows you to execute the commonly used CAD commands from the menus while running Carlson. Quick Keys are user-defined short cut names that can be typed in to start commands. To review the current set of
Quick Keys, run the Quick Keys command in the Settings pulldown menu. Quick Keys are explained in more detail in the next section.

For command entry at the Command: prompt, pressing Enter repeats the last command. Also the prompt history records the sequence of previous commands, and you can run these previous commands without invoking the menu. To access the commands, use the keyboard up and down arrows. The up arrow moves backwards in the history and the down arrow moves forward. As you press the arrows, the previous command names appear at the command prompt. When you get to the command that you want to run again, press Enter.

**Layer and Style Defaults**

Many Carlson commands have default layers such as AREATXT for area labels and BRGTXT for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands and several can be set in Configure. Sometimes you may want to use the current layer and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that set in the dialog, the default layer can be set as "CLAYER" which will use the current layer. For example, if the annotation layer is set to CLAYER then annotation will be drawn in the current layer instead of BRGTXT or whatever the annotation layer used to be.

This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.

**Carlson File Types**

.AAN Auto-Annotate Settings
.ADF Annotation Default Settings
.ARX AutoCAD Runtime Extension For Carlson Program
.ATR Strata attribute definitions
.AVG Mining Composite Quality Analysis
.BLK Mining Block Model
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
.CFZ Cut/Fill Color Map Zones
.CGC C&G Coordinate File
.CGR C&G Raw Data
.CH Corehole definition
.CL Centerline file
.CLT Culvert Settings
.CN Hydrology CN Factors
.COG Cadvantage Coordinate Data
.COT Multiple Outlet Design Data
.CQT Mining custom quantity table
.CRBB Template Curb Definition
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
Chapter 1. Introduction
Chapter 1. Introduction
Standard Report Viewer

Many Carlson routines display output in the Standard Report Viewer as shown below. A project name and job number can be added to the report header by filling out values for them in the Settings->Drawing Setup command. The format for the date in the upper right of the report is controlled by the Date Format setting in Settings->Configure->General Settings. The report can be edited directly in the report viewer. Report Viewer commands are described below.

**Open:** This allows you to open an ASCII file and display the contents in the report viewer.

**Save:** Save the contents of the report viewer to a text file.

**SaveAs:** This allows you to save the contents of the report viewer to a file.

**Append To:** This allows you to append the contents of the report viewer to another file.
Print: Print the contents of the report viewer. This will open the standard windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.

Screen: Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

Undo: Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.

Chapter 1. Introduction
Select All: Selects all the text in the report viewer.
Cut: Deletes the selected text and places it on the Windows® clipboard.
Copy: Copies the selected text to the Windows® clipboard.
Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.
Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.
Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.
Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.
Hide: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.

**Report Formatter Dialog**

The Carlson Report Formatter routine is a highly customizable and flexible reporting engine that can be used to create a variety of output document types. A number of Carlson routines provide an option to use Report Formatter Options and allows you to specify how and which results of calculations should be presented in the report. In addition to the Standard Report Viewer, reports can be generated in web-friendly HTML format along with data formats compatible with Microsoft Excel or Microsoft Access.
Format: Select an available report format from the list of pre-established report configurations or key-in a new report format name.

Save As: Saves the current configuration of the active report format. The next time that you come to the Report Formatter from the same Carlson routine, it will recall this last format. To pick another format, select from list of formats in the left top corner and pick which format to use.

Delete: Removes the current report configuration from the listing of available report formats.

Export: Sends ALL available report formats to an XML-based "formatter style" (*.FMS) file.

Import: Imports the contents of a previously exported *.FMS file.

Control

Action

Moves the selected report option in the Used listing above the preceding entry until it reaches the top of the list.
Moves the currently selected item from the Available listing to the Used listing.
Removes the currently selected item from the Used listing and makes it selectable once again to the Available listing.
Moves the selected report option in the Used listing below the following entry until it reaches the bottom of the list.

Report Content Controls

Sort Field: For the selected "field" of data, indicate its sort method:

- **Hold**: The given field is not sorted and prohibits the sorting of subsequent columns.
- **Up**: The given field is sorted in ascending order.
- **Down**: The given field is sorted in descending order.
- **Ignore**: The given field is not sorted and permits sorting for the next column(s).

Columnar Format: When enabled, this toggle groups a given field of data into a column in the report. When disabled, each field of data is placed onto its own row in the report (the report data is output in a single column).

Mirror the Columns: (Suggested for short reports only). When enabled, this toggle transposes columns from the
report into rows and vice versa.

**Double Space:** Adds a blank row between data rows.

**Display Table Header:** When enabled and exporting the report to an *HTML Report* format, the field "keys" as defined in the "Attribute Options" control are included in the report header.

**Use Commas in Numbers:** When enabled, this option will insert commas into numeric fields for every three digits.

**Ignore Repeating Fields:** When enabled, only the first occurrence of a repeating field is display in the report. Subsequent occurrences of the repeated field (*e.g.* the point description) are suppressed until a different value in the repeating field is encountered.

**Preserve Empty Columns:** When enabled, custom named columns can be added to the report which have no data in the rows.

**Auto-width:** When enabled, the width of each column is automatically set to be the wider of the column heading or the data contained within the column.

**Widths by Field:** When enabled, the width of each column established in the Attrib Options control (found in the Settings Tab) is used per field.

**Fixed-width:** When enabled, specify the width of each column.

**Include Totals:** When enabled, the total of each field is reported.

**Totals Only:** When enabled, only the total of each field is reported.

**Total:** Select the desired total for the *Used* field(s) of data. The summation level is defined by this "Total" pop-up list. By default, only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted.

For example if the first column is "Area Name" and it is sorted, and "Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name.

Once the desired fields of data and reporting options have been specified, the output can be generated and manipulated using one of four tabs:

1. Report
2. MS Excel
3. Import/Export
4. Settings

Choose one of the output options:

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Control Icon]</td>
<td>Sends the current report to the Standard Report Viewer command. Upon exiting the Viewer, you come back into the Report Formatter for further data manipulation as needed.</td>
</tr>
</tbody>
</table>

*Chapter 1. Introduction*
Sends the current report to a "spreadsheet" interface where it can be further exported to a variety of popular file formats. Additional information is provided in the Spreadsheet discussion.

Sends the current report to an Internet/web-ready HTML file format and displays the report using the HTML viewer that is configured on your computer.

Places the current report as a table-type of entity into the current drawing. Additional information is provided in the Table Entity discussion.

Places the current report into a special-formatted report. Additional information is provided in the Report Viewer discussion.

Report Tab Options

Spreadsheet

Export: This button has the same output options as the Export function under the Import/Export Tab. Use this option to create a variety of popular file formats, including:

- XML Format (xml)
- Text or CSV File (txt, csv)
- MS Excel "database" (xls, xlsx)
- MS Access database (mdb, accdb)
- SQLite database (db3, sqlite)
- ODBC Data Sources (Misc. database formats)

For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. Some commands
that can utilize this functionality are Surface Mine Reserves with the pit polylines and Underground Timing with the panel polylines.

When the polyline data is available for the GIS Links, there will be a report field called Handle. This Handle field is the entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report Used list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS Data commands from the GIS module to manage and report the data.

Table Entity
The data for the Table Entity is put into a queue and the table is not drawn until the Report Formatter is closed. Then the program prompts for a location to draw the table and provides options shown above to control items such as the header names, sizes, alignments, styles, colors and layers. You can also set whether to draw the table header and totals.  

**Report Viewer**

The Report Viewer option provides the ability to produce more professional looking reports that contain horizontal and vertical dividing lines and can also be exported to a variety of common report formats.

Indicate the paper size you will be printing to along with desired values for:

- Left Margin
- Right Margin
- Top Margin
- Bottom Margin

**Grid Color:** Used to choose the color for report grid lines.

**Grid Width:** Used to specify the grid line width in points (1/72 of an inch).

Upon specifying the desired values and clicking **OK**, the Report Viewer dialog box will display:
Controls within the report viewer allow you to:

- navigate through the page(s) of information
- refresh the report
- send the report to a printer
- switch between print layout and print preview mode
- re-configure the page setup
- export the report to other document applications
- specify the "zoom" level while displaying the report
- searching the report for a given search criteria

Several Microsoft Excel export options are provided. You may specify a spreadsheet file to load before the export, as well as a left upper cell to start with and sheet name to use. Text lines which are reported when using built-in viewer may be skipped when using Microsoft Excel export.

Control | Action
This button contains the same export options as described in the Spreadsheet discussion.

This button allows the current report to be combined with a previous report.

This button saves all the report data values as well as all the report format settings into a single *.RPT file that can be shared with others, merged with other reports or loaded at a later time.

For commands and data that conform to the ESRI Mapping Specification for DWG/DXF (MSD), this button creates an ESRI MSD-compatible report.

Import/Export Tab Options

Control Action

This option allows you to define new fields as equations based on existing fields. Additional information is provided in the User-defined Attributes discussion.

This option allows you to further customize additional content (e.g. Date/Time, Report Name, etc) into the report header, body and/or report footer. Additional information is provided in the Field Options discussion.

This option allows you to control several parameters of each field including title names, number of decimal places, etc. Additional information is provided in the Attribute Options discussion.

This option allows you to create more condensed reports yet still maintain easily decipherable column headings and/or permits a 2-line column heading. Additional information is provided in the Subheaders discussion.

Settings Tab Options

User-defined Attributes
You can create highly customizable fields of data using parametric equations from other fields of program-generated data... all without the use of an external spreadsheet! These User-Defined Attributes are mathematical manipulations to existing attributes. For example, if the report includes a LENGTH attribute reported in feet, you can create a User-Defined Attribute to also report this value in inches. When a User-Defined Attribute is added or edited, the above dialog will appear.

**Key:** This is a unique named used to identify the attribute. The Key can be used to reference the attribute in other User-Defined Attribute equations.

**Heading:** This is the label for the value that will show in the report. It is often useful to use a very descriptive name for the Heading.

**Reported:** This toggle controls whether to list this attribute as available for reporting or to only use internally as an attribute for the equation of other attributes.

**Percent Of Field:** This toggle defines the attribute to be a percentage of the total of another field such as the lot area percent of the total area. When this option is enabled, you will not be able to define an equation for the attribute.

**Equation:** This is where the attribute value is defined. To use the value of another attribute in the equation, the attribute name is entered in brackets as shown in the dialog above. The below table lists the mathematical operators that may be used in the equation.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>+</td>
</tr>
<tr>
<td>Subtract</td>
<td>-</td>
</tr>
<tr>
<td>Divide</td>
<td>/</td>
</tr>
<tr>
<td>Multiply</td>
<td>*</td>
</tr>
<tr>
<td>Exponent</td>
<td>^</td>
</tr>
<tr>
<td>Grouping</td>
<td>()</td>
</tr>
</tbody>
</table>
Compare - Greater Than  >  
Compare - Less Than    <  
Compare - Equal To     =   
Logic - AND           &   
Logic - OR            —   
Logic - NOT           !    
Absolute Value        ABS() 

**Total Options:** This controls how to total the attribute.
**Sum:** The total is a sum total of all report entries of the attribute.
**Simple Average:** The total is an average of all reported entries of the attribute.
**Weighted Average:** The total is a weighted average of the reported entries of the attribute. The attribute will be weighted based on the attribute selected in the Average By dropdown list.
**Recalculate:** This total is not based on the individual entries of this attribute, but is instead recalculated based on the totals of referenced attributes. For example, consider the below report in which values A and B are naturally reported and C is a User-Defined Attribute equal to A+B. Each attribute uses a different Totaling option. In this case, the total for C is recalculated based on the totals for A and B rather than on the previous reported entries for C.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>11</td>
</tr>
<tr>
<td>5</td>
<td>9</td>
<td>14</td>
</tr>
<tr>
<td>Total</td>
<td>Total by</td>
<td>Simple Average</td>
</tr>
<tr>
<td>3</td>
<td>21</td>
<td>24</td>
</tr>
</tbody>
</table>

**Decimals:** This dropdown lists controls the reported precision of the attribute.
**Advance line after the field:** This toggle adds a blank row to the report after the attribute is reported.

**Field Options**
"Field Options" can be placed into one or more locations within the report:

- Report Header
- Report Body
- Report Footer

Select the desired location for the field and then click on the various controls to add or remove the item from the desired location or change its formatting information.

**Attribute Options**

The Attribute Options dialog shows a list of all the attributes in the report. Use the Edit button to set the attribute properties.
The Heading is the label to use for this attribute. The Total Method chooses between:

- Sum
- Simple Average
- Weighted Average
- No total

For Weighted Average, you can select another attribute to weight the average by such as tons for averaging a strata quality. When controlling the number of Decimal places, the values can also be rounded up to the nearest integer level such as when earthwork volumes need to be reported to the nearest 1000. The Alignment controls the justification of the attribute. By default, numbers are right justified and strings are left justified. There is an option to Advance Line After the Field of the report which inserts a blank row and shifts the next attributes down to a new line in the report. The Auto Width option sets the attribute width to fit the attribute heading and all the values. Otherwise you can set a fixed Field Width. The Prefix and Suffix allow you to add to the attribute value such as adding the "ft" suffix to indicate feet units. The Style settings control the font to use for the header, body and total for the attribute. Use the Report Viewer output method to use the different style settings.

Subheaders
Subheaders may be created for situations where many columns of data may make the report too wide. You can use the subheaders to stack the column names. For example, a point list report with descriptions from the coordinate file also listed with descriptions from the drawing file could be setup with "Description" as a subheader (use Ctrl+Click functionality to select the desired fields that are to get a subheader). Consider (table borders added for visual clarity):

<table>
<thead>
<tr>
<th>Description</th>
<th>CRD Description</th>
<th>DWG Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TDC / Oak</td>
<td>Deciduous Tree Oak</td>
</tr>
</tbody>
</table>

Using Subheaders

Contrast with:

<table>
<thead>
<tr>
<th>Description</th>
<th>CRD Description</th>
<th>DWG Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TDC / Oak</td>
<td>Deciduous Tree Oak</td>
</tr>
</tbody>
</table>

Without Subheaders

**Instruction Manual and Program Conventions**

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/<Pick point>:**

Bold text represents prompts or questions that the computer program will ask the user.

*<90.0000>*

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an OSNAP mode that is turned on by the command.
CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please read the following Software License Agreement before using the SOFTWARE. Using this SOFTWARE indicates that you have accepted its terms and conditions.

Carlson 2020

END-USER LICENSE AGREEMENT FOR CARLSON SOFTWARE

IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and Carlson Software, Inc for the software accompanying this EULA, which includes computer software and may include associated media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising your rights to use the SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to the terms and conditions of this EULA, you may not use the SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS EULA, DO NOT INSTALL OR USE ANY PART OF THE SOFTWARE.

Carlson Software, Inc., referred to as "LICENSOR", develops and/or licenses proprietary computer programs and sells use licenses for such proprietary computer programs together with or apart from accompanying copyrighted material and documentation and;

End User desires to obtain the benefits thereof and, in return for which, is willing to abide by the obligations and fee agreements applicable to LICENSOR's use licenses in LICENSOR's proprietary computer programs.

For good and valuable consideration, including but not limited to license grant in accordance with this Agreement by LICENSOR to End User's covenant regarding LICENSOR's proprietary rights, LICENSOR agrees to permit End User to utilize materials representing LICENSOR's product or products subject to the following terms and conditions:

1. License Grant: Subject to the terms, conditions and limitations of this EULA, LICENSOR hereby grants End User a personal, limited, non-exclusive, non-transferable, license to utilize the Software Product you have purchased. The license granted in this EULA creates no license, express or implied, to any other intellectual property of Licensor, except for the specific Software Product which they have lawfully purchased from LICENSOR. This EULA grants you the following rights: You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use on a portable computer. Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.

2. Exclusive Source. End User shall obtain all LICENSOR authorized product materials through LICENSOR or LICENSOR'S authorized representative and no other source. LICENSOR authorized product materials include, but are not limited to, manuals, license agreements and media upon which LICENSOR's proprietary computer programs are recorded. End User shall make no copies of any kind of any of the materials furnished by LICENSOR or LICENSOR's authorized representative, except as specifically authorized to do so in this EULA. End User is not entitled to make archival copies of those portions of LICENSOR's product(s) that are provided on a machine readable media.
3. Proprietary Rights of Licensor. End User agrees that LICENSOR retains exclusive ownership of the trademarks and service marks represented by its company name and logo and all of the documentation and computer recorded data related thereto. End User also agrees that all techniques, algorithms, and processes contained in LICENSOR's computer program products or any modification or extraction thereof constitute TRADE SECRETS OF LICENSOR and will be safeguarded by End User, but in no event shall End User exercise less than due diligence and care in accordance with the laws of the country of purchase and International Law, whichever operates to best protect the interests of LICENSOR. End User shall not copy, reproduce, re-manufacture or in any way duplicate all or any part of LICENSOR products WHETHER MODIFIED OR TRANSLATED INTO ANOTHER LANGUAGE OR NOT, or in any documentation, or in any other material provided by LICENSOR in association with LICENSOR's computer program products regardless of what manner of storage and retrieval the product exists, except as specified in this Agreement and in accordance with the terms and conditions of this Agreement which remain in force. End User agrees that in the event End User breaches this EULA, End User will be liable for damages as may be determined by a court of competent jurisdiction.

4. Restrictions. End User's rights and obligations under this EULA are nonexclusive and personal in nature, and the intellectual property Licensor grants to End User is subject to applicable law other than bankruptcy law. End User may not transfer or assign the SOFTWARE, rights under this EULA or accompanying user documentation, or any updates of the SOFTWARE which may be provided under this EULA, to a third party unless End User receives written consent from Licensor at least 30 days prior to the completion of transfer. Licensor reserves the right to deny transfer or assignment if, in its sole discretion, Licensor determines the transfer not to be a necessity. Whether or not a transfer or assignment is allowed shall be determined in Licensor's sole discretion after taking into consideration certain factors to find the existence of a necessity including, but not limited to, merger or acquisition of an entity, complete asset acquisition, change of control, severe economic hardship, severe loss of human resources or significant loss in business divisions, or winding down of entity affairs.

If Carlson consents to a transfer, such transfer shall be allowed only as a one-time permanent transfer of this EULA and Software to another end user, provided the initial End User retains no copies or previous versions of the Software. The transfer must include all of the Software, including all component parts, any media and printed materials, any upgrades, this EULA, and any associated license key. The transfer may not be an indirect transfer, such as a consignment, rental or lease. No corresponding Maintenance Agreement rights shall transfer with the SOFTWARE transfer to the subsequent end user. Prior to the transfer, the subsequent end user receiving the Software from the initial End User must agree to all terms of this EULA, with the added condition that no further transfers to third parties are permitted for any reason whatsoever, and shall agree to the terms and conditions of a new Maintenance Agreement with Licensor.

You may not reverse engineer, decompile, or disassemble the SOFTWARE or alter the images utilized in the SOFTWARE and user documentation. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be separated for use on more than one computer. You shall communicate to any individual user in your facility that they are bound by the restrictions of this license agreement may not copy or alter the SOFTWARE for use outside End User's facilities.

Upgrades. If you purchase an upgrade of a SOFTWARE PRODUCT and you use it on different machine from one where upgraded SOFTWARE PRODUCT was used, use of original SOFTWARE PRODUCT must be discontinued and confirmed within 30 days. If such use is not discontinued, it is a material breach of this EULA and LICENSOR shall be entitled to all remedies available to it under this EULA, and under the laws of Kentucky, USA.

5. Security Mechanisms. Licensor and its affiliated companies take all legal steps to eliminate piracy of their software products. In this context, the Software Product may include a security mechanism that can detect the installation or use of illegal copies of the Software Product, and collect and transmit data about those illegal copies. Data collected will not include any customer data created with the Software. By using the Software Product, you consent to such detection and collection of data, as well as its transmission and use if an illegal copy is detected. Licensor also reserves the right to use a hardware lock device, license administration software, and/or a license authorization key to control access to the Software. You may not take any steps to avoid or defeat the purpose of any such measures. Use of any Software without any required lock device or authorization key provided by Licensor is
6. Audit Rights. End User agrees that LICENSOR has the right to require an audit (electronic or otherwise) of the LICENSOR Materials and the Installation thereof and access thereto. As part of any such audit, LICENSOR or its authorized representative will have the right, on fifteen (15) days’ prior notice to End User, to inspect End User's records, systems and facilities, including machine IDs, serial numbers and related information, to verify that the use of any and all LICENSOR Materials is in conformance with this Agreement. End User will provide full cooperation to enable any such audit. If LICENSOR determines that End User's use is not in conformity with this EULA, End User will obtain immediately and pay for a valid license to bring End User’s use into compliance with this EULA and other applicable terms and pay the reasonable costs of the audit. In addition to such payment rights, LICENSOR reserves the right to seek any other remedies available at law or in equity, whether under this Agreement or otherwise.

7. Warranty. THE PRODUCT IS PROVIDED "AS IS" WITH ALL FAULTS. TO THE MAXIMUM EXTENT PERMITTED BY LAW, LICENSOR HEREBY DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND WARRANTIES THAT THE PRODUCT IS FREE OF DEFECTS AND NON-INFRINGEMENT, WITH REGARD TO THE SOFTWARE, AND THE ACCOMPANYING WRITTEN MATERIALS. YOU BEAR ENTIRE RISK AS TO SELECTING THE PRODUCT FOR YOUR PURPOSES AND AS TO THE QUALITY AND PERFORMANCE OF THE PRODUCT. THIS LIMITATION WILL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY REMEDY. In any event, LICENSOR will not honor any warranty shown to exist for which inaccurate or incorrect identifying data has been provided to LICENSOR. The product(s) provided are intended for commercial use only and should not be utilized as the sole data source in clinical decisions as to levels of care.

8. LIMITATION OF LIABILITY. EXCEPT AS REQUIRED BY LAW, LICENSOR AND ITS DISTRIBUTORS, DIRECTORS, LICENSORS, CONTRIBUTORS AND AGENTS (COLLECTIVELY, THE "LICENSOR GROUP") WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES ARISING OUT OF OR IN ANY WAY RELATING TO THIS EULA OR THE USE OF OR INABILITY TO USE THE PRODUCT, INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, LOST PROFITS, LOSS OF DATA, AND COMPUTER FAILURE OR MALFUNCTION, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF THE THEORY (CONTRACT, TORT OR OTHERWISE) UPON WHICH SUCH CLAIM IS BASED. THE LICENSOR GROUP'S COLLECTIVE LIABILITY UNDER THIS AGREEMENT WILL NOT EXCEED THE GREATER OF $500 (FIVE HUNDRED DOLLARS) AND THE FEES PAID BY YOU UNDER THIS LICENSE (IF ANY).

9. Update Policy. LICENSOR may, from time to time, revise the performance of its product(s) and in doing so, incur NO obligation to furnish such revisions to any End User nor shall it warrant or guarantee that any revision to the SOFTWARE will perform as expected by the End User on End User's equipment. At LICENSOR's option, LICENSOR may provide such revisions to the End User.

10. Customer Service. Although it is the LICENSOR's customary practice to provide reasonable assistance and support in the use of its products to its customers, LICENSOR shall not be obligated to any End User to provide technical assistance or support through this Agreement and may at LICENSOR's sole election charge a fee for customer support.

11. Termination of End User License. If any one or more of the provisions of this Agreement is breached, the license granted by this Agreement is hereby terminated. In the event of such termination, all rights of the LICENSOR shall remain in force and effect. Any protected health information data of End User maintained on LICENSOR'S data base shall upon reasonable notice to End User and at the discretion of LICENSOR may be destroyed.
12. Copyright. The SOFTWARE (including, but not limited to, any images, photographs, animations, video, audio, music and or text incorporated into the SOFTWARE), and all intellectual property rights associated with it, whether exists in a tangible media or in an electronic image media is owned by LICENSOR and is protected by United States copyright laws and international treaty provisions and all other commonwealth or national laws. LICENSOR reserves all intellectual property rights in the Products, except for the rights expressly granted in this Agreement. You may not remove or alter any trademark, logo, copyright or other proprietary notice in or on the Product. This license does not grant you any right to use the trademarks, service marks or logos of LICENSOR or its licensors. You may not copy any user documentation accompanying the SOFTWARE.

13. Injunctive Relief. It is understood and agreed that, notwithstanding any other provision of this Agreement, LICENSOR has the unequivocal right to obtain timely injunctive relief to protect the proprietary rights of LICENSOR.

14. Entire Agreement. This EULA constitutes the entire agreement between the parties and supersedes any prior agreements. This EULA may only be changed by mutual written consent.

15. End User Agreement Acknowledgment. The End User hereby accepts all the terms and conditions of this Agreement without exception, deletion, alteration. End User acknowledges they are authorized to enter this agreement on behalf of any organization for which the license is sought. Any unauthorized use of LICENSOR products will be considered a breach of this Agreement, subject to liquidated damages and otherwise unlawful and willful infringement of LICENSOR’s trade secrets and/or proprietary products.

16. Payment and Refund Policy. The use of the SOFTWARE herein is deemed a commercial use and under the terms of this license agreement End User shall not be entitled to any refund of purchase price. End User agrees to pay all user fees promptly. LICENSOR is authorized by End User to suspend any further access to SOFTWARE in the event fees are not fully paid. End user entity shall promptly pay any and all access and use charges incurred regardless of the end user. End user is responsible for protecting any pass word and user identity supplied to End User.

17. Loss/Theft/Misuse. End user shall promptly report to LICENSOR the theft or other loss of any password and/or user identity required to access SOFTWARE. LICENSOR shall not be responsible for maintaining the integrity of End User data in the event that end user's data base is accessed and/or altered by an unauthorized end user due to the failure of licensed End User to protect its password or user identity. End User shall be responsible for any costs incurred by LICENSOR due to the negligence or reckless disregard of End User's failure to protect its password or user identity.

18. Civil/Criminal Investigation. End user shall fully cooperate with LICENSOR and or any person authorized by LICENSOR (including local, state, or federal law enforcement officials) to investigate any alleged theft, misuse or unauthorized use of SOFTWARE or data related thereto.

19. U.S. Government Restricted Rights. The SOFTWARE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (b)(1)(ii) and (c) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.

20. Governing Law. This EULA shall be governed and construed in accordance with the laws of the Commonwealth of Kentucky, USA.

About Carlson TakeOff
Displays the Carlson TakeOff version number, serial number, license information, and copyright information. You can run the registration wizard by clicking the Change Registration button on this dialog.
Prerequisite: None

Keyboard Command: ABOUT_SCAD
File Menu
New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. The first dialog for the New command, called Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right.

The template file (.DWT) that you use will depend on the version of AutoCAD or IntelliCAD that you are running. For AutoCAD 2000-2002, the Carlson template file is carlson02.dwt. For AutoCAD 2004, it is carlson04.dwt. For AutoCAD 2005, it is carlson05.dwt. For AutoCAD 2006, it is carlson06.dwt. And for AutoCAD 2008, the Carlson template file is carlson08.dwt. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box, or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in one of the Carlson .DWT template files, depending on the measurement system you've chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.
English: This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is 12 × 9 inches.

Metric: This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is 429 × 297 millimeters.

The New command creates a new drawing, using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

Remember that there are two methods that you can use to work on a Carlson drawing. One is the New command, and the other is the more generic Open command. If you need to open an existing drawing, use Open, also found in the File menu, and then choose an existing file name.

Pulldown Menu Location: File
Keyboard Command: new
Prerequisite: None

Open

This command allows you to open an existing drawing file. Carlson TakeOff displays the Select File dialog box (a standard file selection dialog box). Select a file and click Open.

Prerequisite: None
Keyboard Command: OPEN

Close

This command allows you to close the current drawing. Carlson TakeOff closes the current drawing if there have been no changes since the drawing was last saved. If you have modified the drawing, the program prompts you to save or discard the changes. You can close a file that has been opened in Read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the SAVEAS command.

Prerequisite: None
Keyboard Command: CLOSE

Save

If the drawing is named, Carlson TakeOff saves the drawing without requesting a file name. If the drawing is unnamed, the program displays the Save Drawing As dialog box (see SAVEAS) and saves the drawing with the file name you specify. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name. This command allows you to save the drawing under the current file name or a specified name

Prerequisite: None
Keyboard Command: SAVE or QSAVE

Save As

This command allows you to save the current drawing and assign the file name which allows you to give an unnamed drawing a file name or rename the current drawing. You can also use this command to save the current drawing to a different file format. You can save a drawing to an earlier version of the drawing format (DWG) or
drawing interchange format (DXF), or save a drawing as a template file. Choose the format from Files of Type in the Save Drawing As dialog box.

If you save the file as a drawing template, the program displays the Template Description dialog box, where you can provide a description for the template and set the units of measurement.

**Prerequisite:** None

**Keyboard Command:** SAVEAS

### Plot

This command allows you to plot a drawing to a plotting device or file.

Carlson TakeOff displays the Plot dialog box. Choose OK to begin plotting with the current settings and display the Plot Progress dialog box.

1. The Plot dialog box includes the tabs, Plot Device and Plot Settings, and several options to customize the plot.
   - **Layout Name:** This option displays the current layout name or displays "Selected layouts" if multiple tabs are selected. If the Model tab is current when you choose Plot, the Layout Name shows "Model."
   - **Save Changes to Layout:** This option saves the changes you make in the Plot dialog box in the layout. This option is unavailable if multiple layouts are selected.
   - **Page Setup Name:** This option displays a list of any named and saved page setups. You can choose to base the current page setup on a named page setup, or you can add a new named page setup by choosing Add.
   - **Add:** This option displays the User Defined Page Sets dialog box. You can create, delete, or rename named page setups.

2. Under the Plot Device Tab you can specify the plotter to use, a plot style table, the layout or layouts to plot, and information about plotting to a file.

   - **Plotter Configuration:** This field displays the currently configured plotting device, the port to which it's connected or its network location, and any additional user-defined comments about the plotter. A list of the available system
• Properties: The option displays the Plotter Configuration Editor (PC3 Editor), where you can modify or view the current plotter configuration, ports, device, and media settings.
• Hints: This option displays information about the specific plotting device.
• Plot Style Table (Pen Assignments): This option sets the plot style table, edits the plot style table, or creates a new plot style table.
• Name: This option displays the plot style table assigned to the current Model tab or layout tab and a list of the currently available plot style tables. If more than one layout tab is selected and the selected layout tabs have different plot style tables assigned, the list displays "Varies."
• Edit: This option displays the Plot Style Table Editor, where you can edit the selected plot style table.
• New: This option displays the Add-a-Plot-Style-Table wizard, which you can use to create a new plot style table.
• Plot Stamp: This option places a plot stamp on a specified corner of each drawing and/or logs it to a file.
• On: This option turns on plot stamping.
• Settings: This option displays the Plot Stamp dialog box, where you can specify the information you want applied to the plot stamp, such as drawing name, date and time, and plot scale.
• What to Plot: This field defines the tabs to be plotted.
• Current Tab: This option plots the current Model or layout tab. If multiple tabs are selected, the tab that shows its viewing area is plotted.
• Selected Tabs: This option plots multiple preselected Model or layout tabs. To select multiple tabs, hold down CTRL while selecting the tabs. If only one tab is selected, this option is unavailable.
• All Layout Tabs: This option plots all layout tabs, regardless of which tab is selected.
• Number of Copies: This option denotes the number of copies that are plotted. If multiple layouts and copies are selected, any layouts that are set to plot to a file or AutoSpool produce a single plot.
• Plot to File: This option plots output to a file rather than to the plotter.
• File Name: This option specifies the plot file name. The default plot file name is the drawing name and the tab name, separated by a hyphen, with a .plt file extension.
• Location: This option displays the directory location where the plot file is stored. The default location is the directory where the drawing file resides.
• [...]: This option displays a standard Browse for Folder dialog box, where you can choose the directory location to store a plot file.

3 Under the Plot Settings Tab you specify paper size, orientation, plot area and scale, offset, and other options.
• Paper Size and Paper Units: This field displays standard paper sizes available for the selected plotting device. Actual paper sizes are indicated by the width (X axis direction) and height (Y axis direction). If no plotter is selected, the full standard paper size list is displayed and available for selection. A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter wizard. The paper size you select is saved with a layout and overrides the PC3 file settings. If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not in inches or millimeters.

• Plot Device: This field displays the name of the currently selected plot device.

• Paper Size: This field displays a list of the available paper sizes.

• Printable Area: This field displays the actual area on the paper that is used for the plot based on the current paper size.

• Inches: This option allows you to specify inches for the plotting units.

• MM: This option allows you to specify millimeters for the plotting units.

• Drawing Orientation: This option specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. You can change the drawing orientation to achieve a 0-, 90-, 180-, or 270-degree plot rotation by selecting Portrait, Landscape, or Plot Upside-Down. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.

• Portrait: This option orients and plots the drawing so that the short edge of the paper represents the top of the page.

• Landscape: This option orients and plots the drawing so that the long edge of the paper represents the top of the page.

• Plot Upside-Down: This option orients and plots the drawing upside down.

• Plot Area: This option specifies the portion of the drawing to be plotted.

• Layout: This option plots everything within the margins of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout is selected. If you choose to turn off the paper image and layout background on the Display tab of the Options dialog box, the Layouts selection becomes Limits.
• Limits: This option plots the entire drawing area defined by the drawing limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option. Available only when the Model tab is selected.

• Extents: This option plots the portion of the current space of the drawing that contains objects. All geometry in the current space is plotted. TakeOff may regenerate the drawing to recalculate the extents before plotting.

• Display: This option plots the view in the current viewport in the selected Model tab or the current paper space view in the layout.

• View: This option plots a previously saved view. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.

• Window: This option plots any portion of the drawing you specify. If you select Window, the Window button becomes available. Choose the Window button to use the pointing device to specify the two corners of the area to be plotted or enter coordinate values.

• Plot Scale: This option controls the plot area. The default scale setting is 1:1 when plotting a layout. The default setting is Scaled to Fit when plotting a Model tab. When you select a standard scale, the scale is displayed in Custom.

• Scale: This option defines the exact scale for the plot. The four most recently used standard scales are displayed at the top of the list.

• Custom: This option creates a custom scale. You can create a custom scale by entering the number of inches or millimeters equal to the number of drawing units.

• Scale Lineweights: This option scales lineweights in proportion to the plot scale. Lineweights normally specify the linewidth of printed objects and are plotted with the linewidth size regardless of the plot scale.

• Plot Offset: This field specifies an offset of the plotting area from the lower-left corner of the paper. In a layout, the lower-left corner of a specified plot area is positioned at the lower-left margin of the paper. You can offset the origin by entering a positive or negative value. The plotter unit values are in inches or millimeters on the paper.

• Center the Plot: This option automatically calculates the X and Y offset values to center the plot on the paper.

• X: This field specifies the plot origin in the X direction.

• Y: This field specifies the plot origin in the Y direction.

• Plot Options: This field specifies options for lineweights, plot styles, and the current plot style table. You can select whether lineweights are plotted. By selecting Plot with Plot Styles, you plot using the object plot styles that are assigned to the geometry, as defined by the plot style table.

• Plot object lineweights: This option plots lineweights.

• Plot with Plot Styles: This option plots using the plot styles applied to objects and defined in the plot style table. All style definitions with different property characteristics are stored in the plot style tables and can be easily attached to the geometry. This setting can replace pen mapping in earlier versions of AutoCAD.

• Plot Paperspace Last: This option plots model space geometry first. Paper space geometry is usually plotted before model space geometry.

• Hide Objects: This option plots layouts with hidden lines removed for objects in the layout environment (paper space). Hidden line removal for model space objects in viewports is controlled by the Viewports Hide property in the Object Property Manager. This is displayed in the plot preview, but not in the layout.

• Full Preview: This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit.

• Partial Preview: This option quickly shows an accurate representation of the effective plot area relative to the paper size and printable area. Partial preview also gives advance notice of any warnings that you might encounter when plotting. The final location of the plot depends on the plotter. Changes that modify the effective plot area include those made to the plot origin, which you define under Plot Offset on the Plot Settings tab. If you offset the origin so much that the effective area extends outside the preview area, the program displays a warning.

Prerequisite: None
Keyboard Command: PLOT

PDF

Output Layouts to PDF

This command creates a PDF from layouts in the current drawing. The command starts by prompting for the output PDF file to create. In the dialog, the Title, Subject, Keywords and Author are optional properties for the PDF file.

The Print Area controls whether to use the page size defined in the Page Setup Manager for each layout, or set the print area by zoom extents on the entities for each layout.

The Store Layers in PDF creates a PDF with the CAD layers.

The Include Off Layers outputs all layers to the PDF.

The Encoded (small size) option creates a PDF with encoding which should be used unless working with an old Adobe Reader.

Each layout can store the layer state for printing for which layers to thaw and which to freeze. The Restore Layout Layer States will set the layer state for the PDF on each layout. This option works together with the Save and Restore Layout Layer commands in the File > PDF menu.

The Open PDF Upon Completion option opens the PDF in the viewer for PDFs assigned in Windows which is typically the Adobe Reader.

For Layouts to Export, choosing Active will output the current layout to the PDF. The All option outputs all the layouts to the PDF. The Selected option lets you control which layouts to output. When in Selected mode, you can use the Remove button to remove a layout from the output. Use the Up and Down button to change the order of the layouts. The Reset button puts the list of layout back to the default.

Pick the Export button to create the PDF.
Pulldown Menu Location: File > PDF  
Keyboard Command: pdfexport  
Prerequisite: Layouts

**Merge PDF Files**

This command combines separate PDF files into a single PDF file. The dialog has a list of available PDF files on the left and there are functions to add or remove PDF files from this list. The list of PDF files on the right and the PDFs to output to the single PDF. Use the Add and Remove buttons to move PDF files between these Available and Used lists. Use the Move Up and Down to change the order of the PDF files for the output PDF. When a PDF is highlighted in the list, a graphic preview is shown.

The Open PDF Upon Completion option opens the PDF in the viewer for PDFs assigned in Windows which is typically the Adobe Reader.

The Rotate PDF CW setting controls how much to rotate the source PDF files for the output PDF.

The Load and Save functions are for storing and recalling a set of PDF files in a .PDQ file.
Save Layout Layers

This command saves the current freeze/thaw status of the layers for the current layout. When the Output Layouts To PDF command generates the PDF for the layout, the saved layout layer settings are used for the PDF output. The Restore Layout Layers command can also be used to reset the freeze/thaw status for the layout.

This command is useful when making a layout using certain layers and then later making new layers in the drawing and you want the layout to use only the original layers.

Restore Layout Layers

This command sets the freeze/thaw status of the layers for the current layout using the settings stored by the Save Layout Layers command.

Chapter 2. File Menu
Drawing Utilities

Recover
This command opens a drawing file and scans it for errors. Use this command if Carlson TakeOff crashes while using the regular Open command.

Prerequisite: none

Keyboard Command: recover

Audit
This command scans your current drawing and looks for any corruption and has the option to fix any errors.

Prerequisite: none

Keyboard Command: audit

Translate Layers
This command renames layers using a lookup table with pairs of original and renamed layer names. This command can be used to convert the layers for a drawing from another source to match your layer standards. The layer names are entered in a spreadsheet. The Add, Insert, Delete and Sort buttons work on the spreadsheet rows. The Report button makes a report for the layer assignments. The SaveAs and Load functions store and recall the layer assignments to a .LTF file for sharing the settings or keeping different sets of layer assignments.

If you use Layer Library and define your target layers with their properties, then the Translate Layers command will use these layer properties. For the example below, if the X-U-TE layer is defined in the Layer Library, then X-U-TE is created using the color, line type, transparency and plot style from the Layer Library.
**Pulldown Menu Location:** File > Drawing Utilities  
**Keyboard Command:** translayers  
**Prerequisite:** None

### 3DSolid and Polymesh Converter

This command converts 3DSolid and Polymesh entities into 3D Faces or Edges. The Set Layer option allows you to put the new 3D Faces or Edges in a specified layer. Otherwise the layer of the original entities is used.

![3D Solid and Polymesh Converter dialog box](image)

**Prompts**

**Converter dialog**  
Select entities to process.  
**Select objects:** *select 3DSolid or Polymesh*  

**Pulldown Menu Location:** File > Drawing Utilities
Remove XData
This command removes the xdata (Extended Entity Data) from the selected entities. Many Carlson routines add xdata to entities in order to add extra program specific information to them. Carlson programs use the xdata to make entities more intelligent. For example, when you draw a centerline (.cl) as a polyline, xdata is attached to the polyline that stores the reference of the .cl file name. Then if you double-click the polyline, then the program can read the xdata to know the polyline is a centerline and launch the centerline editor. By removing the xdata, the entities revert to regular CAD entities which is useful if you want to detach these entities from the program links.

Prompts

Select entities to remove extended entity data from.
Select objects: pick the entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: xxdata
Prerequisite: Entities with xdata

Remove Civil 3D Custom Objects
This command removes all Civil 3D custom objects (AEC objects) from the current drawing so that the next time the drawing is opened, AutoCAD will not load the AEC functions. The AEC objects can be either erased or exploded into standard AutoCAD entities. The cleaned drawing is saved to a new dwg file.

Prompts

Erase or Explode AEC entities during conversion [<Erase>/Explode]? press Enter
Save dwg selection dialog

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: aeccleaner
Prerequisite: Drawing with AEC data

Remove Reactors
This command removes the reactor links from the selected points, text, polylines and lines. This disables the links for points to the coordinate (.CRD) file, annotation with linework and linework with points. Note that is General Settings there is a section called Object Linking. This is the specific section that contains the options for creating these reactors to the drawing entities. Reactors can be turned off for entities created later by clicking off the four link options in General Settings. To get to this dialog go to Settings > Configure > General Settings.

Prompts

Select entities to remove reactors from:
Select objects: pick the entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: delreact
Remove Groups
This command is used to "ungroup" selected entities that, prior to using this command, were part of a group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD or IntelliCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.

Prompts
Select entities to remove from groups.
Select objects: select entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: rmgroup
Prerequisite: Entities in group(s)

Purge
Displays a tree view summary of all named objects that can and can't be purged in the current drawing. The View Items You Can Purge and View Items You Cannot Purge options toggle the dialog box display, showing different options and tree view summaries.
**Items Not Used in Drawing:** Displays a tree view of all named object categories (blocks, layers, and so on) in the current drawing. A plus sign appears next to the object category names that you can purge. Clicking the plus sign or double-clicking an object category expands the tree view, displaying all unused named objects that exist for the category. To purge all unused named objects, select All Items in the tree view, and choose Purge All. To purge a specific named object category, select the category in the tree view, and choose Purge.

**Confirm Each Item to Be Purged:** Displays the Verify Purge dialog box when you purge an item.

**Purge Nested Items:** Removes all unused named objects from the drawing even if they are contained within or referenced by other unused named objects. The Verify Purge dialog box is displayed, and you can cancel or confirm the items to be purged.

**Prerequisite:** None

**Keyboard Command:** purge

---

**Store Project Archive**

This command creates an archive of the current project. The archive contains the drawing file (.dwg) and all the associated data file such as the surfaces and layer target definitions. This archive can be used as a backup for the project or as a way to transfer the project to another computer. The format of the archive file is a standard .zip file which can be used by WinZip.

When this command is run, the program will ask for a file name of the archive to create. Enter a name and pick the Save button. The number of files stored to the archive is reported at the command line.

**Prerequisite:** an active Takeoff project

**Keyboard Command:** zip_project
Extract Project Archive

This command reads the project files from an archive created by the Store Project Archive command. The archive contains the drawing file (.dwg) and all the associated data file such as the surfaces and layer target definitions. Since the archive contains the drawing file, you should not have the same project drawing open in Takeoff while extracting the archive. The format of the archive file is a standard .zip file which can be used by WinZip.

The command starts by prompting for the archive file to open. Then there is a dialog with extraction options. You can either extract the files to the specified folder or use the folder names stored in the archive. When using the archive folders, there is a setting to choose the target drive because the archive has the folder names but not the drive names.

Prerequisite: a Takeoff archive file

Keyboard Command: unzip_project

Xref Manager

Attaches, overlays, lists, binds, detaches, reloads, unloads, renames, and modifies paths to external references (Xrefs) in the current (or host) drawing. Displays the Xrefs in the drawing in a tree view or a list view. You can use the F3 and F4 keys to switch between list view and tree view.
List View: Displays a flat listing of the attached Xrefs and their associated data. You can sort the list of references by name, status, type, file date, file size, or the saved path and file name.

Reference Name: Lists the names of the Xrefs as stored in the definition table for the drawing. Status: Shows whether the Xref is loaded, unloaded, unreferenced, not found, unresolved, orphaned, or marked for unloading or reloading.

- **Loaded:** Currently attached to the drawing.
- **Unloaded:** Marked to be unloaded from the drawing once the Xref Manager is closed.
- **Unreferenced:** Attached to the drawing but erased.
- **Not Found:** No longer exists in the valid search paths.
- **Unresolved:** Cannot be read by AutoCAD.
- **Orphaned:** Attached to another Xref that is unreferenced, unresolved, or not found.

Size: Shows the file size of the corresponding reference drawing. The size is not displayed if the Xref is unloaded, not found, or unresolved.

Type: Indicates whether the Xref is an attachment or an overlay.

Date: Displays the last date the associated drawing was modified. This date is not displayed if the Xref is unloaded, not found, or unresolved.

Saved Path: Shows the saved path of the associated Xref (this is not necessarily where the Xref is found).

Tree View: Displays a hierarchical representation of the Xrefs, displaying the relationships between Xref definitions. Tree view shows the level of nesting relationship of the attached Xrefs, whether they are attached or overlaid, and whether they are loaded, unloaded, marked for reload or unload, or not found, unresolved, or unreferenced.

Attach: Displays the External Reference dialog box if an external reference is selected or displays the Select Reference File dialog box if no external reference is selected.

Detach: Detaches one or more Xrefs from your drawing, erasing all instances of a specified Xref and marking the Xref definition for deletion from the symbol table. Only the Xrefs attached or overlaid directly to the current drawing can be detached; nested Xrefs cannot be detached. Carlson TakeOff cannot detach an Xref referenced by another Xref or block.

Reload: Marks one or more Xrefs for reloading. This option rereads and displays the most recently saved version of the drawing.

Unload: Unloads one or more Xrefs. Unloaded Xrefs can be easily reloaded. Unlike detaching, unloading does not
remove the Xref permanently. It merely suppresses the display and regeneration of the Xref definition to improve performance.

**Bind:** Displays the Bind Xrefs dialog box. The Bind option makes the selected Xref and its dependent symbols (such as blocks, text styles, dimension styles, layers, and linetypes) a part of the current drawing.

**Found At:** Displays the full path of the currently selected Xref. This is where the Xref is actually found and is not necessarily the same as the saved path.

**Browse:** Displays the Select New Path dialog box (a standard file selection dialog box), in which you can select a different path or file name.

**Save Path:** Saves the path, as it appears in Xref Found At, to the currently selected Xref.

**Prompts**

Command: _Xref
Overlay Xref "example1": ..\..\..\..\Program Files\Carlson TakeOff
2004\WORK\example1.dwg
"example1" loaded: G:\oem4\src2\work\example1.dwg

Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Command: Specify opposite corner:
Select objects: Enter

**Prerequisite:** multiple files

**Keyboard Command:** Xref

**Import Xref to Current Drawing**

This command allows you to import external reference files (Xrefs) into the current drawing. Before Xrefs are imported, the drawing data from the Xrefs can be viewed but not modified. This import routine has a simplier method for importing than the Xref Manager command. A list is shown of the Xrefs that are attached to the current drawing. If the Xref file is not found, you can pick the Set Path button to locate the drawing file. To import an Xref, highlight the file name and Pick Import.
**Prerequisite:** files to import

**Keyboard Command:** import_xref

**Carlson Community**

This command displays files from Carlson Community where Carlson Software customers can post files to share. This file warehouse is hosted on a Carlson Software server. Types of files on Carlson Community include 3D models for visualization (mdl), point symbol files (dwg), Field-to-Finish code tables for standards in different regions (fld), and road design templates (tpl). To view and download files, you don’t need an account log in.

To find a file, first choose the File Type to search for. The files are organized by category and you can browse by category using the category tree on the left. The Include Sub-Categories option shows the files in the current category as well as any sub-categories. The results can be filtered by User, Tag and Text.

There are two views for displaying the file results. The List view shows a spreadsheet. Under the Settings button, you can control the columns to show for the List view. The Icons view shows a series of buttons with images for each file.

To see details about a file, highlight the file and pick the View button, or double-click on the file. The View file dialog shows the file name, title, image, description, tags, category, number of downloads, average rating by users, file size, user name who uploaded the file, date/time of the upload and user comments.
To download the file to your computer, pick the Download button on the View dialog or highlight the file on the main dialog and pick the main dialog Download button. The download routine will then prompt where to save the file on your computer.

To do more on Carlson Community, you need to have an account and log in. To log in, pick the Log In button and then enter either your User Name for Carlson Community or your email and then your password.

To create a new account, pick the Log In button and then the Account Sign Up button. You need to create a unique User Name for Carlson Community and a password. Your email is also required and needs to be in the Carlson Software records to create a Carlson Community account. If your email is not in the records, then you will receive an email that needs to be confirmed before your Carlson Community account is activated.

Also on the sign up, you must agree to the Terms of Use to create an account. The rest of the information is optional. The Company Key is a way to group users by company which is used by the Carlson Cloud routine for data exchange with SurvCE.
After logging in, you can upload files by picking the Upload button. On the Upload dialog, pick the Select File button and choose the file to upload. Currently the file size limit is 10mb. To upload several files at once, turn on the Enable Multiple Upload toggle before picking Select File. The Select Preview File allows you to pick an image file to use as the preview for your file. Without selecting a preview file, the program will automatically make a preview. The Title, Description and Tags are all optional but helpful ways for users to search for your file. Select a Category for the file from the list or create a new category by entering the category name in the edit box.

Under Account Options, you can update your email, image and other account settings. The List Users shows users by the Company/Group Key name. The Delete Account removes your account from Carlson Community.

The Members routine shows a list of Carlson Community accounts along with activity on uploading.

Files available on Carlson Community include:
MUTCD symbol drawings (dwg): Manual on Uniform Traffic Control Devices from FHWA.

Pulldown Menu Location: File
Keyboard Command: community
Prerequisite: None
Import/Export Carlson Triangulation Files

Import Carlson Triangulation Files allows you to import an external surface file into TakeOff to use as a named surface. Export Carlson Triangulation Files allows you to take a Surface Triangulation file and save it independent of the drawing.

Prerequisite: .TIN or .FLT files

Keyboard Command: import_tin, export_tin

Import/Export DXF Files

Import DXF File allows you to import an external DXF file into the Carlson TakeOff drawing (DWG). Export DXF File exports selected entities from the Carlson TakeOff drawing (DWG) to a DXF file. The DXF file is another format for the drawing objects of the DWG file. Typically, other CAD programs at least support DXF files if they don't support DWG. So the DXF file (Drawing eXchange File) can be used to transfer drawing data between Carlson Takeoff and other non-DWG programs.

Prerequisite: a DXF file

Keyboard Command: _dxfin, _dxfout

Import/Export LandXML Files

This command performs two functions: Export Carlson files to LandXML and Import LandXML files into Carlson. This command supports version 1.0 of LandXML and the following Carlson file types: Coordinate (.CRD) files, Centerline (.CL) files, Profile (.PRO) files, Section (.SCT) files, Grid (.GRD) files, Triangulation (.FLT) files, and Lot (.LOT) files.
Export to LandXML: Allows you to export a Carlson file to LandXML. Choose a new or existing LandXML file, then choose an existing Carlson file.

Import to Carlson: Allows you to import a LandXML file into Carlson. First, choose a new or existing Carlson file, then choose an existing LandXML file.

You first see the Import/Export LandXML dialog. To Export, for example, first click Export to LandXML. Then click Current Drawing Data Files button. You will then see the Select LandXML File dialog box. Select an existing .XML file to be exported from the list of files on the right and click Open.

The next dialog appears, showing the new buttons to be used for the Export. Choose the Add, Remove, Change Directory and/or Report buttons, and then Continue.
Choosing the Continue button takes you further into the Export process. The Report button will give you the Report Formatter Options dialog box.

Data protection is turned on by default, meaning that if you are importing/exporting to an existing file, you will be prompted before the program overwrites existing data. There is a Point Protection option that will not allow any points to be overwritten if the same number appears more than once in the XML file being imported. If you decide to Import From LandXML, go back to the opening dialog an choose the existing LandXML file.

**Keyboard Command:** imp, exp  
**Prerequisite:** Files to convert

---

**Import/Export Trimble TTM File**

These commands convert between Trimble TTM format triangulation files and Carlson format. First you select the source file to read and then the destination file to write.

**Pulldown Menu Location:** Surface->Import/Export Surface  
**Keyboard Command:** ttm2tin, tin2ttm  
**Prerequisite:** File to convert

---

**Import/Export Topcon TIN File**

The Export Topcon TIN File command writes a Topcon TIN file (.TN3) from a Carlson triangulation file (.TIN, .FLT). The routine first prompts for the Carlson file and then the Topcon file.

The Import Topcon TIN File command creates a Carlson Tin file (.TIN, .FLT) from a Topcon triangulation file (.TN3). The routine first prompts for the Topcon file and then the Carlson file.

The units (Feet or Meters) for the triangulation file are the current units set in Drawing Setup.
**Import**

**Data Collectors**

This command does two main functions for a variety of popular data collectors. First, this command transfers (uploads and downloads) data between the data collector and Carlson. Second, this command converts data formats between the data collector format and the Carlson format. So, if you already have the data file on the computer, you can skip the transfer function and just perform the conversion function.

The transfer function does the conversion at the same time. In most cases, the download from the data collector produces a raw (.RW5) file (field notes) and/or a coordinate (.CRD) file (coordinate points). Several of the download programs have an option to automatically run the *Edit-Process Raw Data File* command after downloading raw data. You can also send, or upload, a coordinate (.CRD) file. The dialog shown here appears when the menu command is selected.

![Data Collector Programs](image)

**Carlson SurvCE**: For Carlson Software data collection programs SurvCE and SurvStar. This button produces the SurvCOM dialog and program.

**CG Field**: For CG Field programs.


**Surveyors Assistant**: For data collectors running Surveyors Assistant software (Corvallis MC2, MC5 and Pentax SC5).

**Sokkia SDR**: For SDR2 through SDR 33 and other collectors that have a SDR format like the Trimble.

**Sokkia G2**: Specifically for the SDR2.

**TDS**: For data collectors that use TDS software (Ranger, HP48, HP95, Husky FS-2 & FS-3, Corvallis MC-V and TOPCON FS2, FC95 and FC48).

**SMI**: For SMI data collectors on the HP48.

**Leica**: For Leica GIF-10 module and Leica instruments.

**Nikon**: For Nikon DTM and DR-48 total stations.

**Geodimeter**: For the Geodimeter Geodat collector.

**Topcon 210/310/220/GPT2000**: Supports these Topcon models.

**MDL Laser**: For MDL Laser instruments.

**General Kermit Transfer**: For general transferring using Kermit.

**Carlson SurvCE**
Note: In the following text, the term SurvCE will apply to SurvCE, SurvStar, and Sokkia G2

Connect the serial cable. Select Data Transfer from the on the handheld. Choose Carlson/Carlson Survey Download. This leads to a File Transfer screen on SurvCE, which says "Awaiting Connection". All the action is on the PC side. There is no time delay in this handshake. It will wait for the PC program to catch up. When you connect the cable from SurvCE to the PC, Microsoft ActiveSync may interfere and say "Connect to PC?" If you get this question, say No or otherwise terminate the Microsoft ActiveSync linkage. Start the Carlson portion of this link by choosing Survey, Data Collectors, then the SurvCE option. If connection is automatically established, SurvCE will display, "Connected to PC".

If only the left side of the screen displays data, then you do not yet have a connection. Press the Connect button located at the bottom left of the file transfer dialog. The transfer program will respond with Retrieving File List. Once the file list has been retrieved, the left side of the dialog box will show files located in the specified path on the PC and the right side of the dialog displays the files located in the designated path on the remote. You can change directories by scrolling to the top of the file list and choosing Up One Level (just like in Windows).

To transfer one or more files, simply select or highlight the desired files and select the transfer button. More than one file can be transferred from the remote to the PC or from the PC to the remote during the transfer process. Standard Windows selection options apply. For example, selecting one file and then while pressing the shift key on the PC, selecting another file deeper on the list will select all the files in between the first and last selected. You can also select the first file to transfer and press and hold down the shift key and use the down arrow to specify the range of files to transfer. Pressing and holding the control key on the keyboard allows for the selection of multiple files in any selection order, by picking the files with the left mouse button.

After the files have been selected, press the transfer button. When the transfer is complete, the program will return a "Transfer Complete" message, and will then proceed to update the file lists on the PC and the Remote.

The following information describes the buttons on the bottom row of the SurvCOM dialog box. The button name is on the left in bold:

**Connect:** After selecting Data Transfer in SurvCE, press this button to start the connection. Once connection is made, the status line on the file transfer utility dialog box will show Connected to the remote machine.

---

Chapter 2. File Menu
Transfer: Pressing this button transfers selected files from either the Remote to the PC, or the PC to the Remote.

Set Path: This option allows for the specification of the desired source and destination drives and folders for both the PC and the Remote device. For example, if you were downloading, or copying files from the Remote device to the PC, to specify a source path on the remote device, select the Remote Machine toggle and then type in the desired path in the path field. To specify a destination path on the PC, select the Local PC toggle and type in the desired path the path field. When a change to either path is made, the transfer utility will retrieve a new file list from the specified paths.

Make dir: This option allows for creation of directories on both the PC and the Remote device. Specify the hardware on which to create the directory and then enter the directory name.

Delete: This option allows you to delete the tagged files. To delete a file, select the file to delete by clicking on the file, press the delete button at the bottom of the dialog. Confirm deletion by selecting the appropriate response on the Delete File dialog.

Rename: To rename a file, click on the file to rename and select the rename button at the button of the dialog. On the dialog that displays type in the new name and press the OK button.
Options: This command allows you to set various options for data transfer. The dialog shown below will appear.

Com Port: You must select which com port on the PC to use.

If you are transferring data via a USB port, set the com port to ActiveSync, see the Options section below for procedures to change com ports. To transfer data using an USB port a connection between the Remote and PC using ActiveSync is required. In ActiveSync verify that the "Connect Settings" have been set to "Allow serial cable or infrared connection to this Com port" and Allow USB connection with this desktop computer. This will allow for connection using an USB port or a COM port connection. Both will use ActiveSync to transfer data between devices.
**File Mask:** You must select a file filtering syntax. This filter allows for the setting of specific file types to display. For example if you only wanted to see CRD files the filter would be *.CRD.

**Directory Sort:** You must select how to sort the list of files.

![Directory Sort](image)

**Display Special Files:** Toggle whether or not you should see special files.

**Confirm Overwrite:** Check this to confirm before overwriting files.

**Baud Rate:** You must choose the baud rate for transferring data.

**Protect Remote Files:** Check this to protect files on the mobile device.

**Archive RW5 Files:** With this option set to YES, when downloading rw5 files, a second copy of the file will be made with a .SC5 extension to serve as an archive of the original rw5 file.

**Geoid:** This command will carve out a portion of the Geoid 99, EGM96, Canadian CGC2000, Canadian HT2.0, Canadian HT 1.01, Australian GDA94, Great Britain OSG-MO2 and Geoid 2003 grid files, and send it to SurvCE. Since these geoid grids are very large, this carves out a precise portion of it and avoids overloading the memory on the remote device running SurvCE. You will be prompted for the directory on the PC of the source Geoid grid file, the approximate latitude and longitude of the job, and the size of the area desired in miles, kilometers or degrees of latitude and longitude. To define a Geoid area, make sure that this criteria is met:

1. Specify the location of the geoid grid files.
2. Specify the geoid type.
3. Enter the latitude and longitude near the center of the job area.
4. Specify the Grid size either in miles, km (kilometers), or deg (degrees).
5. Name the grid file.

The file will be transferred to the data collector and place in the appropriate place for use.
F2F conv: This converts the more thorough and detailed Carlson field code file (for field-to-finish work, *.FLD) to the more simplified Feature Code List that runs in SurvCE (*.FCL). The Feature Code List in SurvCE (not SurvStar or Field) handles Linework (on or off), Line Type (2D or 3D), Layer (= Code) and Full Text (Description). Select the Carlson field code (*.FLD) to convert, the conversion takes place and the file is transferred and located in the correct location for use in the data collector.

Send Pnts: This option allows for the uploading of a user specified point number range out of the selected crd file to unload. Use the Select button to specify the crd file to upload. The Remote File Name will default to the name of the crd file selected to upload. You can change this name if needed. Specify the Point Range to Send and select the OK button.
**Exit:** This command will exit the File Transfer Utility

The following information describes the buttons on the Data Collection Programs dialog box that come after the Carlson SurvCE button, moving from left to right and then from top to bottom. The command/button name is on the far left margin, in bold:

**CG Field**

To transfer data to and from data collectors using CGField software, first make sure that the Baud Rate is set to 9600 and the Parity is set to NONE then follow the steps outlined below.

**Receiving a Coordinate File from CGField**

CGField:

1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 4, "Send Coords"
3) Select the Coordinate file to send.

Stop here in CGField and go to Carlson.

Carlson:

Leave the FILE fields blank.

Press the "Download Coordinates" button to ready Carlson to receive the file.

Stop here in Carlson and go back to CGField to complete the transfer process.

CGField:

Select the points to send

1) For All points
2) To select Blocks of points.
3) From .PTS file (the set of points in a Batch Point File).

The coordinates will be transferred. After the transfer is complete, you will be asked for the CRD file name. The C&G CRD file will automatically be converted to a Carlson CRD file. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Receiving a Raw Data File from CGField

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 2, "Send Raw Data". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download Raw" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

CGField:
Select the raw data file to be sent. The transfer will begin.
The C&G .RAW file will be transferred and saved in the data folder. After the transfer is complete, you will be asked for the RW5 file name. The RAW file will be automatically converted to a Carlson RW5 file.

Receiving an ASCII file from CGField

This will allow you to transfer a C&G report file (RPT) or an ASCII NEZ file to Carlson.

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 6, "Send ASCII". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download ASCII" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.
Select the ASCII file to send. After the transfer is complete, you will see the file in the Carlson editor. You can then select FILE and SAVE (or SAVEAS) to save the ASCII file.

**Sending a Coordinate File to CGField**

**CGField:**
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 3, "Receive Coords" to ready the data collector. Stop here in CGField and go to Carlson.

**Carlson:**
Leave the FILE fields blank.
1) Press the "Upload (Send Carlson File)" button.
2) Select the Coordinate file.
3) Select the points to send.
4) Press the "Start Transfer" button.

**CGField:**
Carlson will send the file name to CGField and a coordinate file with the same name will be automatically created or opened in CGField.

If the file exists you will be asked how you want to handle duplicate points:
1) Overwrite
2) Don't Overwrite
3) Ask for each Point

The point transfer will begin.

**Convert CG .RAW to Carlson .RW5**

This utility allows you to convert a C&G raw data file to a Carlson raw data file. Select the C&G .RAW file to convert. Then enter the file name of the destination Carlson RW5 file.

**Thales/FastSurvey** You will be taken directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**Surveyor's Assistant**

**Download**
From the Surveyor's Assistant data collector, go to the Transfer routine from the main menu. Fill out the transfer screen as follows:

- **Direction:** OUTPUT
- **Format:** LIETZ
- **Data:** Coordinate or All Data
- **Port:** COM1 or COM2
- **Chk Hold:** NO
- **Protocol:** NONE

You should also check the settings under the PORT menu. Typical port settings are baud=9600, parity=none, data=8, stop=1 and handshake=XON/XOFF. Now in Carlson, run Data Collection in the Survey menu and choose Surveyor's Assistant. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to Surveyor's Assistant and press GO. The file transfer should now go. If the All Data option is used, then the Leitz format will contain both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point...
data before downloading the point from the data collector.

**Upload**

Point data from the Carlson coordinate (.CRD) file can be uploaded into the Surveyor's Assistant. First go to the Transfer routine on the main menu. Fill out the screen as follows:

- **Direction:** INPUT
- **Format:** LEITZ
- **Port:** COM1 or COM2
- **Protocol:** NONE

Go back to Carlson and choose Surveyor's Assistant from the *Data Collection* command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to the Surveyor's Assistant and hit the GO function key. The Surveyor's Assistant is now waiting to receive so return to Carlson and click OK on the range of point dialog. The file transfer should now go.

**Sokkia SDR**

This routine applies to the Sokkia SDR-20, SDR-22, SDR-31 and SDR-33 as well as other collectors that have SDR format transfer such as the Trimble and C & G.

**Download**

From the SDR data collector, go to the Communications routine from the main menu. Choose Data Format SDR. Next hit the Send function key. Then choose Select Jobs. From the list of jobs, highlight the job to transfer and set it to Yes with the arrow keys. Now in Carlson, run *Data Collection* in the Survey menu and choose Sokkia/SDR. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SDR and press OK. The file transfer should now go. The SDR format contains both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. The original SDR transfer file is stored on the computer as a RAW file. When the transfer is
complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

The SDR-33 has different modes for storing and transferring data. In coordinate mode, the download will create points in the coordinate (.CRD) file and the raw data (.RW5) file will only contain some basic header lines. In the raw data mode, the download will create all the measurement data in the raw file and no points will be created in the coordinate (.CRD) file. For this raw data mode, you will need to run Edit-Process Raw Data File in the Survey menu to calculate the points from the raw data. The third mode in the SDR-33 creates both raw data in the raw data (.RW5) file and points in the coordinate (.CRD) file. The Include Time Stamps in Notes option sets whether all the date-time records for each point are put in the raw data (.RW5) file as description records. The Include Point Attributes in Notes option will store SDR code 13(AT) codes to the point note (.NOT) for the coordinate (.CRD) file.

Upload

Point data from the Carlson coordinate (.CRD) file can be uploaded into the SDR. First go to the Communications routine on the SDR main menu. Choose Data Format SDR. Go back to Carlson and choose Sokkia/SDR from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. Then a Sokkia Options dialog appears for setting the job parameters for the file to be created on the collector. Be sure to choose the Distance Unit that matches your coordinate (.CRD) file (meters, US feet or international feet). Click OK and the next dialog now allows you to specify the range of point numbers to upload. Before clicking the Start Transfer button for range of points, go to the SDR and hit the Receive function key. The SDR is now waiting to receive so return to Carlson and click Start Transfer on the range of point dialog. The file transfer should now go.

Communication Settings

Besides matching the baud rate between Carlson and the collector, make sure that the collector is set to word length of 8 and 1 stop bit under the communication settings.

Print File

The Receive Sokkia Print File downloads a print report from the SDR33 data collector. This file is only used for printing report purposes in Carlson. This file is not used by Carlson to generate coordinate (.CRD) files or raw files.
The first step is to choose Data format=Printed in the Communications menu of the SDR33. Next pick the Receive Print File button in Carlson. Then on the SDR33 choose the Send function and select a job to send. At this point the file is transferred. After downloading, the job report is displayed in the Carlson standard report viewer.

**Example of Sokkia Printed Format:**

```
SDR33 V04-04.25 (C) Copyright 1998 Sokkia May-29-80 23:39 01/29/1999
Angle Degrees Dist Feet
Temp Farenht Coord N-E-Elev
JOB TRAV Point Id Alpha (14)
Atmos crn No C and R crn No
Record elev Yes Sea level crn No
POS TP 1 North 10050.000 East 10000.000 Elev 0.000
POS TP 2 North 10000.000 East 10000.000 Elev 0.000
POS TP 3 North 9515.636 East 9551.975 Elev 37.611
POS TP 403 North 4967.527 East 5074.632 Elev 0.000
NOTE TS Jan-01-80 00:14
** End of report **
```

**Sokkia G2** This routine takes you directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**TDS**

**Download [HP-48 and Husky]**

In the TDS program, go to the File Transfer routine. Choose the type of data to transfer (CRD or RAW). Next pick the Send function key. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Download [Ranger and Windows CE]**

In the TDS program, go to the Transfer routine and pick the Send File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. In the Type field of the file selection dialog, choose Coordinate Files or Raw Files. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS and pick OK in the TDS dialog. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Upload [HP-48 and Husky]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the File Transfer routine. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

Upload [Ranger and Windows CE]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the Transfer routine and pick the Receive File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

SMI
Download
To send point data from the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TOPC] [COMM]. In SMI version 6 or later, type [Job][KERM][SEND]. Also in version 6, make sure that the first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. The [NE] stands for North-East coordinate order which is the format that Carlson expects. Also in the [Job][KERM] screen, make sure that the second function key reads [COMM] and not [SPACE]. The [COMM] stands for comma separators. Then enter the first point to send followed by the last point to send but before pressing Enter for the last point go to Carlson. Run Data Collection in the Survey menu and choose SMI. Check that the COM port...
and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SMI and press Enter for the last point to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. To send raw data, use the [Print][Raw] routine in SMI along with the same Carlson procedure used for point data.

**Upload**

From the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TO48] [COMM]. In SMI version 6 or later, type [Job][KERM][RECV]. Also in version 6, make sure that first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. Then enter the first point to send followed by the last point to send. Next enter the job name but before pressing Enter go to Carlson and run SMI under **Data Collection** in the Survey menu. In the Carlson dialog, specify the same job name as entered in SMI. Next pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the same range of points as entered on the SMI. Go back to SMI and hit Enter for job name followed by clicking the OK button for range of points in Carlson. The file transfer should now go.

![SMI HP 48 Data Collection](image)

**Leica**

There are two types of Leica transfers: GIF-10 and GeoCom for all other Leica instruments. The type is set in the Equipment Type field on the main dialog. For transferring with the Leica instruments, the GeoCom program shows a dialog of the available COM ports on your computer. On the first time that you transfer to an instrument, you will need to pick the Instruments button and register the instrument from the list. Pick the Port Settings button to make sure that the communication settings match the instrument.

To download a file with GeoCom, make sure that the instrument is ON and connected to the computer by serial cable. The instrument also needs to be in GeoCom mode. Then pick the Download in the Carlson dialog. In the GeoCom program, open the computer COM port that the instrument is connected to by picking the ‘+’. Then open the Memory Card and GSI folders. Next select the file to transfer and click the OK button. With Point Protect on,
the routine will check the coordinate file for existing point data before downloading the point from the data collector.

To upload a file with GeoCom, specify the file name to be created on the instrument in the Leica File field and pick the Upload button in the Carlson dialog. Then the program will prompt for the range of points to transfer. Fill out the range and pick the Start Transfer button. Then the GeoCom program will start. Open the computer COM port by picking the ‘+’. Then open the Memory Card folder and highlight the GSI folder and click OK.

The upload and download file transfer works with the GIF-10 data collector. The GIF-10 communication settings should be the following:

Baud: 9600
Parity: NONE
Protocol: NONE
Stop Bit: 1
End Mark: CR/LF
Connected As: Some computers use DCE and others use DTE

![First Leica dialog](image1)

![When Leica 1200 Series is chosen](image2)
**Download**

From the GIF-10, go to the file transfer routine. Then go to Carlson and run Data Collection in the Survey menu and choose Leica. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to GIF-10 and select the file to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Upload**

From the GIF-10 data collector, go to the file transfer routine. Then go to Carlson and run Leica under Data Collection in the Survey menu. In the Carlson dialog, specify the job name in the Leica File field. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to GIF-10 and start the receive by highlighting Receive and pressing the Run button. The GIF-10 now shows the available job numbers. Choose a job to receive the transfer using the arrow buttons and then press the Run button.

**Converting**

Carlson supports raw and coordinate data collected using three different Leica Operation Codes: Wildsoft and 10-20-30-40 as well as the newer LISCAD. Moreover, data could be in the GSI8 format or the newer GSI16 format. Some example files are shown here.

**GSI8 format data file using LISCAD Operation codes:**

WILD GIF-12
410149+00000001 42....+00005003 43....+00005.42 44....+00005.25 45....+00005000
110150+00005000 21.324+35959480 22.324+09238590 31..01+00228271
410151+00000005 42....+00010100
110152+00005001 21.324+35156390 22.324+09303500 31..01+00133532
410153+00000005 42....+00070100
410154+00000014 42....+00000ELM
Leica raw files usually have a .RAW or .GSI extension. The primary difference in the GSI8 and GSI16 formats is that information is contained in data blocks of 16 characters in the GSI16 format, while it is contained in blocks of 8 characters in the GSI8 format. Leica instruments make it possible to have both the GSI8 as well as GSI16 data formats in the same raw file. However, lines with the GSI16 format data will always start with an asterisk (*) character, to distinguish them from the GSI8 format. There is no distinction between Leica raw files collected in the Wildsoft and LISCAD operation codes.

**Supported LISCAD codes:**
1: New instrument setup  
2: New target height  
3: Sets of directions  
4: Fixed azimuth  
5: Feature code  
6: Measured offset  
8: Line creation for sub-codes 1 (straight string), 2 (curved string) and 6 (arc by 3 points)  
9: Fixed coordinates  
11: Close string  
14: Additional description  
20: Start of job  
27: Feature code  
90: Split feature code  
100+: Descriptions
The Convert button can be used to convert any Leica format file into a Carlson format file. For example, if you have a Leica PCMCIA card then there is no serial cable transfer to do. Instead use the Convert routine to make the Carlson raw data (.RW5) and coordinate (.CRD) files. Since there is no distinction between Wildsoft and LISCAD files, the user must know in advance which format has been used in the file. Then, select that particular option (Wildsoft, 10-20-30-40 or LISCAD) under the “Coding System” option at the bottom of the dialog box, as shown in the previous page. Another option that the user needs to choose is the order in which foresight-backsight readings have been recorded in the raw file, BFFB or BFBF, as explained in the dialog box. Then, the user can simply pick the "Convert" button and the program prompts for the input" Wild/Leica File” (raw file), and the output” Carlson RW5 file” and "Carlson CRD file”, if they are not already filled.

Nikon

Download
First choose the equipment and data type under the Transfer Type list. Also check that the communication and data format settings match your collector. Then click the Download button and follow the on-screen directions. When the transfer is complete, the program will ask you for the Carlson coordinate file (.CRD) and raw file (.RW5) to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. The original data from the collector is stored in a file name with the same name as the coordinate file except with a .TRN extension. For example, job5.crd would have job5.trn.

Upload
Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Set the points and then click the Start Transfer button. The file transfer should now go.

Convert Nikon to Carlson
The Convert button will translate the Nikon raw file format (.TRN or .RAW) into Carlson coordinate (.CRD) and raw (.RW5) files.
Portion of typical Nikon file format:
MP,1,,5000.0000,5000.0000,0.0000,T/1
ST,1,,0.0000,0.00000,0.00000
SS,3,0.0000,152.1510,359.59590,90.44100,11:43:38,T/2
SS,4,0.0000,127.5560,0.06040,90.40110,11:44:45,CON
SS,5,0.0000,97.1820,2.19580,90.52460,11:45:43,CON

Geodimeter

Download
From the Geodimeter data collector, go to the file transfer routine by pressing the PRG (Program) key and entering program 54. Then choose Imem (option 1) as the source. Next choose the file type to send as either Job (measurement data) or Area (point data). The Geodimeter will then prompt for the job name. Next enter Serial (option 3) as the destination. A confirmation screen appears showing the serial port settings. Here are some typical settings:
COM=1,8,0,9600

Before pressing enter (ENT key), go to Carlson and run Data Collection in the Survey menu and choose Geodimeter. Then click the Download button and within 15 seconds, go back to the Geodimeter and press Enter. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate file and raw file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
In Carlson, run Geodimeter under Data Collection in the Survey menu. Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the points to send but before clicking OK, go to the Geodimeter data collector. Start the file transfer routine by pressing the PRG key and entering program 54. Then choose Serial (option 3) as the source. The Geodimeter will display the serial port settings. Check these values and press enter. Next choose Area (option 2) as the destination. Then enter the job name. The Geodimeter is now listening for data. Quickly go back to Carlson and click OK on the points to send dialog. The file transfer should now go.
Convert
The Convert button will translate the Geodimeter raw file format (.OBS) into Carlson coordinate (.CRD) and raw (.RW5) files.

Communication Settings
If the Geodimeter is not communicating with Carlson, run function 79 on the Geodimeter and make sure that it is set to 4. This setting is for the transfer message end of sequence format.

Supported Geodimeter Codes
The following Geodimeter codes are processed when converting the Geodimeter raw file. All other codes are recorded as descriptions in the Carlson rw5 file.
0=Info
1=Data
2=Station No
3=Instrument Height
4=Point Code
5=Point Number
6=Signal Height
7=Horizontal Angle
8=Vertical Angle
9=Slope Distance
11=Horizontal Distance
17=Horizontal Angle
18=Vertical Angle
21=Horizontal Reference Angle
30=Atmospheric Correction
37=Northing
38=Easting
39=Elevation
40=Delta North
41=Delta East
42=Delta Elevation
45=Correction To Bearing
46=Standard Deviation
50=Job Number
51=Date
52=Time
53=Operator
54=Project Id
55=Instrument Id
56=Temperature
60=Shot Id
61=Activity Code
62=Reference Object
70=Entered Radial Offset
71=Entered Angle Offset
72=Calculated Radial Offset
73=Calculated Angle Offset
74=Air Pressure

Portion of typical Geodimeter file format
5=108
4=13POC
6=5.000
7=238.0708
8=89.2236
9=440.39
37=767.42
38=4626.07
39=699.795

Topcon 210/310/220/GPT2000

This command supports these above Topcon models.
MDL Laser
The MDL Laser outputs a raw file of angles, distances and codes as one long string of data which can be converted into a Carlson raw data (.RW5) file. There is no coordinate data in the MDL raw file. So you need to run Edit-Process Raw File to calculate coordinates from the raw data. The Download button will transfer the MDL raw data from a BDI logger.

Kermit
Kermit can be also used for transferring files with accuracy. The dialog looks like this:
Keyboard Command: datacolt
Prerequisite: None

Import Google Earth File
The Import Google Earth File command allows you to insert a KML (Keyhole Markup Language or alternatively a KMZ) file of points (KML Placemark), polylines (KML Path) and closed polylines (KML Polygon) into your drawing. Throughout this discussion, KML will be used to also describe KMZ files unless explicitly noted.

Import Lines and Polygons: When this option is selected, KML Path and Polygon entries will be placed into the drawing as open or closed polylines, respectively.

Import Points: When this option is selected, KML Placemark entries will be placed into the drawing and active coordinate file.

Point Protect: When enabled, existing points in the active coordinate file will not be over-written.

Use Name as Number: When enabled, the names of KML Placemark entries will be utilized as Carlson point numbers.

Attach Image To Points: This option applies to KML files created by Carlson SurvCE when the points are stored together with an image. Use this option to attach the image to the point symbol. The images can be viewed using
the Image/Document Inspector command. The image files are extracted from the KML and stored in the Image Storage Path folder.

**Import Overlay Images:** When enabled, any Overlay Image placemarks in the KML file will be inserted into the CAD drawing.

**Use Folders as Layers:** When enabled, KML Folder entries will be used to create layer names in CAD and the supported KML options described above will be placed onto the layer that conforms to the Folder to which they belong.

**Default Layer:** The supported KML options described above that are not contained in a KML folder will be placed into the specified layer.

**Import GIS Data:** When enabled, this routine will populate GIS data into the drawing such as that written from the drawing with the Export Google Earth File command.

**Note:**

- Placemarks, paths or polygon entries that have an altitude value specified will be imported at the proper "Z" elevation in the CAD drawing.
- KML or KMZ files can be specified for the import process.

**Prompts**

**Google Earth File to Read:** Select a previously saved KML or KMZ file.

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

**Pulldown Menu Location:** File > LandXML/RoadXML/Google Earth

**Keyboard Command:** kmlread

**Prerequisite:** A KML or KMZ file with Placemark, Path and/or Polygon information, an active coordinate file with an established projection zone through Drawing Setup.

**Import LandXML File**

This command imports project data from the industry standard LandXML file format version 2.0 and earlier. Land development software applications including Carlson Software can exchange project data using LandXML. The project data in LandXML includes survey measurements, coordinates, centerlines, profiles, cross sections, surfaces, lots, plan view linework and pipe networks.

To import a LandXML file, the program first prompts to select a LandXML file to import. Then there is a dialog with import options along with a view of the contents of the LandXML file. You can toggle on which data from the file that you want to import.
**LandXML Units:** Indicates the Units of Measure associated with the incoming LandXML file (see the Unit Differences item below).

**Point Protection:** When enabled, you are prompted for a course of action if an existing LandXML file you’ve selected contains COGO points that have the same number(s) as those that already exist in the drawing. When disabled, existing point data in the project is updated with the values from the LandXML file.

**Destination File Method:** This option allows you to indicate how the incoming data file(s) are named as they are imported.

**Load Surfaces into Surface Manager:** When enabled, this option will automatically add surface model (TIN) data into the Surface Manager and graphically represents (draws) the surface model/contours according to the current settings found in the Triangulate & Contour command.

**Skip Invisible Triangles:** This option skips triangles flagged as invisible when importing a triangulation surface.

**Use Old FLT Triangulation File Format to Import Surface Data:** When enabled, the older ASCII-based Carlson *.FLT file format will be used in place of the newer and more efficient *.TIN file format.

**Save All Existing Ground Profiles from One Centerline to the Same File:** When enabled, collections of existing ground profiles associated with a particular centerline are combined into a single *.PRO file.

**Draw PlanFeatures to current drawing:** When the LandXML contains PlanFeatures, this option will automatically draw this linework. Otherwise, the program stores a .pln file which can be drawn using the File > Import > Polyline File routine.

**Save Point Descriptions:** For coordinate records, this option controls whether to use the LandXML description or code record for the coordinate file point descriptions.

**Add F2F Codes to Points from PlanFeatures:** When the LandXML file contains both coordinates and plan features, this option adds Field-to-Finish linework codes to the descriptions of the coordinates. For example, if a
plan feature line ends at point 25, then the Field-to-Finish end linework code of END is appended to the description of point 25.

**Change Directory:** This option allows you to adjust the folder location where the new data files will be written.

**Import from LandXML:** Enable or disable various entries that should used to produce the data files found within the LandXML file.

![](image1.png)

**Unit Differences:** If the Units of Measure specified in the LandXML file are different than those found in Drawing Setup, you will be prompted for a course of action.

![](image2.png)

**Manning's "n":** If you are importing sewer data from a LandXML file and if the LandXML file does not carry Manning's "n" values, you will be prompted to specify a default Manning's "n" value for all incoming sewer entities that don't already have a Manning's "n" value.

![](image3.png)

**Import Structures:** If you are importing sewer data from a LandXML file and structure values specified in the LandXML file do not exist in the Structure Library, you will be prompted to indicate the structure(s) that should be imported into the Structure Library. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple structures at the same time.

**Skip Invisible Triangles:** This option applies to importing TIN surfaces from Civil 3D. When this option is active, triangles marked by Civil 3D as invisible or excluded are not imported.

**Note:**
• The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don't have to own or use the CAD or software product used by your data provider).
• Visit http://www.landxml.org for additional information on the uses and acceptance of the LandXML project.

Pulldown Menu Location(s): File > LandXML
Keyboard Command: landxml_import
Prerequisite: A LandXML file to import

**Import MicroStation DGN**

This command takes a MicroStation DGN file and imports the MicroStation elements into your current DWG drawing. After selecting the DGN file you want to import, you will receive a conversion report like the one below:

<table>
<thead>
<tr>
<th>Element</th>
<th>Type Name Encountered</th>
<th>Converted</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Line3d</td>
<td>273</td>
</tr>
<tr>
<td>4</td>
<td>LineString3d</td>
<td>48</td>
</tr>
<tr>
<td>6</td>
<td>Shape3d</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>ComplexString</td>
<td>321</td>
</tr>
<tr>
<td>17</td>
<td>Text3d</td>
<td>131</td>
</tr>
<tr>
<td>-1</td>
<td>Model</td>
<td>1</td>
</tr>
<tr>
<td>775 total</td>
<td></td>
<td>775</td>
</tr>
</tbody>
</table>

775 converted elements in 1 seconds.

After the command has imported the DGN file, run View > Zoom > Extents to see the converted entities.

Pulldown Menu Location: Tools > Import/Export
Prerequisite: a MicroStation DGN file
Keyboard Command: dgn_in

**Import Polyline File**

**Function**

This command draws polylines from the selected polyline file. These polylines are drawn in the current layer. This command supports the following formats: Carlson (.PLN), Idan (.DIS), MicroStation (.TXT), MOSS (.INP, .PRN) and Topcon Pocket 3D (.TXT).

**Prompts**

Polyline file format [<Carlson>/DTM/Idan/MicroStation/MOSS/Topcon]? press Enter to accept Carlson
Polyline File to Read Dialog select existing .PLN file

Keyboard Command: polydraw
Prerequisite: A polyline file

**Import PDF File**

This command allows you to bring in an Adobe .PDF file and convert it into CAD linework or an image file. First the program prompts to select the file you want to convert. Next, the below dialog will open. The first line in the dialog with show important information about the PDF, including the file name, data type (Vector or Raster), and the
number of pages. It will also display "Layers" or "3D" if those elements are found in the file. Vector vs Raster data is an important distinction. Vector PDFs are typically of higher quality and can be brought in with the "Linework Options". Raster PDFs are lower quality and it is recommended to bring them in with the "Image Options".

![Image of Import PDF File dialog box]

**Linework Options**
The "Insert Linework" button shown above will convert the PDF file into usable CAD polylines. If layers are present in the PDF file, "Keep PDF Layers" will import the PDF layers into CAD layers. If there are not layers in the PDF file, "Use Colors for Layers" will parcel out the converted polylines onto layers based on the linework's color, gray scale, width, horizontal and vertical orientation. "Insert as Block" will create one block entity for all the linework. "Join Nearest" can be used to clean up the converted linework by combining adjacent linework but requires longer processing time. The "Reduce Vertices" simplifies the linework by removing extra vertices. The "Use Zero Linewidth" option creates linework with the line width set to zero. Otherwise the linewidth will be set from the linework properties in the PDF. The "Skip Tiny Lines" option doesn't draw any super short lines which is helpful for handling a PDF that has a dense hatch pattern made of tiny lines.

**Image Options**
In some cases, it may be preferred to bring in the PDF as an Image. "Image Options" shown below has three different methods for working with the converted Image. "Insert as Image" will convert the PDF into a Image file that is then inserted into the drawing. When inserted, the Image is visible on the screen, but unusable as CAD linework. "Save to Image File" simply saves the Image file without inserting it into the drawing.
"Vectorize and Insert" can be used to convert raster PDFs into CAD linework. If the program recognizes "vector data", indicated in the status section of the dialog, then it is recommended to use the "Linework Options" to produce CAD linework. Using "Vectorize and Insert" on "raster data", you will receive this additional dialog:

In this dialog, you can specify the Layer, Color, Scale, and whether to draw the entities on the screen or write a .dxf file. Minimum Polyline Length will reduce the amount of line segments created from the conversion.

**Inserting the Converted PDF**

When you are inserting the converted PDF into the drawing, will you receive the following prompts:

- Pick point to insert PDF: Specify the insertion point for the PDF converted linework by either picking on the screen or typing in a coordinate (Example: 1000,1000).
- Specify rotation angle: To accept the default value displayed, press Enter, or enter the rotation angle (Example: 90). Specify scale <1.0>: To accept the default value displayed, press Enter, or enter a scale factor. If the scale factor is not known, which is typical, accept the defaults to this prompt.
- Note: The proper scale factor can be determined by running Edit>Scale Wizard after inserting the PDF.

After the command has imported the PDF file, run View > Zoom > Extents to see the converted entities.
Settings
The program has two different conversion engines available, "Visual Integrity" and "Ghostscript". "Visual Integrity" is recommended and the default. In order for Ghostscript to work you need to download and install it from the website http://sourceforge.net/projects/ghostscript/. For 32-bit computers you'll want to download gs(xxx)w32.exe by clicking on the "Download Now!" button located on the main page.

If gs(xxx)w32.exe is not listed under "Download Now!" or you are running a 64-bit computer, click on the "View all files" button to the right of the "Download Now!" button. A list of Ghostscript versions will appear below (i.e., 9.23, 9.22). Choose the 9.23 or newer version. After downloading the .exe to your computer double click on it to install. Ghostscript is a free software and should only take a few minutes to install. Once it is installed, Carlson Takeoff will automatically utilize this software when Ghostscript is selected as the PDF Import Engine.

Pulldown Menu Location: Tools > Import/Export
Prerequisite: a PDF file, Ghostscript installed
Keyboard Command: loadpdf

Import RoadXML File
The Import RoadXML File routine provides a mechanism where road-based data from other software applications (including Carlson Software) can be brought into a project and used for analysis and/or design purposes. The program supports centerline and profile data in Trimble style RoadXML format. To import a RoadXML file, a series of dialog boxes are presented:

Select RoadXML File: The standard File Selector dialog box prompts you identify an existing RoadXML (*.RXL) file you wish to import. The following dialog box is then displayed:
**RoadXML Units:** Indicates the Units of Measure associated with the incoming RoadXML file (see the Unit Differences item below).

**Destination File Method:** This option allows you to indicate how the incoming data file(s) are named as they are imported.

**Change Directory:** This option allows you to adjust the folder location where the new data files will be written.

**Import from RoadXML:** Enable or disable various entries that should used to produce the data files found within the RoadXML file.

RoadXML Units: RoadXML files are always in metric units. If the current drawing units as set in Drawing Setup are not metric, then you will be prompted whether to apply a scale factor. Note: Visit http://www.road-xml.org for additional information on the RoadXML initiative.

**Pulldown Menu Location:** File > Import  
**Keyboard Command:** roadxml_import  
**Prerequisite:** A RoadXML file to import

**Import 3D Model File**

This command draws 3D faces for geometry in a 3D model file in .mdl or .obj file format. These graphic files are used in 3D viewing commands like 3D Drive Simulation. The Settings > 3D Model Library manages these graphics files. The .mdl file is also used for Solids in the Underground Mining module.
Import SketchUp File to Drawing

This command creates a CAD block from a SketchUp model and inserts this block into the drawing.

After selecting the .skp file to import, the options dialog shows the dimensions of the model at the top of the dialog.

- **Layer**: Sets the layer for the block in the drawing.
- **Scale Factor**: Allows resizing the model. For example, when the SketchUp model is in inches and the drawing in feet, use a scale factor of 0.0833333.
- **Prompt For Rotation**: This option prompts to pick a second point for rotation of the block in the drawing.
- **Place Multiple**: Sets whether to place a single block in the drawing or allow for drawing multiple copies.
- **Elevation By**: The Pick method uses the elevation of the picked points. The Fixed method uses the **Elevation** from the dialog. The Surface method prompts for a grid or triangulation file to use for the elevation.


Prompts

- **Select SketchUp File**
- **Draw SketchUp Model dialog**
- **Pick position**: pick a point
- **Pick rotation**: pick a point
- **Pick position (Enter to end)**: press Enter

Convert Polylines To Text

This command will create text from polylines generated by a PDF or raster import. When you run the command you will be prompted to load or create a Character file (.ocr). This file acts as a library that associates polylines in your drawing with a particular character (A, B, C, 1, 2, 3, etc.) to convert into text. From the Polylines To Text dialog, you have the ability to modify the Character library and to Convert selected linework in the drawing.
To build the Character library, pick on the Add button. Here you type in the character you’d like to add, choose the font style the text will appear on, and then select the polyline(s) that comprise the character.

After the desired library has been compiled, Convert will prompt you to select the linework you wish to process from the library into text. Below is an example of PDF linework convert from polylines into text.

Run Save or Save As to use the Character file (.ocr) on future projects.
Convert Dashes To Polylines

This command connects sequential dashes into polylines. The program will prompt you to select a sample and adjacent dash line. This identifies the layer and approximate gap between dash lines. It is helpful to isolate this layer before running the command. Next, select the dash lines to process and press enter. Below are typical results of the conversion.

Before Conversion
Pulldown Menu Location(s): Tools > Import/Export  
Keyboard Command: dash2pl  
Prerequisite: Dashed linework to convert into continuous polylines.

Export

This command creates a .mdl graphics files from selected 3D faces. These graphic files are used in 3D viewing commands like 3D Drive Simulation. The Settings > 3D Model Library manages these graphics files. The .mdl file is also used for Solids in the Underground Mining module.

Pulldown Menu Location: Solid  
Keyboard Command: dwg2mdl  
Prerequisite: 3D faces

Drawing to 3D PDF

This command creates a PDF file from 3D entities in the drawing. The elevations of the entities are used to make the PDF a "3D PDF" that can then be opened and oriented in 3D with a standard PDF viewer such as Adobe Acrobat Reader.

Note:

- See the 3D Viewer to 3D PDF command for a complete description of the 3D PDF Options controls.
- Additional controls can be exposed in the 3D PDF via a "right mouse click" while the 3D PDF is open.

Prompts

Select entities for 3DPDF.  
<Select entities>: Select the entities that should be written to the 3D PDF file.
3D Viewer to 3D PDF

This command creates a PDF file from 3D viewer files (.3DX) which are created in commands such as 3D Viewer Window and Surface 3D Viewer. The PDF file is a "3D PDF" that can then be opened and oriented in 3D with a standard PDF viewer such as Adobe Acrobat Reader.

Title: Indicate a title (if any) that should appear at the top of the PDF file you are about to create.

Output File Name: Use the Select button to supply the desired PDF file name to which the drawing content shall be written.

Merge with existing PDF: Use this option with the Template File Name to add the 3D PDF onto an existing PDF. This option is a way to have your own title block as a template PDF and then insert in the 3D PDF.

Paper Size: Indicate the desired PDF paper size.

Append with existing PDF: When enabled, the new PDF output will be appended as a new page to the Output File Name if the file already exists.

Plan View Margins: Controls the margins around the 3D view window and the border of the page.

Background Color: Controls the background color for the PDF.

Show Axis: When enabled, the X,Y,Z axis directions will be displayed in the PDF.

Include North Arrow: When enabled, a North Arrow will be displayed in the PDF.

Include Vertical Exaggeration Control: When enabled, a Vertical Exaggeration control will be available in the PDF.

Include Inspector Controls: When enabled, an inspection (Signature) control is provided in the PDF.

Background Color: Indicate the desired background color of the PDF.

Note:

- To create a 3D PDF from entities directly selected from a drawing, see the Drawing to 3D PDF command.
- Additional controls can be exposed in the 3D PDF via a "right mouse click" while the 3D PDF is open.
Prompts

3DX File to Create PDF: Select the *.3DX file that should be written to the 3D PDF file.

Pulldown Menu Location: PDF
Keyboard Command: 3dx2pdf
Prerequisite: A *.3DX file

Export DXF File

Function

This command allows the user to create a DXF file from the current drawing. It gives the option to create a DXF file from the entire drawing or selected objects. The degree of precision for numbers can be selected. Whether a binary file needs to be used can also be selected. These DXF files can be used by other CAD systems to open up Carlson Software drawings.

Export LandXML File

The Export LandXML File routine provides a mechanism where data can be sent from Carlson Software into a LandXML file for use in other applications that support the LandXML data specification. LandXML version 2.0 is used which includes the ability to output triangulation surfaces with colors and materials defined for the triangles.

To generate a LandXML file, a series of dialog boxes are presented:

![Import/Export LandXML]

Export to LandXML: This option allows you to individually select the desired Carlson Software data file(s) that should be included in the LandXML file.

Project Data Files: This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

Select LandXML File: Specify the name of a LandXML file you wish to create.
Include Files Referenced in Select Files: When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson Road Network command references TINs, Centerlines, Profiles, etc, and adding the single Road Network file will also add the referenced file(s) into the Export to LandXML File dialog box.

Export to LandXML File: Add, remove (using standard Windows click, shift+click and/or ctrl+click functionality) or otherwise organize the data file(s) that is to be incorporated into the LandXML file.

Change Directory: This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

Report: Create a report (suitable for file transmission or archival purposes) of the file(s) selected to be incorporated into the LandXML file.
LandXML Units: Specify the desired Units of Measure that reflect the outgoing data.

Point Protection: When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those being selected for the LandXML file. When disabled, point data you've selected for the LandXML file are automatically written to (or updated into) the existing LandXML file.

Exported Element Protection: When enabled, you are prompted if existing data (such as a centerline) in a LandXML file should be updated with data of the same name that you have selected for the LandXML file.

Precision: Set the desired level of precision for each of the various measurement categories.

Profiles:

There are two major different types of profiles in LandXML: ProfSurf and ProfAlign. ProfSurf is typically an existing surface that is usually created using existing surface data. The data for this type of profile it is stored in a series of station-elevation values as a representation of a PntList2D list. ProfAlign is for a design profile. The data for this type of profile is stored in LandXML elements starting from the simplest one: PVI element, CircCurve element, ParaCurve element, etc.

Carlson differentiates the two types mentioned above by using the profile type in the Carlson .pro file: Generic = ProSurf, Road = ProAlign.

Note:

- The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don't have to own or use the CAD or software product used by your data provider).

Pulldown Menu Location(s): File > LandXML
Keyboard Command: landxml_export
Prerequisite: Carlson project data files to convert

Export RoadXML File

The Export RoadXML File routine creates a RoadXML RXL file using Carlson format centerline and profile files. This RoadXML file can be used for data exchange with other applications that support the RoadXML data specification such as Trimble. To generate a RoadXML file, a series of dialog boxes are presented:

Current Drawing Data Files: This option selects the various data files associated with, and defined by the Drawing Explorer command.

Project Data Files: This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

Selected Data Files: This option allows you to individually select the desired Carlson Software data file(s) that should be included in the RoadXML file. This is followed by:

Select RoadXML File: Use the standard File Selector dialog box to specify a new or append to an existing RoadXML file. This is followed by:
Include Files Referenced in Select Files: When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson Road Network command references TINs, Centerlines, Profiles, etc, and adding the single Road Network file will also add the referenced file(s) into the Export to RoadXML File dialog box.

Export to RoadXML File: Add, remove (using standard Windows click, shift+click and/or ctrl+click functionality) or otherwise organize the data file(s) that is to be incorporated into the RoadXML file.

Change Directory: This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

Report: Create a report (suitable for file transmission or archival purposes) of the file(s) selected to be incorporated into the RoadXML file.

RoadXML Units: The Units of Measure are displayed for the RoadXML file about to be created.

Exported Element Protection: When enabled, you are prompted if existing data (such as a centerline) in a RoadXML file should be updated with data of the same name that you have selected for the RoadXML file.

Precision: Set the desired level of precision for each of the various measurement categories.

Pick the Export button to complete the creation of the RoadXML RXL file.

RoadXML Units: RoadXML files are always in metric units. If the current drawing units as set in Drawing Setup are not metric, then you will be prompted whether to apply a scale factor.
Indicate the desired action of what should occur if the units of the RoadXML do not match those of the current drawing.

Note: Visit http://www.road-xml.org for additional information on the RoadXML initiative.

**Pulldown Menu Location(s):** File > LandXML/RoadXML  
**Keyboard Command:** roadxml_export  
**Prerequisite:** Carlson project data files to convert

## Export Surface DXF Files

Export Carlson Triangulation Files allows you to take a Surface file and save it as a DXF file. The DXF file will contain 3D Faces for the triangulation surface. This command is another way besides the LandXML routine to transfer a Carlson Takeoff surface to other programs.

**Prerequisite:** .TIN or .FLT files  
**Keyboard Command:** EXPORT_DXF

## Export Polyline File

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. This polyline file is a text file that has three formats. The Carlson format (.PLN) is used by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number". Then the points for the polyline are listed on separate lines in X,Y,Z format. Here is a list of the available color numbers:

<table>
<thead>
<tr>
<th>Color Number</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Black</td>
</tr>
<tr>
<td>1</td>
<td>Blue</td>
</tr>
<tr>
<td>2</td>
<td>Green</td>
</tr>
<tr>
<td>3</td>
<td>Cyan</td>
</tr>
<tr>
<td>4</td>
<td>Red</td>
</tr>
<tr>
<td>5</td>
<td>Magenta</td>
</tr>
<tr>
<td>6</td>
<td>Brown</td>
</tr>
<tr>
<td>7</td>
<td>Light Gray</td>
</tr>
<tr>
<td>8</td>
<td>Dark Gray</td>
</tr>
<tr>
<td>9</td>
<td>Light Blue</td>
</tr>
<tr>
<td>10</td>
<td>Light Green</td>
</tr>
<tr>
<td>11</td>
<td>Light Cyan</td>
</tr>
<tr>
<td>12</td>
<td>Light Red</td>
</tr>
<tr>
<td>13</td>
<td>Light Magenta</td>
</tr>
<tr>
<td>14</td>
<td>Yellow</td>
</tr>
<tr>
<td>15</td>
<td>White</td>
</tr>
</tbody>
</table>

The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space
delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new
polyline. The DTM and Idan formats create linework files for the DTM and Idan programs.

Prompts

Polyline file format [<Carlson>/DTM/Idan/MicroStation]? press Enter for Carlson format
Specify File to Write dialog create a new file or append to existing
Polyline file for Grid File Utilities macro [Yes/<No>]? press Enter The option will write a polyline file that can
be used with Grid File Utilities for inclusion/exclusion perimeters.
Include Z coordinate in polyline file [Yes/<No>]? press Enter This option controls whether the polyline vertices
are written in 2D or 3D.
Specify Exclusion/Warning Polylines [Yes/<No>]? press Enter This option applies to machine control for
warning areas.
Specify WorkZone Polylines [Yes/<No>]? press Enter This option applies to machine control for working areas.
Reduce Polyline Vertices [<Yes>/No]? press Enter This option applies Reduce Polyline to the polyline vertices
before writing the file.
Enter reduce offset cutoff <0.1>: press Enter
Decimal places for coordinates <2>: press Enter
Select polylines, lines and arcs to write.
Select objects: pick the entities to process
Done.

Sample Polyline File:

POLYLINE,15
47639.82,74540.11,0.00
47670.49,74565.79,0.00
47701.08,74591.49,0.00
49375.61,76358.47,0.00
50066.86,76846.75,0.00

POLYLINE,15
47633.24,74547.97,0.00
47663.90,74573.65,0.00

etc...

Keyboard Command: polywrite
Prerequisite: Polylines in the drawing

Export Google Earth File

The Export Google Earth File allows you to produce a KML (Keyhole Markup Language or alternatively a KMZ)
file of points, polylines, text, solids, images, lines and arcs for rendering in other mapping and GIS applications such
as Google Earth and Google Maps. Throughout this discussion, KML will be used to also describe KMZ files unless
explicitly noted.
**Drape on Google Terrain (2D):** When this option is selected, entities written to the KML file will have an Altitude setting of "Clamped to ground."

**Use Elevation from the Drawing (3D):** When this option is selected, entities written to the KML file will have an Altitude setting of "Absolute."

**Line Width (pixels):** Indicate how wide selected linework should be when viewed in Google Earth. The higher the value, the thicker the line.

**Include Selected Points:** When enabled, this option exports selected Carlson point information to the KML `<Placemark><Point>...</Point></Placemark>` tag structure. For the Google placemark, you can choose between using the point number, elevation or description.

**Include Selected Text:** When enabled, this option exports selected Text and MText entities to the KML `<Placemark><Point>...</Point></Placemark>` tag structure.

**Include Layer Information:** When enabled, this option organizes exported information based on the layer of each entity, with each CAD layer becoming a KML `<Folder>...</Folder>` entry with the color of the group taking the general color of the CAD layer.

**Shade Closed Regions:** When enabled, all closed polyline regions (e.g. building pads, ponds, etc) will be fill-shaded.

**Include Solids and Images:** When enabled, Solid entities and Images are included in the KML as `<Placemark><Polygon>...</Polygon></Placemark>` and/or `<GroundOverlay>...</GroundOverlay>` tags, respectively.

**Export to KMZ Format:** When enabled, the KML file is written to the more compact (zipped) KMZ version of the standard KML file format.

**Display Results in Google Earth:** When enabled, the results of the KML are passed to and automatically opened with Google Earth. To setup for running Google Earth Pro, go to Windows Start > Default Programs > Associate File Type With Program and assign KML and KMZ file types to Google Earth Pro.

**Share Results through Dropbox:** When enabled, the results of the KML are passed to a personal DropBox account.

**Include GIS Data:** When enabled, GIS attribute data associated with selected entities will be populated into the
KML file. GIS attribute data can be imported via the Import SHP File command (see the Sample Esri Data note below) or manually assigned with the Input-Edit GIS Data command or the Set Google Tags command. Upon specifying the KML file to output, the Quick View Settings dialog box of the GIS Inspector command may display:

1. Select a desired GIS Feature from the upper-left of the dialog box.
2. Add the desired Attributes to the display list using a double-click action or clicking the Add Attribute button.
3. Indicate a desired Attribute to serve as the Placemark Name and use the Use as Placemark Name button to set it.

Upon exiting from the dialog box, available GIS Data on a per-entity basis will be populated into the KML file:
Linework Opacity: Use the horizontal slider control to indicate the desired level of opaqueness that should be applied to linework entities. A lower opacity results in increased entity transparency and is helpful for viewing underlying map data found in applications such as Google Earth.

Solids and Images Opacity: Use the horizontal slider control to indicate the desired level of opaqueness that should be applied to Solids and Image entities. A lower opacity results in increased entity transparency and is helpful for viewing underlying map data found in applications such as Google Earth.

Note:

- When the *Use Elevations from the Drawing (3D)* option is selected, be aware that elevation values lower than the Google Earth terrain may be obstructed in the Google Earth display.
- Attribute information (*e.g.* Number, Elevation, Description) of selected Carlson points are also written to the KML and will display in the "balloon" when a point is picked in the Google Earth display or data hierarchy.
- The formatting of any selected MText entities is not propagated into the KML/KMZ file.
- When the *Shade Closed Regions* toggle is enabled, note that all closed polyline regions will become fill shaded and may lead to undesired results for items such as closed contours.
- When *Image* entities are included, the size of the image itself is incorporated into the KMZ file and my significantly swell the size of the KMZ file which may result in lengthy load times into other applications.
- To have results posted to Dropbox, the Dropbox Application for Windows must be first installed to your PC using its default folder specification for the location of shared/synchronized folders/files.
- When prompted for the name of the KML/KMZ file to write, the appropriate KML or KMZ file extension based on the *Export to KMZ Format* toggle will be added to the file if the file extension is not specified.
- Arcs and polylines with arcs are converted into chord segments that closely approximate the arc(s).
- Other entities not supported for direct export to a KML file (*e.g.* circles, ellipses, splines, multilines, *etc*), can be first turned into polylines with the Entities to Polylines command.
- Sample Esri data of the United States in Shape File form can be freely downloaded and explored.
- The graphical symbology of any/all items sent to the KML file can be manually modified via the Google Earth interface.

Prompts

Select points, polylines, text, solids, images, lines and arcs to write.

*Filter/<Select entities>*: Select the desired entities and press Enter when complete.

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.

Pull-down Menu Location(s): File > Export

Keyboard Command: kmlwrite

Prerequisite: Points, lines or polylines in the drawing with an established projection zone through Drawing Setup.
Edit Menu
Redo
This command allows you to reverse the effects of the previous UNDO command.

Prerequisite: None
-keyboard command: REDO

Clipboard
This command allows for different cut, copy, and paste options.

Cut
To cut objects to the Clipboard.
- Select the objects you want to cut.
- From the Clipboard command, choose Cut.
The objects are available to be pasted into other Windows applications.

Copy
To copy objects to the Clipboard.
- Select the objects you want to copy.
- From the Clipboard command, choose Copy.

Copy with Base Point
To copy objects to the Clipboard. When the objects are pasted into a drawing, the program places them relative to the specified base point.
- Select the objects you want to copy.
- From the Clipboard command, choose Copy with Base Point.
- Specify the base point.

Paste
The objects currently on the Clipboard are pasted into the drawing at the specified insertion point.
- From Clipboard command, choose Paste.

Paste as Block
The objects currently on the Clipboard are pasted into the drawing as a block at the specified insertion point.
- From Clipboard command, choose Paste as Block.

Paste to Original Coordinates
The objects currently on the Clipboard are pasted into the drawing using the coordinates from the original drawing.
Erase

Erase Select

This command allows you to remove objects from a drawing.

**Prerequisite:** None

**Keyboard Command:** ERASE, E

Erase by Layer

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the **Select Layers from Screen** button and then select the entities on the layers to be deleted. The **Select Layers by Name** button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline. The **Save** and **Load** buttons save and recall the layer names.

![Erase by Layer/Type](image-url)
Pulldown Menu Location: Edit > Erase  
Keyboard Command: ldel  
Prerequisite: Something to erase

**Erase by Closed Polyline**

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.

First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog. The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.

In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

Pulldown Menu Location: Edit > Erase  
Keyboard Command: erasepline  
Prerequisite: Entities and a closed polyline
Erase Outside
This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

Prompts

**Pick 1st corner of window to erase outside of:** Pick point location
**Pick 2nd corner:** Pick second point location
**Pulldown Menu Location:** Edit > Erase
**Keyboard Command:** eraseout
**Prerequisite:** Entities to erase

Move
This command allows you to displace objects a specified distance in a specified direction.

**Prerequisite:** None
**Keyboard Command:** MOVE, M

Copy

**Standard Copy**
This command copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing as an OLE object.

You can also use CTRL+C to run this command. If the cursor is in the drawing area, Carlson TakeOff copies the selected objects to the Clipboard. If the cursor is on the command line or in the text window, the program copies the selected text to the Clipboard.

**Prerequisite:** None
**Keyboard Command:** COPY

Copy To Layer
This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).
Prompts

Select entities to copy.
Select objects: select entities
Select Layer dialog select a layer from list and click OK
Pulldown Menu Location: Edit > Copy
Keyboard Command: copy2layer
Prerequisite: Entities to be copied

Offset

Offset
This command creates a new object at a specified distance from an existing object or through a specified point. Offset does not support 3D polylines. Use Offset 3D Polyline to offset these entities.

Prompts
1 Specify offset distance or [Through] <Through>: Press Enter
The Through option allows you to screen pick the location of the offset. You can also enter a value for the interval of the offset.
2 Select object to offset or <exit>: select entity
3 Specify through point: pick point

Menu Location: Edit
Prerequisite: None
Keyboard Command: OFFSET

Offset To Layer
This is a command to offset a polyline and put the offset polyline into a separate layer from the original polyline. The Offset Both Sides For Open Polylines option can be used to create easement perimeters. For example, you can pick a pipe polyline and this option will offset to both sides to create an easement around the pipeline.
Prompts

Offset To Layer dialog
Select object to offset: pick a polyline to offset
Specify point on side to offset: pick a point
Select a polyline to offset (Enter to end): press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_layer
Prerequisite: Linework to offset

Offset to Area

This command offsets a polyline by a distance that results in creating the specified target area. The source polyline should represent the frontage on the area. There is an option to connect the sides between the source and offset polylines to make a closed polyline.

Prompts

Pick line or polyline to offset: pick a polyline
Select side to offset: pick a point on the offset side
Keep existing polyline [Yes/<No>? press Enter
Create closed polyline [<Yes>/No]? press Enter
Acres/<Enter target area (s.f.)>: 90000

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_area
Prerequisite: polyline to offset

Multiple Offsets

This command applies the same offset multiple times in series from the original polyline.

Prompts
Specify offset distance <20.0000>: 25
Enter Number of Repetitions <1>: 3
Select object to offset or <exit>: pick a polyline to offset
Specify point on side to offset: pick a point

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_mult
Prerequisite: Linework to offset

**Median Offset**

This command creates a median polyline that is offset halfway between two existing polylines. For example, this command can be used to get the center of a river given polylines for the left and right river banks. The intersection method finds where the offsets from the two reference polylines intersect. The Salient and Normal methods come from the CAPD program originally developed by the BLM.

**Prompts**

Select the First Polyline: pick a polyline
Select the Second Polyline: pick a polyline
Draw Chords of Parabolas [Yes/<No>]? press Enter
Draw Perpendiculars for Check [<Yes>/No]? press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: medoff
Prerequisite: two polylines to offset
Variable Offset

This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

Prompts

Vary offsets by line segments or at points [<Line>/Point]? press Enter
Select a polyline to offset (Enter for none): pick polyline
Select side to offset: pick a point on the side to offset to
As you go from segment to segment, you can enter in different offset values for each line segment.
Enter the segment horizontal offset <0.000>: 56
Enter the segment horizontal offset <56.000>: 33
Enter the segment horizontal offset <33.000>: 12
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: VOFFSET
Prerequisite: A polyline to offset

Buffer Offset

This command offsets a polyline, and maintains a fixed distance from the original polyline by placing an arc on convex corners. The standard Offset command can actually have a distance greater than the offset at corners. In the example shown, the distance between the corners of the original and offset polylines is 70.01, while the offset distance is 50.0. Buffer Offset makes an offset polyline that doesn't exceed the offset distance. This is useful when you want an offset that goes no further than the offset distance, such as wetland offsets. Later versions of AutoCAD can achieve the same effect using the standard Offset command by changing the system variable OFFSETGAPTYPE to 1.

Prompts

Enter the offset amount: 50
Select object to offset: pick the original polyline
Specify point on side to offset: pick a point on the side to offset to

Regular Offset
Buffer Offset

Pulldown Menu Location: Edit > Offset
Keyboard Command: boffset
Prerequisite: A polyline to offset
Explode

Standard Explode

This command allows you to break a compound object into its component objects. Results differ depending on the type of compound object you're exploding. The following is a list of objects that can be exploded and the results for each.

- **All Explodable Objects**: Produces object geometry that may look the same, but the color, linetype, and lineweight of the object may change.

- **Block**: Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.

When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a "+E" prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the attribute values and redisplays the attribute definitions.

- **2D and Lightweight Polyline**: Discards any associated width or tangent information.

- **Wide Polyline**: Places the resulting lines and arcs along the center of the polyline. TakeOff discards any associated width or tangent information.

- **3D Polyline**: Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.

- **Text Explode to Polylines**: Explodes polylines depending on the font used for various annotations, this can make the resulting polylines more efficient in terms of vertex count.

- **Leaders**: Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), Mtext, or tolerance objects, depending on the leader.

- **Mtext**: Explodes into text entities

- **Multiline**: Explodes into lines and arcs.

- **3D Solid**: Explodes planar surfaces into regions. Nonplanar surfaces explode into bodies.

- **Region**: Explodes into lines, arcs, or splines.

- **Body**: Explodes into a single-surface body (nonplanar surfaces), regions, or curves.

- **Polyface Mesh**: Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.

- **Circle Within a Nonuniformly Scaled Block**: Explodes a circle within a nonuniformly scaled block into ellipses.

- **Arc Within a Nonuniformly Scaled Block**: Explodes an arc within a nonuniformly scaled block into elliptical arcs.

**Prerequisite**: None

**Keyboard Command**: EXPLODE, X
Block Explode

This command retains the values of attributes when a block is exploded. The standard *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Pulldown Menu Location:** Edit  
**Keyboard Command:** explode2  
**Prerequisite:** A block to be exploded

---

Trim

This command allows you to trim objects at a cutting edge defined by other objects.

**Prompts**

1. Select cutting edges ...

   Select objects: **pick entity**

2. Select object to trim or shift-select to extend or [Project/Edge/Undo]: **select entity to be trimmed**

   - **Project:** You can project the object to be trimmed in order to trim objects that do not intersect.
   - **Edge:** You can project the trimming edge in order to trim objects that do not intersect.
   - **Undo:** This option allows you to undo the above projections.

**Prerequisite:** None  
**Keyboard Command:** TRIM, TR

---

Extend

Extend To Edge

This command allows you to extend an object to meet another object.

**Prompts**

1. Select boundary edges ...

   Select objects: **pick entity**

2. Select object to extend or shift-select to trim or [Project/Edge/Undo]: **pick entity**

   You have the option of trimming or projecting objects and edges.

**Prerequisite:** None  
**Keyboard Command:** EXTEND

---

Extend to Intersection

This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

**Prompts**
Select first line or polyline to extend: *pick a line or polyline*
Select second line or polyline to extend: *pick another line or polyline*

Before Extend to Intersection

After Extend to Intersection

**Pulldown Menu Location:** Edit > Extend

**Keyboard Command:** extint

**Prerequisite:** Two lines or polylines

---

**Extend by Distance**

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.

The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

- **# - Number:** Distance to draw or extend
A# - Angle change: Rotates pointer by specified number of degrees
A - Align: Rotates pointer to align with segment
B - Bearing: Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)
C - Close: Closes the polyline
D - Draw Mode: Actions draw or extend the line or polyline
E - Extend to Edge: Extends to intersection with a selected line or polyline
I - Input mode: Toggles distance input between decimal feet and feet-inches
L - Left rotate: Rotates counterclockwise 90 degrees
M - Move Mode: Actions only move the pointer
N - Next: Moves pointer forward to next point
O - Open: Opens the polyline
P - Previous: Moves pointer backward to previous point
R - Right rotate: Rotates clockwise 90 degrees
S - Switch: Reverses pointer direction
T# - Total distance: Sets current segment to specified distance
U - Undo: Undo the last Extend by Distance command
Z - Zoom mode: Toggles auto-zoom between on/off
? - Info: Displays lengths of current polyline

H - Help: The Help option also displays this Extend by Distance Commands list.
Press <Enter>: Ends the routine

The result of using the Info (?) feature

Prompts

Select line or polyline to extend: select line or polyline near the place to extend
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units. Use the Pick option to pick a distance.
Pick/Horizontal Distance to Extend ([Enter] for new line): R Rotate right 90 degrees.
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units. Use the Pick option to pick a distance.
Extend another (<Yes>/No)? No
Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

**Pull-down Menu Location:** Edit > Extend  
**Keyboard Command:** extender  
**Prerequisite:** An existing line or polyline with at least one segment from which to start.

## Break

### by Crossing Polyline

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

### Prompts

Select the clip edge polyline: *pick a closed polyline*  
Select the polylines and lines to be clipped.  
Select Objects: *pick the entities to break*  
Specify layer names for Inside segments (Yes/No)? *Yes*  
Enter a layer name for the Inside segments <0>: *press Enter*  
Specify layer names for Outside segments (Yes/No)? *Yes*  
Enter a layer name for the Outside segments <0>: *Final*
Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: select polyline

Total Distance: 779.429 This is the length of the polyline reported.
Distance Along Polyline For Break: 55.0
Distance Along Polyline For Break (Enter to end): 110
Distance Along Polyline For Break (Enter to end): 165
Distance Along Polyline For Break (Enter to end): press Enter
3 polyline breaks created.
Select Object, Two Points

This command allows you to break an object by selecting the object, then two points. First select the object, then the program will prompt you to select two points that define where the object will be broken.

Prompts

1 Select object: select entity to break
2 Specify second break point or [First point]: First
3 Specify first break point: pick first point
4 Specify second break point: pick second point

At Intersection

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the Area by Lines & Arcs command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

Prompts

Select Line, Arc, or Polyline to Break
Select object: select object to break
[int on] Pick Intersection to break at: pick intersection point
Pulldown Menu Location: Edit > Break
Keyboard Command: breakat

At Selected Point

This command allows you to break an object by selecting the object. Only one pick is necessary since TakeOff both selects the object and treats the selection point as the break point.

Prompts

1 Select object: select entity to break
Select an object to break
Prerequisite: None
Keyboard Command: BREAK

Rotate

By Bearing

This command allows you to move objects about a base point by a given bearing.

Prompts

1 Select entities to rotate.
Select objects: pick entities
2 Base pivot point?
Pick point or point number: pick a point
3 Reference Bearing point?
Pick point or point number: **pick a point**

4 Azimuth/<New Bearing (Qdd.mmss)>: **enter a bearing**

**Prerequisite:** None

**Keyboard Command:** BROT

---

**Standard Rotate**

This command allows you to move objects about a base point using a point as a rotation reference.

**Prompts**

1. Select objects: **pick entities**
2. Specify base point: pick point on screen as reference
3. Specify rotation angle or [Reference]: **rotate to desired location**

**Prerequisite:** None

**Keyboard Command:** ROTATE

---

**Standard Scale**

This command allows you to enlarge or reduce selected objects equally in the X, Y, and Z directions.

**Prompts**

1. Select objects: **pick entities**
2. Specify base point: pick point on screen as reference
3. Specify scale factor or [Reference]: **scale to desired size**

**Prerequisite:** None

**Keyboard Command:** SC

---

**Align**

**2D Align**

This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the standard Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.
**Prompts**

Select entities to align.

Select objects: *pick entities to process*

First Source Point?
Pick point or point number: *pick point 84*

First Destination Point?
Pick point or point number: *pick point 18*

Second Source Point?
Pick point or point number: *pick point 85*

Second Destination Point?
Pick point or point number: *pick point 19*

Scale factor: 1.00434258
Scale objects based on alignment points [Yes/<No>]? Y

This command DOES NOT change the coordinates in the CooRDinate file!
Use Coordinate File Utilities menu, Update CRD File from Drawing.

**Pulldown Menu Location:** Edit > Align

**Keyboard Command:** scalign

**Prerequisite:** None
**Standard Align**

Aligns objects with other objects in 2D and 3D

You use ALIGN to move, rotate, or scale objects into alignment with other objects. Add source points to the objects you want to align, and add destination points to the objects to which you want the source objects to align. You can add up to three pairs of source and destination points to align an object.

The first set of source and destination points defines the base point for the alignment. The second set of points defines the angle of rotation.

When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

If you use two source and destination points to perform a 3D alignment on nonperpendicular working planes, you get unpredictable results.

After you enter the points, Takeoff prompts you to scale the object. The program uses the distance between the first and second destination points as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

**Prompts**

1 Specify first source point: **pick point**
2 Specify first destination point: **pick point**
3 Specify second source point: **pick point**
4 Specify second destination point: **pick point**
5 Specify third source point or <continue>: **Press Enter**
6 Scale objects based on alignment points? [Yes/No] <N>: **Press Enter**

**Prerequisite**: None

**Keyboard Command**: ALIGN

**Text**

**Edit Text**

This command allows you to edit text and attribute labels.

1 Select Text to Edit: **select the text**

You can modify text in provided text field.

**Prerequisite**: Text

**Keyboard Command**: EDITXT

**Find and Replace Text**

With this command, you can find, replace, select, or zoom to text contained in the current drawing.

**Keyboard Command**: find

**Prerequisite**: Text
Text Enlarge/Reduce

This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

**Pulldown Menu Location:** Edit > Text
**Prerequisite:** Text entities to be changed
**Keyboard Command:** txtenl

Change Text Font

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name, you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.

**Pulldown Menu Location:** Edit > Text
**Keyboard Command:** chgtxtstyle
**Prerequisite:** Text entities to be changed

Text Explode To Polylines

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the Write Polyline File command.

**Prompts**

*Select text to be EXPLODED.*
*Select objects: select the text*
*Substitute With Simple Font [<Yes>/No]? Y*
*1 text object(s) have been exploded to lines.*
*The line objects have been placed on layer 0.*
*Reading the selection set ...*
*Joining ...*
*Converting ...*
Image

**Image Frame**

This command controls whether TakeOff displays the image frame or hides it from view.

Because you select an image by clicking its frame, setting the image frame to off prevents you from selecting an image.

**Prompts**

1. Enter image frame setting [ON/OFF] <current>: **enter an option or Press Enter**
   - **On**: Displays image frames so you can select images.
   - **Off**: Hides image frames so you cannot select images.

**Prerequisite**: None

**Keyboard Command**: IMAGEFRAME

Image Clip

This command allows you to create new clipping boundaries for an image object.

**Prompts**

1. Select image to clip: select the edge of an image
2. Enter image clipping option [ON/OFF/Delete/New boundary] <New>: **enter an option or Press Enter**

The boundary you specify must be in a plane parallel to the image object.

- **On**: Turns on clipping and displays the image clipped to the previously defined boundary.
- **Off**: Turns off clipping and displays the entire image and frame. If you reclip the image while clipping is turned off, the program automatically turns clipping back on. The program prompts you to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
- **Delete**: Removes a predefined clipping boundary and redisplays the full original image.
- **New Boundary**: Specifies a new clipping boundary. The boundary can be rectangular or polygonal, and consists only of straight line segments. When defining a clipping boundary, specify vertices within the image boundary. Self-intersecting vertices are valid. Rectangular is the default option. If you use the pointing device to specify a point at the Enter Clipping Type prompt, the program interprets the point as the first corner of a rectangle.

3. Enter clipping type [Polygonal/Rectangular] <Rectangular>: **enter P or Press Enter**
   - **Polygonal**: Uses specified points to define a polygonal boundary.

Specify first point: Specify a point
Specify next point or [Undo]: **specify a point or enter u**
Specify next point or [Undo]: **specify a point or enter u**
Specify next point or [Close/Undo]: **specify a point, or enter c or u**
You must specify at least three points to define a polygon.

If the image already has a clipping boundary defined, TakeOff displays the following prompt:
Delete old boundary? [No/Yes] <Yes>: enter N or Press Enter
If you choose Yes, the program redraws the entire image and the command continues; if you choose No, the command ends.

- **Rectangular**: Specifies a rectangular boundary by its opposite corners. TakeOff always draws the rectangle parallel to the edges of the image.

Specify first corner point: **specify a point**
Specify opposite corner point: **specify a point**

**Prerequisite**: None
**Keyboard Command**: IMAGECLIP

**Image Adjust**
This command controls the display of the brightness, contrast, and fade values of images.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Brightness</strong></td>
<td>Controls the brightness, and indirectly the contrast, of the image. Values range from 0 through 100. The greater the value, the brighter the image and the more pixels that become white when you increase contrast. Moving the slider to the left decreases the value; moving the slider to the right increases the value.</td>
</tr>
<tr>
<td><strong>Contrast</strong></td>
<td>Controls the contrast, and indirectly the fading effect, of the image. Values range from 0 through 100. The greater the value, the more each pixel is forced to its primary or secondary color. Moving the slider to the left decreases the value; moving the slider to the right increases the value.</td>
</tr>
<tr>
<td><strong>Fade</strong></td>
<td>Controls the fading effect of the image. Values range from 0 through 100. The greater the value, the more the image blends with the current background color. A value of 100 blends the image completely into the background. Changing the screen background color causes the image to fade to the new color. In plotting, the background color for fade is white. Moving the slider to the left decreases the value; moving the slider to the right increases the value.</td>
</tr>
<tr>
<td><strong>Image Preview</strong></td>
<td>Displays a preview of the selected image. The preview image updates dynamically to reflect changes to the brightness, contrast, and fade settings.</td>
</tr>
<tr>
<td><strong>Reset</strong></td>
<td>Resets values for brightness, contrast, and fade to default settings (50, 50, and 0, respectively).</td>
</tr>
</tbody>
</table>

**Prerequisite**: None
**Keyboard Command**: IMAGEADJUST

The Image Adjust dialog box controls how the image is displayed by adjusting the brightness, contrast, and fade settings of the selected image. Adjusting these values changes the display of the image but does not change the image file itself.
Selection Sets

Select Similar
This command creates a selection set of all entities in the drawing with properties that match the selected entity. The properties filter uses the entity type and layer name. To use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: selectsim
Prerequisite: None

Select by Filter
This command can be used to build a selection set of objects inside a drawing based on properties of layer, level, entity type, style, linetype, size and color. The open/closed filter applies to polylines. There is a dialog to define the filter of which properties to include and exclude. The Entities To Process option chooses between checking the entire drawing or prompting for a selection to process with the filter. The program then builds a selection set of those objects that resides on those layers. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

![Select By Filter dialog](image)

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: fsel
Prerequisite: None

Select by Elevation
This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select by greater, less or between elevations [<Greater>/Less/Between]? press Enter
Enter elevation for greater than: 19
Ignore zero elevations [<Yes>/No]? press Enter
Select objects to build selection set. pick objects
Processing selection set ...
Built selection of 120 objects for elev more than 19.00.
To use type 'P' at Select objects: prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: zselect
Prerequisite: Entities

**Select by Length**

This command builds a selection set of linework objects in the drawing based on linework length. The length filter can be setup to get linework greater than or less than the specified value, or between two length values. After specifying the length criteria, the program prompts for selecting the linework to check. The program then builds a selection set of those objects that pass the length filter. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:” prompt.

**Prompts**

Select by greater, less or between lengths [<Greater>/Less/Between]? press Enter
Enter length for greater than: 1000
Select objects to build selection set.
Select objects: pick linework to filter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: lenselect
Prerequisite: None

**Select by Block**

This command builds a selection set of blocks by using a block name filter. The block name to match is specified in a dialog with a list of all the block names in the drawing. Either pick from the list or use the Select From Screen button to get the block name by picking a block in the drawing. After selecting the block name, pick OK and the program will report how many of those blocks were found in the drawing and put into the selection set. This selection set is then ready to use at the next command with a select objects prompt. To use the selection set, type 'P' at the select objects prompt.

![Select By Block](image-url)
Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick the closed polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Type of selection (Window/<Crossing>)? press Enter
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: press Enter
Built selection set with 43 objects.
Command: Erase
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: press Enter

Join Nearest

This command joins lines, arcs and/or polylines together. While the PEDIT-Join command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.
Max Separation to Join: Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.

Max Deflection Angle (degrees): This option will not join any lines if the angle between them is greater than this angle in degrees.

Connection Method: Determines how to connect the endpoints. See the illustration below.

1. **Average Endpoints Together**: New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. **Directly Connect Endpoints**: Original endpoints are connected with new segment (see the middle illustration below).
3. **Fillet with Radius Zero**: Same as the `FILLET` command using zero radius (see the illustration on right).

Convert Lines and Arcs Into Polylines: When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

Join Across Intersections: This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

Join Only Identical Widths: When checked, only polylines with the same width will be joined.

Join Only Identical Layers: When checked, only entities on the same layer will be joined. Join Only Identical Colors: When checked, only entities with the same color will be joined.

Join Only Identical Linetypes: When checked, only polylines with the same linetype will be joined.

Join Only Common Elevations: When checked, only endpoints located on the same elevation will be joined.

Different Layer Prompt: When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.

Different Elevation Prompt: When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.

Elevate Zero Elevations When Joined To Elevated: This option applies when joining a combination of linework at elevation and linework at zero elevation. When checked, zero elevation vertices will get assigned the elevations from connected neighboring vertices.
**Perimeter Polyline Properties**

This command allows you to control the properties of any perimeter polyline (Note: Perimeter polylines also have to be closed polylines). Select a polyline and the following dialog appears. Here you can define the functionality of the polyline in regards to, the Site Boundary, Areas of Interest, and Topsoil Removal/Replacement. These properties can also be set separately using the Boundary Polyline, Areas of Interest, and Topsoil Removal/Replacement commands found under the Tools menu of Carlson Takeoff.

**Prerequisite:** a polyline

**Keyboard Command:** `perim_prop`

**Polyline Entities**

**Entities to Polylines**

This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multiline, regions and solids into individual polylines. Use `Join Nearest` to convert adjoining lines and arcs into continuous polylines.
Prompts

Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: select entities
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: topline
Prerequisite: lines, arcs or other entities to convert

Reverse Polyline
This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands Station Polyline, MXS by Polyline, Profile from Surface Model or CL File from Polyline, since the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the Reverse Polyline command to change its order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

Prompts

Select the Polyline to Reverse: pick a point on polyline
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: revpline
Prerequisite: A polyline

Reduce Polyline Vertices
This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a polyline with three points in a straight line, the middle point can be removed without changing the polyline.

Prompts

Enter the offset cutoff <0.1>: .5
Select polylines to reduce.
Select objects: pick polylines
Processed polylines: 1
Total number of vertices: 10
Number of vertices removed: 1
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: reduce
Prerequisite: A polyline

Densify Polyline Vertices
This command adds vertices to the selected polylines at the specified interval. These points are interpolated between existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.
Prompts

Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity> 1
Added 17 points to 1 polyline.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline

Smooth Polyline
This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. Either the entire polyline can be smoothed or only a section of the polyline. When using Polyline Section, the program will prompt for points along the polyline to start and end the smoothing. The Looping Level controls smoothing amount. A higher factor gives more looping. The Offset Cutoff (After Smooth) is used to reduce the number of vertices in the final polylines. To not reduce vertices, set this Offset Cutoff to zero. The Offset Cutoff is the maximum amount that the polyline can move horizontally when removing a point. The Reduce Polylines Before Smoothing option removes extra vertices from the contours before smoothing. Removing points before smoothing gives the Bezier smoothing more freedom to make the polylines curvy.

Prompts

Smooth Polylines dialog
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline

**Draw Polyline Blips**

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual location of each vertex. The Blips can be drawn as temporary marks or lines. The lines method creates line entities that can be cleared from the drawing using Remove Polyline Blips. For temporary marks, any change to the viewport (pan, zoom, regen) will make the blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will remain visible during and after viewport changes.

Prompts

**Draw as temporary marks or lines [Temporary]/Lines\]? press Enter**
Select polylines to draw blips.
Select objects: select polyline(s)

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
Prerequisite: A polyline

**Join Polyline By Trace**

This command combines linework entities to create a polyline. This command is similar to Join Nearest. The difference is that this command processes a single polyline at a time instead of a selection set of polylines. This
command prompts for a linework entity to start joining from. Then the program looks in the drawing at other linework to join to this polyline using the filter options from the dialog. All the options in the dialog are the same as Join Nearest except the Prompt For Linework To Join option which prompts for other linework to join to the polyline once the program has finished tracing. See the Join Nearest section of the manual for descriptions of the other options.

Prompts

Join Polyline By Trace dialog
Select line, arc or polyline to join: pick an entity
Select entity to join to start (Enter for none): press Enter
Select entity to join to end (Enter for none): press Enter

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: joinpoly
Prerequisite: Linework to join

Join Two Polylines
This command combines two linework entities to create a polyline. This command is simple variation of the Join Nearest command. The difference is that there is no options dialog and only two linework entities are processed. The linework entities can be polylines, lines or arcs. At the first entity prompt, you can enter Options to set the connection method for how to bridge a gap between the linework. The Direct method creates a segment across the gap. The Average method averages the endpoints into a single vertex. The Fillet method does a fillet with radius of zero.

Prompts

Select 1st entity to join [Options]: pick polyline
Select 2nd entity to join: pick polyline

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: join2
Prerequisite: Linework to join

Merge Closed Polylines
This command combines two closed polylines that share a common boundary to create a single closed polyline. For example, this command can be used to merge a polyline for a lot that is too small with a polyline for a neighboring lot. There are two methods for merging. One method is to pick the two polylines to merge. The other method takes an area size and selection set of polylines and merges all the polylines with an area smaller than the specified amount.
Prompts

Select polylines by individual pick or size filter [Pick>/Size]? press Enter
Pick 1st closed polyline to merge: pick a polyline
Pick 2nd closed polyline to merge: pick a polyline
Done.
Pick 1st closed polyline to merge (Enter to end): press Enter

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: mergepl
Prerequisite: two polylines to offset

Edit Polyline

Add Intersection Points
This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-Annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompts

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Add Polyline Arcs

This command replaces a series of short chord line segments in a polyline with an arc segment. This applies where you want to have a true arc instead of a series of line segments. In some cases, the CAD drafting has the arcs drawn as a series of short chords. Another application is to create an arc out of a series of connected survey points along the curve. The routine works by searching for a series of polyline vertices that fit within the specified tolerance with a best fit curve.

The options dialog allows you to set the layer for the new polylines. Otherwise the original polyline layer is used. There is an option whether to keep or erase the original polylines. The Snap Tolerance is the maximum offset allowed between the original points and the arc.

Prompts

Add Arcs to Polylines dialog
Select polylines to process.
Select entities: pick the polylines
Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal distances, the coordinates will change.

![Edit Polyline Vertex dialog](image)

Prompts

Select polyline to edit: *pick a polyline*

Pick point on polyline to edit: *pick a point to be modified*

Edit Polyline Vertex dialog *click “Pick Position”*

Pick vertex position: *pick a new location for the vertex*

Edit Polyline Vertex dialog *click OK*

Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.

Select polyline to edit (Enter to end): *press Enter to end*

Pulldown Menu Location: Edit > Polyline Utilities

Keyboard Command: editpl

Prerequisite: A polyline
Edit Polyline Section

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

Prompts

Select polyline to edit: *pick the polyline at the place to start editing*
Pick intermediate point (Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *press Enter*
Pick reconnection point on polyline: *pick the polyline at the place to join*

Contour with segment replaced with new points

Change Polyline Width

This command sets the width of the selected polylines. In later versions of AutoCAD, the command `PEDIT` can also modify the width of multiple polylines.

Prompts

New width <1.0>: 2
Select Polylines/Contours to change width of:
Select objects: *pick polylines*

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline

Keyboard Command: cwidth

Prerequisite: A polyline

---

**Set Polyline Origin**

This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.

**Prompts**

Select Polyline: *pick a polyline*

Pick Near New Origin Point: *pick a point on the polyline to be the starting point*

Processing ...

Select Polyline: *press Enter*

---

**Close Polyline**

This command allows you to close a selection set of open polylines.

Prerequisite: Open polyline(s).

Keyboard Command: CLOSEPL

---

**Open Polyline**

This command allows you to open a selection set of closed polylines.

Prerequisite: Closed polyline(s).

Keyboard Command: OPENPL

---

**Remove Polyline**

**Remove Duplicate Polylines**

This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

**Prompts**

Select lines, arcs and polylines to process.

Select objects: *select linework to process*

Reading the selection set ...

Removed 1 duplicate linework entities.

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline

Keyboard Command: rmduplwork

Prerequisite: Polylines that have duplicates
Remove Polyline Arcs

This command replaces arc segments in polylines with a series of chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. There are three methods to control the size of the chords and how many vertices are created. The Offset cutoff sets the maximum distance any point on the arc will be allowed to shift from the true arc to the chord position. The Length method sets the chord length. With the Length method, you can choose to create the chords entirely on the left or right side. Without setting the side, the program puts the chords on the inside of the arcs. The Count method sets how many chords to replace each arc with.

Prompts

Select polylines to remove arcs from.
Select objects: pick polylines
Use max offset or chord length method [<Offset>/Length]? press Enter for Offset method
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs

Remove Polyline Segment

This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.
Prompts

Break polyline at removal or keep continuous (Break/<Continuous>)? press Enter
Select polyline segment to remove: pick point on polyline
Select polyline segment to remove: press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: removepl
Prerequisite: A polyline

Remove Polyline Vertex

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete, press Enter when you are done.

Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Prerequisite: A polyline

Check Polylines

Check Elevation Range

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is
outside of the range will be highlighted with an X.

**Prompts**

Enter elevation range minimum: 0  
Enter elevation range maximum: 4900  
Select polylines to check.  
Select objects: pick polylines to process  
Found 1 polylines outside of elevation range.  
Set polylines outside elevation range to zero elevation [Yes/<No>]? N

**Pulldown Menu Location:** Edit > Polyline Utilities  
**Keyboard Command:** checkpl  
**Prerequisite:** Polylines with elevations

---

### Highlight Non-Perpendicular Intersections

This command highlights selected polylines that have T-intersections with other polylines that are non-perpendicular. For example, this command can be used to check that side lines for lots are perpendicular to the frontage polyline. For every non-perpendicular intersection, a temporary graphic arrow is drawn and the angle and the coordinates of the point are reported at the command line.

**Prompts**

Select the polylines to check.  
Select objects: pick polylines to check  
Warning: Polyline non-perpendicular by 0°00'47'' at 5477.08,5047.53

**Pulldown Menu Location:** Edit > Polyline Utilities > Check Polylines  
**Keyboard Command:** highlight_nonperp  
**Prerequisite:** Polylines

---

### Highlight Non-Tangent Polylines

This command highlights selected polylines that have non-tangent lineworks. For every non-tangent polyline, an arrow is pointed to the first non-tangent point, and the non-tangent angle and the coordinates of the point are
Prompts

Select polylines to check.
Select objects: 1 found
Select objects: 1 found, 1 total
Select objects: press Enter to end
Polyline non-tangent by 32°15′26″ at 1540.41,-182.05
Highlighted 1 non-tangent polylines.

Pulldown Menu Location: Edit > Polyline Utilities > Check Polylines
Keyboard Command: highlight_nontangent
Prerequisite: Polylines

Highlight Crossing Plines

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.
Prompts

Select polylines to check.
Select objects: pick polylines to process
Ignore zero elevations [Yes/No]? press Enter for Yes to filter out polylines at zero elevation
Reading points ... 1677
Finding points on breaklines ...
19 crossing polylines are highlighted.
Use Report Formatter [Yes/No]? press Enter for No. Use the Report Formatter to customize the report layout or export to Excel.
Minimum delta Z to report <0.0>: 2
Add polyline vertices at intersections [Yes/No]? Y
Set 3D polyline to crossing contour elev or average elevs [Set/Average]? press Enter for Average. The Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of
the intersection point as the average of the crossing polyline elevations at that point.

**Maximum delta Z to average <1.0>: press Enter.** This option will only add the intersection point with the averaged elevation if the elevation difference is less than this tolerance.

**Pulldown Menu Location:** Edit > Polyline Utilities  
**Keyboard Command:** xing.plines  
**Prerequisite:** Polylines with elevations

### 3D Polyline Utilities

**Offset 3D Polyline**

This command offsets a 3D polyline entity in both the horizontal and vertical directions. There are six offset methods.

The **Interval** method applies one horizontal and one vertical offset to all the vertices of the polyline.

The **Constant** method has a horizontal offset and sets the elevation of the polyline to one constant elevation.

The **Variable** method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

The **Surface** method allows to offset/project a 3D polyline entity on to a surface (tin;flt;grd) based on cut and fill slope ratios.

The **Multiple** method allows multiple offsets of a 3D polyline with separate layers. User can add, insert and delete offsets rows and set individual layers. The option Progressive Offsets draws offsets progressively, i.e. successive offsets uses last drawn offset as base.
The **Intersection** method creates a 3D polyline at the intersection of two slopes from two reference 3D polylines.

The **Slope Projection Perpendicular To** option applies to sloping 3D polylines. The Polyline method creates the user-specified slope perpendicular to the polyline. The Slope Direction method accounts for the slope of the 3D polyline and makes the surface between the original and offset polylines to match the user-specified slope. For example, if the 3D polyline is at a 10% slope and the offset slope is at 2:1, then the Polyline method would create surface slopes that are 2:1 perpendicular to the polyline while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the sloping 3D polyline. For the same case except with the Slope Direction method, the resulting slope perpendicular to the polyline is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

The **Change Layer** option sets the layer for the offset polyline. Otherwise the offset polyline will use the layer of the original polyline.

**Prompts**

**Enter the offset method [ <Interval> / Constant / Variable / Surface / Multiple]:** press Enter

**Vertical / <Horizontal offset amount>:** 15

**Percent / Ratio / Vertical offset amount <0>:** 10

**Select a polyline to offset (Enter for none):** select a 3D poly

**Select side to offset:** pick a point

Select a point on the graphics screen that is in the direction of the side of line to offset.

**Select a polyline to offset (Enter for none):** press Enter

**Pulldown Menu Location:** Edit > 3D Polyline Utilities

**Keyboard Command:** offset3d
Prerequisite: 3D polyline

Fillet 3D Polyline
This command fillets two segments of a 3D polyline with the given radius. The standard FILLET command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

Prompts

Fillet corner of a polyline or intersection of two polylines [Corner]/Intersection? press Enter
Enter fillet radius <10.00>: press Enter
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: press Enter (to end command)

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: fillet3d
Prerequisite: 3D polyline

Join 3D Polyline
This command joins 3DPOLY entities into a single 3D polyline entity.

Prompts

Select the 3D polyline to join: pick a 3D polyline
Select the other 3D polyline to join: pick a 3D polyline that has a common endpoint with the first 3 segments added to the polyline.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: join3d
Prerequisite: Plot the 3DPoly lines to use for selection

Add Point by Two Slopes
This command inserts a vertex into a 3D Polyline between two points based on the slopes specified for these two points on polyline.

Prompts

Select polyline to process: select a polyline
Select first point on polyline: select a point on polyline
Enter percent slope from first point: -1.0
Select second point on polyline: select a second point on polyline
Enter percent slope from second point: -1.0

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: plzslopes
Prerequisite: 3D Polylines
Merge Crossing 3D Polylines

This command works with 2 crossing 3D polylines, adding one or more vertices to one of them at the virtual point of intersection to match the elevation of the other. The 3D polyline that is vertically unchanged is referred to as the "Main 3D polyline", the 3D polyline that is edited is referred to as the "Side 3D polyline." The command uses the 2 vertices on the Main 3D polyline on either side of the virtual intersection to determine an interpolated elevation on the Main 3D polyline at the point of virtual intersection, and adds a vertex on the Main 3D polyline at that location with the calculated elevation, but the vertical characteristics of the Main 3D polyline are otherwise unchanged. The Side 3D polyline gets a new vertex at the virtual intersection with the same interpolated elevation, thereby changing it's vertical definition as much as necessary to match. The characteristics of the transition are controlled by the settings in the Merge Crossing 3D Polylines dialog box.

![Merge Crossing 3D Polylines dialog box](image)

**Transition PVI Distance:** This option creates 2 additional vertices on the Side 3D polyline, each at the specified distance from the virtual intersection, and both with the same elevation as the vertex at the virtual intersection, essentially creating a flat section.

**Transition VC length:** This option creates a vertical curve for the transition, passing through the interpolated elevation at the virtual intersection. The start of the vertical curve is the specified value from the virtual intersection, as is the end, so the overall length of the entire vertical curve is actually twice the value specified in the dialog box.

**Add Main Road Crown Onto Side Road:** This option creates the transition by assuming the Main 3D polyline is a crowned roadway, and creates corresponding additional vertices on the Side 3D polyline.

**Prompts**

**Select the Main 3D polyline:** *pick the 3D polyline that will determine the crossing elevation, but will remain essentially unchanged*

**Select the Side 3D polyline:** *pick the 3D polyline that is be changed to match the Main 3D polyline elevation at the virtual intersection*

**Merge Crossing 3D Polylines dialog** Adjust variables as desired in Merge Crossing 3D Polylines dialog box, pick OK.

**Pulldown Menu Location:** 3D Data

**Keyboard Command:** merge3d

**Prerequisite:** 2 crossing 3D polylines

Chapter 3. Edit Menu 144
3D Polyline by Slope on Surface

This command creates a 3D polyline at a user-specified slope. The user picks the starting point and then the polyline continues along the surface at the slope until it reaches a point where the maximum slope at the point is less than the design slope. The surface is defined by a grid or TIN file which must be created before running this routine. Applications for this command include designing haul roads or ditches.

Prompts

Enter the polyline layer <SLOPE ROAD> : press Enter
Select the Grid File dialog
Reading row > 51
Extrapolate grid to full grid size (Yes/<No>)? Y
Limiting length for polyline (Enter for none):
Pick origin point of 3D polyline: pick a starting point
Direction of 3D Polyline (<Up>/Down)? press Enter The slope must go either uphill or downhill.
Direction of 3D Polyline facing up slope (<Left>/Right)? R Imagine facing uphill. Do you want the polyline to go to the left or right?
Enter the design slope: 10 This value is in percent slope.

Pulldown Menu Location: 3D Data
Keyboard Command: surfpl
Prerequisite: Existing surface file

Extend To Elevation

This command extends the end segment of a 3D polyline or line until the segment reaches the specified elevation. The slope for the extension is user-specified and defaults to the existing segment slope.

Prompts

Select line or polyline to extend: pick a 3D line or polyline
End point elevation: 496.130
New elevation: 495
Slope to extend <-1.482> : press Enter
Select line or polyline to extend (Enter to end): press Enter

Pulldown Menu Location: 3D Data
Keyboard Command: extend2z
Prerequisite: 3D linework

Break 3D Polyline by Surface

This command breaks 3D polylines against a surface. The surface is defined by a 3D grid or triangulated surface model which can be selected from a .grd, .flt or .tin file. Alternately, the user can select 3D entities on the screen from which the program internally calculates a 3D grid. This routine is one step in 3D polyline design. In this example, a valley fill is designed using 3D polylines as follows:

1. Draw 3D Polyline - draw a 3D polyline at elevation 1450 across valley
2. Offset 3D Polyline - offset the 3D polyline at 2:1 slope and 10:1 for benches and top
3. Break 3D Polyline by Surface - trims the 3D polylines by the valley sides
4. Draw 3D Polyline - with OSNAP endpoint, draw 3D polyline perimeter around 3D polylines ends
5. Make 3D Grid File - create 3D grid file of fill surface
6. Plot 3D Grid - draw the 3D grid using 3D polyline perimeter as inclusion polyline
7. Viewpoint 3D - creates the last figure view

Prompts

Source of surface model (File/<Screen>)? press Enter The File option allows you to choose the .grd, .flt, or .tin file that models the site. Otherwise, a grid will be calculated by picking the grid location and selecting surface entities on screen (e.g., contour polylines). Using the File option can be quicker because the surface is already calculated. Also the .grd file can be drawn to preview the existing surface.

Pick Lower Left limit of surface area: pick a point
Pick Upper Right limit of surface area: pick a point

Make GRiD Setting Dialog OK
Select polylines to clip.
Select objects: pick the 3D polylines
Select surface entities.
Select objects: select objects that define the surface.

Erase polyline below surface (<Yes>/No)? press Enter If you answer yes, the segments of the polylines below the surface will be erased from the intersection, if any, of the polyline with the surface. Otherwise the polylines will only be broken into separate polylines at the intersection.
Specify layer names (Yes/<No>)? press Enter If you answer yes, you will have the option to place the broken polylines into different layers.

Before Break 3D Polyline by Surface

After Break 3D Polyline by Surface
Add Points At Elevation

This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

Prompts

Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects:
Processing polylines ...
Added 10 points to polylines.

Tag Hard Breakline Polylines

This command tags polylines with a description so that Triangulate & Contour can identify these polylines as hard breaklines. The tag is invisible and doesn't change the polyline. Triangulate & Contour will not smooth the contours as they crosses these hard breaklines. For example you could tag 3D polylines that represent a wall so that the contours go straight across the wall without smoothing curves.

Prompts

Select hard breaklines.
Untag Hard Breakline Polylines

This command removes description tags from polylines. These tags are used by Triangulate & Contour to identify polylines as hard breaklines. Contours are not smoothed as they cross these hard breaklines. This routine untags polylines so that contours are smoothed across them.

Prompts

Select polylines to remove hard breakline tag from.
Select objects: select polylines

Prerequisite: Polylines with hard breakline tag.
Keyboard Command: softbrk
View Menu
Redraw
This command refreshes the display in the current viewport.

Prerequisite: None

Keyboard Command: R

Regen
This command regenerates the drawing and refreshes the current viewport.

Prerequisite: None

Keyboard Command: REGEN

Zoom

Window
This command zooms to display an area you specify by two opposite corners of a rectangular window.

Prerequisite: None

Keyboard Command: ZOOM, W

Dynamic
This command zooms to display the generated portion of the drawing using a view box. The view box represents your viewport, which you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms the viewport, filling it with the image inside the view box.

Prerequisite: None

Keyboard Command: ZOOM, D

Previous
This command zooms to display a previous view. You can restore up to 10 previous views.

Prerequisite: None

Keyboard Command: ZOOM, P

Center
This command zooms to display a window you define by picking a center point and a magnification value or height. A smaller value for the height increases the magnification. A larger value decreases the magnification.

Prompts
1 Specify center point: pick a point
2 Enter magnification or height <226.66>: enter a value

Prerequisite: None

Keyboard Command: ZOOM, C
**Extents**

This command zooms to display the drawing extents. You can use Zoom Extents transparently, but it always regenerates the drawing.

**Prerequisite:** None

**Keyboard Command:** ZOOM, E

---

**Zoom In**

This command increases the zoom factor of the current viewport by a factor of 2.0.

**Prerequisite:** None

**Keyboard Command:** ZOOM, 2.0x

---

**Zoom Out**

This command decreases the zoom factor of the current viewport by a factor of 0.5.

**Prerequisite:** None

**Keyboard Command:** ZOOM, 0.5x

---

**Zoom Most**

This command zooms to show the bulk of the entities in the drawing and avoid outliers. This zoom method is helpful when the drawing has a few entities far off and regular zoom extents results in showing small dots because it zooms out so far. When outliers are detected, there is a choice to either zoom to the bulk of the entities so you can see your main drawing, or to zoom to the outliers so you can see the entities that are far away. When no outliers are found, this command reports that none are found and does a regular zoom extents.

**Prompts**

*Zoom to [<Most>/Outliers]?* press Enter for Most

---

**Zoom Points**

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

**Prompts**

*Find by point number or description [<Number>/Desc]?* N

Point number or range of point numbers to find <1>: 2079

We want to find point number 2079

*Magnification or Height* <179.50>: press Enter

Accept the default zoom magnification

**Pulldown Menu Location:** View

**Keyboard Command:** zoompnt
Pan

This command moves the drawing display in the current viewport. The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

When you reach a logical extent (the edge of the drawing space), a bar is displayed on the hand cursor on the side where the extent has been reached. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).

When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.

To stop panning at any time, press Enter or ESC.

Prerequisite: None

Keyboard Command: P

Viewpoint 3D

This command allows you to define 3D view settings.

1. Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).

   - **Absolute to WCS**: This option sets the view direction relative to the WCS.
   - **Relative to UCS**: This option sets the view direction relative to the current UCS.

2. You must specify the viewing angles.
• **X Axis**: This field specifies the angle from the X axis.

• **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.

• **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

  **Prerequisite**: None.

  **Keyboard Command**: DDVPOINT

### Lock Layers

The *Lock Layers* command will lock the layers for the layers of the selected entities.

The *Unlock Layers* command will unlock the layers for the layers of the selected entities.

  **Pulldown Menu Location**: View
  **Keyboard Command**: laylock, layunlock
  **Prerequisite**: None

### Draw Model View

This command draws a rectangular polyline in Model space for the outline of a selected viewport in Paper space. Before running this command, switch to a Layout that has the viewport to draw. The polyline is drawn in the drawing current layer. After drawing the polyline, the program switches to Model space.

**Prompts**

**Pick viewport to draw**: pick a viewport

  **Pulldown Menu Location**: View > Viewports
  **Keyboard Command**: mview_draw
  **Prerequisite**: Layout with a viewport

### Twist screen

**Standard**

This command allows you to "twist" the screen's orientation so that a direction other than North is toward the top of the screen and the drawing. It does not do a coordinate rotation, and it leaves the database unchanged. The ROTATE and MOVE commands in the Edit menu can be used to do a coordinate rotation and translation.

This command prompts you for the twist angle, then adjusts the screen and crosshairs to that angle. The twist angle is always measured counterclockwise, with 0 degrees at the east/right.

  **Prerequisite**: None

  **Keyboard Command**: TWIST1
### Line, Polyline or Text
This command is a variation of Twist Screen Standard. The command aligns a selected line, polyline or text to be parallel to the east-west direction of your graphics screen.

Think of what you select as a pointer or arrow that will be moved to point in the east direction of the screen. Select the line, polyline or text closest to the endpoint that you want it to point in the horizontal or east direction of the screen.

**Prerequisite:** None  
**Keyboard Command:** TWIST2

### Surveyor
This command is another variation of Twist Screen Standard. You enter the angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen.

**Prerequisite:** None  
**Keyboard Command:** TWIST3

### Restore Due North
This command twists the screen to make due north vertical. When the grid projection is specified under the Drawing Setup command, this command will prompt for whether to use grid north or geodetic north. When the grid projection is not set, this routine automatically twists to grid north.

**Prompts**

 Twist to Grid North or True Geodetic North [<Grid>/True]? press Enter

**Pulldown Menu Location:** View > Twist Screen  
**Keyboard Command:** twist4  
**Prerequisite:** None

### Twist To 3D View
This command orients selected text, symbols and point attributes to face the current viewpoint. Typically, text and points are drawn to face up to plan view. When viewed in 3D from the side, this text can be hard to read. This command makes this text readable for the current view. Before running this command, the 3D view should be set by commands like Viewpoint 3D or Orbit. The entities are oriented to the current view by setting the extrusion values for the entities.

**Prompts**

 Select points, symbols and text to twist.  
**Select objects:** pick entities

**Pulldown Menu Location:** View > Twist 3D Entities  
**Keyboard Command:** twist3d  
**Prerequisite:** Entities to view
**Restore World View**

This command is the companion to the Twist To 3D View command. This command resets entities so that they face up in plan view.

**Prompts**

*Select points, symbols and text to restore.*

**Select objects:**  *pick entities*

**Pulldown Menu Location:**  View

**Keyboard Command:**  untwist3d

**Prerequisite:**  3D Entities

**Display Order**

This command allows you to change the display order of objects by repositioning an entity from either the background to the forefront of the drawing view or from the forefront to the background of the drawing view.

**Prerequisite:**  None

**Keyboard Command:**  draworder

**Update Colors For Set Elevations**

This command refreshes the color of entities depending on their elevation and layer target. For entities assigned to the Existing or Design layer targets, if the entities are at zero elevation then their color is set to grey. Otherwise the entities have their true, original color. If the Automatic Update Colors command under Settings->Configure->Takeoff Module is toggled off, then this command is the way to update the entity colors after editing elevations.

**Prerequisites:**  none

**Keyboard Command:**  update_tk_colors

**3D Views**

This command allows you to view the existing surface in 3D mode.
In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface. The arrow icon reports the elevations at the bottom of the screen as you move around the surface. The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

Prerequisite: an existing surface

Keyboard Command: cube_exist

Existing Surface 3D Viewer

This command allows you to view the existing surface in 3D mode.
In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface. The arrow icon reports the elevations at the bottom of the screen as you move around the surface. The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

Prerequisite: an existing surface

Keyboard Command: cube_exist
Design Surface 3D Viewer
This command allows you to view the design surface in 3D mode.

In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface (the shading is shown in the above drawing). The arrow icon reports the elevations at the bottom of the screen as you move around the surface.

The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

Prerequisite: a design surface
Keyboard Command: cube_design

Chapter 4. View Menu
This command allows you to view and move around the design surface in 3D mode.

Use the arrows on your keypad to move around the drawing.

At the very bottom of the window you will find the basic commands: Run will start to drive your vehicle around the surface, once your vehicle is moving the Run button turns into the Stop button. The arrows moves your vehicle left and right. The magnify glass zooms in and out. Click and drag up to zoom in and click and drag down to zoom out. When your vehicle is stopped the icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis.

The hand icon allows you to pan around the viewer. Click and drag the direction you want to move. The icon toggles the shading of the surfaces. The icon exits 3D Driver Simulation.

Above the basic command buttons you can change the Elevation and Distance away from your vehicle. Also, you can set the speed at which your vehicle travels. For a smaller drawing you may want to move around slower, for a larger drawing faster. Note: Unrealistic speeds such as 500 mph in a dozer may cause 3D Drive Simulation to freeze.

View Direction: Sets the direction of the view from the Front, Back, Left, or Right.
Vehicle Icon: You can select which Vehicle you want to use whether: Dozer, Hummer, School Bus or none at all.
View Position: Sets the elevation and distance to either that of the driver, a pedestrian, or bird.
Shading: Here you can set the shading of the surface to either Flat, Smooth, Elevation, Cut/Fill, or none. Flat just shades the contours as they are. Smooth smooths contours to look for realistic. Elevation colors different elevations in different colors so differences can visual be seen. Cut/Fill colors areas of cut differently than areas of fill so they can be visually seen. None merely shows the triangulation and does not shade in a surface.
You can select the Surface, High, and Low color by enter in an AutoCAD defined color number or you can choose...
Select to pick a color. The circle on the right determines the shade of the color.

In the top right of the 3D viewer is an aerial map of your surface. Below that the Elevation, Slope percentage, Azimuth, and Roll are updated as your vehicle moves around the surface. Slope and Roll are shown visually here as well.

On the bottom right you can set the Vertical Scale and check to Ignore Zero Elev, Display Trail, and Display Cut/Fill. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Display Trail draws a line where your vehicle has driven. Display Cut/Fill displays the cut and the fill.

**Prerequisite:** a design surface  
**Keyboard Command:** tk_flyby

**FlyOver Along 3D Polyline**

This command allows you to view a self guided animation of following a path through a 3D surface model. There are two variations to this command. When the command is started, you must specify whether you want to use a surface model from file or screen entities.

**Surface model from file:** Using this method, you can select either a triangulation (.TIN) file or a grid (.GRD) file, then you have the option of following a polyline or following a "free" path. If you choose the polyline method, then the animation is limited to following the polyline. If you choose the "free" path method, you first specify two points to obtain a starting direction, the while inside the viewer you can point the animation in any direction.

**Screen entities:** Using this method, you must select a 3D polyline to follow. The animation is limited to following the polyline.

After making the above selections, the 3D graphics window is opened. The main window is for the animation, the smaller upper right window shows you the overall plan view, and the smaller window located at middle right shows you the current elevation, slope and azimuth. While following a "free" path, you will have a 3rd small window located at lower right which shows you the amount of roll at your current position.
This button raises the elevation of your viewing position. This button lowers the elevation of your viewing position. This button turns your viewing position to the left. This button turns your viewing position to the right. This button allows you to zoom in and out. This button allows you to rotate the main animation window in any X, Y or Z direction. This button allows you to pan. This button toggles shading on and off. This button starts the animation in the main window. This button stops the animation. This button exits the 3D Surface FlyOver command.

**Prerequisite:** Surface Model and optionally a 3D Polyline

**Keyboard Command:** flyby

### 3D Viewer Window

This command loads the selected 3D faces, blocks, polylines, lines and points into a separate 3D Viewer window. Some of the features of this viewer include the ability to zoom in and out, pan, rotate around the X-Y-Z axes, and shade entities with user-positioned lighting.
The 3D Viewer Window has several mouse and keyboard controls that can assist with navigating the scene. These are listed below:

- Hold left-mouse button: Rotates/pans/zooms the scene based on the current mode. You can change the mode by clicking one of the control icons.
- Hold right-mouse button: Zooms in/out.
- Hold middle-mouse button: Pans around the scene.
- W key: Zooms in.
- S key: Zooms out.
- A key: Pans left.
- D key: Pans right.
- Q key: Pans up.
- Z key: Pans down.
- E key: rotates down.
- C key: rotates up.
- X key: rotates left.
- V key: rotates right.

Ignore Zero Elevations: When enabled, the 3D viewer will not display entities at zero elevation.

Color By Elevation: This will color the entities by elevation.
The None option will not modify the color of entities in the viewer.
The All option will color all entities by elevation. The elevation color legend will be displayed on the left of the window and can be adjusted via the Color By Elevation Scale controls.
The Surface Only option will only color surface files by elevation. Other entities such as polylines and 3D faces will not be colored by elevation.

Sky: This option controls the background image for the 3D viewer. By default, no background image will be displayed. When a background image is displayed, you can toggle the Background Color Below Horizon checkbox to hide the bottom half of the background image.

Vertical Scale: This option sets the vertical scale factor for the 3D viewer.

Lighting by Location/Time: This button will display the below dialog, which allows you to set the lighting as it would appear at a specific location at a specific time.
**Date/Time:** These values set the date and time for the lighting. The **Select** button will allow you to pick the date from a calendar. The horizontal slider below the time will allow you to set the time of day.

**Latitude/Longitude:** These values set the location of the viewpoint

**Time Zone:** This value adjusts for the various time zones. Values should be integers representing GMT adjustments. For example, the Eastern Standard Time (EST) in the USA will use a value of -5.

This control represents the position of the sun in plan view. If the yellow square is in the center of the blue circle, the sun is in a zenith. If the yellow square is near the edge of the circle, the sun is near the horizon. To move the yellow square, simply drag it to a new location, or click on the new location. The slider bars on the sides control the intensity and brightness of the display.

Switch to Pan mode. Click and drag to pan.

Switch to Rotation mode. When the cursor is placed near the outer edge of the view, a "Z" cursor is presented that permits rotation around the Z-axis. When the cursor is placed further into the interior of the view, an "X,Y" cursor is presented that permits the tilt angle of the view to be adjusted.

Switch to Dynamic Zoom mode. Click and drag to zoom in and out.

Zoom Previous.

Toggle shading of 3D Faces and Surfaces. The shading of these entities is controlled by the Shading Mode control.
Switch to Pick mode. In this mode, hovering over an entity will display data such as the layer, entity type, elevation, and length. Double-clicking an entity permits additional actions to be performed on the entity including the ability to change the layer of the entity and/or setting the entity to an elevation of zero (0). When hovering over a surface, the coordinates and slope of the surface at the cursor location will be displayed. Clicking a point on the surface will set a new reference point from which the distance and slope to the cursor will be displayed (click a point, move the mouse to measure the distance/slope).

Resets the 3D view to plan.

**Rotation Axis:** Permits the use of "slider" controls to orient the view in the X, Y and/or Z axis direction(s). Axes may be locked to prevent rotation about that axis.

**Fixed Views:** Permits the view to be displayed from one of six different directions:

1. Custom - This option will be displayed after manually rotating the view. Selecting this option will not return to a predefined view.

2. Plan View - Sets the view directly over the site, looking straight down. This is the same as the Reset to Plan button.

3. NE - Sets the view as shown from the Northeast looking to the Southwest in a downward direction.

4. SE - Sets the view as shown from the Southeast looking to the Northwest in a downward direction.

5. SW - Sets the view as shown from the Southwest looking to the Northeast in a downward direction.

6. NW - Sets the view as shown from the Northwest looking to the Southeast in a downward direction.

**TIN Edit:** This option is only available when using the Surface 3D Viewer Command and when using the Pick Mode. This allows you to modify TIN files by picking points on the surface.

*Swap Tin Edge* will rotate the edge of two adjacent triangles, but this is not possible for all triangles on the surface. *Add Breakline* will add a breakline to the surface after selecting the starting and ending points on the surface. *Remove Point* will remove a point on the surface and retriangulate the affected area. *Remove Triangle* will remove a triangle from the surface, leaving a gap. *Set Point Elevation* will allow you double-click a point on the surface and enter a new elevation for that point.

**XRay Cursor:** This option is only available when using the Surface 3D Viewer Command and when using the Pick Mode. This will hide the surface file near the cursor, allowing you to see objects beneath it.
Display Axis Icon: This option toggles the display of the X-Y-Z axes icon in the lower left corner of the window.

Bounding Box: This dropdown menu controls the display of a 3D box around the limits of the data.

The None option will not display the bounding box.
The Box Only option will display simple bounding box around the objects in the 3D view.
The Box with Labels option will display a bounding box with labels to indicate the range of X, Y, and Z values in the scene.

Display Orbit: This option toggles the display of a graphic guide for controlling the view angle and position using the mouse movements similar to the AutoCAD Orbit routine.

Smooth Surface: This option shades 3D faces in a way that appears to remove sharp transitions from one entity to another. This option affects both surfaces and solids.

Display Triangle Edges: This option toggles the edge lines of triangles that make up surfaces. The triangle edge color can be set with the Set Colors button.

Display Surface Names: This option toggles the display of the file names for the surfaces currently being viewed.

Display Vertical Scale: This option toggles the display of the vertical scale.

Display Non-Surface Entities: This option toggles the display of entities that have been tagged as "non-surface" by the Tag Non-Surface Entities/Points commands.

Use Dynamic Text: This option automatically resizes and rotates text entities so that they are always readable. When the option is first enabled, you will need to restart the viewer for the changes to take effect.

Hide Backs of Triangles: This option toggles the display of the backs of 3D Faces. When enabled, even the edges...
of the triangles will be hidden.

**Linework Pixel Thickness:** This value sets the display thickness for polylines.

**Point Pixel Size:** This value sets the display thickness for points.

**Set Colors:** This button opens the dialog shown below.

![Set Colors Dialog](image)

**Color By Elevation Scale:** These three colors are used for the Color By Elevation option. The program will interpolate between these colors for the color scale.

**Contour/Edge color:** These colors control the coloring for contours and triangle edges. Note that this does not affect the coloring of contour polylines that are loaded into the viewer, but only contours that are generated within the viewer.

**Use CAD Background Color:** When enabled, the background color of the 3D viewer will match the CAD background color. If this option is disabled, you can set a different background color.

**Default Surface Colors:** These colors set the default colors for new surfaces (Grid or TIN files) that are loaded into the 3D viewer. The colors of the surfaces may changed after they have been loaded.

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Control Symbol]</td>
<td>Sets the drawing view to match the view shown in the 3D viewer window. Sets the view position and target position by coordinates according to the below dialog.</td>
</tr>
</tbody>
</table>

Settings Controls
The positions can be entered in the edit boxes or you can use the respective **Pick >** button to pick a point in the drawing. The program will pick up the elevation of the surface for picked points and then the **Height** above the position can be entered. For example, to check sight distance the view position could be a point on a road at the driver's eye height and the target position could be the distance to check.

**Saved Views:** This option allows for naming and saving a 3D view for easy recall later. Named views can be selected from the pull-down and the active view can be deleted from the list.

**Block Model Objects:** This option has three choices when loading block model entities:

1. **Leave as Points** - this option will display blocks as points. In this mode, vertical stacks of blocks will be composited by color. For example, if 5 blocks of the same color are on top of one another, only one point will be displayed for those 5 blocks. This greatly reduces the number of points to be displayed in the viewer, but this viewing mode can be difficult to interpret for relatively homogeneous block models.

2. **Render** - this option will display each block as a solid.

3. **Prompt Each Time** - this option will prompt you to select the viewing mode each time a block model is loaded into the viewer.

**Shading Mode:** When the Shading control is enabled, the rendering of the shaded 3DFACE entities (usually used to represent a surface model) will vary based on:

1. **Shade Front** - Shades only the "positive" normal direction.
2. **Shade Back** - Shades only the "negative" normal direction.
3. **Shade Both** - Shades both the "positive" and "negative" normal directions.
Control

Action

Adds a single surface file to the 3D Viewer. You may also add one or multiple surfaces to the viewer by right clicking on "Surfaces" in the tree view.

Allows you to select more entities from the drawing to add to the 3D Viewer.

Allows you to edit properties of the currently selected entity.

Loads a 3DX file into the viewer. This file contains all entities within a saved 3D View.

Save the entities in the 3D Viewer to a 3DX file.

Model Controls

Within the "model" tab is a "tree-view" of the various entities that comprise the view along with the listing of layers upon which the entities are found. Each "branch" in the tree view may be expanded by clicking the "+" symbol to the left of the branch. Entities may be displayed (thawed), hidden (frozen), or edited by right clicking the entity name and selecting the appropriate option. The below dialog shows the properties of a surface that may be edited.
**Visibility:** This option toggles the visibility of the entity.

**Opacity (Surfaces/Solids):** This option controls the opacity of the entity. A lower opacity results in increased surface transparency and is helpful for viewing sub-surface utilities such as Storm Sewer pipes and manholes.

**Color By Normal (Surfaces/Solids):** When enabled, this option will color the surface/solid by the direction perpendicular to each face. This view can be useful for identifying particularly steep areas of the surface. The Color By Elevation option must be disabled to show the designated color.

**Override color from file:** When enabled, this option will override any color assignments and display the entity as a single color. The Set Color button below this option sets the color for the entity. The Color By Elevation option must be disabled to show the designated color.

**Texture Mode (Surfaces/Solids):** This dropdown controls how texture images are applied to surfaces and solids.

*None* will not apply a texture to the surface/solid

*Single Texture* will apply a single texture image to the surface/solid. The texture image and the Scale of the texture may be set by clicking the Edit button.

*By Color* will set different texture images for each colored area of the surface. For example, surfaces output from RoadNet, may have a different color for the asphalt compared to ditches. This option will then allow you to apply one texture to the asphalt and another to the ditch. When enabled you can add a row to the Texture by Color table, first selecting a color and then specifying the texture to use in place of that color.

*By Color, Single as Default* is the same as the *By Color* option, but you are allowed to set a default texture for any colors not included in the list.

*By Slope* sets the texture of the surface according to the slope of the surface. When enabled, you will be able to set a texture, scale, and max slope for each zone.
Shading Mode (Solids):  This option controls which side of the 3D faces of the solid should be shaded.

These controls are always displayed at the bottom of the window.

Control Action

The **Clip Plane** slider bars hide a portion of the view. Sliding the bar to the right will clip more of the view. This is helpful for producing quick "section" views of the data.

The **Near** slider bar will clip objects closer to the camera, while the **Far** slider bar will clip objects further away from the camera. Similarly, the **Top** and **Bottom** slider bars will clip higher and lower objects, respectively. Specific elevations for the **Top** and **Bottom** clipping plans may also be set by entering values in the **Top Elev** and **Bottom Elev** text boxes.

Clicking the cyan button to the left of each slider bar will allow you to pick a point in the 3D view to set the clip position.

The **Sync Front/Back** toggle will move both the **Near** and **Far** slider bars by the same amount when enabled. This can be used to hold a specific viewing width while. The **Sync Top/Bottom** toggle has a similar effect on the **Top** and **Bottom** slider bars.

This button takes a screenshot of the 3D Viewer. Several different image file formats are supported including bmp, png, jpg, xpm and gif. The image resolution and color depth may be set with this option.

This button exports the 3D Viewer to a PDF report with project information. The default project information is set under Carlson Configure > General Settings. The dialog that appears for this command is shown below.

This button exports the 3D Viewer to a 3D PDF. This function is further described in the to the 3D Viewer to 3D PDF help article. Note that you must have access to the CADNET module in order to use this command.

This button opens the help documentation you are currently reading.

Exit the 3D viewer window.

Common Controls
Scale Type: This option controls how the image and the paper will be scaled to match one another. When the *Fit Paper to Image* option is selected, you will be able to manually set the **Image Size**.

Paper Size: This option sets the size of the PDF.

Draw Border: This option toggles the addition of a border around the PDF.

Draw Title Block: This option toggles the addition of a title block in the PDF. Information such as the **Company Name**, **Project**, **Date**, and **Logo** will be included in the title block. The logo may be selected by clicking the **Select** button and the dimensions may be specified in pixel dimensions.

Top/Side/Bottom Margin: These values set the margins around the PDF in inches.

- To quickly view just a surface file, use the Surface 3D Viewer command.
- To visualize a site with animated vehicle controls, use the Surface 3D Fly-Over command.

Pulldown Menu Location: View > 3D View

Keyboard Command: cube

Prerequisite: Entities to display

**Viewpoint 3D**

This command allows you to define 3D view settings.
1 Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).

- **Absolute to WCS**: This option sets the view direction relative to the WCS.
- **Relative to UCS**: This option sets the view direction relative to the current UCS.

2 You must specify the viewing angles.

- **X Axis**: This field specifies the angle from the X axis.
- **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.

- **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

**Prerequisite**: None.

**Keyboard Command**: DDVPOINT

## Layer Control

This command allows you to manage layers and layer properties.
This Layer Properties Manager dialog box makes a layer current, adds new layers to the layer name list, and renames an existing layer. You can assign properties to layers, turn layers on and off, freeze and thaw layers globally or by viewport, lock and unlock layers, set plot styles for layers, and turn plotting on and off for layers. You can filter the layer names displayed in the Layer Properties Manager, and you can save and restore layer states and properties settings.

1 Under Named Layer Filters, you determine which layers to display in the list of layers. You can filter layers based on whether they're xref-dependent, or whether they contain objects. You can also filter layers based on name, visibility, color, linetype, lineweight, plot style name, whether they are plotted, or whether they are frozen in the current viewport or in new viewports.

- [...]: This button displays the Named Layer Filters dialog box.
- Invert Filter: This option displays layers based on the opposites of the criteria you select when you are using a named layer filter. Layers that fit the inverse criteria are displayed in the layer name list.
- Apply to Object Properties Toolbar: This option displays in the Object Properties toolbar only layers that match the current filter. The layer list tooltip on the Object Properties toolbar displays the filter status of layers in the drawing. (To display the layer list tooltip, position the pointing device over the layer list on the Object Properties toolbar.)
- New: This option creates a new layer. After you choose New, the list displays a layer named LAYER1. You can edit this layer immediately. To create multiple layers quickly, you can select a layer name for editing and enter multiple layer names separated by commas. If you create a new layer, the new layer inherits the properties of the currently selected layer in the layer list (such as Color, and On/Off state). To create layers with default settings, make sure that there are no selected layers in the list or that you select a layer with default settings before beginning layer creation.
- Current: This option sets the selected layer as the current layer. The CLAYER system variable stores the layer name.
- Delete: This option deletes selected layers from the drawing file definition. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block definitions), the current layer, and xref-dependent layers. Layers that don't contain objects (including objects in block definitions), are not current, and are not xref-dependent can be deleted by using the PURGE command. Be
careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.

- **Show/Hide Details:** This option controls whether the Details section is displayed in the Layer Properties Manager.

- **Save State:** This option displays the Save Layer States dialog box, in which you save layer state and layer properties settings of all layers in a drawing. You can choose which layer states and properties you want to preserve. You save a layer state by assigning it a name.

- **Restore State:** This option displays the Layer States Manager, in which you can manage named layer states.

2 The Layer Properties Manager dialog box displays all layers and their properties. To modify a property, click its icon. To quickly select all layers, right-click your pointing device and use the shortcut menu. The following are the layer properties you can modify:

- **Name:** This field displays the names of the layers. You can select a name, and then click and enter a new name.

- **On/Off:** This field turns layers on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.

- **Freeze/Thaw in All Viewports:** This field freezes and thaws layers in all floating viewports. A frozen layer is invisible and excluded from regeneration, hiding objects, rendering, and plotting. A thawed layer is visible and available for regeneration, hiding objects, rendering, and plotting.

You can freeze layers to speed up ZOOM, PAN, and many other operations, improve object selection performance, and reduce regeneration time for complex drawings. TakeOff does not display, plot, or regenerate objects on frozen layers. Objects on frozen layers do not hide objects and are not rendered.

You can freeze layers in all viewports, in the current viewport, or in new viewports.

Freeze layers that you want to be invisible for long periods. When you thaw a frozen layer, the program regenerates and displays the objects on that layer. If you switch between visible and invisible states frequently, use the On/Off setting.

- **Lock/Unlock:** This field locks and unlocks the layers. You cannot select or edit objects on a locked layer. Locking a layer is useful if you want to view information on a layer for reference but do not want to edit objects on that layer.

- **Color:** This field changes the color associated with the selected layers. Clicking the color name displays the Select Color dialog box.

- **Linetype:** This field changes the linetype associated with the selected layers. Clicking any linetype name displays the Select Linetype dialog box.

- **Lineweight:** This field changes the lineweight associated with the selected layers. Clicking any lineweight name displays the Lineweight dialog box.

- **Plot Style:** This field changes the plot style associated with the selected layers. If you are working with color-dependent plot styles (the PSTYLEPOLICY system variable is set to 1), you cannot change the plot style associated with a layer. Clicking any plot style displays the Select Plot Style dialog box.

- **Plot/Don't Plot:** This field controls whether the selected layers are plotted. If you turn off plotting for a layer, the objects on that layer are still displayed. Turning off plotting for a layer affects only visible layers in the drawing (layers that are on and thawed). If a layer is set to plot, but is currently frozen or off in the drawing, TakeOff does not plot the layer. Turning off plotting for layers containing reference information such as construction lines can be useful.

**Prerequisite:** None

**Keyboard Command:** LAYER
Set Layer

This command allows the user to change the current layer to a different layer by picking an entity on that layer.

Pulldown Menu Location: View
Keyboard Command: lset
Prerequisite: None

Change Layer

This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed in or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

Prompts

Select entities to be changed.
Select objects: pick entities
The Select Layer dialog appears select a layer from the list, or select Screen Pick
If Screen Pick is chosen,
Pick entity with layer to change to: pick another entity This assigns the selected entities to the layer of this entity.
or
Enter new layer name or pick entity with layer (Enter/<Pick>)? E
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View
Keyboard Command: lchg
Prerequisite: None

Freeze Layer By Pick

This command will freeze layers by picking entities on that layer. The entity selection is done one at a time. As entities are selected, the layers are frozen.

Prompts
Pick entity on layer to be frozen: pick an entity
Freezing layer
Pick entity on layer to be frozen (U-Undo, Enter to end): press Enter

Pulldown Menu Location: View
Keyboard Command: pickoff
Prerequisite: None

**Freeze Layer By Selection**

This command will freeze layers by picking entities on that layer. The entity selection is done by selection set for selecting one or more entities.

**Prompts**

Select entities on layers to be frozen.
Select objects: pick entities

Pulldown Menu Location: View
Keyboard Command: loff
Prerequisite: None

**Thaw Layer**

This command thaws the layers frozen by the Freeze Layer command.

Pulldown Menu Location: View
Keyboard Command: lon
Prerequisite: None

**Isolate Layer**

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

**Prompts**

Select objects on layers to isolate.
Select objects: pick entities
Retain POINT layers [Yes/No]? Press Enter
Isolate the wall layer by picking one wall line

Pulldown Menu Location: View
Keyboard Command: isolate
Prerequisite: None

**Restore Layer**

This command thaws the layers that were frozen by the *Isolate Layer* command.

Pulldown Menu Location: View
Keyboard Command: restore
Prerequisite: None

**Thaw/On All Layers**

This command turns on and thaws all layers in the drawing.

Pulldown Menu Location: View
Keyboard Command: loa
Prerequisite: None

**Lock/Unlock Layers**

The *Lock Layers* command will lock the layers for the layers of the selected entities.

The *Unlock Layers* command will unlock the layers for the layers of the selected entities.

Pulldown Menu Location: View
Keyboard Command: laylock, layunlock
Prerequisite: None

**Save/Restore Layer State**

The *Save Layer State* command stores to a file all the layers in the drawing and their current status of color, freeze/thaw, on/off, and linetype. The layer state file has a .LAY extension. Later versions of AutoCAD include the ability to save and restore layer states, found in the layer dialog box.
The *Restore Layer State* command sets the drawing layers and their status from the layer information in a layer state file (.LAY file). If a layer from the layer state file does not exist in the drawing, the program will create the layer. Besides the Carlson format, the Land Desktop layer state format, which is also uses a .LAY extension, is supported by this command.

**Pulldown Menu Location:** View  
**Keyboard Command:** savelay, restlay  
**Prerequisite:** None
Draw Menu
**Line**

This command allows you to draw a line entity by picking points on the screen or by supplying the coordinate values using the point number and associated coordinates stored in the current coordinate file. The Line command links the line with the points when the line is drawn using point numbers if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line. This command always draws 2D lines with a zero elevation.

**Prompts**

1 Pick point or point numbers: 1-3
You may enter a single point number or a range of point numbers
2 Undo/Distance/ <Pick point or point numbers>: 16
3 Undo/+/-/Distance/ <Pick point or point numbers>: 35
4 Undo/+/-/Close/Distance/ <Pick point or point numbers>: +
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
5 Perpendicular Distance Right: 80
6 Undo/+/-/Close/Distance/ <Pick point or point numbers>: -
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
7 Perpendicular Distance Left: 105.12
8 Undo/+/-/Close/Distance/ <Pick point or point numbers>: D
The distance option allows you to input a distance for the next line segment. The position of the cursor determines the angle.
9 Enter distance: 174.32
10 Undo/+/-/Close/Distance/ <Pick point or point numbers>: C
The close option draws a line segment back to the original starting point

**Prerequisite:** None

**Keyboard Command:** 2DLINE

**2D Polyline**

This command creates a 2D polyline. A Polyline is a complex CAD entity comprised of one or more line or arc segments. While a 2D polyline elevation isn't necessarily zero, a 2D polyline is flat with all vertices at the same elevation.

This command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (2DP) and provides many more options than the standard CAD version of the command. Unless disabled, the Polyline 2D Options dialog box will appear after starting Carlson's 2D Polyline command.
Show Options on Startup: When this option is enabled, the Polyline 2D Options dialog box will display automatically upon starting the 2D Polyline command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.

Elevation: Set the elevation of the polyline to be drawn. The Set Elevation By 1st Point option will use the elevation from the first specified point for the whole polyline.

Offset from Centerline: If this option is enabled, an additional option, Offset, is available from the Command line. Issuing the "Offset" option allows you to draw a new polyline using Station and Offset entry from an existing polyline or existing Centerline (.CL) file.

Skip Inline Vertices for Extend: This setting applies to the "Extend" option with the Total Distance Sub-Menu option. If enabled, an existing vertex will dissolve when lengthening a 2D Polyline segment.

Prompt To Draw Another: This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

Annotate Closed Pads: Enabling this option will activate the "Settings" button. The "Settings" button displays the Label Pad Elevations dialog box where you can specify label settings for the pad and other vertical offset elevations. For instance, you can label both the Finished Floor Elevation and the SubGrade elevation of a building pad at the same time using this command. See additional information on the Label Pad Elevation command.
In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

**Auto-Correct For 90 Degree Corners:** This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

**Smooth Polyline:** This option applies for drawing smooth polylines such as a path for a stream. The Bezier smoothing method is used which passes through all the points and smooths only between the points.

**Use Current Drawing Properties:** Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

**Layer:** Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

**Set Color:** Use this button to manually specify a color for the newly created polyline.

**Width:** Specify the width of the newly created polyline.

**Linetype:** Use the "Select" button to manually specify a linetype for the newly created polyline.

**Select Code:** This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the **Point Defaults** dialog box.

**Prompts**

**Command:** 2dp  
[Continue/Extend/Follow/Offset/OPtions/<Pick point or point numbers>]: screen pick a point  
[Arc/Close/Distance/Follow/Offset/Undo/<Pick point or point numbers>]: screen pick a point  
Segment length: 202.55, Total length: 202.55  
[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point  
Segment length: 179.73, Total length: 382.28
Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command: line. To issue any of these options, simply type in the capitalized portion of the Option at the Command: line and press Enter. The default option is always shown between angle brackets <Default>.

Continue: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend: ", you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command: line. Once finished adding segments, they are automatically joined to the original polyline.

Extend: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend: ", you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>]

I - Input mode - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.
R - Right rotate - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.
L - Left rotate - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.
S - Switch direction - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.
T - Total distance - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the Polyline 2D Options dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.
A - Angle change - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a specified angle and then prompts for a distance.
B - Bearing/Azimuth/Turned/Deflection - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.
E - Extend to edge - Extends current segment to another line or entity
U - Undo - Undo last action
X - Quit extend mode - Returns to normal 2D Polyline Draw mode
Help - Displays the descriptions of the Extend options
Enter or Pick Distance - Distance to extend the current segment

Follow: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations:". With this being a 2D Polyline, the answer to this is most likely "NO". You will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a
distance to trace the existing polyline.

**Offset:** With the "Offset" option, you will first be prompted to select an existing polyline or select an existing Centerline (.CL) file. Next, you will be asked to "Specify starting station:" where you will enter the station number of the first polyline vertex. Then, you will be prompted to "Enter Station" and "Enter Offset" for each vertex of the new polyline. Note: To have this option available, you must place a check next to Offset From Centerline in the **Polyline 2D Options** dialog box.

**Pick Point or Point Numbers:** This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

**Arc/Line:** New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

**Close:** This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

**Distance:** This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

- **Cursor** - This method will draw the polyline segment in the direction of your cursor position.
- **Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.
- **Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo:** Undo the last drawn polyline segment.

**Angle Entry Methods**
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

**Pulldown Menu Location:** Draw
**Keyboard Command:** 2DP
**Prerequisite:** None
3D Polyline

This command creates a 3D Polyline. A 3D Polyline is a version of a polyline that can have different elevation at every vertex. 3D Polylines can not have arcs and the program will instead draw a series of short chords to closely follow an arc.

The 3D Polyline command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (3DP). Unless disabled, the Polyline 3D Options dialog box will appear after starting Carlson's 3D Polyline command.

Show Options on Startup: When this option is enabled, the Polyline 3D Options dialog box will display automatically upon starting the 3D Polyline command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.

Prompt for Elevation/Slope: When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

Prompt for Coordinate Point Elevations: This option only applies if you specify a point number from an associated Coordinate (.CRD) file to establish the X,Y,Z values for a new 3D Polyline vertex. When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

Elevation Adder: Use this setting to add a constant elevation value to all default elevation values.

Check Elevation Range: Enabling this option allows you to monitor elevations assigned to 3D Polyline vertices and issue a warning (with options to correct) if the elevation falls outside the specified range. If the proposed elevation of a 3D Polyline vertex falls outside the range specified, the Warning: Elevation Range dialog box is displayed. The Warning: Elevation Range dialog box allows you to assign a new elevation to the vertex, adjust the acceptable range of elevations or turn OFF monitoring of elevations.
Use Surface Model From File: Selecting this option allows you to use a Surface Model (.TIN, .GRD, .FLT) file to determine the elevation for each new 3D Polyline vertex.

Skip Inline Vertices for Extend: This setting applies to the "Extend" option with the Total Distance Sub-Menu option. If enabled, an existing vertex will dissolve when lengthening a 3D Polyline segment.

Prompt To Draw Another: This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

Auto-Correct For 90 Degree Corners: This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

Smooth Polyline: This option applies for drawing smooth polylines such as a path for a stream. The Bezier smoothing method is used which passes through all the points and smooths only between the points.

Use Current Drawing Properties: Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

Layer: Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

Set Color: Use this button to manually specify a color for the newly created polyline.

Width: Specify the width of the newly created polyline.

Linetype: Use the "Select" button to manually specify a linetype for the newly created polyline.

Select Code: This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the Point Defaults dialog box.

Prompts

For A 3D Polyline With A Specified Elevation At Each Vertex:
Command: 3dp
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: screen pick a point
Interpolate/Object/<Elevation> <0.00>: 150.50
Z: 150.50

[Arc/Circle/Distance/Follow/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/OSnap.[/]/Next point or elevation <Interpolate>: 155.25
Z: 155.25, Hz dist: 324.63, Slope dist: 324.66, Slope: 1.5% Ratio: 68.3:1

[Arc/Circle/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/OSnap.[/]/Next point or elevation <Interpolate>: 148.12
Z: 148.12, Hz dist: 272.88, Slope dist: 272.98, Slope: -2.6% Ratio: -38.3:1

[Arc/Circle/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
Command:

For A 3D Polyline With Interpolated Elevations At One or More Vertices:

Command: 3dp

[Arc/Circle/Distance/Follow/Options/<Pick point or point numbers>]: screen pick a point
Interpolate/Object/<Elevation> <0.00>: 91.73
Z: 91.73

[Arc/Circle/Distance/Follow/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/OSnap.[/]/Next point or elevation <Interpolate>: screen pick a point
This point elevation will be interpolated upon completion.

Percent/Ratio/Elevation/Degree/Object/OSnap.[/]/Next point or elevation <Interpolate>: screen pick a point
This point elevation will be interpolated upon completion.

Percent/Ratio/Elevation/Degree/Object/OSnap.[/]/Next point or elevation <Interpolate>: screen pick a point
This point elevation will be interpolated upon completion.

Percent/Ratio/Elevation/Degree/Object/OSnap.[/]/Next point or elevation <Interpolate>: 94.44
Z: 94.44, Hz dist: 79.39, Slope dist: 122.88, Slope: 0.8% Ratio: 122.4:1

[Arc/Circle/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
Command:

Note that the difference between this and the previous example is that, instead of entering an elevation for each vertex, we are screen picking another new vertex. Each time we neglect to enter an elevation we are notified that, "This point elevation will be interpolated upon completion." After we specify "94.44" as the elevation of the last vertex, the slope of the interpolated segments is calculated using the total elevation change and the total length of all interpolated segments. Now, the elevations of all vertices can be determined and set based on the resulting slope.

**Options and SubMenu Options**

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command: line. To issue any of these options, simply type in the capitalized portion of the Option at the Command: line and press Enter. The default option is always shown between angle brackets <Default>.

When starting a new 3D Polyline, the initial set of options assist you in setting the X,Y location of the first vertex:

**Continue**: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:“, you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command: line. Once finished adding segments, they are automatically joined to the original polyline.

**Extend**: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline.
and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:“, you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>]}

**I - Input mode** - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.

**R - Right rotate** - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.

**L - Left rotate** - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.

**S - Switch direction** - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.

**T - Total distance** - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the **Polyline 3D Options** dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.

**A - Angle change** - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a specified angle and then prompts for a distance.

**B - Bearing/Azimuth/Turned/Deflection** - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qddd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**E - Extend to edge** - Extends current segment to another line or entity

**U - Undo** - Undo last action

**X - Quit extend mode** - Returns to normal 3D Polyline Draw mode

**Help** - Displays the descriptions of the Extend options

**Enter or Pick Distance** - Distance to extend the current segment

**Follow**: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?". After answering Yes or No, you will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

**Options**: This will display the **Polyline 3D Options** dialog box.

**Pick Point or Point Numbers**: This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

After setting its location, the next set of options help you calculate the elevation of the initial vertex:

**Interpolate**: This option will set the elevation of the vertex by calculating the slope between other vertices of known elevation.

**Object**: This option allows you to "Select an elevation label or a point on a polyline:" to set the elevation of the vertex. Elevation labels such as "FFE: 124.85" or "Z: 124.85" can be selected.

**Adjust**: This option allows you to add or subtract an amount from the elevation like for a curb offset.

**Elevation**: This is the default option and prompts you to type in the elevation for the vertex.

For subsequent 3D Polyline vertices, several options are added to assist you in setting the X,Y location of each new vertex:

**Arc/Line**: New polyline segments can be either an Arc or a Line segment. If the last polyline segment
drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

**Close**: This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

**Distance**: This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

- **Cursor** - This method will draw the polyline segment in the direction of your cursor position.
- **Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.
- **Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo**: Undo the last drawn polyline segment.

After setting subsequent vertices, several more options are added to help you calculate the elevation of each new vertex:

- **Percent**: This option allows you to specify the slope in Percent format (3%) from the previous vertex.
- **Ratio**: This option allows you to specify the slope in Ratio format (for 3:1, enter 3) from the previous vertex.
- **Degree**: This option allows you to specify the slope angle in decimal degree format (dd.dddd) from the previous vertex.
- **Osnap[.]**: Using the [.] will toggle Running OSNAP settings ON or OFF.

**Angle Entry Methods**
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

**Pulldown Menu Location**: Draw  
**Keyboard Command**: 3DP  
**Prerequisite**: None

---

**Circle**

This command allows you to draw a circle.

**Prompts**

1 Pick center point or point number or [3P/2P/TTR]: pick point or specify option
• 3P: This option draws a circle based on three points on the circumference.
• 2P: This option draws a circle based on two endpoints of the diameter.
• TTR-Tangent, Tangent, Radius: This option draws a circle with a specified radius tangent to two objects.

2 Specify radius of circle or [Diameter]: enter a value

Sometimes more than one circle matches the criteria specified in the command. The circle whose tangent points are closest to the selected points is drawn.

**Prerequisite:** None

**Keyboard Command:** SCIRCLE

### Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the *Edit Symbol Library* command. The locations for the symbols can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. If you specify a point number, and that point number already has a symbol on it, you will be prompted whether or not to replace the existing symbol. Selecting the Enter coords option allows you to insert the symbol by entering a northing, easting and elevation. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Under the Options command, you can turn prompting for rotation on or off. With rotation off, the symbol will be inserted horizontal to the current twist screen. Choose a symbol from the Select Symbol dialog by clicking on it. The Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols.
Appears at start of command

Appears when Select (symbol) is chosen

Select entities dialog box

Prompts
Insert Symbols dialog choose variables and click OK
Options/Select entities/Enter coords/<Pick point or point numbers>: pick a point
Options/Select entities/Enter coords/<Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from
the current coordinate file.
Options/Select entities/Enter coords/<Pick point or point numbers>: 5
Insert Symbols dialog
Select arcs, faces, points, text, lines and polylines. select objects
Options/Select entities/Enter coords/<Pick point or point numbers>: press Enter to end
Keyboard Command: ptsym
Prerequisite: None

Insert Drawing
This command allows you to place a named block or drawing into the current drawing.

1 In the Insert dialog box, you specify the block to insert and define the position for the inserted block. The last
block you insert during the current editing session becomes the default block for subsequent uses of this command.
• Name: This field specifies the name of a block to insert or the name of a file to insert as a block.
• Browse: This button opens the Select Drawing File dialog box (a standard file selection dialog box) where you
can select a block or a file to insert.
2 Under Insertion Point, you specify the insertion point for the block.
• Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
• X: This field sets the X coordinate value.
• Y: This field sets the Y coordinate value.
• Z: This field sets the Z coordinate value.
3 Under Scale, you specify the scale for the inserted block. Specifying negative values for the X, Y, and Z scale
factors inserts a mirror image of a block.
• Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
• X: This field sets the X coordinate value.
• Y: This field sets the Y coordinate value.
• Z: This field sets the Z coordinate value.
• Uniform Scale: This option specifies a single scale value for X, Y, and Z coordinates. A value specified for X is also reflected in the Y and Z values.

4 Under Rotation, you specify the rotation angle for the inserted block.
• Specify On-Screen: This option specifies the rotation angle of the block using the pointing device.
• Angle: This field sets a rotation angle for the inserted block.

5 You can explode the block and inserts to the individual parts of the block. When you select Explode, you specify only an X scale factor.

Prerequisite: None

Keyboard Command: DDINSERT

Write Block

This command allows you to write objects or a block to a new drawing file.

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected. For example, if you have a single block selected when you open the Write Block dialog box, the Source radio button is set to Block.

1 Under Source, you write selected blocks and objects out as a file, and specify insertion points.
• Block: This option specifies an existing block to save as a file. Select a name from the list.
• Entire Drawing: This option selects the current drawing as a block.
• Objects: This option specifies objects to be saved as a file.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.
• X: This field specifies the X coordinate value.
• Y: This field specifies the Y coordinate value.
• Z: This field specifies the Z coordinate value.
• Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.

• Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
• Convert to block: This option converts the selected objects to a block instance in the drawing after you create the block.
• Delete from drawing: This option deletes the selected objects from the drawing after you create the block.
• Select objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
• Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
• Objects Selected: This option displays the number of selected objects.

4 Under Destination, specify the name, location, and unit value used for the objects in the file.
• File Name: This field specifies a file name that the block or objects will be saved to.
• Location: This field specifies the drive and directory path for the file.
• Insert Units: This field specifies the unit value to be used when the new file is inserted as a block. Enter 0 (zero) if you do not want to scale the drawing to a specific value as you insert it.

**Prerequisite:** Drawing entities

**Keyboard Command:** WBLOCK

---

### Text Wizard

This command creates text using a dialog to set the text properties. In the dialog, you set the text string to create, height, justification, layer, style and color. Text Rotation chooses between having the label horizontal to the current view, prompting for the label angle or at a fixed angle specified in the dialog. The Use MText setting controls whether to create the text as a regular Text entity type or as MText. The Use Current Drawing Properties option will use the current layer, style and color from the drawing instead of the dialog.

![Text Wizard Dialog Box](image)

**Prompts**

---

*Chapter 5. Draw Menu* 194
Text

Creates a single-line text object.

You can use the TEXT to enter several lines of text that you can rotate, justify, and resize. As you type at the Enter Text prompt, the text you are typing is displayed on the screen. Each line of text is a separate object. To end a line and begin another, press Enter after entering characters at the Enter Text prompt. To end the TEXT command, press Enter without entering any characters at the Enter Text prompt.

By applying a style to the text, you can use a variety of character patterns or fonts that you can stretch, compress, make oblique, mirror, or align in a vertical column.

If TEXT was the last command entered, pressing ENTER at the Specify Start Point of Text prompt skips the prompts for height and rotation angle and immediately displays the Enter Text prompt. The text is placed directly beneath the previous line of text. The point specified at the prompt is also stored as the Insertion Point object snap.

Prompts

1 Current text style: "MONO" Text height: 4.00
2 Specify start point of text or [Justify/Style]: S
   The style option lets you change the text style on the fly
3 Enter style name or [?] <MONO>: STANDARD
4 Current text style: "STANDARD" Text height: 4.00
5 Specify start point of text or [Justify/Style]: J
   The justify option lets you specify the justification for the text.
6 Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: BC
   In this case BC = Bottom Center
7 Specify bottom-center point of text: pick point or enter coordinates
8 Specify height <4.00>: press enter to select default or enter text height
9 Specify rotation angle of text <0d000": press enter to select default or enter angle
10 Enter text: Found Iron Pin
11 Enter text: press enter to end
Prerequisite: None
Keyboard Command: DTEXT, TEXT

Hatch

This command allows you to fill an enclosed area or selected objects with a hatch pattern.

The Hatch command first defines the boundaries of the area you want to hatch, either by computing a region or polyline boundary from a specified point within an enclosed area, or by using selected objects as boundaries. It then
fills the boundaries with a hatch pattern or a solid color. You can create an associative hatch, which updates when its boundaries are modified, or a nonassociative hatch, which is independent of its boundaries. You can preview any hatch and adjust the definition.

Due to the large number of combinations of geometry that you can hatch, editing hatched geometry can produce unexpected results. In this event, delete the hatch object and rehatch.

The Boundary Hatch dialog box defines the boundary, pattern type, pattern properties, and attributes for hatch objects. Use the Quick Tab to work with hatch patterns and quickly create a hatch. Use the Advanced Tab to customize how TakeOff creates and hatches boundaries.

1 Under the Quick Tab you define the appearance of the hatch pattern to be applied.

- **Type**: This field sets the pattern type.
- **Pattern**: This field lists the available predefined patterns. The six most recently used predefined patterns appear at the top of the list. The Pattern option is available only if you set Type to Predefined.
- ** [...]**: This button displays the Hatch Pattern Palette dialog box, in which you can view preview images for all predefined patterns at once to help you make a selection.
- **Swatch**: This field displays a preview of the selected pattern. You can click the swatch to display the Hatch Pattern Palette dialog box.
- **Custom Pattern**: This field lists the available custom patterns. The six most-recently used custom patterns appear at the top of the list. The Custom Pattern option is available only if you set Type to Custom.
- **Angle**: This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.
- **Scale**: This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.
- **Relative to Paper Space**: This option scales the hatch pattern relative to paper space units. Using this option, you can easily display hatch patterns at a scale that is appropriate for your layout. This option is available only from a layout.
- **Spacing**: This option specifies the spacing of lines in a user-defined pattern. This option is available only if you set Type to User Defined.
ISO Pen Width: This option scales an ISO predefined pattern based on the pen width you choose. This option is available only if you set Type to Predefined and set Pattern to one of the available ISO patterns.

2 Under the Advanced Tab you define how TakeOff creates and hatches boundaries.

- Island Detection Style: This option allows you to specify the method for hatching objects within the outermost hatch boundary. If no internal boundaries exist, specifying an Island Detection style has no effect. Because you can define a precise set of boundaries, it's often best to use the Normal style.

The illustrations that accompany each style show how the program hatches a group of three nested boundary objects in each case.

Normal

Hatches inward from the outer boundary. If the program encounters an internal intersection, it turns off hatching until it encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of intersections are hatched, and areas separated by an even number of intersections are not.

Outer

Hatches inward from the outer boundary. The program turns hatching off if it encounters an internal intersection. Because this process starts from both ends of each hatch line, the program hatches only the outermost level of the structure and leaves the internal structure blank.

Ignore

Ignores all internal objects and hatches through them.
Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies. The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.

- **Object Type:** This option allows you to specify whether to retain boundaries as objects, and specifies the object type TakeOff applies to those boundary objects. Object Type controls the type of the new boundary object. TakeOff creates the boundary as a region or a polyline. This option is available only if you select Retain Boundaries.

- **Retain Boundaries:** This option adds the temporary boundary objects to the drawing.

- **Boundary Set:** This field defines the set of objects TakeOff analyzes when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary. By default, when you use Pick Points to define a boundary, the program analyzes all objects visible in the current viewport. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because the program examines fewer objects.

- **New:** This option prompts you to select the objects that define the boundary set. When you choose this option, the dialog box temporarily closes, prompting you to select objects. TakeOff includes only the hatchable objects you select when it constructs the new boundary set. TakeOff discards any existing boundary set, replacing it with the new boundary set defined by the objects you select. If you don’t select any hatchable objects, the program retains any current set. Until you exit the Hatch command or create a new boundary set, TakeOff ignores objects that do not exist in the boundary set when you define your boundaries using Pick Points.

- **Island Detection Method:** This option allows you to specify whether to include objects within the outermost boundary as boundary objects. These internal objects are known as islands.
  - **Flood:** This option includes islands as boundary objects.
  - **Ray Casting:** This option runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction, thus excluding islands as boundary objects.

3 In the Boundary Hatch dialog box, you set the options that define the selection set.

- **Pick Points:** This option determines a boundary from existing objects that form an enclosed area. How TakeOff detects objects using this option depends on the selected Island Detection Method on the Advanced tab. For example, if the Island Detection Method is Flood, the program detects objects within the outermost boundary as islands and includes them in the boundary definition. The Island Detection Style (which you also set on the Advanced tab) then determines how to hatch the detected islands. When you choose Pick Points, the dialog box closes temporarily, and the program prompts for point specification.

- **Select Objects:** This option allows you to select specific objects for hatching. The dialog box closes temporarily, and the program prompts you for object selection. When you define your boundaries using Select Objects, the program does not detect interior objects automatically. You must select the objects within the selected boundary to hatch those objects according to the current Island Detection Style (which you set on the Advanced tab). Each time you choose Select Objects, the program clears the previous selection set. While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last or all selections, change the selection method, change the island detection style, or preview the hatch.

- **Remove Islands:** This option removes from the boundary definition any of the objects that the program detects as islands when you use Pick Points. You cannot remove the outer boundary.

- **View Selections:** This option temporarily dismisses the dialog box and displays the currently defined boundaries with the hatch settings that you last previewed. This option is unavailable when you have not yet specified points or selected objects.

- **Inherit Properties:** This option hatches specified boundaries using the hatch properties of one object. After selecting the associative hatch object whose properties you want the hatch to inherit, you can right-click in the drawing area and use the shortcut menu to toggle between the Select Objects and Pick Internal Point options to create boundaries.
• Double: For user-defined patterns, this option draws a second set of lines positioned at 90 degrees to the original lines, creating a crosshatch. This option is available only if you set Type to User Defined on the Quick tab.

• Associative: This option creates an associative hatch, meaning that the hatch is updated when you modify its boundaries.

• Nonassociative: This option creates a nonassociative hatch, meaning that it is independent of its boundaries.

• Preview: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the current hatch settings. This option is not available when you have not yet specified points or selected objects to define your boundaries.

Prerequisite: None

Keyboard Command: BHATCH

Curves

2 Tangents, Radius

This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.000>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc

Keyboard Command: 2tanlin

Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Arc Length

This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts

Arc Length <100.00>: press Enter or enter distance
[int on] Pick P.I. of curve: pick intersection of tangent lines
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc

Keyboard Command: 2tanlal

Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Chord Length

This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts
Chord Length <100.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlcl
Prerequisite: Tangent lines should be drawn before execution

Best Fit Curve
This command draws an arc between two endpoints with a radius that is derived from sampling points. Least-squares is used to find the radius for the closest arc that passes through these points. The Hold End Points option applies additional weight to the end points by the specified weight factor. After specifying the points, the program calculates the best-fit arc and shows the results in the dialog box here. You can toggle each point for whether to include in the calculations. When a point is toggled off for processing, it is not used to calculate the best-fit arc but the residual is still reported. Use the Remove button to remove a point both from calculation and reporting. You can also modify the radius. After picking OK, the arc is drawn in the current layer and there is a report.

Prompts
Starting Point?
Pick point or point number: 46
Ending point?
Pick point or point number: 50
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software Points.
Select objects: pick points
Hold end points [Yes/<No>]? press Enter

Best Fit Arc
Coordinate File > C:\sample\PLAT.CRD

Source Coordinates
Point# Northing Easting Residual
46 4573.478 5647.688 -0.059
47 4618.180 5667.428 0.177
48 4680.360 5671.494 -0.211
50 4707.039 5664.138 0.093

Chapter 5. Draw Menu
Residuals Standard Deviation: 0.148
Average Residual: 0.135

Circle Center: 4657.233,5516.647
Radius: 155.580

Pulldown Menu Location: Draw > Arc
Keyboard Command: bfitcrv
Prerequisite: Points for sampling should be drawn before execution.

3 Point
This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either by picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

PC, PT, Radius Point
This command draws an arc between the PC point, radius point and PT point. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/<Yes>: N

PC, Radius, Chord
This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts
Radius of Arc <40.00>: 500
PC Start Point?
Pick point or point number: pick a point
Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
Enter Bearing (Qdd:mmss) <90.0000>: 145.1041 (for NE 45d10'41")
Chord Length <200.46>: 200
Is this arc in the correct direction (<Yes>/No)? Press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcb
Prerequisite: None

3D Arc
This command draws an arc in 3D using three points for input. The points are the beginning of the arc (PC), a point along the arc, and the end of the arc (PT).

Prompts

Pick PC point or point numbers: pick a point
Point on arc.
Pick point or point number: pick a point
PT point.
Pick point or point number: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3darc
Prerequisite: None

Hatch Wizard
This command draws a hatch. The dialog has settings for the Color, Layer, Transparency and Scale for the hatch. The Use Layer/Color of Perimeter Polyline option sets these properties for the hatch from the polyline used for the hatch perimeter instead of from the dialog. The Pick Interior Point to Make Perimeter method defines the hatch area by picking a point in the drawing and having the program find the bounding linework. Otherwise the program prompts to select the inclusion and exclusion perimeter polylines. The Prompt For Exclusions controls whether the program prompts to select closed polylines for areas to exclude from the hatch. The Create Hatch Boundary by Auto-Connecting method creates a closed area for hatching from unclosed linework by joining the selected linework at their endpoints.

After dialog and selecting the hatch area, the program prompts for the hatch pattern. Then the hatch is created.
Prompts

Pick interior point method:
Pick interior point: pick a point
Pick interior point (Enter to end): press Enter

Pick polylines method:
Select the Inclusion perimeter polylines.
Select objects: pick closed polylines to hatch
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Select Text to Exclude from fill or ENTER for none.
Select objects: press Enter
For selected text, the program automatically creates an exclusion box around the text to keep the hatch pattern from covering the text.

Pulldown Menu Location: Draw
Keyboard Command: hatchwiz
Prerequisite: Perimeter linework

Raster Image

This command allows you to manage raster images.
The Image Manager dialog box lists all the image files attached to the current drawing. You can view the parameters and details for selected images. You can attach new image files and detach, locate, reload, and unload existing images.

- **List View:** This button lists the image definitions attached to the drawing. Each image name appears only once regardless of how many times you attach (insert) the image. You can sort the list of images by name, status (loaded, unloaded, or not found), size, type (TIFF, for example), date, or the saved path and file name. By default, TakeOff displays the list alphabetically by image name.

  To select multiple images, hold down SHIFT or CTRL while selecting items.

  To sort the list alphabetically or numerically by a specific column, click that column's heading.

  To change the width of the column, drag the line between the column headings to the right or left. The program saves and restores the settings when you reopen the dialog box.

  To change an image name, select it and then click it again, or select it and then press F2. You cannot edit names of images that reside in external references (xrefs). Image names can include up to 255 characters and can contain letters, digits, spaces, and any special characters not used by Microsoft® Windows® or TakeOff. The image name can be identical to the file name, but changing the image name does not change the file name.

  - **Tree View:** This button displays all the image definitions and the levels of nesting of images within xrefs. The top level of the tree view shows images that you attached directly to the drawing, images nested in block references, and the names of externally referenced drawings containing images. The names of the images attached to the externally referenced drawings appear nested within the drawing at the next tree level. To insert a copy of an already attached image, select it, and then choose Attach.

  Tree view lists the image names only (not file names) and lists the image name just once, regardless of how many times you attach (insert) the image.

  You can edit an image name by selecting it and then clicking it again, or by selecting it and then pressing F2. However, you cannot select more than one image at a time.

  - **Attach:** This option displays the Select Image File dialog box. When you unload and then reload an image, the program draws that image on top. Images remain loaded or unloaded from one drawing session to the next.

  - **Detach:** This option removes the selected image definitions from the drawing database and erases all the associated image objects from the drawing and from the display.

  - **Reload:** This option loads the most recent version of an image or reloads an image that was previously unloaded. Reloading does not control whether the image is displayed, but it ensures display of the most current image.

  - **Unload:** This option unloads image data from working memory without erasing the image objects from the drawing. It is recommended that you unload images no longer needed for editing to improve performance.
unloaded image cannot be displayed or plotted. You can selectively load and unload individual images from a working list of images associated with the drawing file.

- Details: This option opens the Image File Details dialog box, which displays the image name, saved path, active path, file creation date and time, file size and type, color system, color depth, width and height in pixels, resolution, default size in units, and a preview image.

- Image Found At: This field shows the path of the selected image. If you select multiple images, this field remains blank. The path shown is the actual path where the image resides.

- Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). The path you select appears under Image Found At.

- Save Path: This option stores the new path information. Press ESC while editing the path to restore the old path. If the program cannot find the referenced image in the new path, the image's status changes to Not Found. If you do not choose Save Path after editing the path, the program uses the original image path the next time you load the drawing.

2 Under the Image dialog box, you can attach an image.

3 In the Image dialog box, you must first identify the image and the path.

- Name: This field identifies the image you have selected to attach, either from the Select Image File dialog box (an unattached image) or from the list of previously attached images. To add another instance of an image file that is already attached, select the image name from the list and choose OK.

- Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). If Show Preview is selected, the program displays a preview of the selected file.

- Retain Path: This option saves the path of the image file with the image definition. If Retain Path is not selected, only the image name is saved and TakeOff searches the Support File Search Path.

4 Under Insertion Point, you must specify the insertion point for the selected image. Specify On-Screen is the default. The default insertion point is 0,0.

- Specify On-Screen: This option directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.

- X: This field sets the X coordinate value.

- Y: This field sets the Y coordinate value.

- Z: This field sets the Z coordinate value.

5 Under Scale, you must specify the scale factor of the selected image. Specify On-Screen directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default
Under Rotation, you must specify the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value on the command line. If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

**Prerequisite:** Raster image  
**Keyboard Command:** IMAGE

### Place Image by World File

#### Function

This function allows you to insert Geo-Referenced TIF files into AutoCAD drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

#### Prompts

- **Select World File:** choose existing *.TFW or *.JGW file  
- **Keyboard Command:** geotiff  
- **Prerequisite:** None

### Closed Polyline By Interior Text

This command allows you to create closed polylines from existing linework. Select all the entities (lines, arcs, or polylines) you would like to use, specify desired snap tolerance (for joining broken lines), then click inside the boundary you would like to close, and the command will generate corresponding closed polylines. Duplicate polylines are detected and are not created. The new polylines are always created on the current layer; the layers of the original linework are not used.

#### Prompts

1. Select polylines: **pick entities**  
2. Select objects: **pick entities**  
3. Select objects: **Press Enter**  
4. Enter snap tolerance <0.0>: **enter a value**  
5. Pick an internal point: **pick a point**  
- **Prerequisite:** Entities on screen.  
- **Keyboard Command:** BOUNDPL

### Shrink-Wrap Entities

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap
polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points. The Interior Void method creates a closed boundary polyline for an empty area that is surrounded by points such as a pond.

Example of Interior Void method
Prompts

Shrink-wrap across gaps or bounded linework only [<Gap>/Bound]? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Reading points... 46
Inserted 46 points.
Inserted 23 breakline segments
Perimeter reduction level 0-3 (0-None, 3-Most) <2>: 2
Reduce Perimeter Pass: 1 Removed: 5
Reduce Perimeter Pass: 2 Removed: 3
Reduce Perimeter Pass: 3 Removed: 4
Reduce Perimeter Pass: 4 Removed: 2
Reduce Perimeter Pass: 5 Removed: 1
Reduce Perimeter Pass: 6 Removed: 0
Create 2D or 3D Polyline [<2D>/3D]? 2D

Pulldown Menu Location: Draw
Keyboard Command: swplines
Prerequisite: Entities

Sequential Numbers

This command draws a text label and then increments to the next value for additional labels. The label can optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size.

In the dialog, specify the Text label. The text Prefix and Suffix are optional. The Text Size Scaler is the text size in paper units that gets multiplied by the horizontal scale from Drawing Setup to set the text drawing size or Text Size Dwg Units. The Justification setting controls the text justification mode. The Size By Symbol method uses a fixed symbol size and sizes the label to fit within the symbol. When Auto Increment Labels is checked, the value entered in the Text field will be incremented by the value in the Increment field. The Group Label With Symbol option will make a group of the label text and symbol. When Prompt for Alignment Every Time is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels. The Draw Leader option creates a leader from the label to a picked point.

The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.
Chapter 5. Draw Menu
Building Envelope Polyline

This command creates a rectangular polyline around selected linework. This can be used to give a building all one elevation.

Select the entities that make up the building. Next you will be prompted to name the layer and to set an offset distance (The above example is offset by 5 feet). Also, you can set the elevation of the envelope and trim crossing linework to ensure you have a flat pad.
Prompts

Draw Building Envelope dialog
Select building lines.
Select objects: pick the linework that makes up the perimeter of the building
Draw another building envelope [Yes/No]? N

Prerequisite: a pad

Keyboard Command: bldg.perim

Drawing Annotation

Distance with Leader
This command labels the distance of a line or polyline segment at a point then draws a user specified leader line to point to the defining line. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Define distance by, Points/Select line or polyline: select a line
Pick point to start leader: pick a point near the line
Label Position: pick a point
Define distance by, Points/Select line or polyline: press Enter to end

Keyboard Command: distlead
Prerequisite: None

Label Arc
This command labels the arc data along the arc between the endpoints of the arc. The curve information is also displayed. The format for the label is set in the dialog shown here. For each arc data value, you can specify the label, the row number, and the side of the arc it will appear on. If a row number is left blank, then that value is not
labeled. There is a choice of labeling inside or outside of the arc. Annotation is drawn as a block. The advantage of this is that the characters, rather than being individual entities, are plotted as a single entity that can be moved and edited as a unit. You would need to explode the "blocked" text in order to edit the text. A toggle button determines whether the user wants to flip the text on arcs that open to the top of the drawing.

Prompts

Define arc by, Points/<select arc or polyline>: select arc
After selecting the arc or polyline arc segment the command displays the dialog below. Select the OK button and the arc is labeled with the current settings of the dialog.

Examples of Label Arc (above and below)
Example of Stack Label Arc

**Pulldown Menu Location:** Annotate > Annotate Arc  
**Keyboard Command:** labarc  
**Prerequisite:** Arc or polyline should be drawn before execution

### Curve - Arrow

Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point. This routine also has a Zorro option which creates a Z leader curve. The Draw Text option will make the program prompt after the leader points for a text label to place at the end of the leader.

### Prompts

- **Pick a starting point:** *pick a point*
- **Pick an ending point:** *pick a point*
- **Pick an intermediate point (U to Undo):** *pick a point*
- **Pick an intermediate point (U to Undo):** *press Enter*
Special Leader

This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the Drawing Setup command. On the command line, selecting O for Options will provide you with more customizing choices to make.

Prompts

Options/Pick Arrow Location: pick a point Pick point where leader arrow will start.
Text location: pick a point
Text: Monument
Text: press Enter
symbols size are controlled by the Line Type Spacing and Symbol Size Scaler settings in the dialog. The Gap Size Scaler controls the size of the break in the line for the linetypes that have a break like UserDef and Arrow_B. The Gap Size Scaler is multiplied by the symbol size to get the gap size in drawing units. To select a linetype from the dialog, pick on the linetype image. Use the Next button to see more linetypes. At the end of the list of linetypes, there are two special choices. The UserDef choice lets you enter your own text string into a linetype, and the Wingdings choice lets you insert any Wingdings font character into a linetype. Consult Windows® documentation for a listing of Wingdings characters.

Prompts

Select Linetype dialog select linetype and adjust other variables
Select items to change.
Select objects: pick the polylines
Linetype styles available using Change Polyline Linetype

**Pulldown Menu Location:** Annotate > Line Types  
**Keyboard Command:** pltype2  
**Prerequisite:** Polylines

### Polyline to Tree Line

This command changes a polyline into a series of semicircles for representing a tree line.

**Prompts**

- **Side for arcs on polyline direction? (<Left>/Right) press Enter**
- **Enter the segment distance <10.0>; press Enter**
- **Select the polylines to convert.**
- **Select objects:** *pick one or more polylines*

---

**Before and After Polyline to Tree Line**

**Pulldown Menu Location:** Annotate > Line Types  
**Keyboard Command:** maketree  
**Prerequisite:** Polyline

### Title Block

This function is different depending on your AutoCAD version
Function (AutoCAD R14)

This command draws a border and title block for the selected sheet size. The margins to use are specified at the bottom of the dialog. Margins are needed so that the border fits in the plotter's plotable area. For sheet 11x17 or smaller, a 1/2 inch margin is typical. For larger sheets, a typical margin is 3/4 inch. The LIMITS of the drawing can be set to the lower left and upper right corners of the border. To change the title block, edit the drawing TBLOCK.DWG in the \SUP directory. Click the toggle User Defined to set a custom sheet size. The default user defined size can be stored in the Configure TakeOff command under the General Settings option. After the title block is drawn, the contents can be edited using the Attribute Edit command under the Modify menu. The Change Scale button will change the scale for the title block and for the drawing.

Function (AutoCAD R2000 and up)

This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The *other* choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the dialog. On the right-hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and its waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.

Prerequisite: set horizontal scale in Drawing Setup

Keyboard Command: tblock
Title Block Dialog for R2000 & up

Barscale
This command draws a barscale. You will be prompted for the horizontal scale. The default value is set in the Drawing Setup command in the Settings menu.

```
0'  50'  100'  150'
```

Prompts
1 Insertion Point: pick a point
2 Horizontal scale <50.0>: Press Enter

Prerequisite: None

Keyboard Command: BARSCALE

North Arrow
This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the Edit Symbol Library command on the Settings menu.
Prompts

**Draw North Arrow Dialog** choose an arrow symbol, layer and other variables

**Specify insertion point:** pick a point

**Keyboard Command:** narrow

**Prerequisite:** None
Digitize Menu
Tablet

**Tablet On**
Executes AutoCad's TABLET command to set the tablet on. Refer to the AutoCad Reference manual for further information.

Note: Function key [F4] can toggle on/off tablet.

**Keyboard Command:** tablet

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up.

**Tablet Off**
Executes AutoCad's TABLET command to set the tablet on. Refer to the AutoCad Reference manual for further information.

Note: Function key [F4] can toggle on/off tablet.

**Keyboard Command:** tablet

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up.

**Tablet Calibrate**
You can calibrate the tablet/digitizer in one of two ways: **Known Reference Points** or **Drawing Scale with New Reference Points**. Reference points are the foundations of whatever data you digitize into the computer. Takeoff bases everything from drawing location to drawing scale on the reference points you digitize.

**Drawing Scale with New Reference Points** method is very convenient when you don't know the precise coordinates of the entities on your drawing. As long as you can obtain the drawing scale from your plan, this method can establish a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). Takeoff would compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display on the **Tablet Calibration Dialog** next time when you calibrate the tablet, so you can digitize back to the previous coordinates using **Known Reference Points** method if you are working on the same drawing, though you might have moved or rotated your drawing on the digitize board..

If you know the precise coordinates of two points, you can select **Known Reference Points** method, which establishes a coordinate system that is exactly match the coordinates in the field or on your drawing. Furthermore, Takeoff saves the coordinates of the two reference points from previous calibration and displays them on the **Tablet Calibration Dialog** next time when you calibrate the tablet. If you want to continue to work on the same drawing, you can use the **Known Reference Points** method with the saved coordinates to digitize back to your previous coordinates although you might have moved or rotated your drawing on the digitizer board.

For accurate takeoff calculations, choose two points that can be easily found in the field and are farther apart rather than closer together.
Prompts

**Tablet Calibration Dialog**
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

**Pick first reference point:** *pick a point on the drawing*

**Pick second reference point:** *pick another point on the drawing*

**Keyboard Command:** digsetup

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up.

**Save Tablet Calibration**
This command saves current tablet calibration to a file. You are prompted to enter a file name.
**Keyboard Command:** tablet1  
**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

---

**Load Tablet Calibration**

This command restores the tablet calibration parameters from a file and load it into the current drawing. You are prompted to specify a file name.

**Keyboard Command:** tablet2  
**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. The calibration file should be associated to the current drawing, and the current drawing shouldn't have been moved on the digitizer board since last calibration.

---

**Digitizer Settings**

This command allows you to select the puck layout and set Auto On/Off features.

![Digitizer Settings](image)

**Auto Tablet On For Digitize Commands** means after you select a digitize command your puck will automatically be put in Digitize Mode. If this is toggle off, then you will need to turn Tablet on separately from running a digitize command.

**Auto Tablet Off After Digitize Commands** means you will return to Mouse Mode after running a digitize command. Read below for more on Mouse and Digitize Mode.

---

**Puck Layout**

The 16-button puck can be used as either a mouse or a digitizer. It's very important to understand how the 16 buttons are mapped in both modes.

---

**Mouse Mode**

When the tablet is off, the puck is in Mouse Mode. The top-left button is the left mouse click, and the top-right button is the right mouse click. The labels on the other buttons do not mean anything. All buttons are mapped as same as the buttons of the default pointing device in AutoCad. Please refer to AutoCad Reference manual for further information.

---

**Digitize Mode**
When tablet has been calibrated and is on, the puck is in digitize mode. It is mapped as a small keyboard, which enables you to enter numerous values such as elevation, thickness and offset etc., and also provide you some functionality to digitize various entities. Currently there are two puck layouts in Takeoff, shown in the figure below. After you install Carlson Takeoff and finish setting up the digitizer, you go to the pull-down menu Digitize->Puck Layout to select a 16-button puck layout. A button mapping would be created and Takeoff would recognize the buttons as represented.

![Digitizer Settings Dialog](image)

 ![Digitizer Puck Layouts](image)

Layout 1 is Carlson Puck Layout, which is the most common layout used in Carlson Takeoff. Layout 2 is for users who don't have a Carlson Puck. If your puck is different than these two layouts, please contact Technical Support for help setting the mapping for your 16 button puck.

**Prompts**

**Digitizer Settings Dialog**
Specify the Digitizer Puck Layout to layout 1 or 2

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed.

**Keyboard Command:** dig_config

**Digitize Existing**

This sets the layer target to existing. Set this prior to running any digitizing command and anything you digitize will be assigned for your existing surface. Checkout the Define Layer Target/Material/Subgrade command under Tools for more on targets.

**Keyboard Command:** set_digit_exist

**Prerequisite:** none

**Digitize Design**

This sets the layer target to design. Set this prior to running any digitizing command and anything you digitize will be assigned for your design surface. Checkout the Define Layer Target/Material/Subgrade command under Tools.
Digitize Other

This sets the layer target to other. Set this prior to running any digitizing command and anything you digitize will be assigned to the Other target. Checkout the Define Layer Target/Material/Subgrade command under Tools for more on targets.

**Keyboard Command:** set_digit_other  
**Prerequisite:** none

Digitize Point

This command allows you to digitize individual points one at a time. The first time it prompts you the Digitize Points Dialog for entering point symbol styles, point prompt settings and number settings, starting point number and layer name. If you want to enter the elevation and description for each point, select Prompt for Descriptions and Prompt for Elevations. After having digitized a point, you can continue to digitize next point by picking the point on the drawing. The command defaults to the last layer name, point symbol, elevation, description and the last point number plus 1. If you have finished digitizing points, press Enter to finish.

**Prompts**

**Digitize Points Dialog**
Specify a layer name and select the point symbol, point prompt settings and number settings.

**Pick point to create (Enter to end):** pick a point on the drawing  
**Select/Enter Point Elevation <>:** enter the elevation or type <Select> to select the elevation text on the screen  
**Enter Point Description <>:** enter the point description

Result like "N: 1231.16 E: 1099.17 Z: 30.00" would be display on the command line, and a point would be drawn

---

**Chapter 6. Digitize Menu** 225
on the screen with the text of its number, elevation and description.

**Pick point to create (Enter to end):** pick next point or press Enter to finish digitizing points

**Keyboard Command:** dig_pt

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

## Digitize Spot Elevation

This command allows you to label points with their elevation. The point can either be digitized from a drawing, picked on a screen or specified by a point number. The command first prompts you the **Label Spot Elevation Dialog** for entering layer name, label prefix and suffix and symbol types etc. Click OK to start. After specifying the point, the command prompts you to enter the elevation if its elevation is unknown and then pick an angle from the location of the point to label the elevation. You can repeat labeling points until you press **Enter** to finish.

![Label Spot Elevation Dialog](image)

### Prompts

**Label Spot Elevation Dialog**
Specify a layer name, label prefix and suffix and select the spot symbol.

**Point to Label?**

- **Pick point or point number:** 2 (enter a point number)
- PointNo. Northing(Y) Easting(X) Elev(Z) Description
  2 1231.16 1099.17 30.00 bb
- **Note:** if the point number you entered is not in the drawing, you will be prompted again to pick point or enter a point number.
- **Elevation <30.000>:** press enter
- **Pick angle for label:** pick an angle from the spot

**Point to Label (ENTER to End)?**

- **Pick point or point number:** pick a point on the drawing
- **Elevation <0.000>:** enter elevation
- **Pick angle for label:** pick an angle from the spot

**Point to Label (ENTER to End)?**

- **Pick point or point number:** press enter to finish
Keyboard Command: labspot
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

**Digitize 2D Polyline**

A 2D polyline is a line of connected points that have the same elevation. This command lets you digitize a 2D polyline by picking points along the lines on the drawing. It prompts you first the **Polyline 2D Options Dialog** for entering the layer name. **Prompt For Polyline Elevation** option allows you to enter the elevation for each polyline, otherwise all 2D polylines have 0.0 elevation. **Auto-Zoom** mode would automatically zoom the display to center around the last point when you get near the edge of the screen while picking points. There are three ways to enter a layer name, **Use current drawing layer**, **Select** from a list of layer name, or **Pick** an entity on the screen to get its layer name. While digitizing a polyline, the command keeps prompting you to either pick the next point or press 0 to create an Arc until your press Enter to finish digitizing. **Press A** on the puck or enter Close on the keyboard to close the polyline on itself. You can define an Arc by Radius, Arc length, Chord length, Delta angle, or by simply picking 3 points along the arc. If at any point you make a mistake, press B on the puck or enter Undo on the keyboard to remove the mistake and then continue to digitize. After finishing a polyline, the command prompts you to digitize another polyline until you press B or enter No.

Prompts

**Polyline 2D Options Dialog**
Enter the layer name and select the options of Prompt For Polyline Elevation and Auto-Zoom mode etc.

- **Enter default elevation <0.00>:** 100
- **First point:** pick a point on the drawing using puck
- **Segment length:** 0.00, **Total length:** 0.00
- **Arc[0]/Close[A]/Undo[B]/Osnap/.]/Pick next point (Enter to end):** pick next point
- **Segment length:** 119.03, **Total length:** 119.03
- **Arc[0]/Close[A]/Undo[B]/Osnap/.]/Pick next point (Enter to end):** pick next point

Chapter 6. Digitize Menu 227
Digitize 3D Polyline

A 3D polyline is a line of connected points that have various elevations, and the slope between points is constant. It can be used in defining pads, excavations, drainage ditched and slopes from proposed design features to meet existing site conditions. This command lets you digitize a 3D polyline by picking points along the lines on the drawing. It prompts you first the **Polyline 3D Options Dialog** for entering the layer name. **Elevation Adder** allows you to truncate the elevations you have to enter in by add a given amount to them. There are five ways to enter elevations: known elevation of the point, interpolate, slope from previous point, ratio from previous point and degree from previous point. You can choose one of the methods between picking points. **Auto-Zoom** mode would automatically zoom the display to center around the last point when you get near the edge of the screen while picking points. While digitizing a polyline, press A to interpolate the elevation or B to enter it in. The command keeps prompting you to either pick the next point or press 0 to create Arc cords until you press Enter to finish digitizing. **Press A** on the puck or **enter Close** on the keyboard to close the polyline on itself. You can define Arc cords by Radius, Arc length, Chord length, Delta angle, or by simply picking 3 points along the arc. You can also use the OSNAP command to pick points by pressing the decimal [.] button on the digitizer puck. If you make a mistake, press B on the puck or **enter Undo** on the keyboard to remove the mistake and then continue to digitize. After finishing a polyline, the command prompts your to digitize another polyline until you **press B** or **enter No**.

---

**Prompts**

Chapter 6. Digitize Menu 228
First point: 
Interpolate[A]/screen Pick/<Elevation[B]> <0.00>: 256
Z: 256.00

Arc[0]Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): Pick point
Slope/Ratio/Interpolate[A]/Degree/screen Pick/<Elevation[B]> <256.00>: A
Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]/Next point or elevation <Interpolate>: Pick point
This point elevation will be interpolated upon completion.
Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]/Next point or elevation <Interpolate>: 279
Z: 279.00, Hz dist: 30.01, Slope dist: 37.81, Slope: 76.6% Ratio: 1.3:1
Arc[0]Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): Pick point
Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]/Next point or elevation <Interpolate>: Press Enter
Z: 279.00, Hz dist: 24.18, Slope dist: 24.18, Slope: 0.0% Ratio: 0.0:1
Arc[0]Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): A
Digitize Another EXIST_PLINE Polyline [Yes(A)/<No(B)>]? B
<Tablet Off>

Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Keyboard Command: dig_3dp

Digitize Rectangle

This command enables you to quickly create rectangles while digitizing. In the dialog, you can pick to set elevations to the rectangles, otherwise all rectangles will have 0.0 elevation. The Elevation Adder will be added to the value you enter in for the prompt "Enter polyline elevation <0.00>:". For example, if you know all the rectangles you are creating are in the 200s for elevation, you can put in this value for the Elevation Adder and simply put 46, 54, 57, etc. when prompted, and your rectangles will end up with the elevations of 246, 254, 257 etc. There are three ways to enter a layer name, Use current drawing layer, Select from a list of layer name, or Pick an entity on the screen to get its layer name. Auto-Zoom mode would automatically zoom the display to center around the last point when you get near the edge of the screen while picking points.

Annotate closed pads will label your rectangles according to the Settings button/dialog shown below:
In this dialog, you can enter in a Prefix or a Suffix to the elevation, and determine the labels position, orientation, precision out to 5 decimal places, its layer, and text size.

Prompts

**Target surface: Design**

**Digitize Rectangle Dialog** Make any chances you desire in the above dialogs.

**Enter polyline elevation** <0.00>: 200

**First point:** pick a point on the drawing using puck

**Segment length:** 0.00, **Total length:** 0.00

**Close[A]/Undo[B]/Osnap[.]/**Pick next point: pick next point

**Segment length:** 1105.96, **Total length:** 1105.96

**Close[A]/Undo[B]/Osnap[.]/**Pick next point: pick next point

**Segment length:** 426.83, **Total length:** 1532.79, **Area:** 236021.59

**Close[A]/Undo[B]/Osnap[.]/**Pick next point (Enter to end): After 3 points you can press (A) for Close to create a rectangle

**Digitize Another FINAL_PAD Polyline [Yes(A)/<No(B)>]?: B for No**

**Prerequisite:** a digitizer

**Keyboard Command:** DIG_RECT

---

**Digitize Perimeter**

Perimeter is a 2D polyline that all points on it have the same elevation. It can be used as boundary polyline of your targets on your drawing. This command allows you to digitize a perimeter by picking points on the drawing. While digitizing a polyline, the command keeps prompting you to pick next point until your press Enter to finish digitizing, or press A on the puck or **enter Close** on the keyboard to close the polyline on itself. If you make a mistake, press B on the puck or **enter Undo** on the keyboard to remove the mistake and then continue to digitize. After finishing a perimeter, the command prompts your to digitize another polyline until you press B or **enter No**.

**Prompts**

**First point:** pick a point on the drawing using puck

**Segment length:** 0.00, **Total length:** 0.00

**Close[A]/Undo[B]/**Pick next point (Enter to end): pick next point

**Segment length:** 104.27, **Total length:** 104.27

**Close[A]/Undo[B]/**Pick next point (Enter to end): pick next point

**Segment length:** 153.14, **Total length:** 257.41

**Close[A]/Undo[B]/**Pick next point (Enter to end): pick next point

**Segment length:** 104.89, **Total length:** 362.30
Digitize Another PERIMETER Polyline [Yes(A)/<No(B)>]? press A or enter Yes to continue digitizing another perimeter, press B or enter No to finish digitizing perimeters.

Keyboard Command: dig_perim
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

**Digitize Areas**

This command allows you to find an area in digitize mode. With the puck, pick around the area you wish to calculate. If Draw Perimeter Polyline is toggled on then the linework of your perimeter will be displayed. You can then set the Layer Name and choose to label the Perimeter and Area and enter in an Area Description. You can also set the area you created as a Boundary, Topsoil, or Area of Interest.

Prerequisite: a digitizer
Keyboard Command: dig_area

**Digitize Contour Polyline**

A contour is a line of points with a constant elevation, representing the natural contour of the site. In Takeoff, there are two layer targets: Existing Ground Surface and Design Surface. Contour Polyline has two sub-command to digitize contour lines into Existing Contour and Final Contour layers directly for assigning them easily into Existing Ground Surface and Design Surface in the future analysis.

There are two ways to digitize contour lines: sketch mode or point mode. You can start digitizing a contour with one mode and switch to the other during digitizing the contour. Sketch mode uses more points than pick mode. In general, we recommend using pick mode to digitize the straight parts of lines because it reduces the number of points and speeds up Takeoff’s calculations, but using sketch mode to digitize the curved parts because it is fast and accurate.

This command lets you digitize contours as polylines one at a time. The first time it prompts you the Digitize Contours Dialog. Enter the layer name or select it from a list of existing layer. Look at your plans and determine an elevation interval that is between most of the contours and enter it in the Elevation Interval field. You are able to modify both the value and the direction of the elevation interval between digitizing contour lines, using the buttons on the puck. To have Takeoff automatically close contours whose beginning and ending points are within a specified range, check the Auto Detect Close Contour. Draw Labels would draw the elevation at the starting point of the contour. In Pick mode, if you want the Takeoff to automatically zoom the display to center around the last point when you get near the edge of the screen while picking points, check the Auto Zoom Center. Click OK to
start digitizing.

If this is your first time digitizing a contour, you are defaulted to the Pick Mode digitizing, otherwise you would be defaulted to the last digitize mode. If you want to use the other digitize mode, press 0 on the puck or enter 0 from the keyboard. Place your cursor at one end of the contour line and begin digitizing the line. While digitizing a line, you can force a contour to close on itself by pressing A on the puck to end the contour and connect the last point to the first point, remove a mistake by pressing B on the puck, or switch to the other digitize mode by pressing 0. During Sketch Mode digitizing, you can stop digitizing by pressing Pick or Enter button on the puck, take some rest or changes, and start sketching again. At the end of the contour line, press Enter on your puck or keyboard. The contour is completed, and the elevation for the next contour is automatically incremented. You would be asked to digitize next contour. If you press A on the puck or enter Yes on the keyboard, you can digitize another contour, or press B on the puck or enter No on the keyboard to finish digitizing contours.

Prompts
Digitize Contours Dialog
Enter Layer Name, Elevation Interval, and toggle on/off Auto Detect Close Contour etc.
Increment(1.00)[A]/Direction(+)[B]/Elevation <573.00>: 450 (enter elevation or press Enter to accept current value)
Start Digitizing...
Sketch[0]/Pick the first point: pick a point to start Pick Mode digitizing (press 0 to switch to Sketch Mode)
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): 0 (press 0 on the puck or enter 0 on the keyboard to use Sketch Mode)
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): pick and drag
Drag to digitize (Pick or press Enter to stop sketching)... pick or press Enter to stop sketching
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): B (undo the last point)
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): B (undo the last point)
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): pick and drag again
Drag to digitize (Pick or press Enter to stop sketching)... pick or press Enter to stop sketching
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): 0 (press 0 on the puck or enter 0 on the keyboard to use Pick Mode)
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): press Enter to finish digitizing
Digitize Another Contour [<Yes(A)>/No(B)]: B (press B to finish digitizing)

Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.
**Digitize Profiles**

This command allows you to digitize profile lines and store the profile data into the profile file (.pro) you have specified. The command first prompts you the **Digitize Profile Dialog**. Enter the profile file name and determine if you want to digitize up to five profiles from the same grid. Next, determine the **Profile Type**: Ground, Road, or Pipe. Selecting Road will prompt you for a "Vertical Curve" to be applied between the current point and previous profile point. If no Vertical Curve exists, type "0"; entering without specifying any Vertical Curve will turn off the VC prompt on subsequent profile points. Selecting Pipe will prompt you for a "Step up for the pipe" and "Enter the Pipe size" at each profile point. With Ground, there are no additional prompts.

Towards the bottom half of the dialog, there are toggles for **Prompt for Station** and **Prompt for Elevation**. These will show you a preview value for the Station and Elevation based on the point that you picked. Press Enter to except or type in a new value in manually. This is most useful for accurate import of Road and Pipe data. Also at the bottom, **Preview Method** offers 2 ways to view the profiles as you digitize. "Graphic Dialog" displays the profile data in a grid dialog and is best when digitizing from paper plans. "Draw on Drawing" draws 2D polylines in your CAD drawing and is best when digitizing over an Image in your drawing. "Keep Drawing Preview" will leave the 2D polylines in your CAD drawing (having this checked off will erase the 2D polylines after each station).

After clicking OK in the main dialog, Takeoff prompts you to calibrate the profile sheet before you digitize the profile lines. You will pick three points and specify their station and elevations in order to determine the horizontal and vertical scales. Corners on the profile grid are preferred reference points. Once calibrated, place your cursor at one end of the profile line and begin digitizing the line. While digitizing a line, you can remove a mistake by pressing A on the puck or entering Undo on the keyboard. At the end of the profile line, press Enter on your puck or keyboard. The command then prompts you to digitize the next profile. You can press A on the puck or enter Exit on the keyboard to finish digitizing. After you digitize the profile lines on your drawing, all the profile data would be saved in a profile file (.pro).
Prompts

Calibrate profile sheet
Pick First profile sheet reference point: pick a grid point of a station on your drawing
Enter station <0.0>: 1000 press Enter to accept the station or enter a new station value
Enter elevation: 95 (enter the Elevation of the reference point)
Pick Second profile reference point: pick a second grid point
Enter station: 1200 (enter the grid's station)
Enter elevation: 110 (enter the Elevation of the reference point)
Pick Third profile reference point: pick a third grid point
Enter station: 1500 (enter the grid's station)
Enter elevation: 105 (enter the Elevation of the reference point)
3 calibration points
Transformation type: Orthogonal Affine Projective

Outcome of fit: Success Exact Impossible
RMS Error: 11.49
Standard deviation: 2.38
Largest residual: 14.08
At point: 2
Second-largest residual: 14.08
At point: 1

Digitize break point/ (Enter to end): pick a point on the profile line
Station: 1000 Elev: 106.77

Digitize break point (Undo[A],Enter to end): pick a point on the profile line
Station: 1145 Elev: 101.18

Digitize break point (Undo[A],Enter to end): pick a point on the profile line
Station: 1440 Elev: 100.49

Digitize break point (Undo[A],Enter to end): press Enter to finish

Keyboard Command: digprof
Prerequisite: For "on-screen" digitizing, have an image loaded and Digitizer Settings set to "Use Mouse". For paper plans, have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Digitize Sections

This command allows you to digitize section lines and store the section data in the section file you have specified. The command first prompts you the Digitize Section Dialog. Enter the section file name and determine if you want to digitize second and third sections at the same station (i.e., for existing, finish grade, unsuitable, etc.). Look at your plans and determines the station interval, which is used to automatically default to the next station value when digitizing a series of stations. If the grids at all the stations have the same base elevation, toggle on Use Fixed Base Grid Elevation. The Interpolate Zero Offset Elevation option calculates a section point at the zero offset when the zero offset point isn't digitized. The Prompt for Save for Each Section option can be used to save the SCT file after completing each station. The Use Beeps with Prompts option gives audio feedback to help keep your eyes on the sheet. Surface Snap Tolerance sets the maximum distance that the program will automatically snap the tie back point between the subgrade and design surface. The Prompt For Descriptions option will prompt for a description for each digitized section point.

There are two ways to account for Subgrades. Prompt For Subgrade By Depth will ask you for a sub-
grade depth while you are digitizing a section file and apply that subgrade depth below each point you pick for that section. If no subgrade linework is shown on the plans, but the depth is known, this is a good option. **Prompt For Subgrade By Pick** allows you to digitize in the subgrade linework after initial section has been digitized. This option is best when your Subgrade Depth is not uniform.

**Preview Method** offers 2 ways to view the sections as you digitize. "Graphic Dialog" displays the section data in a grid dialog and is best when digitizing from paper plans. "Draw on Drawing" draws 2D polylines in your CAD drawing and is best when digitizing over an Image in your drawing. "Keep Drawing Preview" will leave the 2D polylines in your CAD drawing (having this checked off will erase the 2D polylines after each station). Click OK to start digitizing.

Takeoff prompts you to calibrate the section sheet before you digitize the section lines. You pick three points and specify their offsets to the centerline and elevations in order to determine the horizontal and vertical intervals. Corners on the section grid are preferred reference points. Place your cursor at one end of the section line and begin digitizing the line. While digitizing a line, you can remove a mistake by pressing A on the puck or entering Undo on the keyboard. At the end of the section line, press Enter on your puck or keyboard. The station is completed, and the station value is automatically incremented. The command would prompts to digitize next section. You can press A on the puck or enter Exit on the keyboard to finish digitizing. If you want to continue to digitize next section, press Enter or enter the new station number. For every station after the first one, you can calibrate the grid sheet by picking one reference point and specify its offset and elevation. After you digitize the section lines on your drawing, all the section data would be saved in a section file (.sct).

**Prompts**

**Digitize Section Dialog**
Enter Section File Name, Station Interval, and toggle on/off Use Fixed Base Grid Elevation etc.

**Section station to digitize <0.000>:** press Enter to start with station 0.0 or enter a station number

**Calibrate section sheet**

**Pick First section sheet reference point:** pick a grid point of this station on your drawing

**Enter offset <0.000>:** press Enter to accept the offset or enter the offset of the point to the centerline

*Chapter 6. Digitize Menu* 235
Enter elevation: 1030 (enter the Elevation of the reference point)
Pick Second section reference point: pick the second grid point
Enter offset: 0 (enter the offset of the point to the centerline)
Enter elevation: 1040 (enter the Elevation of the reference point)
Pick Third section reference point: pick the third grid point
Enter offset: 50 (enter the offset of the point to the centerline)
Enter elevation: 1040 (enter the Elevation of the reference point)

3 calibration points
Transformation type: Orthogonal Affine Projective

Outcome of fit: Success Exact Impossible
RMS Error: 11.49
Standard deviation: 2.38
Largest residual: 14.08
At point: 2
Second-largest residual: 14.08
At point: 1

Digitize break point for DRA WING1 section 0.000 (Enter to end): pick a point on the section line
Offset: -39.81 Elev: 1028.80

Digitize break point for DRA WING1 section 0.000 (Undo[A],Enter to end): pick a point on the section line
Offset: -9.94 Elev: 1030.03

Digitize break point for DRA WING1 section 0.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 49.44 Elev: 1034.93

Digitize break point for DRA WING1 section 0.000 (Undo[A],Enter to end): press Enter to finish
Save changes to DRA WING1 section 0.000 [<Yes(A)?>/No(B)]] A (press A or B)
Exit[A]/Section station to digitize <50.000>: 200 (enter next station number)
Calibrate next section
Pick section reference point: pick a grid point of the station on your drawing
Enter offset <0.00>: press Enter to accept the offset or enter the offset of the point to the centerline
Enter elevation <1030.00>: 1020 (enter the Elevation of the reference point)
Digitize break point for DRA WING1 section 200.000 (Enter to end): pick a point on the section line
Offset: -40.40 Elev: 1008.07

Digitize break point for DRA WING1 section 200.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 5.38 Elev: 1019.98

Digitize break point for DRA WING1 section 200.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 27.86 Elev: 1030.02

Digitize break point for DRA WING1 section 200.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 50.33 Elev: 1035.80

Digitize break point for DRA WING1 section 200.000 (Undo[A],Enter to end): press Enter to finish
Save changes to DRA WING1 section 200.000 [<Yes(A)?>/No(B)]] A (press A or B)
Exit[A]/Section station to digitize <250.000>: A (press A to finish or enter the station number to continue)

Keyboard Command: digxsec
Prerequisite: For "on-screen" digitizing, have an image loaded and Digitizer Settings set to "Use Mouse". For paper plan digitizing, have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Digitize End Areas

There are two types of end areas: cut area and fill area. This command allows you to digitize both cut area and fill area on the drawing and writes data to a .ew file. The command first prompts you to calibrate the section sheet by picking three points and specify their offsets to the centerline and elevations in order to determine the horizontal
and vertical intervals. Corners on the section grid are preferred reference points. Then it prompts you to digitize the cut area and fill area respectively. Place your cursor at one end of the end area and begin digitizing the outline of the area. At the end of the section line, press Enter on your puck or keyboard. The end area is completed, and its area is printed on the command line, and you are prompted to digitize next end area. After you finish all the end area at one station, accumulated cut area and fill area are computed and printed out on the screen. All data of cut area and fill area at every station would be saved in the area file (.ew) that you have specified.

**Prompts**

**Calibrate section sheet**

Pick First section sheet reference point: pick a point on the drawing

Enter offset <0.0>: press Enter to accept the offset (or enter the offset of the point to the centerline)

Enter elevation: 1020 (enter the Elevation of the reference point)

Pick Second section reference point: pick a point

Enter offset: 0 (enter the offset of the point to the centerline)

Enter elevation: 1030 (enter the Elevation of the reference point)

Pick Third section reference point: pick a point

Enter offset: 50 (enter the offset of the point to the centerline)

Enter elevation: 1030 (enter the Elevation of the reference point)

3 calibration points

Transformation type: Orthogonal Affine Projective

Outcome of fit: Success Exact Impossible

RMS Error: 11.69

Standard deviation: 2.40

Largest residual: 14.29

At point: 2

Second-largest residual: 14.29

At point: 3

Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 0*(0.211129 1030.76)

Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 1*(11.5804 1030.49)

Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 2*(17.8643 1030.73)

Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 3*(19.0216 1032.35)

Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 4*(-0.777246 1030.75)

Digitize cut area (Enter to end): press Enter to finish

End area: 17.2312

Accumulated Cut Area: 17.2312

More Cut Areas [Yes(A)/<No>(B)]? press A to digitize more Cut Areas, or press B to finish digitizing Cut Areas.

Accumulated Cut Area: 17.2312

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 0*(-18.9614 1029.65)

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 1*(-18.1315 1030.75)

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 2*(-11.9592 1030.49)

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 3*(-2.06761 1030.72)

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 4*(-10.0082 1030.01)

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 5*(-18.531 1029.67)

Digitize fill area (Enter to end): press enter to finish

End area: 8.64646

Accumulated Cut Area: 8.64646

More Fill Areas [Yes(A)/<No>(B)]? press A to digitize more Fill Areas, or press B to finish digitizing Fill Areas.

Accumulated Cut Area: 8.64646

Total Cut Area: 17.2312

Total Fill Area: 8.64646

Store data to file [ <Yes>(A)/No(B)]? press A or B
Opened file: C:\Program Files\Carlson TakeOff 2004\DATA\Drawing1.ew

**Station Number:** 1 *(enter Station Number)*

Data Stored in file: C:\Program Files\Carlson TakeOff 2004\DATA\Drawing1.ew

**Digitize another station** [Yes]/(No)? *press A or B*

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

**Keyboard Command:** digendar
The Raster menu commands convert raster images into drawing entities.
Draw Raster Image

This command inserts an Image file into your current drawing. After selecting the file you wish to draw, the following dialog is shown:

The name of the file is shown at the top with a preview of the file shown below. To select a different file, click on the Browse button. Path Type can be set to the full (absolute) path, the relative path to the image file, or No Path, the name of the image file (the image file must be located in the same folder as the current drawing file). If the scale factor is known, you can enter it under Scale.

If the scale factor is unknown, it is recommended to use the default scale factor of 1 and adjust the Scale with Edit > 2D Scale once the Image is inserted and a scale factor can be determined. Specify On-Screen allows you to input the scale at the Command prompt. Insertion Point specifies the insertion point for the selected image file. Specify On-Screen is the default. The default insertion point is 0,0,0.

Specify On-Screen Directs input at the Command prompt or the pointing device. If Specify On-Screen is unchecked, enter the insertion point as X, Y, and Z coordinate values Rotation specifies the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value at the Command prompt. If Specify On-Screen is unchecked, enter the rotation angle value in the dialog box. The default rotation angle is 0.

Below is list of Images that can be inserted into the drawing. For PDF files, use the Import PDF File (loadpdf) command available in Carlson Takeoff.
Prompts

Specify the insertion point: pick on the screen or typing in a coordinate (Example: 1000,1000).
Specify rotation angle: To accept the default value displayed, press Enter, or enter the rotation angle (Example: 90).
Specify scale <1.0>: To accept the default value displayed, press Enter, or enter a scale factor. If the scale factor is not known, which is typical, accept the defaults to this prompt. The proper scale factor can be determined by running Inquiry>Standard Distance on a known distance on the site (ie, the side of a building or the distance across the road). If the side of a building is labeled as 60' and Standard Distance reports it is at 120', then the Scale factor is 0.5 (60/120). Run Edit>2D Scale, select the imported objects, specify a base point of 0,0 and use the Scale Factor you determined with Standard Distance to scale the entities correctly. After the command has imported the Image file, run View > Zoom > Extents to see the converted entities.

Pulldown Menu Location: Raster > Draw Raster Image
Keyboard Command: imageattach
Prerequisite: None

Set Raster Image

The Raster pull-down has several commands for manipulating images. These commands work with one image at a time. Set Raster Image determines which image in a drawing is "current" to edit. Simply run the command and select the image.

Prompts

Select image: Pick on the image (often you will need to pick on the boundary of the image to select it)
Image selected. Image file: pdf1.bmp

Pulldown Menu Location: Raster
**Keyboard Command:** rassel  
**Prerequisite:** an image in the drawing

### Save As Raster Image

This command saves the current image to a file. This command is a way to make a backup of the image before doing image adjustment commands. Also this command is a way to change the format of the image file such as .bmp to .jpg.

**Pulldown Menu Location:** Raster > Set Raster Image  
**Keyboard Command:** rassaveas  
**Prerequisite:** Set Raster Image

### Raster Edit Options

General Settings for working with images can be found in the command Raster Edit Options. Defaults are shown below.

![Raster Editor Options](image)

**Pixels to skip:** This setting applies to the Trace Line and Trace Polyline commands. As the program determines where to draw the new linework, it can "skip" or pass over a given amount of pixels who's color does not match the rest of the linework that is being processed. This allows for longer length polylines to be created on poor quality images. A larger amount of pixels to skip will typically create longer length new linework.

**Line and Polyline layer** determines the Layers for the new linework.  
**Close polyline tolerance (pixels):** While running the Trace Polyline command, this setting will automatically close the polyline if you select an point within the defined tolerance from the starting point.  
**Contour interval:** In the Contour Mode of Trace Polyline, this setting determines the value to add or subtract to polyline elevations.
**Elevation Mode:** Zero, Contour, or Prompt. By default, Trace Polyline creates linework at Zero elevation. **Contour Mode** speeds up elevating multiple polylines by adding (or subtracting) the Contour interval to the previous elevation value. **Prompt Mode** allows the user to specify the elevation of each polyline created.

**Thicken min surrounding pixels (1-8):** When running the "rasthicken" command (type-in only, not in pull-down menu), the routine looks at the surrounding pixels of an individual pixel and will change the color of that individual pixel to the surrounding pixels if minimum amount is met. The lower the number, the more "thickening" or densifying will occur.

**Thicken pass count (1-20):** This is the number of times the "rasthicken" command (type-in only, not in pull-down menu) will run in a selected area. The greater number of passes, the more "thickening" or densifying will occur.

**Draw new linework** will update the source Image file with the new linework you create through "Trace Line" or "Trace Polyline".

**Erase existing linework** will remove linework segments from the source Image file as you trace over those segments.

**Pull-down Menu Location:** Raster > Raster Edit Options

**Keyboard Command:** rasopts

**Prerequisite:** none

---

**Trace Line**

Trace Line will convert a line in an image into a single CAD polyline. If an image is "current" through the Set Raster Image command, simply run Trace Line and click on a line in the image. In the command line, you will see the Line Length, Angle, and Thickness reported for the new polyline. The command line will also prompt you to change the Angle, Length or Reverse the direction the new polyline if desired. To accept the new line press Enter. To cancel, type C or press Esc.

Different images have different resolutions or quality to them. To account for this, you can adjust the parameters that the program tries to recognizes linework in an image with Edit Raster Options. Here is also where the default Layer for the new polyline is determined.

**Prompts**

**Pick a point for line (Enter to end):** Select a line in the image

Line Length=780.00 Angle=269°32’47’’ Thickness=5

**Enter to accept line or [Angle/Reverse/Length/Cancel]:** Type in the first letter in a word to adjust that element of the new polyline. For example, typing in "A" would allow you to adjust the Angle.

**Pull-down Menu Location:** Raster > Trace Line

**Keyboard Command:** rasline

**Prerequisite:** Set Raster Image

---

**Trace Polyline**

Trace Polyline will convert linework in an image into a CAD polyline with multiple vertices. Trace Polyline requires that an image is "current" this can be accomplished either by using the Set Raster Image command or if only one image exists in the drawing, running Trace Polyline will automatically set the lone image in the drawing as the "current" image.

**Trace Polyline options menu:**
Set Background Color Manual/From Image:
Trace Polyline currently works best if the image being processed has a distinct background color that pervades most of the image and is easily distinguished from the color of the line work of the image. Set Background Color Manual allows the user to set the color that Trace Polyline interprets as the background color manually, by selecting a color from the Color dialog (shown below). Alternately The user can select the background color From Image.
**Pixels to skip:**
Sets the number of pixels (0-25) that Trace Polyline will "skip" (pass over) in order to connect two groups of pixels of the same color. This allows for longer length polylines to be created on poor quality images that contain gaps in between traceable line work. A larger number of pixels to skip will typically create longer length CAD line work. However, if the image line work contains few gaps, then the Pixels to skip should be set lower to avoid incorrectly connecting traced line work between unrelated traceable line work.

**Smooth Polyline:**
Interpolates between nodes of the polyline currently being traced to create interstitial nodes in the current polyline that give the current polyline a smoother appearance.

**Auto-correct for 90 degree corners:**
Attempts to determine if a section of line work represents a 90 degree corner. If so, creates a 90 degree corner in the current polyline traced over line work.

**Close polyline tolerance (pixels):**
Sets the close polyline distance tolerance (in pixels, 0-25) for Trace Polyline. If the beginning and end of the current polyline are closer than the close polyline distance tolerance then Trace Polyline will determine the current polyline to be closed, geometry will be automatically added to the polyline to connect the beginning and end of the polyline. Any redundant nodes created by connecting the beginning and end of the polyline will be removed.

**Zoom Options:**
1. **To Ends**, zooms view to the end nearest the most recently added polyline geometry. This end is set as the currently active end (see switch ends).
2. **To Bounds**, zooms view such that the entirety of the geometry of the currently traced line work is visible.
3. **None**, view does not change after the addition of new geometry.

**Elevation Options:**
1. **Contour**, sets polyline geometry z values based on elevation set by the contour prompt. When enter is pressed, or the currently active polyline is closed, the user is prompted to update contour information (again, using the contour prompt).
2. **Prompt**, prompts user to enter z value of traced polyline geometry. If enter is pressed or polyline is closed, user is again prompted to enter z value of traced polyline geometry.
3. **Zero**, all polyline geometry is drawn with its z value set to 0.0.

**Modify Raster Options:**
1. **Draw new linework**, Draws a 1 pixel wide line of the color of the current line work on the "current" image.
2. **Erase existing linework**, Sets pixels on "current" image to the current background color up to a distance of 'Pixel size' from the current polyline geometry.

**Raster Nearest Snap Options:**
Snap Radius, tolerance factor for selecting line work. If line work is found at a distance less than 'Snap Radius' away from most recent user selected pick point, that line work will be added to the geometry of the current polyline.

**Prompts:** Pick segment or [Options/Manual point/cross line Pick/Undo/Close/Switch active end/Exit] (Enter to end polyline):
(Select pick point to continue tracing polyline.)
(O)-Options, opens the Trace Polyline options dialog.
(M)-Manual point, allows user to contribute additional geometry to current polyline manually, ie not automatically traced.
(P)-cross line Pick, allows user to select pick point by crossing line work to be added with a cross line.
(U)-Undo, undoes previously drawn geometry.
(S)-Switch active end, switches the end to which geometry will be added (given new geometry begins near active end).
(E)-Exit, exits Trace Polyline.
*(C)-Continue, if no geometry has been traced, continue allows user to select on screen polyline geometry and use that as the basis for new line work.

Pick manual point or [enable snap Nearest/Switch active end/Exit] (Enter to end):
(Pick manual point to add to polyline geometry.)
(N)-enable snap Nearest, see raster Nearest Snap Options.
(S)-Switch active end, switches the end to which geometry will be added.
(E)-Exit, exits Trace Polyline.

Enter elevation or [Increment 1.00/Direction +/-/Exit] Elevation <0.00>:
(Enter elevation in contour mode.)
(I)-Increment, increment the elevation according to "direction" (either + or -).
(D)-Direction, toggles incremental direction from + to - or vice versa.
(E)-Exit, exits Trace Polyline.

Enter elevation or [Exit] Elevation <0.0>:
(Enter elevation in Prompt mode.)
(E)-Exit, exits Trace Polyline.

Pulldown Menu Location: Raster > Trace Polyline
Keyboard Command: raspline
Prerequisite: Set Raster Image

Trace Rectangle

This command draws a rectangle by following a rectangle in the image. The Elevation Mode to Prompt is useful for cases like building pads and you want to set the pad elevations. The Draw New Linework option draws the rectangle in the image as well as the drawing. The Erase Existing Linework option removes the rectangle in the image by setting the rectangle pixels to the background color.

Prompts

Trace Rectangle dialog
Select a point on the rectangle [Options/Undo] (Enter to exit): pick a point on the image rectangle
Select a point on the rectangle [Options/Undo] (Enter to exit): \textit{press Enter}

**Pulldown Menu Location:** Raster  
**Keyboard Command:** rasrect  
**Prerequisite:** an Image

### Trace Circle

This command draws a circle by following a circle in the image. The Draw New Linework option draws the circle in the image as well as the drawing. The Erase Existing Linework option removes the circle in the image by setting the circle pixels to the background color.

![Trace Circle dialog](image)

### Prompts

**Trace Circle dialog**

- **Select a point on the circle [Options/Undo] (Enter to exit):** \textit{pick a point on the image circle}
- **Select a point on the circle [Options/Undo] (Enter to exit):** \textit{press Enter}

**Pulldown Menu Location:** Raster  
**Keyboard Command:** rascircle  
**Prerequisite:** an Image

### Raster Nearest Snap

Similar to the standard Object or Entity Nearest Snap with CAD entities, \textbf{Raster Nearest Snap} will snap to the nearest point on a linework segment or point in an Image. This command can be used with Draw commands such as Draw > 2D Polyline.

**Pulldown Menu Location:** Raster > Raster EndPoint Snap  
**Keyboard Command:** rnea  
**Prerequisite:** most Draw commands
**Raster EndPoint Snap**

Similar to the standard Object or Entity EndPoint Snap with CAD entities, **Raster EndPoint Snap** will snap to the closest endpoint of a point or linework segment in an Image. This command can be used with Draw commands such as Draw > 2D Polyline.

**Pulldown Menu Location:** Raster > Raster EndPoint Snap  
**Keyboard Command:** rend  
**Prerequisite:** most Draw commands

---

**Merge Raster Files**

This commands merges bitmaps or other images (not pdf-based, unless the pdf has been turned into an image). There are two different methods for merging raster files: Automatic and Manual.

**Automatic Merge**

The program will first prompt you for the two existing files to merge and then for a new file name to create of the results. After picking and naming these files, the program will bring up a preview of each file to merge. Here, you will be prompted to "Select Window for area to process":

Create a Window along the given or approximate match lines (shown above in red), excluding elements like the title box. After doing this on both images, the program will preform a best-fit match and crop out any unneeded linework. The results will be shown in a preview window with a prompt: "Select Window for area to output". This allows you to select the whole or a smaller area of the preview to create the final image from. After Windowing the desired area, the new image will be created and the command will exit out.

**Manual Merge**

First, run "Set Left Image" and "Set Right Image" to determine the files to merge. Next, pick identical control points
on the left side and right side. Zoom in and pick the best that you can. This establishes the scale, rotation, and alignment for the merge. Note: the preview windows are labeled "Left Image" and "Right Image", but the program will merge images "Top" to "Bottom" if the control points are aligned in that orientation.

After establishing control points, click the Merge button and it merges the left with the right side. When you click Save Image, you can save it in a number of distinct forms (typically as a .bmp is sufficient). Notice the program automatically removed the match line text, with no overlap. The key is that your two reference points for scale and rotation, which match, must be at the linear overlap line, because everything to either side is removed automatically. Originally, the two images overlapped, but now that has been removed.

**Pulldown Menu Location:** Raster > Merge Raster Files  
**Keyboard Command:** rasmerge  
**Prerequisite:** Two or more Images you'd like to combine
Cut Image
This command wipes out an area of an image using the specified Background Color and is used to clean up an image. The area to cut can be selected either by picking a window or selecting closed inclusion polylines. Everything in the image to the inside of the area is removed. Warning: this command will update the image seen on the screen as well as the source Image.

Pulldown Menu Location: Raster
Keyboard Command: rascut
Prerequisite: an Image and a closed polyline

Crop Image
This command is used to clean up an image. Everything in the image to the outside of crop area is wiped out using the specified Background Color. The area is defined either by picking a window or selecting closed inclusion polylines. The Resize New Image option will make the image file smaller to remove the cropped out area. Warning: this command will update the image seen on the screen as well as the source Image.

Pulldown Menu Location: Raster
Keyboard Command: rascrop
Prerequisite: an Image and a closed polyline

Adjust Image
Remove Speckles
Images that have been scanned in from paper plans often have unwanted black dots or "speckles" that can be removed with this command. Depending on the image, there is a max speck size that can be set. The larger the size
indicated, the more specks will be removed. You can specify the area to remove specks from based on the entire image, a window area or by a closed inclusion polyline. The Speck Preview option will highlight the specs to be removed for confirmation before the removal.

Warning: this command will update the Image seen on the screen as well as the source Image.

Pulldown Menu Location: Raster > Adjust Image  
Keyboard Command: rasdespeckle  
Prerequisite: an Image

Mirror Image
This command flips an image either top to bottom or left to right.

Prompts

Mirror direction [<Left-right>/Up-down]? press Enter

Pulldown Menu Location: Raster  
Keyboard Command: rasmirror  
Prerequisite: Set Raster Image

Deskew Image
This command rotates an image. To do the rotation, this command defines a line by picking two points on the image and the image is rotated to make this line horizontal.

Prompts

Pick point 1 of the horizontal: pick point 1  
Pick point 2 of the horizontal: pick point 2  
Crop deskewed image [Yes/<No>]? press Enter

Pulldown Menu Location: Raster  
Keyboard Command: rasdeskew  
Prerequisite: Set Raster Image

Chapter 7. Raster Menu
Shrink Resolution

This command decreases the resolution of an image file. This feature applies when an image resolution is too dense to process in some other routines or you simply want to make the file size smaller to save space. This command prompts for the input image file to read and the output image file to write. The Scale Down Factor sets how many times smaller to make the output file.

Pulldown Menu Location: Raster
Keyboard Command: rasres
Prerequisite: Set Raster Image

Black/White By Threshold

This command makes the current image binary by assigning grays and colors to either black or white based on a brightness threshold. A binary image is easier to process in commands like Raster To Text and Raster To Vector. The Calculate Threshold function analyzes the image using the specified Threshold Method to estimate a good threshold value.

Pulldown Menu Location: Raster
Keyboard Command: rastreshold
Prerequisite: Set Raster Image

Replace Color

This command replaces colors in the image with a specified new color. You can specify the area to get colors by window area or by a closed inclusion polyline. The program makes a list of all the colors from the selected area. From this list, toggle which colors that you want to be replaced and pick the Replacement Color button to select the new color.
Warning: this command will update the Image seen on the screen as well as the source Image.

Pulldown Menu Location: Raster > Adjust Image
Keyboard Command: rascolors
Prerequisite: an Image

Brighten/Darken Image
This command changes the brightness of the current image and applies to color images. Enter a positive number to brighten and negative to darken.

Prompts
Enter brightness change from -255 to +255: 64

Pulldown Menu Location: Raster
Keyboard Command: rasbright
Prerequisite: Set Raster Image
Negative Image
This command inverses the colors of an image. For example, black pixels are changed to white.

Pulldown Menu Location: Raster
Keyboard Command: rasnegative
Prerequisite: Set Raster Image

Undo Raster Edit
Undo Raster Edit will revert an Image back to its original form (both on-screen and source) from changes made by: Image Cut, Image Crop, Remove Speckles, Trace Line or Trace Polyline. It will not remove any polylines created by Trace Line or Trace Polyline.

Pulldown Menu Location: Raster > Undo Raster Edit
Keyboard Command: rasundo
Prerequisite: an Image that has been edited

Import Raster To Vector
This command creates polylines from a raster image. The image can be either an external .bmp file or an image inserted in the drawing.

For the external file to process other file types, such as .tif or .jpeg, open the image up in Microsoft Paint and Save As the file as a monochrome .bmp. In the dialog below, you can specify the Layer, Color, Scale, and whether to draw the entities on the screen or write a .dxf file. Minimum Polyline Length will reduce the amount of line segments created from the conversion.

For an image in the drawing, you can process the entire image or limit the area to process by window or inclusion polylines. The Erase Selection option wipes out the image with the specified Background Color in the area that is processed.
Pulldown Menu Location: Raster
Keyboard Command: ras2vec
Prerequisite: a monochrome .bmp file

**Raster To Text**

This command will create text from an image in your drawing generated from commands such as PDF Import, Raster Import, Attach Image, etc. one line at a time. From the OCR (Optical Character Recognition) Options dialog, you have the ability to identify the Background and Text Color of the image being used. The Text Layer and the font Style the text will appear on once converted can also be set here.

Perform Numeric OCR will limit the text recognition to only numeric values. By default, this command attempts to convert to alphabetic characters as well. When dealing with only numeric text, turn this feature on so that no alphabetic characters are accidentally used during the conversion. Use the Match Prefix or Match Suffix to help the recognition when the numbers have an alpha prefix or suffix like "TC 123.4".

The Overwrite Image option will erase the raster text from the image after it has been converted to CAD text.
The Leader Line option draws a leader along with converting the text.

For the OCR Mode, the **Standard Mode** prompts to pick two points across the raster text for each text to convert. These points define the area of the image to process. The **One Click Mode** converts the first text like Standard Mode and gets the text size and angle properties from this first text. Then for the additional text to convert, you only need to pick a single point on the text instead of two points. For the **Area Search Mode**, the first text is again processed the same as Standard Mode and then you window an area and the program looks for other raster text with the same size and angle as the first text.

The **Prompt Before Placing Text** shows the conversion results in a dialog with a chance to review, edit or cancel.

![Prompt](image.png)

After clicking OK to the OCR Options dialog, you will be prompted for a "start of strike-line" then "end of strike-line". Pick left to right through the text you want to convert. A **Replacement Text dialog** will appear. Here you can review the values that the program has converted and change them if needed before accepting them by clicking OK. You will then be prompted to "strike-through" another line of text. Press Enter to end.

### Prompts

**OCR dialog**

Pick start of stike-line or [Options] (Enter to end): pick 1st point
Pick end of stike-line (Enter to end): pick 2nd point
Pick start of stike-line or [Options] (Enter to end): press Enter

**Pulldown Menu Location:** Raster
**Keyboard Command:** RASOCR
**Prerequisite:** An image in the drawing

### Vector To Text

This command will create text from linework in a drawing. From the OCR (Optical Character Recognition) Options dialog, set the Text Layer and the font Style the text will appear on in drawing once converted. **Perform Numeric OCR** will limit the text recognition to only numeric values. By default, this command attempts to convert to alphabetic characters as well. When dealing with only numeric text, turn this feature on so that no alphabetic characters are accidently used during the conversion.
By default, this command converts one line at a time. **Perform Batch (Horizontal) OCR** allows you to convert multiple line at once as long as the text is aligned horizontally. Choosing a **Text Size** helps the program to distinguish text linework vs. standard linework. "Pick" allows you to pick two points in the plan view to set the text height to be used.

After clicking OK to the "OCR Options" dialog (with "Perform Batch (Horizontal) OCR" checked off), you will be prompted for a "start of stike-line" then "end of stike-line". Pick left to right through the linework you want to convert. With "Perform Batch (Horizontal) OCR" checked on, you will be prompted to "Select objects", which can be individually picked linework or windowing around a group of linework. After making your selection, a **Replacement Text dialog** will appear. Here you can review the values that the program has converted and change them if needed before accepting them by clicking OK. You may also Skip the conversion altogether or OK All the conversions at once in this dialog.

**Pulldown Menu Location:** Raster  
**Keyboard Command:** vecocr  
**Prerequisite:** Linework to convert to text

---

### Set Text Color

This command sets which color to use as the text color for other Raster commands such as Raster To Text. For example, one image could have a black background and white text, and another image could have the opposite with a white background and black text. The Raster commands need to know which type of text color the image has.

This command uses the current image. If the current image isn't already set, then the program prompts to select the image. Then the program reports the current text color and prompts to pick a point on the image. The program reads the color from the image at the picked point to set the text color.

**Prompts**

- **Select image:** Pick on the image (often you will need to pick on the boundary of the image to select it)  
- **Current text color:** red=0 green=0 blue=0  
- **Pick a point in the image to set the text color:** *pick point*  
- **Text color changed to:** red=201 green=234 blue=157

**Pulldown Menu Location:** Raster
**Set Background Color**

This command sets which color to use as the background color for other Raster commands such as Trace Line. For example, one image could have a black background and white lines, and another image could have the opposite with a white background and black lines. The Raster commands need to know which type of background the image has.

This command uses the current image. If the current image isn't already set, then the program prompts to select the image. Then the program reports the current background color and prompts to pick a point on the image. The program reads the color from the image at the picked point to set the background color.

**Prompts**

- **Select image:** Pick on the image (often you will need to pick on the boundary of the image to select it)
- **Current background color:** red=255 green=255 blue=255
- **Pick a point in the image to set the background color:** pick point
- **Background color changed to:** red=232 green=232 blue=232

**Pulldown Menu Location:** Raster

**Keyboard Command:** ocrbgcolor

**Prerequisite:** an image in the drawing
Elevate Menu
The Elevate menu commands convert 2D entities to 3D.
Change Elevations

This command will change the elevation of selected Entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson TakeOff points are selected, their attribute text and z axis coordinate are changed.

Prompts

Ignore zero elevations (<Yes>/No)? Press Enter. If you answer No, then entities with elevation 0 will be changed.
[A]bsolute or [D]ifferential Change <A>: A
Select/<Enter Elevation <0.0000>: 125
Change Layer for changed entities [Yes/<No>]: No
Elevation to change to:

By using the Absolute option all entities selected are changed to the elevation 125.

Select Entities for elevation change.
Select objects: C
First corner: (pick point)
Other corner: (pick point)
Select objects: [Enter]

Keyboard Command: chgelev
Prerequisite: Something to change

Set Polyline to Elevation

This command allows you to assign elevations to one or more polylines. The elevation can be assigned by entering in the value or by picking a text entity that has the elevation.

Prompts

Select/<Enter Elevation <0.0000>: Select a text entity or type in an elevation. Press enter for the default elevation in brackets.

Select Polyline for elevation change. Pick on the screen a polyline you wish to change such as: LWPOLYLINE
Done.
Set another polyline [<Yes>/No]? Press Y to pick another polyline to assign an elevation to. Type in N to finish the command.

Keyboard Command: set_pline_z
Prerequisite: A polyline and an elevation to assign it

Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution you will be asked to select a polyline to edit. Upon selection a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. Then pick near the vertex you wish to edit, and the following dialog appears.

At the top of the dialog it identifies the type of polyline, being 2D or 3D. In the case of 2D polylines it allows you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values
in the dialog, new values for derivatives are being calculated. For example if you change the horizontal distances, the coordinates will change.

Prompts

Select polyline vertex to edit: pick a polyline at the point to be modified
Pick or enter position <5264.23,5048.21>: pick a point
Enter elevation <0.00>: Press Enter
Select polyline vertex to edit: Press Enter to end

Keyboard Command: editpl
Prerequisite: A polyline.

2D to 3D Polyline

By Surface Model

This command converts a 2D polyline into a 3D polyline by calculating 3D polyline vertices at all the intersects of the 2D polyline with surface entities (contour polylines, triangulation lines) and by interpolating elevations from these intersections at the original vertices locations. An application for this command is to create breaklines. For example, a ridge breakline could be generated from contour lines by drawing a 2D polyline along the ridge and across the contours. Then this command could grab the contour line elevations along the polyline to make a ridge breakline.

In addition to using entities in the drawing, the 2D polyline can be converted to 3D using a surface model stored in triangulation (.flt or .tin) file. If you use a file, then you can also use the polyline's current elevation as a vertical offset from surface.

Prompts

By Screen Entities:
Source of surface model [File/<Screen>]? Type S for Screen
Select polylines to convert.
Select objects: select the polyline(s) to convert
Select surface 3DFaces, lines and polylines.
Select objects: select the surface entities (contour polylines, breaklines, triangulation lines, etc)
Keep existing polylines [Yes/<No>]? Press Enter
This command creates a new 3D polyline, and this prompt allows you to keep the old polyline.

Set layer name for converted polylines [Yes/<No>]? Press Enter
This allows you to assign the new polyline to a layer.

Converting polylines ...
Converted 1 polylines.

By a .flt or .tin File:
Source of surface model [<File>/Screen]? Type F for File
Select polylines to convert.
Select objects: select the surface entities (contour polylines, breaklines, triangulation lines, etc)

Use current polyline elevations as vertical offset from surface [Yes/<No>]? Press Enter
This will offset the new polyline by its current elevation. That is, if a polyline has an elevation of -4 and the surface you are converting it to has an elevation of 800, then saying Yes will drape the polyline at an elevation of 796.

Keep existing polylines [Yes/<No>]? Press Enter
This command creates a new 3D polyline, and this prompt allows you to keep the old polyline.

Set layer name for converted polylines [Yes/<No>]? Press Enter
This allows you to assign the new polyline to a layer.

Keyboard Command: 2dto3dp
Prerequisite: A polyline and surface lines or grid file or triangulation file.

By Screen Entities
This command converts a 2D polyline into a 3D polyline by calculating 3D polyline vertices at all the intersects of the 2D polyline with surface entities (contour polylines, triangulation lines) and by interpolating elevations from these intersections at the original vertices locations. An application for this command is to create breaklines. For example, a ridge or valley breakline could be generated from contour lines by drawing a 2D polyline along the ridge top or valley bottom, crossing the contours. Then the command would "grab" the contour line elevations along the polyline to make a ridge or valley breakline.

Prompts
Select polylines to convert. select polylines
Select objects: 1 found
Select objects: press Enter to conclude selection.
Intersection extend tolerance <0.1>: enter value for "near" intersections that so not quite intersect.
Select surface 3DFaces, lines and polylines. select source 3D objects
Select objects: Specify opposite corner: 7 found
Select objects: press Enter
Reading points ... 5353
Keep existing polylines [Yes/<No>]? press Enter to accept defaults in brackets
Set layer name for converted polylines [Yes/<No>]? 
Converted 1 polylines from 24 intersections.

Pulldown Menu Location: 3D Data > 2D to 3D Polyline
Keyboard Command: 2dto3dps
**Prerequisite:** Polylines and 3D surface entities

**By Points**

This command adds 3D data to polylines by using the elevations of points. At each vertex of the polylines, the program looks for a point with elevation at the same x,y location. The points can be Carlson point blocks or AutoCAD POINT entities. This routine can be useful if the linework is created in 2D at zero elevation, and points with elevation are located along the linework. It can also be used in conjunction with other 2D to 3D commands to elevate polylines by more than one method. The linework can be converted into 3D polylines with this command. For example, a centerline polyline with arcs may need to be created in 2D for stationing because AutoCAD does not allow arcs on 3D polylines. To use this polyline as a breakline in surface modeling, this command can convert the polyline into a 3D polyline.

**Prompts**

**Select points and polylines.**

**Select objects:** select polylines to convert and the points with elevation

![Diagram of polylines with elevation points](image)

**Keyboard Command:** 2dto3dpt

**Prerequisite:** A polyline and points

**By Slope From Reference**

This command converts a 2D polyline into a 3D polyline using a slope from a reference 3D polyline or point. For example, this command can be used to elevate a bottom-of-bank polyline given an elevated top-of-bank polyline and bank slope. After selecting the polyline to elevate and the 3D reference, there is a prompt for the slope percent. Use negative for downhill. For each vertex on the 2D polyline, the program finds the nearest position on the 3D reference and assigns the vertex elevation using this reference position elevation plus the slope multiplied by the distance from the vertex to the reference.

**Prompts**

**Select polyline to assign elevations:** *pick polyline to elevate*

**Select reference 3D polyline:** *pick reference polyline*

**Enter slope percent:** -25

**Select polyline to assign elevations (Enter to end):** *press Enter*

**Pulldown Menu Location:** 3D Data > 2D to 3D Polyline

**Keyboard Command:** elev_slope

**Prerequisite:** A 3D polyline or 3D points to reference

**By Text**

This command adds 3D data to polylines by elevation labels. This command will prompt you for samples of the elevation labels and the polylines to convert. The program uses these samples to know the layer names for the labels and linework to process. Then select all the polylines with their labels you want to convert.

*Chapter 8. Elevate Menu* 264
You will then be prompted to enter in an elevation to add to label values. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 539.97, 540.02, 540.11 sometimes, like in the example on the side, they are listed as 39.97, 40.02, 40.11. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing. This command will assign elevations from the labels to nearby vertices. If vertices do not have a close elevation label than they will be interpolated from vertices that are nearby elevation labels. The vertices elevated in this command will appear as control vertices in the command Edit-Assign Polyline Elevations. It can also be used in conjunction with other 2D to 3D commands to elevate polylines by more than one method.

Prompts

Select sample of elevation text: Pick a text label
Select sample of a polyline to convert: Pick a polyline
Select polylines to convert and elevation labels.

Select objects: Select all the entities to process
19 found, 19 total

Enter elevation to add to label values <0.00>: 500
Pre-processing entity #19 of 19
Filtering text entities
Processing elevation text #18
Remaking polyline #1

Keyboard Command: elevfb
Prerequisite: 2D polyline and elevation labels
By Text With Leader
This command will assign elevations from the labels to the polylines by following the label leaders to their corresponding vertices on the polyline.

This command will prompt you for samples of the elevation labels, the leaders, and the polylines to convert. The program uses these samples to know the layer names for the labels and linework to process. Then select all the labels and leaders for the polylines you want to convert. You will then be prompted to enter in an elevation to add to label values. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 800s instead of labeling every elevation 817.85, 817.40, 817.30 sometimes, like in the above example, they are listed 17.85, 17.40, 17.30. This command allows you to add a given amount, such as 800, to every label elevation to produce the correct elevation in the drawing.

Carlson TakeOff searches for all leaders and gathers their associated text. If the program finds different labels in the elevation text, then this dialog box allows you to select the text you want to create 3D polylines. In this example you might want to use elevations followed by TC. This dialog box allows you to select that text and exclude the other text which is not to be used in the elevations of the polyline, such as FS.
If you are creating 3D polylines from multiple elevation labels than this dialog box will allow to offset certain labels by a given amount. In the above example you can offset an elevation labeled FS by .50 so that it matches vertices set by TC labeled elevations. The vertices elevated in this command will appear as control vertices in the command Edit-Assign Polyline Elevations. It can also be used in conjunction with other 2D to 3D commands to elevate polylines by more than one method.

**Prompts**

**Select sample of elevation text:** Pick a text label

**Select sample of an annotation leader:** Pick an annotation leader

**Select sample of a polyline to convert:** Pick a polyline

**Select polylines to convert, leaders and elevation labels to process.**

**Select objects:** Select the desired entities

22 found
3 were filtered out.

**Select objects:**

**Enter elevation to add to label values <0.00>:** 800

Pre-processing entity #19 of 19
Filtering text entities
Processing leader #6
Remaking polyline #1

**Keyboard Command:** elevfl
Prerequisite: 2D polyline, elevation labels, and leaders

By Start-End Elevations
This command allows you to convert a 2D polyline to a 3D polyline by specifying the starting and ending elevations of the polyline. All intermediate polyline vertex elevations are linearly interpolated from these end point elevations.

Prompts
Select polyline to assign elevations:
Enter starting elevation: 109.85
Percent/Ratio/<Enter ending elevation>: 112.16
Select polyline to assign elevations (Enter to End): press enter to end
Keyboard Command: 2dto3dpl
Prerequisite: A polyline

Pad Polyline By Interior Text
This command allows you to set one or more pad elevations using interior text labels.

After running the command you will be prompted to select the layers you want to use for the pad elevation and for the boundary of the pad. Sometimes pads are drawn with linework from two different layers and Carlson TakeOff allows you to pick all the correct linework.

This dialog box allows you to create a new layer with the correct x,y coordinates and elevations. If the pad shares the same coordinates with other linework with different elevations than this dialog box allows you to offset the new polyline to avoid the problem of shared occupied points with different elevations. You can choose to have an interior offset or an exterior offset and also decide how much to offset the new polyline. Selecting Both will give both the interior pad elevation and the exterior contour elevations. This helps the transition from you pad elevation to the design contouring. The Snap Tolerance field joins linework which falls within the range you set to create a pad. Trim Outside Elevated Polylines will trim out contour elevations that go through your pad that you are not using elevations from within the pad.

Elevation to add to text values adds to the values from the elevation labels. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 523.5, 543.3, 537.2 sometimes they are listed as simply 23.5, 43.3, 37.2. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing.

After running the command you will be prompted to select the layers you want to use for the pad elevation.
and for the boundary of the pad. Sometimes pads are drawn with linework from two different layers and Carlson TakeOff allows you to pick all the correct linework. In addition, if your text has multiple Prefixes and Suffixes you will be prompted to select the ones you want to use the elevation from.

![Prefix Suffix Filter](image)

After clicking <OK> select all the pads and their elevation labels that you wish to change, press <Enter>, and the new layer with elevations will be created and placed in the Design target.

![Elevation Labels](image)

**Prompts**

Select layer sample of elevation text: Pick a label text
Selected text layer —— TX07
Select layer sample of boundary linework:
Selected linework layer PAD
Select another layer sample of boundary linework (Enter to continue):
Select text and linework to process.
Select objects: 1 found
Select objects: 1 found, 2 total
Select objects:
Analyzing entire selection...
Set elevation for 1 polylines.

Keyboard Command: pad_by_text
Prerequisite: Pad polylines and elevations

3D Entity by Surface Model

This command assigns the elevations of the selected points, inserts, lines and polylines to the elevations defined by the specified grid (.GRD) or triangulation (.FLT, .TIN) file. For lines and polylines, additional vertices are added to model the surface. 3D Polylines cannot have arcs, so any arcs in the original 2D polylines are converted to a series of chords. This command is useful to "drape" objects onto a surface and to easily update them if they are moved to a different location on the surface later by executing the command again.

Prompts

Choose Grid or Tmesh File to Process dialog
Select points, inserts, lines and polylines to convert.
Select objects: pick the entities to convert
Converting entities ...
Done.

Pulldown Menu Location: 3D Data
Keyboard Command: convert3d
Prerequisite: entities to be converted, grid or triangulation file

Convert Spot Elev To Points

This command takes spot elevation entities with zero elevations and assigns them elevations according to corresponding elevation labels. This dialog box allows you to choose the format of the spot elevations entities that you want to convert.
Output:

**Carlson points:** creates Carlson points at elevation of spot and stores them in coordinate file

**AutoCAD points:** creates AutoCAD point objects at elevation of spot

**Is spot indicator a part of the elevation label?**

If set to "Yes", four choices for Spot indicator are available to select from:

- **Text insertion point:** uses the insertion point of the text for the location of the new point
- **Text decimal point:** uses the decimal point in the text for the location of the new point
- **Text plus sign:** uses the plus sign in the text for the location of the new point
- **Text letter x:** uses the letter x in the text for the location of the new point

If set to "No", five choices for Spot indicator are available to select from:
Linework leader: creates a data point at the end of a leader

Linework cross: creates a data point at the intersection of a linework cross
Text plus sign: creates a data point at the insertion point of a text plus sign
Text letter x: creates a data point at the middle of a text letter x
AutoCAD point: creates a data point at the node of an AutoCAD point

Block References:
Process Block References: If check box is cleared, Carlson Civil searches only text entities for elevations, but if checked, Carlson Civil will search block references for elevations that are stored as attributes of a block. Use this option if the elevation is an attribute and the symbol designating the location of the spot elevation are both part of the block definition.
Expand Block References: Use this option to search block references when the elevation is stored as an attribute of a block, but the symbol designating the location of the spot elevation is a different block or even other geometry that is not defined within a block.

Base elevation: The value entered here is added to the existing spot elevations for all newly created points. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 523.5, 543.3, 537.2 sometimes they are listed as simply 23.5, 43.3, 37.2. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing. Note: The base elevation will not be added to any elevations that are closer to the base elevation value than they are to 0; e.g. if a base elevation of 500 is specified, 500 will be added to elevations like 23.4, 45.5, etc, but will not be added to elevations like 456.4 or 468.9.

Prefix Filter: Carlson Civil examines all selected spot elevations for prefixes or suffixes. If they are all the same, the command proceeds, but if there are different prefixes and/or suffixes found, the Prefix Filter dialog box is invoked. This dialog box allows you to select which prefixes and/or suffixes to use to create spot elevations, and also allows you to use different offset values for each.
Prompts

Starting point number <1>: press Enter
Select TEXT, MTEXT spot elevations to process and any associated leader lines:
Select objects: pick entities to process
Pre-processing entity #40 of 40...
Filtering text entities
Processing elevation #40...
Converted 40 spot elevations.

Keyboard Command: spotelv2
Prerequisite: Spot elevations

Elevate Text

This command sets the elevation of text entities by reading the elevation value from the text label. For example, this command can elevate spot elevation labels. Having the text entities at real elevation instead of zero can be useful for viewing in 3D or using for surface modeling.

Prompts

Select text to elevate.
Select objects: pick text entities
Elevated 12 text entities.

Pulldown Menu Location: 3D Data
Keyboard Command: ztext
Prerequisite: None

**Draw Building Envelope Polyline**

This command creates a rectangular polyline around selected linework. This can be used to give a building all one elevation.

Select the entities that make up the building. Next you will be prompted to name the layer and in the dialog, you can set the layer name for the rectangle and other settings.

**Prompts**

**Offset:** This is the amount the building envelope will be offset out from the source linework.
**Prompt For Each Side Offset:** This option allows you have different offsets for each side of the rectangle.
**Length Snap Resolution:** Will round the dimensions of the created Building Envelope by a certain tolerance. For example, if you select None you may get a Building Envelope of 37.4 x 25.2. However, if you set the Length Snap Resolution to 0.5, you will get a Building Envelope of 37.5 x 25.0.
**Prompt For Elevation:** This option allows you to set the elevation for the rectangle. Otherwise the rectangle is drawn at zero.
**Trim Crossing Linework:** This option trims any linework that crosses the building envelope which applies to linework like contours to ensure that you have a flat pad when building the surface model.
**Draw Corner Cross Lines:** This option draws two lines between the corners of the rectangle.
Select building lines.
Select objects: pick the linework that makes up the perimeter of the building
Enter the segment horizontal offset <0.000>: 10
Enter the segment horizontal offset <10.000>: Enter
Enter the segment horizontal offset <10.000>: 5
Enter the segment horizontal offset <5.000>: Enter
Select/<Enter Elevation <0.000>>: 400
Draw another building envelope [<Yes>/No]? No

Pulldown Menu Location: Civil > 3D Data, Survey > COGO, Takeoff > Elevate
Keyboard Command: bldg_perim
Prerequisite: Building linework

Set Point Elevations by Surface Model

This command assigns elevations to points by a triangulation or grid surface model. For each of the points, the routine looks up the elevation from the surface model at the point x,y location. The option to Link Elevations To Surface Model will update the point elevations when the reference surface model is changed.

Prompts

Choose Grid or Tmesh file to process dialog choose existing GRD, TIN or FLT file
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Elevating points...
Elevated 10 points.

Pulldown Menu Location: Survey and 3D Data for Civil
Keyboard Command: 3dpts_tin
Prerequisite: A surface model

Set Point Elevations by 3D Polylines

This command assigns elevations to points by referencing 3D polylines. The station-offset is calculated for each point to the nearest reference 3D polyline. The point must be within the specified Max Offset Tolerance in order to be elevated. The elevation is calculated from the elevation of the reference 3D polyline at the station combined with the specified percent slope times the offset plus the vertical offset. The Decimals setting is for the elevation label of the point. The elevation for the coordinate file always uses full precision. The option to Link Elevations To Polylines will update the point elevations when the reference polyline is changed.
Prompts

Options Dialog
Select points from screen, group or by point number [Screen/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Select reference 3D polylines.
Select objects: pick the reference 3D polylines
Elevating points...
Elevated 10 points.

Pulldown Menu Location: Survey and 3D Data in Civil
Keyboard Command: 3dpts,3dp
Prerequisite: 3D polylines

Draw Curb Ramp

This command modifies 3D curb polylines to fit in a ramp of the specified dimensions. For input, this command requires 3 3D polylines that define the face of curb (bottom and top) and the back of curb. There is a dialog to enter the curb dimensions. For the Pick Method, the Center method places the ramp centered at the pick point. The Sides method prompts to pick two points on the curb polylines to define the left and right sides of the ramp. The Driveway method allows you to create multiple ramps at once by selecting closed polylines that represent driveways. These polylines must be closed polylines with two vertices on the curb polyline. The ramp is fit between these two vertices. The Elevate Driveway option sets the elevation of the driveway polyline to match the curb polyline. The Back Taper option applies the Front Taper width to the back of the ramp as well as the front. The Lip Method controls the height between the bottom-of-curb and top-of-curb polylines at the bottom of the ramp. The Ramp Slope method sets the slope between these polylines to match the ramp slope and the Height method sets a fixed height. The Slope Method controls the ramp slope. The Match Curb Height method sets the slope so that the back of the ramp reaches the original height of the top-of-curb. The Slope method sets the ramp slope to the specified value. The Second Ramp and Third Ramp allow for additional ramps such as for a landing pad.

After the dialog, the program prompts to pick the curb 3D polylines to draw the ramp. The existing 3D curb polylines are modified to lower the curb for the ramp and new 3D polylines are drawn for the rest of the ramp. Also, the program updates other 3D linework that crosses the ramp such as sidewalks. These 3D polylines can then be used for breaklines in surface modeling such as with the Triangulate & Contour routine.
Plan view of 3D curb polylines with ramp dimensions

3D view of curb polylines and ramp
Prompts

Curb Ramp dialog
Select curb polyline: pick a polyline
Select curb polyline (Enter to end): press Enter

Pull-down Menu Location: 3D Data > 3D Polyline Utilities
Keyboard Command: curb_ramp
Prerequisite: 3D curb polylines

Elevate Intersection Curb Return

This command elevates an intersection curb return based on the distance along the side road in relationship to the curb return. Instead of an interpolation of the elevation this command will apply the interpolation from the side road to the curb return.

Side Road CL File/<Select polyline>: select the side road's polyline or choose the centerline .CL file

Select Side Road Edge polyline: select the side road's edge polyline
If the selection is not a 3D polyline, next you will be prompted to choose the Side Road Edge profile .PRO file
Select Main Road Edge polyline: select the main road's edge polyline
If the selection is not a 3D polyline, next you will be prompted to choose the Main Road Edge profile .PRO file

Select Curb Return polyline: select the corresponding curb return edge polyline to create profile for
Export Profile

Select the profile .PRO file to create for the curb return.

![Select Curb Return Profile File to Write - .pro](image)

Draw 3D Profile

This will draw the profile as a 3D-Polyline on the original curb return's layer.

Erase Existing Curb Return

This will erase any already created 3D-Polyline drawn for the selected curb return.

Override Layer Name

This will override the original selected curb return's layer with the layer choosen.

![3D Polyline Utility](image)

**Pulldown Menu Location:** 3D Data - 3D Polyline Utilities
**Keyboard Command:** calcapron

**Prerequisite:** Existing profiles for Side and Main Road Edges

---

**Assign Contour Elevation - Multiple in Series**

This command can be used to quickly and accurately assign the elevation of series of AutoCAD polylines that have been converted from raster or digitized without correct elevations. The routine will automatically assign elevations to the polylines crossing the fence line selected by two points. At the same time the elevations are changed, the program can assign it a new layer, color, linetype, and polyline width. This process usually works best if contours are in a temporary (white) layer to start. When they are processed, they will take on the color of the new layers making it easy to distinguish which polylines have been processed.

**Prompts**

- **Settings/First Point:** *(Press S to change settings or pick first point.)*
- **Second Point:** *(Pick second point)*
- **Beginning Elevation** <0.00>: 1020
- **Increment Direction U/D** <U>: (enter)

---

**Keyboard Command:** grpcelev

**Prerequisite:** digitized polylines
Assign Contour Elevation - From Contour Labels

This command allows you to set elevations to contours from elevation labels.

Select a sample of the elevation text to be used on the contouring. Next, select a sample of the contouring that you want to add the elevations to. In case you have contours on different layers like for major and minor contours, there is a prompt to pick a second contour line example. The program uses the Layers of the selected entities to know which entities to process as the contour labels and lines. Now select all the contours and their corresponding elevation labels. The program will then add elevations to all the contours. You may be prompted to distinguish what contour goes with what elevation label. You can either press <Enter> to accept the contour that the program has selected or you can Press <N> to choose another contour.

Prompts

Select sample of elevation text: pick a contour label
Select sample of a contour line: pick a contour line
Select second sample of a contour line (Enter for none): press Enter
Select contour lines and elevation text to process.
Select objects: pick lines and labels

Joining adjacent polylines...
Reading the selection set ...
Joining ...

Pre-processing entity #1008 of 1008
Filtering text entities
Processing elevation text #518

Conflict detected: pick contour corresponding to current elevation text
Press N for next selection or Enter to accept current:
Remaking polyline #311

Pulldown Menu Location: Elevate in Takeoff, 3D Data in Civil
Keyboard Command: TXTCELEV
Prerequisite: contours and contours labels

Assign Contour Elevation - Single Elevation Group

This command changes the elevations of polylines and can be used to set the elevations of contour polylines. The routine begins at a specified elevation and prompts for a selection set of polylines to set to the elevation. Then the routine repeats using the last elevation plus the elevation increment. Enter an empty selection set to exit the routine.

Prompts

Starting elevation <0.0>: 500.0
Contour interval (negative for down) <1.0>: 5.0
Select polylines to set to elevation 500.0.
Select objects: pick the polylines
Select polylines to set to elevation 505.0.
Select objects: pick the polylines
Select polylines to set to elevation 510.0.
Select objects: Press Enter

Keyboard Command: setcelev
Prerequisite: polylines

Edit Contours

This command revises a segment of a contour polyline. Begin by picking a point on the contour where you want to start editing. Then pick new points for the polyline. When finished picking new points, press Enter and then pick a point on the contour to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

Prompts

Select contour to edit: pick the contour polyline at the place to start editing
Pick intermediate point (Enter to End): pick a point
Pick intermediate point ('U' to Undo, Enter to End): pick a point
Pick intermediate point ('U' to Undo, Enter to End): Press Enter
Pick reconnection point on contour: pick the contour polyline at the place to join

Edit this contour by picking new points
Contour with segment replaced with new points

Keyboard Command: editctr
Prerequisite: polylines with elevation (contour polylines)
Create Ridge Polylines From Contours

This command creates 3D polylines along the tops of ridges and in the bottom of drainages for more accurate modeling of the surface.

**Draw Options:** Specify whether to draw Ridge/Valley segments, Summit/Pit segments, or all. Ridge/valley segments travel along the tops of ridges or bottom of valleys and are extracted from the contours lines by finding acute vertices and looking to the next adjacent contour for the corresponding acute vertex. Summit or pit segments model closed polyline contours and extend the trend either upward or downward to the peak or bottom point in the geometry.

**Extraction Type (Significant and Full):** Significant segments are those segments that fall into relatively flat areas of the triangulation (large open spaces between the contours). Use this setting to reduce the number of segments generated by this command. Full extraction will model all segments.

**Minimum Segment Count and Branch Length:** Use this setting to prevent small segment branches from being generated. This can reduce the occurrence of errors in the output.

**Layer Selection:** Specify the layer that the ridge/valley and summit/pit polylines will be drawn on. You may choose the select button to specify from the list of existing layers, or specify a new layer by simply typing the new layer name.

**Density Multiplier:** The quality of output produced by this command is directly proportional to vertex density of contour polylines. This multiplier can be used to temporarily increase contour vertex density for the duration of calculations at the cost of additional processing time. Setting this multiplier to higher values generally reduces occurrence of errors in the output.

**Ignore Zero Elevations:** select this to ignore linework set at zero elevation.
Snap Contours to 3D Polylines

Snap Contours to 3D Polylines can be used to align contour polylines to match elevation with intersecting of a 3D polylines. Doing so will fix spikes in a surface model. The program will ask for the Contours to be adjusted. Pick will allow you to grab the contours from the plain view. Select allows you to identify the layer(s) from a list. The layers under Contour Layers will be adjusted to match the Reference Layers at the point of intersection. A Reference layer can be identified by Pick or Select as well. The Maximum Snap Distance is the furthest distance along the Reference line the Contour polyline will move in order to match elevations. Z Tolerance sets the minimum elevation difference between the Reference line and the Contour polyline for the program to process. Anything less than this number will not be modified. Transition Distance is the length over which the positioning change will be applied to the Contour polylines.

After selecting OK, you will be prompted for the entities to process. Pick or Window Select the linework you
want to process. You can also type in "all" to select everything. Here is a standard report that is displayed on the command line:

Entities in set: 282
Select entities:
Contour polylines: 125 Processed, 12 Adjusted

**Pulldown Menu Location:** Elevate (in Takeoff), 3D Data (in Civil)
**Prerequisite:** 3D linework
**Keyboard Command:** snap.cntrs
Define Layer Target/Material/Subgrade

The Define Layer Surfaces dialog box (shown here) offers many functions that will ultimately make up the surface models used in volume and material calculations. Every entity (line, polyline, point, etc) in a drawing is assigned a layer name. Carlson Takeoff uses the entity layer names to define which entities represent the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. Any previously created triangulation file (.tin) can be set to the design or existing Target with the Surface Source drop-down set to File. In this mode, the Select File button will allow you to pick the .tin file you want to use for the Target.

When the Surface Source drop-down is set to Layers, drawing entities are assigned to target surface by their layer name. For example, if polylines representing design contours are on the layer "Final", then "Final" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other. The Define Layer Surfaces dialog has three lists for layer targets: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog. To move a layer to a target destination, highlight the desired layer, choose the target from the Move To list and pick the "Move To" button. All layers populate the "Other" target before being assigned to "Existing" or "Design".

Besides the basic three layer targets (Existing, Design and Other), you can add more target surfaces with the Add Target button. When another target is defined, there will be another tab along the top of the Define Layer Surfaces dialog. Then layers can be assigned to this additional target surface. The only pre-defined additional surface is Overexcavate. The layers that are assigned to the Overexcavate target can be modeled into the Overexcavate surface using the Make Overexcavate Surface command. Besides Overexcavate, the other additional targets are user-defined. The layer targets can be modeled using the Make User-Defined Surface command. Then these surfaces can be used in Takeoff commands by assigning them to a Takeoff existing or design surface using the Set Active Surfaces command.

Edit Materials

The "Edit" button activates the Edit Material dialog box (shown here) and allows you to define the Material name
and Subgrade depths and names. Besides assigning target surfaces by layer, layers are also used to define material names and subgrades depths. By assigning a material name, Subgrade names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface, or tie into the design surface by a Slope Ratio if "Use Layback" is checked on. For Area and Back Of Curb/Pavement material types, the polylines on the layer used for a Material must be closed polylines. Carlson Takeoff supports nested Subgrade polylines for exclusion areas such as islands by counting how many Subgrade polylines surround an area. If the number is odd, then the area is included in the Subgrade. The even count regions in the area are not part of the Subgrade. To activate the Edit Material, select a layer from the list and then choose "Edit".

**Include in Material Quantities Report**

With this option checked on, the material that is named will appear in the Material Quantities Report. The report will include either the area of the material, the linear length of the material, or the number of items counted on the layer defining the material. This is accomplished by choosing "Area", "Linear", or "Count" for the Material Type.

**3D Drive View**

This option allows you to assign a color or texture for this particular material for display purposes during the 3D view/drive simulator. The color is assigned to the design surface TIN file.

**Material Type**

This will report the subgrade by area, linear length, count, or as curb/pavement area. If you choose Back of
Curb/Pavement then you can pick on the Curb Dimensions button and bring you to the below dialog:

With the Back of Curb/Pavement, the 3D polylines represent the back of curb elevations. When using this method, the curb polylines alone define the pavement areas and no other design entities (i.e., design contours or spot elevations) should be in the pavement area. The program will adjust the design surface for the height of the curb above ground to get the elevations to the top of pavement. Also with Curb/Pavement, the program will calculate your curb volume as well as act as the limit of the pavement. For the pavement areas bounded by the curb polylines, the program will apply the subgrade depths defined separately from the Curb Dimensions. These pavement subgrade depths are defined in the Area Subgrades section of the Edit Material dialog. The pavement limit will be from the Back of Curb polyline offset by the length of the Curb base. In the above case the base is 30 inches wide. Therefore, the pavement area will stop 30 inches before the Back of Curb polyline.

**Material Cost Per Cost Unit**

Use this field to add the value of the multiplier for the unit cost of your material. If the material type is an area that has multiple subgrades, use the available fields below to add each individual subgrade name, depth and cost value per unit type. If a linear or count type material type option is selected, use the "length in feet", or the "count" unit options.

**Adjust Design Surface by Depth**

This determines whether the subgrade depths are incorporated in the design surface or not.

**Use Vertical from Pad to Surface**

This will interpolate the surface model out to your layer and then vertically adjust the model to tie into the layer. With this checked off, the program will directly interpolate a surface model between your layer and the elevated entities around it.
Output Solid

This creates a solid model for area type materials using the depth for the thickness of the solid. The solid model is saved in an .MDL file that is named automatically using the drawing name.

Area Subgrades

Depth Units

Select the "feet" or "inches" as the unit value desired for depth of subgrades.

Subgrade Name Depth Shrink Cost Per Cost Unit Density

Use these options for areas that are represented with a single/multiple closed polygon/polygons in the drawing, but have multiple material types defining the surface. Simply name each "lift" in the area, issue a depth value and add a cost unit if desired, or click on select and choose a material from the Materials Library (see Define Materials Library for more). Carlson Takeoff will report each subgrade material value in the material quantities report. The Shrink factor is multiplied by the subgrade volume in the material quantities report and represents the fill shrinkage. A Density factor can be entered in when using Cost Per Tons.

If user entered values are needed in the report use the "Edit User-Fields" button to activate the "User Defined Features" dialog box shown here. Choose the "Add" button to define needed fields such as TONS of material or BAGS OF GRASS SEED for reporting options.

Once all of the material subgrades, depths and cost units or user defined units have been defined, select save to preserve the settings in a .trg file, the "save as" function allows the user to name the file to load later.

Prerequisite: None

Keyboard Command: define_tk_layers

Edit Selected Layer

Use this command to click on any layer and advance to the Edit Materials dialog from the Define Layer Target/Material/Subgrade command.

Prerequisite: none

Keyboard Command: edit_tk_layer
Set Layer For Existing

Set Layer For Existing allows the user to pick the layers from objects on the screen and assign them to the Existing Layer.

Prerequisite: none
Keyboard Command: set_existing_layer

Set Layer For Design

Set Layer For Design allows the user to pick the layers from objects on the screen and assign them to the Design Layer.

Prerequisite: none
Keyboard Command: set_design_layer

Set Layer For Other

Set Layer For Other allows the user to pick the layers from objects on the screen and assign them to the Other Layer.

Prerequisite: none
Keyboard Command: set_other_layer

Boundary Polyline

The Boundary Polyline options allow the user to Set the Boundary Polyline, Set the Exclusion Polylines, Clear Exclusion Polylines, Hatch the Boundary Area, Erase the Boundary Hatched area.

Set Boundary Polyline

Use this command to select the "CLOSED" polyline that defines the outer most limit of the disturbed area. This boundary should dissect the site at the point where the design contours meet the existing contours, or where the limit of work will occur. If your site contains separated areas (such as different phases or isolated sections of work), then multiple Boundary Polylines can be used. Volume calculation will take place inside this boundary.

Prerequisite: a closed polyline
Keyboard Command: tag_inclu

Set Exclusion Polylines

Use this command to select the "CLOSED" polylines the define the areas inside the Boundary Polyline that will not be disturbed. These boundaries should also be at the intersection of the proposed and existing surface. A pond or wetland that will not be removed during construction is a good example of an Exclusion Area.

Prerequisite: a closed polyline
Keyboard Command: tag_exclu

Clear Exclusion Polylines
Use this command to select polylines that were previously defined as exclusion polylines but are no longer needed as exclusion areas.

**Prerequisite:** exclusion polylines  
**Keyboard Command:** untag_exclu

### Highlight Boundary Polylines

This command highlights the polyline you set as the Boundary Polyline.

**Prerequisite:** a boundary polyline  
**Keyboard Command:** highlight_boundary

### Hatch Boundary Area

Use this command to confirm the boundary polylines that have been selected are correct. This hatched area can also be utilized in exhibits of the drawing.

**Prerequisite:** a boundary polyline  
**Keyboard Command:** hatch_boundary

### Erase Boundary Hatch

This command erases the hatch drawn in the plan view.

**Prerequisite:** a boundary hatch  
**Keyboard Command:** erase_boundary

### Areas Of Interest

Areas of Interest can be used to calculate volumes and material quantities within a specified area. The Area Of Interest perimeters are defined by user-selected closed polylines and each area is assigned a name. The Area Of Interest polylines can be assigned either as inclusion or exclusion perimeters for the area. You can have any number of exclusion perimeters within an inclusion but inclusion perimeters cannot be inside exclusions. The same area name can be used with multiple inclusion polylines to combine the quantities from those polylines in the report.

The Areas Of Interest (AOI) commands allow you to Tag/Untag Areas of Interest, Identify/Report Areas of Interest and Hatch/Label Areas of Interest.

### Tag Area Of Interest

This command allows the user to select polylines and exclusion perimeters that define phases of a project. Carlson Takeoff will separate each area of interest in the volume and material reports.

**Prerequisite:** a closed polyline  
**Keyboard Command:** tag_aoi
Area Of Interest by Interior Text

This command allows the user to select text from the screen to name AOIs and linework to determine the area.

**Prerequisite:** area linework and text  
**Keyboard Command:** txt2aoi

Untag Area Of Interest

This command allows the user to remove previously tagged areas.

**Prerequisite:** an area of interest  
**Keyboard Command:** untag_aoi

Identify Area Of Interest

This command allows users to identify AOI by either picking on a polyline(s) or by searching the entire drawing. The command will then report the AOI name, layer, type, starting point, and highlight the polyline in the plan view.

**Prerequisite:** an area of interest  
**Keyboard Command:** id_aoi

Report Area Of Interest Areas

Use this command to report the Inclusion or Exclusion area (SF), the name, the layer, and the starting point.

**Prerequisite:** an area of interest  
**Keyboard Command:** report_aoi

Hatch Area Of Interest Areas

This command allows the user to visually see AOIs in the plain view.

This command draws a hatch with a specified color and pattern for the Areas of Interest. The purpose is to allow you to visually review AOIs to make sure that the area coverage is correct.
The command displays a dialog for the hatch pattern, color and scale. The scale determines how spread out the pattern is within the hatch. The Automatic Hatch Scale option checks the size of the subgrade areas and sets the scale to make the pattern fit. Cycle Different Colors For Each Area will give each AOI its own color so that you can distinguish between different AOIs.

The resulting hatch areas show where the AOI is applied. Exclusion Areas of AOIs will not be hatched.

**Prerequisite:** an area of interest  
**Keyboard Command:** hatch\_aoi

---

**Erase Area Of Interest Hatch**

This command erases AOI hatchings.

**Prerequisite:** hatched area of interest  
**Keyboard Command:** erase\_aoi\_hatch

---

**Label Area Of Interest Areas**

This command labels the AOI name and area in the plain view.

**Prerequisite:** an area of interest  
**Keyboard Command:** label\_aoi

---

**Erase Area Of Interest Labels**

This command erases AOI labeling.

**Keyboard Command:** erase\_aoi\_labels  
**Prerequisite:** hatched area of interest

---

**Subgrade Areas**

---

**Hatch Subgrade Areas**

This command draws a hatch with a specified color and pattern for the area that the selected subgrade area applies to. The purpose is to allow you to visually review a subgrade area to make sure that the area coverage is correct.

The command displays a dialog to select which subgrade to hatch. The list of available subgrades comes from the layers with subgrade depths as set in the Define Layer Target/Material/Subgrade command. Then there is a dialog for the hatch pattern, color and scale. The scale determines how spread out the pattern is within the hatch. The Automatic Hatch Scale option checks the size of the subgrade areas and sets the scale to make the pattern fit.

The resulting hatch areas show where the subgrade is applied. In the example below, notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. Also note that the smaller pad area is not hatched because this polyline layer is different than the bigger pad polyline.
### Hatch Subgrades

Select Subgrade To Hatch

<table>
<thead>
<tr>
<th>Name</th>
<th>Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAD</td>
<td>PAD</td>
</tr>
<tr>
<td>PR-FC-CURB</td>
<td>PR-FC-CURB</td>
</tr>
</tbody>
</table>

[Image of a map with hatch subgrades]

[Image of a window listing hatch subgrades]
Pulldown Menu Location: Takeoff > Subgrade Areas
Keyboard Command: hatch_subgrade
Prerequisite: subgrades

Erase Subgrade Hatches
This command removes from the screen the subgrade hatches created by the command Hatch Subgrade Area.

Keyboard Command: erase_subgrade
Prerequisite: hatch subgrade areas

Draw Subgrade Hatch Legend
This command draws a legend for the subgrade areas currently in the drawing. The legend includes the subgrade names and squares of the hatch patterns. The size of the labels, size of the hatch squares, layer for the legend entities and the legend title are set in the dialog shown below. The subgrade hatches to include in the legend are automatically selected from all the subgrade hatches currently in the drawing that were created by the Hatch Subgrade Areas command.

Pulldown Menu Location: Takeoff > Subgrade Areas
Keyboard Command: draw_subgrade_legend
Prerequisite: hatched subgrade areas

Report Subgrade Areas
This command reports all the subgrade areas in the drawing. For each subgrade polyline, the report includes the layer name, subgrade depth, area and polyline starting point.
Sample Report:

Layer Depth Area Starting Point
PAD 1.500 21979.7 6135018.84,2190093.71
CURB 1.000 50420.2 6134994.81,2190125.80
CURB 1.000 114507.3 6135191.33,2190335.27

**Pull-Down Menu Location:** Takeoff > Subgrade Areas  
**Keyboard Command:** report_subgrade  
**Prerequisite:** Subgrade Areas

---

**Label Subgrade Areas**

This command lets you label the subgrade depth and area (in sq. ft. or meters). The label is placed at the center of the subgrade area, but can be moved with the Move command under Edit.

**Pull-Down Menu Location:** Takeoff > Subgrade Areas  
**Keyboard Command:** label_subgrade  
**Prerequisite:** Subgrade Areas

---

**Erase Subgrade Labels**

This command erases subgrade labels.

**Pull-Down Menu Location:** Inquiry-> Subgrade Areas  
**Keyboard Command:** erase_subgrade_labels  
**Prerequisite:** subgrade labels

---

**Topsoil Removal and Replacement**

The Topsoil Removal and Replacement options (shown here) allow the user to Define Topsoil removal and replacement depths, Set topsoil removal and replacement areas by selecting closed polylines, Clear the selected boundary polylines if needed, Hatch the topsoil removal and replacement areas and Erase the hatched areas.
Define Topsoil Depths

This command requires user input to define the depth, or strata, of topsoil removal and replacement. Fill in the options available in the Define Topsoil Depths dialog (shown here). Carlson Takeoff will perform four functions with these values. First, the value set for the Removal Depth, or the Top Strata if selected, will be the "defined" removal amount from the Existing Ground Surface. Second, the calculated volume of topsoil removed will be included in the reporting options. Third, the value set for the Replacement Depth will be added "BELOW" the Finished Ground Surface model. Fourth, the amount of topsoil replaced will be included in the reporting options.

When topsoil depths are defined, the volume report routines will include the topsoil quantities. These topsoil quantities are in addition to the cut/fill for the existing to design surfaces for the site.

The Removal Swell Factor and Replacement Shrink Factor are multiplied by the topsoil removal and replacement quantities respectively in the volume report routines. The Density is used to report topsoil tons when the volume report option for tons is active.

The Topsoil Offset Method choose between offsetting the topsoil depth vertically or perpendicular to the surface. The perpendicular method will result in more topsoil quantities since it represents applying the topsoil depth to the slope area of the surface whereas the vertical method represents applying the topsoil depth to the horizontal area.

![Define Topsoil Depths dialog](image)

Prerequisite: topsoil depths

Keyboard Command: define_topsoil

Identify Topsoil Polylines

This command allows users to identify topsoil polylines by either picking on a polyline(s) or by searching the entire drawing. The command will then report the layer name and starting point for both removal and replacement polylines. These polylines are also highlighted in the plain view.

Prerequisite: topsoil polylines

Keyboard Command: id_topsoil

Report Topsoil Areas

Use this command to report the Inclusion or Exclusion area (SF), the type, the depth, the layer, and the starting point.
Prerequisite: topsoil areas
Keyboard Command: report_topsoil

Label Topsoil Areas

This command labels the topsoil type and area in the plain view.

Prerequisite: topsoil area
Keyboard Command: label_topsoil

Erase Topsoil Labels

This command erases topsoil labeling.

Prerequisite: hatched topsoil
Keyboard Command: erase_topsoil_labels

Set Topsoil Removal Polylines

Use this command to select the "CLOSED" polyline boundary defining the extents of topsoil removal and any "CLOSED" interior polylines that define the topsoil removal area. The layer names for these boundaries is irrelevant. You will be prompted to use the Removal Depth defined in the Define Topsoil Depths command or to customize your depth.

Prerequisite: polylines for removal
Keyboard Command: tag_topsoil_remove

Clear Topsoil Removal Polylines

This command allows the user to remove and previously selected Topsoil Removal Polyline boundaries.

Prerequisite: topsoil polylines
Keyboard Command: untag_topsoil_remove

Hatch Topsoil Removal Area

Use this command to display a hatch pattern over the entire area designated for topsoil removal.

Prerequisite: topsoil areas
Keyboard Command: hatch_topsoil_remove

Erase Topsoil Removal Hatch

Use this command to remove the hatch pattern that defined the topsoil removal area.

Prerequisite: hatched topsoil
Keyboard Command: erase_topsoil_remove
Set Topsoil Replacement Polylines

Use this command to select the "CLOSED" polyline boundary defining the extents of topsoil replacement, and any "CLOSED" interior polylines that define the topsoil replacement. The layer names for these boundaries is irrelevant. You will be prompted to use the Topsoil Replacement amount defined in the Define Topsoil Depths command or to customize your amount.

Prerequisite: polylines for replacement
Keyboard Command: tag_topsoil_replace

Clear Topsoil Replacement Polylines

This command allows the user to remove and previously selected Topsoil Replacement Polyline boundaries.

Prerequisite: topsoil polylines
Keyboard Command: untag_topsoil_replace

Hatch Topsoil Replacement Area

Use this command to display a hatch pattern over the entire area designated for topsoil replacement.

Prerequisite: topsoil areas
Keyboard Command: hatch_topsoil_replace

Erase Topsoil Replacement Hatch

Use this command to remove the hatch pattern that defined the topsoil replacement area.

Prerequisite: hatched topsoil
Keyboard Command: erase_topsoil_replace

Special Fill Areas

Special Fill Areas can be used to identify areas to report fill separately. This can be used for areas were a different type of fill is needed. Such as under a building pad. The Special Fill Areas perimeters are defined by user-selected closed polylines. Carlson Takeoff will separate the special fill volume within the Calculate Total Volume Report.

Tag Special Fill Area

This command allows the user to select perimeter polylines that define special fill areas. Note: The inclusion and exclusion polylines are selected at the same time. The polyline to the inside will be used as an exclusion polyline.

Untag Special Fill Area

This command allows the user to remove previously tagged Special Fill areas.

Identify Special Fill Area
This command allows the user to identify Special Fill Areas by either picking on a polyline(s) or by searching the entire drawing. The command line report the layer, starting point, and highlight the polyline(s) in the plan view.

**Pulldown Menu Location:** Takeoff  
**Prerequisite:** Closed polylines that represent Special Fill Areas  
**Keyboard Command:** tag_special_area, untag_special_area, id_special_area

## Make Existing Ground Surface

This command makes the triangulation models for the existing ground surface. There are three surfaces that are created: initial original ground (og), original ground after applying subgrade zones (ze), and original ground after subgrade zones and topsoil removal (ex). These surface files are automatically named as "filename-og.tin", "filename-ze.tin" and "filename-ex.tin" respectively. The "filename" is set to the name of the current drawing (dwg) file. Also, the file extension will be .tin for the binary format triangulation and .flt for the ASCII format triangulation. This file format is set in Configure->Takeoff.

The surface is built using 3D entities in the drawing on the layers define in Define Layer Target/Material/Subgrade command. Also, the surface elevation for any drillholes are used for the model. The subgrade zones are defined in the Define Layer Target/Material/Subgrade command. If there aren't any subgrade zones for the Existing surface, then the original ground after subgrades surface with be the same as the initial original ground surface. The topsoil removal depths and areas are set with the commands in the Topsoil Removal/Replacement sub-menu. The topsoil removal areas will lower the ground surface by the topsoil depth. If there aren't any topsoil removal areas, then the original ground after subgrade and topsoil surface will be the same as the original ground after subgrade surface.

Before running this command, the layer names for the entities on the Existing layer target must be set in the Define Layer Target/Material/Subgrade command. Also these entities must be at their proper elevations. The entity elevations can be reviewed using commands from the Inquiry menu and the elevations can be assigned if needed using command from the Elevate menu. Another prerequisite is that the Boundary Polyline must be set for the site. If the boundary has not been set, the following error message will appear.

![Carlson TakeOff Message](image)

If this error message appears, run the “Set Boundary Polyline” command and pick the CLOSED polyline representing the boundary of the site.

When the program finds errors in the existing entities, a Data Error Log dialog reports these errors. Three types of conflicts are reported: Crossing Breaklines, Vertical Edges, and Breakline T-Intersections. Crossing Breaklines indicates that the intersection of two entities does not have a common elevation. Vertical Edges indicates that two entities or vertices of differing elevations have the same x-y location, thus forming a vertical plane. Breakline T-Intersections indicates that a 3d entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection. Each type of conflict is listed in its own category.

The Data Error Log shows the amount of elevation difference at each error. You can use the Data Error Log to review, report and draw markers at these error locations. Then you can exit the Data Error Log and fix the data errors with the commands in the Elevate menu or other drafting tools. After these errors are fixed, you can run Make Existing Ground Surface again.
Clicking to the "plus" sign beside a category will display the individual conflicts within that category. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.

**Zoom To** pans the drawing to move the selected conflict to the center of the screen. The zoom functions are only active when a single line item is selected.

**Zoom In** zooms in on the highlighted area for closer inspection. Multiple picks on the zoom button will increase the magnification.

**Zoom Out** zooms out away from the highlighted area.

**Report All/One** toggles between One and All depending whether a single line item conflict or a category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.

**Draw All/One** toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict. The layer and size of the symbol is controlled in the fields below.

**Continue** closes the Error Log and proceeds with the contouring operation.

**Settings** has controls for the tolerances for error reporting and for the Layer Name and Symbol Size to use with the Draw function.

**Keyboard Command:** mk_exist_tin

**Prerequisite:** a boundary polyline and elevated entities on the Existing layer target

### Make Design Surface

This command makes the triangulation models for the design surface. There are three surfaces that are created: initial unadjusted design (bs), design after applying subgrade zones (zn), and design after subgrade zones and topsoil replacement (fn). These surface files are automatically named as "filename-bs.tin", "filename-zn.tin" and
"filename-fn.tin" respectively. The "filename" is set to the name of the current drawing (dwg) file. Also, the file extension will be .tin for the binary format triangulation and .flt for the ASCII format triangulation. This file format is set in Configure->Takeoff. The subgrade zones are defined in the Define Layer Target/Material/Subgrade command. If there aren't any subgrade zones for the Design surface, then the design after subgrades surface will be the same as the initial design surface. The topsoil replacement depths and areas are set with the commands in the Topsoil Removal/Replacement sub-menu. The topsoil replacement areas will lower the design surface by the topsoil depth to leave room for the topsoil replacement. If there aren't any topsoil replacement areas, then the design after subgrade and topsoil surface will be the same as the design after subgrade surface.

Before running this command, the layer names for the entities on the Design layer target must be set in the Define Layer Target/Material/Subgrade command. Also these entities must be at their proper elevations. The entity elevations can be reviewed using commands from the Inquiry menu and the elevations can be assigned if needed using command from the Elevate menu. Another prerequisite is that the Boundary Polyline must be set for the site.

When the program finds errors in the existing entities, a Data Error Log dialog reports these errors. Refer to the Make Existing Surface command for more information on the Data Error Log dialog.

**Keyboard Command:** mk_final_tin

**Prerequisite:** a boundary polyline and elevated entities on the Existing layer target

---

**Overexcavate Surface**

**Make Overexcavate Surface From Existing/Design Surfaces**

The Initialize Overexcavation Surfaced dialog box shown here allows the user to select which surface model to overexcavate and to enter in the depth value for the desired adjustment. Use the Min Existing/Design option to set the overexcavate as the minimum of the existing and design surfaces. If a single surface is selected the value entered will be applied to that surface only. The resulting surface of Make Overexcavate Surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

**Prerequisite:** Existing and/or Design surfaces

**Keyboard Command:** set_overx

---

**Make Overexcavate Surface From Surface File**

This command sets the overexcavate surface to a selected TIN surface file by copying the TIN file to the overexcavate surface. The overexcavate surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

**Pulldown Menu Location:** Takeoff > Overexcavate Surface

**Keyboard Command:** overx_by_file

**Prerequisite:** .tin file
Make Overexcavate Surface From Strata

This command sets the Overexcavate surface to a selected strata surface. Before running this command, the strata surface must be created with the Make Strata Surfaces command in the Drillhole menu. The resulting overexcavate surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

Prerequisite: Strata surfaces
Keyboard Command: overx_by_strata

Make Overexcavate Surface From Screen Entities

This command makes the overexcavate surface from entities on the layers defined as Overexcavate in the Define Layer Target/Material/Subgrade command. The resulting surface of Make Overexcavate Surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

Prerequisite: overexcavate entities
Keyboard Command: mk_overx_tin

Adjust Overexcavate Surface

This command adjusts the overexcavate surface vertically within the selected perimeter polylines. This command allows the site to be overexcavated at a variety of depths in specified areas represented with CLOSED polyline boundaries. Select the desired areas to be adjusted when prompted at the command line.

Keyboard Command: adjust_overx
Prerequisite: an overexcavate surface

View Overexcavate Surface

Use this command to view the current overexcavate surface. The Takeoff 3D Viewer will display the 3D faces of the adjusted surface. Shade the 3D model and adjust its perspective to view a rendered display. The surface that is displayed will depend on the latest surface created using the make and adjust routines.

Prerequisite: an overexcavate surface
Keyboard Command: cube_overx

Draw Overexcavate Surface 3D Faces

Use this command to draw the 3D faces of the overexcavated surface model on the screen. The 3D faces will be drawn in the TK_OVERX_SURFACE layer and will depend on the latest surface created using the make and adjust routines.

Prerequisite: An overexcavate surface
**Erase Overexcavate Surface 3D Faces**
Use this command to remove the previously drawn 3D Faces from the screen.

**Prerequisite:** 3D Faces  
**Keyboard Command:** erase_overx

**Draw Overexcavate Cut Color Map**
Use this command to display a cut color map on the screen that shows the areas of overexcavate cut. The colors will graduate from white to red based on zero cut depth to maximum cut depth. This command also offers the user to place a legend of the cut depths on the screen. Pick the desired location and type the desired scale of the legend when prompted at the command line.

**Prerequisite:** An overexcavate surface  
**Keyboard Command:** overx_cfmap

**Erase Overexcavate Cut Color Map**
Use this command to remove the previously drawn Cut Color Map and Legend from the screen.

**Prerequisite:** An overexcavate cut color map  
**Keyboard Command:** overx_cfmap2

**Clear Overexcavate Surface**
Use this command to remove the overexcavate surface. When the overexcavate surface is removed, the rest of the Takeoff commands will not calculate overexcavate volumes. You will be prompted to confirm before the remove is done.

![Clear Overexcavate](image)

**Pulldown Menu Location:** Takeoff > Overexcavate Surface  
**Prerequisite:** An overexcavate surface  
**Keyboard Command:** clear_overx

**Overexcavate Removals**

**Make Top Surface**

**From Existing/Design Surfaces**
This command sets the top Overexcavate surface (dwgname-rm.tin) that will be compared to a bottom Overexcavate surface for removal volumes. In the below dialog, Existing and Design surfaces created in Takeoff can be used as
the top Overexcavate surface. Min Of Existing/Design is the minimum, or lowest grade, between the Existing and Design surfaces. Adjustment Depth allows you to drop either the Existing or Design surface by a specified amount.

Prerequisite: an existing or design surface
Keyboard Command: set_rm_top

From Triangulation Surface File

This routine allows a previously created surface .tin or .flt file to be loaded as the top Overexcavate surface.

Prerequisite: a previously created surface .tin or .flt file
Keyboard Command: rm_top_file

From Screen Entities

This command will create the top Overexcavate surface from entities in the plan view. Entities will need to have elevation such as contours, 3D faces, or elevated polylines.

Prerequisite: screen entities with elevation
Keyboard Command: mk_rm_top

View Top Surface

This command allows you to view the top Overexcavate surface in 3D mode.
In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface (the shading is shown in the above drawing). The arrow icon reports the elevations at the bottom of the screen as you move around the surface.

The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

Prerequisite: a top Overexcavate surface
Keyboard Command: cube_rm_top
Draw Top Surface 3D Faces

This command will display the top Overexcavate surface as 3D faces in the plan view.

Keyboard Command: draw_rm_top
Prerequisite: Make Top Surface
This command will erase the plan view entities created in Draw Top Surface 3D Faces.

Keyboard Command: erase_rm_top
Prerequisite: Draw Top Surface 3D Faces

Removal Settings

This command sets the layers suffixes for the entities created in the commands Draw Removal Surface and Draw Removal Contours. These Surfaces are added to the Removal Area names. For example, if Topo2 is set to Current in the Removal Manager, Draw Removal Surface will create 3D faces on the layer Topo2_TIN. Likewise, Draw Removal Contour will create contours on the layer Topo2_CONTOUR. The interval that the contours are drawn are also set here.
Prerequisite: none  
Keyboard Command: rm_overx_setup

Removal Manager

In Removal Manager command every Removal Area in a project and the entities that define them is displayed as well as the Centroid (center coordinate) for that Area. Add allows you to name and create a new Removal Area. Remove will delete the Removal Area. When a Removal Area is set to Current, it will be used by other Removal commands when processing.

Prerequisite: none  
Keyboard Command: rm_overx_mgr

Import Removal Text ASCII File

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. The points brought in with this command will be assigned to the Current Removal Area if Draw Points is set to Points or Field-to-Finish. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters.
Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File. Special formats can be directly imported by choosing that File Format at the top of the dialog.

**Prerequisite:** Text/ASCII File and a Removal Area created and set to Current  
**Keyboard Command:** rm_overx_mgr

### Draw Removal Field to Finish

This command turns data collector field notes into Removal Area points and linework by matching the descriptions of the field points with user-defined codes. Two files are used in Field-to-Finish - a coordinate file and a field code definition file. For more on these files and their settings see Draw Field-to-Finish under Survey.

**Keyboard Command:** rm_overx_f2f

**Prerequisite:** A data file of points with descriptions and a Removal Area created and set to Current

### Draw Removal Breakline

This command allows you to draw 3D linework for the Current Removal Area.
The Show Options on Startup dialog will appear every time the command is run, unless this is turned off. If it is off, then the last settings will apply. To get the box back, choose O for Options.

Prompt for Elevation/Slope controls whether the elevation of each picked point will be entered in, or hit S for slope to draw a slope line.

Use Surface Model from File will use a grid or triangulation file as a surface model. Wherever the points are picked on the surface, the elevation of the surface will be assigned to the polyline.

There are 3 options under Auto-Zoom Mode. Never will not zoom to the last point picked. Proximity will zoom to the percent proximity set below. Always will always zoom center on every point.

If the Proximity Auto-Zoom mode is checked, the percent of the proximity is set in the Proximity Zoom Level% box.

**Keyboard Command:** rm_overx_3dp  
**Prerequisite:** a Removal Area set to Current

---

## Removal Entities

### Tag Removal Entities

This command allows the user to select polylines and points that define the Current Removal Area. Carlson Takeoff will separate each Removal Area in the Calculate Removals Volumes Report.

**Prerequisite:** linework and/or points intended for the Current Removal Area  
**Keyboard Command:** tag_rm_overx

### ID Removal Entities

This command allows users to identify Removal Entities by either picking on a polyline(s) or by searching the entire drawing. The command will then highlight the polyline in the plan view.

**Prerequisite:** Tag Removal Entities  
**Keyboard Command:** id_rm_overx

---

## Untag Removal
This command allows the user to remove previously tagged Removal Entities.

**Prerequisite:** Tag Removal Entities  
**Keyboard Command:** untag_rm_overx

---

**Set Removal Boundary**

Use this command to select the "CLOSED" polyline that defines the outer most limit of the Current Removal Area. This boundary should dissect the site at the point where the Current Removal Entities end. Volume calculation will take place inside this boundary.

**Prerequisite:** a closed polyline  
**Keyboard Command:** rm_overx_perim

---

**Make Removal Surface**

This command makes the triangulation models for the Removal Surfaces. The surface is automatically named as "filename-removalname.tin". The "filename" is set to the name of the current drawing (dwg) file. The "removalname" is determined by the Removal Area current in the Removal Manager. Before running this command, you must have a current Removal Area with elevated entities. Another prerequisite is that the Removal Boundary must be set for the site.

**Keyboard Command:** mk_rm_overx  
**Prerequisite:** Removal Entities and a Removal Boundary

---

**Draw Removal Surface**

This command draws the current Removal Surface as 3D faces in the plan view.
Keyboard Command: draw_rm_overx_tin
Prerequisite: Make Removal Surface

**Draw Removal Contours**

This command displays all the contours that represent current Removal Surface. They are created off of the Removal Area .tin model. For contour interval, see Removal Settings.

Keyboard Command: draw_rm_overx_ctr
Prerequisite: Make Removal Surface

**Calculate Removals Volumes**

This command reports the volumes in cubic yards for each Removal Area against the Top Removal Surface. The volumes are given for each area as well as a total for all the areas. Calculate Removal Volumes then creates and reports a Composite Surface against the Top Removal Surface taking the lowest grade in overlapping Removal Areas.
From the Standard Report Viewer, you can Save, Print, or place on the Screen the volume numbers. You can also type your own text into the report.

**Keyboard Command:** calc_rm_overx  
**Prerequisite:** Make Top Surface and Make Removal Surface

### Make Combined Removal Surface

This command makes a TIN surface from all the removal surfaces from the Removal Manager. The command reports all the removal surfaces from the current drawing and then prompts for the TIN file to create.

**Keyboard Command:** overx_combine  
**Prerequisite:** Overexcavate Removal Surfaces

### Surface Tools

#### Surface Manager

This command allows the user to name and manage multiple surface models. The Surface Manager dialog shown here has options to name and save the current "existing and design" surface models. The "current" surface is dictated by the layers that populate a target and the Make Surface command. If layers are removed from a target, and others assigned, multiple surfaces can be created and stored. When the Lock Status is check, the Current Surface will remain current even if you run Takeoff > Make Existing Ground Surface or Make Design Surface. If the Lock Status is uncheck, then Making the Existing or Design Surface will become the current surface, overriding the current surface selected in the Surface Manager. Highlight a named surface and select the Set Current From List option to make that model active. Use the Remove From List option to remove a named surface model from the list.
Selecting the Save Current To List options brings up the Surface Name dialog box shown here. Type the desired name that describes a particular surface model and select OK.

**Pulldown Menu Location:** Takeoff > Surface Tools
**Prerequisite:** none
**Keyboard Command:** surf_mgr

**Make User Defined Surface**
This command makes a surface from the entities on the layers defined as user-defined targets in the Define Layer Target/Material/Subgrade command. The purpose of user-defined surfaces is for modeling surfaces besides existing ground and design. The drawing needs to contain entities that represent the elevations of the user-defined surface. For example, the user-defined surface could be for alluvial soil and the drawing has contour polylines for this surface.

There is a dialog to select which surface to make. The surface is stored in a triangulation file that is named after the current drawing name with the user-defined surface name appended.

This user-defined surface can be applied to Takeoff routines by running the Set Active Surfaces command.

**Pulldown Menu Location:** Takeoff > Surface Tools
**Prerequisite:** Define Layer Target/Material/Subgrade command
Set Active Surfaces

This command assigns which surfaces to use for initial and final. These surfaces are used by all the Takeoff routine that compare surfaces including:
- Calculate Total Volumes
- Calculate Volumes Inside Perimeter
- 3D Drive Simulation
- Cut/Fill Contours/Labels/Color Map
- Surface Inspector
- Quick Profile
- etc.

The surface created by the Make Existing Ground Surface command is called "Existing" and is the default for the Initial Surface. The surface created by the Make Design Surface command is called "Design" and is the default for the Final Surface.

The purpose of this routine to for selecting user-defined surfaces to use in place of the existing ground or the design surface. For example, there could be a user-defined surface for alluvial soil that is set as the initial surface while design is set to the final surface. Then the calculate volume routines will report the quantities between alluvial soil and design. Also the Display->Cut/Fill Color Map routine will make the map for the difference between the alluvial soil and design surfaces.

These user-defined surfaces can be created using the Add Target function in the Define Layer Target/Material/Subgrade command combined with the Make User-Defined Surface command.

Prerequisite: a surface model
Keyboard Command: set_active_tins

Design Surface Vertical Offset

This command can be used to lower or raise the design surface within a defined perimeter or by the entire surface.

Prerequisite: a design surface
Keyboard Command: adjust_final

Existing Surface Vertical Offset

This command can be used to lower or raise the existing surface within a defined perimeter or by the entire surface.

Prerequisite: an existing surface
Keyboard Command: adjust_exist
Merge Existing With Design

This command allows you to merge the existing surface with design surface within perimeter polylines. The resulting merged surface can be saved to update either the Existing or Design surfaces. The program prompts for inclusion and exclusion perimeter polylines. These polylines must be closed. The merge will be applied inside the inclusion perimeters and not inside the exclusion perimeters. The exclusion perimeters are optional.

For example, if a portion of the site is completed, you can update the existing surface to match the design for the completed area. First, draw a closed polyline around the completed area. Then run Merge Existing With Design and choose the merge results target as Existing. Then select the perimeter polyline.

Pulldown Menu Location: Takeoff > Surface Tools
Prerequisite: existing and design surfaces and an inclusion perimeter polyline
Keyboard Command: merge_final

Triangulate and Contour

This command provides all of the functionality related to contouring and creating tin surface models in one routine. Given data entities that represent the surface, this command creates a final contour map with labeled, smoothed, and highlighted contours and/or a surface model that can be saved to a file (to be used in other areas of the program) or drawn on the screen as triangles or faces. Eligible data entities include points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

Triangulate & Contour has many options which are defined in the exhibits shown in the following pages. With this command, you can do any combination of drawing the triangulation network lines, drawing the contours, drawing triangulation network 3D Faces or lines, writing a triangulation file and storing a surface file.

In order to force Triangulate & Contour to correctly interpolate elevations between two points that define a grade break in the surface (such as points on a ridge, wall, or road), a breakline must exist between the points. A breakline line can be specified as a 3D polyline or line. In fact, all 3d polylines and lines with elevation are be treated as breaklines.

Triangulate Tab
Draw Triangulation Lines

When this option is turned on, the program will draw the triangulation as 3D lines. Specify the layer for these lines in the box to the right.

Draw Triangulation Faces

When this option is turned on, the program will draw each triangle in the triangulation network as a 3D Face. These 3D Faces can then be used in AutoCAD's modeling routines such as **HIDE** and **SHADE** or in routines such as **3D Viewer Window**, **3D Surface FlyOver and Slope Zone Analysis**. Specify the layer for these 3DFaces in the box to the right.

Store Surface Data

This option names and creates a surface or surfaces that are associated with the drawing. The creation of a surface is necessary in order for the Surface Tools to function. A Triangulation file must also be specified before using the Store Surface option.

Write Triangulation File

This option stores the triangulation surface model as an .flt or a .tin file. The .flt file format is a text file depicting the edges in the triangulation network. The .tin file is a new binary file format depicting the triangulation network. The .tin file is much faster and more efficient than the previous .flt file format. The triangulation file/s can be used by several commands such as **Volumes By Triangulation**, **Spot Elevations**, and **Profile from FLT File**. Either type in the file name to create or press the Browse button to select a file name.

Use Inclusion/Exclusion Areas

When this box is activated, the program will later prompt you for inclusion and exclusion polylines which are used to trim the contours. The inclusion and exclusion polylines must be closed polylines and must be drawn before starting **Triangulate & Contour**. Only the parts of the contour lines that are within the inclusion polylines will be drawn. For example, an inclusion could be the perimeter of the site. The parts of contour lines that are inside the exclusion polylines are not drawn. Exclusion polylines can be used for areas where you don't want contours such as within buildings.

Ignore Zero Elevations
When activated, this setting will filter out all data points at an elevation of zero from the data set.

**Erase Previous Contour Entities**

When activated, this setting will erase previously drawn contour entities.

**Specify Elevation Range**

The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval. If you would like to manually set the range over which to contour, select this option.

**Pick Reference Plane**

The triangulation network is based on the x,y position of the points. This option allows you to contour an overhang or cliff by changing the reference plane to a side view. The reference plane can be specified by first using the *Viewpoint 3D* command and then using the View option, or you can specify three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines**

This option highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys**

This option creates additional triangulation in a ridge or valley situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours, since it replaces the need to manually draw 3d polylines along ridges and valleys.

**Interpolate Summits and Pits**

This option creates additional triangulation in a summit or pit situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours.

Before: Surface made from an existing contour map. Note the flat spots in the bottom of the valley when Interpolate Ridges and Valleys is disabled.

After: The same surface with Interpolate Ridges and Valleys enabled.
**Max Triangle Mesh Line Length**

This value limits the length of the triangulation network lines. Any triangulation line that exceeds this limit will not be drawn or included in contouring. This allows you to avoid abnormally long triangulation lines where you have relatively too few data points and on the outskirts of your data points. The **Exterior** value applies to triangulation lines around the perimeter of the triangulation area and the **Interior** value applies all the other triangulation lines. Generally you would have the exterior value larger than the interior.

**Error Log**

The following dialog box appears when the Triangulate & Contour routine finds a conflict between breaklines or other surface entities. The type of conflict is identified, and when an item is chosen, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Crossing Breaklines indicates that the intersection of two entities has two differing elevations. Vertical Edges indicates that two entities or vertexes of differing elevations have the same xy location, thus forming a vertical plane.
Contour Tab

Draw Contours
When this box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

Contour by Interval or Contour an Elevation
Select whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows
you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

**Contour Interval**

Specify the interval to contour. Note: If the above option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

**Minimum Contour Length**

Contour lines whose total length is less than this value will not be drawn.

**Reduce Vertices**

This option attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is ON

**Offset Distance**

When the Reduce Vertices option is enabled, This value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

**Hatch Zones**

When activated, this option will allow you to hatch the area between the contours sequentially. A secondary dialog will load allowing the user to specify the hatch type and color.

**Draw Index Contours**

This option creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

**Contour Smoothing Method**

Select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

**Bezier Smoothing Factor**

The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect.

**Subdivisional Surfaces / Subdivisions Generation**

This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance's sake, consider enabling Reduce Vertices.

**Labels Tab**
Label Contours
When activated, contours will be labeled based on the settings below.

Label Layer
Specifies layer name for intermediate contour labels.

Index Label Layer
Specifies layer name for index contour labels.

Label Style
Specifies the text style that will be used for the contour label text.

Label Text Size Scaler
Specifies the size of the contour labels based on a multiplier of the horizontal scale.

Min Length to Label
Contours whose length is less than this value will not be labeled.

Break Contours at Label
When checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

Draw Broken Segments
When checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

Label Contour Ends
When checked, contour ends will be labeled.

Draw Box Around Text
When checked, a rectangle will be drawn around contour elevation labels.

Label Index Contours Only

When checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

Hide Drawing Under Labels

This option activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour is fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels, and the contour lines themselves remain contiguous. This feature will also hide other entities that area in the immediate vicinity of the contour label.

Align Text with Contour

When checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

Align Facing Uphill

When checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the bottom of the text label will always be toward the downhill side of the contours. So as the labels are read right side up, you are always facing uphill.

Internal Label Intervals

Choose between label intervals or distance interval. Label intervals will label each contour with a set number of labels. Distance interval lets you specify a distance between labels.

Selection Tab
Specify Selection Options

When checked, this allows you to control what type of entities *Triangulate & Contour* uses. Points, 3D Polylines, 2D Polylines, Lines, Inserts are standard AutoCAD entities types. Spot/Bottom Elevation Inserts include text entities that start with 'X'. From File allows you to triangulate from the points in a coordinate (.CRD) or ASCII file.

Label Contour Ends

Align Text With Contour ON

Align Text With Contour OFF
Contours without triangulation network. The contours are smoothed, reduced, drawn at an interval of 2, and highlighted at an interval of 10 with labeling on the index contours.

**Pull-Down Menu Location:** Tools-> Surface Tools

**Prerequisite:** Data points of the surface

**Keyboard Command:** tri
Triangulation File Utilities

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10’, thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

**Load TIN File:** Allows you to specify a triangulation (.flt or .tin) file to load.

**Load DXF File:** Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

**Select 3D Faces:** Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.

**Pick Bounding Polylines:** Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

**Fast TIN Intersect:** When checked, this command will not try and intersect 3DFACE entities.

**Fill-in-holes:** When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to set before loading the TIN file to take effect.

**Next:** Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you...
do not specify any perimeters, the desired operation/s will be performed on the entire TIN.

**Elev-Value:** Specify either an elevation or value depending on the operation. The value specified will be used for subsequent operations.

**Set New Elevation:** Sets all TIN faces in the subject area to the elevation specified in the Elev-Value field.

**Set NULL's to Elevation:** Sets all NULL values in the subject area to the elevation specified in the Elev-Value field.
Set Elevation's to NULL: Sets all of the elevation values in the subject area to NULL.

Set Elevation by Surface: Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.

Add: Adds the value specified in the Elev-Value field to the subject area of the TIN.
Subtract: Subtracts the value specified in the Elev-Value field to the subject area of the TIN.
Multiply: Multiplies by the value specified in the Elev-Value field to the subject area of the TIN.
Divide: Divides by the value specified in the Elev-Value field to the subject area of the TIN.

Offset: Performs a perpendicular offset of the TIN surface by the specified amount.

Tolerance: This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

Simplify: Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

Add TIN: Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

Subtract TIN: Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

Min TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

Max TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

Join TIN: Merges the existing subject TIN into a second user selected TIN file. The subject TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file.

Insides: If this is the only option checked, only changes made within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved.

Border:

Outsides: If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved. Everything outside of the perimeter will be saved.

SaveAs TIN: Saves the current TIN as an .flt or .tin file.
SaveAs DXF: Saves the current TIN as a DXF file. This format can be used by many other CAD programs.
Draw As 3DFaces: Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.
This icon converts the right mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out. This icon converts the right mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis. This icon converts the right mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes. This icon toggles shading on and off. This icon restores the graphics to plan view. This icon reverses the effects of all operations performed on the TIN and reverts it back to its original status. This icon exits the routine. If the TIN has been modified, you will be prompted to save.

**Pull-Down Menu Location:** Tools-> Surface Tools
**Prerequisite:** 3D Faces, a TIN file or a DXF file.
**Keyboard Command:** TINUTIL

## Volumes By Triangulation

Volumes By Triangulation is an alternative volume method that compares two triangulation networks. This method is different from the grid based volume routines (Stockpile Volumes, etc.) and the cross section volume routine (Calculate Section Volume). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismatic volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot wide ditch. Then the grid resolution would need to be less than 5 foot to model the ditch which might be difficult on a large site.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes by Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.

The triangulation networks to compare are defined in .flt files that are created by **Triangulate & Contour** with the Write Triangulation File option. Before using this command, run **Triangulate & Contour** twice to create an triangulation (.TIN) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.

### Prompts

**Select EXISTING surface Tmesh File** Choose a .tin file  
**Select FINAL surface Tmesh File** Choose another .tin file  
**Pick inclusion perimeter polyline (ENTER for none):** *pick a closed polyline perimeter*  
**Calculating ...**  
**Write report to file (Yes/<No>)?** *Press Enter*  
**Write report to printer (Yes/<No>)?** *Press Enter*  
**Comparing Triangulation files: C:\SCADXML\DATA\TRI1.FLT and C:\SCADXML\DATA\TRI2.FLT**
Cut volume: 66891.35 C.F., 2477.46 C.Y.  
Fill volume: 43458.01 C.F., 1609.56 C.Y.  

Pull-Down Menu Location: Tools-> Surface Tools  
Prerequisite: Two .tin files.  
Keyboard Command: trivol  

**Calculate Stockpile Volume**

This command is a customized and simplified method for calculating volumes in a situation in which the entire volume to be calculated is above the perimeter elevation, such as in the case of a stockpile of material. The complimentary command, *Calculate Pond/Pit Volume*, is for the opposite situation, in which the entire volume to be calculated is below the elevation of the perimeter.

The program internally computes base and final grid surfaces from drawing geometry. The base surface is calculated from a 3D polyline representing the perimeter of the area being analyzed. If that 3D polyline is drawn on the PERIMETER layer, the command will automatically detect and use it. If no 3D polyline is found on that layer, you have an opportunity to manually select another 3D polyline to use. The 3D polyline perimeter can be drawn with the Draw 3D Polyline Perimeter command before using this routine.

The 3D polyline perimeter is also used as the inclusion perimeter for the volume calculation. Additional 3D polylines can also be specified to more precisely define the base surface. These must be on the BASE_BREAKLINE layer to be used for this purpose. These can be generated by the *Draw 3DPoly Base Breakline* routine.

The final surface is calculated from all of the other selected drawing entities such as points, line, inserts, and polylines, along with the perimeter polyline, but not including the BASE_BREAKLINE polylines.

You have the option of setting the resolution of the grids.

**Prompts**

*Material density lbs/ft³ (Enter for none):* enter a material density in lbs per cubic foot, or press Enter for none  
*Ignore Zero Elevations [<Yes>/No]?*  
*Select stockpile entities and perimeter.*  
*Select objects:* pick the objects that define the stockpile and the 3D polyline perimeter  
*Select stockpile perimeter polyline:*

![Make 3D Grid File dialog](image)

Make Grid File dialog Set the resolution and then click OK.
Volume report
Lower left grid corner: 15965.45,12657.05
Upper right grid corner: 16269.40,12906.29
X grid resolution: 50, Y grid resolution: 50
X grid cell size: 6.08, Y grid cell size: 4.98
Stockpile volume: 1191674.87825 cubic ft, 44136.107 cubic yards

Stockpile defined by points and a 3D polyline perimeter
Window these objects to obtain the volume report

Keyboard Command: stockvol
Prerequisite: Data representing the stockpile surface and a 3D polyline representing the perimeter of the stockpile.

Calculate Pond/Pit Volume
This command is a customized and simplified method for calculating volumes in a situation in which the entire volume to be calculated is below the perimeter elevation, such as in the case of a pond or pit. The complimentary command, Calculate Stockpile Volume, is for the opposite situation, in which the entire volume to be calculated is above the elevation of the perimeter.

The program internally computes base and final grid surfaces from drawing geometry. The base surface is calculated from a 3D polyline representing the perimeter of the area being analyzed. If that 3D polyline is drawn on the PERIMETER layer, the command will automatically detect and use it. If no 3D polyline is found on that layer, you have an opportunity to manually select another 3D polyline to use. The 3D polyline perimeter can be drawn with the Draw 3D Polyline Perimeter command before using this routine.

The 3D polyline perimeter is also used as the inclusion perimeter for the volume calculation.
Additional 3D polylines can also be specified to more precisely define the base surface. These must be on the BASE_BREAKLINE layer to be used for this purpose. These can be generated by the Draw 3D Poly Base Breakline routine.

The final surface is calculated from all of the other selected drawing entities such as points, line, inserts, and polylines, along with the perimeter polyline, but not including the BASEBREAKLINE polylines.

You have the option of setting the resolution of the grids.

Prompts
Ignore Zero Elevations [Yes]/No? Select Pond/Pit entities and perimeter.

Select objects: pick the objects that define the surface and the 3D polyline perimeter
Select Pond/Pit perimeter polyline:

Make Grid File dialog Set the resolution and then click OK.

Keyboard Command: pitvol
Prerequisite: Data representing the pond/pit surface and a 3D polyline representing the perimeter of the pond/pit.

**Draw 3D Poly Perimeter**

This command draws a 3D polyline in the PERIMETER layer. This polyline is required by the Calculate Stockpile Volume and Calculate Pond/Pit Volume routines. In these routines, this polyline is used as the inclusion perimeter for volumes. You may want to set your AutoCAD Object Snap prior to running this routine so that you obtain the elevations of existing points while creating the 3D polyline.

**Prompts**

Select the 3D polyline options you want and press enter.

Command: 3dperim

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: (Pick)
Interpolate/screen Pick/<Elevation> <0.00>: 818
Z: 818.00

[Arc/Close/Direction/Extend/Follow/Undo/<Pick point or point numbers>]: (Pick)
Slope/Ratio/Interpolate/Degree/screen Pick/<Elevation> <0.00>: 814
Z: 814.00, Hz dist: 60.64, Slope dist: 60.77, Slope: -6.6% Ratio: -15.2:1

[Arc/Close/Direction/Extend/Follow/Undo/<Pick point or point numbers>]: (Pick)
Slope/Ratio/Interpolate/Degree/screen Pick/<Elevation> <0.00>: 815
Z: 815.00, Hz dist: 26.32, Slope dist: 26.33, Slope: 3.8% Ratio: 26.3:1

[Arc/Close/Direction/Extend/Follow/Undo/<Pick point or point numbers>]: c for close

Pull-Down Menu Location: Tools-> Surface Tools
Keyboard Command: 3dperim
Prerequisite: None

**Draw 3D Poly Base Breakline**

This command draws a 3D polyline in the BASE_BREAKLINE layer. This polyline is used by the Calculate Stockpile Volume and Calculate Pond/Pit Volume routines to model the base surface. You may want to set your
AutoCAD Object Snap prior to running this routine so that you obtain the elevations of existing points while creating the 3D polyline.

**Prompts**

Select the 3D polyline options you want and press enter.

command: 3DBASE

[Continue/Extend/Follow/Options/<Pick point or point numbers>:] (Pick)

Interpolate/screen Pick/<Elevation> <0.00>: 818

Z: 818.00

[Arc/Close/Direction/Follow/Undo/<Pick point or point numbers>:] (Pick)

Slope/Ratio/Interpolate/Degree/screen Pick/<Elevation> <0.00>: 814

Z: 814.00, Hz dist: 60.64, Slope dist: 60.77, Slope: -6.6% Ratio: -15.2:1

[Arc/Close/Direction/Extend/Follow/Undo/<Pick point or point numbers>:] (Pick)

Slope/Ratio/Interpolate/Degree/screen Pick/<Elevation> <0.00>: 815

Z: 815.00, Hz dist: 26.32, Slope dist: 26.33, Slope: 3.8% Ratio: 26.3:1

[Arc/Close/Direction/Extend/Follow/Undo/<Pick point or point numbers>:] (Enter)

**Pull-Down Menu Location:** Tools->Surface Tools

**Prerequisite:** None

**Keyboard Command:** 3dbase

**Calculate Total Volumes**

Use this command to report total volume calculations within the site boundary polyline. The report includes the cut and fill quantities, slope and horizontal area, average and max strata cut depth and max cut/fill depths and locations. Also in the report, strata and topsoil quantities if the site has strata and topsoil defined. Besides reporting the total quantities for the site boundary, Area Of Interest polylines can be used to report quantities within named perimeters.

Before running this command, the existing and design surfaces must be created and the boundary polyline must be assigned. Also, the strata surfaces, topsoil and Area Of Interest polylines need to be set before this command if those features are to be reported.

The Volume Options dialog box shown here offers options for the final report. Here you can select four different types of reports: Standard Report Viewer, Custom Report Formatter, Expanded Auto Format, and Compressed Auto Format. The Cut Swell Factor is multiplied by the cut volume and the Fill Shrink Factor is multiplied by the fill volume. Report Cut/Fill Depth Zones breaks the Cut/Fill volumes up by user-defined depth intervals. The Report Units setting chooses between English and Metric quantities for the report. In Drawing Setup in Takeoff, you set the drawing units as either English or Metric. The Report Units will default to match the drawing units but you can change the Report Units to the other mode and the program will apply the conversion between English and Metric for the report. So you can have a drawing in English units and create a report with Metric quantities.

Note: As the quantities are calculated within each area, the area is hatched with a solid fill as a visual verification that the right area is being processed.
Shown here is an example of a Standard Report Viewer.

Use Customs Report Formatter to customize or "user define" the reporting options. The Report Formatter Options dialog box shown here offers a variety of output options including Excel. You can choose the fields to report from the Available list and set their report order under the Used list.
For the Compress and the Expanded Auto Formats, the Report Cut/Fill in Color option will color the cut values in red and the fill values in blue in the report. Also, the Page Settings button has more controls for these auto formats including whether to output the report to PDF or to a drawing layout.

The Expanded Auto Format is shown below.
If drillholes have been located on the drawing and strata types and depths have been defined, a calculate Strata Depth Zones Volume option becomes available. Here strata volumes are broken down by user-specified depth intervals. The depths are either determined horizontally (By Level) or by the area of the deepest cut (By Zone Area).
Shown here is an example of the report if strata depth intervals have been defined.

The Balance Cut/Fill option shown here allows an import or export volume in cubic yards option. Use these options if waste material is available or needed elsewhere. If this option is used the resulting report indicates the vertical movement of the site needed to satisfy the balance option.

Shown here is a report with a 500 CY importation of material and suggests that the site be vertically raised 0.859 feet.
If the adjusted surface is satisfactory, Carlson Takeoff offers the option to save the adjusted surface as shown here in the Balance Cut/Fill dialog box.  

**Pulldown Menu Location:** Takeoff

**Prerequisite:** Existing and design surfaces and a boundary polyline

**Keyboard Command:** `tin_volume`

---

### Calculate Volumes Inside Perimeter

Use this command to create volume reports inside the selected closed perimeter polyline. The same reporting options are available for this command as are for the Calculate Total Volumes command.

**Keyboard Command:** `tin_volume2`

**Prerequisite:** Existing and Design surfaces and a closed perimeter polyline

---

### Linework Length Report

This command reports the length and properties of selected linework. When the layer for the linework is defined with a linear cost in the Define Layer Surface/Material Subgrade command, then the report will report costs. The Material name for the report also is defined in Define Layer Surface/Material Subgrade.

This command has an option to draw labels next to the linework. The dialog has settings for the label layer, prefix and size.
Material Quantities

The Material Quantities flyout shown here offers many options for quantity reporting including standard and custom report options. User-defined attributes can also be drawn, edited, and identified from the different command options.

Material Quantities draws heavily from the command Define Layer Target/Material/Subgrade found in the Takeoff and SiteNET pull-down menus. Material Quantities are calculated from the entities in the drawing. Several entity properties can be reported including entity count, length, area, and volume. The type of material for each entity is determined by the layer for the entity. Use Define Layer Target/Material/Subgrade, to assign the material types by layer before running the Material Quantities Standard or Custom Report.

Standard Report
Use this command to display all or a selected set of material quantities in present in the drawing. Quantities can be limited by the established boundary polyline(s) or can look outside your boundary area for materials that might be outside of your Cut/Fill limits.

The command will then report out the materials found in the drawing based off of settings made in Define Layer Target/Material/Subgrade. This text report can be edited, printed, or put onto the screen.

Prerequisite: Defined materials
Keyboard Command: materials_report2

Custom Report

Use this command to customize or "user define" the reporting options. This command first prompts whether to report quantities for all the entities in the drawing or selected entities. Then if the drawing contains Areas Of Interest polylines, there is an option report quantities by these areas which adds the area name to the available report.
fields to allow sorting and grouping by area name. The Report Formatter Options dialog box shown here offers a variety of output options. You can choose the fields to report from the Available list and put them in report order under the Used list.

Selecting the Display option shows the report in the standard Carlson Takeoff report viewer. Reports can be exported to an Excel spreadsheet as well.

**Prerequisite:** Defined materials  
**Keyboard Command:** materials_report

### Define Materials Library

Define Materials Library allows you to Add, Remove, Load, Save, and Report a list of material costs. Costs can be set per area, count, volume, ton, or length by using the Edit function at the bottom of the dialog. The left side of the dialog can be used to set categories for different material costs. Material costs can also be Imported from user-specified text files (.txt, .dat, or .csv). Once this library is defined, the items can be used in Define Layer Target/Material/Subgrade and reported out with the Material Quantities standard and custom reports.
Prerequisite: pricing for materials
Keyboard Command: define tk_materials

Edit-Assign Block Materials

This command scans the current drawing to find and report block/symbol names and their count. For example, when the drawing contains different symbols for different types of utilities, this command identifies each type of symbol and the number.

From this command, you can set the Description and Cost of the block by using the Edit button. You can also set the Description and Cost by predefined Materials by using the Set By Library button. When a block name is highlighted from the list, the drawing is zoomed to the location of one of those blocks so that you can see what it looks like. To Report these materials as part of the Standard Report, check on Include Materials Quantities Report in the Edit Materials dialog of the block layer found in the Define Layer Target/Material/Subgrade command. You can also just click on the Report button for a simple report.

Prerequisite: Blocks
Keyboard Command: edit_all_blocks
Define Material Attributes

Use this command to create user-defined attributes that can be assigned to objects in the drawing. Once attributes have been defined, use Input-Edit Material Entities to add the attributes to existing linework or Draw Material Entities to create new linework. For reporting, the material attributes defined in this command will be shown as Available items in the Material Quantities Custom Report command.

![Define Material Entities dialog box]

The Define Attribute dialog box shown here allows the user to "Add", "Edit", or "Remove" attributes and save the definitions for later use. Simply "Load" a saved attribute definition file with the "tkd" extension for future use.
Selecting the Add or Edit options produce the edit attribute dialog box shown here. Use this command to define the Data name and the layer the objects currently reside on and the layer that future objects will be drawn on. Two entity types can be used, polyline data or point data. If the symbol option is selected the user has the option of which symbol will represent the object. Attribute fields must be defined for material reporting.

Selecting the Add or Edit button on the Edit Attribute dialog box brings up the Edit Field dialog box shown here. Use this dialog to define the field name and type. If the Value option is selected, only numeric values will be allowed when prompted. If the String option is selected, the user will have the ability to type in a text message when prompted.

**Prerequisite:** attributes  
**Keyboard Command:** define_tk_data

**Draw Materials Entities**

Use this command to apply attribute data to objects as you draw or digitize them. Select the predefined attribute type to draw from the list available in the Select Attribute to Draw dialog box shown here.
The command line will prompt the user to pick the points of the desired location of the object and allow the attribute data fields to be filled out upon completion or each "enter".

**Prerequisite:** defined attributes  
**Keyboard Command:** draw_tk_data

### Input-Edit Material Attributes

Use this command to assign predefined attribute information to an object already existing in the drawing. The command line prompt will require the user to select the object that attribute information is to be applied, and offer the Input-Edit Attribute dialog box shown here. This dialog box will display all predefined fields for that particular attribute type.

**Prerequisite:** predefined attribute information  
**Keyboard Command:** edit_tk_data

### Identify Materials Entities

Use this command to display all the objects that have attribute data assignments. The user will have the options of selecting the objects by picking them individually or by searching the entire drawing database. The objects that have attribute information assignments will "highlight" on the screen and the command line will display the attribute information.

**Prerequisite:** attributes
Cost Summary Report

This command reports the combined costs from the quantities from the Calculate Total Volumes and Material Quantities routines. For the volume quantities, there are separate costs for the different types of volumes. For the material quantities, the report just has the total material cost. For detail material costs, use the Material Quantities routines.

In the dialog, use the Edit button to set the unit cost and the report name. Use the Move Up and Down functions to change the report order. After picking OK, the report data is shown in the Report Formatter for setting the report style and output method such as Excel.

![Cost Report](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Unit Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Volume</td>
<td>20.00/CY</td>
</tr>
<tr>
<td>Import Volume</td>
<td>100.00/CY</td>
</tr>
<tr>
<td>Cut Volume</td>
<td>20.00/CY</td>
</tr>
<tr>
<td>Other Cut Volume</td>
<td>20.00/CY</td>
</tr>
<tr>
<td>Topsoil Removal</td>
<td>25.00/CY</td>
</tr>
<tr>
<td>Materials</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cost Summary</th>
<th>Cost</th>
<th>Amount</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill Volume</td>
<td>$88,173.85</td>
<td>4,408.7</td>
<td>$20.00/CY</td>
</tr>
<tr>
<td>Import Volume</td>
<td>$103,218.02</td>
<td>1,032.2</td>
<td>$100.00/CY</td>
</tr>
<tr>
<td>Cut Volume</td>
<td>$67,530.25</td>
<td>3,376.5</td>
<td>$20.00/CY</td>
</tr>
<tr>
<td>Other Cut Volume</td>
<td>$141,331.69</td>
<td>7,067.6</td>
<td>$20.00/CY</td>
</tr>
<tr>
<td>Topsoil Removal</td>
<td>$106,023.27</td>
<td>4,241.0</td>
<td>$23.00/CY</td>
</tr>
<tr>
<td>Materials</td>
<td>$70,144.21</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$576,443.29</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Takeoff

Keyboard Command: tk_cost

Prerequisite: Calculate Total Volumes or Material Quantities
Graphic Reports

Make Layout

This command creates a layout with a title block and optionally creates a model view. In the dialog, choose the Printer/Plotter and Paper Size that the program will use to set the print area on the layout.

The Create Model View option makes a viewport on the layout. The Model View X/Y settings are in paper units and define the borders of the model view window. For the model view, the program will automatically size the drawing to fit in the viewport by using the boundary polyline from the Set Boundary Polyline command.

The Block Name sets the title block to use. You can use a custom drawing that has your company logo and title block. The Set Sheet Attributes defines how to fill out any block attributes defined in the block drawing.

The Layer Name is used for the layer of the block and report title label in the layout.

The Report Title is the label to draw in the layout at the position defined under Title Settings.

The Layout Name is the name for the new layout to create.

Pulldown Menu Location: Takeoff > Graphic Reports

Keyboard Command: make_layout

Prerequisite: None

Place Image On Layout

This command inserts an image in the drawing to fit within a view window. The image is cropped to fit the window. This command is a way to handle an image with a different aspect ratio then the window area for a report. The image is sized to fill the whole window area. For example, you can use the screen shot function in the 3D Viewer Window to make an image of your surface model and then use this command to fit this image onto a report.

After selecting the image file, the program prompts to pick the corners of the window for the image in the drawing. Then the dialog shows the image and four white boxes for the corner points for cropping. Click and drag the corner points to move and resize these corner points. When you click in the middle, all the corners move together. When
you click near a corner that corner point can be moved in or out to resize.

The program creates a new image file for the adjusted image. This file is named after the original file name with ".fit" added. The original image file is not changed.

![Fit Image dialog](image.png)

**Prompts**

**Select Image File**
**Pick 1st corner for image:** *pick a point*
**Pick other corner for image:** *pick a point*

**Fit Image dialog**

**Pulldown Menu Location:** Takeoff > Graphic Reports
**Keyboard Command:** image_layout
**Prerequisite:** Image file

**Save Layout Layers**
This command saves the current freeze/thaw status of the layers for the current layout. When the Output Layouts To PDF command generates the PDF for the layout, the saved layout layer settings are used for the PDF output. The Restore Layout Layers command can also be used to reset the freeze/thaw status for the layout.

This command is useful when making a layout using certain layers and then later making new layers in the drawing and you want the layout to use only the original layers.
**Pulldown Menu Location:** Takeoff > Graphic Reports  
**Keyboard Command:** save_layout  
**Prerequisite:** None

---

**Restore Layout Layers**

This command sets the freeze/thaw status of the layers for the current layout using the settings stored by the Save Layout Layers command.

**Pulldown Menu Location:** Takeoff > Graphic Reports  
**Keyboard Command:** restore_layout  
**Prerequisite:** Save Layout Layers
This chapter provides information on using the commands from the Drillhole menu to produce, import and edit drillhole strata settings, place drillholes and report drillholes.
Drillhole Strata Settings

This command selects drillhole symbols, defines strata, and determines how you place drillholes.

**Note:** The order in which the Strata are defined in the Strata Definitions list will be the default order for the strata when you create new drillholes through *Place Drillhole*.

The dialog box below shows the layout of the Drillhole and Strata Settings.

- **Select Symbol:** Select a symbol to represent the drillhole location on the screen.
- **Symbol Name:** This name corresponds to the symbol selected.
- **Symbol Size:** This field can be edited to adjust the symbols size displayed on the screen.
- **Strata Definitions:** This is not directly editable. Select the Strata you are interested by highlighting it, then select the Edit button.
- **Add:** This option adds additional strata to the available Strata name list. See Edit Strata dialog box below.
- **Edit:** Similar to Add, this option is available to make changes to the Strata, including adding a swell factor.
- **Strata Name:** The name of the strata.
- **Density (lbs/ft³):** The Strata Density field is the default density used to calculate strata tons. Density is strata-specific.
- **By Depth:** This option will generate a strata surface by modeling the strata depth values in the drillholes. This strata surface will follow the existing ground surface at the model depth.
• By Strata Elevation: This option will generate a strata model that connects strata irrespective of the upper surface elevation changes.

• Strata Modeling Method: There are three ways to model strata by Inverse Distance to the 2nd power, 3rd power, or by linear least squares.

Inverse Distance (Power 2 and Power 3) Modeling Method
Inverse distance calculates the strata model by assigning weights to the drillholes. The strata model calculated by inverse distance are a weighted average of the drillhole data. Inverse distance will not carry trends and the calculated surface model will never be higher than the highest drillhole elevation. Likewise the calculated strata model will never be lower than the lowest drillhole elevation. The weights are proportional to the inverse of the distance between the point to be estimated and a drillhole. Closer drillholes are weighted more than points farther away. The inverse distance can be calculated to the second or third power which are \((1/d^2)\), and \((1/d^3)\) respectively. Inverse Distance - Power 3 will weigh drillholes less that are further away.

Linear Least Squares Modeling Method
The linear least squares method finds the least squares best fit plane across the surface model. The least squares routine weights each drillhole by inverse distance so that closer points are weighted more than points farther away.
So the best fit plane varies at different points on the surface. The linear least squares method extrapolates trends very well. Least squares will trend and allows for data points that are new highs and lows, that don't appear in the original drillhole data.

- **Remove**: This will remove a strata name from the available strata.
- **Move Up**: This option will move the selected strata name up one place in the strata name list.
- **Move Down**: This option will move the selected strata name down one place in the strata name list.
- **By Strata Elev**: This method will generate a strata surface by modeling the strata elevation values from the drillholes. This strata surface is independent of the existing ground surface.
- **Place Drillhole Prompts**: If Depth is selected, then when you run Place Drillholes you will be prompted for the depth of each strata in your drillhole. If Thickness is selected, you will be prompted for the thickness of each strata. If Dialog is selected, you will go straight into the Place Drillhole dialog when you create a drillhole.
- **Default Last Thickness**: Will set the thickness of your bottom strata to the same amount for all your drillholes.

**Keyboard Command**: tk_chdef

**Prerequisite**: strata information

## Drillhole Import

This command allows you import existing drillhole files. When you select Drillhole Import from the Drillhole menu, a command prompt shows:

"Use separate drillhole and strata files [Yes/No]?" If you have two separate files, one with strata info, and the other file has drillhole locations, select Yes. If you enter Yes, the dialog box below appears.

This command creates drillholes from the data contained in text files. Currently there are many company-specific formats. A Drillhole Data File Formatter that is flexible to handle almost any drillhole text file format is below. The format to use is chosen in the dialog shown here.

![Drillhole Data File Format](image)

The import text can have comma delimited, space delimited or fixed width columns of data. All the data for a record should be on one row. For the fixed width format, choose the Fixed Width toggle and then enter the column numbers separated by spaces in the edit box. For example, “8 15 24 32”.

*Chapter 10. Drillhole Menu* 355
The Custom format can import all the drillhole and strata data from one text file or the drillhole data from one file and the strata data from another file. The method to use is set at the Use separate drillhole and strata files prompt.

Use the following commands to prepare a file format that will match the *.imp imported file.

- **Add**: Moves the selected entry from Available to Used.
- **Add Attribute**: Allows user input attributes into the Used section.
- **Add Skip**: Adds a "Skip" place holder in the Used List
- **Remove**: Moves a selected item from Used to Available list.
- **Move Up**: Moves the selected item up one place in the list.
- **Move Down**: Moves the selected item down one place in the list.
- **Comma Delimited**: Select this if your *.imp file has commas separating each field.
- **Single space delimited**: Select this if your *.imp has a space separating each field.
- **Tab delimited**: Select this if your *.imp file has tabs separating each field.
- **Fixed widths**: Select this if your *.imp has a defined width of space separating each field.
- **Auto Fixed widths**: Select this to automatically determine the fixed widths that separate each field in the *.imp file.
- **Header Lines to Skip**: If your *.imp file has header lines, enter the number of header lines here.
- **Load**: Takes you to select/brows for your *.imp file.
- **Save**: This command will save your imported file as a *.imp file.

The dialog box below details the drillhole import options.

In addition to the previously listed import commands above, this dialog box also has the following prompts:

- **Avoid Duplicate Strata Names**: Select this to prevent have more than one strata with the same name.
• **Strata on one row:** Select this option if all of your strata info is on one row.

**Keyboard Command:** tk_chimport  
**Prerequisite:** drillhole files

### Place Drillhole

This command allows you to screen pick, enter coordinates or, locate by station-offset the placement of a drillhole.

Go to **Drillhole/Strata Settings, Place Drillhole Prompts,** to determine how you would like to be prompted. When you select **Place Drillhole** from the **Drillhole menu,** the command line prompt shows:

"Station/<Pick Drillhole Location>:" Type in x-y coordinates or move your pointer around the screen to pick the placement of the drillhole. To load a centerline file, press S, select the centerline file to reference, then type in the desired Station and Offset amount. If you are in Dialog Mode defined in **Drillhole/Strata Settings,** once a location has been selected, the following dialog box appears:

![Place Drillhole](image)

Place Drillholes generates drillholes in the drawing that are required to run strata surface application routines. Each drillhole consists of a surface elevation, strata, and optional description(s). Every strata has a name, bottom elevation, thickness. Within a drillhole, the strata names must be unique, but each real-world strata should have the same strata name across all the drillholes. This is because strata surface applications connects together the strata with the same name.

The drillhole data can be entered in the dialog shown here, or if Depth or Thickness Mode is selected under **Drillhole/Strata Settings,** then the data can be entered in on the command line when you place each drillhole. Make sure to specify the surface elevation and drillhole description. While in Dialog Mode or to change data, use the Edit and Insert/append buttons to enter strata data. The symbols are defined in DrillHole/Strata Settings and drillhole may be changed in Edit DrillHole. Pick Save when done and a drillhole symbol is drawn.

- **Edit:** Make changes to the highlighted strata name. Thickness, Bottom Elevation, Depth.
When placing drillholes, every strata must be assigned a bottom elevation and a thickness. The bottom elevation is the elevation of the bottom of the strata. There are different methods for entering this information.

- **Insert Above:** To add a Strata above the highlighted strata name.
- **Append to Bottom:** To add a strata to the bottom of the available strata name list.
- **Remove:** Removes a strata from the available Strata Name list.
- **Surface Elevation:** This field can be set by you to establish the surface elevation of the drillhole.
- **Drillhole Name:** The name of the drillhole
- **Description:** Drillhole descriptions are intended for storing of drillhole specific information in the drillhole. One general drillhole description is predefined and user may define any number of specific drillhole descriptions. Typical additional descriptions are DRILLER, DATE, TOWNSHIP, and etc. You will be prompted for values of these descriptions in Place DrillHole.
- **Adjust Bottom Elevations:** Will make adjustments to the bottom elevation based on thickness changes.
- **Adjust Next Thickness:** Will adjust the next thickness to hold the bottom elevation unchanged.
- **Save:** This command saves this drillhole as listed.
- **Zoom In:** This increases the magnification of the black view window, cross-section view of the drillhole.
- **Zoom Out:** This decreases the magnification of the black view window, cross-section view of the drillhole.
- **Cancel:** Ends Drillhole placement routine without making changes.

**Keyboard Command:** tk.chplace

**Prerequisite:** drillhole information

### Edit Drillhole

This command allows you to screen pick an existing drillhole and edit its properties. When you select **Edit Drillhole** from the **Drillhole menu**, a command prompt shows:

"Select Drillhole to edit:" Move your pointer around the screen to pick the drillhole you want to edit. Once a drillhole is picked on the screen, the following dialog box appears:
• **Edit**: Make changes to the highlighted strata name. Thickness, Bottom Elevation, Depth.

• **Insert Above**: To add a Strata above the highlighted strata name.

• **Append to Bottom**: To add a strata to the bottom of the available strata name list.

• **Remove**: Removes a strata from the available Strata Name list.

• **Surface Elevation**: This field can be set by you to establish the surface elevation of the drillhole.

• **Drillhole Name**: The name of the drillhole

• **Description**: The screen display description of the drillhole

• **Adjust Bottom Elevations**: Will make adjustments to the bottom elevation based on thickness changes.

• **Adjust Next Thickness**: Will adjust the next thickness to hold the bottom elevation unchanged.

• **Save**: This command saves this drillhole as listed.

• **Zoom In**: This increases the magnification of the black view window, cross-section view of the drillhole.

• **Zoom Out**: This decreases the magnification of the black view window, cross-section view of the drillhole.

• **Cancel**: Ends Drillhole placement routine without making changes.

**Keyboard Command**: tk.chedit

**Prerequisite**: drillhole information

---

**Label Drillhole**

Label Drillhole can be used to label selected properties from drillholes in the current drawing. The first prompt will ask you to select the drillholes you wish to label. To do this, either window around the drillholes you wish to label or type in "all" enter to select all the drillholes in the drawing. Next, a dialog will appear that gives you control on what is displayed in the Labels.
On the left side of this dialog are the Available label options for the drillholes. You have control what is shown for each strata surface as well as general drillhole information such as the name and coordinates. Use the arrows in the middle of the dialog to move an Available label option into the Used column on the right. When you do this, the below dialog will appear with more options.

In the Edit Text Format dialog, you can control the Layer, Style, Color, Prefix/Suffix, Decimals, Row Position, and Alignment of text. These items when changed become default the next time the dialog is opened. Here is an example of Drillhole Labels.
Strata Polylines

Strata Polylines define strata elevation or thickness along linework instead of a single point like Place Drillhole. Linework defined as Strata Polylines are incorporated with Drillhole Data to create surface models. Note: Strata surface models can not be made exclusively from Strata polylines, some drillholes need to be placed as well.

Tag Strata Polylines

This command allows the user to select polylines that define a Strata. Pick the Strata from the list or type in the name in the Enter Name field. Any Strata you enter in must match a strata defined in Drillhole/Strata Settings in order for the surface to be created.

After selecting a Strata and pressing enter you will be prompted for the type of polyline.
Type of strata polyline [<Elevation>/Thickness]?

Elevation signifies that the Z value for the polyline(s) you are about to select represent the bottom elevation of the previously selected strata. Thickness means that the Z value represents thickness of the strata. Choose one of these options and select the polylines.

Prerequisite: Drillhole/Strata Settings, desired polylines
Keyboard Command: stratatag

Highlight Strata Polylines

This command allows users to identify Strata Polylines by either picking on a polyline(s) or by searching the entire drawing. The command will then dash the polyline in the plan view.

Prerequisite: Tag Strata Polylines
Keyboard Command: highlight_strata_pl

Identify Strata Polylines

This command allows users to identify topsoil polylines by picking on a polyline. The command will then report the Strata name and Type (either Elevation or Thickness).

Prerequisite: Tag Strata Polylines
Keyboard Command: strataid

Untag Strata Polylines

This command allows the user to remove previously tagged Strata Polylines so that they are not included in the strata model.

Prerequisite: Tag Strata Polylines
Keyboard Command: stratauntag

Tag Strata Polylines

This command attaches a strata name to a 3D polyline that represents the bottom elevation, top elevation or the thickness of that strata. When modeling the drillholes, each point in these strata polylines is used as an elevation or a thickness data point for the assigned strata. For example, a 3D polyline for the outcrop of a strata could be tagged with the strata name and used in processing for additional model enhancement. If bed names are used, be sure to include the _TOP, _KEY, _PARTING or _BOTTOM extensions to the bed name.

Prompts

Strata name: Seam1
Type of strata polyline [<Elevation>/Thickness]? press Enter for Elevation
Elevation reference [<Bottom>/Top]? press Enter for Bottom
Select strata bottom elevation polylines.
Select objects: 1 found

Pulldown Menu Location: Drillhole
Keyboard Command: stratatag

**Highlight Strata Polylines**

This command simply highlights the named strata polylines in the drawing. A regen of the screen will unselect the polylines.

**Prompts**

Select the polylines to check.
Select objects: Specify opposite corner: 5 found
Highlighted 3 Strata Polylines. Skipped 2 other polylines.
Pulldown Menu Location: Drillhole in Geology
Keyboard Command: highlight_strata_pl

**Identify Strata Polylines**

This command simply allows you to pick a polyline and report the strata name, if any, attached to this polyline. These are tagged for use in modeling the bottom elevation or thickness in addition to drillholes.

**Prompts**

Select strata polyline to identify:
Strata Name: SEAM2 Type: Thickness
Select strata polyline to identify:
Strata Name: SEAM1 Type: Elevation
Select strata polyline to identify: *pick one that is not tagged*
No strata name assigned to polyline.
Select strata polyline to identify:
Pulldown Menu Location: Drillhole
Keyboard Command: strataid

**Untag Strata Polylines**

This command removes the strata polyline information and returns the selected polylines to the original status: regular polylines.

**Prompts**

Select strata polylines to have strata tags removed.
Select objects: 1 found
Pulldown menu location: Drillhole
Keyboard command: stratauntag
**Drillhole Reports**

This command allows you to generate a report of selected drillholes. When you select *Reports* from the *Drillhole* menu, a sub-menu choice of *Standard Drillhole Report* or *Custom Drillhole Report*, is displayed.

**Standard Drillhole Report**

If this is selected, several prompts are asked at the command line. They are as follows:

**Select objects:**

Add Page break between drillholes [Yes/<No>]?  
Report Strata depth to [Top/<Bottom>]?  
Report Strata elevation of [Top/<Bottom>]?  
The report is then displayed accordingly.

**Custom Drillhole Report**

This function allows you to customize your report format.
Prompts:

Command: tk_chreport2
Select the Drillholes for report.
Select objects: Specify opposite corner: 271 found
262 were filtered out.

Keyboard Command: tk_chreport, tk_chreport2
Prerequisite: drillholes

**Custom Drillhole Report**

This command builds custom reports of the drillholes. The main difference between this command and Standard Drillhole Report is that this command loads all drillhole data into the report formatter. The report formatter allows you to choose which fields to report and their layout. The report data can be exported to Excel, to Access or into a comma-delimited file, or just saved or printed as shown.
Prompts

Select the Drillholes for report.
Select objects: pick the drillholes
Process beds [Yes/<No>]? press Enter for No Process beds will composite the strata by bed name. Otherwise the strata are reported individually.
Separate field names by strata/bed [Yes/<No>]? press Enter for No This option will add the strata name to each
strata data field which allows you to control the report for the strata data separately by strata name. For example, if there were strata named "COAL1" and "COAL2", then you would have field names of "COAL1_THICK" and "COAL2_THICK". Otherwise, there would be only one strata thickness field named "THICK" which would report the thickness for both COAL1 and COAL2.

**Pulldown Menu Location:** Drillhole > Reports

**Keyboard Command:** chreport2

---

### Make Strata Surface

This command generates multiple strata surfaces based on strata definitions and placements of drillholes. Strata surfaces are generated at the bottom of each strata. These strata surfaces can then be used in other TakeOff commands like **Calculate Total Volumes**. They can be viewed on screen, through the command **Draw Strata Surface**.

**Note:** By observing the command line, one can see the status of each strata surface generation.

**Keyboard Command:** tk_chgrid

**Prerequisite:** Define Drillhole/Strata Settings, Place Drillhole

---

### Clear Strata Surface

This command clears the strata surfaces previously generated with **Make Strata Surface**. This removes the strata surfaces from processing in other takeoff commands.

**Note:** This command will not remove the surface from the screen view. You must use the command **Erase Strata Surface** to remove them from view.

**Keyboard Command:** tk_chclear

**Prerequisite:** Make Strata Surface

---

### Draw Strata Cut Depth Contours

This command will draw the **Strata Cut Depth Contours**. This command creates contours for the cut depth between the design surface and strata.

You must have created Strata Surfaces through the **Make Strata Surface** command.

Then select **Draw Strata Cut Depth Contours** from the **Drillhole menu**. You will be prompted to select the Strata from the dialog box below.
You can assign a contour interval and contour layer for the contours to be drawn. If Use Inclusion/Exclusion Perimeters is checked on you will be prompted for an Inclusion polyline and an Exclusion polyline if needed, otherwise the drawing's Boundary linework will be used.

**Keyboard Command:** tk_chdepth  
**Prerequisite:** Make Strata Surface

### Erase Strata Cut Depth Contours

This command will erase the Strata Cut Depth Contours from the screen display.

**Keyboard Command:** tk_chdepth2  
**Prerequisite:** Strata Cut Depth Contours

### Draw Strata Cut Color Map

This command will generate a map of areas where the design surface cuts into the selected strata.

Prompts

Select point for color legend: - Use your pointing device to select the top left corner of where you want the cut color legend to be displayed.

Legend size <10.0>: Screen display size.  
Label all zones or summary [All/<Summary>]? This pertains to the number of elevation labels on the legend.

**Keyboard Command:** tk_chmap  
**Prerequisite:** Make Strata Surface

### Erase Strata Cut Color Map

This command will erase all Strata Cut Color information from the screen display.

**Keyboard Command:** tk_chmap2  
**Prerequisite:** Draw Strata Cut Color Map

### Draw Strata Surface

This command will display the selected strata surfaces as 3D faces. The bottom elevation of the strata is drawn.
A color can be selected to distinguish each strata.

**Keyboard Command:** tk.chplot

**Prerequisite:** Make Strata Surface

### Erase Strata Surface

This command will erase all strata surface 3D faces from the screen display.

**Keyboard Command:** tk.chplot2

**Prerequisite:** Draw Strata Surface
# Trench Menu

The Trench menu commands layout trench networks and calculate trench quantities.

<table>
<thead>
<tr>
<th>Trench</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Trench Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spreadsheet Trench Editor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export Trench Network Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trench Network File Backup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plan View Label Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Trench Network (Plan View)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Trench Network (Profile)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Trench Network (Centerline)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input-Edit Trench Template</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Typical Trench Template</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define Pipe Groups</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trench Subgrade Areas</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trench Network Quantities</td>
<td>Report Trench Network</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trench</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Trench Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spreadsheet Trench Editor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remove Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Trench Network Structure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export Trench Network Data</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trench Network File Backup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plan View Label Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Trench Network (Plan View)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Trench Network (Profile)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Trench Network (Centerline)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input-Edit Trench Template</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Typical Trench Template</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define Pipe Groups</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trench Subgrade Areas</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trench Network Quantities</td>
<td>Report Trench Network</td>
<td></td>
</tr>
</tbody>
</table>
Input Trench From Polyline

This command allows you to input a trench sewer network structure from polylines or points. It first prompts you the Input Trench Line Dialog where you specify the Trench Type, Trench System, and the System Name. The Fixed Depth method automatically assigned the trench elevations at a specified depth from the surface. The Individual Profile option lets you input one trench reach at a time and save its information to a profile (.pro). The Connected Network option lets you input all the trench polylines on the drawing, merge them into a trench network structure and save the whole structure to a .sew file. For trenching or utilities without Invert-Ins, uncheck Prompt For Invert-In Elevation. If you want to set the Rim Elevation to any surface elevations, check on Default Rim Elev to Surface Elev and then use the Surface Button to select the desired .tin or .flt surface file. Prompt For Pipe Wall Thickness allows you to enter in the pipe thickness that will be used in calculating backfill quantities in two prompts: 1) the interior pipe size and, 2) the thickness of the pipe wall. If this is check off, the value in Pipe Wall Thickness will be automatically added to the Pipe Size for backfill volumes. You can also enter in a Structure Width to be considered in the Cut volumes. Pipe Shape determines the prompting so that you can create Circular, Elliptical, or Rectangular pipe. Click OK to start inputting trench structures.

There are two different types of Input Methods in this command: Polyline or Points. Points allows you to pick freely the location of each sewer structure. With the polyline method, Takeoff extracts the coordinates of all the vertices of the polyline to determine the location of the structures. With both methods you are prompted for the starting station number. Takeoff computes the station values based on the starting station number. Next, you are prompted to enter the Manhole ID (Sewer Trench) or Station ID (Pipe Trench), Invert Elevation, Manhole Elevation (Sewer Trench), and Pipe Size or Pipe Group for every station. You can either enter the values manually or select the texts that represent these values on the drawing. When you finish inputting a polyline, the command would ask you for a profile name to store the profile data if you are doing Individual Profile; otherwise the command would ask you to pick next polyline that is in the same trench network.

Prompts:

Pick a polyline that represents a trench reach: pick a polyline on your drawing
Starting Station of trench reach <0.0>: press Enter to accept 0.0 as the starting station or enter a value
For station 0.00 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
For station 270.22 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
Undo/Select/Group/<Enter Pipe Size <0.0000>>: select the pipe size text on the drawing or enter Enter on the keyboard to enter the pipe size value manually or select Group to enter in a Pipe Group
For station 425.02 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
Undo/Select/Group/<Enter Pipe Size <0.0000>>: select the pipe size text on the drawing or enter Enter on the keyboard to enter the pipe size value manually or select Group to enter in a Pipe Group
For station 649.73 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
Undo/Select/Group/<Enter Pipe Size <0.0000>>: select the pipe size text on the drawing or enter Enter on the keyboard to enter the pipe size value manually or select Group to enter in a Pipe Group
Another Polyline [<Yes>/No]? enter Yes to input another trench reach from a polyline or enter No to finish

At the end of the command, a file opening dialog would be prompted to you to specify a .sew file name to store the trench network structure.

Prerequisite: A drawing with one or more polylines that represent the trench structure.
Keyboard Command: pline_trench

Create Trench Network Structure

This command allows you to create or modify a trench network structure on a drawing. Before you are able to locate the trench structure, the drawing has to be open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. You can locate the trench structure by one of three methods: picking points on the drawing, entering the point number, or specifying the station and offset of a centerline. If you use centerline method, you need to specify a centerline file. After you locate a point on the drawing, you are prompted the Sewer Structure Data Dialog for entering the sewer structure information, such as Structure Name, System Name, Symbol Name, and Elevations. Take a look at the
list of the trench points that have been defined. If there is any point that is connected upstream to the current point, you add it to the Upstream Connections list. The Invert Elevation and the Pipe Size fields will be filled with the information of the upstream point. Use Pipe Group allows you to set multiple pipes for the trench run by using a existing or new Pipe Group. Click OK to finish entering the trench structure data. The command will repeatedly ask you to pick a structure point until you hit Enter to finish. The trench network structure data is saved in a .sew file.

Prompts

By Pick:

Locate by pick point, point number or station-offset [<Pick>/Number/CL]? press Enter to do Pick point

Loading edges...
Loaded 4 points and 5 edges
Created 2 triangles

Pick structure location: pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): press Enter to finish

By station-offset of CL:
Locate by pick point, point number or station-offset [<Pick>/Number/CL]? CL (enter CL to do locating trench structure by station-offset of a centerline)
Specify a centerline file.

Loading edges...
Loaded 4 points and 5 edges
Created 2 triangles

**Structure Station**: 0 (enter the station number on the centerline)
**Structure Offset**: 200 (enter the offset from the centerline)
**Sewer Structure Data Dialog**: enter trench structure information
**Structure Station (Enter to end)**: 100 (enter the station number on the centerline)
**Structure Offset**: 200 (enter the offset from the centerline)
**Sewer Structure Data Dialog**: enter trench structure information
**Structure Station (Enter to end)**: press Enter to finish

**Prerequisite**: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface.
**Keyboard Command**: locate_trench

---

**Edit Trench Network Structure**

This command edits the existing trench structure data on the drawing. There has to be a trench network structure that has been created beforehand and its data is store in a .sew file whose name is as same as the drawing name. The command first prompts you to pick a sewer structure on the drawing. If there is no such structure in the .sew file, you would get an error message like this: "Error: unable to locate structure in file C:\temp\takeoff\SANI1x.sew, otherwise this command will restore the trench structure data from the corresponding .sew file and display it on the Sewer Structure Data Dialog for editing. Click OK to confirm your modification. You are prompted to edit another structure point until you press Enter to finish. All modifications are saved in the .sew file.

Set Location will return you to the plain view and prompt you for a new location for the structure by either typing in the coordinates or picking on the screen. In the dialog you can change the Structure Name, Symbol, Width, Depth, and Type. Setting a Structure Template will allow you to set the dimensions of the Structure with a .tch file. See Input-Edit Trench Template for details on creating a .tch file. Here you can also manage how the Structure is connect to other Structures. Under Upstream Connections you will see the Structure(s) currently connected to upstream and a list of available Structures on the right. Pick Add to connect to a Structure you have selected under Available, and Remove to disconnect to any selected Structures. Other options are to edit the Rim Elevation, Invert In and Out, as well as Pipe information between your Structure and the highlighted Upstream Connection. Use Pipe Group allows you to set multiple pipes for the trench run by using an existing or new Pipe Group. Min Cover shows you the depth between the Design Surface and top of pipe. Set Min Cover will adjust your Invert In and Out elevations so that you have at least the value you enter as the Min Cover.

**Prerequisite**: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.
**Keyboard Command**: edit_trench
Spreadsheet Trench Editor

This command allows you to view and edit existing trench network data in spreadsheet form. Upon running the command, the program will open the .sew file associated with the drawing, or if one has not been established, you will be prompted to select one.

The Trench Spreadsheet Editor allows you to select the Pipe Line you want to edit, or view all the Pipe Lines at once by checking on "Select All Pipe Lines". After selecting a Pipe Line, each segment of the Pipe Line will be displayed as: the downstream connection (Down Junct), upstream connection (Up Junct), the invert in of the downstream manhole (Down Invert), the invert out of the upstream manhole (Up Invert), and the Slope, Length and Pipe Size between the two. Any value between two manholes can be edited except for the Length. Spreadsheet Settings allows you to choose what elements of a segment are displayed.

Click OK to confirm your modification. All modifications are saved in the .sew file.

**Prerequisite:** Sewer Network File

**Keyboard Command:** edit_trench2

Remove Trench Network Structure

This command removes the existing trench structure data. There has to be a trench network structure that has been created beforehand and its data is store in a .sew file whose name is as same as the drawing name. The command first prompts you to pick a sewer structure on the drawing or to select from a List of your Sewer Structures. If there is no such structure in the file, you will get an error message like this: "Error: unable to locate structure in file C:\temp\takeoff\SANI1x.sew, otherwise this command removes the structure from both the drawing and the .sew file immediately. You are prompted to remove another structure point until you press Enter to finish. The removed trench structure points would no longer be found in the .sew file.

**Prompts**

Select structures to erase by screen pick or name list [Pick>/List]? Pick to choose from the screen, or List to choose from the below dialog.
Prerequisite: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.

Keyboard Command: remove_trench

Find Trench Network Structure

This command will center the screen and draw an arrow to the structure you specify.

Prerequisite: a Trench Network

Keyboard Command: findswr

Import Trench Network Data - Sewer Network

This command imports a sewer network file (.sew) into the current trench network model.

Pulldown Menu Location: Trench

Keyboard Command: import_swrenet

Prerequisite: .sew file

Import Trench Network Data - Utility Network

This command imports a utility network file (.util) into the current trench network model.

Pulldown Menu Location: Trench

Keyboard Command: import_utilnet

Prerequisite: .util file

Export Trench Network Data

Export to Points
This command will add points at your trench structures and add them into your coordinate file by either the Rim Elevation or the Invert-Out.

Export to Profiles

This command will create a profile file (.pro) of your trench either going Upstream or Downstream. The (.pro) file can then be drawn under Roads->Draw Profile.

Prerequisite: a Trench Network  
Keyboard Command: swr2pts, swr2pro

Trench Network File Backup

Save Trench Network File saves your trench network as a (.sew) file. Load Trench Network File loads a previously saved (.sew) file.

Prerequisite: none  
Keyboard Command: save_trench, load_trench

Plain View Label Settings

This command allows you to set the labeling for your structures and piping. The below dialog box gives you the option to display the Structure Name, the Rim Elevation, the Invert-In, and Invert-Out. In addition, you can set the Prefixes, Suffixes and labeling location as you so desire. The Use Structure Data Table will create linework around each Structure's labeling.
This below dialog box gives you the option to display the Length, Size, Material, and Slope for you Piping. In addition, you can set the Prefixes, Suffixes and labeling location as you so desire. To specify to which structure the label is meant for, select Arrow On Pipe, Parallel Leader, or None. You can also set the type of linework to draw.

In this dialog you can set the properties for your Symbol and Linework as well as the decimal places to report.
Prerequisite: a trench network
Keyboard Command: swrsetup

Draw Trench Network - Plan

This command draws trench network structures, pipes, and labels on the screen, based on the Plan View Label Settings command and the trench network structure data in the .sew file whose name is as same as the drawing name. Pipe linework will automatically be displayed as 3D faces in the command 3D Viewer Window. If Takeoff can't find a .sew file in the same directory where the drawing is located, nothing would be drawn on the screen.

Prerequisite: A open drawing
Keyboard Command: plan_trench

Draw Trench Network - Profile

This command allows you to draw a branch of the trench network structure as a sewer/pipe profile. There has to be a trench network structure that has been created beforehand and its data is store in a .sew file whose name is as same as the drawing name, otherwise you would get an error message like "Error: no data in sewer network file". The command first prompts you the Draw Sewer Network Dialog. Select the Upstream and Downstream Struct that you want to draw. If you want to draw the existing and final design surface, as well as Strata Surfaces, toggle on Draw Existing Ground Surface, Draw Final Design Surface, and Draw Strata Surfaces options. If your profile is from upstream to downstream, then select the Profile Direction as Downstream, otherwise Upstream. You can also choose to save the profile data to a profile file. Click OK to draw.
**Initializing Draw Profile command ...**

**Draw Sewer Profile Dialog** Enter drawing parameters such as Grid scale, text scaler, starting and ending stations etc. for drawing the sewer profile.

Enter general sewer profile settings such as elevations (Rim, Invert-In, Invert-Out) to draw and label.
Use the Manhole tab to define what manhole information is labeled in your trench profile.

Use the Pipe tab to define what piping information is labeled in your trench profile.
The command will find the elevation range of your profile and display it at the top of this dialog. Here you can set the elevation top and bottom of the profile's grid.

**Prerequisite:** Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.

**Keyboard Command:** profile_trench

---

**Draw Trench Network Centerline**

This command allows you to draw a branch of the trench network structure as a centerline. There has to be a trench network structure that has been created beforehand and its data is store in a .sew file whose name is as same as the drawing name, otherwise you would get an error message like "Error: no data in sewer network file". The command first prompts you the **Draw Sewer Network Centerline Dialog.** Select the Upstream and Downstream Structure for the centerline you are about to create. The Centerline Direction determines from which structure the polyline is drawn. You can also choose to save the centerline data to a .cl file with the option of entering in the Beginning Station. In this dialog is the ability to set the Layer name as well. Click OK to draw.
Prerequisite: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.

Keyboard Command: drwswrcl

Input-Edit Trench Template

This command lets you create a new trench template or modify an existing trench template. It prompts you the Input-Edit Trench Template Dialog. If you are modifying a trench template, click the Load button on the dialog to open a trench template file and display the template data on the dialog. Enter the dimensions of the trench: bottom offset, trench width and vertical side height. The Edit Trench Benches button will bring up the below dialog, and allows you to enter in up to four benches into your trench.

There are three methods for entering the cut slope, Percent, Ratio and Degree. Choose one of the methods and enter the slope value. Display Sewer Structure allows you to see your pipe or manhole as part of the trench. This is for display purposes only, calculations will be drawn from the pipe size you set in the Trench Network Structure commands. Add Pipe Diameter To Trench Width will increase the size of your trench by the diameter of your different pipe sizes. The Add Pipe Diameter To Backfill Thickness will increase the thickness of backfill material either by half the pipe diameter or the full pipe diameter. For example, when set to Half #1, the backfill thickness
for #1 material is increased by half the pipe diameter.

If there is a Top Backfill, enter the Material Name, Thickness and if needed Shrink Factor. The thickness of the Top Backfill is assessed from the top of the trench down. There are three trench Bottom Backfill layers that can be defined. Enter the layer label in the material name field, the depth of the layer in the thickness field. The thickness of these values are assessed from the bottom of the trench up. The Middle Backfill Material is any volume between the Top and Bottom Backfills and can fluctuate depending on the depth of the trench. No set thickness can be applied to the Middle Backfill. Click Save or SaveAs to save the template information in a .tch file, and Click Exit to quit this command.

Prompts:

**Input-Edit Trench Template Dialog**
Enter the dimensions of the trench template, save the information to a template file (.tch).

**Pulldown Menu Location:** Trench
**Prerequisite:** None
**Keyboard Command:** make_trench_tpl

**Draw Typical Trench Template**

This command draws a trench template on the screen. After you select a trench template file (.tch) to draw, a **Typical Trench Template Dialog** is prompted for entering the layer name, drawing scale, text size scaler and selecting how many decimal points you want. You can also hatch the backfill on the drawing. Click OK to draw the template at the position that you pick on the screen.
Prompts

Pick position to draw template: pick a position on the screen

Prerequisite: None.
Keyboard Command: draw_trench_tpl

Define Pipe Groups

Pipe Groups allow users to define multiple pipes inside a single trench. Pipe Groups can be applied to a Trench Run during the creation of a Trench Network or after the fact with Edit Trench Structure. In the Define Pipe Groups dialog you can Add, Remove, Edit, or Report different Pipe Groups.

Click Add and a blank Pipe Group dialog will appear. Here you can enter in a Name for the Group and Add different types of pipes into the Group. Clicking Edit or Add in the Point Group dialog will bring up the Edit Pipe dialog. Here you can specify the Pipe Shape, Bottom Offset (from the bottom of the Trench), the Size, Width (when needed), and the Wall Thickness of the pipe.
Report in the Define Pipe Groups dialog will bring up the below dialog:
From this dialog you can pick on what you want to report and view it or export it into Excel.

Prerequisite: none
Keyboard Command: define_pipe_grp

Trench Subgrade Areas

The purposes of Trench Subgrades is to assign a different type of trench template when a trench passes under a road, building pad, etc.

Set Trench Subgrade Polylines

Choose a closed polyline that defines the area that you want a different trench template for, ie a building pad polyline.

Prerequisite: None.
Keyboard Command: tag_trench_subgrade

Clear Trench Subgrade Polylines

This command untags selected polylines for trench subgrade use.

Prerequisite: Trench Subgrade Polylines
Keyboard Command: untag_trench_subgrade

Hatch Trench Subgrade Area

This command hatches trench subgrades for easy viewing.
Prerequisite: Trench Subgrade Polylines
Keyboard Command: hatch_trench_subgrade

Erase Trench Subgrade Hatch

This removes previous made trench hatching.

Prerequisite: Trench Subgrade Hatching
Keyboard Command: erase_trench_subgrade

Trench Network Quantities

This command calculates the trench volumes. There has to be a trench network structure that has been created beforehand and its data is store in a .sew file whose name is as same as the drawing name, otherwise you would get an error message like "Error: no data in sewer network file".

The command loads the trench network data and splits them into individual trench lines and displays them on the Calculate Trench Quantities Dialog. You can choose to calculate the trench volume of one trench line or several trench lines at a time. You need to set a Main Template in order to calculate volumes. To create a template, run Trench> Input-Edit Trench Template. The trench cut volume is multiplied by the Cut Swell Factor. Surface Target determines the Surface that the bottom of the trench is compared to, either: the Existing Surface, the Design, the Existing and Design to minimize cut, or simply to the Rim Elevations (no surface required). Trench Depths can be reported by either the bottom of the trench or bottom of the pipe by using the Depth Target pull-down. If you have Strata Surfaces defined then the program can calculate cut volumes for a strata you select. For more comprehensive reports you can customize, click on the Structure, Trench, and Depth Details Reports buttons. For the Standard Report, click the OK button.

Setup Depth Zones will breakout your trench cut volumes according to user-defined "depth zones" of the trench. You can also color the trench in the drawing by these defined zones. The Width value is used with the Draw Plan
View Zone Map for the width of the trench lines. The Manhole Cost is for reporting the structure cost by zone depth. The Linear Cost is for reporting the linear cost for the trench lines by zone depth.

<table>
<thead>
<tr>
<th>Zone</th>
<th>Depth Range</th>
<th>Plan View</th>
<th>Manhole Width</th>
<th>Manhole Cost</th>
<th>Linear Width</th>
<th>Linear Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone 1</td>
<td>0.00-5.00</td>
<td>0.50</td>
<td>100</td>
<td>26</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 2</td>
<td>5.00-6.00</td>
<td>0.50</td>
<td>150</td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 3</td>
<td>8.00-12.00</td>
<td>0.50</td>
<td>200</td>
<td>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 4</td>
<td>12.00-16.00</td>
<td>0.60</td>
<td>250</td>
<td>100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 5</td>
<td>&gt;16.00</td>
<td>0.50</td>
<td>300</td>
<td>125</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 6</td>
<td></td>
<td>0.50</td>
<td>100</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 7</td>
<td></td>
<td>0.50</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 8</td>
<td></td>
<td>0.50</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 9</td>
<td></td>
<td>0.50</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zone 10</td>
<td></td>
<td>0.50</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Create Trench TIN Surface will create a triangulation surface of the trench. Under the Setup dialog, the Write Triangulation File option will have the program prompt for a TIN file to create for the trench surface. The Draw Triangulation Faces option creates 3D faces in the drawing on the Layer Name from this dialog. Use "View > 3D Viewer Window" to display the new 3D faces in 3D. Note: Pipes are automatically displayed in 3D from the linework created in "Draw Trench Network (Plan View)". To turn 3D pipes off in the viewer, freeze the layer created with "Draw Trench Network (Plan View)". By default this layer is "SWRNET".
Click OK to compute the template volumes. Backfill quantities take into account pipe size. A report would be shown after the calculation and any depth zone linework and 3D faces will be drawn in the plan view.

Prompts

Trench Quantities Report Window

Draw zone map color legend on the screen [Yes/<No>]: y for Yes

Pick a point for color legend: pick a point away from site

Legend size <10.00>: Press <Enter> for the default

Pulldown Menu Location: Trench

Prerequisite: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.
**Keyboard Command:** calc_trench

**Trench Quantities By Profiles**

This command calculates trench quantities using two profiles that define the ground surface and the pipeline. See the Pipe Depth Summary command in the Profiles chapter for more information.

**Pulldown Menu Location:** Trench

**Prerequisite:** Two profiles

**Report Trench Network**

This command will a report the Name, Station Distance, Invert-In Slope, Invert-Out Width, the Rim Elevation, Trench Type, Manhole Depth, and the Area Direction for the selected Trench. You may also choose to report the Trench Network from Downstream or Upstream, or just the Structures.
Prerequisite: a sewer line

Keyboard Command: reportswr
Roads Menu
**Input-Edit Centerline File**

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to Design Centerline and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc). For creating a new centerline, it is ideal for entering data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.

**Drag Action (Zoom and Pan):** In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

**Zoom Drawing To Current Segment:** This option zooms the drawing graphics to center on the centerline segment currently highlighted in the dialog.

**Hold Other PI Points When Change Starting Point:** With this option active, all the existing PI's are held when the starting coordinate is moved. Otherwise, all the PI's are moved by the same amount that the starting point is moved.

**Show Right of Way:** This option shows any ROW's defined in the centerline in the graphic preview window.

**Type of Curves:** This setting chooses between roadway and railroad definitions for curve lengths.

**Add:** Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.

**Edit:** Allows you to edit the highlighted segment.

**Remove:** Removes the highlighted element from the centerline.

**Up/Down:** Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45d NE, moving the last element.
up would create a line at 45° after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45°.

**Load:** Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

**Screen Pick:** Allows user to pick a CL off the screen in the drawing to load into the editor.

**Tools > Reverse:** Reverses direction of Centerline.

**Tools > Rotate:** Rotates the centerline by the specified rotation angle and around the specified pivot point.

**Tools > Scale:** Scales the centerline which can be used for changing units between metric and English.

**Draw:** This button draws the centerline in the drawing on the specified layer.

**Save:** Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

**SaveAs:** Prompts you for a file name for the saved file.

**Fit Curve:** Fits a circular curve element into the centerline after the line element that is currently selected. When all the elements are lines, the program allows you to fit curve for all PIs. The program checks if the radius fits all PIs and will prompt the maximum radius that works for all PIs if the current radius is too big. The Horizontal Speed Tables allows you to pick a speed and a super elevation rate to the minimum radius.
**Fit Spiral**: Fits a spiral curve element into the centerline after the line element that is currently selected.

**Point Numbers**: This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

**Station Equations**: At any number of locations on a centerline, you can set the back station and forward station for the re-stationing of the centerline. The station equation dialog appears below:
If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range is repeated.

**ROW:** This function edits the right-of-way definitions associated with the centerline. There can be multiple ROW's assigned to the centerline for left and right sides as well as multiple on the same side. The function first shows a list of ROW's for the centerline where you can add, edit or delete.

When you add or edit a ROW, there is a second dialog for entering the stations and offsets that define the ROW relative to the centerline. Use negative offsets for left and positive for right.

Alternatively, the **Enter Right of Way** and **Polyline to Right of Way** commands are other ways to define the ROW's for a centerline.

**Exit:** Exits this routine, prompting to save changes if necessary.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the
element. It then allows the user to modify or define the parameters specific to the type of element. The following are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and spirals.

- Wherever length of the element is to be entered, entering an expression of the type 123.5 - 93.7 would evaluate the difference of the values. This is particularly convenient where only the stations of the start and end points of the element are known.
- When the station is specified, the program takes the length of the element as the difference between the station of the start point of the element and the station specified.
- All bearings should be specified by entering the angle between 0 and 90 degrees (in dd.mmss format) and selecting the quadrant.
- When entering the delta angle of a curve, only the absolute value (between 0 and 360 degrees) is to be entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered in (dd.mmss) format.
- Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length. The other parameters of the curve that can be edited are the bearing of tangent-out and the “Station to”, which also defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point (PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right). The Spiral Definition setting chooses between Arc definition for clothoid spirals and Chord for 10-chord spirals.

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can
be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated.

The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results. You can spiral from tangent to curve, curve to tangent and curve of one radius to curve of another radius. You can also spiral from one endpoint to another endpoint. To define the spiral by sweep angle, use the Delta Angle field. To define the spiral by length, use the Spiral Length field. To define the spiral by end point, fill in the min and max radius fields and then enter either the End Point Pnt# or coordinates and the program will calculate the radius and spiral length to fit that point.

Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only):
Line (Tangent) Segment: We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.
**Spiral Segment:** Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, and (3) the tangent-out bearing. Everything else will calculate when you press Enter for the PI station.

**Curve Segment:** Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

**Final Line Segment:** All you need to enter in the final dialog for the line (tangent) segment is its length. All other items will calculate when you press Enter.
The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
Polyline to Centerline File

This command writes a centerline (.CL) file from a polyline in the direction the polyline was drawn. The Northing and Easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve. After selecting the polyline, the program shows the direction by drawing temporary arrows along the polyline. To reverse the direction of the polyline, there is a keyword option R for Reverse at the Command line. Also, the Reverse Polyline command can be used to switch the direction of a polyline.

For stationing the centerline, there is a Command line prompt for entering the station at the beginning of the polyline and then using the polyline segment lengths for the rest of the centerline stations. Alternatively, there is a keyword option E for Ending to specify the station at the end of the polyline and then back calculating the centerline stations to the beginning using the polyline lengths.

In addition to being used as roadway/corridor "baselines," a .CL file can also be used as the horizontal control for a Template Point Centerline.

Note: To convert lines and/or arcs into a polyline, use the Entities to Polylines command or the Join Nearest command.

Prompts

Centerline file to Write dialog Enter the .CL file name to create
Centerline station [Reverse/Ending/<Beginning: 0+00>]: Press Enter to accept the default station value specified or Type in the beginning station then press Enter
Select polyline that represents centerline: Pick the polyline that represents your centerline

Draw Centerline File

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an option to specify whether to draw PI lines and specify their length. The Label Centerline option draws station labels using a .STA settings file.
created by the Save Settings function in the Station Polyline/Centerline command.

Next you are prompted for the file name of the centerline to plot.

The .CL file can be made with the following commands on the Design menu: *Polyline to CL File*, *Input-Edit Centerline* or *Design Centerline*. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

**Prompts**

**Draw Centerline Options dialog**

**Centerline File to Draw file selection dialog** Select the .CL file name to read and plot.

**Pulldown Menu Location:** Centerline

**Keyboard Command:** cl2pline

**Prerequisite:** a centerline file

**Centerline Report**

This command reads a centerline file and creates a report in the standard report viewer which can be written to a file, a printer, or to your drawing. If the centerline file contains point numbers, then the report will include these point numbers. If station equations are found, they are noted at the top of the report. The options dialog has settings for the report format and type of the centerline. The Use Profile for Elevations Report option will prompt you for a profile (.pro) file to add elevations to the report. The Report At Interval option will report stations, northing and easting at the specified station interval. The Use Report Formatter option lets you choose the report format and has output options for Excel. Also, the Report Formatter enables an expanded report with options for Report 2nd Centerline and Include Geodetic Report. The Report 2nd Centerline uses the second centerline for reporting offsets. The Geodetic Report adds geodetic distances and bearings to the report. It requires the grid projection to be defined in Drawing Setup.
Here is an example report:

Centerline Report  
Centerline File:  C:\sample\setback_3.cl

Station Northing Easting Bearing Distance
0+00.000  4033.165  4379.271  
N 13°07'20'' W 92.076'
0+92.076  4122.836  4358.367  PC
Radius:  4196.621  4674.880  Radius Length:  325.000'
PI:  4159.044  4349.926  1+29.254  Tangent:  37.178'
Arc Len:  74.035'  Delta:  13°03'07''  Right Degree:  17°37'46''
Chord Len:  73.875'  Chord Brg:  N 06°35'47'' W
Radial-In:  N 76°52'40'' E  Radial-Out:  N 89°55'47'' E
Tangential-In Tangential-Out
1+66.110  4196.222  4349.881  PT

Pulldown Menu Location:  Centerline
Keyboard Command:  clreport
Prerequisite:  A centerline (.CL) file

**Centerline conversion**

**Import Centerline**

This command converts Terramod, Geodimeter, GeoPak, Sokkia/Leitz, Softdesk, and Leica road files into Carlson TakeOff centerline (.CL) files.

Prerequisite:  a Terramod, Geodimeter, GeoPak, Sokkia/Leitz, Softdesk, or Leica road file

**Import TDS RD5 File**

This command converts a TDS RD5 road file into TakeOff centerline (.CL) and profile (.PRO) files.

Prerequisite:  a TDS RD5 file
Station Polyline/Centerline

This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made in the geometry.

**Distance for Stations** is the primary interval for stationing. On Curve allows for a different interval for curve segments versus line segments.

**Distance for Intermediate Stations** is the intermediate interval for stationing. On Curve allows for a different interval for curve segments versus line segments.

**Beginning Station** is the beginning station of the centerline for stationing.

**Locate Even Stations** labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).

**Locate Odd Stations** labels the non-interval stations at the polyline/centerline end points and PC and PT points.

**Locate User-Entered** prompts you for individual stations to label.

**Locate Start/End Stations** labels the Start and End Station as specified when the option Specify Start/End Stations is enabled.

Without the **Increment Station Labels from Beginning Station** option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program
will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

**Label Deflection Angles** adds deflection angles to centerlines without arcs. Settings for this are specified in the **Label Deflections Setup**, accessed by the Deflections Setup button.

![Label Deflections Setup](image)

**Include Station** sets the station name as None, Prefix or Suffix to the deflection angle. **Station Prefix** and Suffix are added to the Station Label. **Use MText** option will create the deflection angle and associated text as Mtext. **Fields on separate rows** will place each line of text on a separate layer. **Label North/East** option adds a Northing and Easting coordinate to the PI location. **Use Symbol for Delta Angle Label** adds a triangular shaped symbol as a prefix to the deflection angle. **Deflection Label Position** controls the position of the label as Perpendicular, Horizontal or Parallel.

When **Specify Start/End Stations** is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When **Erase Previous Station Labels** is checked, previous station labels are erased when new ones are generated.

The **PC/Spiral Setup PC** button accesses the **PC/Spiral Setup** dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the centerline as well as for the spiral special stations (TS, SC, CS, ST).
Label on Radial Lines controls whether to draw a perpendicular line and label the station.
Label On Centerline when checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.
Draw PC Symbols controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the symbol box.
Label PC Radius controls whether this point is labeled.
Max PC Length controls the maximum length for the PC lines to be drawn described above.
Position controls the placement of the PC and PT labels as either the midpoint of the PC line or at a user defined offset from the centerline.
Prefix/Suffix: Each special station has a prefix/suffix string that can be added to the station label.
Curve Table Settings controls which elements will be labeled or placed in a data table for both arcs and spirals as shown in the Curve Table Setup dialog box.
Draw Arc Table when enabled, creates and draws a table containing the arc information selected. Delta Angle, Radius, Length and Total Tangent.

When Label PI Stations is checked, the PI station is labeled at the PI point.

When Locate PI Points is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When Label Station Text is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the Label Setup button will become available for selection.

The Label Setup controls the placement, precision, font and size of station labels along the centerline.

Text Layer is the user-specified layer for text labels to be drawn on.

Text Style is the user-specified text style for labels.

Text Size Scaler determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.

Text Offset Scaler works like text size scaler above controlling the distance the text labels will be offset from the centerline.

Station + at Tick Mark labels the station text along the polyline with the ‘+’ of the station text at the station’s location on the polyline. See Marker Set up for marker size manipulation settings.

Horizontal Offset shifts the station label along the centerline.

Use MText controls whether to create the labels as MText or regular Text entities.

Draw on Real Z Axis creates the labels and tick marks at elevation when using a 3D Polyline for the centerline.

Label Intermediate Stations: If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.

If the Flip Text For Twist Screen setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.

Station Units when set to Miles divides the station values by 5280 for creating the station labels. When set to
Kilometers, it divides the station values by 1000 for the labels.

Station Prefix adds to the front of the station labels.

Remove Zeros removes the specified number of least significant digits from the station label if these digits are all zero.

Label Northing/Easting of Starting Point adds this label information, including prefixes and/or suffixes as specified.

Decimals determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.

Use Label Stations to specify whether to label the stations perpendicular or parallel to the centerline.

Specify the Position of the station labels, either above or below the centerline. This is only available when labeling stations using the parallel option is enabled.

Align determines the alignment of the station label, either left or centerline, centered along the centerline or to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The Marker Setup options control the size of markers for different station types as well as the layer the markers will be drawn on.

The Marker Layer specifies which layer the station marks will be placed.

Use Label Layer option sets the label for the markers to be the same as that of the labels as set above.

The Half Size Main Marker, Half Size Intermediate Marker and Half Size Odd Marker options draw a perpendicular tick mark on only one side of the centerline. Otherwise a full marker is drawn that goes on both sides of the centerline.

Draw PI Lines option will draw a line in the direction of both tangents, in and out of the PI at the size designated in the PI Lines Size.

Specify whether to define the Centerline By picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

- Using a 2D Polyline will result in horizontal distance stationing along the polyline.
- Using a 3D Polyline will result in the slope distance stationing along the polyline.
- Using a CL File will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.
Use **Station Type** to specify the stationing format to use.

Use **Type of Curves** to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

**Locate Centerline Points** will locate points and store them in the current CooRDinate file.

**Locate Radius Points** will locate the radius points of any arc segments.

**Starting Point Number** determines the starting point number for the points to be located.

**Vertical Exaggeration** applies to Profile Polyline mode. This factor is the ratio between the horizontal and vertical scales on the profile grid.

There are two ways to **Set Elevations** for the centerline points and offset points to be created.

- The **3D Polyline** option gets the elevation of the point from a specified 3D Polyline within the drawing.
- The **Profile** option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.
- With the **None** option selected, no elevations will be determined for the points.

When **Include Station in Description** is checked, the station along the centerline will be included in the resulting offset point description field.

![Description Setup](image)

- **Left Prefix** or **Suffix** is added to the left offset label
- **Right Prefix** or **Suffix** is added to the left offset label
- **Decimals** controls the label precision
- **Description Prefix** is an optional user-specified prefix to be added to the point description.
- **Description Suffix** is an optional user-specified suffix to be added to the point description.
When **Label Sta Equations** is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

**Locate Offset Points** will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

**Use Polylines** allows you to select an offset reference polyline
**Left** and **Right** offsets allow a user defined offset amount
**Percent Slopes** allows you to project an offset grade based on a slope from the corresponding centerline points.
**Vertical Offset** allows you to define a separate vertical offset for the left and right horizontal offsets.
**Bisect Deflection** Angles controls how the offsets are located at angle points. When enabled, two offset points both 90 degrees from their respect centerlines are located.

**Label Super Elevation:** This option labels the super elevation transition stations as defined in the specified .SUP file. You can choose which types of the transition stations to label and set the prefix for each type.

**Prompts**

**Station Polyline Dialog**
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: *select a polyline*

Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

Labels set to perpendicular and Max Length of PC lines set to 75.0
Labels with Draw PI Lines, Label PI Stations and Locate PI Points all checked on

![Diagram of a road alignment with labels and measurements](image)

Labels using Centerline By 2D Polyline (Horizontal Station)

![Diagram showing horizontal measurement](image)

Labels using Centerline By 3D Polyline (Slope Station)

![Diagram showing slope measurement](image)

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** stapl  
**Prerequisite:** A polyline or CL file

### Label Station-Offset

This command will compute and label the stations, offsets and elevations of selected points or entities. Additional labels for the names of the reference alignments and point data (point name, northing, easting, latitude, longitude, description) can also be specified and placed.

A common usage for using dual alignments and profiles typically involves the alignment and profile of a road coupled with the alignment and profile of a pipe/utility.
1st/2nd Alignment: Specify the criteria for either one or two alignments that will be used for the label(s) that will be placed into the drawing.

Use 2nd Alignment: Enable this toggle if multiple alignments are to be used for the label(s) that will be placed into the drawing.

Name: Supply a label-friendly value for the name of the alignment (e.g. "King Street" or "Water Main"). The value(s) specified get assigned to the Alignment Label Field.

Centerline: Indicate the source (Polyline or Centerline File) for the reference alignment. If the Polyline option is selected, you will be prompted to select the polyline(s) after the OK button is pressed. If CL File option is selected, supply a valid path and file name for the centerline file or navigate to the file using the "File Picker" button. The Beginning Station will be determined from the selected Centerline File.

Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. This control is not used when you use a centerline (.CL) file to define the centerline as the starting station of the centerline is stored in the .CL file.

Vertical Reference: Indicate the source (3D Polyline, Profile File, Road Network or Surface File) for the reference elevation. With a Vertical Reference, there are label fields to label the Elevation Reference and Cut/Fill. With 3D Polylines, there will be an additional Slope Station available under the Label Fields in addition to the regular horizontal distance station. If the Profile option is selected, supply a valid path and filename for the profile file or navigate to the file using the "File Picker" button shown above. For the Road Network, specify the road network (.rdn) file with the "File Picker". With the Road Network method, the program will find the road design surface elevation for the specified points using all the road network design files including profiles, templates and transitions. For Surface File, the program will prompt for selecting a triangulation or grid surface model.

Cross Slope (%): Indicate the slope as a percentage to "travel" from the Vertical Reference. A value of 0 (zero) will not apply any cross slope from the reference elevation. Positive values will decrease the calculated elevation(s) and negative values will increase the calculated elevation(s).

Vertical Adjustment: Indicate the desired amount of vertical displacement that should applied to the calculated elevation. This is useful when deriving elevations for back or face of curb.
**Label Alignment:** Specify whether the labels should be Horizontal on the screen, Vertical on the screen, Parallel to the Centerline, Perpendicular to the Centerline, or user-specified by Picking.

**Label Brackets:** Options to draw brackets around the labels with different styles including Square, Parenthesis, Arrow and Curly. The Single, Double and Triple options are for how many brackets to draw.

![Label Brackets Example](image)

**Text Placement Options:** Controls how the leader is drawn with the label. The Above/Below Leader method draws the leader along the label. The After Leader draws the leader up to the label.

![Text Placement Options Example](image)

**Text Size Scaler:** Determines the size of the labels. This value multiplied by the horizontal scale setting in *Drawing Setup* results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scalar is set to 0.10, the labels will be 10 units.

**Text Offset Scaler:** Controls the distance between the leader and the label.

**Text Offset Scalar:** Determines the scalar to offset top, and or bottom label(s) from the label line base point (i.e. the end of the leader line). This value is multiplied by the horizontal scale setting in *Drawing Setup* to determine the on screen label(s)' text offset up/down. (NOTE: Only available when top, and or bottom label(s) text is offset up, and or down. Not available when drawing labels as MLeader objects)

**Text Style:** Specify the desired text style for the label.

**Use MLeader:** Creates an MLeader which combines the leader with the label.

**Leader Segments:** Specify the desired number of leader segments that should be allowed when constructing the label.

**Use Relative Leader:** Indicate whether successive labels placed into the drawing should re-use the geometry of the initial leader placed with the command.
**Draw Leader Arrow:** Indicate whether to draw an arrowhead on the leaders.

**Draw Line From Centerline:** This option draws a perpendicular line between the point and the centerline. The Setback Offset option shortens the line and makes gaps at the centerline and point ends. The Set Label Adjacent option places the label along this line instead of at the leader endpoint.

**Draw At Fixed Position:** After you pick the first label position, the rest of the labels will be placed at this same level. This option applies to the Vertical and Horizontal Label Alignment methods.

**Label Fields:** Use the green arrow buttons to specify the items that are to appear in the labels. As labels are "moved" from Available to Used, a Label Format dialog box particular to the label will appear that will allow for more precise display control. To subsequently edit each item, use the Format Editor button as shown below.

![Label Format Dialog Box](image)

**Note:**

- The Row Number value is specified as the row starting closest to the leader with subsequent rows moving further from the leader as shown in the figure below. Row 2 below the leader has been illustrated with the Draw Box option enabled.

```
Row 4
Row 3
Row 2
Row 1
```

- The Row Number value is specified as the row starting closest to the leader with subsequent rows moving further from the leader as shown in the figure below. Row 2 below the leader has been illustrated with the Draw Box option enabled.

```
Row 1
Row 2
Row 3
Row 4
```

**Layers:** Specify the layer of each item that comprises the label.

**Max Offset to Calc:** Specify the maximum offset to calculate.

**Truncate Station at +:** Removes the digits before the + in the station labels.
Station Type: Specify the stationing format to use.

Station Units: When set to Miles divides the station values by 5280 for creating the station labels. When set to Kilometers, it divides the station values by 1000 for the labels.

Add to Existing Point Description: When picking points to label by point #, this option appends the label to point description instead of creating a text label. The description is updated both in the coordinate file and for the point description attribute in the drawing.

Flip Text for Twist Screen: When this option is enabled, the label(s) text will be flipped as necessary to adjust for the use of Twist Screen. When this option is disabled the normal, and forward direction of the Centerline will be used to determine an up direction for drawing the label(s) text. Applicable to Perpendicular, Parallel, and Pick Label Alignment.

Offset Tolerance: For points with an offset greater than the specified tolerance, this option puts the labels in a separate layer. This option is a way to highlight points with offsets more than the tolerance. The separate Offset Tolerance layer can be setup to use a different color.

Type of Curve: Specify whether the centerline is for a roadway or railroad. Stationing for Roadway Curves is measured along the curve length itself whereas stationing for Railroad Curves is measured along chord segments.

Save: Allows the current settings to be saved to a Station-Offset Settings (*.sos) file.

Load: Allows settings from a previously saved Station-Offset Settings (*.sos) file to be recalled for use.

Prompts

Polyline should have been drawn in direction of increasing stations.

Select Polyline Centerline (Alignment-1): Pick the polyline centerline This prompt will not appear if the Centerline File option was specified.

Select 3D Polyline Profile (Alignment-2): Pick the polyline profile This prompt will not appear if the Profile File option was specified.

Pick point or point numbers (SS for Selection Set,G for Group,Enter to End): Pick a point

Pick point to label: Pick a leader vertex point

Pick label alignment: Pick angle for the label This prompt will only appear if the Pick option was specified.

Pick point or point numbers (SS for Selection Set,G for Group,Enter to End): Press Enter

Real-time display of Station and Offset as you move the cursor.
A sample label with a 2-segment leader.

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** offsta  
**Prerequisite:** A polyline or centerline file

### Offset Point Entry

This command creates points along a centerline at specified stations and left and right offsets. The centerline can be defined by a polyline, centerline (.CL) file or two points.

![Offset Point Entry dialog box](image)
The Output option to Coordinate File will store any points the current coordinate (.CRD) file. This includes centerline points and offset points. The option to Draw will draw the new points using the settings from Points > Point Defaults.

When Locate Points on Centerline is checked, the program will locate points along the centerline, otherwise just the offset points will be created.

When Label Stations & Offsets is checked, the program will label the station-offset as the point description attribute.

The Include Station-Offset In Description option will add the station and offset of the point into the point description.

**Beginning Station:** Enter the Beginning Station of the Centerline.

Use Centerline from to specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Use Reference Elevation to assign elevations to the points created when locating points on the centerline of offset points. When using a 3D Polyline for the elevation reference, points will be created at the station entered and the offsets specified with the elevation of the same station along the 3D polyline. The Profile option will do the same as the 3D Polyline option only it will use a profile file for the elevation reference. You will be prompted for the profile to use for the elevation reference. None simply creates 2d point data on elevation zero. The Reference Elevation option is good for creating points along the centerline for final grade elevation points. Profile to 3D polyline can be used to transfer the profile data to the polyline before calculating the final grade points.

**Cross Slope %:** This option is used to alter the elevations of the new points by applying either a Cross Slope calculation or a Delta Z variable.

The Manual Entry option in Input Station-Offset from will prompt for the station and offset distances. The Read File option will read the stations and offsets from a text file. The text file format with point number, station, offset, elevation and description. The program handles station formats with or without the '+' (i.e. either 250 or 2+50). The elevation and description are optional. The Read File option is a quick routine to convert a station-offset data file into coordinates. The delimiter for the text file and the order of the fields are set in the dialog shown here.
When Offset Prompt is set to Both Left-Right, the program will prompt for left and right offsets. If you respond to an offset prompt with zero (0), no offset point is created. The Single Offset option will prompt for one offset per station. Enter a right offset with a positive value and a left offset as a negative value. The Multiple option keeps prompting for offsets at the current station until you enter a blank offset. This option applies when you have more than one offset to create on the left or right side.

Use Station Type to specify the stationing format to use.

Use Type of Curve to specify whether the curves are for a roadway or railroad.

Prompts

Offset Point Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline to Station-Measure: select a polyline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
Distance from beginning station along centerline (Enter to end): 110
Starting Segment Station: 0.0 Ending Segment Station: 228.633
Working Line segment...(5413.4 4879.64 0.0)
Left offset distance <10.0>: 15
Right offset distance <15.0>: 20
Distance from beginning station along centerline (Enter to end): press Enter
Keyboard Command: offpts
Prerequisite: A centerline (.CL) file, polyline, or two points

Calculate Offsets

This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example). After entering the points
to calculate, the program prompts for selecting another centerline which is optional in case you want a report for multiple centerlines.

**Beginning Station:** Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

**Maximum Offset to Calc:** This is the maximum distance from the Centerline for which offsets are calculated.

**Report Offsets Ahead/Behind Centerline:** When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

**Label Station and Offsets:** When checked, the station offsets will be labeled in the drawing.

**Label Cut/Fill:** When using a reference elevation from the Report Grade Elevation setting, this option labels the cut/fill between the reference elevation and the points.

**Cut/Fill In Inches:** Sets the precision for reporting cut/fill when using inches or whether to report in decimals.

**Sort Report by Stations:** When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

**Report Point Coordinates:** When checked, this option will include the point northing and easting in the report.

**Report Point Notes:** When checked point notes will be included on the calculate offset report.

**Create Point Notes:** When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

**Use Report Formatter:** When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft Excel or Microsoft Access. You must check this option on in order to use the Report Grade Elevation From option.

**Round Stations:** When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.
Store Station Text to CRD File: When checked, the station offset text is appended to point numbers that are selected.

Report Grade Elevation From: When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To Use this option, the Report Formatter must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

Define Centerline by: Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, by a point and direction angle, or using 2 points. The polyline mode can be either 2D or 3D for horizontal or slope distance stationing.

Station Type: Specify the stationing format to use.

Decimals: Specify the display precision for the stations and offsets.

Type of Curve: Specify whether the curves are for a roadway or railroad.

Prompts

Calculate Offset Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline Centerline: select polyline centerline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
PtNo. North(y) East(x) Elev(z) Description
140 4889.13 5410.25 0.00 1+10.00L10.00 Station on Line
141 4870.15 5416.55 0.00 1+10.00R10.00 Station on Line
+ before station denotes point is ahead of line segment, - denotes beyond.
Pick point or point numbers (Enter to End): 22-28

Quick Profile From Surfaces
This command allows you to create, view, edit, and report profiles from the TakeOff surfaces.
Pick starting point (CL-Centerline, P-Polyline): To make a profile you need to define the alignment by: 1) picking points on the screen; 2) typing in CL in the command prompt, and selecting a centerline file; or 3) typing in P and choosing a polyline from the screen. After doing so, the above profile viewer is created.

The far right dialog box allows you to toggle on and off different Surfaces to view in the profile viewer including: Original Ground, Topsoil Removal, Design Surface, Final Subgrade, Overex Surface, Strata Surfaces. If a surface is not defined in the current TakeOff project, like Topsoil Removal in this example, than you will not have the option to display it. In this example, the three Surfaces that can be displayed, Original Ground, Design Surface, and Final Subgrade, are displayed in the profile viewer.

When you move the cursor around the profile viewer a crosshair follows along the surface and reports the Station, Slope %, and Elevation at each point. It is displayed towards the bottom-right side of the screen next to Adjust Alignment. In this example the station is 2+16.650, the Slope is -5.6%, and the Elevation is 818.133. A crosshair can been seen in the profile drawing and along the alignment in the main drawing as well.

Vertical Exaggeration: x1 is the actual appearance of the surface(s). Depending on the flatness of the surface(s), you can select x2, x5, x10 vertical exaggerations to better see the elevation differentiation and different surfaces. The option Fit automatically exaggerates the vertical to best fit the profile viewer.

Drag Action: This dialog allows you to zoom in and out, and pan around the profile. To zoom in click and drag up, to zoom out click and drag down. To Pan, click and drag the direction you want to move.

The Adjust Alignment icon allows to pick the polyline or centerline that you used and move it to your liking. If you selected an endpoint vertex, you can pivot that vertex around 360 degrees and the profiles will update in real time. This is helpful when checking for spikes. If you select the middle vertex then you can shift the entire centerline around.

If you created a profile alignment by picking points and you want to save that polyline you created then toggle on Draw Plan View Polyline. If you do not choose Draw Plan View Polyline than the polyline will be lost when you exit out of the Quick Profile command. Grid Ticks Only marks elevations and distances but does not draw them into grids.

The Save icon allows you to save the profile as a (.pro) file by whatever name you give it. The Draw icon allows you to draw the profile right on your drawing. Set the layer name, vertical and horizontal scale as desired, pick a starting point to draw, and the profile is created. Note: the below example has a veritcal scale of 5 feet per grid and a horizontal scale of 50 feet per grid.

**Prompts**
Command:
QUICKPRO
Pick starting point (CL-Centerline,P-Polyline): p

Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>:
Loading edges...
Loaded 5057 points and 14923 edges
Created 9866 triangles

Prerequisite: a surface

Keyboard Command: TK QUICKPRO

Create Profiles

Profile From Existing Surface
This command will create a profile file (.pro) for the existing surface. To define the profile alignment, type in CL in the command prompt, and select a centerline file, or pick the polyline from the screen. This will create the profile file. You can now use the other Profile commands to draw, edit and report from this profile.

Prompts

Command: progrid2

Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>:
Enter the starting station <0.0>:

Loading edges...
Loaded 574 points and 1393 edges
Created 820 triangles

Found 19 profile points.

Prerequisite: a surface

Keyboard Command: progrid2

Profile From Design Surface
This command will create a profile file (.pro) for the design surface. To define the profile alignment, type in CL in the command prompt, and select a centerline file, or pick the polyline you want to use from the screen. This will create the profile file. You can now use the other Profile commands to draw, edit, and report from this profile.

Prompts
Command: progrid3

Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>:
Enter the starting station <0.0>:

Loading edges...
Loaded 574 points and 1393 edges
Created 820 triangles

Found 19 profile points.

**Prerequisite:** a surface

**Keyboard Command:** progrid3

**Design Road Profile**

This command is for simultaneously creating a .pro file and drawing the road profile. The procedure is to first specify the on-screen grid and then enter or pick the stations and elevations.

Once two segments have been entered, you will be prompted for the vertical length. If you don't want a vertical curve, enter 0. Otherwise, you can directly enter the vertical curve, or enter the sight distance or the K-value from which the vertical curve is calculated. The vertical curve can also be specified to pass through a point or do a best fit through multiple points. This through point option would be useful for hitting an existing feature such as a driveway on the vertical curve. Unequal vertical curves is another option where the vertical curve length going into the PVI differs from the length leaving the PVI. Before using your entry, the vertical curve, sight distance, and K-value are displayed. Object height and eye height are two variables that effect the vertical curve.

Notice that the station, elevation, and slope at the current position of your cursor crosshairs are displayed in real-time in a small dialog.

**Prompts**

**File Selection dialog** Specify a profile file to create.

**Profile Settings dialog**

Station of first PVI or pick a point: 0
Elevation of PVI: 565
Station of second PVI or pick a point ('U' to Undo): 200
Percent grade entry/Ratio/<Elevation of PVI>: 575
Station of next PVI or pick a point ('U' to Undo, Enter to End): pick a point

**Snap PVI dialog**

The Snap PVI dialog box appears when you pick a point (if the Prompt for Snap option in the Profile Settings dialog is selected). The station and slope may be changed to the nearest snap value. The elevation is the free variable and it will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new value.

View Table/Unequal/Through pt/Sight Distance/K-value/<Length of Vertical Curve>: 100
For Crest with Sight Distance => VC and Vertical Curve => 100.00

Sight Distance => 87.30, K-value => 44.1

Use these values (<Y>/N)? Press Enter

Station of next PVI or pick a point ('U' to Undo, Enter to End): press Enter

Vertical Curve Text Options dialog box
Pick vertical position for VC text: Pick a position above the profile grid.
Prerequisite: A profile grid
Keyboard Command: road

Quick Profile from Screen Entities

This command allows you to create, view, and draw profiles from the current surface.
Pick starting point (CL-Centerline, P-Polyline): To make a profile you need to define the alignment by: 1) picking points on the screen; 2) typing in CL in the command prompt, and selecting a centerline file; or 3) typing in P and choosing a polyline from the screen. After doing so, the above profile viewer is created.

Quick Profile from Screen Entities creates a profile from all the entities that cross your alignment. When you move the cursor around the profile viewer a crosshair follows along the surface and reports the Station, Slope %, and Elevation at each point. It is displayed towards the bottom-right side of the screen. In this example the station is 2+79.657, the Slope is -5.2%, and the Elevation is 819.460. A crosshair can been seen in the profile drawing and along the alignment in the main drawing as well.

Vertical Exaggeration: x1 is the actual appearance of the surface(s). Depending on the flatness of the surface(s), you can select x2, x5, x10 vertical exaggerations to better see the elevation differentiation and different surfaces. The option Fit automatically exaggerates the vertical to best fit the profile viewer.

Drag Action: This dialog allows you to zoom in and out, and pan around the profile. To zoom in click and drag up, to zoom out click and drag down. To Pan, click and drag in the direction you want to move.

If you created a profile alignment by picking points and you want to save that polyline you created then toggle on Draw Plan View Polyline. If you do not choose Draw Plan View Polyline than the polyline will be lost when you exit out of the Quick Profile from Screen Entities command. Grid Ticks Only marks elevations and distances but does not draw them into grids.

The Save icon allows you to save the profile as a (.pro) file by whatever name you give it. The Draw icon allows you to draw the profile right on your drawing. Set the layer name, vertical and horizontal scale as desired, pick a starting point to draw, and the profile is created.

**Prompts**

**Command:** tk.quickpro2

**Pick starting point (CL-Centerline,P-Polyline):** *P to select a polyline from the screen*

**Select profile centerline polyline:** *Select the desired polyline*

**Tested 39 of 39 Entities Intersects found > 12**

**Opening file C:/Program Files/Carlson TakeOff 2004/quickpro.pro for write.**

**Prerequisite:** entities

**Keyboard Command:** tk.quickpro2

**Profile from Screen Entities**

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.
The Interpolate Endpoint Elevations from Beyond Profile Extents option will cause the program to look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline. The Station by Another Reference Centerline option will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.

![Profile from Surface Model dialog](image)

In addition to creating the one centerline profile, offset profiles may also be created by entering the offset distances in the Profiles Offset box of the Profile from Surface Model dialog.

**Prompts**

**File Selection Dialog**
Specify a profile file name to create.

**Profile from Surface Model dialog box (previous page)**
Polyline should be drawn in direction of increasing stations.

CL File/ select polyline which represents the profile centerline>: *Pick the centerline*

Select Lines, PLines, and/or 3DFaces that define the surface for profiling.

Select objects: C (for crossing and window everything the centerline crosses)

Prerequisite: A polyline centerline and surface lines and polylines.

**Profile from TIN or Grid**
This command creates a profile (.PRO file) from a centerline polyline and a surface model stored in a 3D grid file (.GRD) or triangulation file (.TIN or .FLT). The polyline defines the alignment of the profile and the grid defines the surface.

After selecting the reference surface file, there is a Profile Options dialog with these options:

**Link Profile To Triangulation:** This option will update the profile whenever the reference triangulation is modified.

**Type of Centerline:** This setting chooses the type of stationing for centerline curves.
**Station by Another Reference Centerline:** This option uses a second reference centerline for the stationing of the profile. The main centerline is used to find the elevations on the surface and then these main centerline positions are projected onto the reference centerline to get the stationing. The reference centerline needs to extend along the full range of the picked polyline in order to project correctly and capture offsets along the entire length of the picked centerline.

**Profile Offsets:** In addition to creating the profile along the centerline, you can also create profiles offset left and right.

**Prompts**

**Choose Grid or Triangulation file to process** Select existing .GRD, .TIN, or .FLT file.

**Profile Options dialog.**

**Choose PROfile file to Write dialog** Enter a profile file (.PRO) name to write.

Polyline should have been drawn in direction of increasing stations.

**CL File/<Select polyline that represents centerline>**: select a polyline

Polyline should have been drawn in direction of increasing stations.

**CL File/<Select Reference centerline polyline>**: press Enter

Reference CL starting station <0.0>: press enter

**Pulldown Menu Location:** Profiles > Create Profile From ...

**Keyboard Command:** progrid

**Prerequisite:** A .GRD grid file, .TIN, or .FLT tmesh file

**Profile from 2D Polyline**

This command allows you to convert a polyline that is drawn on a profile grid into a profile (.PRO) file. The polyline must be drawn in the direction of stationing.

**Prompts**

**New or Append Dialog Box**

Choose New unless you intend to create a multiple profile.

**File Selection Dialog Box**

Specify the profile (.PRO) file to create.

**Profile Settings Dialog**
Set these parameters to match the dimensions of the grid.

**Pick the lower left grid corner:** *Pick the grid corner.* Endpoint snap is set on.

**Profile number <1>:** *Press Enter.* This is an optional profile name used for multiple profiles.

**Select the polyline to write profile from:**

**Select object:** *Pick the polyline in the grid.*

A station and elevation report is produced.

**Prerequisite:** Drawn polyline which represents profile.

**Keyboard Command:** pro2dpl

![Profile Settings](image)

**Profile from 3D Polyline**

To create a profile (.PRO), Profile from 3D Polyline uses X-Y distances between the points of a 3D polyline for sequential stations and the Z values at these points for profile elevations. In the options dialog, Profile Name is an optional description for the profile. The Prompt For Elevations option will prompt for the elevation at each polyline vertex to use for the profile instead of using the polyline elevations. The Station By Another Reference Centerline method locates the station for each polyline vertex along a reference centerline and uses this reference station instead of the polyline distance for the profile stationing. The reference centerline can be defined by another polyline or centerline file (.CL). When using the reference centerline, the Combine Multiple Polylines Into Profile option allows you to select multiple 3D polylines and put the data into a single profile. For example, you can use these two options to create a profile of curb elevations with road centerline stationing by selecting multiple 3D curb polylines and the road centerline as the stationing reference.

![Profile From 3D Polyline](image)

After the options dialog, the program prompts for the .PRO file to create and then the 3D polyline to process.

**Prompts**
Profile From 3D Polyline dialog
Profile File to Write dialog Specify a profile file name to create
Select polyline to profile: pick a 3D polyline
Created 72 data points for profile C:\sample\abc.pro
The new profile is then stored.

Pulldown Menu Location: Profiles
Keyboard Command: pro3dpl
Prerequisite: A 3D polyline

Profile from Points on Centerline
This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).

Prompts

PROfile file to Write dialog box: Enter a new profile file name to write.
CL File/<Select polyline that represents centerline>: pick a polyline or choose C for Centerline
Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.
Note: for all selected points, the points should be located on the real Z axis.
Select the Carlson points along the centerline.
Select objects: Select the point entities.

Keyboard Command: profpts
Prerequisite: A polyline centerline and points
Profile Utilities

Profile To 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs. Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.
2. Profile from Surface Model - to create existing surface profile.
3. Design Road Profile - to design the final profile with vertical curves.
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.
7. Triangulate & Contour - draw final contours using road 3D polylines.
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

Prompts

Layer Name for 3D Polyline <3DPROF>: press Enter
Select profile centerline polyline: pick a polyline
Station by another reference centerline [Yes/<No>]?: N for no. This option will prompt for a second centerline to use for stationing.
Enter the starting station <0.0>: press Enter
Select Profile File
Starting station of centerline <0.0>: press Enter
Erase centerline (Yes/<No>)?: Y This option will erase the original 2D polyline centerline.

Example of road design in plan-view with Profile to 3D Polyline

Keyboard Command: proto3dp
Prerequisite: A .PRO file and a centerline polyline

Chapter 12. Roads Menu
This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC’s and PT’s) can be stored in the point description depending on user settings.

Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.
Interval On Line Segments: Specify station interval for line segments.
Interval On Curve Segments: Specify station interval for curve segments.
Station to Begin Intervals: Specify station to start intervals.
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.
Create Points on Centerline: When checked, points will be created on the centerline.
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.
Vertical Offset of Profile: Specify the vertical offset. Enter zero for no vertical offset.
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the point description. For example, if the profile name is DESIGN.PRO, then the point description might be DESIGN 0+63.37.
Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.
Centerline by: Click either Polyline or CL File.
Type of Centerline: Click either Roadway or Railroad.
OK: Specify files.

Prompts
Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.

Select profile centerline polyline: pick a polyline
Starting station of centerline <0.0>: press Enter

Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing. With this option, the first centerline is used for locating the points and the second reference centerline is used for locating the profile stations. So the first centerline represents where the points are created (i.e. the edge of pavement) and the second centerline represents the profile location (i.e. the road CL).

Choose Profile to Process dialog Specify a profile name.

Starting point number <1>: press Enter This defaults to the point number after the highest one currently in the CRD file.

Station for additional point (ENTER to end): press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.

![Graph showing profile slope report]

Points created along profile centerline using elevations from the above road profile

Keyboard Command: pro2pts
Prerequisite: A .PRO file and a centerline polyline

Profile Slope Report
This command calculates the slope and distance of a line, polyline segment, an entire polyline, or pair of points, as drawn on a profile. There are options to label the slope and distance. If the labels are turned off, this command can be used to just report the profile slope and distance. The distance is the horizontal distance between the profile stations.
Horizontal Scale: Specify the horizontal scale of the profile grid.
Vertical Scale: Specify the vertical scale of the profile grid.
Text Size Scaler: Specify the text size scaler which is multiplied by the Horizontal Scale.
Symbol Size Scaler: Specify the symbol size scaler which is multiplied by the Horizontal Scale.
Layer: Layer name for the labels.
Style: Text style for the labels.
Slope and Distance Decimals: Specify the display precision for the slope labels and distance labels.
Label Symbol: When checked, the degree symbol or percent sign will be used in the label.
Label Arrow: When checked, a slope direction arrow will be included.
Arrow Scaler: Specify the arrowhead size scaler which is multiplied by the Horizontal Scale.
Label Minus Sign: Will label a minus sign on negative slopes.
Slope Prefix/Suffix: Strings to add to the slope value for the slope label.
Distance Prefix/Suffix: Strings to add to the distance value for the distance label.
Label Format: Choose whether to label slope and distance.
Slope Format: Specify how to label the profile slopes. The automatic settings means to use a percent label for any slope less than 10%, and a ratio for any slope greater than 10%.
Label Method: Choose to label the entire profile at once or to pick individual segments.
Reduce Profile Points: When checked, the number of labels created on the profile will be reduced based on the Offset Distance value. Applies only to the Entire Polyline selection option.
Offset Distance: Specify maximum offset between profile vertices. Only available when Reduce Profile Points toggle is checked on.

Prompts

Slope Report Options dialog box
Points/Select line or polyline to list-label>: pick a polyline
Slope Distance > 600.33 Horizontal Distance > 600.00
Elevation Difference: 20.00 Slope Ratio: 30.00:1 Slope Percent: 3.33
Starting point of label ([Enter] for none): pick a point
Points/Select line or polyline to list-label>: press Enter If you choose P for points, you go into the Points mode and can label the slope of any pair of screen picks on the profile.
Pipe Depth Summary

This command reports the horizontal distances for the range of depths comparing a surface profile to a trench, pipe or sewer profile. There is an option to use two surface profiles and the program will use the minimum of the two depths. In addition to the report, the depth ranges can be labeled along the profile in the drawing.

The simplest of applications of this command, comparing a sewer profile to a surface profile and reporting the depth summary according to the specified Depth Zones, is shown below.

Use Trench Template for Volumes: Trench templates are made using the command Input-Edit Trench Template within the Profile Utilities "flyout". Trench earthwork volumes are then computed.

Report Backfill Volumes: Available if trench templates is clicked on.

Use Rock Strata Profile: If clicked on, the Rock Profile can be entered in the lower portion of the dialog, and if the pipe invert is below rock surfaces along any segment, rock linear feet will be reported, in the same depth categories as used for trench depths. In the example shown below, if rock depth is uniformly 5 feet below surface elevation, in the form of a rock profile, rock quantities are 348 feet of 0-2 feet depth of rock trenching.

Use 2nd Surface Profile to Minimize Cut: If the final grade is below existing grade, in those areas, it saves trenching work to first do the cut to final grade, prior to filling over existing grade in areas of fill. Then trench depths are minimized. This option, if clicked on, computes trench depths to the minimum of the two specified surfaces, and activates the 2nd Surface Profile option in the lower portion of the dialog.

Extend Shorter Profile to Longer Profile: This option will extrapolate the starting and ending stations of the shorter profile to match the longer profile.
**Draw Zone Dimensions on Profile:** The depth zones will be annotated along the horizontal axis of a profile drawing with this option.

**Report Manhole Depth Summary:** This leads to the depth summary report.

**Depth Zones:** These zones are for reporting the pipe range of depth. The depths should be entered in lowest to highest order. Use the Next and Back buttons to move between the 20 possible depth values.

---

### Prompts

**Pipe Depth Options dialog**

*Pick lower left grid corner [int on]:*  *pick the profile grid corner*

*Pick vertical position for dimensions:*  *pick a point below the profile grid*

---

#### Pipe Depth Summary

**Surface Profile:** C:\\SCAD2003\\DATR\\SURFACE.PRO

**Pipe profile:** C:\\SCAD2003\\DATR\\SEWER.PRO

<table>
<thead>
<tr>
<th>Depth</th>
<th>Manholes</th>
<th>Linear Ft</th>
<th>% of Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-2.0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>2.0-4.0</td>
<td>1</td>
<td>34.2</td>
<td>7.9</td>
</tr>
<tr>
<td>4.0-6.0</td>
<td>0</td>
<td>280.6</td>
<td>65.3</td>
</tr>
<tr>
<td>6.0-8.0</td>
<td>2</td>
<td>115.2</td>
<td>26.0</td>
</tr>
<tr>
<td>8.0-10.0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>&gt;10.0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>3</strong></td>
<td><strong>430.0</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Manhole Depth**

- MH#3: 6.15
- MH#2: 6.21
- MH#1: 3.28

**Total:** 15.94

---

**Pulldown Menu Location:** Profiles

**Keyboard Command:** pipedeep

**Prerequisite:** Two profiles, one for the surface and one for the pipe invert elevation
Profile Report

This command creates a summary report of generic, road, crossing, pipe and sewer profiles using a profile file (.PRO file). The report is generated in the standard report viewer which can print the report, save it to a file or draw it on the screen. The different types of profiles have different report options.

To report stations adjusted by station equations, first run Input-Edit Centerline and enter the station equations. Then run Input-Edit Profile and assign the centerline as the Reference Centerline for the profile.

For roadway profiles, Report Sag and Crest Stations will calculate and report sag and crest stations and elevations. Report Stations at Centerline Points will prompt the user for a centerline file (.cl file) and report stations and elevations at horizontal PC and PT points. Report Cut/Fill from Second Profile will compute and report the elevation difference between the subject profile and a second reference profile. Report Min/Max Cut/Fill reports the stations and amounts for the min and max cut and fill between the road and reference profiles. Report Station/Elevation at Interval will calculate and report stations at the specified interval in addition to other points. Report Elevation to Vertical Offset creates and additional elevation column in the report. The differential amount for this column is specified by the user in the Vertical Offset window. The Use Report Formatter option runs the report through the report formatter where you can choose which fields to report and the report order as well as output to Excel or databases.

For sewer profiles, the Report Method chooses between reporting the slopes and pipe distances between manhole centers or from the outside manhole edges for the actual pipe dimensions. The Report Pipe Size Summary option reports the total pipe length for each different pipe size. The Station By Another Reference Centerline option reports the sewer stations using a reference alignment besides the sewer alignment. For example, this option can be used to report the sewer stations based on the road centerline. When this option is on, the program will prompt for both the sewer centerline and the reference centerline. The program first finds the position of the sewer station along the sewer centerline and then finds the station of the nearest perpendicular offset along the reference centerline.
Prompts

**Specify a Profile File** dialog Choose the .PRO file.

**Profile Report** dialog Make selections, click OK.

If a vertical offset is entered, a second column of elevations is reported.

Sample Profile Report:

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
<th>Type</th>
<th>VertCurve</th>
<th>Distance</th>
<th>Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>0+00.00</td>
<td>88.08</td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
</tr>
<tr>
<td>1+00.00</td>
<td>94.39</td>
<td></td>
<td></td>
<td></td>
<td>6.45%</td>
</tr>
<tr>
<td>2+00.00</td>
<td>100.84</td>
<td></td>
<td></td>
<td></td>
<td>6.45%</td>
</tr>
<tr>
<td>3+00.00</td>
<td>107.29</td>
<td></td>
<td></td>
<td></td>
<td>6.45%</td>
</tr>
<tr>
<td>3+73.78</td>
<td>112.05</td>
<td>PVC</td>
<td></td>
<td>371.48</td>
<td>6.45%</td>
</tr>
<tr>
<td>4+00.00</td>
<td>113.68</td>
<td></td>
<td></td>
<td></td>
<td>6.00%</td>
</tr>
<tr>
<td>5+00.00</td>
<td>118.82</td>
<td></td>
<td></td>
<td></td>
<td>4.27%</td>
</tr>
<tr>
<td>6+00.00</td>
<td>122.22</td>
<td></td>
<td></td>
<td></td>
<td>2.54%</td>
</tr>
<tr>
<td>6+23.78</td>
<td>128.18</td>
<td>PI</td>
<td>350.00</td>
<td>250.00</td>
<td>6.45%</td>
</tr>
<tr>
<td>7+00.00</td>
<td>121.26</td>
<td></td>
<td></td>
<td></td>
<td>-6.10%</td>
</tr>
<tr>
<td>7+23.78</td>
<td>119.50</td>
<td>PVT</td>
<td>100.00</td>
<td></td>
<td>-8.67%</td>
</tr>
<tr>
<td>7+75.71</td>
<td>115.00</td>
<td></td>
<td>51.93</td>
<td></td>
<td>-8.67%</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Profiles

**Keyboard Command:** preport

**Prerequisite:** A .PRO file

**Input-Edit Profile File**

Similar to the Input-Edit Road Profile command, this command features a spreadsheet type editor and handles a variety of profile (.PRO) configurations. Besides editing a profile, this routine can be used to just view the contents of a profile.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the
profile and vary its appearance by using zoom and pan. The station, elevation and slopes are also shown at the lower left of the dialog which update/track with the movement of the cursor. There are between five and nine possible data fields in a profile depending on the type of profile that has been selected.

![Input-Edit Profile dialog](image)

**Profile Name:** This name is optional and often used when multiple profiles are stored in a profile (.PRO) file and graphically generated using the Draw Profile command.

**Add Row:** Adds a new row into the profile after the current row.

**Remove Row:** Removes the current row.

**Type of Profile:** There are 6 types of .pro files and the spreadsheet columns will change to match the data fields for the selected profile type:

- **Generic** - Generic profiles have station, elevation and description fields.
- **Road** - Road profiles include the Generic controls and adds a vertical curve field. For an asymmetrical vertical curve, enter the left and right side values separated by a dash in the spreadsheet cell. For example, a 200' vertical curve with 50' to the left of PVI and 150' to the right would be entered as "50-150".
- **Sewer** - Sewer profiles include the Generic controls and adds step up, pipe size, pipe thickness, manhole elevation and manhole ID fields.
- **Pipe** - Pipe profiles include the Generic controls and adds a pipe size field.
- **Crossing** - Crossing profiles are for pipe crossings along the centerline. Besides station and elevation, the crossing data points also have the pipe size. The crossing elevation is for the bottom elevation of the pipe. The crossing profile data points are not connected.
- **Circular** - Circular profiles are the same as Road profiles except the vertical curve is circular instead of parabolic.

**Edit Slope To Change:** This setting controls which field to update when the slope is modified in the spreadsheet.

**Reference Profile:** Selects a reference profile and displays it in the profile graphic view immediately.
Reference CL: Selects a reference centerline which is used for station equations.

Sag-Crest Points: When editing a road profile, its sag/crest points are shown here.

Through Pt: This button lets user to make the road profile pass through a certain point.

Vertical Exaggeration: Changes the look of the profile.

Edit Slope to Change: When edit the slope value, you can choose a value to change from the following selection: the next elevation, the previous elevation, the next station or the previous station.

Check Stations: Reports profile information at the specified stations. The Check Stations are not stored in the profile; they are merely used as a design/analysis tool for viewing the elevations at certain stations while adjusting the profile data.

Speed Tables: This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

Next: Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

Previous: Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

Load: Used for loading another, existing .PRO file for editing.

Save: Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

SaveAs: Allows you to save the profile under a different profile file name.

Calc PI: This function calculates a station/elevation point given two existing station/elevation points and slopes from them. The values are entered in this dialog. When you pick Calculate, the program finds the intersection of the grade lines. Then pick OK and the calculated PVI is added to the profile.

Report: Creates a report of current profile.

Undo: Reverts the last action in the editor.

Settings: Opens the settings dialog.
Hold Next Slopes: When editing a profile elevation, this option will maintain all the slopes after the edit point by adjusting the elevations. Otherwise, the elevations for the rest of the profile points are held and the slope from the edit profile point to the next profile point is adjusted.

Show Slope When Zoom In: This option allows to display the slopes on the long enough profile segments when zoom in.

Grid Ticks Only: Toggles between displaying the grid and grid ticks in the graphic box.

Set Grid Interval: This option allows you to control the elevation grid spacing in the graphic preview. When this option is off, the program automatically figures the elevation grid interval.

Hold Elevation When Update Step-Up for Sewer Profiles: Toggles between holding the elevation or the pipe slope

Enable Additional Invert-In Fields for Sewer Profiles: When editing a sewer profile, this option allows you to display an extra invert-in column for in-coming pipes. The invert-in elevations are separated by commas.

Enable Cradle Fields for Sewer Profiles: When editing a sewer profile, this option allows to display cradle above and cradle below columns.

Display Sight Distance Options: Display either K-Value or Sight Distance in the fifth column for road profiles.

Grid Mode: The Dynamic option will update the grid interval labels when you zoom in or out of the profile image. The Static option will keep the grid interval labels static.

Tools: Opens the Tools dialog.
Translate: Globally adds or subtracts value to stations and/or elevations within the specified range of stations. while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.

Scale: Applies the specified scale factor to stations and/or elevations within the specified range of stations.

Reduce: Reduces the profile points by the Offset Cutoff value.

Reverse: Reverses the direction of the stationing for the profile.

Cradle Setup: Sets up the cradles for sewer profiles. The cradle parameters are different with different pipe sizes and are defined in the Pipe Size Library. You can either use library data or specify new values here.

Pulldown Menu Location: Profiles
Keyboard Command: profedit
Prerequisite: None
Quick Section

This command creates section files in one step. The horizontal alignment for the sections can be defined by using picked points, a centerline file or a polyline. A section alignment (.MXS) file is not required for this routine. 3D screen entities or surface files (.GRD, .FLT, or .TIN) are used to define the vertical alignment.

There are two options under Quick Section Methods. The Station Series method creates sections perpendicular from the horizontal alignment at a station interval. In this case, the horizontal alignment represents the centerline. The Single Station method creates one section along the horizontal alignment appends this section to the output section file. In this case, the horizontal alignment represents the alignment of the section.

For the Station Series method, there are settings for the Start Station of the horizontal alignment, the End Station to stop creating sections, the Interval for the stations, and the Left and Right Offsets to define the section width. There are also options to control the section stations to create. The Stations At Interval option will create sections at the specified station interval. The Stations At Centerline Points option will create sections at the special stations of the centerline for the centerline transitions such as PC, PT points.

For the Single Station method, the Station value is assigned to this section. The Zero Offset Point chooses between using the starting point of the horizontal alignment as the zero offset or selecting a point along the alignment as the zero offset.

With the Source Of Surface Model set to Surface Files, the program prompts for up to two surface files so that up to two section files can be generated at a time. When the Surface Model is set to Screen Entities, only one section file is created from the screen entities. With Screen Entities, there are a few more options. The Descriptions By Layer option will use the layers of the screen entities as the descriptions for the section points. The Interpolate From Data Beyond Section Limit will check for intersections with the section line and the screen entities beyond the left/right offsets to interpolate the elevations at the left/right offset extents. The Ignore Zero Elevations will filter out screen entities that are at zero elevation. The Interpolate Zero Offset Elevation Of Sections will create a section point at offset zero by interpolating between the nearest section points.

The program requires an output section file to store the results. There is an output option to draw the sections which calls the Draw Section File command. Finally, the option to Draw Plan View Polyline will draw the horizontal alignment as a polyline which is especially useful is the method to define the alignment by picked points was used.
Prompts

Pick starting point (CL-Centerline, P-Polyline): select a point
Pick second point: select second point
Pick next point (Enter to end): press Enter

Quick Section Options dialog
Choose Source of Surface Model, Screen Entities or Surface File, and make other selections. Click OK.

Keyboard Command: quicksct
Prerequisite: 3D Screen entities or surface files

Input-Edit Section Alignment

This command will create or append to a section alignment file which is stored as a Multiple Cross Sections (.MXS) file. This file contains the coordinates that define the center and endpoints of section lines and is a requirement of many section commands such as Sections from Surface Entities and Sections to 3D Polyline. The section alignment defines the stations along a centerline and how far left and right to create cross sections. This routine starts by asking for a new or existing .MXS file name. Then the centerline is specified by either by choosing a centerline file (.CL file) or selecting a polyline that represents the centerline. Next, the program prompts for the starting station of the centerline. If this is a new section alignment, the Make MXS File Settings dialog appears.

The Input-Edit Section Alignment dialog lists all the section stations and offsets in the alignment of an existing .MXS file.
Dialog if using an existing .MXS file

**Edit:** Allows you to edit the currently highlighted row.

**Add:** Allows you to add more sections by displaying the Make MXS File Settings dialog (shown below).

**Delete:** Deletes the currently highlighted row.

**Save:** Saves the MXS file, exits this dialog and draws the section alignment on the screen using temporary vectors (yellow for left offsets, magenta for right offsets). Any viewport change such as Redraw or Zoom will cause these vectors to disappear. The draw the section lines with Line entities, use the Draw Section Alignment command.

**SaveAs:** Saves a new MXS file with a user-specified name.

---

**Station Interval:** Enter the station interval for sections.

**Right Offset:** Enter the width for the sections, right of the centerline. Not available if Pick Offset Distances is checked.

**Left Offset:** Enter the width for the sections, left of the centerline. Not available if Pick Offset Distances is checked.

**Type of Curve:** Specify either Roadway or Railroad curve to account for the differences in stationing curves.

**Prompt for Starting and Ending Stations:** This option allows you to specify the range of stations to process. Otherwise the program will use the full station range of the centerline.

**Pick Offset Distances:** Allows you to specify the offsets by using the distance between two picked points in the
Use Perimeter Polyline: Allows you to specify a closed polyline that will be used as the limit of the cross sections. The offsets will be contained within this closed polyline.

Station By Another Reference Centerline: Prompts for a separate CL to use for stationing. The program sets for station to store for the section alignment by locating the position of the original station on the section alignment centerline and then finding the station of this position along the reference centerline.

Stations at Interval: Creates cross sections at the specified interval such as every 25 feet. If the Prompt for Starting and Ending Stations is on, then the program will apply the station interval to the user-specified range of stations. Otherwise the station interval is used along the entire centerline.

Stations at Centerline Special Stations: Creates cross sections at every transition point in the centerline such as the PC, PT, spiral points and end points.

Stations at Profile PVC/PVT Stations: Creates cross sections at profile vertical curve transitions stations. When active, the program will prompt for the profile to process.

Stations at Profile High/Low Stations: Creates cross sections at profile vertical curve high and/or low stations. When active, the program will prompt for the profile to process.

Stations from Reference Section File: Creates cross sections at stations contained in the reference section file. When active, the program will prompt for the section file to process.

Stations at Crossing Polylines: Allows you to select polylines that cross the centerline and creates cross sections at the intersections of these polylines with the centerline.

Sections from Polyline: This method prompts to select polylines that define the section alignments. This method is handy when the section alignments have multiple bends such as for HEC-RAS.

Stations at Crossing Pipes: This method creates cross sections at the stations where pipes intersect.

Odd Stations with Specified Endpoints: Creates cross sections at stations that are entered or at picked points along the centerline. This option also allows you to pick the left and right offset points which do not have to be perpendicular to the centerline.

Additional Odd Stations: Creates cross sections at the specified stations but the offsets are always perpendicular to the centerline with the user-defined default offset distances.

Use Exclusion Areas: This option prompts for selecting closed polylines to use as exclusion areas which are areas to skip for the section surface. The stations and offsets for the exclusion areas are stored in the section alignment file. Then routines like Calculate Section Volumes and Draw Sections will skip over these areas and not calculate volumes or draw section lines in these areas.

Allow Sections Overlap: On the inside of a centerline curve, section lines will cross when the section length is longer than the radius. This option controls whether to shorten the section lines on the inside of the curve or to keep the regular length and let the section lines cross.

Prompts

Specify an MXS file dialog Choose new or existing.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick centerline
Enter Beginning Station of Alignment <0.00>: press Enter

Pull down Menu Location: Sections
Keyboard Command: editmxs
Prerequisite: A polyline centerline or a centerline .CL file

Create Sections

Sections From Existing Surface

This command will create a section file (.sct) for the existing surface. First, select a .mxs file for section alignment. If you need to create a .mxs file go to Input_Edit Section Alignment. Next, save the file with a new name or override
a previous file and the section file will be created. You can now use the other Section commands to draw, edit, and report from this section.

Prompts

Command: sctgrid2
Reading edges 1393, intersections found 541

Prerequisite: a surface

Keyboard Command: sctgrid2

Sections From Design Surface

This command will create a section file (.sct) for the design surface. First, select a .mxs file for section alignment. If you need to create a .mxs file go to Input/Edit Section Alignment. Next, save the file with a new name or override a previous file and the section file will be created. You can now use the other Section commands to draw, edit, and report from this section.

Prompts

Command: sctgrid3
Reading edges 1393, intersections found 541

Prerequisite: a surface

Keyboard Command: sctgrid3

Sections from Screen Entities

This command allows you to create cross sections from a surface model. The stations for the sections and the left and right offset distances are defined in the MXS file that must be created before running this routine using Input/Edit Section Alignment. The surface model is defined by lines or polylines with elevation. The polylines with elevation could be a contour drawing file from a photogrammetry firm or can be created from survey points with the Triangulate & Contour command. When using Triangulate & Contour, it is useful to use the Draw Triangulation Lines option because the 3D triangulation lines represent all the break lines in the surface which increases the accuracy of the cross section, as against just using the contours. Barrier lines or 3D polylines can also be used to represent break lines along ridges and valleys. The program samples the selected lines, polylines and 3DFace entities and calculates the intersections of these segments with any of the cross sections. The station, offset and elevation of these intersections make up the data in the section file. This section file (.SCT file extension) can be reviewed or edited with the
Input-Edit SeCTion File command. Also the section file can be plotted with the Draw Section File command or used in the by the Earthworks and Final Contours command to calculate volumes.

The options for this command are set in the dialog shown below. The Interpolate 0 Offset Elevation of Sections option will add a data point at offset zero for every station with an elevation that is interpolated from existing offsets. The Breakpoint Descriptions from Layer option will store the layer name of the surface entity as the description for the offset-elevation point in the section file. The section end points are the left and right furthest offsets such as left and right 100 feet. When calculating sections based on the intersections with surface entities, there usually, intersection exactly at the end points is not possible. For example, there could be contours at offsets right 87.31 and 105.43 but no intersection exactly at 100. There are four methods for determining the elevation for these end points.

1. The Extrapolate Endpoint Elevation from Last Slope calculates the slope from the last two offset-elevation points and calculates the elevation at the endpoint from this slope. For example, given offsets at 80 with elevation 100 and 90 with elevation 101, the elevation at offset 100 would be 102.

2. Extend at Flat Grade to Right and Left MXS Limit uses the last offset elevation as the end point elevation. For example, if the last offset were 85 with elevation 102, the program would add an offset at 100 with elevation 102.

3. The Cut-off at the End of Surface Data option does not add offsets at the end points. The sections will end at the last offset found in the surface model.

4. Interpolate from Surface Data Beyond MXS Limit looks beyond the offset limit for more intersections with surface entities. Then the endpoint elevation is interpolated between the offsets above and below the endpoint. For example, given offsets at 90 with elevation 101 and at 110 with elevation 103, the endpoint offset at 100 would have elevation 102.

Prompts

**MXS File to Process** Select the section alignment file

**New or Append** Choose whether to create a new section file or add to an existing section file

**Section File to Create** Specify the section file

**Select Lines, PLines, and/or 3DFaces that define the surface.**

**Select objects:** pick the surface entities

Compiling file c:\scdev\data\simo2.sct
**Prerequisite:** Construct surface model to be sampled

---

### Sections from Grid or FLT File

This command creates a cross-section file (.SCT file) from a surface model that is defined by a 3D rectangular grid file (.GRD file) or a triangulation file (.TIN). The grid file can be created in the DTM-Contour module with the `Make 3D Grid File` routine. The triangulation file can be created with the `Write Triangulation File` option in the `Triangulate & Contour` command. This command also requires an .MXS file to define the alignment and stations of the sections. The number of section points created is displayed at the end of the routine.

**Prompts**

- Choose Grid file to process
- Choose MXS File to Process
- Choose SCT file to write
- Found 1410 section points.

**Prerequisite:** A grid file (.GRD file) or triangulation file (.TIN file) and a cross sections alignment file (.MXS file)

**Keyboard Command:** profedit

---

### Sections from Polylines

This command allows the user to select a polyline that represents a section in cross section view and writes it to a .SCT file. This can be useful for revising sections or for defining a new one. For example, let's say you have extracted sections from a surface model of the existing ground on a site and have plotted them using the `Draw Section File` command. Now use this command to send the sections to a Section file and compute the earthworks using the `Calculate Sections Volume` command. After selecting the command, the Polyline to Section File dialog appears.

The first time this command is selected the output Section file is set to the same name as the current drawing. Select the Section File Name... button to specify a different name.

The Station Interval edit box allows you to specify the amount that the default station number will be incremented as the station prompt shown below appears.

The Interpolate Zero Offset toggle if on, causes the program to output the elevation of the zero offset to the output .SCT file.

A second section file can be specified to process two sections at a time for each station. This allows you to handle both existing and final grades at once.

After selecting the OK button the prompts below appear.

**Prompts**

**Command:**

SCTFPL

Exit/Pick text/<Station <0.0000>>: Press Enter for the default

Exit/Pick text/<Starting elevation of grid <100.0000>>: Pick Text from the screen

[int on] Pick point at starting elevation and zero offset of section ([Enter] for none): Press Enter

Select station 0.0000 section polyline: Pick a Polyline

Renamed original file: C:/TAKEOFF_2004/DEMO2A-OG.SCT as:

C:/TAKEOFF_2004/DEMO2A-OG.sck

---
List continues...
Sta> 0.000 Revised data stored in C:/TAKEOFF_2004/DEMO2A-OG.SCT
Exit/Pick text/Station <50.000>: Press Enter for the default

Exit/Pick text/Starting elevation of grid <100.000>: Pick Text from the screen

[int on] Pick point at starting elevation and zero offset of section ([Enter] for none): Press Enter

Select station 50.000 section polyline: Pick a Polyline

Renamed original file> C:/TAKEOFF_2004/DEMO2A-OG.SCT as>
C:/TAKEOFF_2004/DEMO2A-OG.sck
1 1857475.2197 159052.3650
2 1857472.8750 159025.7500
3 1857475.5000 159000.2500
List continues...
Sta> 50.000 Revised data stored in C:/TAKEOFF_2004/DEMO2A-OG.SCT
Exit/Pick text/Station <50.000>: Exit

Prerequisite: Plot the section or profile to write to the .SCT file.

Keyboard Command: sctfpl

Sections From Polylines On Section Grids - By Layer
Section From Polylines By Layer command can be used to automatically import section data from drawing entities by selecting samples of the different section elements. When running the command, you will first be prompted to name and save the section file you are about to create. The next dialog shown below will ask you to select the layers
that represent different elements of the section. Use the mouse pick on the right side to pick the layer in the plan view, or type in the layer name in the middle column.

Here is an example of the linework needed for Section From Polylines.

The "Maximum grid text distance from grid" allows you to determine how far from the grid linework the routine searches in order to find text. The program uses the grid linework and the text associated with the linework to calculate the scale of the grid. Station Text Position tells the routine to assign stationing from text either Above or Below the section linework. After saying okay to this dialog, the routine will prompt you to select the entities to process. You can pick on linework, window around a group of linework or type in All.

Pulldown Menu Location: Roads > Create Sections
Prerequisite: dwg with section grids
Keyboard Command: sctfsct

Sections from Points
This command creates an .SCT file from Carlson points in the drawing. An .MXS file is needed to define the centerline and the stations of the cross sections. The offsets for the cross sections points are derived from the perpendicular distance between the centerline and the TakeOff points. The cross section elevations come directly
from the elevations of the points. In order to be included in a cross section, a TakeOff point must be within the offset tolerance distance of the cross section line.

**Prompts**

**Choose MXS File to Process**

**Choose SCT file to write**

**Enter the maximum offset tolerance < 1.0: Press Enter**

**Ignore Zero Elevations (<Yes>/No)? Press Enter.** This option will filter out all Carlson points that have a zero elevation.

**Select the Carlson points along the sections.**

**Select objects:** *pick the Carlson point inserts*

**Prerequisite:** Carlson points and an MXS file

**Keyboard Command:** sctpts

---

TakeOff points for use in creating Section file

**Import Sections**

This command converts Columnar Text, Agtek, Ceal, GeoPak, IGRDS, Moss, RoadCalc, SMI, and Softdesk files into Carlson TakeOff section (.section) files.

**Prerequisite:** a Columnar Text, Agtek, Ceal, GeoPak, IGRDS, Moss, RoadCalc, SMI, or Softdesk file
Section Utilities

Sections to 3D Polylines

This command creates 3D polylines from a section (.SCT) file. Besides the section file, a centerline polyline, centerline file or section alignment (.MXS) file must be specified to define the plan view location of the 3D polylines. The elevations for the 3D polylines come from the section file. These 3D polylines can then be used by other Carlson routines to create surface models.

In the options, dialog set the range of stations to draw and the Layer Name for the 3D polylines.

The **Draw Method** has four options:

- **Cross Section:** The 3D polylines are drawn as cross-sections perpendicular to the centerline at each station.
- **Offsets By Description:** The 3D polylines are drawn parallel to the centerline by connecting section points when the same description. To use this method, the SCT file must have descriptions on the section points. For example, if the section file has descriptions for each section point then you can draw 3D polylines for EP, SHD, TIE, etc.
- **Offsets By Value:** The 3D polylines are drawn parallel to the centerline at a specified offset value.
- **Offsets By Sequence:** The 3D polylines are drawn parallel to the centerline by connecting section points by their sequence in the section file. For example, a 3D polyline will connect all the 1st section points, another 3D polyline will connect all the 2nd section points, etc. This method requires the sections to have the same number of data points for each station.
- **Water Level Profile:** This method draws two 3D polylines for the left and right banks of a waterway. The section file represents the cross sections of the waterway. The program also prompts for a profile of the water level. At each section, the program gets the water elevation at that station from the water profile and finds the offset on the section for the left and right banks.

**Description for Layer:** This option uses the section point descriptions in the layer names for the 3D polylines when using the Offsets By Description method.

**Draw perimeter of sections:** This option will connect all the left most offsets and right most offsets together with a 3D polyline.

**Alignment Method:** Chooses how to define the horizontal alignment.

**Type of Curves:** This option chooses between roadway and railroad methods for stationing along curves.
Prompts

Choose Section File to Process Select the .sct file
Sections to 3D Polylines dialog Choose your settings
Select centerline polyline: pick the polyline
Enter the centerline starting station <0.0>: press Enter
Use reference profile to interpolate between sections [<Yes>/No]? N for no. This option will prompt for a profile to use for interpolating elevations along the 3D polylines between the section stations. This improves the accuracy when the profile goes through vertical curves. Without the profile, the 3D polyline elevations will be straightline interpolated between the sections.
Draw all template ids or specific ids and offsets [All/<Specific>]? press Enter for Specific
Enter Offset or Description to draw: EP

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: scto3dp
Prerequisite: A section (.SCT) file

Sections to Points
This command creates Carlson points using a section (.SCT) file to define the point elevations. The x,y position of the points are calculated based on the station and offset along a centerline polyline. These points are stored in the current coordinate (.CRD) file and can also be plotted in the drawing. Points can be created at each station in the section file or at a set station interval. The range of stations to process can also be set. The Description Match field can be used to filter the offsets and only create points with matching descriptions (e.g. only "EOP" offsets). The Create points at fixed offsets option can be used to make points at user-specified offset distances. The program will interpolate the elevations for these points by interpolating from the neighboring offsets. The is both a Centerline by Polyline or by CL File option. The CL File option will prompt for an existing centerline (.CL) file. The Reduce Points option will skip creating points for the same offset between stations if the x,y position and elevation change is less than the offset tolerance. Essentially, when a series of offsets are on a straight line (no vertical and no horizontal curve) then only the starting and ending points are needed and all the intermediate points can be skipped.
For example, the Reduce Points routine will look at the left side EOP offset points at stations 1+00, 1+05 and 1+10 and if these three points make a straight line then the point for station 1+05 can be reduced. The Offset Distance is the tolerance that Reduce Points uses for testing whether the middle point (offset point at station 1+05) can be reduced. The distance for the middle point is calculated as the perpendicular distance from the middle point to the line between the two end points. Both the horizontal and vertical distances are checked.

Prompts

Sections to Points Settings dialog

Coordinate File to Process Choose a .CRD or other coordinate file to add the points to. This prompt only occurs if no coordinate file is current.

Choose SCT file to read pick the cross section file

Range of stations: 3.34 to 750.00

Enter the starting station to process <3.34>: press Enter

Enter the ending station to process <750.00>: press Enter

Select centerline polyline: pick the polyline that defines the stations

Type of centerline [\(<\text{Roadway}\>/\text{Railroad}\)]? RO

Enter the centerline starting station <0.0>: press Enter

Created 65 points.

Keyboard Command: sctopt

Prerequisite: A .sct file and polyline centerline

Section Report

This command generates a report of a section file for the specified stations. The information contained in the report is determined by the settings in the Section Report Options dialog box.
**Decimal Places:** Specify the display precision for stations and elevations.

**Use Row-Column Report Layout:** When checked, offsets are reported in columns. Example reports showing the difference are shown below. Also when active, there is an option to **Line-Up Columns By Center Offset** which makes the zero offset column line up. Otherwise, the columns are lined up by the left most offset.

**Use Report Formatter:** Report output is directed to the Report Formatter which allows for custom reports, as well as being able to export the report to Microsoft Excel or Access.

**Report Descriptions:** Controls whether the descriptions for each section point are reported.

**Specify User-Entered Offsets To Report:** After choosing OK from this dialog, the program will prompt for additional offsets to report with interpolated elevations. These are for offsets that don’t already exist as section points in the section file.

**Report Slopes:** Will report the slope between section points. Specify how to report the slopes, either none, percent, ratio, or auto format. Auto format means that slopes less than 10% are reported in percent, while greater slopes are reported as ratios.

**Stations to Report:** Specify either a range and interval of stations to report or enter each station one at a time.

**Station Direction:** This setting controls the order of the stations for the report.

**Grades to Report:** This applies to section files that contain subgrades. For these section files, you can choose which grades to report (top surface or subgrades). All is also an option.

**Description Match:** This field can be used to filter the section points by their description.

**Report Elevation Difference:** Reports section elevations by Reference Grade Point, Section File or Surface File. The Surface File method works with a triangulation file (TIN) and can be used to compare a 3D TIN model with the design sections.
Reference Grade Point: Specify the reference grade ID. Only available if Grade Point option is selected, as mentioned above.

Select Reference Section File: Specify a reference file. Only available if Section File is chosen, as mentioned above.

Elevation Difference at Offset Interval: Used if there is an elevation difference. The next three options only available if Elevation Difference at Offset Interval is clicked.

Offset Interval: Value required.

Left Limit/Right Limit: Values required.

Prompts

Section Report Options dialog choose options
Section File to Report dialog choose existing file
Starting station for report <0.000> press Enter
Ending station for report <1147.478> press Enter
Station interval (A for All) <100.0> press Enter

Sample Report

Pulldown Menu Location: Sections
Keyboard Command: sctrprt
Prerequisite: A section file (.sct)
Mass Haul Analysis

This command will determine the volume and haul distance for each group of net cut and net fill station ranges along a road. The program calculates the optimized cut to fill movements so that the total volume-distance moved is minimized.

You will first be prompted to select the Existing Ground section file and the Design Surface section file or on End Area (.ew) file. These files will be used to determine the Mass Haul quantities. If you do not have either of these files, you can create them using the different Create Sections commands under Roads. After you selected your section (.sct) files or (.ew) file, the following dialog will appear.

![Mass Haul Analysis dialog](image)

**Range of Stations:** The program will pick up the range of stations determined by your section files. In this field, you can modify the range of stations to process. The Settings button brings up another dialog with more station options:

![Cut/Fill Station Ranges dialog](image)

**Cut/Fill Starting/Ending Stations:** The Cut and Fill Starting and Ending Stations are for tapering the end areas at the start and end of the section range down to zero beyond the station range.

**Cut/Fill Gaps:** Use the Add and Remove buttons to define a series of station ranges for cut/fill gaps where the program will not calculate any volumes.

**Shrink/Swell Factors:** The Shrink Factor is multiplied by the fill quantities and the Swell Factor is multiplied by the cut quantities.
**Report Precision:** This setting controls the number of decimal places to use in the report.

**Use Report Formatter:** The Report Formatter will allow you to customize the information reported by the Mass Haul Analysis.

**Calculate Centroids Using Centerline:** This option will find the center offset for each Cut/Fill area and use a centerline to adjust the station interval along curve segments for the end area volumes.

**Use Rock Section For Rock Volumes:** This option will use a third section file for reporting rock cut quantities.

**Extend Shorter Sections to Longer:** This option will find your longest section and match the length of all your other sections to it.

**Interpolate Missing Section Stations:** Toggle this on to interpolate any missing stations so that the Mass Haul report can use all the stations.

**Topsoil Adjustment:** This will apply a Topsoil Removal/Replacement definition from the Template Adjustments to adjust the sections.

**Mass Diagram:** This will create a Mass Diagram of the cut/fill balance by station. This data is stored in a profile file (.pro) format file, and you can use Draw Profile to draw it.

**Mass Haul Settings**

The Haul Distance ranges are for reporting the cut to fill volume movements by the different haul distance ranges. For each range of stations with a net cut volume, the report has a row for the net fill station range the cut was moved to, the amount of cut/fill, the volumes per haul distance range, the average haul distance per range and the overall haul distance average. The In Station Volume is the amount of cut and fill that occurred at the same station and doesn’t have to be hauled to another station. The purpose is to evaluate how far the cut has to be moved, and the haul distance ranges can be used to separate the distances for different types of equipment.
The External Hauls can be used to specify the stations along the road for borrow pits or dump piles. The program will use volume from these external hauls when the cut/fill of the road does not balance.

When dealing with multiple external hauls, the program will automatically minimize earth movement based on the haul distances and the available import/export (determined by "Set Volume Limit") of each haul. "Distance" sets how far a borrow pit or dump pile is from the entry station. "Road Conditions" is a multiplier against the specified distance. For example, if road conditions are twice as poor along an 2,700ft entry road as the main road, then a "Road Conditions" of 2.0 should be used. The program will then use a distance of 5,400ft (2,700x2) for that external haul when calculating optimized movement along the road.

**Mass Haul Analysis**

Existing Section> C:\Takeoff\Drawings\demo2-og.sct
Final Section> C:\Takeoff\Drawings\demo2-fn.sct
Volumes per Range Average Haul per Range
Net Cut Net Fill Total In Sta Haul 0 200 Over 0 200 Over
Station Station Cut(CY) Import Fill(CY) Export Volume Volume Volume 200 500 500 200 500 500 Overall Avg 0+00.000 1+00.000
1+00.000 2+50.000 1251.729 0.000 1251.729 0.000 1251.729 1127.595 124.134 124.134 0.000 0.000 153.135 0.000 0.000 153.135

Chapter 12. Roads Menu
Slope Zone Section Analysis

This command reports the areas of the surface within different slope ranges. The surface is defined by a cross section file (SCT). The option to Use Another Section For Cut/Fill Reference reports the cut/fill areas and volumes within given ranges of slopes.

Prompts

Select Section to Process Select .SCT file
Select Slope Zone dialog

Report slope or horizontal area [<Horizontal>/Slope]? S
Slope format [<Percent>/Ratio]? press Enter
Greatest slope % of zone 1: 10
Greatest slope % of zone 2: press Enter
Starting station to process <0.000>: press Enter
Ending station to process <1514.567>: press Enter

The Standard Report Viewer creates a report called Section Slope Zone Analysis Report.

Section Slope Zone Analysis

Section File: C:\src\work\output.xsct
Starting Station: 0+00.000
Ending Station: 15+14.567

Slope % Area(SF) % of Total
0.0 to 10.0 78757.5 61.3
> 10.0 49617.0 38.7
Total: 128374.5

Pulldown Menu Location: Sections
Keyboard Command: sctzone
Prerequisite: .SCT file

Highway Section Staging
This command takes a design cross section and splits it into two stages for cases when the design surface will be built in stages. There are two staging methods.

The Offset method splits the design section at a specified offset with the left side as one stage and the right side as the other stage. This method applies to the situation of designing a partly completed road or regrade. For example, if a four lane road will built two lanes at a time, then the offset method can be used to split the design section with two lanes on the left side of the offset and the other two lanes on the right side. Using an existing and a final grade section file, the program will create four new sections files for the finished existing sections, finished final sections, remaining existing sections, and remaining final sections. The source existing and final section files should have matching stations. There is an option to process a range of the possible stations from the section files. The complete part of the road can be either on the left or right side. The pivot point is a cross section offset where the completed part ends. From this point, the final grade will connect to the existing grade by a line at the specified slope.

The Description method uses a specified description from the existing ground section file plus an offset from this description. Then the existing section is overlaid onto the design section for the offset zone around this description. This method applies when a portion of the existing ground stays intact when the first stage of design is built and then this remaining portion of the design is done as the second stage. For example, this applies to improving railroads where the existing track is left undisturbed while the work for the new bed is prepared. In this case, the existing section file should have a description for the offset position of the existing track centerline. Then you specify the buffer offset around this centerline. From the resulting left and right offsets, the program ties the existing section into the design at a specified slope.

Prompts
For Offset Method:
Select Existing Sections File Choose the cross sections file.
Select Final Sections File Choose the cross sections file.
Enter slope as percent grade or slope ratio [Percent/<Ratio>]? press Enter
Enter the fill slope ratio <2.0>: press Enter
Enter the cut slope ratio <2.0>: press Enter
Stage by side from offset or overlay existing at description [<Offset>/Desc]? press Enter
Place road on left or right [<Left>/Right]? press Enter
Range of stations: 50.0 to 100.0
Enter the starting station to process <50.0>: press Enter
Enter the ending station to process <100.0>: press Enter
Apply same pivot offset to all stations [Yes/<No>]? Y
Enter the pivot offset (enter left offsets as negative) <0.0>: 5.0

SCT File dialogs
Enter new .SCT file names for 1) existing road .SCT file, 2) final road .SCT file, 3) remaining existing .SCT file and 4) remaining final .SCT file.

Here is an example of the Offset method showing the original existing and design sections and then the four new sections files for the finished existing sections, finished final sections, remaining existing sections, and remaining final sections that the routine creates.

For Description Method:
Enter slopes as percent grade or slope ratio [Percent/<Ratio>]? press Enter
Enter the fill slope ratio <2.0>: press Enter
Enter the cut slope ratio <2.0>: press Enter
Stage by side from offset or overlay existing at description [<Offset>/Desc]? D for description
Existing section target description: CL
Range of stations: 100.00 to 100.00
Enter the starting station to process <100.00>: press Enter
Enter the ending station to process <100.00>: press Enter
Enter the buffer offset <0.0>: 4

Here is an example of the before and after for the Description method.

Pulldown Menu Location: Sections
Keyboard Command: scstage
Prerequisite: Existing and final grade section files (.SCT)

Calculate Section Volumes
This command will read two section files and compute the cut and fill end areas and volumes. It computes the sections volume in the order they appear in the file. If you need to sort the stations in sequential order use the Input-
Edit Section File command. Begin by selecting the base section file then the final section file. After specifying the input files the Calculate Section Volumes dialog appears. The settings can then be chosen and customized to match your reporting needs. There is an option to apply topsoil removal/replacement adjustments, as well as support for processing sections with subgrades.

**Range of Stations to Process:** Specify the range of stations to process. Separate stations with a hyphen as shown. The Settings button brings up another dialog with more station options:

**Cut/Fill Starting/Ending Sta.:** Volumes are calculated using end areas between the range of stations. Instead of cutting off the volumes exactly at this range, the Ending and Starting Stations for Cut and Fill can be used to have the volume taper from zero at the specified Starting Station to the volume at the first station in the range. Likewise, the Ending Stations can be used to taper the volume from the last station in the range to zero at the specified Ending Station.

**Cut/Fill Gaps:** Use the Add and Remove buttons to define a series of station ranges for cut/fill gaps where the program will not calculate any volumes.

**Fill Shrink/Cut Swell Factor:** Allows you to specify a value that the volume calculated will be multiplied by.

**Report Precision:** Specify the decimal precision for the report.
Use Centerline to Calculate Centroids: When checked, the program will calculate the centroids using a centerline (.CL) file. You will be prompted to select the centerline file.

Use Centerline for Station Equations: This option applies to section files with stations numbered using station equations. This option will use the station equations defined in a centerline file to remove the station equations from the section file stations for calculating the true end area distances. You will be prompted to select the centerline file.

Use Inclusion Perimeter: This option prompts for a closed polyline in plan view for the limits of volumes. Without this inclusion perimeter, volumes are calculated to the extents of the sections.

Use Report Formatter: This option allows for customized report layout and contents. Otherwise a standard report is displayed.

Report Centroids: Specify whether or not to report centroids.

Calculate Rock Volumes: When checked, you will be prompted to select a third section (.SCT) file that will be used to calculate rock quantities.

Calculate Progress Volumes: This option prompts for a third section file that represents a stage of progress between the existing and design surfaces. The includes both the total cut/fill quantities and the subset of progress cut/fill quantities. The progress volumes are limited to be within the volumes between existing ground and design in order to avoid any extra cut or fill.

![Diagram of progress volumes](image)

Calculate Elevation Zone Volumes: This option reports the amount of cut and fill for elevation zones. With this option, the program prompts for a starting station and elevation interval. Then starting at this elevation, the program calculates the amount of cut and fill between the section surfaces up to the next elevation. This elevation zone calculation is repeat until the highest elevation in the section files is reached.

Calculate Overexcavation: When checked, calculates volume of overexcavation. See diagram.

![Diagram of overexcavation](image)

Report Cut/Fill Text: Specify whether or not to report cut/fill at each station.

Report Cut/Fill Differences: Adds a running total of the cut to fill balance at each station to the report.

Report Cumulative Cut/Fill: Adds a running total of the cut/fill at each station to the report.

Extend Shorter Sections to Longer: If checked, shorter sections are lengthened to the same left and right offset extents as the corresponding longer sections.
Interpolate Missing Section Stations: If checked, the missing stations are accounted for in the calculations.

Breakout Quantities by Staging: This option breaks out the cut and fill end areas and volumes according to user defined offsets along the road. The "Slope Format" determines how each stage will tie back into the road.

In the example above, volumes will be reported separately for the left side of the road, the inside right lane (offset 0-10), the outside right lane (offset 10-20), and then the remainder right side of the road will automatically be reported as the "Last Stage".

Topsoil Adjustment File: This optional input file applies topsoil removal and replacement for the calculations. See the Topsoil Removal/Replacement command for more details on the .TOP file.


End-Area Output File: Specify an optional end-area (.EW) file for output that can be used in the Edit-Process End Area File command.

Prompts

Section File (Existing Ground) to Read choose existing .SCT file
Section File (Final Ground) to Read choose the other existing .SCT file
Calculate Sections Volume dialog Make selections.

Pulldown Menu Location: Sections
Keyboard Command: calcsct
Prerequisite: Two section (.SCT) files

Calculate End Area
This command allows the user to select two polylines representing an existing grade section and a final grade section, and calculate the end area. Or you can also specify and define cut/fill end areas by picking interior points. The area calculated can be drawn at a user specified point. Optionally, the command writes the stations cut and fill to an earthwork (.EW) file that can be printed/displayed by the Edit-Process End Area File command. This command starts with the Calculate End Area dialog.
**Horizontal Scale:** Specify the horizontal scale of the existing cross section.

**Vertical Scale:** Specify the vertical scale of the existing cross section.

**Station Interval:** Only available if Write Results to EW File is toggled on. Allows you to specify the station interval that the station prompting will default to as you select the polyline/sections for computation.

**Extend Shorter Ends to Longer:** Click or leave blank.

**Calculate Unsuitable Areas:** When checked, the user will be prompted for polyline(s) or interior point(s) that represent unsuitable material. The areas and/or volumes for the unsuitable material is reported out separately from the overall cut and fill areas and/or volumes for overexcavation consideration.

**Define end areas by** chooses between picking two polylines or picking inside each end area.

**Text Scale:** Specify the text size scaler, this value is multiplied by the horizontal scale to determine the final text height.

**Decimal Places:** Controls the decimals for the cut/fill area labels.

**Cut/Fill Prefix/Suffix:** Specify prefix and suffix for the cut, fill, and unsuitable labels.

**Label Layer:** Specify the layer for the cut/fill area labels.

**Write Results to EW File:** When checked, the results will be written to an earthwork (.EW) file. You may create a new file or choose to append/revise an existing file.

**Prompts**

**Calculate End Area dialog** make choices

**Specify Earthworks File (ew) dialog** specify new or existing file This box appears if Write Results to EW File is clicked.

**Select existing grade polyline (ENTER to end):** select polyline

**Select final grade polyline:** select polyline

**Calculating End Area...**

**Cut:** 12002.965 **Fill:** 660.272

**Pick Point for Label (Enter for none):** pick point
Enter the station <0.00> press Enter Pressing Enter selects the default station 0+00. If the station does not exist in the file it will be added. If it does it will be revised.

Select existing polyline: press Enter

Continue moving along automatically to the next station interval and select polylines. Or enter the station values randomly. The command sorts the .EW file regardless. As a result of this sort feature, the user can select stations in any order and they will be arranged in ascending order for proper volume computation.

Keyboard Command: endarea
Prerequisite: Plot the existing grade and final grade polyline/section

**Edit Process End Area File**

This command opens an End Area (.EW) file for editing and processing. Data can be entered directly into the spreadsheet. The Calculate Section Volumes command has an option to create an .EW file. The accumulative volume is displayed in the right side column of the spreadsheet. The Report function outputs a report of the stations, intervals, cut and fill. The Make Mass Haul Diagram function makes a .MAS file that can be used by the Draw Mass Diagram and Mass Diagram Report commands. The Use Centerline for Station Equations option applies to end area data with stations numbered using station equations. This option will use the station equations defined in a centerline file to remove the station equations from the end area stations for calculating the true distances for the volume calculations. You will be prompted to select the centerline file.

Pulldown Menu Location: Sections

Keyboard Command: ewedit
Prerequisite: None

**Input-Edit Section File**

This program can be used to enter or edit data stored in a section file (.SCT file), including a real-time graphic window in the Edit mode. The section data consists of stations, offsets, elevations and descriptions. This command also has utilities for translating the offsets and elevations, deleting stations from the file, intersecting the outslopes of one section file with another, combining multiple occurrences of the same station and sorting the stations, offsets and elevations.

While editing the section file, a second section file can be used as reference. To choose this file, pick the Reference Section button. For example, when editing the proposed section file, you can reference and view the ground section file as the second file. Besides showing the reference section in the graphic preview, the program also reports the end areas while editing a section station. Also, the reference section can be used to tie to the catch point. Another option is to set a Reference CL which is used to adjust the stations when the CL has station equations.

The program begins by prompting for a New or Existing section .SCT file to process. The Section file to process dialog appears, allowing you to specify the file that you want to operate on. Use the New option to create a new file. Use the Existing option to edit the offsets and elevations for station/sections that you have already created, or append new stations to a file. The program defaults to a section file with the same name as the drawing or a name that you specified using another section command. You also can choose a 2nd existing .SCT file to reference. After specifying the file name(s), the program displays any stations currently in the file, in the Stations List of the Input-Edit Section File dialog box.

Alternately, when sections are drawn in the drawing, you can double-click on a section polyline to launch Input-Edit Section File for the .SCT file associated with the section polyline.

If you specified a new file, the Stations List box will be blank. To edit and display the offset and elevation data at a station, you can double click on the station in the Stations List box, or input the station in the Station to Edit edit box at the bottom of the dialog. To add a station to a new file or existing file, you must enter the station in the Station to Edit edit box. Stations will present in accordance with the Section-Profile settings in Configure under the Settings pulldown menu (eg. 10+00, 1+000, 1000).
Edit: Opens the Edit Station dialog which shows a graphic of the section on top, a list of the offset-elevation points in the middle, and the function buttons on the bottom. To add an offset point, type in the offset, elevation and optional description in the spreadsheet. Left offsets are entered as negative numbers. You can enter the slope or ratio from the last point and the program will calculate the elevation. To edit an offset point, highlight the point from the list and then edit the values in the Offset, Elev and Desc columns. The highlighted point will be marked by an X in the graphic screen. The Sort button will sort the list of offsets from lowest to highest, left to right. It is recommended that you Sort offsets before doing the Tie command, so that the left-most and right-most offsets appear first and last in the offset list. The Up button will move the highlighted offset point up in the list. Likewise the Down button moves the highlighted offset point down in the list. Prev (F2) and Next (F3) buttons move through the stations and allow you to review and edit stations in forward or reverse order. The scroll bar can also be used to quickly move through stations and then zero in with Prev (F2) or Next (F3). When you edit a slope value in the spreadsheet, then the Slope Updates setting controls which elevation value to update for the section segment. The section data can be edited directly in the spreadsheet or graphically by picking the Edit Point button with the pencil icon. To edit graphically, use the click-n-drag method. Start by picking the Edit Point button and then pick the section point to edit in the graphic preview and hold the mouse button down and then drag the mouse to the new position and then release the mouse button. The Edit Mode setting governs the click-n-drag operation. The Free mode allows the section point to be moved anywhere. There Hold Slope modes maintain the slope and moves the point along these slopes. The Hold Offset allows changing the section point elevation only. The Hold Elevation allows changing the point offset only.

When a Reference Section is set in the main dialog, the Edit Station spreadsheet has a column for Depth. This Depth is the elevation different to the reference section. You can edit the depths to change the elevations for the section.
The Add Row button inserts an offset line above the currently highlighted row. The Remove Row button erases the highlighted offset and elevation from the list. After inputting or editing press the OK button to return to the Stations List dialog and keep any changes you have made. Select the Cancel button if you want to cancel changes made to the current station. Extend Pavement/Subgrade will allow you move a surface point and shift, in parallel, the associated subgrades and tie points. One application, shown below, is to extend a shoulder point and re-compute the TIE point, all in one clean operation:

Another application of Extend Pavement/Subgrade is to move the curb position and all associated subgrades. The "inside" curb point is at 12.00 units from centerline. If the pavement is extended from 12 to 15 at this station, use of this feature will extend the subgrades, maintain all slopes and re-compute the TIE point, as shown below:
A real-time report of offset-elevation-slope now displays in the top of the graphic as you move the cursor across the section in the graphic window. The screen defaults to zoom mode where holding down the right-mouse button zooms in and out. You can also switch to pan mode. There are buttons for zoom extents, zoom in and zoom out. If your mouse has a scroll button, you can hold it down to pan and scroll it to zoom in and out. You can also set the Vertical Exaggeration ranging from 1X to 10X and including "Fit". Show subgrades has the ability to tie a subgrade into the surface. Grid Ticks Only just shows the left and bottom axis lines of the grid with grid tick marks along the axes. With Auto Zoom All turned off, you can hold the same view position as you click Next and Previous and move through the list of stations. The Check Offset field calculates an elevation based on an entered offset.

**Drive (Edit Station):** This function scrolls through the sections at the rate of speed specified by the user in the Speed window. The Drive View options determine whether the sections are displayed using the full width of the graphic window or centered in the window. The combination of Full Grid Range and Auto Zoom All allows the sections to rise and fall with the centerline elevations, as if you were driving an actual road. With Auto Zoom All off, and Full Grid Range on, the grid itself moves up and down at the current position of the first section, as you drive. Focus View On Offset Range allows the user to set the left and right viewing limits of the sections. Section data beyond the specified limits is not displayed.

**Elevation Field (Edit Station):** Equations (+, -, *, /) can be entered to calculate or adjust an elevation. For instance, to subtract 1.25' from elevation 1926.18, simply enter 1926.18-1.25 and press enter. The new elevation will be...
calculated and displayed in the viewer window.

**Tie (Edit Station):** The Tie button allows you to tie the left and right surface points of the 1st section file into the 2nd section file. It is used for classic outslope intersects from final grade to existing grade. The dialog layout includes an option to tie the section to a specified elevation, in addition to a surface (second section file). A left or right tie direction can also be selected. If a point has been tied in from SH for shoulder at offset -20 at 3:1, a new offset with the description "TIE" is created. If you try another outslope such as 4:1 from the same SH shoulder point, a new "TIE" point is created and the old TIE point is removed automatically.

![Tie Offset dialog](image)

**Lock:** This function will tag the section file as locked so that no routine can automatically overwrite this file. If a routine attempts to overwrite this section file, the program will stop, report that the file is locked and prompt whether to override the lock.

**Translate:** Allows you to add or subtract a distance from the offsets to adjust or shift the centerline. You can also adjust the elevations up or down. When using this option, you can choose the range of stations to operate on (starting and ending stations) and the values to adjust the offsets and elevations. If, for example, you want to shift the centerline, but not the elevations, enter the plus or minus amount you want to translate, and when prompted for the elevation enter zero. The Station Equation function removes the station equation adjustments to the station values in order to set the station values to the true centerline distances. To use the Station Equation function, a Reference CL must be set on the main dialog.
Scale: Allows you to scale the station, offsets and/or elevations by the specified scale factor. This function can be used to convert between English and metric units.

Delete: Allows you to remove a station or range of stations from the Stations List. You can delete a range of stations or an individual station. Also there are options to delete all the data for the selected stations or filter to delete only data that is outside an offset or elevation range. Since the station editor data is stored in memory, if you accidentally delete a range, Quit the editor without saving the stations to disk. Then recall the original file.

Reduce: Allows you to remove offsets from a range of stations by removing vertices in the offsets that are virtually in a straight line. Using an offset cutoff, meaning no offset and elevation moves more than the entered amount (eg. 0.01), excessive numbers of vertices can be eliminated. The command is similar to Reduce Vertices when applied to the plan view.
Sort: Allows you to sort the station numbers into ascending order, and sort the offsets and elevations in the individual station records (offsets are sorted from left to right). When sections are derived from the Sections from Surface Entities command they are already sorted, but when sections are digitized or input manually they occur in the order that you digitized them. So, for proper plotting and earthworks, you may want to run the Sort option before processing.

Combine Stations: Used to bring together in one record slot multiple occurrences of the same station number. This can occur when using the Digitize Sections (XSec) command and the section that you are digitizing has match/break lines which forces you to digitize the station in two or more parts.

Interpolate: Allows you to add or overwrite a station between two stations or projecting forward from two stations. You can choose to interpolate a single station or an interval of stations. Specify the two known stations in the Start Station and End Station edit boxes, as well as the interval if using the interval method. The program will do straight line, mathematical interpolations, adding offsets to the interpolated stations to match the totality of offsets in the starting and ending stations. However, if the offsets have descriptions, you can choose to interpolate by description and the program will interpolate by description (eg. EP at 12 on Station 1100 and EP at 15 at station 1150 would lead to EP at 12.6 at 1110). There is also an option to reference a profile, so if station 1100 and 1150 were on either side of a high point at 1125, the interpolated offsets would respect the profile as well as the starting and ending station. Use of this command is often critical to creating accurate digital terrain models of sites for machine control. Select the OK button to execute the function with the current settings or select the Cancel button to abort the process.
Copy Station: Allows you to copy a station that already exists to a new or existing station number. Choose the existing From Station using the edit pulldown box, then enter the new station number in the To Station edit box. Select the OK button to execute the function with the current settings, or select the Cancel button to abort the process.

Rename Station: Allows you to change the value of a station. In the dialog, select the existing station from the list and enter in the new station value.

Tie Station: Allows you to tie the outslopes into the reference second section file. This routine first brings up a dialog to specify the range of stations to process. It includes a line to set the slope to tie with. The program will start from the left most offset and use this slope to find the intersection with the reference section file. Then the intersection from the right most offset is calculated with this slope. These intersection points are the tie points. The slope can be defined by percent, ratio, continue the last slope, and vertical.

Add Subgrades: Adds subgrades to the sections with specified depths and offsets. You can add multiple subgrades at a time by filling in the spreadsheet. Each row of the spreadsheet is for a separate subgrade. Each subgrade definition takes a description, left and right offsets, depth and intersection method of either straight up or at a specified slope. The subgrades are added by referencing the existing surface elevation and dropping down the specified depth. The center of the subgrade always drops down vertically. The outside of the subgrade ties in by the specified intersection method. The station range to add the subgrades can be the same of all the subgrades or
specified separately for each subgrade.

**Save:** Saves the currently loaded section file.

**SaveAs:** Allows you to save the currently loaded section file as a different file.

**Exit:** Allows you to exit from the section editor and return to the drawing editor. The program will warn you to save to a file if you have made changes.

**Pull-down Menu Location:** Sections

**Keyboard Command:** scted

**Prerequisite:** None

## Draw Section File

This command generates plots of cross-section data which can be used to further iterate the corridor design or used for construction documentation. The Section files drawn with this command can be created by several methods including the Input-Edit Section File, Digitize Sections, any commands under the Create Sections from... menu, Process Road Design or Road Network commands.

For metric-based projects, please refer to the Drawing Metric Section Sheets section of this document.

The Draw Section File routine will call two primary dialog boxes:

- The first is the Section Files for Drawing dialog box that allows you to specify the Section files (.sct) to be drawn and some general sheet and layer settings.
- The second is the Draw Section File dialog box that allows you to specify various scale, layout and labeling settings.

If the *Type of Plot* option in the Draw Section File dialog box is set to "Sheet," a third Section File Sheet Drafting Parameters dialog will be displayed which provides detailed sheet layout settings.
Add: Specify an unlimited number of Section (.sct) files to plot

Add Multiple: Add multiple files to plot with a single selection

Remove: Highlight and remove any section file from the selection set

Clear: Clear the selection set (remove all files).

Open Set: Open a preset selection of cross sections (.XST file)

Save Set: Save the current selection set as an .XST file

After specifying the Section Files (.sct) the Draw Section File dialog box opens:
**Horizontal Scale:** Specify the horizontal scale.

**Vertical Scale:** Specify the vertical scale. The vertical scale relative to the horizontal scale determines the vertical exaggeration factor.

**Link Sections to Files:** This setting controls the linkage of the plotted sections to the actual section (.sct) file(s), determining how changes to the file affect the plotted sections.

**Type of Plot:** Specify the type of Plot you wish to create.

- **Vertical Stack:** Stacks all the cross sections in a vertical row or rows. The cross sections will be drawn in model space and will automatically stack with regard to the parameters set.
- **Pick Location:** allows the user to manually select a location in model space for each individual section.
- **Sheets:** draws the cross sections in either model space or paper space with regard to the settings in the Section File Sheet Drafting Parameters dialog box. When you pick OK on this main dialog, the Sheet Drafting Parameters dialog box appears allowing you to specify all the settings for sheet plotting.

**Section File Sheet Drafting Parameters**

![Image of Section File Sheet Drafting Parameters dialog box]

**Choose Space:** Indicate whether sheets are to be drawn to **Paper** Space (also known as a Layout) or to **Model** Space. When drawing to Model Space, the Display In Paper Space option will draw the sections in model space and then create layouts with viewports to show the sections.

**Layout Name:** Indicate the name of the layout to which the first sheet should be drawn.

**Use Template Layout:** This option allows you to use a layout that exists in the current drawing as the template for layouts created by the command. This option only works for paper space sheet creation.

**Add Layout Name To File For Drawing Output:** When the Output To Separate Drawing option is active from the
main settings dialog, this option creates separate drawing files for each sheet by appending the layout name to the
drawing name.

**Tile Sheets:** Enabling this option places all sheets in the specified Layout Name. The result is a vertical stack of
sheets in the layout. Disabling this option allows additional layouts to be created each containing one sheet. As
additional layouts are created, the name of each successive layout is incremented by a value of 1.

**Plot at 1:1:** Enabling this option draws the sections so that one unit horizontally in the section is equivalent to one
plotted unit. The ratio of the Horizontal Scale:Vertical Scale determines the amount of vertical exaggeration.

**Block Name:** Specify the drawing name that will be inserted for each sheet. The default is SCTSHT1 which is
included with Carlson Software and is located in the %AppData%\Carlson Software\Sup\ folder. You can use
this or use a sheet block of your own design. The block should be drawn at a 1:1 scale since the program inserts
it using the Horizontal Scale setting from the previous dialog. Click the **Set** button to browse/navigate to an alternate
drawing file.

**Set Sheet Attributes:** For grid sheet block names that utilize attributes (useful for items such as sheet numbers,
drawn date, drawn by, job name, etc), use this command to provide attribute values that will be placed for each sheet
block:

![Set Sheet Attributes](image)

**Find Sheet Attributes:** This routine will scan the Block Name for any attribute definitions and return them to the
dialog box so values can be established for each attribute.

**Starting Page #:** Indicate the starting page number to be applied to the plots through the use of the **Set Sheet
Attributes** command.

**Scan Block for Width/Height:** Use this routine to scan the specified Block Name for its width and height. These
values are populated into the Sheet Width and Sheet Height controls.

**Sheet Grid Interval:** Indicate the spacing between the grid lines in the sheet block. The routine will not draw the
grid lines and uses this information to control the placement of each section onto the sheet.

**Vertical Space Between Sheets:** Indicate the amount of space that should be placed between sheets when the Tile
Sheets option is enabled.

**Rows of Sections**

**Per Sheet:** Specify the maximum number of sections that can be stacked on top of each other on a sheet.

**Space Between:** Specify how much space will be placed between the top of the last section plotted and the bottom
of the next section. For U.S. Customary based units, a value of 1 would be a good starting value.

**Columns of Sections**

**Per Sheet:** Specify how many columns of sections can be placed on each sheet.

**Space Between:** Specify the distance between the left edge of one section column edge and the right edge of the
next column. This will generally be the area where elevation labels and station circle annotation will be placed. For
U.S. Customary based units, a value of 2 would be a good starting value.

**Label Grid Zero Offset:** Enable this toggle if the zero offset location of each section should be labeled on each
section.

**Column Order:** Controls the station order of the sections for going top to bottom, or bottom to top.
Offset for 1st Section

**Horizontal Offset:** Specify how far from left edge of the sheet the first section will be placed on to the section sheet. The block SCTSHT1 has a 1” left margin.

**Vertical Offset:** Specify how far from bottom edge of the sheet the first section will be placed on to the section sheet. The block SCTSHT1 has a 1/2” bottom margin.

**Preview:** This button allows you to get an approximate idea of what the initial sheet will look like based on the current settings.

**Back:** This button allows you to return focus to the main dialog and make changes to any previous settings or cancel the routine.

**Save Settings:** This button allows you to save all the parameters settings to a file so you can easily recall them for another project.

- **Off:** A linkage between the SCT file and the graphical section entities is not formed; you will need to manually re-create section sheets after section design changes.
- **Prompt:** You will be asked whether or not to update the plotted sections when the underlying SCT file is changed.
- **Auto:** The plotted sections will automatically update when the underlying SCT file changes.

**Fit Each Vertical Grid:** When checked, the grid bottom elevation and grid height are set automatically and you may specify values to add to the top and bottom of each grid (see Vertical Grid Adder to Top and Vertical Grid Adder to Bottom). When not checked, you specify the elevation of the grid bottom and the grid height through the Grid Bottom Elevation and Grid Vertical Height controls, respectively.

**Output to Separate Drawing:** When checked, this option will prompt for a New drawing name and location into which all cross sections will be drawn. When using the Vertical Stack method, the program will prompt for whether to output all the sections to the same drawing or create a separate drawing for each station.

**Draw Reverse Order:** When checked, this option will draw the cross sections in the order of the highest numbered station to the lowest.

**Scan File to Set Defaults:** This button allows the program to set the minimum and maximum parameters. If you choose this option, the program will automatically set the range of stations, vertical spacing distance, right and left grid distances and starting/datum elevation. This option writes a file called "sectsort.tmp" that is read and used to set the defaults the next time you use the program. Therefore, if you are selecting a different .SCT file to plot you should use this option to update the .TMP file.

**Stations to Draw:** Select eight All or Selected to specify the range of stations from the file which will be drawn.

- **All:** When selected the program will draw all of the stations in the file.
- **Selected:** This option will allow the user to specify exactly which stations will be drawn via the Set dialog box.
Interval: Specify the interval of stations to draw. For example, perhaps you sampled every 25 feet with the Sections from Surface Model command for more accurate quantities but only want to plot 50 foot stations. ALL is the default value for this field.

Range: Specify a range of stations to include

**Vertical Grid Adder to Top:** Specify the distance that will be added to the highest elevation of the section for the sheets and pick location options. This option is only available when Fit Each Vertical Grid is checked ON.

**Vertical Grid Adder to Bottom:** Specify the distance that will be subtracted from the lowest elevation of the section for the sheets and pick location options. This option is only available when Fit Each Vertical Grid is checked ON.

**Grid Bottom Elevation:** Specify actual bottom elevation for each section grid. This option is only available when Fit Each Vertical Grid is checked OFF.

**Vertical Grid Height:** Specify actual grid height for each section grid. This option is only available when Fit Each Vertical Grid is checked OFF.

**Space Between Grids:** Specify the Horizontal and Vertical distance between the sections when they are drawn when the Vertical Stack option is specified.

**Maximum Sections Per Column:** Sets the maximum number of sections allowed per column when the Vertical Stack option is specified.

**Symbol Size Scaler for Section Pts:** Sets the scale as a multiplier of the overall drawing scale for the section points to be drawn.

**Label Reference Offsets:** When enabled, the offset from selected break points of one section file relative to the position(s) of selected points from another section file can be labeled onto the plots.

Specify which section(s) to draw
**Set:** Opens the dialog box for to set the display precision, text size scaler, layer, text style, color, prefix, suffix, position and draw order for these labels.

![Label Reference Offsets dialog box]

**From Break Points:** allows a user based filter to specify break points

**To Reference Points:** allows the user to control which offsets to label by specifying the reference points from a template (TPL) file.

**Label Right of Way:** When enabled, this option will label Right of Way points as defined using the Section Points from Right of Way command. Press the **Set** button to the right of this toggle to set the text size and label offset scalers, layer and text style settings.

![Right-of-Way Label Settings dialog box]

**Draw Vertical Line:** Places a vertical line, from top to bottom, through the Right-of-Way point.

**Draw Leader/Draw Arrow Symbol:** When enabled, a short vertical line is drawn, with or without, the arrowhead through the Right-of-Way point.

**Label Position:** Indicate the desired orientation of the "ROW" text label.
**Label Elev at Zero Offset:** Will label the section elevation at offset zero.

Specify which section(s) to draw

**Vertical Offset from:** sets the location of the Label relative to the grid or section.

**Vertical Offset:** controls the offset distance for the label.

**Set:** opens the dialog box for to set the display precision, text size scaler, prefix, suffix, color and layer for these labels. The Draw Leader option can be set to None, Diagonal or Vertical.

**Label Break Pt Offsets:** Select the Section(s) to be included in the labeling parameters

**Set:** Opens the dialog box for to set the display precision, text size scaler, layer, text style, color, prefix, suffix, and position for these labels. In addition the label position and draw order can be selected.
Label Break Pt Elevations: Select the Section(s) to be included in the labeling parameters.

Set: Opens the dialog box to set display precision, text size scaler, Layer, style, color, prefix, suffix, position and draw order for these labels. The Description Match is a way to filter which section points to label. There are also options to toggle whether or not to place labels at the break offsets or Beginning and ending offsets.
**Label Break Pt Descriptions:** Select the Section(s) to be included in the labeling parameters.

**Set:** opens the dialog box to set the text size scaler, layer, style, color, prefix, suffix, position and draw order for these labels. The Description Match is a way to filter which section points to label.
**Label Slopes:** Select the Section(s) to be included in the labeling parameters.

![Label Slopes dialog box]

**Set:** Opens the dialog box to set the text size scaler, layer, style and color for these labels.

![Label Slopes dialog box with detailed settings]

**Label Symbol:** places the % symbol after the slope label

**Label Arrow:** draws a slope direction arrow next to the label.

**Label Minus Sign:** places a - in front of negative slope values.

**Label Below:** places the label below the section line.

**Label Format:** controls which format the slopes will be labeled in.

**Ration Format:** Sets either horizontal to vertical or vertical to horizontal format

**Slope suffix (Percent):** creates a suffix to the slope label when using the Percent Label Format.

**Slope suffix (Ratio):** creates a suffix to the slope label when using the Ratio Label Format.

**Slope suffix (Degree):** creates a suffix to the slope label when using the Degree Label Format.

**Minimum Horizontal Distance to Label:** sets the minimum value of a segment length to label.

**Slope Direction:** can either be set left to right or right to left.

**Label From:** specifies the portions of the section to label a slope. for example, you could specify to only label the
slope between the SW (sidewalk) and SH (shoulder) ID points as defined in the Template file (.tpl) that was used to generate your Section file (.sct).

**Label Distances:** This option labels the horizontal distances between offset points. There are separate Label Distances settings for each section file. On the first dialog, toggle which section file you want to label distances. Choose the Set button to control the settings for that station. The settings dialog has settings for the distance label size, layer, style, color, decimals and suffix. The **Description Match** is a way to control which section offset points to label. The **Min Horizontal Distance To Label** setting is a way to filter out short section segments and only label the longer segments. The **Label Format** sets whether to label the distances as a CAD dimension or as regular text rotated by the section slope or horizontal. The **Dimension Offset** controls the vertical distance between the section segment and the label.

![Label Distances dialog box]

**Label End Areas:** Will label cut and fill end areas on each section. This dialog box sets the Decimal Precision, text size scaler, layer, style and color of the labels.
**Use Table:** option will create a table of the cut/fill values on each section.

**Cut and Fill label prefix and suffix:** allows user defined prefix and suffix added to the label

**Include elevation:** when enabled, this option will include the centerline elevations in the table. The Ground and Final Headers are user defined

**Auto-Center On Section:** this option will center the table or label next to the drawn cross section.

**Skip Zero Labels:** this option will not label cut or fill values of zero.

**Offset Horizontal and Vertical:** manually controls the placement of the table or label.

**Vertical offset from:** specifies where the offset dimensions are to be referenced to.

**Label Volumes:** Will label cut and fill volumes on each section. The volumes are measured between the current station and previous station. There are settings to control the format and placement of the labels. This dialog box sets the Decimal Precision, text size scaler, layer, style and color of the labels.
Use Table: option will create a table of the cut/fill values on each section.
Cut and Fill label prefix and suffix: allows user defined prefix and suffix added to the label.
Include elevation: when enabled, this option will include the centerline elevations in the table. The Ground and Final Headers are user defined.
Auto-Center On Section: this option will center the table or label next to the drawn cross section.
Offset Horizontal and Vertical: manually controls the placement of the table or label.
Vertical offset from: specifies where the offset dimensions are to be referenced to.
Label Running total Volumes: will label the accumulative total volumes with each station.
Use all the section stations: chooses between using all the section stations to calculate volumes or only the stations being drawn.

Hatch Subgrades: This option hatches the subgrade areas of design section using the section points with descriptions starting with SUBGRADE. There are settings for up to four different hatch patterns.

Hatch End Areas: This option hatches the cut/fill areas between the first and second section files. The program treats the first section as existing and the second as design for determining cut verses fill. There are separate hatch pattern, color and scale settings for cut and fill.
Draw Break Pt Leader: Enable this option to include a leader with the Label Break Pt Offsets, Label Break Pt Elevations or Label Break Pt Descriptions options. Click the Set button to specify the desired layer for the leader.

Note:

- When redrawing sections, the program retains any custom edits to label and leader positions.

Draw Break Pt Symbol: Enable this option to include a symbol with the Label Break Pt Offsets, Label Break Pt Elevations or Label Break Pt Descriptions options. Click the Set button (to the immediate right of the Layer control) to specify the desired layer for the symbol. Click the Set button (to the immediate right of the Symbol control) to specify the desired symbol and indicated the desired Size Scalar.

Break Pt Label Offset: Indicate the desired offset amount from the surface break point to its label.

Draw Grid: When enabled each cross section is drawn on a grid. The Grid Setup is used to customize how the grid will be drawn.
Main Grid Lines: Sets the Layer, Linetype and Color for the Major Grid Lines as set below
Intermediate Grid Lines: Sets the Layer, Linetype and Color for the Intermediate Grid Lines. (Those not defined as major)

Elevation Text: this section contains controls for setting the elevation Precision, text Size Scaler, Offset Scaler, Layer, text Style, and color, prefix and suffix for the elevation labels.
Offset Text: this section contains controls for setting the offset Precision, text Size Scaler, Offset Scaler, Layer, text Style, and color, prefix and suffix for the offset labels.
Label Elevations Left Side Only: when enabled, elevations will be labeled on the left side of the sections only.
Vertical Justification: this sets the justification of the elevation text.
Place Label Offsets: Top will place the labels at the top of the grid, Bottom will place along the bottom of the grid and None skips drawing the offset labels.

Grid Spacing: sets the horizontal and vertical spacing for the grid lines as well as the horizontal and vertical Major Grid lines the offset text (grid spacing) and the elevation text.
Label Scale: when enabled will label the horizontal and vertical scale.
Grid Style: sets the type of grid lines to be drawn. Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks, Text Only or Grid Lines and Dots.
Draw Elevation Bar: places the elevations on a bar offset from the grid at a user defined location.
Label Vertical Axis: draws a label vertically along the vertical axis.

The Station Settings button displays another dialog box for the station label settings including decimal places, size, layer, style, color, prefix, suffix, format type and position. The Circle Station option will draw a circle around the station label.
**Draw Horizontal Label Box:** Enabling this option will draw a table with desired labeling above or below each cross-section. By picking the Set button to the right, you can choose the data to be placed in the table. The Elevation, Offset and Description of each point on the cross section can be added to the table. If more than one Section file (.sct) is being drawn on the cross-section, you will also have the option of displaying the elevation difference between sections.

**Box Placement:** Chooses between drawing the label box above or below the section grid.

**Draw Vertical Line:** Sets drawing a vertical line from the section data point to the specified row in horizontal label box.

**Title Box Width:** Sets the size for the field name in the label box.

**Offset From Grid:** Controls the separation distance between the section grid and the label box.

**Overlap Transition Distance:** When drawing vertical lines and the labels are shifted to prevent overlap, this setting controls the length of the line for shifting over.

**Label Elevation at Interval of Top Section:** When labeling multiple values such as elevations for different sections, this option uses the stations from the section points of the top section as the stations to label for all the sections.
In the *Draw Horizontal Label Box* dialog, select from the *Available Fields* in the list on the left to populate the list of *Used Fields* on the right side. Once an item has been moved to the list of *Used Fields*, you can double-click on the Field to change settings and format for each Field. An example of the *Elevation Difference* option is shown below:

The *Row Title* for each field can be edited from the default to show a descriptive title. The *DZ* value in the Elevation Difference settings dialog allows you to specify which Section's elevations are to be subtracted from the other. This setting is critical to return the correct cut and fill depth values. In all field settings boxes, you have the ability to skip surface points in order to make the data more legible.

**Place Labels at Interval:** This option creates labels at the specified offset interval.
**Place Labels at Break Offsets:** This option creates labels at each section point.

**Skip Subgrades:** Enable this option to skip all subgrades as may have been defined in Design Template files (.tpl).

**Skip Points:** Enable this option to skip points in the Section file (.sct) that were created using any of the **Create Section Points**... commands.

**Skip Overlaps:** Enabling this option will cause any overlapping text in the table to be skipped. Having this option enabled will disable the Shift Overlaps option.

**Shift Overlaps:** Enabling this option will shift any text in the table to the right so that it does not overlap preceding text.

A sample cross-section with **Horizontal Label Box** is shown below:

![Crossing Pipe Label Setup]

### Crossing Pipe Label Setup

![Crossing Pipe Label Setup Table]

**EG : Elevation**

<table>
<thead>
<tr>
<th></th>
<th>284.32</th>
<th>285.42</th>
<th>285.48</th>
<th>285.08</th>
<th>284.70</th>
<th>284.42</th>
<th>283.37</th>
<th>283.07</th>
<th>282.70</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>284.30</td>
<td>285.78</td>
<td>286.61</td>
<td>285.29</td>
<td>284.24</td>
<td>284.45</td>
<td>285.51</td>
<td>286.66</td>
<td>287.30</td>
</tr>
<tr>
<td></td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
<td>100.30</td>
</tr>
</tbody>
</table>

---

*Chapter 12. Roads Menu* 496
Pipe Symbol: Choose whether to show the Pipe Crossing symbol as a circle or a square. When the sections are drawn with vertical exaggeration by different horizontal and vertical scales, then the circles or squares will be stretched into ellipses or rectangles.

Text Style and Text Scaler: Specify the text style and size of Pipe Crossing labels.

Position: Chooses between creating horizontal or vertical labels.

Label Offset, Label Elevation, Label Pipe Size, Label Pipe Name, Label Pipe Material: Enable any or all of these options to label the distance left or right off the alignment (Label Offset), the invert elevation, pipe size and pipe name of each crossing pipe. Use the optional settings for specifying "Prefix" or "Suffix" text and use Decimals to set precision for each label.

Show Pipe Thickness draws the pipe thickness around the crossing symbols using the specified hatch.

Draw Pipe Crossings on-the-fly: Enable this option to have Crossing Pipes that have been created using a Sewer Network file (.sew) or Draw Pipe 3D Polyline command drawn in cross sections. It is not necessary to enable this option if Pipe Crossings have been saved to a Section file (.sct) using the Section Points from Pipes command.

Check Sewer/Utility Files Associated to Current Drawing: This option looks for crossings with the pipes in .sew and .util files for the current drawing. To review and edit which files are in the current drawing, use the File > Drawing Explorer command. The program will show a list of files to choose from for checking.

Alignment: Pick this button to select either a Centerline file (.cl) or Section Alignment file (.mxs) to scan for Crossing Pipes.

Layer and Color: These settings specify the layer and color of the Pipe Crossing symbol.

Prompts
If the Pick Location option was specified, the program scans the station data and determines the minimum and maximum elevations, and proposes a datum elevation. If you have pre-plotted a grid sheet and want to reference another local grid coordinate, then change the datum elevation appropriately. The Pick Location type of plotting has the following prompts:

Station > 25.000 Min Elev > 1055.301 Max Elev > 1057.068
Change datum elev/<Select point that represents 0 offset elev 1050.0>: Pick a point
Station > 50.000 Min Elev > 1055.557 Max Elev > 1057.324
Change datum elev/<Select point that represents 0 offset elev 1050.0>: Pick a point

The program continues to prompt until the last station in the range specified is drawn. You can use the Cancel function (the Esc key) to stop plotting, if necessary.

If the Sheets option was specified with Model space as the destination, you can choose where to insert the sheet(s):

Select Starting Point for Row of Sheets <0.0,0.0>: Pick a point or press Enter to accept the default value specified

Sheet Sample

**Drawing Metric Section Sheets**

First, be sure that you are set to metric mode in Drawing Setup under the Settings menu. For our example, assume a 1:1000 horizontal scale. Once set, issue the Draw Section File command and click OK to reach the second dialog. There is a different block name for metric sections called schsht2.dwg which is located in the %AppData%\Carlson Software\...\Sup\ folder. Begin by setting the parameters for the second dialog as shown.
Second dialog with metric settings

Adjust settings as needed to achieve the desired look/layout.

**Pulldown Menu Location(s):** Civil > Sections, Field > Roads

**Keyboard Command:** drawsct

**Prerequisite:** A Section (.sct) file
Design Template

This command creates a template definition file (.TPL file) used primarily for modeling roadway, railway and other types of corridor designs.

Template files can then be applied through a variety of commands including (but not necessarily limited to):

- Process Road Design
- Road Network
- Draw Typical Template
- Locate Template Points
- Design Pad Template
- Draw Field-to-Finish

In the lower portion of the dialog box are four "list boxes" that list the elements of the template. The Surface elements are listed in order starting from the center of the template moving outward. The Subgrades are listed from top to bottom order. To add a template element, highlight the position in the list above where to insert the element. There is no limit to the number of Surface or Subgrade elements. The following types of objects can be utilized to create a template:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grades</td>
<td>Typically, linear segments that defined paved surfaces such as roadway pavement, sidewalks and other linear surfaces that are &quot;exposed to daylight.&quot;</td>
</tr>
<tr>
<td>Curb</td>
<td>Typically, &quot;formed&quot; shapes that help control storm-water run-off.</td>
</tr>
<tr>
<td>Median</td>
<td>Typically, &quot;free-form&quot; features such as &quot;roll-over&quot; medians or other types of traffic barricades.</td>
</tr>
</tbody>
</table>
Subgrade - Subsurface material(s) that are used to derive "pavement" volumes (e.g. bituminous asphalt, aggregate base course, etc.

Superelevation (Super) - Parameters that indicate how (and where) the template "grades" should elevate within curves or other areas of superelevation.

Cut Slopes (Cut) - Specialized "grade" slopes that are used to "tie" the template to an existing surface when the elevation of the outermost point of the template is below ground.

Fill Slopes (Fill) - Specialized "grade" slopes that are used to "tie" the template to an existing surface when the elevation of the outermost point of the template is above ground.

Rights-of-Way (ROW) - Additional constraints utilized by the template in an effort to minimize the "footprint" of the disturbed limits of a cross-section relative to the right-of-way based on a given centerline.

Template Components

Additional categories of functionality include:

- View Controls
- Data Tools

Grades

Percent: Specify this option when the "s" vertical displacement amount of a slope is specified relative to 100 horizontal units of measure.

Ratio: Specify this option when the "s" horizontal amount of a slope is relative to 1 units of measure vertically.

Vertical: Specify this option for an "undefined" (vertical) slope ("s") in which there is no horizontal component.

Slope: Indicate the "s" value relative to the type of slope selected above. Positive slope values indicate an increase in elevation along the grade segment; negative slope values indicate a decrease in elevation along the grade segment.

Linear: Specifies a constant slope along the grade segment.
Parabolic: Specifies a varied slope that gets steeper across the grade until it reaches the full specified slope at the end of the grade.

Horizontal Distance: Specify the horizontal distance component (positive values only) of the grade segment.

Pick: Prompts to select a linework segment or two points from the drawing to define the grade slope and distance.

ID: The ID (typically a two- or three-character identifier) serves four purposes:

1. The ID will be applied as a description to all final template points generated in the form of a coordinate file.
2. The ID can be used as a parametric design point for subgrade offsets and distances (e.g. EP+0.5).
3. Points of common ID may be connected by 3D polylines as an output option of Process Road Design.
4. Quantities can be generated with reference to the ID and material (gravel, concrete, etc) entered elsewhere within this command.

Set: Displays a list of grade ID's from the current Template ID Library.

Curb

Curb Type: Select the general shape of the curb "plate" that best matches the curb you wish to define. If your curb does not conform to one of these shapes, you can also utilize the Median component.

Dimension Units: Indicate the desired units for the Curb Dimensions (e.g. feet, inches or meters in metric mode).

Integral Curb/Separate Curb: Indicate whether to draw the front line of the curb to separate the curb from the subgrade. For example, fully concrete pavements that contain a curb would be drawn with the "integral" curb option:

Integral

Rounding: Indicate the type (or amount) of "smoothness" that should be applied between curb faces.

- Straight - no smoothing occurs between curb faces.
• Smooth - this option will smooth the surface of the curb which only shows when the template is applied in commands such as Process Road Design.
• Round - this option fillet a curve at the bottom and top of the Taper segment using the specified Bottom and Top Radius.

**Base Slope Type:** The Base Slope Type of the curb can either be flat, set to the slope of the incoming grade or set to a user-specified slope. For the Match Crown method, you can use the Table option to define a lookup table of different curb slopes for different crown grades. For cases with part of the curb at a slope and part flat, you can use the Base Break Offset to set the transition position between sloped and flat. The Target setting for the slope controls which parts of the curb are sloped.

**Curb Dimensions:** Indicate the various dimensions (in units defined by Dimension Units) of the curb components.

**Material:** Indicate the name of the material for the curb for reporting purposes from commands such as Process Road Design.

**ID:** The ID (typically a two- or three-character identifier) serves four purposes as discussed in this ID discussion.

**Set:** Displays a list of grade ID's from the current Template ID Library.

**Direction:** This option controls which way the curb faces and is needed for divided roadway templates that have curbs facing both ways on either side of the road.

**Load:** Allows a previously saved curb (*.crb) "plate" to be opened for editing.

**Save:** Commits the current curb "plate" to a named curb (*.crb) file.

**Median**

The Median is a flexible, closed figure defined in a clockwise direction. Each median point consists of an X and Y offset. The median must be closed and the program will automatically create the closing segment. The display shows the median in magenta and the grade lines in and out in green. For the display the grade in comes from the left and the grade out goes to the right. The median must define the Grade In point which is the point that ties into the incoming surface grade. Also the Grade Out point must be specified for where the surface grade continues out from the median. These Grade In and Grade Out points emanate from the starting or "from" position in the coordinate dialog where they are specified. Since a single median must be placed on the left or right side (and is typically not used symmetrically with right side same as left), you will need to offset the template centerline one-half the median width within the command Process Road Design in order to center the median. You will also have to move the "C/L" designation, to obtain centering, when using Draw Typical Template.
**Skip Median at Stations without Adjustments:** When enabled, this option creates the median only in the station ranges of a Template Point Profile and/or Template Point Centerline transitions.

**Median ID:** The ID (typically a two- or three-character identifier) serves four purposes as discussed in this ID discussion.

**Set:** Displays a list of grade ID's from the current Template ID Library.

**Add (Edit):** To enter the dimensions of the median, use the Add or Edit button to display a dialog box similar to that below:

**X/Y Offset:** Provide the X/Y displacement of the median segment relative to the end of the previous median segment.

**Grade In/Grade Out Point:** Indicate if the median point is the position that accepts the incoming grade and/or generates the location for the out-going grade segment of the template.
Elevation Difference Factors: Controls how to apply Template Point Profiles. For Template Point Profiles, the program figures the amount of vertical adjustment between the transition profile and the normal profile. The amount of this vertical adjustment is multiplied by the adjustment factor and then added to the X/Y Offsets of the median point.

Horizontal Offset Factors: Controls how to apply Template Point Centerlines. For Template Point Centerlines, the program figures the horizontal adjustment between the transition centerline and normal centerline for Template Point Centerlines and applies this adjustment by the factors to the offsets.

NOTE: These adjustment factors allow for dynamic medians. For example, the height of a retaining wall could be controlled using a Template Point Profile and the median points for the vertical sides would have a Y Factor set to 1 to pick up the full vertical adjustment and the median points for the top and bottom edges would have a Y Factor of 0 keep those edges the same.

Remove: Deletes the highlighted X/Y Offset record in the list.

Up (Down): Changes the order of the highlighted X/Y Offset record in the list.

Pick: The Pick button prompts to pick a closed polyline from the drawing to define the median geometry.

Load: Allows a previously saved median (*.mdn) to be opened for editing.

Save: Commits the current median to a named median (*.mdn) file.

You can design a median for "mirroring" to create a centered effect, as illustrated in a paved "rumble strip" section as shown below. The only negative to this method is the appearance of a vertical line in the median plot.

Subgrade

Clicking the Subgrade button displays the dialog box below that permits you to establish "design" materials used to build the design project. Subgrade entries are displayed below the Grade entries and there can be any number of subgrades stacked below one another or side by side.
NOTE: The subgrade values for Horizontal Offset, Distance and Pivot Offset can be specified by Template ID points (consider using the Template ID Library to create a consistent set of template ID codes). For example, EP could be used in Distance to have the subgrade assume (and be controlled by) the width of the "EP" grade. Additionally, expressions can be used such as EP+BC to adopt the distance of the EP segment plus the distance of the BC segment. This is especially useful for template transitions so that if the width of the EP grade varies, the subgrade width will automatically adjust.

Subgrade Type: Chooses where to apply the subgrade. The roadway is the default for subgrades under the road grades. The Cut and Fill Slopes are for subgrades between the pivot (hinge) point at the end of the road grades and the catch (tie) point.

Slope Type: Indicate if the "bottom" of the subgrade surface should match the slope of the grade surface above it or if the subgrade slope should travel at a special slope value. Remember, a positive slope value increases in elevation further from the centerline while a negative slope value decreases in elevation further from the centerline.

Distance Direction: Indicate if the bottom of the subgrade moves away from (Out) or toward (In) the center of the template.

Intersect Surface: Indicate how the subgrade surface should "tie" into another component of the template to form a closed region:

- **Continue Slope**: Specify this option when the subgrade surface should continue along the slope as specified in the Slope Type control. Common uses of this intersect method is for aggregate surfaces used in rural design scenarios and/or railway ballast scenarios. When set to Continue Slope and the subgrade can't find an intersection because the subgrade is too low, then the **Tie Undershoot Vertically At Hinge** option can be used to make the subgrade switch to Straight Up method at the pivot point offset.
- **Straight Up**: Specify this option when the slope is to tie vertically to the surface above it. Common uses of this intersect method are for "rigid" shapes such as concrete roadways or sidewalks and for bituminous asphalt abutting Curb & Gutter.
• **Wrap Around:** Specify this option when the subgrade material is to extend beyond the limit of a previous component (typically, a curb) and then return toward the center of a driving lane to form a closed region as illustrated below:

![Wrap Around Subgrade](image)

When enabled, the **Wrap Height** control will become enabled that allows the wrap height (units of feet or meters) to be specified.

• **Tie Slope:** Specify this option when the subgrade is to tie into a previous element with a desired slope value. This slope type is commonly used when a subgrade region is being excavated with a "lay-back" slope. When enabled, the **Tie Slope** control will become enabled that permits the desired tie slope value (e.g. a 100% slope = a 1H/1V or 1:1 slope).

**Horizontal Offset:** Indicate the distance (by numerical or para-metrical equation) from the template centerline where the subgrade should start. The subgrade moves straight down from this location the depth specified in the **Vertical Offset**.

**Vertical Offset:** Indicate the cumulative depth from the elevation of the specified **Horizontal Offset** plus the desired thickness of the subgrade material. For example, if 6" of a pavement subgrade has been defined and 8" of aggregate subgrade is desired upon which the pavement is built, the vertical offset of the aggregate would be specified as 14". The **Match Existing Surface** option adjusts the subgrade depth to match the existing surface which applies for road rehabilitation when the subgrade is overlaying the existing surface.

**Units:** If applicable, specify the desired units of measure for the **Vertical Offset** control described above.

**Distance:** Indicate the distance (by numerical or para-metrical equation) of the desired width of the subgrade to the point where the Intersect Slope should start.

**Material:** Indicate the name of the material for the curb for reporting purposes from commands such as Process Road Design.

**Coatings/Notes:** This optional description is used in reporting and for labeling in Draw Typical Template.

**Superelevation Settings:** Indicate if special superelevation pivot points will be used:

**Pivot Offset:** Indicate the distance (by numerical or para-metrical equation) of the desired superelevation pivot point. This location allows the subgrade slope to break in superelevation independently from where the surface grade breaks. The subgrade will follow the superelevation slope from the centerline to the Pivot Offset. After the Pivot Offset, alternative slope factors govern.

**Max Slope After Pivot:** Indicate the maximum allowable slope for the subgrade once the Pivot Offset has been reached.

**Slope Type After Pivot:** Indicate how the slope of the subgrade after the Pivot Offset should be governed:

• **Normal:** This option sets the slope the same as the non-superelevation state.
• **Special:** This option can be used to set the slope to a specific value.
  – **Standard Slope Percent:** Indicate the default slope that should be attempted.
– **Minimum Slope Percent**: Indicate the minimum allowable subgrade slope.

**Superelevation (Super)**

Clicking on the "Super" (superelevation) button provides an interface of how the template should behave in zones of superelevation via the Input-Edit Superelevation command.

![Superelevation Settings](image)

**Divided Road**: When enabled, the *Transition from Normal to Super (Inside Edge)* controls will be enabled.

**Transition from Normal to Super (Inside Edge)**: When enabled, identify (by Template ID point or para-metrical equation, *e.g.* EPI+2 or EPI-2) where superelevation pivot points (typically, inside edge of pavement) should occur for the High and/or Low locations of the Pivot Points for a Divided Roadway template.

**Transition from Super to Normal (Outside Edge)**: Identify (by Template ID point or para-metrical equation, *e.g.* EP+2 or EP-2) where superelevation pivot points should occur for the High and/or Low locations of the Pivot Point for an Undivided Roadway template.

**Max Percent Slope Difference**: Indicate the maximum allowable grade difference between the segments on either side of the Pivot Point. Once this maximum allowable slope difference is achieved, template segments outside of the pivot point will elevate as a unit relative to the grade segment inside the Pivot Point.

**Low Side Grades to Match Greater Super Slope**: This option applies to the template grades that are outside the superelevation pivot point. When the superelevation slope becomes steeper than these outside grades, then these grades are adjusted to match the same super slope. You can adjust up to two additional grades past the superelevation pivot point. For example, consider a template where the superelevation pivot point is the EP grade and the next grade is a shoulder (SH) and you desire this first segment to adjust with the EP grade. Set the "Low Side Grades..." control to "1". If the regular SH slope is -4%, the SH will stay at -4% through the superelevation until the superelevation rate becomes greater than 4% (at this point, the SH crown has been removed). If the superelevation rate of the EP segment continues to 6%, the SH segment will steepen to -6% to keep the SH crown removed.

**Pivot Super From Low/Inside Edge**: Commonly used in Divided Roadway scenarios, when this option is enabled the elevation of the Inside Pivot Point relative to the design profile elevation is held fixed and segments outside of the Low/Inside Pivot Point are raised. There is an edit box to enter in the grade ID for this pivot super point which defaults to the Low Side Pivot Point if this is left blank.

![Diagram](image)
Superelevation About C/L with Low Side Grades... = 1 and Max Percent Slope Difference = 7

Superelevation About Inside Edge with Low Side Grades... = 0 and Max Percent Slope Difference = 7

**Cut Slopes (Cut)**

Use the Cut button to define cut-slope treatments when the outermost point of the template is below existing ground.

![Cut Grades Dialog Box](image)

**Slope Type:** Indicate the type of slope unit used for the actual Cut Slope(s)/Fill Slope(s).

**Right Side Same as Left:** When enabled, the cut-slope treatments of the Left side of the template will also be used for the Right side of the template.

**Pivot at Subgrade:** This option will position the cut pivot point where the bottom subgrade intersects the template grade. The ditch or up-slope conditions will then occur from this special subgrade "daylight" pivot point, instead of from the outer grade pivot point.

**Smooth Slope Transitions:** When enabled, this option will gradually transition the slopes from one range to the next. In the Cut Grades dialog box example above, if the depth is 6 feet the slope will be in transition between 4:1 and 3:1.

**Slopes in Series:** When disabled, a single slope is used based on the depth of the Cut Pivot Point. When enabled, each slope is used to its target depth until an intersection with the ground is reached. Each successive slope in the series starts from where the previous slope ended.

**Repeat Slopes:** When enabled, the pattern of Cut slopes will repeat until the sequence of slopes "daylight" with existing ground.
**Cut To:** In addition to bench cut slopes to specific **Depths**, the Cut To option can be used to have each bench cut slope intersect a surface such as a Rock Section File. With Cut To set to **Surface**, the Process Road Design command will prompt for the cut slope surface for each bench. The bench surface can be either a cross section file, triangulation surface or user-specified fixed elevation.

**Bench Between Cuts:** This option allows you to enter a "bench" pattern consisting of a width at a percent slope to be inserted between each cut slope. This option is commonly used in deep rock cuts as a means to help protect vehicles from loose/falling debris in the rock-cut areas.

**Tie to Existing Section Point:** When enabled, this option will tie the cut slope from the cut pivot point to either:

- **End:** The outer-most offset-elevation from the Existing Section file.
- **Desc:** The offset-elevation point with a specified description from the Existing Section file. This method is used when survey crews collect sections and designate the specific slope tie points.

**Tie ID:** Indicate the desired identification where the slope intersects the Existing Surface. This is the same setting as under the Fill Grades dialog.

**Tie to Set Offset:** When enabled, this option forces the cut slope catch point to a specified fixed offset. This offset can be relative to the:

- **Outside Grade:** The offset is determined from the outer-most Grade of the template.
- **Centerline:** The offset is determined from the Centerline and can be used when you want the slope to always tie into existing ground at a fixed Right-of-Way offset.

**Cut Slope(s):** There is room to specify up to five cut slopes that can be applied at specific depths. In a simple case of a single cut slope, supply the Slope value and leave the Depth and remaining Slope/Depth boxes blank.

**Pick:** These buttons prompt to select two points or a linework segment from the drawing to define the cut slope:

**Screen Pick Grade**

- **Points**
- **Linework**
- **Vertical Exaggeration**

**Slope to Rock:** Indicate the slope that should be used when using a Rock Section File within Process Road Design.

**Slope Order:** Enable/Disable this toggle to switch between the two Slope Order modes for rock slopes:

1. **Slope TO Rock:** The cut slope will be the Slope To Rock up to the rock surface. After reaching the top of the rock surface, the regular cut slopes apply.
2. **Slope FROM Rock:** The regular cut slopes apply up to the rock surface. Then the slope from the Slope From Rock applies from the top of the rock surface to the ground surface.

**Force Berm:** When enabled, this option will apply the Berm (defined using the Fill icon) in cut instead of a ditch up to the Max(imum) Depth of cut.

**Force Fill:** When enabled, this option will make the template attempt to find a catch point with a specified **Fill Slope** even when the pivot point is in cut to a Max(imum) Depth in cut.

**Minimum Depth for Ditch:** When the Cut Pivot Point is shallower than this value, the ditch grade(s) will not be applied. To always apply the ditch grade(s) when in cut, specify a value of 0.

Ditch Grade(s) can be inserted between the Cut Pivot Point and the Cut Slope(s) as a means to further control and channel storm-water run-off. Ditch Grades are essentially identical to the Grades option used in the regular template. The location of the Cut Pivot Point is based on the outer-most Grade or Median segment. Consider one of the following scenarios:

- **Cut Pivot Point is "Shoulder Point"** - In this scenario, the last grade segment is taken to be a shoulder point. You could use:
1. One ditch grade to create a "V-bottom" ditch (the single ditch grade emanates from the shoulder and forms one segment of the ditch with the cut slope comprising the other segment, or,
2. Two ditch grades to create a "trapezoidal" ditch (the first ditch grade emanates from the shoulder with the second ditch grade forming the trapezoidal ditch bottom with the cut slope comprising the final segment.

- Cut Pivot Point is a "Toe of Foreslope" - In this scenario, the last grade segment is taken to be an additional slope (typically downward) from the shoulder point that is placed regardless of Cut vs. Fill. You could use:
  1. No ditch grades to create a "V-bottom" ditch. The last grade of the template and the cut slope comprise the V-bottom, or,
  2. One ditch grade to create a "trapezoidal" ditch (the single ditch grade forming the trapezoidal ditch bottom).

The option you use is ultimately governed by how/where the Cut Pivot Point should be defined.

- **Edit Ditch:** Highlight a desired ditch grade and use this option (or simply double-click on the ditch segment) to adjust its value(s).
- **Add Ditch:** Use this option to add any number of ditch grades. See the Grades for information pertaining to the various controls.
- **Remove Ditch:** Highlight a desired ditch grade and use this option to remove it from the ditch grade list.
- **Load Ditch:** Recalls a previously saved ditch (*.DIT) file.
- **Save Ditch:** Saves the current ditch geometry to a ditch (*.DIT) file.

### Fill Slopes (Fill)

Use the Fill button to define fill-slope treatments when the outermost point of the template is above existing ground. The options for Fill Slopes treatment are similar to those used for Cut and any difference(s) are noted below.

**Slope Type:** Refer to Cut – Slope Type for information.
Right Side Same as Left: Refer to Cut – Right Side Same as Left for information.
Pivot at Subgrade: Refer to Cut – Pivot at Subgrade for information.
Smooth Slope Transitions: Refer to Cut – Smooth Slope Transitions for information.
Slopes in Series: Refer to Cut – Slopes in Series for information.
Repeat Slopes: Refer to Cut – Repeat Slopes for information.

Fill To: In addition to bench fill slopes to specific Depths, the Fill To option can be used to have each bench fill slope intersect a surface. With Fill To set to Surface, the Process Road Design command will prompt for the fill slope surface for each bench. The bench surface can be either a cross section file, triangulation surface or user-specified fixed elevation.

Bench Between Fills: Refer to Cut – Bench Between Cuts for information.

Tie to Existing Section Point: Refer to Cut – Tie to Existing Section Point for information.

Tie ID: Refer to Cut – Tie ID for information.

Tie to Set Offset: Refer to Cut – Tie to Set Offset for information.

Fill Slope(s): Refer to Cut – Cut Slope(s) for information.

Pick: Refer to Cut – Pick for information.

Force Cut: When enabled, this option will make the template attempt to find a catch point with a specified slope even when the Pivot Point is in Fill. You can specify the Cut Slope to use and the Max(imum) Depth for the slope.

Force Ditch: When enabled, this option has two different methods to apply the Ditch Grades from the Cut definition when the Max(imum) Depth of fill has not been exceeded:

1. At Base Of Fill: (enabled) When enabled, the Force Ditch method creates the ditch where the Fill slope intersects existing ground. The Uphill Only option creates this base of fill ditch only when the existing ground goes uphill from the tie point.
2. At Base Of Fill: (disabled) When disabled, the Force Ditch method applies the ditch grades from the template pivot point.

Use Guardrail: When enabled, this option will extend the last template surface Grade the specified SHD Extension distance when the Fill is greater than the Min(imum) Depth.

Use Berm: Berm Grades are the fill equivalent to Ditch Grades. The Minimum Depth for Berm Grades will only draw the Berm Grades when the Fill depth is greater than the specified value.

Rights-of-Way (ROW)

The ROW (Right of Way) icon brings up the dialog shown which provides several methods that help govern how/where Cut and Fill slopes interest existing ground. Right-of-Way data is stored in a Centerline (.CL) file as stations and offsets for the left and right sides of a centerline.
Limit Cut/Fill Slopes by ROW: When enabled, the Cut or Fill slope will become steeper in order to tie into the ground at the Right-of-Way offset. For example, if the Cut slope is 4:1 but this slope ties into the ground past the Right-of-Way, the slope will be modified to something steeper such as 3:1.

Extend Ditch for Tie at ROW: When enabled, this option allows you to tie the catch-slope into the original ground at the Right-of-Way offset by widening the lowest ditch slope along its slope until the Row-of-Way limit is attained. Common practice for the utilization of this option is to obtain additional fill material and/or for the placement of linear fences along the catch-slope (Right-of-Way).

Use Left/Right Retaining Wall: When enabled, the Cut or Fill slope will be applied until the Right-of-Way offset and will then tie into the ground via a vertical slope.

Offset to Left/Right ROW: Specify an additional "buffer" amount (if any) inside the Right-of-Way that is to serve as the desired Right-of-Way catch-point.

Left/Ride Side Display: Choose the type of catch-slope treatment (e.g. Cut, Fill or None) that should be displayed in the dialog box preview of the template.

NOTE: The appropriate Cut/Fill slope will be applied to the cross-sections regardless of the Display setting.

Super Elevation: Choose the type of superelevation (e.g. Right, Left or None) that should be displayed in the dialog box preview of the template relative to the specified Super % amount.

NOTE: The appropriate superelevation will be applied to the cross-sections regardless of the Display setting.

Right Side Same As Left: When enabled, template geometry specified for the left-side of the template will be mirrored to the right-side of the template to create a symmetrical template. For unique geometry on either side of the template, disable this option and click/highlight in the desired side (Left vs. Right, Surface vs. Subgrade) to establish the desired geometry.

Profile Delta Z: This option applies a vertical offset to the profile when the template is processed. This vertical offset applies to a template that has an element at the profile position that makes the template different than the profile grade. For example, when the profile grade is along the centerline at the pavement level and the template has a curb or median that is 0.5 above the pavement, then set the Profile Delta Z to 0.5 so that the template matches the pavement grade after coming down from the 0.5 curb or median.

Button Action
"Pans“ the Preview display of the template (same as a press/hold of the middle-button of a 3-button mouse).
"Dynamic zoom" of the Preview display of the template (same as a "wheel roll" of a wheel-button mouse).
Incremental "zoom in" of the Preview display of the template.
Incremental "zoom out" of the Preview display of the template.
"Zoom extents" of the Preview display of the template that fits/restores the content of the template into the Preview display.

Move Up/Down: Highlight an element whose position you want to change and click the appropriate button to move the template element up or down through the other Surface or Subgrade items.

Edit: Highlight an element whose data you want to modify. Alternatively, double-click on the item to edit it.

Remove: Removes the highlighted element from the list.

Import Polyline: This routine adds Grade element(s) to the template from a selected polyline. The polyline can either be drawn in cross section or in 3D. For the cross section polyline, the delta X of each polyline segment is used for the grade distance and the delta Y is used for the grade slope. For a 3D polyline, the horizontal distance of each polyline segment is used for the grade distance and the polyline elevations are used for the grade slope. After selecting the polyline, the routine prompts for the centerline point along the polyline which is the reference point for
the template zero offset position.

**Change Units:** This option allows you to apply a scale factor to the distances in the template which can be used to convert between English- and Metric-based templates.

**Save:** Saves the current change(s) to the template (*.TPL) file.

**Save As:** Description of Control.

**Draw:** Refer to the Draw Typical Template documentation for information pertaining to this command.

**Report:** This option provides two different report formats:

1. **Detail Report:** This report provides all of the dimensions and their IDs of the template elements.
2. **IDs Report:** This report provides just the ID's of the template elements.

**Copy Left to Right:** This action is essentially the same as the Right Side Same As Left in that it clones the current elements on the left side of the template to the right side of the template.

**Prompts**

**Select polyline:** Select a POLYLINE, LWPOLYLINE or LINE entity whose X,Y geometry should be used for the Distance/Elevation change of a particular Grade element.

**Pick centerline position on polyline [end on]:** Pick the location of where the template centerline is relative to the entity selected above.

**Pull down Menu Location(s):** Civil > Roads, Construction > Roads, Takeoff > Roads

**Keyboard Command:** template

**Prerequisite:** None

**Draw Typical Template**

This command draws a template and labels the slopes and distances. The cut and fill treatment can be shown on the left and/or right sides. All the cut/fill slopes are shown for the different depths when multiple slopes are defined. There are options to draw the normal template, super elevation or details of different sections.

You will be prompted to select the template (.TPL) file first, then the Typical Section dialog appears. Specify the parameters and press the Draw button.
Prompts

Template File to Read Specify a template file.
Typical Section dialog Set your options then click Draw.
Pick Starting Position: pick a point

Curb Detail
Offset 3D Polyline By Grade Table

This command creates a 3D polyline that is offset from a reference 3D polyline using the distances and slopes from a Grade Table file. This command provides a simple and easy way to handle complex offsets for features like bottom of ditch polylines offset from the road edge-of-pavement in a road design with transitions.

The Grade Table defines the slopes and offset distances at different stations along the reference polyline. Slopes and offsets for polyline segments between defined stations in the list are interpolated. For example, if the distance at station 0 is 10 and the distance at station 100 is 14, then the offset distance for a polyline vertex at station 50 would be 12. Then slopes and distances are interpolated separately. So if there is a slope change at a station but the distance doesn't change at that station, then you only need to make an entry in the table with the station and slope and leave the distance blank.
The **Output Layer** is used for the offset 3D polyline that is created. The **Side To Offset** controls the offset direction from the reference polyline. The **Reduce Vertices** is used to reduce the number of vertices in the offset polyline. The **Offset Distance** is the maximum amount that the polyline can move horizontally when removing a point. To not reduce vertices, set this Offset Distance to zero.

The **Set Distance** function has several methods for filling out the distance in the table.  
**Polyline method**: prompts to pick the reference and target polylines and then figures the different distances between them. This method applies when there is a 2D polyline for the target location of the 3D offset.  
**Profile method**: prompts for the reference 3D polyline and a target profile. The slope must already be defined in the Grade Table. This method uses the elevation difference between the reference 3D polyline and a profile plus the slope to fill out the distances.  
**Surface method**: prompt for the reference 3D polyline and the target surface. The slope must already be defined in the Grade Table. This method finds the intersection of the surface from the reference 3D polyline at the slope to fill out the distances.  
**Section method**: prompt for the reference 3D polyline and a cross section file. The reference polyline should be at offset zero of the cross sections. The slope must already be defined in the Grade Table. This method finds the intersection of the cross section from the reference 3D polyline at the slope to fill out the distances.

The **Import** function reads in station, slope and distance data into the table. The data can come from either a text file, drawing graphics or superelevation file. For the text file, the format should have station, slope% and distance separated by a delimiter such as a comma. For the drawing graphics, the import reads a polyline on a superelevation diagram grid to set the transition slopes. For superelevation file method, the import reads the transition slopes from a .sup file.

**Pulldown Menu Location**: Roads  
**Prerequisite**: 3D Polyline  
**Keyboard Command**: tgtoffset
Template Grade Table

This command creates a Template Grade Table file (.TGT), which is a lookup file for slopes and distances at stations for grade points within a template. Each side of the template is controlled independently. This user interface provides a simple and easy way to handle complex transitions. A similar result could be produced using a Template Series, or a combination of Template Grade Centerline for horizontal control and Template Grade Profile for vertical control. The advantage of Template Grade Table is that it provides a simpler solution. Besides handling transitions like lane widening, it can also be used to specify superelevation control.

The way that Template Grade Table works is that you select a grade to modify on the left or right side. Then the program has a spreadsheet to define the sequence of transitions for the slope and distance of the selected grade. The grade will use the slope and distance defined in the template file (TPL) until the first station specified. Then the program uses the specified slope and distance going forward. When there is another transition station, the program interpolates the slope and distance between the transitions. For the example dialog below, the grade distance will be 14 at station 50 and will be 16 for all stations after 100. The slope and distance transitions are independent of each other. If one changes and the other doesn't at a station, you only need to enter a value for the one that changes. In the example dialog below, the distance doesn't change after station 100. So only the slope changes are entered after station 100.

A Template Grade Table can be used on a single road with Process Road Design command, or specified for specific roads within a Road Network.

The Template Grade Table is associated with a design template (.TPL) file which is used to set which grades are in the table.

Besides the grades in the template, the table also has the cut and fill slopes. Only the first cut and fill slopes are available. If the template has more complicated cut and fill conditions with multiple cut and fill slopes based on depth, then use the Template Series Files or Template Transition commands to transition these complex cut and fill conditions.

The Match Slope function assigns slopes to the grade table using cross slopes from a reference section file. This function can be used to match the template slopes to existing slopes such as for road rehabilitation to match the new road cross slopes to the existing. After selecting the reference section file, there is a dialog to set the range of stations to process and the offsets of the sections to get the cross slope from. The second offset is optional. When only one offset is specified, the program uses the existing slope at the offset. When both offsets are set, the slope is calculated between the two offset points on the existing surface. The Lowest and Highest Slope % settings are optional restrictions on the transition slopes. The Low/High Slope range can also be set by entering the Target Slope and Slope Tolerance. The Use Reference Template Grade Table for Target Slope option is a method to match the slope within the Slope Tolerance to a variable slope. For example, this option applies when matching an existing road that is transitioning through superelevation. When active, this option will make the program prompt for a separate Template Grade Table to use for the slope reference. The Max Slope Rate of Change Per 100 is an optional restriction on how quickly the slopes can change between stations. If you don't want to use a restriction, you can leave the field blank or set a high value.
The Report function shows all of the slope and distance changes for all of the template grades.

The Import function reads in transition data to the currently highlighted grade in the list. The data can come from either a text file, polyline, superelevation graph or superelevation file. For the text file, the format should have station, slope% and distance separated by a delimiter such as a comma. For the polyline method, the program prompts to select a polyline for the template grade and then prompts for the centerline alignment. There is an option to use another reference alignment for when the template grade is not the first grade from the centerline. Then the grade distances are set using the polyline location. If the reference alignment is selected and is a 3D polyline with elevations, then the import also assigns the grade slopes. For the superelevation graph, the import reads a polyline on a superelevation diagram grid to set the transition slopes. For superelevation file method, the import reads the transition slopes from a .sup file.

The Insert, Delete, Move Up, Move Down and Clear functions work on the data in the spreadsheet. The Pick button in the spreadsheet lets you screen pick a point to set the station for that row. The Default button sets the slope and distance to the values for the grade as defined in the template file (TPL).

**Prompts**

**Template Grade Table to Edit/Create** Choose New to create a new Template Grade Table, or Edit to modify an existing one.

**Template File to Process:** When creating a new Template Grade Table, an existing Template file must be selected to be used with it. When editing an existing .TGT, the Template previously associated with it will be automatically loaded with it.

**Template Grade Table dialog**
**Pulldown Menu Location:** Roads  
**Keyboard Command:** tpltable  
**Prerequisite:** A template .TPL file

---

**Template Transition**

This command creates a template transition file (.TPT file) that can be used for the commands *Locate Template Points* and *Process Road Design*. The template transition is associated with a typical template (.TPL) file. The template transition file defines changes in grade distances or slopes for a specific template ID through a specified range of stations. Lane widths, for example, can be made to expand and contract. You can only modify existing template grades. Template Transition does not allow curbs, medians, subgrades or cut/fill treatment to be modified. Also new template elements cannot be added and existing elements cannot be removed. For this reason, lanes of road that "emerge" and slope distinctly from standard road lanes would need to be entered as small (0.001 in width) segments in the original template, available for expansion using Template Transition. Template Transition offers one of 3 ways to change template widths and slopes. Another way involves use of Template Point Profile and Template Point Centerline, where a particular template ID can be directed to follow a specific profile and centerline of its own. The third method is template-to-template transitions using Input-Edit Template Series, where distinct templates transition one to another. All three methods require that template IDs "pre-exist" in order to be expanded, or to follow profiles and centerlines, or to transition between template files. So the technique of making very short phantom segments for emerging and disappearing "lanes" or roads with distinct grades is universal. If special slopes are not involved, lanes can expand and contract without creation of phantom segments in the original template. Only clever use of Input-Edit Template Series, where templates with no curbs could "end" and templates with curbs can begin at specified stations, can effectively make "new" features like curbs and medians materialize.
Reviewing the below plan view, when you are given stations and offsets that define a template position like edge-of-pavement (above), you can use Template Transition effectively.
The first Template Transition dialog shows a list of the transitions, covering the above right-lane variable width. To add a transition, click the Add button. This brings up the second Template Transition dialog which shows the transition template for the second segment. The middle sections list the template grades that can be changed. To modify a grade, highlight the grade and click the Edit button. The Report function creates a report of the template transition data.

The Begin Transition Station is where the normal template begins to transition to the modified template. The Begin Full Template Station is where the modified template is used entirely. The End Full Template Station is where the template starts to transition back to normal. The End Transition Station is where the template has returned to normal. This method is designed for elements like passing lanes which expand from normal then contract back to normal. But you can also use this method for roads that start off or end expanded or altered. For example, to start off the road at a 40' edge-of-pavement dimension, it is necessary to transition up from 12.5' (normal dimension). If you need to have 40' at station 0, then enter station -0.01 as the "Begin Transition Station", and enter station 0 as the "Begin Full Template Station". Select the EP grade in the dialog, and change it to 40'. Then click "Link to next transition". The Link to Next Transition option joins the current transition to the next transition without returning to the normal template. This takes you to the second dialog, shown above. You sustain the 40' width from Begin Transition Station 125.29 and transition at station 215.08 to a 24.23' dimension. Then quickly end the transition at station 215.081 for the "End Full Template Station". Finally, transition back to normal 12.5' by entering 335.51 for "End Transition Station".

The Series # setting is for grouping a sequence of transitions separately from other transitions. This Series # allows for independent transitions over the same station range. All transition changes that are part of the same transition should be given the same Series #. For example, when a grade on the right side of the road transitions separately from a grade on the left side of the road, all the transitions for the right side grade could be assigned as Series #1 and all transitions for the left side grade could be assigned as Series #2.

There is another "trick" to using Template Transition with templates that include subgrades. The subgrades will not automatically extend and follow the expanded grade IDs such as EP for "edge-of-pavement", unless the subgrades are defined in terms of the IDs themselves within Design Template. Subgrades that expand "at slope" to intersect a curb, for example, can expand naturally as the curb position moves outward on the right side. But subgrades that go "straight up" at back of curb at offset 14.5' in this example will stay at 14.5', unless defined as shown below by referencing the "EP ID:

![Sub-Grade Dimensions](image)

Cut and Fill slopes can also be transitioned by picking the Cut and Fill buttons. Ditch and Berm grades can also be modified here.

Chapter 12. Roads Menu 522
Transitions can also be applied to the left, right or both sides. This allows you to have separate overlapping transitions for the left and right sides.

Prompts

**Template Transition to Edit/Create** Choose New to create a transition file or Edit to modify a transition file
**Template File to Edit:** Specify a transition file
**Template Transition dialog**
**Pulldown Menu Location:** Roads
**Keyboard Command:** tpltrans
**Prerequisite:** A template .TPT file

**Input-Edit Super Elevation**

This command is an editor for super elevation stationing. The super elevation data is stored in new or existing super elevation (.SUP) files. When creating a new super elevation file, there is an option to read a centerline file and build the super elevation stationing based on the curves and spirals in the centerline using AASHTO-based stationing or optionally, the Virginia DOT method. The AASHTO calculations are based on the equations in chapter 3 of the 2004 Green Book titled Geometric Design of Highway and Streets. The length of the transition from normal crown to superelevation will be automatically computed by the program using either method based on the design speed and other settings. You can control the amount of this transition that occurs in the tangent leading up to the curve or in the curve itself by either a fixed distance or percentage of the transition. Use the Transition Part in Tangent By Distance for the distance method. Otherwise the percentage method is used. The Use Transition Curves option enables fields for the transition curves at each super elevation grade break. For example, if a normal grade is -2% and it starts changing at station 1+00 to reach 4% as station 2+00, then you could have a transition at 1+00 to go from the constant -2% to the rate of change of 6% over 100'. This transition curve will show up in the Draw Superelevation Diagram similar to a vertical curve in Draw Profile.
The main superelevation dialog displays a list of each super elevation transition. These entries should be sequentially entered from lowest to highest stations. To edit the super elevation stationing, highlight the entry line and click Edit. The Add button creates a new entry below the current highlighted row or at the top of the list if no row is highlighted. The Delete button removes the highlighted row from the list. The Save button saves the super elevation file. To exit the program without saving, click the Cancel button.

The super elevation stationing is entered in the Input/Edit Superelevation dialog. The View Table button shows a table of the super elevation slope for the delta angle and radius at different design speeds. The Calc Super button calculates the slope of full super given the design speed. The station entries are defined as follows:
Station to begin transition: where normal crown rate begins to transition
Station to begin super run-in: where slope becomes flat
Station for super at normal crown rate in: where slope equals negative of normal crown rate
Station to begin full super: where slope reaches full super slope
Station to end full super: where slopes begins to transition from full super back to normal
Station for super at normal crown rate out: where slope equals negative of normal crown
Station to end super runoff: where slope becomes flat
Station to end transition: where slope returns to normal crown rate

Given these various Station settings, an unequal rate of change can occur between any two stations. However, the program can calculate the stations to set an even rate of transition, as long as it knows the max superelevation, the normal crown slope and the station to start transition, start full super, end full super and end transition. The Calculate Stations button therefore calculates the stations for begin run-in, normal crown rate in, normal crown rate out and end super run-out. To calculate these stations the values with an "*" must be entered.

The Compound Curve option allows you to specify a second superelevation slope for a compound curve. In addition to specifying the second slope, the starting and ending stations for this slope must also be entered. The Reverse Curve option is similar to the Compound Curve option. A typical Reverse Curve is shown below in plan view and as it would appear in the summary dialog:
Station 399+00 is the "pivot" where superelevation left flattens and turns into superelevation right.

**Prompts**

**New or Existing Super Elevation File dialog**

Superelevation File to Process Specify a superelevation file.

Superelevation Editor dialog

Pulldown Menu Location: Roads

Keyboard Command: super

Prerequisite: None
Template Series is another method of widening lanes or causing templates to change: direct template-to-template transitioning. Using this command, you specify the station where one template "ends" and the station where another template "begins", and the program auto-transitions between templates.

The Template Series is stored in a .TSF file and consists of a sequence of template file names (.TPL) with stationing. The Design Template command is used to create the .TPL files. The Template Series can be used in commands like Process Road Design and Road Network. In these commands, the template selection can be either a regular template (.TPL) or the template series (.TSF).

For the transition to work optimally, the templates should share the same IDs so that the program can connect the template 3D polylines and transition between templates. If the templates are distinct with separate, unrelated IDs, then by ending template1 at station 500 (for example) and starting template2 at station 500.01, a very abrupt transition can be accomplished.

For a design with transitioning templates, the Template Series method is an alternative to the Template Transition method, a third method of Template Grade Table, and to a forth method of using Template Point Profiles and Template Point Centerlines, where a template ID "follows" a particular centerline and profile. One advantage of the Template Series approach is that it can be used to link different templates together, like non-curb and curb templates, as shown here in plan view:

For the above example, Template 1 applies from station 0+00 to 0+30, then transitions to Template 2 at 1+00 which has a wider EOP distance. This transition occurs between stations 0+30 and 1+00. Then the full Template 2 continues until station 1+40. Then Template 3 starts with a curb replacing a standard EOP/Ditch combination on the left side. So Template 3 would be set to begin at 1+40.1, a short distance past 1+40. This template transitions into Template 4 at station 2+00. Template 4 has a shorter middle grade on the left side. You do not need to enter start and ending templates at station 0+00 or after station 2+00. Therefore, the dialog for this example might look as follows:
Note that you can run Process Road Design to review the design results in plan view, with entry of only the Design Template/Series, the Profile and the Centerline (items 1, 2 and 4 within Process Road Design). You do not need existing cross sections to use Process Road Design. If you process at an interval such as 10 over any desired station range, you can output the Template Polylines and verify the result in plan view. If no sections are found, the program will process from edge of shoulder left to edge of shoulder right, and omit cut and fill slopes. With the correct templates, this would reproduce the plan view shown above.

Input-Edit Template Series is also an effective way to accomplish superelevation, and even simultaneous superelevation and lane widening. Consider the "stages" of pivoting into superelevation of 3%. The first template might be called "Normal Crown" (the lower template). The second template might be called "Reverse Crown" (+2% cross slope). The third template might be called "Full Super" and would be the +3% template. You need the second template because you need to "restrain" the left-hand side of the road from pivoting until the continuous +2% cross slope is reached. If you only used the "Normal Crown" template, say, at station 4+00 and then the "Full Super" template at station 6+00, then at station 5+00, where 1/2 of the transition occurs, the left side cross slope would be -2.5% (transitioning halfway). In reality, the left side should not pivot until station 5+60. If the rate of pivoting is less from normal crown to flat outside lane, and the rate changes after that point, then you would need a fourth template to direct how the road transitions to full superelevation.

The Reference CL is optional. When it is set, then screen pick is an option for specifying the template transition stations.

The Report function has options for either a summary report of the stations and template, or a detailed report that adds the template dimensions.

The Reset Direction function applies when the folder for the template files (.TPL) has changed and you need to set a new location.

The Create From Sections function reads a section file for a design and creates templates at each change and fills in the template series with these templates. The section file must have descriptions on the section points (ie "EOP").

Here is the dialog for adding and editing templates for the series where you set the template name and station to apply. The Transition With Previous Template In Series will match any common template ID's with the previous template and linear interpolate any changes in distance or slope for the stations between the templates. Otherwise, the template dimensions are held unmodified up to the midway station between the templates where the switch occurs.
Topsoil Removal/Replacement

This command creates a topsoil definition (.TOP) file which defines topsoil removal and replacement zones to be used in the Process Road Design command. You can have different topsoil adjustments for different station ranges. These adjustments are applied to the existing ground section in the Process Road Design command and will affect the cut and fill volumes. Process Road Design will also report the amounts of topsoil removal and replacement.

The command starts by displaying a list of the topsoil stations in the dialog shown below. To add a topsoil adjustment, pick the Add button which brings up a second dialog. You can have different amounts of topsoil removal and replacement for areas in cut and areas in fill. Subsoil is another category of removal that will be combined with any topsoil removal. The Subsoil removal volume is reported separately from topsoil removal by Process Road Design. Subsoil is automatically removed from the site and not used in fill or as a replacement quantity. Therefore, the subsoil element applies only to unsuitable materials that need to be removed. In the example below, we are only removing topsoil in cut (where cutting must take place in any case), and in the cut, we are removing 2' of subsoil which will be hauled off site (since subsoil is not re-used). The removed 0.5' of topsoil in cut will then be replaced in both cut and fill zones of the road within the limits specified by the "Replacement Limit ID". (No topsoil will be replaced on paved surfaces!)

The Replacement Limit ID is an option to limit the replacement to occur only within the template left offset Limit ID and the right offset Limit ID. If this Limit ID is left blank, then the program will apply the replacement between the left catch point and the right catch point. Topsoil removal is always applied between the catch points. The Limit ID corresponds to a template ID as set in the Design Template routine. Typically, you would use an ID like SH for shoulder and replace topsoil only from the far left and right tie/catch points to the SH or shoulder point. If you use a curb and want to replace topsoil to back of curb, keep in mind that the program takes the basic code "CB" and creates 3 curb points typically, so the back of curb would become CB3 in most L-shaped curbs.
If the Topsoil (".TOP") file is selected within Process Road Design, all quantities of topsoil removal and replacement and subsoil removal are reported, as shown below:

Processing 0+00.00 to 4+42.10

Total Topsoil Removed: 5219.22 C.F., 193.30 C.Y.
Total Subsoil Removed: 20876.89 C.F., 773.22 C.Y.
Total Topsoil Replaced: 5309.57 C.F., 196.65 C.Y.
Hauled-In Topsoil: 90.35 C.F., 3.35 C.Y.
Total Cut: 9106.52 C.F., 337.28 C.Y.
Total Fill: 16402.56 C.F., 607.50 C.Y.
Total SUBGRADE1 - asphalt: 2763.36 C.F., 102.35 C.Y.
Total SUBGRADE2 - stone: 9209.44 C.F., 341.09 C.Y.
Total CURB - concrete: 1078.37 C.F., 39.94 C.Y.

The cut reported in Process Road Design would be the remaining cut after topsoil and subsoil removal, and the fill would be the fill necessary to bring the grade to base of topsoil replacement, on top of which the topsoil is added. The removal of topsoil and subsoil usually creates less cut and more fill, as some of the cut is accomplished by the topsoil/subsoil removal, and in terms of fill, the grade must be brought up to replace the "cavity" created by the topsoil and subsoil removal. Topsoil removal depths and replacement depths can have a dramatic impact on cut and fill quantities, particularly on smaller scale projects like subdivision roads. In this example, every extra 0.1' of topsoil removal produces approximately 100 c.y. of net fill.

**Prompts**

**Topsoil File to Read** Specify a topsoil file.

**Topsoil dialog** Choose your options.

**Keyboard Command:** topsoil

**Prerequisite:** None

**Assign Template Point Profile**

This command assigns profile (.PRO) files to template point ID's like EP (edge of pavement), SH (shoulder) or DL (ditch line), storing this information in a template point profile (.TPP) file which can be used by the Process Road Design and Road Network commands. The purpose of the profile assignments is to allow separate profiles for template points that are independent of the centerline profile. For example, a ditch grade could have a different profile than the centerline. Multiple template point profiles can be assigned so the amount of control is unlimited. The Template Point Description corresponds to the name set in the Design Template command.

If you want the template ID point to follow a special slope or vertical alignment, use Assign Template Point Profile. The combination of using template point centerlines and profiles applied to particular template ID points is a design method sometimes referred to as "strings", where template elements string along special horizontal and vertical
alignments. The rules of the template in terms of distances and slopes to the next point in the template will resume after the template point centerline and profiles are applied.

**Prompts**

First you are prompted to create a new Template Point Profile (.TPP), or edit an existing one.

Next the Define Template Alignments dialog is presented, showing a list of existing Template ID-Profile assignments. To add a new assignment, first pick the Set button to set the Reference Template file (.TPL), then pick the Add button. This brings up the Template Point Profile Settings dialog. First, pick a Template Point Description from the List, which is derived from the components defined in the Template. Next, pick the Specify Profile File button, to choose the file (.PRO) to assign to the Template Point ID. Alternatively, instead of picking a profile, you can use the Screen Pick button to select a 3D polyline from the drawing which the program will use to generate a profile. Next, enter the Station range to Apply the assignment. The **Station Reference** sets whether the template profile stationing uses the same stationing as the main CL or uses the template grade stationing. The template grade stationing applies when the template grade is also using a Template Point Centerline so that the template grade has a different length than the main CL. The **Side To Use Profile** specifies if this profile is for the Left, Right, or both sides of the main centerline. The **Method** setting controls how to apply the profile. Since the template profile can change the relative position of the template ID from the centerline, you have two options for how to fit in the template ID profile: Hold Offset or Hold Slope. Hold Offset will keep the same offset for the template ID and adjust the slope to the template ID. The Hold Slope will keep the same slope to the template ID and adjust the offset to reach the template ID profile elevation. Use Hold Offset when Template Point Profile is used in conjunction with Template Point Centerline, where a single template ID is defined to follow both a special and distinct horizontal alignment (centerline) and vertical alignment (profile).

Pick OK. Back in the Define Template Alignments dialog, pick Add to add another assignment, Edit to edit an existing assignment, Report to create a report of the template point profile data, Delete to delete a defined assignment, or Save to Exit.
Now Process the road design employing the newly defined Template Point Profile assignment. In the Process Road Design main dialog, pick the Template Point Profile button to select the new file (.TPP). You could also create a new Template Point Profile file directly from this dialog box by picking the Edit button and specifying a new file name.

**Pulldown Menu Location:** Roads  
**Keyboard Command:** tppset  
**Prerequisite:** Profile file (.PRO) or 3D polyline

## Assign Template Point Centerline

In roadway design situations involving varying pavement widths, Assign Template Point Centerline is an effective way to control the edge of pavement horizontal alignment as well as any other element in the template. This command assigns centerline (.CL) files to template ID points, independent of the main centerline, thereby controlling the horizontal location. Besides controlling the template grades, you can also control the tie point where the cut/fill slope intersects the existing ground by entering TIE for the Template Point ID.

The assignment of Template ID points to centerline files (.CL) is stored in Template Point Centerline files (.TPC). These files are then used by the Process Road Design and Road Network commands. The slope to these template points is based on the parameters defined in Design Template. Subgrades can be made to follow template IDs if their offset distances are defined not by distance but by reference to the template ID. For example, with a grade ID of EOP and a subgrade that goes one foot past this grade, the subgrade distance can be defined as EP+1 so that the subgrade follows the template point centerline adjustments.

The commands that process Template Point Centerlines such as Road Network will make the template grades follow the template point centerlines including along their curves for the output of the template 3D polylines and road TIN surface. This way Template Point Centerlines can be used to create rounded medians and edge-of-pavements that follow alignments that are independent of the main centerline as shown here.
There are a few key settings to a road design with medians as shown here.

- Use Template Point Centerlines to control the alignments of the median and curbs. The Adjust Next Outside Grade Distance option should be ON.
- In the Design Template command, for a template (TPL) with a median crossing the centerline, use the Profile Delta Z set to the height of the median.
- Use the Template Series File command to define the sequence and station ranges of templates (TPL) switching between templates with and without medians. Turn OFF the option to Transition With Previous Template In Series.

**Prompts**

First you are prompted to create a new Template Point Centerline file (.TPC) or edit an existing one.

Next the Define Template Alignments dialog is presented, showing a list of existing Template ID-Centerline assignments. Use the Add, Edit and Delete buttons to manage the list of template point centerlines. The Report function creates a report of the template point centerlines in the standard report viewer. The Reference Template is optional for setting the road template (TPL) to use for selecting the template point description from a lookup list.
The Add and Edit buttons bring up the Template Point Centerline Settings dialog. First, set the Template Point Description which refers to the Template ID for an element in the Template (TPL) defined by the Design Template command. Next, pick the Specify Centerline File button, to choose the file (.CL) to assign to the Template Point ID. Alternatively, you can use the Screen Pick button to select a polyline from the drawing that the program will use to generate a centerline. Specify if this assignment is for the Left or Right side of the main centerline.

The Adjust Next Outside Grade Distance controls how template elements are affected that are outside from the current Template Point Description. This option controls whether to hold the grade distance or grade offset from the main centerline for the outside template elements. When this option is on, the outside grade distances are adjusted by the same amount that the template point centerline adjusts the horizontal alignment. When this option is off, the outside grade distances remain set by their distance defined in the template. For example, consider a template that has an inside median grade (MED) followed by an edge-of-pavement (EP) and the MED has a template point centerline. When this option is on and the template point centerline shifts the MED out 2 feet, then the EP grade is reduced by 2 feet so that the EP offset from the main centerline isn’t affected. When this option is off and the MED is shifted out 2 feet, then EP grade distance doesn’t change and the EP offset from the main centerline is shifted out 2 feet.

The Skip Travel Lane for Parallel Grades applies to a grade for a travel lane that is outside a grade being adjusted by a template point centerline. This option controls whether this outside grade is adjusted to by parallel with the template point centerline or the road main centerline.

The Skip Grade When Centerline Missing means that the template will only contain the element at stations that have a template point centerline for it. The Additional Grades To Skip specifies other related template elements to skip in this case. The option applies to template elements like intermittent medians that you only want included in the template for stations where they have a template point centerline defined.

Here are two sections along the roadway, illustrating the varying lane widths on the right side of the main centerline. These sections are created by Process Road Design with the TPC set in the input files and these sections are viewed with the Input-Edit Section File command.
Pulldown Menu Location: Roads
Keyboard Command: tpcset
Prerequisite: Centerline file or polyline
### Tag Curb Ramps

This command draws symbols for where to create curb ramps in Process Road Design and Road Network. The curb ramps are drawn by adjusting the 3D polylines for the top-of-curb and back-of-curb to lower the curb for the ramp. Also, a 3D polyline of the ramp outline is created for each ramp. These curb ramps can be used for sidewalk handicap ramps and for driveways.

In the options dialog, select a symbol to use for the curb ramp location markers. The dialog also has the ramp parameters which are described in the Draw Curb Ramp topic in this manual. After the dialog, pick points along the curb polylines for the ramps. The ramp marker should be placed on the curb polyline at the center of the ramp.

To process the curb ramps, run Process Road Design or Road Network and these commands will automatically find the symbol markers and create the curb ramps.

![Tag Curb Ramps dialog](image)

**Prompts**
Tag Curb Ramps dialog
Pick curb ramp position: *pick a point along a curb*
Pick curb ramp position (Enter to end): *press Enter*

Pull-down Menu Location: Roads
Keyboard Command: tag_curb_ramp
Prerequisite: curb polylines

**Process Road Design**

The primary function of this command is to assemble all of the components for a road design and process them together. While all of the Input Files can be created prior to accessing the Process Road Design command, all can be edited from the Road Design Files dialog, and many files can actually be created from the Road Design Files dialog itself. The actual processing of the Road Design essentially applies the design template at the design profile elevation along the specified centerline and computing the outslopes and earthworks relative to the existing ground surface. The earthworks report can be shown in the standard report viewer or customized with the Report Formatter option. Secondary functions include creating a final grade section file for plotting with the Draw Section File command, creating final grade points in a coordinate file, creating a final surface/contour model, and drawing the road as 3D polylines. You can also output a mass haul diagram profile. The program also has options for applying a superelevation file, template transition file, template point profile, template point centerline, rock section file, an as-built existing section file and a topsoil removal file. **Process Road Design** can be used not just for final road design computations but for levees, channels and any template-based application.

This command begins with the dialog shown below. The top section contains input Files. In a typical implementation of this command, you will have already defined a horizontal centerline for the design to follow, however, you could actually pick the Centerline button, pick the New tab, name the new centerline file (.CL), pick Open, and then back in the main Road Design Files dialog, pick the Edit button and layout the centerline design. The only component that you must have already created before running Process Road Design is an Existing Surface file. As long as there is an Existing Ground Surface, the command will generate the Existing Ground Profile automatically, and the Proposed Finish Grade Profile can be created with the Edit button. Even a Design Template can be created right from here as well. Ultimately, the top 3 Input items (Centerline, Design Profile, and Design Template/Series) are required to Process a Road Design, leading to final sections and full contouring and 3D viewing. The Existing Surface is needed as well to process with earthwork calculations and tie slopes.
The rest of the input files are optional design files. It should be pointed out that Template Point Profile and Template Point Centerline enable template IDs to follow any defined centerline or profile and provide total flexibility of design. Lane widening, matching existing curb lines, special ditches, etc. can be easily accomplished with these two options. The template IDs simply "string along" or follow these pre-defined alignments, and the rules of the template apply to all other template ID points.

The Output Files section allows you to specify files to store the processing results. The Section File creates a final grade section file that can be drawn with Draw Section File. The Topsoil Section File creates the modified existing ground section file if Topsoil Removal is set in the input. This "post-topsoil removal" section file can be used for earthworks calculations to compare any stage of work, using Calculate Sections Volume under the Section pulldown menu. The Coordinate File creates a coordinate file containing every break point in the final grade. The point descriptions include the station, offset and template ID. Whether to include the subgrade points as well as the final surface points is determined by the Include SubGrade Points in Output CRD File option on the next dialog. To the right of the Output Files is the option to create new output files or append to existing output files. If you extend the road, or revise a portion of the project, you can simply "Append" rather than overwrite. The first time that you run this command for stations 0-1000, you would set Output Files to New. Then you could run this command again, possibly with new inputs, for stations 1000-2000 and set Output Files to Append.

On the next dialog, there is a Save Settings button to store all the settings from the first and second dialogs into a specified Road Design File with an (.RDF) file extension. Recorded (.RDF) files can be recalled later using the Load Settings option.

**Centerline**

Specify the name of the Centerline file with this option. The (.CL) file contains the horizontal alignment geometry for a project. This parameter file must be specified if you want to have earthworks centroid corrections computed, generate final coordinates, Disturbed Area Polyline, and/or use Triangulate & Contour. The centerline file can be created by the Design Centerline or Polyline to Centerline commands in the Design pulldown menu.
Design Profile

Specify the design profile (.PRO) file to derive the centerline elevations when the template is applied. This file defines the vertical alignment and is always required. The profile can be created with any of the profile creation routines in the Profile menu, but typically you would use Design Road Profile or Input Edit Profile.

Example Design Profile

Design Template/Series

Specify a template definition (.TPL) file or template series (.TSF) file that defines the final grade offsets and elevations and the cut/fill slopes. The template file is created by the Design Template command and the template series file (a set of templates ordered by range of stations) is created using Input-Edit Template Series. A single template file or a template series file is required to run Process Road Design.

Example Design Template

Existing Surface

Specify the surface model which will be treated as the existing ground for cut and fill volumes and to calculate the outslope intersections when the template is applied at the profile elevations. This Existing Surface can be defined by either a section file or triangulation. The section file can be created with commands such as Sections from Surface Entities, Input/Edit Section File, Sections from Points or one of the Digitize Sections commands on the Section menu. The triangulation file can be created with the Triangulate & Contour command.
Rock Section File

This option specifies an optional rock section file that is used as an additional surface. When in cut, a special cut slope is used up to the intersection of the rock surface. After this intersection, the normal cut slopes apply. The special rock cut slope is specified in Design Template under the cut options. If the "pivot point" in cut is below the rock line, then the special rock cut slope will be applied. Note that rock sections can be derived from borings to rock, as modeled, or can be created quickly by using the "translate" command within Input-Edit Section File to translate the existing ground sections by a vertical offset (e.g. -6) to an approximate top of rock.

Template Transition File

Specify a .TPT file with this option. The Template Transition file allows modified template files to be applied at different ranges of stations on a project. In this way, template IDs can be made to widen (as for passing lanes) and contract. Use the Template Transition command under the Design menu to create a template transition file.

Super Elevation File

This option is used to specify a super elevation file (.sup file) that defines the super elevation transition stations on a project. The super elevation file can be created with the Input-Edit Super Elevation command.

Template Point Profile

This option lets you have separate profiles for template points that are independent of the centerline profile. This design file is created with the Assign Template Point Profile command.

Template Point Centerline

This option lets you have separate centerlines for template points that are independent of the main centerline. This design file is created with the Assign Template Point Centerline command.

Template Grade Table

This input file is optional. The Template Grade Table is a method for template transitions that uses a lookup table of distance and slopes at transition stations for each template ID. This design file is created with the Template Grade Table command.
Topsoil Removal

This option applies topsoil removal and/or replacement to the existing ground section file. This design file is created with the Topsoil Removal/Replacement command.

As-Built File

The As-Built File is a cross section file used to match existing grade and retain as-built portions of a road improvement project. The final cross sections will conform to the as-built cross sections for those template IDs specified in the second dialog. Beyond the specified set of offsets in the as-built cross section file, the design road files will be applied.

Road Design Parameter

This input file is optional for running checks on the road design for parameters such as min sight distance and max grades. This .RDP file is created with the Define Road Design Parameters command.

Road Stripes

This option draws road markings such as double yellow lines along the centerline. The types of markings are defined in the Road Stripe Library command. The Draw Road Stripes command creates a .RST file for using with Process Road Design. The file sets which markings to draw and sets the centerline offsets.

Output Design Section File

Specify the name of the file to output the final grade sections calculated by applying the template file at profile elevations and calculating the outslope intersection with the existing ground cross sections. This file can then be plotted by using the Draw Section File command. After plotting the final sections overlaid on the existing sections, revisions can be made graphically with commands like PEDIT and Polyline by Slope Ratio. The data output to the file can also be edited and reviewed with the Input-Edit Section File command. If the final sections are edited graphically, the revised section data can be updated in the .SCT file with the Polyline to Section File command.

Output Existing Section File

This option creates a section file of existing ground. This applies when the existing surface is a triangulation file. The station intervals for the existing section file will match the stations from the design section file.

Output Topsoil Replacement Section File

This option writes out a modified existing ground section adjusted by the topsoil replacement. This option only applies when a Topsoil Removal file is being used.
This option writes out a modified existing ground section adjusted by the topsoil removal. This option only applies when a Topsoil Removal file is being used.

**Output Coordinate File**

This option creates a coordinate file containing every break point in the final grade for the range of processed stations. Using the second dialog, there are additional options to output subgrade and ditch/berm points. The point descriptions include the station, offset and template ID. The station interval is set by the stations in the Existing Section File.

**Output Solid Model**

This option creates a solid model file (MDL) for all the subgrades.

**Output Mass Diagram File**

The mass haul diagram can be output as a profile file and shows the cumulative cut and fill along the selected range of stations. Cut and fill is balanced between points on the mass haul profile that cross the Z-axis. Because of the typically large values of cut and fill associated with road and earthwork projects, the vertical scale for the profile may need to be set to 10 times the horizontal scale, or more. The profile preview screen which appears when you select profile for loading will show the elevation range and help suggest an appropriate vertical scale.

**Output Super Elevation Diagram File**

This option writes out a super elevation transition file (.SUD) that can be used with the Draw Super Elevation Diagram routine. This file contains the template cross slopes and the transition stations.

**Running the Road Design Job**

After setting up the files and options in the first dialog click the OK button. The next dialog shown below has processing options.
In the Process Options section, the Range of Stations to Process field sets the range of station that you want to calculate. Each time you use this command, the existing grade (.SCT) file is scanned and the range in the edit box is set to the minimum and maximum stations in the file. If you change the station range, you can click the Full Range button to restore the default full range of stations.

The Settings button will interpolate additional existing cross sections (internally) and create final cross sections at special stations like profile high and low points, profile transition stations for PVC and PVT, key centerline points like PC’s and PT’s, and superelevation and template transition points and any user-defined special stations. These additional station improve volume calculations.

Volumes are calculated using end areas between the range of stations. Also under the Settings button, there are controls for the cut/fill starting and ending stations. Instead of cutting off the volumes exactly at this range, the Ending and Starting Stations for Cut and Fill can be used to have the volume taper from zero at the specified Starting Station to the volume at the first station in the range. Likewise the Ending Stations can be used to taper the volume from the last station in the range to zero at the specified Ending Station. You can also specify cut/fill gaps to stop the end area volume calculations over the station range of that gap. This applies in cases like a bridge.

The Edit Design Sections Before Final Processing does just that. You can review and edit the final sections in the spreadsheet with graphic view editor similar to the Input-Edit Section File command. For example, you can change the tie slope as selected stations. After making these changes, the modified final sections are used for the rest of the road design process including earthworks and drawing output.

The Station Interval and Existing Section Max Offset buttons are ghosted if the existing surface is a set of cross sections. If there is no existing surface, or the existing surface is a grid, TIN or FLT file, then you must enter the Station Interval to generate sections along the centerline. Besides the stations at interval, sections can be created at special stations as specified under the Settings button. The Existing Section Max Offset controls the max left and right offsets for generating the existing sections when the Existing Surface is defined by a triangulation file. This offset needs to be set far enough for the final sections outslopes to tie into existing. On the other hand, keeping this offset fairly close to the tie point will help make processing run faster.
The **Calculate Centroid** option applies to centerlines containing curves. The centroids of the cuts and fills will be computed, and the radius to these centroids will be calculated. Then the effective interval will be computed between cut and fill centroids. In this way, in a tight curve where fill is concentrated to the outside of the curve and cut is concentrated to the inside of the curve, fill will be increased and cut will be reduced. This also increases the accuracy of volume calculations.

The **Use Takeoff Strata** option uses the strata surfaces created in the Takeoff module to report the strata cut volumes both for the total strata volumes and the strata end areas per station. This method allows for unlimited strata definitions with advanced modeling techniques including Kriging and Inverse Distance to model strata surfaces. In Takeoff, the Drillhole/Strata Settings command is where you define the strata names and modeling methods. Next, the Place Drillhole command creates the drillholes. Once the drillholes are entered, use the Make Strata Surfaces command to build the strata surfaces which are stored as TIN files and associated with the current drawing.

The **Template ID for Profile** allows the profile grade to be applied to another template ID point other than the centerline. This feature might apply, for example, to a 2-lane road that will eventually be part of a 4-lane road being built in stages. The first-stage, 2-lane road would be fully symmetrical and designed around the crown of the road, but the template profile might be one of the edge of pavements. You can specify the template ID (e.g. EP), and whether the left or right side ID should be used to apply the profile grade.

The **Shrink and Swell Factor** edit boxes allow you to specify a value that the volume calculated will be multiplied by. If you specify any number other than one an additional report showing accumulated adjusted volumes and differences will be produced.

The **Vertical Offset of Profile** edit box will place the template at the profile grade as raised or lowered by the entered offset.

The **Horizontal Offset of Road** will shift the template left or right on the centerline by the specified amount. Use a positive value to offset to the right and use a negative value to offset left. This option is useful, for example, when one side of a divided highway is built before the other side is to be started. In this case, you could define a normal template with a crown in the middle, but would enter a horizontal offset from the crown of the road to the actual centerline of the divided highway. In case the offset is variable instead of a fixed offset, there is an option to specify a centerline file (.CL) for the offset. This method applies for a divided highway where each side of the road follows its own alignment. In this case, the main centerline from the first dialog can be for the centerline along the median between the roads and this main centerline is used for the stationing in the reports and output sections. To process both sides of the divided highway, run Process Road Design twice, once for each side.

The **Slope Perpendicular To** option defines the slope projection method. The centerline method creates the template cut/fill slopes perpendicular to the centerline. The Slope Direction method accounts for the slope of the profile and makes the final surface to match the template cut/fill slope. For example, if the profile is at a 10% slope and the fill slope is at 2:1, then the Centerline method would create fill slopes that are 2:1 perpendicular to the centerline while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the profile. For the same case except with the Slope Direction method, the resulting slope perpendicular to the centerline is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

The **Skip First Grade** option skips the first template grade. This option applies when the road design is adding onto an existing road. In this case, the first grade in the template can cover to the edge where the existing road is being kept. Then Process Road Design will skip over the existing road and start the design from the second template grade.

The **Report and File Output Options** include settings for reporting final coordinates (if specified in the previous file output dialog), as well as special features.

To report tons and costs for the subgrade materials, set the material names in Design Template for the .TPL file.
Also, in Define Materials Library in the Takeoff menu of the Construction menu, specify the density and cost parameters for the material names. Then the Process Road Design report will include the tons and costs for the subgrade materials.

The **Report Precision** controls the number of decimal places.

The **Use Report Formatter** option allows you to customize the fields to report and their order. It also can output the report to MS Excel or databases.

The **Report Subgrade Areas** option will include an additional line in the report for the end area of each subgrade material.

The **Report Centroids** toggle controls whether the shift in the cut or fill centroid radius shift will be included in the earthworks report.

The **Report Cut/Fill Text** option greatly expands the size of the report by presenting the cut and fill end areas at each station. A sample of the cut/fill text report is shown below. Volumes by end area method are presented between each line containing station and end areas of cut, fill and optionally rock.

<table>
<thead>
<tr>
<th>Station</th>
<th>Cut (sf)</th>
<th>Fill (sf)</th>
<th>Rock (sf)</th>
<th>Interval</th>
<th>Cut (cy)</th>
<th>Fill (cy)</th>
<th>Rock (cy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3+00.00</td>
<td>0.00</td>
<td>101.07</td>
<td>0.00</td>
<td>50.00</td>
<td>313.78</td>
<td>93.58</td>
<td>0.00</td>
</tr>
<tr>
<td>3+50.00</td>
<td>338.88</td>
<td>0.00</td>
<td>0.00</td>
<td>6.09</td>
<td>80.93</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3+56.09</td>
<td>379.10</td>
<td>0.00</td>
<td>0.03</td>
<td>43.91</td>
<td>824.60</td>
<td>0.00</td>
<td>31.84</td>
</tr>
<tr>
<td>4+00.00</td>
<td>634.92</td>
<td>0.00</td>
<td>39.12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Report Cut/Fill Differences** option will report the cut/fill ratio and balance at each station.

The **Report Cumulative Cut/Fill Differences** option will report the running totals of cut/fill at each station.

The **Report Final Station-Offset** option will create a report of the final section offset-elevation data in row-column format. The station and profile grade are shown on the left followed by columns of offset and elevation for each data point. There are options to report the surface points only, the subgrade points only or filter the points by ID.

**Write SMI Chain File** creates a chain (.CH) file that contains the centerline, profile and template data for SMI Construction V.

The **As-Built IDs to Use** option applies only if you have specified an as-built section file as one of the inputs in the previous dialog. Consider a normal road template with 20 feet to edge of pavement (EP) and 10 feet more to shoulder (SH). Going further, assume that when you run this template, it does a fill condition on the right and creates a TIE point. If you wanted to conform the template to match a wider section of road at certain stations, you could edit the output file of a normal run (using Input-Edit Section File) and create new offsets and subgrade points for widening and even force a trapezoidal ditch in cut, as shown in the entries below:
Because all the other offsets to the left match by default, this editing will force the template to conform from offsets 21.33 right to the tie at 46 right. As you try different design template or other changes in Process Road Design, this as-built information would hold for the specified station. Alternately, you could edit the final cross section directly in Input-Edit Section File. Note that you can use distinct, new ID points like BD2 which are not found in the template file, and they will be created if part of the as-built cross section file, and if referenced as As-Built IDs to Use. This As-Built method works best when inserting controlled section defined from TIE left to TIE right, which get inserted as completed sections in a run of Process Road Design.

The Coordinate Output Options apply when a Output Coordinate File is specified in the first dialog. The Template IDs to Output allows you to output any combination of template surface, subgrade, ditch and berm points. The Side to Output controls whether to create points on the left, right or both sides of the centerline. The Horizontal Offset shifts the points away from the centerline. The Draw Points option draws the points in addition to storing the points to the coordinate file. The Description Settings control the contents for the point descriptions. The Stations to Output control at which stations to create points. Here are example coordinates for station 0+90:

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>North(y)</th>
<th>East(x)</th>
<th>Elev(z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>122</td>
<td>189497.42</td>
<td>611730.32</td>
<td>90.01</td>
<td>TIE 0+90.00L53.65</td>
</tr>
<tr>
<td>123</td>
<td>189461.43</td>
<td>611733.72</td>
<td>108.09</td>
<td>SHD 0+90.00L17.50</td>
</tr>
<tr>
<td>124</td>
<td>189457.45</td>
<td>611734.09</td>
<td>107.93</td>
<td>CURB3 0+90.00L13.50</td>
</tr>
<tr>
<td>125</td>
<td>189456.95</td>
<td>611734.14</td>
<td>107.93</td>
<td>CURB2 0+90.00L13.00</td>
</tr>
<tr>
<td>126</td>
<td>189456.95</td>
<td>611734.14</td>
<td>107.09</td>
<td>CURB1 0+90.00L13.00</td>
</tr>
<tr>
<td>127</td>
<td>189455.96</td>
<td>611734.23</td>
<td>107.09</td>
<td>EP 0+90.00L12.00</td>
</tr>
<tr>
<td>128</td>
<td>189444.01</td>
<td>611735.36</td>
<td>107.33</td>
<td>CENTER 0+90.00R0.00</td>
</tr>
</tbody>
</table>
The **Drawing Output Options** bottom section of the Additional Earthworks Parameters dialog contains output options which are only available when a centerline file is specified.

The **Triangulate & Contour** option will automatically run this command after Process Road Design is done to create the final contours. Triangulate & Contour uses the template 3D polylines to model the final surface, and the disturbed area polyline is used as the inclusion perimeter for the contours. With Triangulate & Contour clicked on, the **Setup** button becomes active. Picking Setup brings up the Triangulate & Contour settings including the contour interval and whether to draw 3D Faces. Also under Setup, there are controls for the colors of the 3D Faces for each template break point. With Triangulate & Contour active, Draw Template Polylines and Draw Disturbed Area Polyline are automatically turned on. The **Merge Road With Existing** option combines the road design triangulation with the existing ground surface and stores the resulting triangulation in the file specified with the Set button. This option is available when the Existing Surface is a triangulation file and the Triangulate & Contour option is active. The Output Surface chooses between Triangulate & Contour building a surface for the top of the road template or the bottom subgrade.

The **Erase Previous Road Entities** option will erase any entities from the drawing that were created in a previous run of Process Road Design using the same design files. This option allows you to easily re-run Process Road Design and update the drawing entities after changing one of the road design files.

The **Draw Cross Section Polylines** option will create 3D polylines perpendicular to the centerline with each template break point. The interval of these cross section polylines is determined by the station interval of the Existing Sections.

The **Draw Template Polylines** option will create 3D polylines parallel to the centerline by connecting common template point IDs. For example, a template ID could be EP which this option would use to create 3D polylines for EP on the left and right of the centerline. Which template point IDs to connect in set under **Template IDs to Draw**. Setting this to an asterisk (*) will plot all the template break points. The **Select** button shows cross sections of the final templates for graphical selection of the ID's to draw.

Likewise, the **Draw Subgrade Polylines** option will create 3D polylines parallel to the centerline for the specified subgrade breakpoints.

The **Draw Disturbed Area Polyline** option will create a polyline perimeter that represents where the cut/fill slopes tie into the existing ground.

**Draw Template Slopes** creates slope arrows parallel to the centerline at the specified template ID's. For example, this option can be used to show the slope direction and amounts along the template flowline. The style of the slope arrows is set under the **Set Slopes** button at the bottom of the dialog.

**Draw Cross Section Slopes** create slope arrows perpendicular to the centerline at the specified template ID's. For example, use this option to show the cross section slope of the pavement lanes. The cross section interval is controlled by the station interval under Process Options. The style of the slope arrows is set under the **Set Slopes** button at the bottom of the dialog.

**Label Profile On Centerline** creates labels in plan view for the profile stations, elevations and slopes as well
as high and low points. This option has the same functionality as the command by the same name in the Profiles menu.

The *Draw Cut/Fill Direction Arrows* option will draw arrow indicators for cut or fill slope direction. The arrows are drawn in plan view and usually are drawn together with the Draw Disturbed Area and Draw Cross Section Plines options. Cut arrows start from the disturbed area limit and point towards the centerline. Fill arrows start from the base of the fill slope and point away from the centerline. The *Solid Cut Arrows* option chooses between solid fill or wire-frame cut arrows. These arrows, especially when drawn as solid cut arrows, help distinguish cut and fill at a glance, when in plan view. In the example below, fill from a berm is shown at the left and cut down to a ditch is shown at the right. The arrows will only draw if there is enough dimension in the cut and fill to fit the entire arrow. So the cut and fill arrows reveal the deeper cut and fill zones.

![Diagram of cut and fill arrows]

### Prompts

**Road Design Files dialog:** Choose the design files

**Additional Road Design Parameters**

**Road Design Report dialog**

*Trim existing contours inside disturbed area (Yes/<No>)?*  
Y This prompt appears if Triangulate & Contour is on. This option will trim polylines with elevation that cross the disturbed area perimeter for the road.

*Join final contours with existing (<Yes>/No)?*  
Y This prompt appears if Triangulate & Contour is on. This option will join the final contours with the existing contours where they join at the disturbed area perimeter.

Portion of Earthworks Report:

```
Template File> C:\DATA\simo2.tpl
Profile File> C:\DATA\rd.pro
Existing Section File> C:\DATA\simo2.sct
Centerline File> C:\DATA\simo2.cl

Processing 0+25.000 to 7+51.152
Total Cut : 800563.177 C.F., 29650.488 C.Y.
Total Fill: 1554948.266 C.F., 57590.677 C.Y.

Station  Cut(sf)  Fill(sf) Interval  Cut(cy)  Fill(cy)
0+25.000  4407.456  0.000   25.000   4784.266   0.000
0+50.000  5926.559  0.000   25.000   5535.921   0.000
0+75.000  6031.029  0.000   25.000   4840.888   0.000
1+00.000  4425.290  0.000   25.000   3432.528   0.000
```
Portion of Final Station-Offset Report:

Final Surface Section Report

<table>
<thead>
<tr>
<th>STATION</th>
<th>P.G.</th>
<th>1013.444</th>
<th>59.619</th>
<th>18.000</th>
<th>12.000</th>
<th>0.000</th>
<th>12.000</th>
</tr>
</thead>
<tbody>
<tr>
<td>2+50.000</td>
<td>992.634</td>
<td>1013.444</td>
<td>1013.204</td>
<td>1013.444</td>
<td>1013.204</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2+75.000</td>
<td>1015.059</td>
<td>65.772</td>
<td>18.000</td>
<td>12.000</td>
<td>0.000</td>
<td>12.000</td>
<td></td>
</tr>
<tr>
<td>3-00.000</td>
<td>1016.499</td>
<td>71.547</td>
<td>18.000</td>
<td>12.000</td>
<td>0.000</td>
<td>12.000</td>
<td></td>
</tr>
<tr>
<td>3-25.000</td>
<td>989.725</td>
<td>1016.499</td>
<td>1016.259</td>
<td>1016.499</td>
<td>1016.259</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Existing Contours and Centerline

3D template polylines, disturbed area perimeter polyline and final contours
Review of 3 Methods of Transitioning Templates using Process Road Design

The 3 methods of template transitions and super elevation are:
(1) Template Transition and/or Super Elevation Files
(2) Template Point Profile and Template Point Centerline files
(3) Template Series file which transitions between multiple, named templates.

Road widening and lane transitions can be handled by all 3 methods. Special ditches are best handled by method (2), Template Point Profile and Template Point Centerline, especially since Template Transition files only work with lanes or portions of roads defined by the Grade button in Design Template. Template Transition files do not apply to cut and fill segments, unless they are designed as fixed features using the Grade button. Super elevation can often be handled by method (1) or method (3). Bear in mind that new lanes or template elements that emerge and then disappear need to exist as template ID points in all referenced templates, using all 3 methods. These template ID points can be set to 0.001 units from adjacent template points, then "told" to emerge and widen as new lanes with distinct slopes appear. The program will not transition templates that don't share common template ID points.

This deceptively easy looking example below might be approached by a combination of methods 1 and 2. For method 1 to apply (template transition), the slopes of the pavement lanes must be maintained according to the template definition from centerline to outside lane. The ditch portion will be handled by method 2 (template point centerline).
Assume Spouts Springs Road is a hillside road with a ditch cut on the left side and fill on the right side. The trapezoidal ditch is shown. We will design only from station 4+00 to station 6+94 where the intersection begins. The standard template of 10’ left lane and 10’ right lane might appear as shown below:

Note that if lanes are designed to expand, its important that the subgrade (9” of paving, shown above) be defined as following the ID, and should not be set to a fixed distance. The "EP" ID is used in the dialog below (top of subgrade dialog within Design Template) for this example.

The right hand portion of this example would be entered as follows:
When you click "Add" within the Template Transition main dialog, you are presented with the above screen. Template transitions require that you specify the correct side of the road in the lower left, then click the Grade or lane to alter, which is the first lane on the right, which is set to 13.73 according to the plans. To make sure the lane is fully expanded from the standard 12 to the 13.73 at station 400, it is necessary to set the "Begin Transition Station" to something less than 400, as shown. Then if this "expanded" lane width does not transition back to standard 12 width, but changes again, you must click on "Link to next transition" and leave the "End Full Template" and "End Transition" stations blank. Then you click "Add" again for the final segment, which would be entered as shown:
First, you specify "Side to Apply" as "Right", then click the pavement lane and edit it to 30', as shown above. Referencing the plan view drawing for Spouts Road shown above, you transition from station 451.67 to the new 30' road lane width at station 556.69 and hold that to the "End Full Template Station", which is 694.00. Then you can enter an "End Transition Station" just past the end of the key station range, which internally would transition the template back to a standard width of 12' at 694.01 (a moot point as the end of the project is station 694 for this exercise). The key to template transition is that it is designed to transition from normal to expanded or reduced dimension, then transition back to normal. It is ideal for use in passing lanes that appear and then transition back, but requires use of "Link to next transition" to handle a sequence of lane width changes as above. Therefore, where lane widths change often, and don’t transition back to the normal template lane width, it is often best to use Template Point Centerline as the method of lane transitioning. We will apply that below to the ditch line.

When the template transition process is repeated for the left driving lane, you obtain a final Template Transition dialog as shown here:

For the left side, the first screen just starts things up by establishing 10.28 as starting left side dimension, then the "Link to next transition" option is used, and the width of 18 is entered, transitioning to 18 at station 554.21 and holding that to an end station of 764.34, transitioning "back" to 12 at the fictitious 764.35, well beyond the 400 to 694 station range of interest. When this template transition file is run in Process Road Design and Triangulate & Contour is turned on within Process Road Design, the output clearly shows that the lane transitions have followed the lane expansions correctly:

However, it is easy to see that the "design ditch" on the left side of the road, at 2' wide, did not conform to the special ditch which hugs the shoulder at station 7+00 but transitions to further off of the shoulder at 4+00. This special ditch is best handled with Template Point Centerline. To complete the special ditch design, use Polyline to Centerline File.
on both ditch polylines, calling the inside polyline BD1.CL and the outside polyline BD2.CL, as a reference to the ditch IDs, BD1 and BD2. You can give them a starting station of 0. The stationing of the ditch polyline does not matter, since only the coordinates of the centerline in the command Assign Template Point Centerline are used to determine the template ID position. Within Assign Template Point Centerline, Add each of the ditch sides as shown:

Note that if the ditch always exists on the left side, the ditch grades can be defined using the Grade button in Design Template, rather than using the Ditch feature within the Cut button. For final results, run the Process Road Design command using a combination of the Template Transition File and the Template Point Profile.

The end result is a final drawing that uses the Template Transition file to create the correct edge of pavement and uses the Template Point Centerline file to track along the correct ditch polylines. This is shown below in the final drawing of the 3D polylines generated by Process Road Design:

The actual slope to the ditch on the left is held at the design of 3:1, or whatever exists within the template from shoulder (SH) to base of ditch (BD1) in cut. Shown below in the Input-Edit Section File screen editor is station 6+50, where the ditch is designed very close to the shoulder:
Note that the distance from BD1 to BD2 is irregular, based entirely on the plan view offset of the ditch polylines. Note also that BD1 to SH is 3:1, holding the defined slope. (The cursor position also can be used to verify slope of any portion of the section in "real-time".) Finally, note that the subgrade follows the widening and irregular position of the pavement lane EP for both left and right sides, since the subgrade offset from centerline was defined as EP.

Although superelevation can be handled by use of superelevation files, for most simple applications (2-lane roads in particular), a single curve with superelevation can be handled by a template series file, using only 3 templates: normal crown, reverse crown, full super. This is illustrated below, for a typical 2-lane road template:

The actual Template Series File will consists of 6 entries for one curve: Normal, Reverse, Begin Full Super, End Full Super, Reverse, Normal. You would only need to make one extra template, for simple roads, for every additional curve, for the full super condition, since normal and reverse crown remain the same. Note that the curbs, even on the high side, can be designed to slope downward and catch the shoulder drainage in Design Template.
by use of "special slope" of -1% in the curb design, or by entering a value for the added "Drop" across the gutter portion. Both methods create a downhill slope to the face of curb. So the above project might be designed as shown below in the Input-Edit Template Series command:

![Input-Edit Template Series File](image)

- **Input-Edit Template Series File**

  Saved c:\road2000\DATATemplateSeriesCurb.txt

<table>
<thead>
<tr>
<th>Station</th>
<th>Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000</td>
<td>TemplateNom:tpl</td>
</tr>
<tr>
<td>250.000</td>
<td>TemplateNom:tpl</td>
</tr>
<tr>
<td>500.000</td>
<td>TemplateNom:tpl</td>
</tr>
<tr>
<td>425.000</td>
<td>TEMPLATE4-5TPL</td>
</tr>
<tr>
<td>675.000</td>
<td>TEMPLATE4-5TPL</td>
</tr>
<tr>
<td>800.000</td>
<td>TemplateRev:tpl</td>
</tr>
<tr>
<td>900.000</td>
<td>TemplateNom:tpl</td>
</tr>
</tbody>
</table>

  Note that beginning and ending stations are not necessary. If station 0.00 was omitted, Process Road Design would use the normal template in any case from station 0 to 250. Similarly, Process Road Design will use the normal template going forward from station 900 automatically.

**Review of 2 Methods of Matching Portions of Existing Roads**

There are two main techniques for tying new template designs into existing roads, which may apply to road expansions, urban re-paving, grade improvements and other renovation projects. As more and more roadwork involves road improvement rather than new road development, these techniques become more useful and critical to master. The two techniques are: (1) Use of Template Point Profile and Template Point Centerline files to match existing conditions on portions of roads that do not change, and (2) Use of the "As-Built" cross section feature as one of the input files. An advantage of the As-Built method is that you can insert section points with special IDs for special features, whereas the Template Point Profile and Template Point Centerline methods must follow template IDs that are found in the original, main template design file. But the Template Point or "string" method allows for calculating sections at any interval, while the As-Built section method will revise final sections only at stations found in the As-Built section file.

Consider this alley-way, which consists of a Belgian block style curb (no gutter) that is already in place. The plans are to remove a crowned asphalt alleyway and put in a bricked alleyway on sand, with a central, "depressed" rock drain of 1’ width, to avoid water draining against buildings that abut the alley. But the design must match an existing "Belgian block" style curb on the right side of the road, which will not be removed.
There is a new profile design involved, and a new template. However, the right side of the template will meet the exact grade and offset of the in-place curb, which has been surveyed as back of curb (CB3). Then the command Offset 3D Polyline was used to create the face of curb at EP=CB1, and to create the inside top of curb (CB2). Because of the symmetry and consistency of the curb, only the back of curb needed to be surveyed to hold the existing curb feature in place within Process Road Design. From that survey, the 3D Polyline for the EP is derived, which will be used for Template Point Centerline and Template Point Profile.

Features such as curbs and medians can be designed once within Design Template and then saved as curb or median files, then re-loaded and used in other templates, and applied to the left or right side of the template as desired. The central rock median of 1’ total width can be constructed as two subgrades, one on the left side of 0.5’ width and one on the right side of 0.5’ width. The brick portion can be designed as a 4” thick subgrade as shown below. On the left side, you would need to use the "Straight Up" method of closing the subgrade surface. On the right side, you can use "Continue Slope". When using Continue Slope, it is best to underestimate the length needed to contact the next surface (the right curb), so continue can do an “extend” and find it. If you make the length too long (e.g. 6’, which catches the curb which itself tilts back -2%), the program will not trim and will draw the subgrade to the back of the curb. Note that the vertical subgrade depth can be entered as 4 or -4. Both are accepted.

| Slope Type          | | Slope (°) |
|---------------------|-----------------------|
| Match Surface       | | 0.00      |

| Intersect surface   | | Wrap Height |
|---------------------|-----------------------|
| Continue Slope      | | 0.00        |

| Horizontal Offset   | | Units: |
|---------------------|-----------------------|
| 0.5                 | | Feet         |

| Vertical Offset     | | Material: |
|---------------------|-----------------------|
| 4.00                | | Brick         |

Be sure to define the sand subgrade on the right side (lowest subgrade) to have a distance of EP, a flexible distance that follows the precise offset of the EP "ID", which will be assigned to follow the face of curb template point profile defined by CB1 above.
The next step is to set up the face of curb 3D polyline as a template point centerline and template point profile assigned to "EP". First you must do Polyline to Centerline File, pick the inner 3D polyline which is face of curb at proposed road level. Then you must do Profile from 3D Polyline and make a profile for the "EP". Then you assign this centerline and profile to the appropriate ID (EP) to force the curb to contact the correct curb position and elevation. The curb defined in the template matches the pattern of the in-place curb, so by setting EP to the correct template centerline and profile, the curb will "follow" at the correct position. The stationing used for the template point centerline is not critical to the calculation. However, the profile stationing much match and reference the centerline stationing. Therefore, when doing the command Profile from 3D Polyline, answer Yes to the question: "Station by another reference centerline [Yes/No]". Making the Template Point Profile is always best accomplished by this method of Profile from 3D Polyline, referencing the design centerline. The Template Point Profile (and Template Point Centerline) would appear as shown here:

The files in Process Road Design would be set up as follows:
Note that no existing surface file is needed to compute final cross sections from as-built (straight wall on left of alley) to as-built (existing curb on right of alley). A final section is plotted below, showing the unique slope and lane distance determined by the as-built centerline and profile files that control the edge of pavement, and by extension, the curb, which continues with fixed dimensions from the edge of pavement.

A second method of doing as-built road design is to use the as-built cross section method. Whenever as-built cross sections are specified as part of the input files in Process Road Design, and then referenced for use on the Additional Road Design Parameters screen within Process Road, those offset IDs that are referenced will be held. Any matching IDs or new IDs found in the as-built cross sections will be substituted for the designed IDs within the final sections. In the example below, it might be proposed to redesign Edgemont Road from a roadside ditch road to one with a curb and gutter as well as sidewalks. However, the designer might want to keep the existing central median, already curb and gutter with plantings.
This example raises the challenging issue of inserting special interior points with new IDs into a set of design cross sections, through a length of about 125 feet of road. If a cross section of the island is taken through station 1+00, it might have the following ID points:

This cross section could then be part of an as-built cross section file (.SCT) which can be recorded at any desired station interval, the smaller the interval, the greater the accuracy. Now if the actual road template is defined as EP for edge of pavement and standard CB for curb, with CENTER for the centerline position, Process Road Design will substitute the As-Built File CENTER ID for the one calculated by the program, and will add in all the unique IDs from the cross section file, from -15.011 left to 15 right. Interestingly enough, this Edgemont Road example would also require a Template Point Centerline for the left and right edge of pavement, to pull the paving edge out to the expanded road dimension, which doesn’t taper to normal until station 3+35.51. It would not require a Template Point Profile, so long as the road maintained a consistent design slope from centerline. When using Template Point Centerline, you need to turn the edge of pavement polylines into centerline files. Before doing so, test each polyline.
with the command Reverse Polyline (within Polyline Utilities under Edit) to verify that the polyline is drawn in the correct direction, as shown by the phantom arrows. The file Template Point Centerline elements might appear as shown:

Be aware that a subgrade such as a concrete sidewalk, if it is to be placed behind the curb, must reference the curb or the edge of pavement ID for positioning, whenever the edge of pavement offset is changing based on use of a Template Point Centerline or As-Built cross section file containing duplicated IDs for edge of pavement. You can specify an offset for the sidewalk in the Subgrade option within Design Template, as shown below. The "2.52" offset was used to move past the tilting edge of the back-of-curb, which slightly exceeds 2.50.

If the Island.sct file is the as-built cross sections, the entire input screen for the Edgemont Road project might appear as follows:
In the next dialog, fill in the descriptions for the section points in the As-Built IDs To Use field.

Here is the resulting output section file showing the combination of the design template with the as-built section points.
Example Divided Highway with Special Super Elevation Treatment

Divided highways such as 4-lane highways with a central depressed, grassy median are among the most challenging roads to define as templates, especially when accurate subgrade elevations and quantities are involved. Rules for superelevation and subgrade pivot points must be applied. And most divided highways do not use the centerline as the profile and require shifting the profile elevation to a specific template ID, like the inside edge of pavement or crown point for each side of the highway. This shifting occurs within Process Road Design. Furthermore, many highway departments have complicated rules for the profile grade. One such rule is that in superelevation, when the pivot lane reaches reverse crown, the profile moves from the crown of the road to the inside edge of pavement. Whatever the delta Z between the crown profile grade and inside edge of pavement profile grade is at reverse crown, this delta Z is subtracted from the profile grade and determines the profile of the inside edge of pavement from reverse crown through full super and back to reverse crown again. This typically improves drainage within the median portion, since a steep superelevation pivoting from the crown of the road can either reduce the median depth, or force the median too low. This is illustrated in the graphic below. Such challenging highways can be designed using special features within Design Template and Process Road Design.

The divided highway template itself can be quite complex. Let's review the requirements of our template below, first left side, then right side, in superelevation of 4.5%.
The main criteria for the design is that the pavement lanes are 12' wide, with 2% slope from the crown point in the middle (except in superelevation). On the interior high side of superelevation shown above, the grade breaks off at the EP or inside edge of pavement, and the maximum algebraic difference is 7%. So at 4.5% superelevation, the normal 4% downhill shoulder slopes instead at 7%-4.5%=2.5%, as shown. This part of the template behavior is controlled by the Superelevation Shoulder button within Design Template, with entries as shown here:

![Super Elevation Settings](image)

Note that the Super Elevation Settings dialog treats the "interior" of the road in the upper part, and the exterior of the entire road (like a 2-lane road) in the lower part. So the "Low Side Pivot Point" under the lower "Transition from Super to Normal" is where, walking from the middle of the road towards the left, super ends and normal slopes resume. That is set to OSH, or the outside shoulder position, the goal being to slope the full shoulder with the superelevation on the lower outside shoulder lane, then resume normal (non-super) slope at the 6:1 "recovery zone" slope. The entry of OSH as Low Side Pivot Point for Super to Normal controls that. In the upper part of the dialog, the inside "Transition from Normal to Super" sets the Low Side Pivot Point at EP. So at EP, walking from the template center left towards the left side of the road, normal ends at EP and superelevation begins. So the median upslope of 6:1 is normal, as is the shoulder, the super starts at EP. But because the 7% maximum percent slope difference is active, the shoulder can't remain at 4% but goes to 2.5% leading to the 4.5% superelevation. When super subsides to 3% or less, the shoulder would be normal at 4% as specified in the template design in this case.

Referring to the graphic above showing the left side of the divided highway, the gravel for the shoulder is shown running out to "daylight" on the outside recovery zone and on the inside median slope. However, to reduce quantities of stone, the stone runs at a uniform slope of -2% in normal crown, or matches superelevation, but pivots to 1% downhill at the outside OEP and 4' past the inside EP. This is accomplished through the subgrade entry dialog. First, the outside subgrade:
Note that the normal slope of the stone subgrade does not follow the surface but stays at the "special" slope of -2%, matching the surface always only beneath the asphalt portion within the pavement zone. For divided highways, it is always necessary to do at least 2 subgrades for each material: one from the crown or middle of the road "out" to the outslope (as above), and one from the crown or middle of the paved portion in to the interior. Since the crown of the road on each side of the highway is 32 feet left of the center depressed median position, the horizontal offset for the "out" position is 32. Enter the vertical offset as the entire distance from the horizontal offset down to subgrade bottom. In this way, any other thinner subgrades above are deducted from total subgrade quantities of the grade under consideration. If the goal is to "force" a -1% slope in both normal crown and superelevation, then set the Max Slope After Pivot(%) to -1%, and click "Special". Then set both Standard Slope and Minimum Slope Percent to -1%. This ensure that -1% will be used at the pivot offset of OEP, or as specified. Apply this to both subgrades ("in" and "out" from horizontal offset 32). If you simply entered -1% for the Max Slope After Pivot(%) and clicked Normal, slopes on the low side would break over to -1% but slopes on the higher side of each superelevation lane (beneath inside shoulder on the left, outside shoulder on the right) would continue on at the super slope and not break off. You must use the "Special" setting. The low side shoulder for the inside portion of the left side of the road is specified by the "In" subgrade, in this dialog:
The pivot point for the subgrade on the inside left of the template is ISH+4, or 4 feet from inside shoulder to inside edge of pavement, the +4 being the direction walking out from the middle of the template in all cases. The right side of the template is shown next:

On the right side, the high-side subgrade pivot in the "out" direction, walking from the middle of the road outward, is OEP+4. On the right side, the high-side subgrade pivot in the "in" direction is simply ISH, as shown. So the controls exist to specify critical break points on subgrade and surface grades using Design Template. Whether this is the best design can be debated, but the controls are there to create surface and subgrade slope breaks and grade changes.

Referring to the Super Elevation Settings dialog above, the key to setting the superelevation of the divided highway to the inside edge of pavement at reverse crown (minus the 0.24 delta Z from profile grade to inside edge of pavement grade) is to click on the option, "Pivot Super From Low Edge".

Now you must run Process Road Design, using this template, to produce verifiable final cross sections. Set the Process Road "Additional Parameters" dialog such that "Crown" (or whatever ID is used for the center crown point on each side of the road) controls the profile grade.
The final sections that are produced will shift the profile grade to the inside edge of pavement from reverse crown to reverse crown through superelevation, adjusted \-0.24\'. A final section is shown plotted below as drawn using Draw Section File:

\[\text{Pulldown Menu Location: Roads}\]
\[\text{Keyboard Command: eworks}\]
\[\text{Prerequisite: Profile file and template file}\]

**Road Network**

This command synthesizes road network design for subdivisions and commercial and industrial sites by enabling interactive 3D design of all road centerlines, profiles and templates, including cul-de-sacs. A docked dialog on the left of the screen identifying the existing DTM surface and all road files combines with an active CAD screen and command line. You can save drawings and run virtually any standard Autocad command while within the docked dialog. Once the user identifies all centerlines involved, the program detects intersections and end segments suitable for cul-de-sacs, and through user input of design parameters for cul-de-sac dimensions and intersection transitions, the program will process the complete 3D design, with output options including cross sections, 3D faces, TIN files and contours. The many roading files involved in a road network design are all saved to an "RDN" file that can be recalled, modified and re-processed.

This **Road Network Help** document is divided into 7 parts: **Road Network Task Pane, Road Network Settings, Adding and Editing Roads, Road Network Road Profile Editor, Adding and Editing Intersections, Adding and Editing Cul de Sacs, Road Network Workflow Example #1** and **Road network Workflow Example #2**

When designing roads using Carlson’s **Road Network** feature, all work is done through a **Task Pane** that docks along the left side of the drawing screen. Having the **Task Pane** open and active does not prohibit or interfere with normal Command: line or other CAD functionality.

All settings and files associated with a roadway design project are saved in the Road Network (.RDN) file. Upon starting the **Road Network** command, the user is prompted to open an existing or create a new Road Network
(.RDN) file in which to save the project data. Once loaded, the active Road Network filename is displayed at the top of the Task Pane.

Once Roads, Intersections and Cul-de-Sacs have been added to the Road Network, selecting any one of them in the project tree highlights the feature and centers it in the drawing screen. Highlighting and centering options may be changed in the Display Options tab of the Road Network Settings dialog box.

Road Network Task Pane

This area of the project tree lists the Roads defined as part of the Road Network. See Road Network: Adding and Editing Roads for additional assistance. The functions are accessed by right-click on the tree or by the icon buttons at the top of the dialog.

Add: Pick this button to Add a Road to the Network. After adding the Road, the Edit Road dialog box is displayed allowing the user to manage and make changes to the Input Files and Output Files for the selected Road.

Edit: Pick this button to display the Edit Road dialog box to manage and make changes to the Input Files and Output Files for the selected Road.

Remove: Pick this button to delete the selected Road from the Road Network. After Removing the Road from the Network the design files associated with that Road will remain in the project folder.

This area of the project tree lists the Intersections within the Road Network. Intersections are created automatically as intersecting Roads are added to the Network. See Road Network: Adding and Editing Intersections for additional assistance.

Edit: Use this button to display the Edit Intersection dialog box and make changes to the Input Data and Output Files for the selected Intersection. Other changes that can be made to the Intersection design are:

1) Changing the Primary/Secondary status of the Roads creating the Intersection,
2) Making design changes that apply to the entire Intersection,
3) Making design changes that apply to one or more Corners of the Intersection.

Reset: Use this button to overwrite all design changes made to the selected Intersection and reset to the original Intersection design.
This area of the project tree lists the Cul-de-Sacs defined as part of the Road Network. See Road Network: Adding and Editing Cul-de-Sacs for additional assistance.

**Add:** Picking this button will display a list of Roads in the Network and prompt the user to "Select Road for Cul-de-Sac"... After selecting the Road, the Edit Cul-de-Sac dialog box is displayed allowing the user to specify the Input Data and Output Files for the Cul-de-Sac.

**Edit:** Use this button to display the Edit Cul-de-Sac dialog box and make changes to the input data and output files for the selected Cul-de-Sac.

**Remove:** Use this button to Remove the selected Cul-de-Sac from the Road.

**Process:** Use this button to manually trigger the computation process for the Road Network and perform the tasks configured in the Output Options tab of the Road Network Settings dialog box.

**Report:** Use this button to Save or Print one of two Reports provided by the Road Network feature which are: the Output Processing report and the Input Data Files report. Default Report settings can be changed in the Report Options tab of the Road Network Settings dialog box.

The Output Processing Report displays the cut/fill and material quantities for each Road, Intersection and Cul-de-Sac of the Road Network.

### Road Network Output Processing Report

The Input Data Files report displays all of the user-specified design files associated with the Road Network. The user has the option of reporting only the filename or both the path and filename.
Road Network Input Data Files Report

Settings: This button displays the Road Network Settings dialog box which is the starting place for all projects designed using the Road Network feature. There are 5 tabs in the dialog box: Process Options, Output Options, Report Options, Display Options and Transition Defaults.

Save: Pick this button to Save the Road Network (.RDN) file.
SaveAs: Pick this button to Save the current Road Network (.RDN) file and give it a new path and/or filename.
Load/New: Pick this button to Load an existing or start a New Road Network (.RDN) file.
Exit: Pick this button to Exit the Road Network command and close the Task Pane.
The Road Network Settings dialog box is accessible from the Settings button on the Road Network: Task Pane.

The Road Network Settings dialog box is the starting place for all projects designed using the Road Network feature. There are 5 tabs in the dialog box: Process Options, Output Options, Report Options, Display Options and Transition Defaults.

Process Options Tab
**Existing Surface**: Use this button to browse to and select the Existing Surface file to be used for the Road Network. Either a TIN or FLT triangulation file are accepted as valid surfaces, both of which can be made within the command Triangulate and Contour. For speed, it is recommended that the binary TIN file format be selected.

**Rock Surface**: Use this button to set the Rock Surface file to be used for the Road Network. This Rock Surface is optional. When the Rock surface is specified, the program will report rock quantities with the cut. Also, the cut definition in the road template file can have a separate slope to the rock surface.

**Station Interval**: These settings determine the distance between cross-section samples. The user has the option of specifying one sampling interval for the Intersection and another for the remainder of the Road.

**Existing Section Max Offset**: Use this setting to specify the furthest distance left and right of the Centerline that cross-sections are to be sampled.

**Special Stations**: This button displays the Stations to Process dialog box (shown above). This box allows the user to decide whether or not cross-sections are to be sampled at critical design points along each Centerline. **Special Stations** include critical points such as the PC & PT for Centerlines and the PVC, PVT, High Point and Low Point for Profiles. "Additional Special Stations" may be added by entering the station number. These settings apply to all Roads in the Road Network. To identify Special Stations for a particular Road, pick the Special Stations button in the Edit Road dialog box.

**Process On Updated Design Files**: This setting has 3 options: **Off**, **Prompt** and **Auto**:

- **Off**: This option allows changes to the design files without triggering an automatic update to the entire Road Network.
- **Prompt**: This option automatically prompts the user, "**Process Road Network?**" when design files are changed.
- **Auto**: This option automatically updates the Road Network any time a design file is changed.

**Slope Perpendicular To**: This setting allows the user to specify the direction of cut and fill slope projection by selecting one of two options: **Centerline** and **Slope Direction**. The Centerline method projects the cut and fill slopes perpendicular to the Centerline of the Road without regard to the Profile of the Road. The Slope Direction method considers the Profile of the Road when projecting the specified cut and fill slopes. For example, projecting cut and fill slopes of 2:1, perpendicular to the Centerline, along a length of Road with a Profile slope of 10% would result in a slightly steeper slope (1.96:1) if measured along the top or toe of that slope. If the same conditions exist
but the *Slope Direction* method is applied, the resulting slope (when measured perpendicular to the Centerline) is slightly less steep (2.04:1) but when measured along the top or toe of slope will be exactly 2:1.

**Tie to Existing**: If enabled and cut and fill slopes have been defined in the Template (.TPL) file, this setting will project the specified slopes to the Existing Ground surface. If not enabled, the Road design will stop at the last Template ID preceding the cut and fill slopes.

**Process Intersections**: If enabled this option will calculate all Roads and Intersections. If it is not enabled, each Road will be processed individually.

**Connect Roads**: This option applies to the 3D polylines/breaklines that are created when Processing the Road Network. If this option is enabled, the 3D polylines for different Roads will be combined around and through Intersections. If it is not enabled, the polylines will be drawn for each Road separately.

---

**Output Options Tab**

**Triangulate and Contour**: When enabled, use the **Setup** button to display the *Triangulate and Contour From Road Network* dialog box. Since this command is very similar to the *Surfaces → Triangulate and Contour* command, only those Settings and Options directly affecting the Road Network will be discussed here. Please refer to the Help files for that command if additional assistance is needed.

**In the Triangulate and Contour From Road Network dialog box...**

**Triangulate tab**

**Draw Triangulation Faces**: The *Road Network* version of this command provides additional controls (beyond those in the standard *Triangulate and Contour* command) for managing the color of the "Triangulation Faces". Once the "Triangulation Faces" option is enabled, the **Set Colors/Layers** button becomes active and, when picked, will display the *Road Color Settings* dialog box (shown below). The color of the faces can be set either by using the Template IDs defined in the Template (.TPL) file or using a color range based on the "Cut & Fill Depths" that uses a range of Reds and Blues to show areas and depths of Cut and Fill for the proposed Road Network. After the Road Network has been Processed, these shaded faces can be viewed using the **3D Viewer Window** command. Also within Triangulate & Contour, there is **Draw Slope Arrows** to create arrows in the drawing to show the direction of each triangular "plate" in the Road Network TIN. This can be helpful to visualize where water will be flowing.
Write Triangulation File: Once enabled, use the Browse button to specify the path and filename for the roadway design Surface (.TIN) file.

Set Road Colors In the "Triangulate and Contour From Road Network" Dialog Box

Contour and Labels tabs...
Use these tabs to define the settings for proposed contours and contour labels.

Output Options ( Continued )

Merge Road with Existing: When enabled, use the Set button to specify the path and filename of a third Surface (.TIN) file to be created by merging the Existing and roadway design Surface (.TIN) files.
Surface To Draw: When creating both the road surface with Triangulate and Contour, and the combined road with existing ground using Merged Road, then this option is used to choose which surface to draw as 3D faces.
Write SurvCE Stakeout: When enabled, use the Set button to specify the path and filename of a SurvCE Stakeout (.RNF) file to be exported. This file can be directly loaded into data collectors using Carlson SurvCE for unlimited field stakeout of the Road Network.
Draw 3D Template Polylines: When enabled, this option will draw all 3D polylines used to generate the roadway design Surface. This option is automatically enabled when the Triangulate and Contour option is enabled. The layer for the polylines is set by picking the Set Layers button in Output Options.
Draw 2D Template Polylines: The 2D Template Polylines are the same as the 3D Template Polylines except that these polylines are created at zero elevation as lwpolylines. The layer names are the same except with the Layer Suffix added.
Draw Disturbed Area: When enabled, this option will draw a closed, zero-elevation polyline around the limits of disturbance of the roadway design Surface. The layer for the polyline is set by picking the Set Layers button in Output Options.
Draw Subgrade Polylines: When enabled, this option will draw all 3D polylines used to generate the roadway subgrade Surface(s). These polylines can be used to manually generate additional surfaces for modeling, stakeout or machine control purposes. Entering an asterisk (*) in the text box will draw polylines for all Template IDs. Once a
Road has been added to the Network, the Select button will be activated. Picking the Select button displays a view of the Template (.TPL) file at the starting station and allows the user to Draw polylines for selected Subgrade IDs. If needed, the Next and Previous buttons at the bottom of the window allow the user to browse through the stations of the road design to find a particular Subgrade ID. The layer for the polylines is set by picking the Set Layers button in Output Options.

![Select Template Descriptions from Stations: 0:30:000](image)

**Pick Subgrade Polylines to Be Drawn**

**Draw Template Slopes**: When enabled, this option will draw slope arrows parallel to the Centerline at the selected Template IDs. This option may be used to indicate direction and steepness of slope along the flowline of the gutter. Entering an asterisk (*) in the text box will draw slope arrows for all Template IDs. Once a Road has been added to the Network, the Select button will be activated. Picking the Select button displays a view of the Template (.TPL) file (similar to the one shown above) and allows the user to Draw polylines for selected Template IDs. If needed, the Next and Previous buttons at the bottom of the window allow the user to browse through the stations of the road design to find a particular Template ID. The layer for the slope arrows is set by picking the Set Layers button in Output Options. Other slope arrow settings are specified by picking the Set Slopes button in Output Options.

**Draw Cross Section Polylines**: When enabled, this option will draw a 3D polyline defining the roadway design surface cross-section at each sampled station along the Centerline. These polylines can be used to manually generate additional surfaces for modeling, stakeout or machine control purposes. The layer for the polylines is set by picking the Set Layers button in Output Options.

**Draw Cut/Fill Arrows**: When enabled, this option will draw arrows at each sampled cross-section station so that the arrow is pointing down-slope. The example shown below indicates a section of Cut slope transitioning to a section of Fill slope. Once enabled, the user has the ability to adjust the size of the arrows and specify whether or not the Cut/Fill Arrows should be solid.
Cut/Fill Arrows On Slopes

**Label Profile on Centerline:** When enabled, this option labels Profile slopes and critical points such as PVC, PVT, High and Low Points in plan view along the Centerline. Once enabled, use the **Setup** button to open the **Label Profile on Centerline Settings** dialog. Then, from the list of "Available Labels", select the label(s) to be drawn and use the **Add** button to shift them to the list of "Used Labels". Selecting one of the "Used Labels" and then picking the **Setup** button allows the user to configure the label style and settings for each type of label.

![Label Profile on Centerline and Label Setup Dialog Boxes](image)

**Output Coordinates:** When enabled, this option allows the user to export a Coordinate (.CRD) file containing all of the critical points for the Road Network. Once enabled, pick the **Setup** button to specify the path, file name and other criteria for the point file.
Point Output Settings Dialog Box

Output EOP Profiles: This option creates individual Profile (.PRO) files for the specified template grade such as the edge of pavement. The EOP profiles use the stations of the main centerline and the elevations from the template grade. You can create up to two EOP profiles such as for curb flow line and top-of-curb.

Output EOP Profiles Dialog Box
Elevate Pads: When enabled, this option adjusts the elevation of closed polylines within a specified proximity of the Road Network. Once enabled, use the Setup button to open the Elevate Pad Settings dialog box and configure the settings.

In the Elevate Pad Settings dialog box...

Reference Template ID: When determining the new pad elevation, all distances and elevation changes are based on the Template ID specified here. Type the Template ID in the text box or use the Select button to choose from a list.

Pad Layer: All original polylines found on this layer (and within the Max Offset of the Reference Template ID) will be elevated.

Max Offset: All original polylines within this distance of the Reference Template ID and on the specified "Pad Layer" will be elevated.

Reference Elevation: This setting has 3 options: "Highest Elevation", "Lowest Elevation" and "Elevation at Middle". Of the elevations found along the Reference Template ID that are adjacent to the pad polyline, the command will use either the highest, lowest or middle elevation found to set the new pad elevation.

Slope Type: This setting has 3 options: Percent (%), Ratio (x:y) and Vertical (change in elevation).

Cut/Fill, Normal/Min/Max Slopes: For future earthwork balancing adjustments, the settings in this dialog are used to specify the range of allowable slopes when in cut or fill conditions.

Assign New Layer: When enabled, this option allows the user to specify a new layer for the new, elevated pad polyline. Once enabled, either type the new layer name in the text box or use the Select button to choose the layer from a list.

Retain Original Polyline: This option is only available if the "Assign New Layer" option is enabled and will keep the original, zero-elevation polyline in addition to the new, elevated polyline. If this option is not enabled, the original polyline will be deleted from the drawing.

Elevate Pad Settings Dialog Box

In the dialog shown here, all closed polylines on layer PAD that are within 100 feet of the road will have their elevations set based on a 2 percent grade up from the PA VE Template ID point, in either Cut or Fill conditions. In future earthwork balancing adjustments, the polyline can be adjusted a maximum of up to a 10 percent grade or down to a 1 percent grade from the Reference Template ID. The example below shows the results of elevating a pad so that it is 2.0' above (using Vertical option) the highest point along a Reference Template ID of "SH" (Shoulder).
Elevate Lots: When enabled, this option follows a logic similar to that of the Elevate Pads routine in that it elevates zero-elevation lot lines relative to a road design and based on a set of grading rules. Once the option is enabled, use the Setup button to display the Elevate Lots Setup dialog box.

In the Elevate Lots Setup dialog box...

Grading Rules: The necessity of a Grading Rules (.GRR) file is the key difference between elevating pads and elevating lots. If a Grading Rules (.GRR) file has already been prepared, use the Select button to browse to and select the file. To create a new file, pick the Edit button to open the Define Grading Rules dialog box and specify the desired settings. Then, pick the SaveAs button to Save a Grading Rules (.GRR) file. Define Grading Rules is a command that also exists outside of the Road Network feature. Please refer to the Help files for that command if additional assistance is needed.

Reference Template ID: When determining the elevations for the new lot line, all distances and elevation changes are based on the Template ID specified here. Type the Template ID in the text box or use the Select button to choose from a list.

Input 2D Lot Layer: All original polylines found on this layer (and within the Max Offset of the Reference Template ID) will be elevated. Either type the layer name in the text box or use the Select button to choose the layer name.

Output 3D Lot Layer: This is the layer to which the newly elevated lot lines will be assigned. Either type the layer name in the text box or use the Select button to choose the layer name.

Front to Ref Max Offset: Use this setting to specify a distance from the Reference Template ID beyond which Lot Frontage polylines will not be elevated.

Back to Ref Max Offset: Use this setting to specify a distance from the Reference Template ID beyond which Back/Rear Lot polylines will not be elevated.
Output Options (Continued)

Set Layers: Pick this button to display the Road Network Layers dialog box.

Set Slopes: Pick this button to display the Road Network Slopes dialog box and configure the settings for drawing slope arrows.
Road Network Slopes Dialog Box

**Output File Defaults**: Pick this button to specify default output file names for Centerline (.CL), Profile (.PRO) and Section (.SCT) files to be created when Processing the Road Network. Each item in the road design (Road, Intersection, Cul-de-sac) has its own output file names. The default options in this dialog apply to fill out default output file names when the item is first added to the road design. The Output Existing Profile At Left/Right options create offset profiles within the existing ground output profiles.

Output File Defaults Dialog Box

Settings on this tab allow the user to specify defaults for the Road Network Report feature. This feature is accessible from the Report button of the Road Network: Task Pane.

**Report Precision**: Specify the decimal precision for the report.

**Use Report Formatter**: This option allows for customized report layout and contents. Otherwise a standard report is displayed.

**Report Cut/Fill End Areas**: Specify whether or not to report cut/fill at each station.

**Report Cut/Fill Differences**: Adds a running total of the cut to fill balance at each station to the report.
Report Cumulative Cut/Fill: Adds a running total of the cut/fill at each station to the report.
Fill Shrink/Cut Swell Factor: Allows you to specify a value that the volume calculated will be multiplied by.

Report Options Tab

Settings on this tab allow the user to configure special display characteristics in order to identify the Road, Intersection or Cul-de-Sac selected in the Road Network: Task Pane.

Display Options Tab

Settings in this tab allow the user to specify the default values used for transitioning from Road to Road, from Road to Intersection and from Road to Cul-de-Sac.

CL Intersections: Use this setting to define the default transition distance and vertical curve length for intersecting Centerlines. See Road Network: Adding and Editing Intersections for more.

Side Intersections: Use this setting to define the default vertical curve length for the Profile and the default radius for Corners at Intersections. See Road Network: Adding and Editing Intersections for more.

Surface Method: When calculating Intersections, there are two options for handling the cross-sections of the intersecting Roads: "Hold Main Crown", which honors the Primary Road Template through the Intersection, or "Radial from Curb", which grades between the Centerline Profile and the Profile of each Corner of the Intersection. The Profile for the Corner may be defined as the edge of pavement (EP), back of curb (BC) or other point on the cross-section by specifying the Template ID in the Settings tab of the Edit Intersection dialog box.
Surface Method: Radial From Curb

Surface Method: Hold Main Crown

Transition Method: This setting applies when a Road has a varying width through an Intersection. The "Across Intersection" option looks at the Primary Road (from start to end of the Intersection) to find the maximum offset distance between the Centerline and edge of pavement, and uses this distance to set the edge of pavement breakline across the Intersection with the Secondary Road. The "Mid Point" option simply finds the pavement width at the Intersection station and uses this distance to set the edge of pavement breakline across the Intersection.

Cul-de-Sac: Use this setting to define the default vertical curve length along the Cul-de-Sac Profile.

### Transition Defaults Tab

Roads in a Road Network are managed in the Road Name area of the Road Network: Task Pane.

**Add:** Pick this button to Add a Road to the Network. After adding the Road, the Edit Road dialog box is displayed allowing the user to manage and make changes to the Input Files and Output Files for the selected Road.

**Edit:** Pick this button to display the Edit Road dialog box to manage and make changes to the Input Files and Output Files for the selected Road.

**Remove:** Pick this button to delete the selected Road from the Road Network. After Removing the Road from the Network the design files associated with that Road will remain in the project folder.
Adding a new Road may be done either by selecting a pre-defined Centerline (.CL) file or by screen-picking a 2D Polyline in the drawing and assigning a new Centerline (.CL) file to it.

**Add**: Use this button to **Add** a Road to the Road Network or right-click on Roads in the project tree and pick Add Road. After picking the **Add** button, the **Add Road** dialog box gives the user the option to "Select Centerline By..." **Centerline File** or **Screen Pick Polyline**. If the **Centerline File** option is chosen, the user is prompted to browse to and select the Centerline (.CL) file.

![Add Road Dialog Box](image)

**Specify Method to Use to Add Road**

If the **Screen Pick Polyline** option is chosen, the user is prompted to select a polyline in the drawing. If an associated Centerline (.CL) file is not found in the project folder, the **Set Centerline** dialog notifies the user that, "No centerline file associated with polyline..." and the user must choose to either select another polyline or to **Assign Centerline File to Polyline**.

![Set Centerline Dialog Box](image)

**Set Centerline Dialog Box**

After picking the **Assign Centerline File to Polyline** button, the **Centerline to Set** file dialog box prompts the user to assign a path and filename for the new Centerline (.CL) file.

![Centerline to Set File Dialog Box](image)

**Centerline to Set File Dialog Box**
Immediately upon defining the new Road, the **Profile to Use** file dialog box prompts the user to assign a path and filename for the proposed Profile (.PRO) file for the Road. By default, the new Profile (.PRO) file is named the same as the Centerline (.CL) file.

![Profile to Use File Dialog Box](image1.png)

**Profile to Use File Dialog Box**

After specifying the Centerline (.CL) and Profile (.PRO) files for the Road, the **Edit Road** dialog box is displayed. This dialog serves as the "manager" for all files relating to the specific Road. The **Edit Road** dialog box allows the user to apply settings and associate various files that are specific to the Road - not the entire Road Network. The **Edit** button in the **Road Name** section of the **Road Network: Task Pane** also displays this dialog box.

![Edit Road Dialog Box](image2.png)

**Edit Road Dialog Box**

**Intersection Only**: If this option is enabled, Road Network will only consider the portions of this Road that
intersect with other Roads when calculating the design.

**Full Range:** This option will process the full station range of the road. Otherwise, turn this option off and set the **Station Range** to process a subset of the road.

**Cut Benches:** Pick this button to specify up to 4 triangulation surface files to use when the "Slopes In Series" and "Cut to Surface" options are used in the Template (.TPL) file. In cut conditions, the program will look to intersect with these surfaces before it reaches the final target surface which is the Existing Surface set under Settings. The order of the Cut Bench Surfaces are from lowest to highest cut. So the Bench #1 is closest to the road and Bench #4 is furthest.

**Station Settings:** Pick this button to display for special stations and cut/fill gaps.

**Special Stations:** Enter one or more stations at which to sample cross-sections.

**Cut/Fill Gaps:** Use the Add and Remove buttons to define a series of station ranges for cut/fill gaps where the program will not calculate any volumes or apply the template cut/fill tie slopes. For example, these stations could be used across a bridge.

---

**Add Road Specific Special Stations**

A Centerline (.CL) file, a Profile (.PRO) file and a Template (.TPL) File are **required** in order to process a roadway design using the **Road Network** feature. In addition, the **Road Network** feature accepts several additional files for designing Roads using specific criteria. In the **Edit Road** dialog box, picking the buttons on the left, that are labeled with the file type, will display a file dialog box prompting the user to select an existing or create a new file of that type. The corresponding **Edit** button to the right of each file type will display the editor for that file type.

---

**Required Road Input Files**

**Centerline:** Pick this button to select an existing or create a new Centerline (.CL) file from which to define the horizontal alignment of the Road. The **Edit** button opens the **Centerline File** Editor. This Editor is the same as the one used for the **Input-Edit Centerline File** command. Please refer to the **Help** files for that command if additional assistance is needed.
Centerline File Editor

Profile: Pick this button to select an existing or create a new design Profile (.PRO) file for the Road. The Edit button opens the Input-Edit Road Profile Editor. The Editor provides the user with both a "profile-grid-view" and a "table-view" of the Profile (.PRO) file. See Road Network: Road Profile Editor for more.

Input-Edit Road Profile Editor
**Template**: Pick this button to select an existing or create a new Template (.TPL) file or Template Series (.TSF) file for the Road.

A Template (.TPL) file defines a typical roadway cross-section including pavement, curb, ditches, medians, super-elevations, subgrades, rights-of-way and cut/fill slopes. One of the most critical steps in defining a Road Template for use with the Road Network feature is the assigning of a Template ID to points on the Template. A Template ID is a unique name for each point on the Template and is used to transition from Road to Road, from Road to Intersection and Road to Cul-de-Sac. The Template ID serves 4 purposes: (1) the ID will be applied as a description to all final Template points generated in the form of a Coordinate (.CRD) file, (2) the ID can be used as a design point in the Template definition, as in EP+5 indicating 5 feet or meters right of edge of pavement, (3) points of common ID may be connected by 3D polylines in the Output Options tab of the Road Network: Settings dialog box and (4) Quantities can be generated with reference to the ID and material (gravel, concrete, etc.) also defined in the Template (.TPL) file.

A Template Series (.TSF) file references Template (.TPL) files for Template-to-Template transitioning and is one method used for widening and narrowing of Road sections.

Picking the Edit button will open the appropriate Design Template or Input-Edit Template Series File Editor. These Editors are the same as those used for the Draw Typical Template and Template Transition commands. Please refer to the Help files for those commands if additional assistance is needed.

**Design Template Editor**
Optional Road Input Files

**Super Elevation:** Pick this button to select an existing or create a new SuperElevation (.SUP) file for the Road. The **Edit** button opens the **Super Elevation** Editor. This Editor is the same as the one used for the **Input-Edit Super Elevation** command. Please refer to the **Help** files for that command if additional assistance is needed.

**Topsoil Removal:** Pick this button to select an existing or create a new Topsoil Removal (.TOP) file for the Road. This file allows the user to define topsoil removal and replacement zones to be used in the Road design. Different topsoil depths can be used for different station ranges and then are computed as part of the cut and fill volumes. The **Edit** button opens the **Topsoil File** Editor. This Editor is the same as the one used for the **Topsoil Removal/Replacement** command. Please refer to the **Help** files for that command if additional assistance is needed.
Topsoil Removal/Replacement Editor

**Template Transition:** Pick this button to select an existing or create a new Template Transition (.TPT) file for the Road. This file allows the user to define changes in grade distances or slopes for a specific Template ID through a range of stations and is another method of widening and narrowing Road sections. The **Edit** button opens the **Template Transition** Editor. This Editor is the same as the one used for the **Template Transition** command. Please refer to the **Help** files for that command if additional assistance is needed.

Template Grade Table: Pick this button to select an existing or create a new Template Grade Table (.TGT) file for the Road. This file allows the user to define specific slopes and distances for one or more Template IDs (and for left and right sides independently) that have been assigned in the Template (.TPL) file. The **Edit** button opens the **Template Grade Table** Editor. This Editor is the same as the one used for the **Template Grade Table** command. Please refer to the **Help** files for that command if additional assistance is needed.
Template Grade Table

**Template Pt Profile:** Pick this button to select an existing or create a new Template Point Profile (.TPP) file for the Road. This file allows the user to assign separate Profile (.PRO) files to specific Template IDs that have been defined in the Template (.TPL) file. This accommodates varying grade changes (for a ditch, for instance) independent of the Profile for the Centerline. The **Edit** button opens Define Template Alignments and then picking the **Add** button displays the **Template Point Profile Settings** dialog box. These dialog boxes are the same as the ones used for the Assign Template Pt Profile command. Please refer to the Help files for that command if additional assistance is needed.

**Assign Template Pt Profile Dialog Boxes**

**Template Pt Centerline:** Pick this button to select an existing or create a new Template Point Centerline (.TPC) file for the Road. This file allows the user to assign separate Centerline (.CL) files to specific Template IDs that have been defined in the Template (.TPL) file. This accommodates varying widths for cross-section surfaces and provides an additional method of managing widening and narrowing of Roads. The **Edit** button opens Define Template Alignments and then picking the **Add** button displays the **Template Point Centerline Settings** dialog box. These boxes are the same as the ones used for the Assign Template Pt Centerline command. Please refer to the Help files for that command if additional assistance is needed.
Assign Template Pt Centerline Dialog Boxes

**ROW Offsets**: The ROW feature draws 2D linework at specified offsets from the centerline. In the dialog, there are settings for the layer for the 2D polyline and the offsets left and right of the centerline. There is also a list of additional offsets to draw. Use the Add, Edit and Remove buttons to setup this list of offsets to draw. The names, offsets and layers for these 2D polylines is stored to a .ROW file.

**Road Design Parameters**: Pick this button to select an existing or create a new Road Design Parameters (.RDP) file for the Road. This file allows the user to define a set of Road design standards to compare against a roadway design. The Road Network Process function will report a warning when the design is out of compliance with these parameters. The Road Design Parameters can be specific to all stations along a Road or, in the event speed limit or other changes must be applied, a range of stations. The Edit button opens the Road Design Parameters dialog box. This box is the same as the one used for the Define Road Design Parameters command. Please refer to the Help files for that command if additional assistance is needed.
Road Design Parameters Dialog Box

**Road Stripes:** This option draws plan view polylines for road stripes such as double yellow lines along the centerline and dashed white lane lines. See the Draw Road Stripes command for a description of this feature.

**Optional Road Output Files**

**Existing Section File:** Pick this button to specify the path and filename for the existing cross-section file to be written. The default filename is set by picking Output File Defaults button in the Output Options tab of the Road Network Settings dialog box.

**Final Section File:** Pick this button to specify the path and filename for the final/design cross-section file to be written. The default filename is set by picking Output File Defaults button in the Output Options tab of the Road Network Settings dialog box.

**SuperElevation Diagram:** Pick this button to specify the path and filename for the SuperElevation Diagram (.SUD) file to be written.

The Input-Edit Road Profile Editor is accessible from the Edit Road Dialog box.

Pick "Edit" to Access the Input-Edit Road Profile Editor

In Carlson's Road Network feature, the initial design Profile is automatically generated and has only a starting and
ending PVI - with the elevation at both ends tying into existing ground. The crosshairs are locked to the design Profile.

The initial PVIs can be seen in the profile-grid-view where the existing ground Profile is shown in red and the design Profile in white. The initial PVIs are shown in the table-view with the "PVI Description" indicating the PVI elevation is tied to the "TARGET-SURFACE" (existing ground).

The buttons and settings directly below the profile-grid-view allow the user to edit the Profile and adjust the Zoom and Scale factors of the profile-grid-view. The **Insert PVI**, **Remove PVI** and **Screen Pick PVI** buttons at the bottom of the dialog box allow the user to make changes to the Profile using the table-view.

The profile-grid-view provides the user with a dynamic viewer and editor. As the crosshairs move along the design Profile, a "station" symbol on the drawing screen indicates the corresponding position/station along the Centerline. Also, as the crosshairs move along the Profile, the current Station, Elevation, Slope and Depth (between design and existing ground Profiles) are displayed and dynamically updated at the top of the window. The starting and ending stations for the Centerline are displayed above the buttons at the bottom of the window.
Pan, Zoom and Zoom Extents: Use these buttons to change the Zoom factor in the profile-grid-view.

Add PVI: Use this button to "screen pick" the location for a new PVI in the profile-grid-view. After screen picking the new PVI location, the New PVI box prompts the user to provide additional design criteria to set the new PVI.

New PVI Dialog Box

Edit PVI and PVI Edit Mode: Use the Edit PVI button to change the elevation and station of a PVI in the profile-grid-view by dragging-and-dropping it to a new location. The default PVI Edit Mode is "Free" which allows 360-degree motion when dragging-and-dropping the PVI. Other PVI Edit Mode options are: Hold Slope In, Hold Slope Out, Hold Station and Hold Elevation. The user also can choose to Hold Vertical Curve Length, Hold K-Value or Hold Sight Distance when editing the PVI using drag-and-drop. This setting is controlled in the Road Profile Settings dialog box.
**Vertical Exag:** Use this setting to "Fit" the Profile into the profile-grid-view area of the window or use other pre-defined options such as "x1", "x2", "x5" and "x10" to exaggerate the vertical scale by 1-, 2-, 5- or 10-times.

**Sag-Crest Points:** After adding one or more vertical curves to the design Profile, a list of the "sag" and "crest" points along the Profile will be listed in the drop-down box.

**Through Point:** After selecting a PVI in the table-view, pick this button to force a sag or crest point to a specific station and elevation.

**Check Station:** To find the precise Elevation, Slope and Reference Elevation (existing ground) for a specific station, enter the station in the text box and **press Enter**.

**Insert PVI:** Before picking the **Insert PVI** button, the user must use the mouse to select/highlight a cell in the profile table-view. Then, picking the **Insert PVI** button will create a blank row, **above the selected row**, allowing the user to enter the information for the new PVI.

**Remove PVI:** Before picking the **Remove PVI** button, the user must use the mouse to select/highlight a cell in the row corresponding to the PVI to be removed. Then, picking the **Remove PVI** button will delete the selected row/PVI from the Profile.

**Screen Pick PVI:** Picking this button allows the user to change the station of a PVI by screen picking a location in the drawing. Before picking the **Screen Pick PVI** button, the user must use the mouse to select/highlight a cell in the corresponding row of the PVI to be changed. Then, picking the **Screen Pick PVI** button changes the user to the active drawing screen, prompting the user to "Pick PVI Point:" in the drawing area.

**Show Sections:** This option is only available if the Template (.TPL) file for the Road has already been specified in the **Edit Roads** dialog box. When picked, the **Show Sections** button will open a "Road Design Section Data" viewer window while keeping the "Road Profile" window open as well. This provides the user a dynamic design environment in which the plan-, profile- and section-views are visible at one time. Additionally, when the "Section" viewer window is open, the notes at the top of the profile-grid-view include the "Cut" and "Fill" end-area at the current station along with the "Cut" and "Fill" volume for the entire Road. These calculations are dynamic and will update if changes are made to the design Profile. Use the Specific Station to check the section at a station. Or move the cursor in the profile preview graphic to change the section station.

---

**Road Profile View and Section Viewer with Station Indicator in Drawing**

**Translate:** Picking this button will display the **Translate Profile** dialog box and allows the user to change the elevation of the entire Profile or a range of stations along the Profile.
Translate Profile dialog box

**Save**: This button saves changes to the Profile (.PRO) file.

**Exit**: This button exits the Input-Edit Road Profile editor dialog box.

**Undo**: This button will undo the last change made to the Profile.

**Setup**: This button opens the Road Profile Settings dialog box. See below for more information.

**Vertical Speed Tables**: Use this button to specify the Vertical Curve Speed Table (.VST) files to use for the design of this Road.

---

Road Profile Settings Dialog Box

**Reference CL File**: In the Road Network feature, the "Reference CL File" is automatically set to the Centerline (.CL) file associated with the Road.

**Hold Current Elevation**: When enabled and the station and elevation of a PVI changes, the "Slope Out" of the adjusted PVI will change but the elevation of the next PVI will be left unchanged. Otherwise, if not enabled, the "Slope Out" of the adjusted PVI is held and the elevation of the next PVI is changed.

**Grid Ticks Only**: When enabled, only grid ticks will be shown in the profile-grid-view. Otherwise grid lines will be used.

**Set Grid Interval**: If enabled, this option allows the user to manually specify the grid- or grid-tick interval shown in the profile-grid-view.

**Show Slope When Zoom In**: When enabled, this option allows the user to display the slopes on those vertical tangents that are long enough to display a slope label when Zoom-ing in closer to the Profile.

**Show Reference Surface**: When enabled, this option displays the Profile of a "Reference Surface" in addition to the...
design Profile. The "Reference Surface" is typically the original or existing ground Profile.

**Show Reference Surface at Left Offset:** When enabled, this option allows the user to see an additional Profile that is offset horizontally from the "Reference Centerline". The offset distance can be specified after the option is enabled.

**Show Reference Surface at Right Offset:** When enabled, this option allows the user to see an additional Profile that is offset horizontally from the "Reference Centerline". The offset distance can be specified after the option is enabled.

**Show Centerline Special Stations:** When enabled, critical Centerline stations such as PC, PT, SC, ST, TS and SP are shown in the profile-grid-view.

**Show Vertical Lines for Intersections:** When enabled, this option will display a vertical line representing the Centerline and Edge of Pavement stations for other Roads in the Road Network.

**Show Sag-Crest Points:** When enabled, this option displays a marker at the sag and crest points of each vertical curve.

**Extend Reference Centerline:** When enabled, the user may provide an extended range of stations so as to show Profile data beyond that generated along the associated Centerline (.CL) file. For instance, for a new Road tying into an existing Road (proposed CL file starts at the Intersection of the Centerline of the existing Road) an extended range of stations may be desired in order to see the Profile of the cross-slope, curb, ditch and slope across both sides the existing Road.

**Output Reference Surface Profile** and **Suffix:** When enabled, this option will generate an existing ground Profile (.PRO) file and allows the user to specify a suffix for the filename. The defaults for this option are set using the **Output File Defaults** button in the **Output Options** tab of the **Road Network Settings** dialog box.

**Reference Surface:** The "Reference Surface" is an additional surface Profile shown in the profile-grid-view alongside the design Profile. For the **Road Network** feature, the "Reference Surface" is the surface specified as "Existing Ground" in **Road Network Settings** dialog box.

**Check Road Design Parameters:** When enabled, this option will compare the current Road design to an established set of design parameters set in a Road Design Parameters (.RDP) file. Please refer to the **Help** files for the **Road Design Parameters** command if additional assistance is needed.

**Display Sight Distance Options:** Use this radio button to display either a "Sight Distance" or "K-Value" column in the profile-table-view.

**Drag PVI Options:** Use this radio button to specify the design criteria to "hold" when using the **Edit/Drag PVI** command in the profile-grid-view. The options are to "Hold Vertical Curve Length", "Hold K-Value" or "Hold Sight Distance".

Intersections are created automatically in the **Road Network** feature without any input from the user. Once Intersections are identified, they are listed and managed in the **Intersection** area of the **Road Network: Task Pane**.

**Edit:** Use this button or right-click on the intersection in the project tree and choose **Edit Intersection** to display the **Edit Intersection** dialog box and make changes to the **Input Data** and **Output Files** for the selected Intersection. Other changes that can be made to the Intersection design are:

1) Changing the Primary/Secondary status of the Roads creating the Intersection,
2) Making design changes that apply to the entire Intersection,
3) Making design changes that apply to one or more Corners of the Intersection.

**Reset:** Use this button to overwrite all design changes made to the selected Intersection and reset to the original Intersection design.

As stated above, Intersections are created automatically in the **Road Network** feature without any input from the user. Road Network recognizes and calculates the Intersection using the Centerline (.CL) files associated with the Roads in the Network. If two Roads are added to the Network and they share one or more common point, an Intersection is created and displayed as an Intersection in the **Road Network: Task Pane**.

For all Intersections, one of the two Roads creating the Intersection will be the "Primary" Road and the other will be the "Secondary" Road. When setting grade through an Intersection, the Primary Road's Template (.TPL) file takes priority and is used to define the cross-section. The grades of the Secondary Road will adjust to
match the Primary Road. Additionally, changes to any of the Primary Road design files - such as the Profile (.PRO) file - will automatically update the affected file(s) of the Secondary Road.

Upon creation of an Intersection, the Road Network feature automatically designates one of the Roads as the Primary Road and the other as Secondary. For four-way Intersections, the first Road added to the Road Network will be deemed the Primary Road and the second Road will be Secondary. For T-Intersections, the Road going straight-through the Intersection will be deemed the Primary Road - even if it's added to the Network after the Road that stops at the Intersection. The user can change the Primary Road designation in the Edit Intersection dialog box.

Picking the Edit button displays the Edit Intersection dialog box which has a Settings tab and, depending on the type of Intersection, 2 or 4 additional tabs - each representing one Corner of the Intersection. The Corner tabs are labeled Front-Right, Back-Right, Front-Left or Back Left. T-Intersections will have 2 tabs and 4-way Intersections will have 4 tabs.

**Intersection Settings**

At the top of the Settings tab, the station and elevation of the Intersection is shown for all Roads.

*The Settings Tab of the Edit Intersection Dialog Box*

**Primary Road**: Use the radio button to specify the Primary Road of the Intersection.

**Profile Transition PVI Distance**: This value represents the distance beyond the edge of pavement of the Primary Road (along the Secondary Road Centerline) that the cross-slope of the Primary Road will be extended.

**Profile Transition VC Length**: This setting allows the user to specify the length of vertical curve to be inserted at the PVI where the extension of the Primary Road's cross-slope and the Centerline of the Secondary Road meet.
"Profile Transition PVI Distance" and "Profile Transition VC Length"

**Template ID:** This is the point on the cross-section used to define the horizontal (Centerline) and vertical (Profile) alignments around the Corners of the Intersection. Also, the profile for the side road will tie into this Template ID on the main road. The Template ID may be specified as any point on the cross-section - such as edge of pavement (EP) or the back of curb (BC) - as long as it has been defined as a Template ID in all of the Template (.TPL) files used to calculate the Intersection. Type the Template ID in the text box or use the Select button to choose from a list.

**Template Profile at 2nd ID:** This option sets the template ID for an additional template ID to control in the curb return besides the main ID. When this option is active, each curb return has a button to edit the template point profile for this additional ID. This option applies when the template is transitioning across the intersection on a grade ID besides the main ID.

**Hinge Profile and 2nd ID:** For the side road profile, this is an optional second point to match from the main road template.

Cross-section of main road showing side (alley) profile tying into single Template ID at flow line
Cross-section of main road showing side (alley) profile tying into Template ID at flow line as well as 2nd Hinge at Right-of-way of main road

**Surface Method:** See the Transition Defaults section above for details on this setting.

**Transition Method:** See the Transition Defaults section above for details on this setting.

**Link Secondary Centerline for T-Intersection:** When this option is enabled, changes to the Centerline (.CL) file of the Primary Road will, if necessary, force the Centerline of the Secondary Road to be extended or trimmed in order to keep the Intersection intact.

**Skip Intersection:** This option skips creating the curb returns for this intersection. This option applies for crossings like an overpass or railroad.

Note: The default value for several design criteria such as Intersection radius and length of vertical curve can be set in the Transition Defaults tab of the Road Network: Settings dialog box.

**Corner tabs - Front-Right, Back-Right, Front-Left, Back-Left**

Depending on the type of Intersection ("T" or 4-way), there will be either 2 or 4 additional tabs available in this dialog box. Each of these tabs represent a Corner of the Intersection and allows the user to specify horizontal and vertical Input Data and Output Files specifically for that Corner.
Intersection Input Data

**Radius**: Use this value to specify the radius of the curve for this Corner of the Intersection. The *Intersection Template ID* specified in the *Intersection Settings* tab of this dialog box determines the point on the cross-section being affected by this setting.

**Tie to Existing**: Enable this option to keep cut and fill slopes from projecting to the existing ground through the Intersection. In areas of steep cut or fill, this setting helps avoid overlapping Road and Intersection tie slopes.

**Edit Profile**: Pick this button to open the *Input-Edit Road Profile* Editor and make changes to the Profile for this Corner of the Intersection. The *Intersection Template ID* specified in the *Intersection Settings* tab of this dialog box determines the point on the cross-section being represented in the Profile Editor. See *Road Network: Road Profile Editor* for more Help with this feature.
Edit Profile for a Corner of an Intersection

**Reset:** Use this button to overwrite all edits to the Profile of the Corner of the Intersection and reset to the original Profile.

**Edit Template Transition:** Pick this button to display the Edit Intersection Transition dialog box. This allows the user to control the stations for transitioning through the Intersection from a Template on one Road to a different Template on another Road. These Transition stations only apply when the Roads in an Intersection have been assigned different Template (.TPL) files.

---

**Edit Intersection Transition Dialog Box**

*In the Intersection Transition Dialog Box...* The Starting and Ending Stations of the Intersection transition are displayed at the top of the dialog box.

**Transition Starting Station:** This is the station at which the Primary Road Template ends.

**Transition Ending Station:** This is the station at which the Secondary Road starts.

**Allow Single VC:** When the difference in grade at the Intersection between the Primary Road and the Secondary Road is too severe, two intermediate PVIs must be inserted into the Profile of the Corner of the Intersection in order to properly transition from one Road to another. In some cases, the transition is possible using only one intermediate PVI in the Corner Profile. If this option is enabled and if the intersecting grades allow it, only one
intermediate PVI will be inserted. If this option is not enabled, two intermediate PVIs will be inserted regardless of the intersecting grades.

**Template Grade Table**: Pick this button to select an existing or create a new Template Grade Table (.TGT) file defining the grades for the Corner of the Intersection. This file allows the user to define specific slopes and distances for one or more Template IDs that have been assigned in the Template (.TPL) file. The **Edit** button opens the **Template Grade Table** Editor. This Editor is the same as the one used for the **Template Grade Table** command. Please refer to the **Help** files for that command if additional assistance is needed.

"L" Intersection with Knuckle: When two centerlines connect at a right angle for an "L" intersection, there is a **Use Knuckle** option for the outside corner that can be used to make a knuckle bulb.

''L'' Intersection with Knuckle:

Intersection Output Files

**Centerline**: Pick this button to output a Centerline (.CL) file representing the horizontal alignment around this Corner of the Intersection. The **Intersection Template ID** specified in the **Intersection Settings** tab determines the point on the cross-section exported to the Centerline (.CL) file.

**Profile**: Pick this button to output a Profile (.PRO) file representing the vertical alignment around this Corner of the Intersection. The **Intersection Template ID** specified in the **Intersection Settings** tab determines the point on the cross-section exported to the Profile (.PRO) file.

**Existing Section File**: Pick this button to output an Existing Section (.SCT) file for this Corner of the Intersection.

**Final Section File**: Pick this button to output a Final Section (.SCT) file for this Corner of the Intersection.

Additional Transitions tab

**Additional Profile Transition Distance**: This option adjusts the transition PVI station on the side profile. The transition station starts as the offset of the Template ID on the main road. The cross slope of the main road is used up to the transition station. For example, if the Template ID is for edge of pavement up to the gutter pan at 11.67 and the side profile needs to match the main crown up the flow line at 13.00, then the Additional Transition Distance should be set to 1.33.
**Additional CL Distance (Front Main, Back Main, Left Side, Right Side):** These options allow you to extend the station range of the intersection. By default the intersection station range is between the PC points where the intersection arcs begin.

Cul-de-Sacs may be added to any Road in the Network and are managed in the **Cul-de-Sac** area of the **Road Network: Task Pane**.

**Add:** Pick the Add button or right-click on Cul-de-sacs in the project tree and choose Add to display a list of Roads in the Network and prompt the user to "**Select Road for Cul-de-Sac**".... After selecting the Road, the **Edit Cul-de-Sac** dialog box is displayed allowing the user to specify the **Input Data** and **Output Files** for the Cul-de-Sac.

**Edit:** Use this button to display the **Edit Cul-de-Sac** dialog box and make changes to the **Input Data** and **Output Files** for the selected Cul-de-Sac.

**Remove:** Use this button to **Remove** the selected Cul-de-Sac from the Road.

**Add:** Picking this button displays a dialog box listing the Roads in the Network and prompting the user to **Select Road for Cul-de-Sac**.

**Select Road for Cul-de-Sac**

After choosing the Road and picking the **OK** button, the **Edit Cul-de-Sac** dialog box is displayed.
Edit Cul-de-Sac Dialog Box

**Cul de Sac Input Data**

**Cul-de-Sac Centerline Position**: Use this radio button to specify whether the Cul-de-Sac is drawn at the starting or the ending station of the Centerline.

**Centerline Direction**: This setting applies only if the horizontal alignment of the Cul-de-Sac is to be saved externally as an *Output Centerline* (.CL) file. If so, this setting determines which end of the Cul-de-Sac is the starting and which is the ending station of the new Centerline (.CL) file.

**Center Station**: Use this setting to precisely locate the center of the Cul-de-Sac along the Road Centerline. By default, the *Center Station* is the starting or ending station of the Centerline depending on whether the user has chosen *Start* or *End* as the desired *Cul-de-Sac Centerline Position*. The station for the center of the Cul-de-Sac may also be entered in the text box or may be specified using a *Delta* value. When using the *Delta* option, the Cul-de-Sac will be shifted the specified distance along the Centerline.

**Cul-de-Sac Radius**: Use this value to specify the radius of the Cul-de-Sac bulb. The *Cul-de-Sac Template ID* determines the point on the cross-section being affected by this setting.

**Fillet Radius**: Use this value to specify the radius of the curve that transitions between the Road and the Cul-de-Sac. The *Cul-de-Sac Template ID* determines the point on the cross-section being affected by this setting.

**Offset**: When set to "0", this setting places the center of the Cul-de-Sac on the Centerline of the Road. Setting this value to a negative(-), greater than "0" value will shift the center of the Cul-de-Sac left of the Centerline by that distance. A positive, greater than "0" value will shift it to the right by that distance.

**Tear Drop Mode**: Enabling this option creates a longer transition between the Road and the Cul-de-Sac. When enabled, a value larger than the *Cul-de-Sac Radius* must be entered as the *Setback*. An example of a "Tear Drop" Cul-de-Sac having a 45' radius and 75' setback is shown below.
Example of Tear Drop Cul-de-Sac

**Template ID:** This is the point on the cross-section used to define the horizontal (Centerline) and vertical (Profile) alignments around the bulb of the Cul-de-Sac. The Template ID may be specified as any point on the cross-section - such as edge of pavement (EP) or the back of curb (BC) - as long as it has been defined as a Template ID in the Template (.TPL) file used for the Road. Type the Template ID in the text box or use the Select button to choose from a list.

**Profile Transition VC:** When adding a Cul-de-Sac to the Road Network, the Profile around the Cul-de-Sac is automatically generated having 3 PVIs - one on each end connecting to the Road and one at the mid-point of the alignment. The Profile Transition VC setting is the default length of vertical curve inserted at the middle PVI of the Profile. As shown below, adding a vertical curve at this PVI can have a significant, positive impact on the resulting surface model and contours of the Road Network.
Effect of Adding a Vertical Curve to Cul-de-Sac Profile

Edit Profile: Pick this button to open the Input-Edit Road Profile Editor and make changes to the Profile of the Cul-de-Sac. The Cul-de-Sac Template ID determines the point on the cross-section being represented in the Profile Editor. See Road Network: Road Profile Editor for more Help with this feature.

Edit Profile for a Cul-de-Sac

Reset: Use this button to overwrite all edits to the Profile of the Cul-de-Sac and reset to the original Profile.

Template: Use this button to browse to and select an existing Cul-de-Sac Template (.TPL or .TSF) file. Specifying a different Template than the main Road allows the user to define different features for the Cul-de-Sac area such as sidewalk and curb.

Create Island: This option creates a circular island in the middle of the cul-de-sac. The template (.TPL) file uses
the grade in the template for the island radius and the template grade slope for the island slope. The island template file does not use the cut/fill slopes.

Cul de Sac Output Files

**Centerline**: Pick this button to output a Centerline (.CL) file representing the horizontal alignment around the Cul-de-Sac. The **Cul-de-Sac Template ID** determines the point on the cross-section exported to the Centerline (.CL) file.

**Existing Profile**: Creates a profile of existing ground along the cul-de-sac centerline.

**Final Profile**: Pick this button to output a Profile (.PRO) file representing the vertical alignment around the Cul-de-Sac. The **Cul-de-Sac Template ID** determines the point on the cross-section exported to the Profile (.PRO) file.

**Existing Section File**: Pick this button to output an Existing Section (.SCT) file for the Cul-de-Sac.

**Final Section File**: Pick this button to output a Final Section (.SCT) file for the Cul-de-Sac.

**Rock Section File**: Creates a cross section (.SCT) file for the rock surface.

Note: Driveways around a cul-de-sac can be easily added simply by drawing polylines for their centerlines and snapping them to the EOP of the cul-de-sac.

**Step 1: Start Road Network and Configure Settings**

Open a Drawing (.DWG) file containing the 2D zero-elevation polylines representing Road Centerlines for the project. Start the **Road Network** command and create a **New** Road Network (.RDN) file. After creating the Road Network file, the **Road Network Task Pane** loads as a docked dialog-box on the left side of the drawing screen.

Configure the Road Network by **picking the Settings button** and displaying the **Road Network Settings** dialog box. In the **Process Options** tab, **pick the Existing Surface button** and browse to and select the Existing Ground Surface (.TIN or .FLT) file to be used for the project.
Next, switch to the **Output Options** tab and pick the **Setup button** next to **Triangulate and Contour**. Select the **Write Triangulation File option** and then pick the **Browse button** to set the path and filename for the design Surface (.TIN) file for the Roads.

Also in the **Output Options** tab, pick the **Output File Defaults button** to display the **Output File Defaults** dialog box. Pick the **Output File Defaults button** to specify additional Centerline (.CL), Profile (.PRO) and Section (.SCT) files to be saved when Processing the Road Network.

Next, review the **Report Options**, **Display Options** and **Transition Defaults** tabs of the **Road Network Settings** dialog box and make any necessary changes.
Pick the OK button to close the Road Network Settings dialog box and then pick the Save button on the Task Pane to save the settings to the Road Network (.RDN) file.

Step 2: Add Roads to the Network
In the project tree, highlight Roads and right-click and choose Add Road.

After picking the Add button, the Add Road dialog box provides two methods for adding a Road to the Network. *Pick the Screen Pick Polyline button.*

**Specify Method to Use to Add Road**

The prompts then switch to the Command: line where you are prompted to *Select Centerline Polyline* in the drawing. At the next prompt, *pick the Assign Centerline File to Polyline button* and set the path and filename for the new Centerline (.CL) file.
Set Centerline Dialog Box

Immediately after creating the new Centerline file, the **Profile to Use** file dialog box is displayed. In this box, you must set the path and filename for the proposed Profile (.PRO) file for the Road. By default, the new Profile (.PRO) file is named the same as the Centerline (.CL) file.

![Profile to Use File Dialog Box](image1)

Profile to Use File Dialog Box

After specifying the Centerline (.CL) and Profile (.PRO) files for the Road, the **Edit Road** dialog box is displayed. The only other **Required Input File** is a Template (.TPL) file. Pick the **Template** button to browse to and select the desired Template file.

![Select Template (.TPL) file Dialog Box](image2)

Select Template (.TPL) file Dialog Box

The **Edit Road** dialog box serves as the "manager" for all files relating to the specific Road. The **Edit** button in the **Road Name** area of the **Road Network: Task Pane** also displays the **Edit Road** dialog box.
Edit Road Dialog Box

Pick the *Edit* button to the right of the *Profile* button to open the *Road Profile Editor*.

Input-Edit Road Profile Editor

In Carlson’s *Road Network* feature, the initial design Profile is automatically generated and has only a starting and ending PVI - with the elevation at both ends tying into existing ground. The movement of the crosshairs is locked to...
the design Profile. The initial PVIs can be seen in the profile-grid-view where the existing ground Profile is shown in red and the design Profile in white. The initial PVIs are shown in the table-view with the "PVI Description" indicating the PVI elevation is tied to the "TARGET-SURFACE" (existing ground).

*Pick the ✱ Add PVI button* to create a new PVI by screen-picking a point in the profile-grid-view at the top. After picking the Add PVI button, the New PVI dialog box is displayed.

New PVI Dialog Box

*Enter a length for a vertical curve or change other settings as desired and then pick the OK button.* Repeat as needed for additional PVIs and vertical curves.
Pick the Show Sections button at the bottom of the Road Profile Editor to display a Section View of the Road. Moving your crosshairs along the design Profile dynamically updates the Section View.

Section Viewer

When the Section View window is open and active, the Road Profile Editor also remains open and active. If you position the Road Profile Editor and the Section View window so that the drawing view of the Road is unobscured, you can move your crosshairs along the design Profile and have a dynamic design environment allowing you to see the plan-, profile- and section-views at one time. Additionally, when the Section View window is open, the notes at the top of the profile-grid-view include the "Cut" and "Fill" end-area at the current station along with the "Cut" and "Fill" volume for the entire Road. These calculations are dynamic and will update if changes are made to the design Profile.

Road Profile View and Section Viewer with Station Indicator in Drawing

Pick the Exit button to close the Section Viewer and then pick the Save button in the Road Profile Editor to save changes to the Profile (.PRO) file. Pick the Exit button to close the Road Profile Editor.
Repeat the steps above to define additional Roads in the Network.

See Road Network: Adding and Editing Roads if you need additional assistance.

**Step 3: Adding and Editing Intersections**

After Adding the next Road, the Road Network command recognizes the creation of an Intersection and the Primary and Secondary Roads are displayed in the Intersection area of the project tree.

Select the Intersection, right-click and pick the Edit Intersection function to display the Settings tab of the Edit Intersection dialog box. Make changes as needed.

Note: Changes made here apply to all Corners of the Intersection.

![Edit Intersection Dialog Box]

**The Settings Tab of the Edit Intersection Dialog Box**

Or, you can switch to one of the Corner tabs - Front-Right, Back-Right, Front-Left, Back-Left to make changes to only one Corner of the Intersection.
One of the "Corner" Tabs of the Edit Intersection Dialog Box

*Pick the OK button* to close the **Edit Intersection** box and save changes.

See **Road Network: Adding and Editing Intersections** if you need additional assistance.

**Step 4: Adding and Editing Cul-de-Sacs**

*Pick the Add button* in the **Cul-de-Sac** area of the **Road Network Task Pane** to display a dialog box listing the Roads in the Network and prompting you to **Select Road for Cul-de-Sac**.

---

**Select Road for Cul-de-Sac**

After choosing the Road and picking the **OK button**, the **Edit Cul-de-Sac** dialog box is displayed. At a minimum, you must *enter a Cul-de-Sac Radius and Fillet Radius* to define the Cul-de-Sac.
Edit Cul-de-Sac Dialog Box

Pick the OK button to close the Edit Cul-de-Sac box and save changes.

See Road Network: Adding and Editing Cul-de-Sacs if you need additional assistance.

Step 5: Save, Process and View the Road Network

Pick the Save button on the Road Network Task Pane to Save the Road Network (.RDN) file.

Then, pick the Process button on the Road Network Task Pane to calculate the road design and perform the functions specified in Road Network Output Options. The resulting contours and breaklines are shown below.
Contours and Breaklines After Processing Road Network

The elevated breaklines and contours can now be viewed using the 3D Viewer Window command as shown below.

Breaklines and Contours as Seen in the 3D Viewer Window

Or, use the Surface 3D Viewer command to view the Surface (.TIN) file as shown below.
**Surface (.TIN) File as Seen in the Surface 3D Viewer**

Or, use the **Surface 3D Flyover** command to drive the Surface (.TIN) file as shown below.

---

**Step 6: Reports**

*Pick the *Report* button* on the **Road Network Task Pane**. Then, *pick the *Output Processing* button* to display the report. This report displays the cut/fill and material quantities for each Road, Intersection and Cul-de-Sac of the Road Network.*
Road Network Output Processing Report

Repeat this step but, this time, pick the Input Data Files button to display the report. This report displays all of the user-specified design files associated with the Road Network. For this report, you are given the option of reporting only the filename or both the path and filename.

Road Network Input Data Files Report

Step 7: Additional Settings and Tools in the Road Network

Draw Triangulation Faces with Color and View in 3D Viewer Window

Pick the Settings button on the Road Network Task Pane and then pick the Output Options tab. Now, pick the Setup button next to Triangulate and Contour to open the Triangulate and Contour from Road Network dialog box.

Select the Draw Triangulation Faces option and then pick the Set Colors/Layers buttons to display the
Road Color Settings dialog box (shown below). The color of the faces can be set either by using the Template IDs defined in the Template (.TPL) file or using a color range based on the "Cut & Fill Depths".

Set Road Colors In the "Triangulate and Contour From Road Network" Dialog Box

Pick the Exit button to close the Road Color Settings box and then pick the OK button twice to exit both the Triangulate and Contour and Road Network Settings dialog boxes.

Pick the Save button on the Road Network Task Pane to Save the Road Network (.RDN) file.

Then, pick the Process button on the Road Network Task Pane to calculate the road design and perform the functions specified in Road Network Output Options. The image below shows only the Triangulation Faces after Processing.
Triangulation Faces with Color After Processing Road Network

The elevated Triangulated Faces can now be viewed using the 3D Viewer Window command as shown below.

Contours and Triangulation Faces with Color in the 3D Viewer Window

Merge Road with Existing

Pick the Settings button on the Road Network Task Pane and then pick the Output Options tab. Select the Merge
**Road with Existing option** and then *pick the Set button* to set the path and filename of a 3rd Surface (.TIN) file to be created by combining the design Surface file and the Existing Ground Surface file.

*Pick the OK button* to close **Road Network Settings**.

*Pick the Save button* on the **Road Network Task Pane** to Save the Road Network (.RDN) file.

Then, *pick the Process button* on the **Road Network Task Pane** to calculate the road design and perform the functions specified in **Road Network Output Options**

The combined Surface (.TIN) file can now be viewed using the **Surface 3D Viewer** command as shown below.

Merged Existing Ground and Road Surfaces in 3D Surface Viewer Window

**Add Knuckle Intersection**

Using the steps outlined in **2 Add Roads to the Network** above, Add two more Roads to the Network.
RD_03 and RD_04

Upon adding the Roads, the new Intersections are automatically added to the Intersection area of the Road Network Task Pane.

To create a "Knuckle" style Intersection between RD_03 and RD_04, select the **RD_03 (Primary) / End:RD_04 (Secondary) Intersection** in the project tree and then right-click and pick the **Edit Intersection** function to display the Settings tab of the **Edit Intersection** dialog box. Pick one of the "Corner" tabs of the **Edit Intersection** dialog box. Select the **Use Knuckle** option and enter a **Main Radius** and **Fillet Radius** value for the Knuckle Intersection.
Pick the OK button to close Edit Intersection.

Pick the Save button on the Road Network Task Pane to Save the Road Network (.RDN) file.

Then, pick the Process button on the Road Network Task Pane to calculate the road design and perform the functions specified in Road Network Output Options. The resulting contours and breaklines are shown below.

Contours and Breaklines Through a "Knuckle" Style Intersection

**Step 1: Start New Road Network**

Start the Road network command. If you have previously run Road Network with the current drawing, the Road Network docked dialog will open with the last Road Network (.RDN) file you worked with. If this happens, but you prefer to create a new Road Network (.RDN) file, click the Load/New button at the bottom of the Road Network docked dialog.

**Step 2: Add Roads**

Back in the main dialog, click "Add" in the upper left "Road Name" portion, and identify all of the main road and secondary (intersecting) road centerlines. For this example, we will start by identifying North Road and East Road as the main roads and Paris Boulevard as the first secondary road. Note that centerlines may be picked as polylines or loaded as centerline files. All centerlines (horizontal alignments) must have, at minimum, an associated profile (vertical alignment) and an associated template. In the Road name dialog portion, select a road and click Edit to review the files. Note that by selecting Paris Boulevard and East Road, the program automatically detects the first
As you follow the design below, you will see that we follow the hierarchy of the road precedence as outlined in the graphics. At every intersection, there needs to be a primary controlling road (template cross slopes are held) and secondary adjusting road (centerline profile adjusts to template of primary road at some transition distance).

Step 3: Process, Review and Add more

Click Process to compute the design. With the Triangulation option enabled under the "Settings" dialog, the program will Triangulate and Contour and create the drawing shown below. If you edit any road feature or dialog entry and click Process again, the program automatically clears the last Triangulate and Contour drawing and creates a new final design drawing. In this way, you can trial-and-error your design for all roads, or build the design in stages.

Viewing the file in the 3D Viewer Window comman...
d with a 4.0 vertical exaggeration, you can even see how the curb-and-gutter Paris Boulevard ends abruptly as it transitions to the roadside ditch template of East Road.

Next we can review the effect of adding Front Drive, Loop Road and West Drive into the equation. If you click Edit after adding Loop Road as above, you have the option to change any aspect of the centerline, profile or template file, and you can add optional files such as road width change files and superelevation files. For example, if you choose to edit the profile, the program derives the existing grade from the existing surface triangulation file specified in Settings, and you are able to design graphically and interactively as shown:
You can also more closely analyze the intersections of any road. If you select the intersection at ParisBlvd and Start:LoopRd, you obtain the multi-tab dialog:

Since we do not have a crossing intersection, we only obtain a "Front-Left" tab and a "Back-Left" tab, left being the left side of the primary road (Paris) and front being the first "curve return" treatment on the outside of the loop and back being the second "curve return" treatment on the inside of the loop. If this was a crossing intersection, you would have 2 more tabs in the dialog: "Front-Right" and "Back-Right".

Completing West Drive, Front Drive and South Drive leads to the following plan view and 3D view. Clicking Add within the Cul-de-Sac portion of the docked dialog enables you to specify at cul-de-sac at the end of South Drive. Clicking Process now produces the following:
A close-up view of the cul-de-sac, in 3D, reveals the detail of the design, showing a raised "fold" due to no vertical curve transition at the projected high point at the back of the cul-de-sac:

This dimple effect can easily be eliminated by lowering the elevation of the "PVI" at the projected intersect point in the back of the cul-de-sac, and by adding a vertical curve transition of, say 50'. This is done by highlighting the South Drive Cul-de-Sac and clicking Edit.

Clicking Edit on the selected SouthDr at End cul-de-sac leads to this dialog:
The first thing we do is change the Profile Transition VC from 0.0 to 50.0, as shown. Then we need to click Edit Profile to lower the profile at the back of the cul-de-sac. This profile refers to the edge-of-pavement grade.

Now, after clicking Process, the cul-de-sac has a better design:
Pulldown Menu Location: Roads → Road Network
Keyboard Command: roadnet
Prerequisite: Existing Ground Surface (.TIN) file, Template (.TPL) file
Points Menu

All of the routines in this menu operate on points in a Carlson coordinate (.CRD) file. Coordinate files are binary files that contain point numbers, northings, eastings, elevations and descriptions. The Carlson coordinate database (.CRDB) is based on SQLite and supports point numbers and descriptions up to 255 characters. Alternately, C&G CRD and CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. All routines in this menu will read from, and write to, these types of point data files. At any given time, there can only be one active coordinate file. If a command is initiated that requires a coordinate file while one is not set, Carlson will prompt for a coordinate file name. From that point on, this is the current coordinate file. Another coordinate file can be used by choosing Set Coordinate File or Open CRD File in Coordinate File Utilities.

Whenever you asked for point numbers, you can enter any combination with commas and dashes or type ALL to use all points. For example 1-3,7,20-23 would act on points 1,2,3,7,20,21,22,23. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point#7A). The type of point number format is set when the coordinate file is created. This setting is found under General Settings in Carlson Configure. This setting only affects new coordinate files.

Each point is drawn by three entities:

1. point block
2. point node
3. symbol

The point block is an INSERT entity with PNTNO, PNTELEV and PNTDESC attributes. These attributes represent the point number, elevation and description respectively. The point node is a POINT entity and is used for picking the point with the NODE snap. The point node is also used as the X, Y, Z coordinate in Triangulate & Contour.
symbol can be any symbol defined in the Symbol Library (use SPT0 for no symbol). Since points use Carlson point symbols, the CAD system variables PDMODE and PDSIZE should usually be set to 0.

The points in the drawing can be linked to their coordinates in the coordinate file. The link updates the coordinate file when a point is modified in the drawing. For example, when points are moved with the Rotate Points command, their coordinates will be automatically updated in the coordinate file. To update the coordinate file without this automatic link, you can run the command Update CRD File from Drawing in Coordinate File Utilities. The linking option is called Link Points with Coordinate File (currently only available in AutoCAD) and can be set under General Settings in Carlson Configure. This setting does not affect points currently in your drawing, only points drawn after you change this setting.

Each point in the coordinate file has room for a 32 character description. To have a longer description, an associated point note file can be used. The note file has the same file name as the coordinate file with a .NOT extension and is stored in the same directory as the coordinate file. For example, survey.not would be the note file for survey.crd. The note file is a text file that stores a point number together with the additional notes for the point. There is no limit to the length of the note. Notes can be added to points using the Edit Points command. The List Points command can be used to print out the notes.

For each point, the point attribute block, node, and symbol can be bound together into a "grouped" entity. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality.

To disable this system altogether, navigate to Carlson Configure > General Settings and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A (holding down the 'Ctrl' key and then pressing the letter 'A' on the keyboard activates this two way toggle and the current status will be echoed to the Command prompt area).

Carlson points include additional information on each element that makes up the point collection (attribute block, node and symbol). This information allows Carlson to know such things as which coordinate (.CRD) the point came from. Commands like Drawing Inspector can then display the point information for the point entities. This also makes it easier for Carlson to identify which drawing objects belong to a point, making commands like Edit Point Attributes a "double-click" pick association instead of a selection set.
Point Defaults

This command sets Carlson point options for drawing point entities.

Descriptions: Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

Label Limit: Sets the maximum length for description attribute labels.

Dialog Prompt: When creating new points, this option controls whether to prompt for descriptions and elevations in a dialog or at the command line.

Elevations: Specify whether you are prompted for a point elevation when creating points and whether or not the point elevation is labeled with the point.

Prefix/Suffix: Indicate a desired prefix or suffix that should be included with the elevation label.

Locate on Real Z Axis: When checked, points are drawn at their actual elevation, otherwise, points will be drawn at Z=0.

The following tables illustrate the effects of Elevation vs. Real Z settings:

<table>
<thead>
<tr>
<th>Picked Point</th>
<th>Elevation Yes</th>
<th>Real Z Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picked Point</td>
<td>Labels point, Prompts for elevation</td>
<td>Uses elevation for z coordinate</td>
</tr>
<tr>
<td>Point Number</td>
<td>Labels point, No Prompt</td>
<td>Uses z coordinate from file</td>
</tr>
</tbody>
</table>

Effects of Elevation Settings - Scenario 1
Effects of Elevation Settings - Scenario 2

Effects of Elevation Settings - Scenario 3

Effects of Elevation Settings - Scenario 4

Attribute Layout ID: Controls the location of the point number, elevation and description. Up to 10 attribute layouts (0 through 9) are available. See Carlson Knowledgebase Article 779 (Customized Carlson Point Attribute Layouts) for examples and steps of different attribute layout configurations.

Symbol Name: Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the Symbol Library.

Prompt for Symbol Names: When checked, you will be prompted for each symbol name instead of using the default symbol.

Point Numbers: When this toggle is OFF, no point number will be created and no points will be stored in the active coordinate file.

Automatic Point Numbers: When enabled, point numbers are numbered sequentially from the Start Point Number. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the Draw-Locate Points command and use the Range option, then a point entity is plotted. When disabled, commands that locate new points will prompt for the point number.

Start Point Number: Specify the starting point number to use.

Layer for Points: Specify the default layer name for Carlson points.

Vertical Angle Mode: Specify how Carlson should prompt you for vertical angles. None means "Do not prompt." This applies to creating points with commands such as Traverse. The vertical angle is used to calculate the point elevation.

Separate Layers: Specify settings for point attribute layers:

- None - The point number, elevation and description use the layer names PNTNO, PNTELEV and PNTDESC, respectively.
- Points - The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC. For example, if the point layer is UTIL then the attribute layers will be UTILITYNO, UTILELEV and UTILDESC, respectively.
- Symbols - The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.
- Both - The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILITYNO, UTILELEV and UTILDESC.

Auto Zoom Center for New Points: When checked, the drawing will perform a "Zoom Center" around new points to keep the display centered around the current working area during the new point creation process.
**Draw Point Nodes:** This option controls whether to create a CAD point entity. A full Carlson point consists of the CAD point entity, point symbol and point attribute block that has the point number, elevation and description labels. Normally the CAD point entity is part of this group but is not required.

**Use Annotative Points:** When enabled, points (usually placed through the Draw Field-to-Finish or Draw-Locate Points commands) will use scale-able annotative properties.

**Support All Drawing Scales:** When enabled, points placed as annotative entities will make use of all annotation scales currently defined within the drawing.

**Mask Point Attributes:** This option hides the drawing behind the point attributes when the points are drawn. The Mask Offset controls the buffer area around the point attribute. This offset value is scaled by the drawing horizontal scale. You can also leave this option off and apply the mask later by using the Mask Point Attributes command under the Points > Point Utilities menu.

**Use Field to Finish for Point Styles:** Allows you to use the code definitions from the designated Feature Library Definition (FLD) table specified below. For example, when creating a point with description of "FH" (for Fire Hydrant), Carlson would look up "FH" in the Field to Finish table and will use the field code definitions to establish the parameters of the point being created instead of the definitions defined in within *Point Defaults*. The Field To Finish settings under **Additional Draw Options** are described in the Field To Finish topic in the manual.

**Code Table:** This option lets you specify the Feature Library Definition file (FLD) used by the Use Field to Finish controls specified above.

**GIS File:** This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results to the note file (.not) associated with the current coordinate file.

**Pulldown Menu Location(s):** Points

**Keyboard Command:** ptsetup

**Prerequisite:** None

---

**Draw-Locate Points**

The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.
The Coordinate File at the top of the dialog shows the current file which can be changed with the Set button.

The name of the symbol file is displayed in Symbol Name. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

Symbol Rotation Azimuth is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.

Layer by Description inserts the points in the layer named by the point description. Using Layer by Description organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT_" and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.

Draw Nodes Only inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting Elev Text Only draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

Locate within Polyline inserts only the points that are inside a closed inclusion polyline. The command prompts you to select a closed inclusion polyline and as well as an optional exclusion polyline. All the points in the current coordinate file are checked. Any points that are located within the inclusion polyline and outside the exclusion polyline are drawn.

Locate within Distance inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

Locate within Window/Coord Range inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command
prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

Under **Point Prompt-Label Settings**, you determine attributes for which you will be prompted.

**Descriptions** determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

**Notes** works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

**Elevations** determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

Use '+' labels the positive elevations with a leading '+'. For example, "+159.43".

Use '-' labels the negative elevations with a leading '-'.

**Locate on Real Z Axis** determines if the points are placed at their elevations or at zero elevation.

**Label Zeros** will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

**Elevation Prefix/Suffix** set the prefix and suffix labels to apply for the elevation labels.

**Elevation Integers** controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals** sets the number of decimals to the right of the decimal places for the elevation labels.

Under **Point Number Settings**, you determine how points will be numbered.

**Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name, CLAYER, or choose an existing layer by clicking Select Layer. Entry of CLAYER selects the current layer. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNTMARK, PNTNO, PNTELEV, and PNTDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by
the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNTS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for all the points.

The **Duplicates** option for **Erase and Redraw** will erase existing point entities that match the point numbers currently being drawn. The **Allow Duplicates** option will leave any existing point entities as the specified points are drawn. The **Draw Only New** option will only draw points that don't already exist in the drawing.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Symbol Size Scaler** controls the size of the point symbol and **Text Size Scaler** controls the size of the point attribute labels. The scalers are multiplied by the Horizontal Scale from Drawing Setup to set the size in drawing units.

**Match Properties** prompts to select an existing point entity and then the program sets the settings in the dialog such as layer and symbol to match the selected point.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting. When a grid projection is defined in Drawing Setup, then there is an option to enter the points using latitude/longitude.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap to EndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**

To create a new point:

**Draw-Locate dialog** choose **Screen Pick**

Pick point to create: pick a point

Select/<Enter Point Elevation <0.00>: Enter elevation Press S to select text to set elevation.

Enter Point Description <>: Enter

N: 5106.57 E: 4901.96 Z: 0.00

Enter/<Select text of elevation>: Select text entity that defines elevation of point.

To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** choose **Draw Range**

Point numbers to draw: 3

Points Drawn > 1

Locates point 3.

Point numbers to draw: 1-2

Points Drawn > 2

Locates a range of points. From 1 to 2.

Point numbers to draw: Enter

Keyboard Command: lpoint

**Prerequisite:** A CRD file and you may want to execute **Drawing Setup** (see the Setting menu) to set the scale and
Field To Finish

When collecting field data, the Field-to-Finish process can be used to draw the points with distinct layers, symbols and other settings based on the point description. Each point description is looked up in the Field-to-Finish code table which defines the layer, symbol and other properties for that description. The code definition can also be used to draw linework between the points. This code table is created using the Field to Finish command in the COGO menu. Codes can be alpha, numeric or alphanumeric. The Carlson Field data collection functions Point Store and AutoPoints at Interval can use a Field-to-Finish code table.

Field-to-Finish - Use Code Table ...

For Field-to-Finish mapping while collecting field data, go to Configure Field, select Point Settings. Under the Field-to-Finish heading check the boxes to the right of Use Code Table For. This activates Field-to-Finish so that points stored with descriptions that are defined as codes in the code table are drawn using the code symbol, description, linetype and layer.

Field-to-Finish - Code File

The currently active code table file is displayed next to Code File. Only one Field-to-Finish code table is active at a time. Several code tables can be created for different clients or applications. Use the Select File button to set which code file is active.

![Point Settings dialog box](image)

Selecting a Code

Both functions Point Store and Auto Points at Interval can use Field-to-Finish capabilities. Each of these data collection functions can display a list of the codes from the currently active Field-to-Finish code table. This alleviates you from having to guess code abbreviations. When you pick Code or press F7, a summary of the currently active code table appears. Use Page Down or Page Up to scroll quickly through the code table. Use the Up or Down arrow...
keys to highlight the code description desired and double click or press Enter to select. If you already know
the code, you can just type it in the *Desc* field.

Field-to-Finish - *Options* (F6)

If you are using the *Point Store* or *Auto Points at Interval* functions, you can change your Field-to-Finish settings by
clicking *Options* or hitting F6. This brings up the *Point Settings* window. You can toggle the *Field to Finish* options
on or off, or you can select a different code table. You can also change the default point settings here. All of this can
be done without leaving *Point Store* or *Auto Points at Interval*.

Field-to-Finish - Editing the Code Table

The code table can be displayed using the command *Field to Finish* under the *COGO* menu. Each line corresponds
to a code. All of the code's parameters (layer, symbol type, description, size,
Linetype) are controlled from here. Clicking on a code will bring up a window which will let you change the settings for this code. New codes can be added using the Add button on the code table.

Field to Finish - Linework

Linework includes all mapping by 2D or 3D polylines with line and arc segments. The Field-to-Finish code table controls the linetype, color and layer for all linework. It does not control where polylines, lines or arcs start or end. Starting and ending linework is controlled directly in Carlson Field’s data collection commands Point Store and Auto Points at Interval.

2D Polylines are always drawn at zero elevation. Their linetypes can be defined in the code table. A simple curve requires three points: a PC, one point on the curve and a PT. The simple curve is drawn as an arc. Complex curves can be shot using multiple points along the curve between the PC and PT. There is no upper limit to how many points can be used. Carlson Field does a Bezier fit to join all these points. The complex curve is actually drawn as a series of very short chords.

3D Polylines are a series of connected 3D points. All curved sections of 3D polylines are drawn as series of very short chords. Elevations of these chords are interpolated from the elevations of the curve endpoints. 3D polylines can be used as breaklines for surface modeling of curving curb lines, retaining walls or any other structure. Using Carlson Field’s Triangulate and Contour command, operators can create a contour map in the field using the data they just gathered and thus check that no areas or breaklines lines are missing or incomplete prior to leaving the site.

Nesting Linework & Points

Both Point Store and Auto Points at Interval allow you to be drawing multiple polylines at the same time. Without ending your current line, you can start another line by simply changing the description code. As long as you didn't select End under Linework for your first line, you can come back to it later. Carlson Field will always recognize if a code next to Desc refers to a line currently active. If it does, Carlson Field continues that line to the new point. To stop a line from being active, you can choose End under Linework before storing the point number.

If two or more polylines are drawn in the same session using the same code, you must add a number after the code to differentiate between two lines. (e.g. EP, EP1, EP2...)

If you use the same point number twice, Carlson Field will allow you to select a new number, override the previous coordinates, or average the two measurements together.
Field-to-Finish Quick Overview

Point Store - Steps to draw using Field-to-Finish:

1) Configure Field - Select the GPS or Total Station equipment in the first dialog.

2) In Configure Field—Point Settings, select the code table to be used. Enable "Use Code Table For" by checking "Symbols", "Descriptions", "Linework" and "Layers".

3) Initiate "Point Store" in Field.

4) Press F7 for the Code button to select the defined code "UP" from the Field-to-Finish code list.

5) Press F8 to start linework or check "Start" under linework.

6) Press F1 for the Read button to take a shot.

7) Press F2 for the Store button to store this point.

Now move to the next location and hit F1 then F2 again to repeat steps 6 and 7. Notice a line between points 7 & 8 draws with a "T" for telephone line and the symbol drawn is a utility pole symbol. The symbol, linework and layer are predefined for the "UP" code in the Field-to-Finish code table. If a line between the two points does not draw, simple click in the join box and a line is drawn between the two points.

Remark: In "Linework", after picking "Start", the next shot with the same description defaults to "Cont"(continue) automatically and the line continues to this next point. When finishing linework, you must select "End" to stop the linework. Linework for breaklines should always be 3D polylines with elevations, unless you select the "No Elev" option. 2D polylines are always drawn at zero elevation and their linetype is defined in the Field-to-Finish code table.
Special Characters and Conditions

When collecting points with additional description information besides the code, use a forward slash (/) after the code and before the additional description. All text after the forward slash is appended text that does not affect the code table (e.g. UP/#531, BLD/COR, PIPE/24", 14D/OAK). When drawing the point in the CAD drawing, the forward slash disappears and UP/#531 will plot as POLE #531. The original code, with forward slash and appended text, is stored in the coordinate and raw file.

Multiple codes are allowed in Point Store. In collecting a point such as a "T" intersection in a fence, the point can be collected once, but with two codes (separated by a space) as the Desc (e.g. FP1 FP2). This also applies when storing a point that contains two or more distinct ground features (e.g. Edge Of Pavement and Catch Basin). Here also you can collect one point and store this point with two codes separated by a space (e.g. EOP CB). The point plots twice: once in the EOP layer and a second time in the CB layer. The point is plotted on two layers in the drawing, but is stored only once in the coordinate file. Points collected in this fashion can have multiple symbols and have multiple lines drawn through them.

Undefined Codes

All points stored without descriptions or with descriptions not stored in the Field-to-Finish code table are drawn using the default Drawing Options in Configure Field->Point Settings.
**List Points**

This command generates a report of point numbers, northings, eastings, elevations and descriptions.

**Selection Method-Range** allows you to specify the points to list by point number range

**Selection Method-Area** allows you to select a closed polyline to list all of the points inside of that polyline.

**Selection Method-Selection Set** allows you to specify the points to list by selecting them from the drawing.

**Range of Points:** If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the **All** button.

**Point Group** allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.
**Description Match:** Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.

**Report Coordinate Range:** When checked, the point list will include the minimum and maximum northing, easting and elevation.

**List Point Notes:** When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the Input-Edit Point command found in Coordinate File Utilities.

**Use Report Formatter:** When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

**Double Space Between Points:** When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the Edit Points command in the Points menu.

Example of List Points Report:

```
List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description>
Job Number> 0.000 Job Date> 06/01/2002
PointNo. Northing(Y) Easting(X) Elev(Z) Description
1 5355.240 5000.000 91.8 CP2
2 5000.000 5000.000 90.0 CP2
1000 5355.236 5000.000 91.8 CK
1001 4941.911 4622.029 91.4 FPC
1002 4952.629 4642.818 90.6 FH
1003 4959.931 4634.440 89.8 TOE1
```

**Modify Points**

**Resize Point Attributes**
This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

**Prompts**

Enter point attribute and symbol size <4.0>: press Enter
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points.
Select objects: pick the point entities
Finding Carlson Software Point Attributes ....
Number of entities changed > 10

**Pulldown Menu Location:** Points
**Keyboard Command:** listpt
**Prerequisite:** Points in a coordinate file or on the screen
Prerequisite: Carlson points

Twist Point Attributes

This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and/or point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.

Prompts

Twist by [Twist screen>/Azimuth/Entity segment/Follow polyline]? F for follow
Attributes to twist [All>/Symbol/Name/Elevation/Description]? press Enter
Select reference polylines to follow.
Select objects: pick a polyline
Select points from screen, group or by point number [Screen>/Group/Number]? select Enter
Select Carlson Software points.
Select objects: pick the Carlson point inserts

Point attributes aligned by Follow Polyline option of Twist Point

Pulldown Menu Location: Points
Keyboard Command: twistpts
Prerequisite: None

Erase Points

This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the three entities that make up a Carlson point: the point symbol, point attributes, and point node. There is an option to skip erasing the point symbol in case you want to leave the symbols in the drawing. The points may optionally be erased from the coordinate file. As long as the points are not deleted from the coordinate file, they can be redrawn with Draw-Locate Points or Field-to-Finish.

When the program detects linework associated with the points, there is a prompt for whether to erase this linework too. For example, when Field-to-Finish is used to draw both points and linework, then this linework can be erased along with the points.

Prompts

Select points from screen, group or by point number [Screen/Group/<Number>]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file [Yes/<No>]? press Enter
Delete point symbols [<Yes>/No]? press Enter
Erasing Carlson Points ....
Number of points erased > 5

Pulldown Menu Location: Points
Keyboard Command: DELPT
Prerequisite: Carlson points to be erased

Adjust Coordinates

Translate Points

This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and Z can be entered directly or calculated from original and destination coordinates. The original and destination coordinates can be entered directly, specified by point number, selecting the point number from a point list by selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified, the Delta X,Y,Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points in the drawing will be updated automatically in addition to updating the coordinate file.

Define Translation By Angle/Distance requires a specified direction, Northeast (NE), Southeast (SE), Southwest (SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the direction and distance are entered, the Delta X,Y,Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the...
Distance field.

With **Process Elevations** checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

**Ignore Zero Elevations** is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With **Translate Screen Entities** checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed: Select objects to rotate (points excluded):

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.

Various **Output Options** for the translated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

**New CRD File** will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a **Range of Points** (1-20,33,36-40....) or by **Point Groups**. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only translates points with the description(s) specified in this field.

**Undo Last Translation** restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command **MOVE** can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in Configure. (Note: This toggle must have been turned ON prior to locating the points). If you do use the **MOVE** command and the CRD file needs updating, run the command **Update CRD file From Drawing** found in Coordinate File Utilities.

**Pulldown Menu Location:** Points  
**Keyboard Command:** transpt  
**Prerequisite:** points in a coordinate file
Rotate Points

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.

The Rotation Point will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the List button to pick from a list of points contained in the coordinate file, or from the screen by using the Pick button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The Original Bearings/Azimuths and Destination Bearings/Azimuths can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 10-12 match the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With Rotate Screen Entities checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):.
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation of the points and screen entities will be completed.

Various Output options for the rotated points are available.

Overwrite Existing Coordinates will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

New Point Numbers will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.
Specifying the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only rotates points with the description(s) specified in this field.

The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** rotatept  
**Prerequisite:** points in a coordinate file

### Scale Points

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.
Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing "group" in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field.

The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. The Combined Factor is the Elevation Factor times the Grid Factor. This calculation process begins with the Calculate Scale Factor dialog shown below.

The **Projection Type** must be specified as either State Plane 83 or State Plane 27 as well as what state plane **Zone** is required.
The available Coordinate Units are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The Range of Numbers to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the List button.

Scale Direction determines which way the scale factor will be calculated. A scale for Ground to Grid or Grid to Ground can be calculated and applied.

Pressing the Calculate button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the OK button.

The Report option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.

With Align Scale Entities checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to scale (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With Use Customized Scale Factor Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

Pulldown Menu Location: Points
Keyboard Command: scalept
Prerequisite: points in a coordinate file

Move Points
This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: a POINT entity, a symbol, and a point attribute block with the point number, elevation and description. This routine updates the X,Y of the point and not the Z. To update the elevation, use commands such as Edit Point Attributes or Translate Points. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point. Setting the Link Points with CRD File from Carlson Configure->General Settings is not necessary because the coordinate file is always updated since the Move Points command has built-in smarts to lookup the coordinate file for the selected point entity. The Link Points settings applies to generic CAD commands like the regular Move command.

Pulldown Menu Location: Points
Keyboard Command: mpnt
Prerequisite: Carlson points

Move Point Attributes Single
This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

Prompts
Select Point Number, Elevation, or Description to Move: select point attribute
Pick new location: pick point
Pick new angle: pick new angle or press Enter
Pulldown Menu Location: Points
Keyboard Command: movepnt
Prerequisite: Carlson points

Move Point Attributes with Leader
This command allows you to move Carlson point attributes (including the point number, elevation or description), and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts. If you redraw a point with Draw-Locate Points or Field-To-Finish, the program will recall the moved attribute location to redraw the attributes in the same location as long as the point coordinate is the same.

Prompts
Select Point Label to Move (O for Options, R for Restore): select point attribute
Pick label position: pick point
Select another Point Label to Move (O for Options, R for Restore, Enter to End): O
**Minimum Leader Length Scaler:** Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.

**Prompt for Curved Leader Points:** This option prompts for additional leader points and creates a smooth leader that goes through all the leader points.

**Draw Horizontal Leader Tick:** Specifies whether or not to draw a terminating tick (a short horizontal line segment sometimes referred to as a "hook line").

**Draw Arrowhead:** Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

**Minimum Leader for Arrow Scaler:** Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.

**Arrow Size Scaler:** A scale factor to apply to resize the arrowhead symbol.

**Leader Offset Scaler:** A distance indicating the desired offset from the point node to the tip of the leader.

**Use Separate Leader Layer:** Specifies whether or not to use a layer other than that of the identified point for the leader. Use the Select button to choose an alternative layer for the leader.

**Point Name Order, Elevation Order and Description Order:** These settings control the sequence of the attributes for the leader.

Select another Point Label to Move (O for Options, R for Restore, Enter to End): R
Select Point Label to Restore: pick label

**Pulldown Menu Location:** Points
**Keyboard Command:** movepntleader
**Prerequisite:** Carlson points

---

**Create Points from Entities**

This command will create Carlson Survey points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the **Prompt for Elevations** toggle and select the **Locate on Real Z Axis** toggle. After you
have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the **Description Settings**, **Prompt for Description At Each Point** will prompt you at the command line for a description for each individual point. **Prompt Per Entity** will ask you for a description per each highlighted entity. **Use Entity Layer for Description** will assign the layer name to the description. **Same Description For All Points** will prompt you for a single description for all points.

The second options dialog has processing settings. When **Entity Layer for Description** is checked, the layer name of the entity will be used as the description for the created point. When **Avoid Duplicates with Existing Pts** is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.

**Prompts**

**Create Points From Entities Dialogs** Choose settings
Select arcs, faces, points, text, lines and polylines.
Select objects: pick entities
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

Pulldown Menu Location: COGO
Keyboard Command: autopnts
Prerequisite: drawing entities

Offset Points By Interval

This command creates offset points along an alignment which can be used for creating curb stakeout points. The alignment can be defined by either a 2D polyline or a centerline file (.cl). The options dialog has three tabs for the General, Description and Draw settings.
Offset Distance: Sets the offset distance from the alignment to the points. Use a positive value for offset right and negative for offset left.

Reference Elevation: This setting controls the point elevations. The 3D Polyline method prompts to select a 3D polyline. The offset points get the elevations from the position of the nearest perpendicular offset on the 3D polyline. The Profile method prompts to select a profile file. The stations of the profile must match the alignment stations. The Constant method sets the point elevations to a fixed elevation. The Surface Model method uses a triangulation (.tin) or grid (.grd) surface model file.

Delta Z: Adjusts the point elevations from the reference elevations.

Create Interval Points: Creates points along the alignment at the specified interval. There are separate intervals for line and curve segments.

Space Points Evenly: For each segment, this option figures how many points fit at the interval and then adjusts the interval to make that number of points evenly spaced. For example, if the interval is 10 and the segment length is 48, then 4 points fit and this option will space them at an interval of 12.

Create Vertex Points: Creates points offset from the points in the alignment.

Create Radius Points: Creates radius points for curve segments in the alignment.

Offset Side Only: Applies to radius points and only creates the radius point when it is on the same side of the alignment as the offset direction.

Max Radius: Applies to radius points to only create the radius point when the radius of the curve is less than this amount.

Create Only Radius Points on Small Curves: When the curve radius is less than the Min Radius, only the radius point is created and not the PC, PT or mid points.

Create Curve Midpoints: Creates a point midway along the curve when the curve length is greater than the specified Min Curve Length.

Minimum Deflection Angle: At an alignment vertex between two line segments, when the deflection between the line in and line out is greater than this value, only a single offset point is created. Otherwise two offset points are created, one for the line in and one for the line out. Set this value to 0 to always have only a single offset point. Set this value to 180 to always have two offset points.

Deflection Distance Tolerance: Sets how close together two offset points should be set on vertex deflection points. When the vertex point is set to get two offset points, but the offset points are within this tolerance of each other, then only a single offset point is created instead of two.

Starting Point Number: The new point numbers will increment starting from this number.
**Point Group to Assign:** Creates a point group for the new points created by this command.

**Create 2nd Offsets:** Creates a second set of points at the 2nd Offset Distance.

The Description settings control the point descriptions for the various types of new points. The **Append Offset To Description** option adds the offset amount to the description of each point.

The Draw settings have the symbol and layer for the points. The **Draw Lines** option is for drawing lines between
the alignment and the points.

Prompts

**CL File/<Select alignment polyline>:** *pick a polyline*

**Offset Points dialog**

**Pulldown Menu Location:** COGO

**Keyboard Command:** curb_pnts

**Prerequisite:** Alignment polyline or centerline

---

**CooRDinate File Utilities**

This command organizes a wide variety of coordinate file and point manipulation routines into one central location. The type of coordinate file format is displayed within the dialog box. Another increasingly popular coordinate format is the Carlson coordinate database (.CRDB) which is based on SQLite and supports point numbers and descriptions up to 255 characters in length.
In addition to running the routines through the dialog, many routines have command names that you can enter at the Command prompt, create a Quick Key, or put into a toolbar. The table below shows the command names and their corresponding key-in command equivalents:

<table>
<thead>
<tr>
<th>File Utilities</th>
<th>Point Utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open CRD File</td>
<td>List Points</td>
</tr>
<tr>
<td>Copy/Merge CRD File</td>
<td>Delete Points</td>
</tr>
<tr>
<td>Convert CRD File Format</td>
<td>Screen Pick Point</td>
</tr>
<tr>
<td>Map Points from 2nd File</td>
<td>Scale Points</td>
</tr>
<tr>
<td>Import Text/ASCII File</td>
<td>Translate Points</td>
</tr>
<tr>
<td>Export Text/ASCII File</td>
<td>Rotate Points</td>
</tr>
<tr>
<td>Edit Header</td>
<td>Align Points</td>
</tr>
<tr>
<td>Compress CRD File</td>
<td>Description for Points</td>
</tr>
<tr>
<td>Coordinate Transformation</td>
<td>Elevation for Points</td>
</tr>
<tr>
<td>Draw Entities by Point ID</td>
<td>Point Number Report</td>
</tr>
<tr>
<td>New Last Point Number</td>
<td>Duplicate Points</td>
</tr>
<tr>
<td>Swap Northing-Easting</td>
<td>Compare Points</td>
</tr>
<tr>
<td>Point Entity CRD File Links Manager</td>
<td>Renumber Points</td>
</tr>
<tr>
<td>Update Drawing from CRD File</td>
<td>Edit.Assign Point</td>
</tr>
<tr>
<td>Update CRD File from cfuupdatecrd</td>
<td>Point History</td>
</tr>
</tbody>
</table>

Chapter 13. Points Menu
Open CRD File: Allows the user to switch to another file. See Set Coordinate File for additional information. When you exit Coordinate File Utilities this will be the current file that you work with in Carlson.

List Points: List the points stored in the active coordinate file. See List Points for additional information.

Copy/Merge CRD File: This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.

Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.

Next there's a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together. For example, 1-3,10,15 would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don't have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.
The Import dialog has a few more options than the Export dialog. The Add Prefix/Suffix To Point Names will change the point names as they are imported. The Create Point Group will make a new point group with the imported point names.

Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.
Delete Points: Deletes points from the active coordinate file. See Erase Points for additional information.

Convert CRD File Format: This allows you to convert the current coordinate file from one format (e.g. numeric only) to another (e.g. alphanumeric). This routine will also change coordinate files to and from other software formats. These formats include Carlson SQLite (.CRDB), C&G, Microsoft Access (.MDB) in same format as AutoDesk Land Desktop, and Simplicity (.ZAK). The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.

Screen Pick Point: Pick a point on the graphics screen and its coordinate value is added to the coordinate file. This command does not plot a point, point attributes or point symbol. Use Draw Field-to-Finish or Draw-Locate Points or Update Drawing from CRD File to graphically draw the point(s).

Map Points from 2nd File: This routine adds point to the current coordinate file from points stored in a second coordinate file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to create in current coordinate file) and source point number (point number to be copied from second coordinate file) will be displayed.

Scale Points: This option multiplies the point northing, easting, and elevation by the scale conversion factor. You can use this routine for Metric-Imperial unit conversion. See Scale Points for additional information.

Import Text/ASCII File: This routine converts point data from a text file into the current coordinate file. See Import Text/ASCII File for additional information.

Translate Points: This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See Translate Points for additional information.

Export Text/ASCII Text File: This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See Export Text/ASCII File for additional information.

Rotate Points: This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See Rotate Points for additional information.

Edit Header: Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

Align Points: This option does a translate based on a source point and destination point and then rotates to align the
first source point and a second source point with the first destination point and a second destination point. See Align Points for additional information.

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.

**Description for Points:** This routine modifies the point description field with the user-specified text for a range of point numbers. There is an option to update the description attributes of the points in the drawing in addition to updating the coordinate file.

**Coordinate Transformation:** Transforms coordinates between local, State Plane 27, State Plane 83, Latitude/Longitude, Universal Transverse Mercator (UTM) and many other projections, including regional and user-defined projections. This works on individually entered coordinates, by range of point numbers and with on-screen entities. See Coordinate Transformation for additional information.

**Elevation for Points:** This routine modifies the elevation of the specified points. The Absolute method sets the elevations to the specified value. The Differential method adds the value to the current elevations. The Scale method multiplies the current elevations by the value.

**Draw Entities by Point ID:** Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.
Prompts

Plot Entities by Point Number
Type of entity, Arc/Polyline/3dpoly/2dline/Exit/<Line>: Indicate the type of entity to draw.
Undo/<Enter point numbers or ranges>: Indicate the point numbers through which to draw.
Example: 1-4,7,10-12,5,8 would draw the entity from point numbers 1 through 4 then to 7, to 10 through 12, then to 5 to 8 (limit 132 characters)
Example: 1-10,20-30 would draw the entity from point number 1 through 10 then to point number 20 through 30.

Point Number Report: This routine lists the used and the unused point numbers in the coordinate file.

New Last Point Number: This option sets the highest point number in the coordinate file. NOTE: All points above this number are erased!

Duplicate Points: This function searches the coordinate file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be reported, deleted or averaged. For the erase and average options, the first point number is kept and any higher point numbers with duplicate coordinates are processed from the coordinate file.

Swap Northing-Easting: This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) become the northing(s).

Compare Points: This function compares the coordinates in the coordinate file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another coordinate file or with different point numbers from the same coordinate file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report. The Create Point Groups option creates point groups of "Missing From Drawing" and "Changed Points" for any points that have this status. Use the Point Group Manager routine to check on these point groups.
Example Bearing-Distance format Compare Points Report:

<table>
<thead>
<tr>
<th>Point#</th>
<th>Hdiff</th>
<th>Bearing</th>
<th>Zdiff</th>
</tr>
</thead>
<tbody>
<tr>
<td>46</td>
<td>0.0138</td>
<td>S 46°07'05&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>66</td>
<td>0.0130</td>
<td>S 45°40'26&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>87</td>
<td>0.0138</td>
<td>S 45°55'41&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>88</td>
<td>0.0138</td>
<td>S 45°08'23&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>148</td>
<td>0.0138</td>
<td>S 45°07'06&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>149</td>
<td>0.0139</td>
<td>S 45°54'17&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>4</td>
<td>0.0137</td>
<td>S 46°19'06&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>5</td>
<td>0.0136</td>
<td>S 45°36'55&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>47</td>
<td>0.0137</td>
<td>S 46°25'52&quot; W</td>
<td>0.0000</td>
</tr>
<tr>
<td>48</td>
<td>0.0136</td>
<td>S 46°43'46&quot; W</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

**Point Entry CRD File Links Manager:** When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the changes (e.g., those generated from the Rotate Points routine) back to the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the coordinate file assigned to point entities which is useful when the coordinate file has been moved or manually renamed after the points were drawn. Use the Unlink button to remove the link.
**Renumber Points:** This option renumbers points in the user-specified range starting from a new point number. See Renumber Points for additional information.

**Update Drawing from CRD File:** This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.

![Update Drawing from CRD File](image)

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press **Enter**. To edit a note, highlight the line in the list box and edit the text in the edit box.

![Input-Edit Point](image)

**Update CRD File from Drawing:** This function allows you to select all or some of the points in the drawing and add or update them to the coordinate file. The points can be filtered using standard CAD entity selection and/or...
wild-card matching of the point descriptions. The Update Point Descriptions option determines whether the point descriptions from the drawing will be stored to the coordinate file. Use this command to manually update the file after a general CAD edit such as Move, Rotate, Erase, etc. This routine directly reads Leica (Wildsoft), Softdesk, Geodimeter, InRoads, Land Development Desktop, and Eagle Point point blocks.

**Point History:** All changes to the coordinate file will record the commands performed on this coordinate file and the status of the points themselves. This makes up the coordinate file history. The history can then be reported by point number or by command. All of the changes can be rolled back.

![Coordinate File History Utilities](image)

The **Disable History Feature** button at the top of the dialog shown above is a toggle device. It should be clicked if you prefer not to build the point history file. Clicking it a second time changes it back to saying **Enable History Feature**. You can also choose **Delete History File** to delete the file altogether. By clicking any point from the list, as shown in the Points tab example above, and then selecting **History**, you will be given the history for that specific point. Double-clicking on any command shows the details. Clicking on **Details** also shows the selected command details. Undo thru Selected will undo the effect of all of the commands up through and including the selected command. The changes from the undo command are themselves then added to the command list and can be undone in the future.

**NOTE:** It is important to note that if maintaining such a history file is your objective, make sure that **Maintain CRD History File** option is enabled within the (Carlson) Configure – General Settings command:

![Object Linking](image)

**Point Protect:** When enabled, attempting to store a point with a point identifier (point number) that already exists in the current coordinate file will display the following alert:
Overwrite with new coordinates will update the existing point number with the new location of the point.

The Renumber Point# field displays the point number that will be used if the Renumber Point# From – Next Available option is selected (the routine will attempt to fill in any point number gaps. To leave any existing point number gaps in the file, specify the End of File option.

The Overwrite All and Renumber All options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing coordinate files.

Pulldown Menu Location(s): Points
Keyboard Command: cfu
Prerequisite: None

Point Group Manager

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

Groups Pulldown

Create Point Group: This routine creates point groups. When selected, the New Point Group dialog box is displayed.
**Group Name** is the name of Point Group to create.

**Description** is the description of Point Group to create.

Use the **Include Tab** to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When **Include All** is toggled on, all points in the coordinate file will be included in the selection.

When **Point List** is toggled on, an option of defining the point list can be selected or the point numbers can be manually entered in the edit box. The points retain the order entered in the edit box which can be used in other point functions that process points where the order matters such as Legal Description. The Edit button brings up a spreadsheet editor for the point list and there is a flag for each point for whether the point is a radius point. This radius point flag is used in routines that process points for a polyline or perimeter such as Legal Description. The radius point is used to define an arc in the polyline. The sequence of points for the arc are PC, radius point and PT.
**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools are available for selection of the points.

**DWG: Inside Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Inside Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**DWG: Along Polyline** allows for the selection of points to include by offset from an alignment polyline. All points located within the specified offset tolerance from the polyline will be included in the selection.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
**CRD: Inside Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

**CRD: Inside Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

**CRD: Along Polyline** allows for the selection of points to include by offset from an alignment polyline. All points located within the specified offset tolerance from the polyline will be included in the selection.

**RW5 File:** creates a list of points from all the point numbers used in the selected RW5 raw data file.

**History Select:** creates a point group by date range using the log stored in the CRD history. See Coordinate File Utility > Point History to review this information.

**Point Name Prefix:** creates a point group by a specified number of digits from the start of point names. This method applies when your point numbering method uses a fixed beginning string for point names. For example, if point names begin with a code for the crew, then this method can make point groups per crew.

**Elevation Range** allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

**Set By Selection** allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

**Set From List** allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.

The **Description** option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.

The **Exclude Tab** allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12,
an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

**Save Changes** saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

**Cancel Changes** discards specified rules and changes and goes back to the Point Group Manager dialog.

**Edit Point Group:** This function allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.

See Create Point Groups for further definitions of the available options.

**Delete Point Group:** This deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Copy Point Group:** This routine creates a new point group by copying the currently highlighted group. This allows you to modify an existing group definition and create a new group.

**Import Point Groups:** This allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.

### Points Pulldown

**Insert into Drawing:** This routine draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.
Erase from Coordinate File and Drawing: This erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:

![Warning dialog box](image)

Selecting Yes will complete the command and erase the points from the screen and also the coordinate file. Selecting No will cancel the command leaving the drawing and the coordinate file unchanged.

Report: The routine will generate a point list of the points contained in the selected group/groups or specified points from within the group.

Highlight: This routine highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

Isolate: This routine freezes all the points except for the current group.

Freeze: This routine freezes the points of the highlighted point group like the Points->Freeze Points command.

Thaw: This routine thaws the points of the highlighted point group like the Points->Thaw Points command.

Thaw All: This routine thaws all the points like the Points->Thaw Points command.

Draw 2D Line: This routine draws a 2D polyline between the points contained in the group/groups or between specified points in a group.

Renumber: Renumbers points in the current group.

Edit Attributes: Edits the point attributes for the points entities in the drawing.

Edit Descriptions: Sets the description for the points in the current group.

Edit Elevations: Sets the elevation for the points in the current group.

Export: This command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files.

When ASCII/Text is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.

**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.

Specify the file name of the CRD file to create and press save.

### Button Functions

The series of buttons at the bottom of the main dialog do the same functions as the routines in the Groups pull-down menu except the Move Up and Move Down which are only available as these buttons. The Move **Up/Down** simply change the display order of the groups in the list. The **Import** function brings in group definitions from either another coordinate file or from a C&G Points List File. The **Sort** function sorts the groups by name or by number of points. The **Merge** function combines the definitions from two or more existing groups to create a new group. To run Merge, highlight the groups to merge in the Groups list by clicking on them while holding the Ctrl key, and then pick the Merge button.

**Pulldown Menu Location:** Points  
**Keyboard Command:** pgm  
**Prerequisite:** A coordinate file
Interpolate Points

Point on Arc
This command locates a point on an arc. You can select an arc entity, an arc polyline segment or enter three points to define an arc. After the arc is defined, the screen preview arrow shows the occupied point and the distance to solve for is entered. The command then displays the curve information and locates/inserts a point symbol at the computed point. When prompted for the distance, use a positive value if the distance is from the 1st endpoint (PC the one highlighted by the screen preview arrow) and a negative value if from the 2nd endpoint (PT).

Prompts

Define arc by, Points/<select arc or polyline>: pick arc or polyline arc segment Pick a point on the arc somewhere near it's midpoint. The preview arrow points to the 1st endpoint.
Precede distance with minus sign if distance from 2nd endpoint.
Distance along arc from 1st point: 100
The command then plots a point at the computed distance.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptarc
Prerequisite: None

Divide Between Points
This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations (to interpolate the elevations, the points picked must be at their real Z axis elevation).

Prompts

Interpolate elevations [Yes/<No>]? hit Enter
Point to divide-interpolate from?
Pick point or point number: 1

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4252.76</td>
<td>4158.32</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>
Point to divide-interpolate to?
Pick point or point number: pick a point
Number of Segments-Divisions: 3
Enter Point Description <>: hit Enter
The command then locates two points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divlin
Prerequisite: 2 points

Elevation Along Entity
This command creates points at a specified elevations along 3D polylines. The points are stored in the current coordinate file and drawn on the screen. A single elevation can be entered or use an elevation interval.

Prompts
Select entities to process
Select objects: pick a 3D polyline
Elevation Range: 547.200 to 587.300
Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter elevation interval: 1
Point Description: EP

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: entptz
Prerequisite: 3D polyline

Divide Along Entity
This command locates points along an entity such as a line, polyline, spline or arc. You must specify the number of divisions.

Prompts
Interpolate Elevations [Yes/<No>]?: press Enter
Select Entity to Divide: pick point on entity
Number of Divisions/Segments: 15
The command then locates 14 points.
Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divent
Prerequisite: 2 points if you want to interpolate elevations

Interval Along Entity

This command creates points at a specified distance along an entity such as a line, arc, spline or polyline. The points are listed out on the text screen, stored in the current coordinate (.CRD) file and drawn on the screen. For example, you might use this command to locate lot corner points along a frontage line. When Break Entity at Points is checked, the selected entity will be broken at every located point. The Create Points At Endpoints option locates points at the starting and ending points of the entity. When Create Point at Vertices is checked, points will also be located at each vertex of the selected entity. Horizontal Distance Between Points allow you to specify the distance between located points. There is also an option to create points on curved portions of the centerline at a different interval than on tangent portions (to reduce chord lengths, a shorter interval may be suitable for curves).

There is an option in this dialog allowing you to determine whether or not to label elevations on the new points. And for the purposes of describing the points, there is an option that allows you to set the same description to all of the points. For more options related to points, see Point Defaults under the Points pulldown.
Create Points at Endpoints turned on

Prompts

Select entity near endpoint which defines first station.
[nea on] Select Entity to Interpolate Points: select entity
[nea on] Select Entity to Interpolate Points: Locating 13 Points
The command locates points along the selected entity.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptint
Prerequisite: An entity

Linework Intersection Points

This command is used to create points at all of the intersections between selected linework entities.
Prompts

Select lines and polylines to process.
Select objects: Specify opposite corner: pick objects

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: ADDINTPTS
Prerequisite: None

Label Coordinates/Elevation

This command will label a coordinate on the screen. You can choose to label the northing and easting, or the elevation, or all three properties. The point can be picked on screen, or specified by point number or point group from the current coordinate (.CRD) file. Options include drawing a box around the label, labeling both feet and meters, setting the layer name for the label, setting the display precision, deciding whether or not to use a leader and selecting a change in the symbol used to mark the point. You can also set the text prefix and suffix for the label. Additionally, you can locate a label on Real Z Axis. The Label With Inches option labels with whole feet and inches for the decimal part. The Label Point Number option uses the point number from the coordinate file. The Label Description option is for including a description with the label. There is a choice for placing this description as a header or footer. The program will prompt for the description. The Use MText option chooses between creating the labels as MText or regular text entities. The Label Angle setting chooses between having the labels horizontal, at a fixed azimuth or prompting to pick the angle for each label. The Label Style chooses between labeling with a leader, with a symbol, as an MLeader entity or along the x/y axis. The Separate Negative Labels option has prefix and suffix settings for negative coordinates that can be used for South and West labels. The Label Lat/Lon adds latitude and longitude labels to the coordinate labels. To use this option, the coordinate system must be defined in the Drawing Setup command.
There is also an option to label the Delta X, Y and/or Z between two points, which is called **Label Delta Between Two Points**. When this option is clicked On, and after the prompt, you will first click two points locations. The label, with the delta value(s), will then be placed precisely in between these two pick locations. If, for example, the North, East and Elevation button is chosen, the resulting label will show the N, E and Z delta values.

The Save and Load buttons save and recall all the settings for this command to .LCE files. This is a way to manage different label styles for different mapping standards and to share between users.

**Prompts**

**Label Coordinates/Elevation dialog**
*Point to Label?*
*Pick point or point number: pick a point*
*Point to Label (ENTER to End)?*
*Pick point or point number: press Enter*

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** labcoor  
**Prerequisite:** None

**Spot Elevations**

This command allows you to label points with their elevation. The point can either be digitized from a drawing, picked on a screen or specified by a point number. The command first prompts you the **Label Spot Elevation Dialog** for entering layer name, label prefix and suffix and symbol types etc. Click OK to start. After specifying the
point, the command prompts you to enter the elevation if its elevation is unknown and then pick an angle from the location of the point to label the elevation. You can repeat labeling points until you press Enter to finish.

Prompts

Label Spot Elevation Dialog
Specify a layer name, label prefix and suffix and select the spot symbol.

Point to Label?
Pick point or point number: 2 Enter a point number.
PointNo. Northing(Y) Easting(X) Elev(Z) Description
2 1231.16 1099.17 30.00 bb

Note: If the point number you entered is not in the drawing, you will be prompted again to pick point or enter a point number.
Elevation <30.000>: press enter
Pick angle for label: pick an angle from the spot

Point to Label (ENTER to End)?
Pick point or point number: pick a point on the drawing
Elevation <0.000>: enter elevation
Pick angle for label: pick an angle from the spot
Point to Label (ENTER to End)?
Pick point or point number: press enter to finish

Keyboard Command: LABSPOT
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Cut Sheet

This command creates a report of the horizontal distance and elevation difference between points and a design. The design elevation can be defined by a grid file, triangulation file, 3D polyline, section file, note file, road template file, runway airway clearance or design points. The station and offset of the points can also be reported when a centerline is applied.
The data for the cut sheet is shown in a spreadsheet. You can edit or enter data in all the fields except for the Cut/Fill and Hz Error fields which are calculated. The cut sheet data can be saved and loaded with a .CUT file. The functions for processing the data are in the pull-down menus. Here's an outline of a typical workflow:

1. Import the survey data using Import > Points, or Import > SurvCE.
2. Assign the target design elevation using a method from the Grade menu.
3. If station-offset are needed, use a method from the Centerline menu.
5. Run File > SaveAs to save the cut sheet data.

File > New: Clears the spreadsheet.
File > Save: Saves the spreadsheet data and report format settings to the current .CUT file.
File > SaveAs: Prompts for a .CUT file and saves the data.
File > Exit: Quits the program.

Edit > Undo: To undo the last edit in the spreadsheet.
Edit > Delete Row: Deletes the currently highlighted spreadsheet row. You can also use the Delete key to delete the current row.
Edit > Insert Row: Inserts a new row above the current row. You can also use the down arrow key from the last row to add rows to the bottom of the spreadsheet, and use the Insert key to add a row above the current row.
Edit > Modify Values: Changes values in the spreadsheet for the elevation, station or offset. In the dialog, set the amount to add or subtract (use negative value to subtract) and set which field to modify. There are controls for whether to update all the values or by point number range or by line number range. The Description Match is a way to filter which values to update.
**Edit > Set Values:** Sets values in the spreadsheet for the description, comment or offset field. In the dialog, choose the field to set, the value and which rows to set.

**Edit > Set Pipe Command:** This function fills in a Comment record of length and slope (ie "81.00ft - 15" RCP @ 2.4%) using the distance and slope between two points. The two points to use and the formatting options are set in this dialog.

**Edit > Cut:** Blanks out the data for the currently highlighted cells and puts this data into the Windows clipboard.

**Edit > Copy:** Copies the data for the currently highlighted cells into the Windows clipboard.

**Edit > Paste:** Puts data from the Windows clipboard into the spreadsheet starting at the currently highlighted cell.

**Import > Coordinate File:** Imports survey data from a coordinate file for the Point#, Northing, Easting, Survey Z and Description fields of the spreadsheet. This function first prompts for the coordinate file to import. Then there is a dialog to choose whether to select the points by point number range, by selecting point entities from the drawing,
or by screen picking points. The Description Match and Ignore Zero Elevations are options for filtering out points. Besides reading the coordinate data, this import function can also read station/offset data from the point descriptions by looking for values after the prefixes defined in this dialog.

**Import > Point Text File:** This method is similar to Import by Coordinate File except a text file is used instead of a CRD file. The text file should have one point per row with fields for the northing, easting, elevation, description and point number.

**Import > Note File:** This method reads the survey data along with the grade elevation from the note (.NOT) file that is associated with a coordinate file. For example, if the coordinate (.CRD) file is job3.crd then the note file name is job3.not. In Carlson Software’s data collection programs (SurvCE and Field), there is an option to store stakeout data to the note file under the Stakeout options. When storing a point in the stakeout routines (using SurvCE or Field), the target point number, coordinates and elevation can be stored to the note file. This results with the as-staked coordinate stored in the coordinate (.CRD) file and the target coordinate stored in the associated note file. The Cut Sheet report can display this stakeout data using the Stakeout Point Comparison report option. The horizontal difference between the staked point and the target point can be reported in Bearing-Distance, Delta X-Y or North-South-East-West format. Also, in SurvCE and Field, the elevation difference routines can record the design grade elevation and station-offset to the note file when a point is stored to the coordinate (.CRD) file. This grade data can be reported using the Grade Elevation Report option. The note file records that the Cut Sheet report uses are TARGET_X, TARGET_Y, TARGET_Z, TARGET_DESC, TARGET_PT, STATION, OFFSET, VOFF1 and VOFF2.

**Import > RW5 File:** This method imports cut sheet data from a RW5 file of measurement data created by SurvCE. The stakeout functions in SurvCE store all the data needed to fill out the whole cut sheet including the survey data, design data and station-offset.

**Import > SurvCE Cut Sheet:** Imports data from a SurvCE Cut Sheet file (.CSV or .TXT). The setup for these cut sheet files in SurvCE is under File > Job Settings > Stake > Cut Sheets.

**Import > TDS Raw:** Imports data from a TDS RAW or RW5 file by reading the TDS stakeout records.

**Grade > Points:** The reference points to compare can be in the same coordinate file or a separate file. The reference/design points need to be matched with the survey points. The Match By Distance Tolerance method matches the design point that is closest to the survey point and within the specified Match Tolerance. The Point# Within Description method looks for the specified Point# Description Code in the descriptions of the design points and gets the survey point number from the suffix of the description code. When the Point# Description Code is found, the number after this code is used as the point# to match from the other file. For example, if description code is "PT" and the description for point# 101 in the first coordinate file is "CURB PT303", then point# 303 from the second coordinate file is used for the match. For the separate file option, there is a third method to match points between the files which is to use point numbers to match points between the files. The Match By Manually method.
has a dialog for picking pairs of point numbers for the survey and design to add. The list of available survey points to match with comes from points in the spreadsheet that have Point#, Survey Northing and Survey Easting but not the design data.

**Grade > Triangulation File**: the design elevation is determined by the elevation of the triangulation surface at each point.

**Grade > Grid File**: the design elevation is determined by the elevation of the grid surface at each point.

**Grade > 3D Polyline**: When using a 3D Polyline for the grade elevation, the program calculates the elevation along the 3D polyline at the position perpendicular from the point selected. This calculated elevation is then compared to the point(s) selected to determine the cut/fill values.

**Grade > Cross Sections**: With Section Files, the grade elevation is interpolated from the offset-elevation data in the section file based on the station-offset of the point along the centerline. When using this method, a centerline file (*.cl) must be specified for station-offset data.

**Grade > Runway Clearance**: This option defines the target surface as the airway clearance around a runway. This method is for clearance reports for tree and building tops by comparing points to this runway clearance surface. The runway surface is built from a 3D perimeter polyline of the runway along with slopes for the approach lanes and runway sides. The runway sides are offset level from the runway perimeter for the specified distances before starting the slopes. The parameters for the runway are defined in the dialog and illustrated in the graphic shown here. The Write Runway Clearance Surface File creates a triangulation surface file that you can draw or inspect for verification of a correct target surface.
Grade > Road Design: This option defines the grade elevation using road design files. For each point, the program finds the station-offset for the point along the centerline and then applies the road design at that station to determine the grade elevation. **Grade to Process** is used to define the surface to use for the cut sheet comparison. These grades are defined as Top Surface, usually final grade, or subgrades and correspond to the defined grades and subgrades within a template file. The required design files include a centerline (.CL) file, a template (.TPL) file, and a profile (.PRO) file. There are also several optional design files such as Superelevation, Template Point Profile and Template Point Centerline. The design files are created in the Civil Design module. Using the design files in Cut Sheet is similar to the **Process Road Design** command.

![Cut Sheet Template](image)

Centerline > Centerline File: This function assigns the Station and Offset fields in the spreadsheet by prompting for a centerline file (.CL) and locating each point along the alignment.

Centerline > Polyline: This function assigns the Station and Offset fields in the spreadsheet by picking a polyline, entering the starting station, and locating each point along the alignment.

Centerline > Points: This method defines the alignment by entering two points to define a line.

Report > Create Report: This function display a report of the cut sheet data using the current report settings. When Use Report Formatter is off, the report is shown directly in the standard viewer. Otherwise, the Report Formatter dialog is shown for customizing the report and outputting to different formats such as Excel.

Report > Report Settings: There are several settings for the report including decimal precision, prefix for cut and fill and distance units. For the Horizontal and Vertical Tolerance, the report highlights any points that exceed these tolerances. The Distance Format chooses between Angle-Distance, Delta X/Y, and North-South-East-West deltas. The Cut/Fill Direction chooses whether to report cut/fill as Survey relative to Design or vice versa.
The **Report Zero Elevations** option controls whether to skip or report points with zero elevation.

The **Report Statistics** option reports the min, max, average and standard deviations of the deltas at the bottom of the report.

The **Design/Survey Data on Separate Rows** option creates two rows in the report for each record with the Design coordinate on one row and the deltas on the second row as shown here.

```
Point# Northing Easting Elevation Description Comment
229 499.997 1000.001 3.027
201 -0.005 -0.002 0.004 A
230 507.120 1000.158 2.929
202 -0.006 -0.003 0.001 B
231 515.694 1000.304 2.875
203 -0.005 -0.006 0.002
```

There are options for up to three **User-Defined Columns** which add extra fields to the spreadsheet and report.

---

**Draw > Draw Labels:** This function uses the cut sheet data and draw settings to create labels in the drawing.

**Draw > Label Settings:** There are three types of labels to draw. The Mark Points Outside Tolerance draws a symbol at each point that exceeds the tolerances setup in Report Settings. The Colors Labels Outside Tolerance sets the color for points outside the tolerance. Otherwise these points are labeled using BYLAYER for the color.

The Draw Delta Symbol has three styles. The DX/DY style draws a symbol to show the direction of the delta X and delta Y along with the values. The deltas are due north-south and due east-west. The Rotate Deltas By
Centerline style draws the same DX/DY symbol but this style prompts for a centerline to align the deltas. The Delta Distance style draws an arrow from the design towards the survey point.

**DX/DY symbol style**

![DX/DY symbol](image)

**Delta Distance symbol style with Hz Error text label**

![Delta Distance symbol](image)

The Text Labels creates text labels for cut/fill, delta-x, delta-y, horizontal distance error or description. There are settings for the sequence order, prefix, suffix, layer, style, color, size and position.

**View > Zoom Plan View**: This function zoom centers the drawing on the currently highlighted point.

**View > Profile**: Creates profiles connecting the survey and design points. The profiles are shown in a graphic preview dialog which has functions to save the profiles to .PRO files.
View > Hide By Point Numbers: This function is a way to filter the spreadsheet by point numbers. The function prompts for a range of point numbers and then only displays those points in the spreadsheet.

View > Hide By Description: This function is a way to filter the spreadsheet by description. Wildcard matching applies to the user-defined description filter.

View > Show All Rows: This function shows all the spreadsheet rows including those hidden by the above functions.

Examples of Cut Sheet reports comparing points are shown next.

Example 1: Cut Sheet comparing points to surface and using Report Viewer for report
1) Run Import > Points and select sample_cusheet.crd from Carlson Projects. Select the points to import by range as shown.

2) Run Grade > Triangulation File and choose sample_cutsheet.tin from Carlson Projects.
3) Run Centerline > Centerline File and choose sample_cutsheet.cl from Carlson Projects. Now all the data is ready for reporting.
4) Run Report > Report Settings and make sure the settings match the dialog shown here.

5) The next steps will format the report. Run Report > Create Report which brings up the Report Formatter. Move the Available fields over to the Used fields list as shown. Also, be sure that Widths by Field is toggled on.
6) On the Report Formatter dialog, pick the Settings tab and then the Attrb Options button which controls how the values are formatted in the report. Then on the Attribute Options dialog, highlight Description and pick the Edit button. On the Attribute Display Options dialog for Description, turn off Auto Width and set the Fixed Width to 18. Then pick OK. Next highlight Comment in the list and pick Edit. Set the Fixed Width to 21 for Comment. Then pick OK on the Attribute Options to finish the attribute edits.

7) On the Settings tab for Report Formatter, pick the Field Options button which setups up the report header and footer. On the Field Options dialog, pick Import and select sample_cutsheet.fds from the Carlson Projects\Settings folder. Then pick OK.
8) On the Report tab for Report Formatter, pick the Report Viewer button. There is a dialog for setting the report page size. Pick OK.

Next is a dialog for entering report fields for the report header as setup in the previous step with the Field Options. Fill in the report fields and then pick OK.

Now the report is displayed in the Report Viewer which can be printed or saved to PDF, MS Word or Excel.
Example 2: Cut Sheet Report comparing points from the Current Coordinate File and with the Use Feet-Inches For Cut/Fill options on.
**Example 3:** Cut Sheet Report comparing points from Another Coordinate file, reporting coordinates for the points.

**Example 4:** Steps for Comparing Points in Current Coordinate file and using Report Formatter Option to customize report output to user preference.

2) Specify points to compare by one of the four methods described above for comparing points within the current coordinate file.
3) Select report content by highlighting the desired data from the Available list on the left side of the dialog box and then pressing the Add button to place the selected data in the Used list. Standard window selection methods using the Ctrl and Shift keys can be used to select more than one item at a time. After moving the selected data to the Used window it may be necessary to move data up or down to obtain the desired order of your report. To do this use the up and down arrows located on the left of the Used window.

4) When the desired data has been specified in the Used window press the Display button at the bottom left of the dialog. For more detailed information on using the report formatter see the Report Formatter section of this manual.
Building Offset Extensions

This command is used to calculate building corner offset points that are extensions of the building faces. This command uses building perimeters that are drawn as closed polylines. The points are stored to the current coordinate file and draw on the screen. There is a dialog for setting the parameters. The Offset Amount is the distance that the offsets are extended past the end of the building line. The Starting Point Number is the point number to begin storing from. The Point Description and Elevation are assigned to all the new points and the Point Layer is used for all the drawn points. The Create Extension Points controls whether offset points are created as extensions of the building lines at the corners. The Create Perpendicular Points applies to the extension points for creating a pair of perpendicular points at the corners. The Create Diagonal Points method creates points at the diagonals of corners. The Create Across Building Points creates points across to the other side of the building for inside corners. The Create Envelope Points calculates a rectangle that encloses the building and creates points at the four rectangle corners. The Create Polyline Vertex Points creates points at each vertex in the building perimeter. The Create 2nd Offset option makes a second point for each point at another offset and with another description.
In the first example shown here, Create Perpendicular Points is on. Points 101, 103, 104, 106, 107, 109, 110, 112, 115, 117, 118 and 120 are corner extension offset points. Points 102, 105, 108, 111, 116 and 119 are diagonal points. Points 113 and 114 are across building points.

In the second example, Create Perpendicular Points is off and the program only creates points on one side. Also on this example, the Create 2nd Offsets option is on.

Chapter 13. Points Menu
Prompts

Building Offset Extensions dialog
Select building perimeter linework.
Select objects: make selection

Pulldown Menu Location: COGO
Keyboard Command: bldg.pnts
Prerequisite: A polyline perimeter that represents a building

Import/Convert Points

Import Text/ASCII File
This command converts point data from an ASCII text file into a Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter.
Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:
5100.0,5150.5,485.1
5127.1,5190.3,487.3
The Coordinate Order would be:
Y,X,Z

For a text file with point number, easting, northing, elevation, description and space delimiters:
1 5000.0 5000.0 490.3 TRAV
2 5030.4 4930.5 495.5 TRAV
The Coordinate Order would be:
P X Y Z D

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file.

The Use Import Formatter is an alternative way to define the format of the input file. This method has a heads up interface for selecting the fields for each column of data. This method also supports fixed width, user-defined delimiter and semi-colon delimited files that the Coordinate Order method doesn't handle.
The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File. The Use Inclusion/Exclusion Areas option prompts for selecting closed polylines to control where to import points.

With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point.

Multiple files can be imported at once. To do this, toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the
resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

Under Process Options, there are choices for selecting the coordinate file to store the imported points. The Current option uses the current coordinate file that is active in the drawing. This coordinate file name is shown at the bottom of the dialog. The Prompt For Another option uses the standard file selection dialog to select the file. The Name Another By Input File uses a coordinate file name with the same name as the input file except for a file extension of .CRD.

The Process Space Separated DMS Latitude/Longitude handles a text file with the degrees, minutes and seconds separated by spaces. The latitude and longitude values get stored to the coordinate file in decimal degrees. Here is an example text file line with the point number (1100), latitude degrees (42), latitude minutes (6), latitude seconds (3.200), longitude degrees (70), longitude minutes (2), longitude seconds (2.090) and elevation (85.245). The Coordinate Order for this example should be set to P Y X Z.

1100 42 06 03.200 70 40 02.090 85.245

The special formats of SDMS .ctl, Leica .d45/.gsi/.raw files, MicroStation .TA2 files, WinCMM .cor and .lev files, TDS .cr5 files, Topobase .ro files, Geodimeter .obs/.raw/.are files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files, CAICE/Caltrans .tss files, NLS MMH360 .360 files, EMXS .xng files, and Cadvantage .cog files can be directly imported by choosing that File Format at the top of the dialog.

<table>
<thead>
<tr>
<th>Pulldown Menu Location: Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard Command: readpt</td>
</tr>
<tr>
<td>Prerequisite: A text file to read</td>
</tr>
</tbody>
</table>

**Import LDD_MDB_File**

This command converts a LDD MDB file into TakeOff centerline (.CL) and profile (.PRO) files.

**Prerequisite:** a LDD MDB file

**Keyboard Command:** ldd_crd

**Export Text/ASCII File**

This command outputs point data from the current Carlson coordinate file to an ASCII text file formatted according to a variety of options presented in the form of a general dialog.
**Format.** Specify the type of file to write from the drop down list. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, Idan REG, NLS MMH360, D45, Cadavantage, Multiplane and SDMS CTL formats. In addition there is a User-Defined Format option to define the order of the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data:

**Selection.** There are four Selection Methods provided for the data to export. Specify either Range, Screen Points, Screen Entities or Pick Points in the Selection Field. A Range selection is a user specified range such as 1-10,30-50. A Screen Points selection is made by selecting points from the screen area. The Pick Points method prompts to select the points to export from the drawing. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from:
Delimiter. Select the desired field delimiter of the export file as either Comma or Space from the drop down list. If a header line is to be included, enable the check box.

Number of Decimal Places. Select the desired number of digits to be included in the mantissa of all output ordinates.

Location Filter. Choose from filter methods of within inclusion perimeter polyline, by coordinate window or center within radius from a center point.

Wild Card Descriptions Match. A description filter is also available for exporting only points from the range or selection set with certain descriptions.

Export Point Notes and Attributes. Notes associated with the points may be included in the export by enabling the check box.

Export Multiple Coordinate Files. Enable this check box to specify multiple CRD files to apply the selection criteria against. If enabled, an additional dialog will be presented from which you can browse, select, and remove as many CRD files as desired. In this mode, you can use the Write To Single ASCII File to output the multiple coordinate files into one combined text file.

Point Group. Displays the Point Group manager dialog from which you may define, modify, and select one or more Point Groups to define the points to be included in the export.

After selecting the OK button, a final dialog appears that allows you to specify a new file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

Pulldown Menu Location: Points
Keyboard Command: writept
Prerequisite: A Coordinate File (.CRD)

Convert C&G to Carlson Points
This command converts C&G Points into a Carlson CRD file.
Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD file or Create Carlson CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format
**Keyboard Command:** cg2crd
**Prerequisite:** A C&G point file

**Convert Softdesk to Carlson Points**
This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities, this updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format
**Keyboard Command:** 2surf
**Prerequisite:** Softdesk points

**Convert Wild/Leica to Carlson Points**
This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format
**Keyboard Command:** 2surv3
**Prerequisite:** Leica points

**Convert Eagle Point to Carlson Points**
This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read into the current CRD file by using the command Update CRD File from Drawing, found in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format
**Keyboard Command:** 2surf2
**Prerequisite:** Eagle Point points
Design Pad Template

This command creates design slopes from a perimeter polyline at specified cut/fill slopes to reach existing ground. This routine can be used to design building pads, pits, roads, ditches, stockpiles, etc. The design is drawn as 3D polylines for the cut/fill slopes and for the daylight perimeter where the design meets existing ground.

Before beginning this routine, you must have drawn the polyline representing the outside edge of the feature to model. The edge is drawn as a polyline which can be either a 2D or 3D closed or open polyline. For a 2D polyline, the program will prompt for an elevation for the pad perimeter. With a 3D polyline, the pad perimeter is set to the elevations of the 3D polyline. For an open polyline, the program will prompt for the side for the design. With a closed polyline, the program designs the slopes either outward or inward depending on the settings in the dialog.

Under **Source of Slope Target Surface Model**, choose between a Surface File (.GRD, .FLT, .TIN), Screen Entities, or a specific Elevation. If using Screen Entities, the routine internally calculates a gridded model, the limits of which are specified by screen picks. Make sure that the grid area covers the entire area for the pad including room for the cut/fill slopes.

For closed pad perimeters, there is a **Slope Direction from Closed Plines** option to draw the slopes inward or outward from the perimeter. The outward method starts the slopes at the design elevation of the perimeter and projects out to intersect the existing surface. The inward method projects the slopes inside to reach the grid surface or a set elevation. Outward sloping would be used for such things as building pads, parking lots, etc. where the interior remains as a defined surface. Inward sloping would be used for such things as the top edge of an excavated pit or pond where the interior side slopes project downward at the specified slopes until reaching the original ground surface.

The **Slope Projection Perpendicular To** option applies to sloping pad perimeters. The Pad Polyline method creates the user-specified slope perpendicular to the pad perimeter. The Slope Direction method accounts for the slope of the pad perimeter and makes the final surface to match the user-specified slope. For example, if the pad
perimeter is at a 10% slope and the fill slope is at 2:1, then the Pad Polyline method would create fill slopes that are 2:1 perpendicular to the pad while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the sloping pad perimeter. For the same case except with the Slope Direction method, the resulting slope perpendicular to the pad is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

Under **Design Slope Format**, choose between **Ratio, Percent, Degree or Template**. The use of a Template allows for complex slopes to be applied, and is also an alternative approach to road design. The template (.TPL) file is created in the Design Template routine in the Roads menu. When using a template, the pad perimeter represents the centerline. One way to create the pad perimeter for the template is to use the Profile to 3D Polyline command which converts a 2D centerline to a 3D polyline using a design profile. With a template, the program uses not only the cut and fill slopes from the template file but also draws all the template grade points such as edge of road, curb and ditch. The subgrade, superelevation and template transition options of the template file are not used in this command. These options are only applied in the Process Road Design command. The grade points are drawn as 3D polylines parallel with the centerline. Cross section 3D polylines that include the grade points are also drawn at the specified interval.

The **Force Cut** option will try the cut slope to find a catch point even when the pad perimeter starts out in fill. This is possible when the existing ground is rising faster than the cut slope. Likewise the **Force Fill** option will try the fill slope to find a catch point when the pad starts out in cut.

The **Grade Limits** option makes the cut/fill slopes fit within the grade limits either by making the slopes steeper or by putting in a vertical wall where the slopes reach the grade limits. When this option is on, the program prompts to select a closed polyline to set the grade limits.

The **Min Cut/Fill Height** setting creates no tie slope when the cut/fill is less than a minimum. To always draw the tie slope, set this value to zero.

The **Merge Surface Color** is used to set the color of the triangles within the pad when using a triangulation surface as the target surface and updating this surface with the pad design. The triangle colors are shown in the 3D Viewer graphics.

The **Process Multiple Pad Polylines** option allows you to process multiple pad perimeter polylines at a time instead of a single pad perimeter. The program will prompt for a selection set of pad perimeter polylines and then cycle through and run the design on each one. There will be one final report for the earthworks for all the pads. The Setup function allows you to specify different cut/fill slopes by layer and also to set the processing order by layer. For example, in the case of processing both building pads with a shallow slope and ditch polylines at a steeper slope, you could set up the processing order to do the building pad first and the ditch last so that the ditch cut slopes will carve out any overlap with the building fill slopes. These pad layer slope and order assignments can be saved and loaded from a .PAD file.
Use Another Surface for Pad Interior will bring up a prompt for another Surface file (.GRD, .FLT, .TIN) to use for the design surface within the starting pad perimeter. Otherwise the program will model the pad interior by straight interpolation from the starting pad perimeter elevations. For example, if a building pad has a starting pad perimeter at a set elevation and the pad is supposed to be flat, then this option is not needed. This option is needed in a case where you are designing a pit and the starting pad perimeter is a 3D polyline that follows an undulating pit bottom surface. The pad design will model the pit side slopes. In order to model the undulating bottom of the pit, you need the Use Another Surface for Pad Interior option to select a surface that models the pit bottom.

Use Different Slopes for Separate Sides allows you to specify different slopes for different sides of your pad polyline. If this is toggled ON, the Assign Pad Cut/Fill Slopes dialog is invoked, where you can create multiple Slope Groups along the Pad Template polyline and set the Cut and Fill design ratios for each.

Use Slope Pad Design allows you to set a cross slope amount for the top of the pad. You will be prompted to screen pick two points that designate the slope direction. For automatic balancing of cut/fill quantities, you will be prompted to find the optimal slope and slope direction.
**Draw Slope Direction Arrows** draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

**Solid Cut Arrows** allows you to choose between drawing the cut arrows as solid filled or as wire frame.

**Round Exterior Corners** holds the outslopes around the corners. Otherwise the side outslopes stay straight until they meet at the corners as shown in the figure.

**Erase Previous Pad Entities** erases drawing geometry created with this command previously.

When **Draw Side Slope Polylines** is ON, Design Pad Template will draw 3D polylines perpendicular to the pad perimeter from the pad to the catch point.

**Color Side Polylines** assigns different colors to Cut and Fill Side Polylines to make them easier to distinguish.
Pad corner with round corners option

**Side Polyline Spacing** specifies the interval at which to draw the Side Slope Polylines. Besides at the interval, side slope polylines are also drawn at grid corners.

**Corner Delta Angle** is the delta angle in degrees between side slope polylines to span the delta angle around exterior corners.

The **Subgrade Depth** is applied to lower the design surface within the pad for the volumes calculations. The volumes are from the existing surface to the base of the subgrade. The effect of the subgrade is to increase cut and decrease fill.

The **Topsoil Depth** is used to report the topsoil removal volume by removing this depth within the pad disturbed area.

Cut volume is multiplied by the **Cut Swell Factor** in the final volume report.

Fill volume is multiplied by the **Fill Shrink Factor** in the final volume report.

The **Contour Pad** option draws contours on the pad. At the end routine, a dialog lets you set the contouring options. Usually you should specify a new contour layer and turn off smoothing.

The **Write Final Surface** option creates a surface model of the pad using the elevations of the pad within the disturbed area polyline and using the original ground surface everywhere else. At the end of the routine, the program will prompt for the surface file name to create.

The **Trim Existing Contours Inside Pad** option trims existing contours inside the disturbed limits of the pad. You must specify the **Pad Layer Name** that the pad 3D polylines will be drawn on.

The **Use Report Formatter** option allows for making a customized report and outputs to various formats.

There is an option to calculate volumes for the pad design. The volumes are calculated by comparing the existing surface with the pad design. The inclusion perimeter for the volume calculation is the daylight perimeter polylines which represents the limits of disturbed area. The existing surface model is defined by the existing surface file (.GRD, .FLT, .TIN) or screen entities selected at the beginning of the command. The pad design surface is calculated by making a surface from the pad 3D polylines including the starting pad perimeter, the side polylines and the daylight perimeter.

Besides calculating the volumes in the **Design Pad Template** routine, you can also calculate the volumes with the **Two Surface Volumes** command, or the **Volumes by Triangulation** command. Two Surface Volumes works with two grid files, Volumes by Triangulation works with two TIN files. The design surface for Two Surface Volumes can be the final output surface from Design Pad or you can create a design surface with **Make 3D Grid File** using the 3D polylines created in **Design Pad**. You could also create a TIN surface of the design surface using **Triangulate and**
Contour. Some of the reasons to use either the Two Surface Volumes command or the Volumes by Triangulation command are that these volume routines have more output options (cut/fill color maps, etc.) and you can check the volumes by plotting or contouring the surface files. Also, you can combine several pads and other final surfaces by running Make 3D Grid File or Triangulate and Contour and then use these volume commands to calculate the overall site volumes.

The design is drawn as 3D polylines and the earthwork volumes are calculated. Before ending, the program allows you to adjust the design by changing the pad elevation, slopes and offset. The program can find the cut/fill balance by automatically adjusting the pad elevation. If adjustments are specified, the pad polylines are redrawn and the volumes recalculated.

A few key notes:

1. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a grid file, then the surface produced from the designed pad will be a grid surface and a grid file (.GRD).
2. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a TIN file, then the surface produced from the designed pad will be a triangulated surface and a TIN file (.TIN).
3. If the Surface used as a Target Surface is listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to Update the Surface, which is the Target Surface, so if you say "Yes," your Existing Ground Surface will now essentially contain the designed pad. So if you want to maintain an unedited version of Existing Ground, you may want to start with a copy of the Existing Ground Surface.
4. If the Surface used as a Target Surface is not listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to create a new surface of the combined surfaces.
5. If you respond "Yes" to the prompt about whether to contour the designed pad, the contouring dialog box has an option of whether to write the designed pad as a new surface, which will be only the area within the limits of the new design, not the entire Target Surface and design pad surface combined.

Prompts

First you are presented with the Design Pad Template dialog box.

If the Source of Slope Target Surface Model is set to a Surface File, you will first be asked to:

**Pick the top of pad polyline:** select perimeter polyline

Then the Select Slope Target Surface dialog box is presented. Choose the Slope Target Surface file, pick Open. You then proceed to enter the slope parameters of the pad...

If the Source of Slope Target Surface Model is set to a Screen Entities, you will first be asked to:

**Pick Lower Left limit of pad disturbed area:** pick lower left These prompts appear for the Screen Entities surface model method.

**Pick Upper Right limit of pad disturbed area:** pick upper right Be sure to pick these limits well beyond the area of the top of pad polyline in order to make room for the outslopes.

**Make Grid File Dialog** After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

Then,

**Pick the top of pad polyline:** select perimeter polyline

Then proceed to enter the slope parameters of the pad...

**Enter the fill outslope ratio <2.0>:** 2.5
**Enter the cut outslope ratio <2.0>:** 2.5 After entering outslopes slope ratios, a range of elevations along the pad top will be noted.
Enter the pad elevation <29.54>: 39
Calculate earthwork volumes (<Yes>/No)? press Enter
Report Viewer Reports cut/fill volume.
Adjust parameters and redesign pond (Yes/<No>)? press Enter
Write final surface to grid file (Yes/<No>)? press Enter
Trim existing contours inside pad perimeter (Yes/<No>)? press Enter
Contour the pad (<Yes>/No)? press Enter

Existing contours with top of pad perimeter polyline

Pad template with contours

3D view of pad with DTM of surface and triangulation faces of pad
Template to apply in Design Pad Template

Existing surface with 3D polyline centerline

Result of Design Pad Template showing template grade polylines, cross section polylines, cut/fill slopes, and final contours
Viewpoint 3D view of Design Pad Template

Design Pad Template can also handle self-intersecting side slopes
Draw Triangular Surface

This command draws a triangulation (.flt or .tin) file as either Surface Object, 3D LINES or 3DFACES. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.

The Surface Object is a custom object for displaying the TIN in the drawing. This custom object also supports the EndPoint snap. The main advantage of the Surface Object is with displaying large TIN files because the Surface Object is more efficient than drawing individual 3D Faces or Lines. The Surface Object requires Carlson to be loaded to display.

In the options dialog, choose the method for how to draw. The Use Inclusion/Exclusion Perimeters will prompt for selecting closed polylines to limit the area where to draw. The Use TIN Colors will color the entities using the colors for triangles stored in the TIN file. Colors can be stored in the TIN files using commands like Triangulation File Utilities, Road Network and Color Surface By Layer. The Erase Previous will erase the existing entities in case the TIN file has already been drawn. For Lines, there is an option to use a different colors for edges in the TIN that are from breaklines.

Triangulation (.flt or .tin) files can be created by routines such as Triangulate & Contour.

Prompts

Select Triangulation File to Draw
Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:
If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

**Loading edges...**
**Loaded 198 points and 234 edges**

![Triangulation mesh](image)

This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window.

**Pulldown Menu Location:** Surface >> Draw Surface
**Keyboard Command:** drawtri
**Prerequisite:** A triangulation (.flt or .tin) file

### Draw Surface As Grid

This command writes a grid file (.grd) from an existing triangulation file (.flt or .tin) in the current drawing.
After selecting the triangulation file to convert, you are prompted for the X, Y grid interval and the Layer name.

Prerequisite: an existing or design surface

Keyboard Command: draw_surface_grd

**Contour Elevation Label**

This command can be used to simultaneously create elevation labels on a group of contour polylines at elevation. First the command starts with a dialog with the label options. Then to place the labels, pick two points crossing the contour polylines at the desired label location. The program will find all the contour polylines that intersect the picked line (defined by the two picked points) and will place labels at the intersection point of each contour. A second crossing line can be initiated immediately, so multiple areas can be quickly labeled while remaining in the command. Alternatively, you can type P for Polyline at the Command prompt and select a polyline. Then the program finds all the intersections between the selected polyline and the contours and places labels at these intersections. The actual "z" elevation of the contour line determines the label value.
**Label Layer** specifies layer name for the contour labels that will be created. **Label Style** specifies the text style to be used for labels. **Horizontal Scale** is used in conjunction with the Text Size Scaler to determine unit height of the contour labels. **Text Size Scaler** is a scaler that will be multiplied by the horizontal scale to set the actual text height of the labels in AutoCAD units. **Integers** controls how many digits to label to the left of the decimal. For example, if all contours are in the 5000's, then setting for three digits would label the 5280 contour as 280. **Decimals** sets the decimal precision for the labels to be created. **Label Position** determines the label position in relation to the contour polyline.

- **On Contour** centers the label on the contour line.
- **Above Contour** places the label above the contour line. If this option is used, the options for Break Contours at Label and Draw Broken Segments become inactive.

**Ignore Zero Elevation Polylines** enables the routine to filter out all entities with an elevation of zero. **Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds: you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label. **Align Facing Uphill** makes the label parallel to the contour and flips the label so that it reads facing uphill. Otherwise, the labels are made to face up relative to the current screen view. When this option is on, the program prompts for a triangulation surface file that should match the surface the contours represent. **Use Commas** adds a comma into the labels for the thousands place such as "5,000" instead of "5000". When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines. When **Break Contours at Label** is checked, the contour lines will be broken and trimmed at the label location for label visibility. When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.
**Label Contour Ends** creates labels off the ends of the contours.
**Label By Distance** places the labels by distance along the contour. The user is not prompted for screen picks of contour crossing when this option is used.

- **Interval** sets the distance interval to be used between labels on each contour.

When **Draw Box Around Text** is checked, a rectangle will be drawn around the elevation labels. The Offset Scaler controls the size of the rectangle.
The **Draw On Real Z Axis** chooses between creating the text entities at the elevations of the contours or at zero elevation.
The **Use MText** chooses between creating MText and DText label entities.
**Index Contours**: Label All will label both index and intermediate contours with the same settings. Label Index Only labels only the index contours. Separate Index Layer will label both index and intermediate contours with the index labels on a different layer.

### Prompts

**Contour Label Options Dialog Opens** Select the desired options and press OK.
Define a line which slices the contours at the desired label locations.
**Pick 1st point (P-Polyline, Enter to end):** *pick a point*
**Pick 2nd point:** *pick a point*

By selecting two points the contour lines that cross the line defined by the two points are labeled.

**Pulldown Menu Location:** Surface >> Contour Labels
**Keyboard Command:** gclabel
**Prerequisite:** polylines with elevation (contour polylines)

### Color Contours by Elevation

This command sets the color of the selected contour polylines and text based on elevation. The color to use is defined in elevation range table.
• Auto - This button opens the following dialog, allowing for automatic configuration of the range of elevations and colors.

  • Starting Zone # - Sets the zone with which to begin the application of the settings defined in this dialog. For instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.
  • Set Values - Enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.
  • Starting Value - Sets the starting elevation value for the first zone.
  • Value Interval - Sets the elevation increment for subsequent zones.
  • Set Colors - Enables the Starting Color and Color Increment fields.
  • Starting Color # - Sets the starting color number, based on the AutoCAD standard color chart.
  • Color Increment - Sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.
  • Note: The Pattern, Scale, and Layer options do not apply to this command.

• Clear - Clears the all of the Elevation fields in the dialog

• Load - Loads previous settings from a saved .pat file
• Save - Saves the current setting configuration to a .pat file.
Prompts

Select polylines and text to color: *pick the entities*

Define Ranges Dialog

Pick point for color legend: *pick a point to a clear area of the drawing to place a legend or press Enter for no legend*

Pull-Down Menu Location: Surface >> Modify Contours >> Color Contours

Keyboard Command: ctcolor

Prerequisite: Contours polylines

---

**Color Contours by Interval**

This command sets the color of the selected contour polylines based on the elevation interval values, which are essentially the number that the elevation ends with, so specific colors are assigned for elevations ending in 0, 1, 2, etc. The color assignments are defined in the Define Interval Colors dialog box.

![Define Interval Colors Dialog](image)

Select Entities: User is prompted to select the contour polylines to change.

By Layer: Contour polylines are selected automatically by their layer.

---

**Prompts**

**Define Interval Colors Dialog** If Select Entities is set as Interval Colors Method, *pick OK*, and you are prompted to:

Select polylines and text to color: *pick the entities* If By Layer is set as Interval Colors Method, set the layers by Screen selection or from a list by Name, then *pick OK*.

Pull-Down Menu Location: Surface >> Modify Contours >> Color Contours
Color Surface By Layer

This command sets the color of the triangles in a triangulation file for the areas within closed polylines using the layers and color assignments from Define Layer Surface/Material/Subgrade. The colored areas of the triangulation surface can then be viewed in commands like Surface 3D Viewer. For example, this command can set separate colors on the triangulation for pavement areas, building pads, ponds, etc.

The color assignments should be set before running this command by using Define Layer Surface/Material Subgrade. This command only prompts for which triangulation file to colorize. Then use a viewer command like Surface 3D Viewer to see the colored surface.

Pulldown Menu Location: Takeoff > Surface Tools
Prerequisite: A surface and colors set in Define Layer Surface/Material/Subgrade
Keyboard Command: color_tin

Watershed Analysis

This command has a collection of tools to analyze the runoff of a surface defined by a triangulation or grid surface file. After selecting the surface file of the surface, the program docks a dialog on the left side of the drawing window. While the Watershed Analysis dialog is running, other AutoCAD and Carlson commands are not available. To zoom or pan the drawing view, use the buttons at the top of the dialog, or use the middle button of a wheel-mouse.
Watershed Analysis calculates the flow connections between the triangles and along the edges of the triangulation. The **Rainfall** amount is used in the processing for figuring the runoff volume to determine when the volume is enough to spillover a local depression in the surface. Besides the Rainfall amount, the runoff coefficients as defined in Define Runoff Layers are also used to calculate the runoff volumes. When the local depression is small enough the runoff will continue through. Otherwise this spot is called a sink for where the runoff stops. The **Allow Overflow Along Boundary** option applies to watersheds that have runoff that hits the surface border. This option will check whether this border runoff can spillover and merge with the neighboring watersheds along the border.
The **Draw Watersheds** function draws the watershed areas using the settings under the Draw tab. The back arrow next to the Draw Watersheds button will erase any previous Draw Watershed entities. The **Watershed Perimeters** option will draw closed polyline perimeters for each watershed area. The **Fill Watershed Areas** option will solid fill each area using different colors. The **Buffer Hatch** option will hatch the perimeters of the watershed areas with the specified width instead of hatching in the entire watershed area. The **Hatch Structure Areas** option will hatch the drainage areas covered by structure inlets defined in the Structures tab. The **Sink Locations** setting draws a symbol at the low point for each drainage area. The **High Point Locations** option draws a triangle symbol at the highest point within each watershed. Typically, this high point will be along the watershed boundary polylines that follow the high points along the ridges between the watersheds. The **Pond Areas** option draws a solid fill hatch in blue for the area covered by the runoff volume of low points. In the example shown, the Fill Watershed Areas and Sink Locations options are active. The **Max Flow Lines** option draws polylines for the longest flow line within each watershed. These longest flow polylines can be used to calculate the time of concentration. The **Group Watershed Entities** option will make AutoCAD groups for the set of entities drawn for each watershed.

The **Spillover Location** option draws symbols at low points within the watershed area that fill up with runoff and spillover on the way to the lowest (sink) location of the watershed. The Setup button allows you to specify criteria for identifying spillover points. These settings include the minimum drainage area, storage volume, drainage volume.

![Watershed Area Size Settings](image)

These settings allow you to filter out small spillover points (ie a pothole) and only draw the significant ones. The **Calculate and Draw Options** buttons allow you to control what is going to be drawn how, it contains settings for the symbol, size and layers to use for the entities created by Watershed Analysis and a number of labeling options.
Gate Control

The watershed calculation can be controlled through use of "gates". Gate is placed at the points of likely overflow from one watershed to another. The gate in its natural state is simply an indication that potentially the connection can occur at the point, joining two watershed areas into one if there is too much runoff volume in at least one of the watershed areas to be contained within. The gate can also be forced closed, which indicates that two areas will not be joined regardless the runoff amount. The example of such case is when there are two large ponded areas you want to treat separately in calculations or further design. On flip side, there are instances when you may want two areas to be joined regardless the overflow actually occurring, for example one area is very small. This is accomplished with a gate forced open. There two ways to control gate state: automatically and manually. Here are the settings for automatic control.
If amount of ponded runoff in an area exceeds the maximum pond volume to merge, the downstream gate will be closed automatically. If area is too small or too shallow, its downstream gate will be forced open, joining it with watershed downstream.

To control gates manually, please first draw gate labels, exit Watershed Analysis, then double-click on gate labels in the drawing to control their state. Once done editing the gate state, just re-run the calculation to draw and report the new adjusted watersheds.

Runoff Tracking

The **Above Point** function reports the watershed data of the current pointer position in real-time as the pointer is moved around. The watershed data is shown in a tooltip next to the pointer position. This data has values for the overall watershed that the position is in including the sink elevation, sink name, drainage area and average slope percent. This data also has values for the watershed above the current point including the drainage area and runoff volume. Plus this data shows the elevation and runoff coefficient at the current point. If the position is picked with the mouse, then the program draws a polyline perimeter for the drainage area above the current point.

The **Above Line** function is similar to Above Point except that you pick two points and the program draws the watershed for all flow that crosses the line between these two points. For example, you can pick points at the left and right banks of a stream to get the drainage area for that stream above these points.
Under the Tools tab there are several analysis routines. The **Runoff Tracking** function draws flow lines that follow the surface. The **Single Point Tracking** method draws the flow lines starting from the picked high points. The **Whole Surface Tracking** method draws a flow line starting from the middle of each triangle in the triangulation. The **Major Flow Tracking** method draws starting in triangles where the drainage area coming into triangle exceeds the specified **Cutoff Area Above** value. The flow lines can be drawn as either 2D or 3D polylines. For 2D polylines, the linetype can be specified or the special linetype with flow direction arrows can be used. This special flow linetype has controls for the size and frequency of the flow arrows.
The **Draw Connections** function draws lines with arrows between the triangles for how the program has determined their flow connections.

When a triangulation file is processed by Watershed Analysis, some of the flow connection data is stored into the triangulation file to speed up reprocessing. The **Re-Process** function resets this flow connection data to start the flow calculations from scratch.

The **Detail Inspect** function reports flow connection data at the pointer position in real-time as the pointer is moved. This data includes the current position triangle number, connecting flow triangle number, sink node number, watershed name, border elevation, ridge elevation, low elevation, downstream sink number, number of source triangles, number of source nodes, current elevation and spillover elevation.

The **Watershed Inspect** function reports runoff flow data at the pointer position in real-time as the pointer is moved. The runoff data is shown in a tooltip next to the pointer and in the **Data** tab. This data has values for the overall watershed that the position is in including the sink elevation, sink name, drainage area and average slope percent. This data also has values for the watershed above the current point including the drainage area and runoff volume. Plus this data shows the elevation and runoff coefficient at the current point. When the Hatch Area Being Inspected option is active, the watershed area for the current position is hatched during inspection.
The **Watersheds Report** function runs the report formatter to choose which of the watershed parameters to report. The **Ponds Report** function reports the position and depth of each ponding area.

Here are some of the values contained in watershed report:

- **Rain volume** - total volume of the runoff for the area
- **Holding volume** - the maximum volume the watershed can contain near the sink
- **Ponding volume** - the volume of all the ponds within the watershed
- **Uncontained volume** - the difference between amount of runoff and the volume of runoff trapped on the slope or at the sink

Additionally, the properties of the pond at the sink are reported: surface elevation, max depth, volume and area.

**Structures**

Besides calculating the runoff of the triangulation surface, Watershed Analysis can also process the runoff effects from structures for inlets, storage ponds, culverts and channels. The structures in Watershed Analysis are simply for placement and watershed delineation. These structures do not have design considerations for parameters like pipe size. In the **Structure** tab, there is a list of the structures to apply with the current surface. The list shows the name, type and drainage area for each structure. The Draw function will draw symbols for each structure. The Inlet structures act as sinks in the watershed and capture all the flow that comes to the inlet point. Each inlet is defined by a single point and a name. The Storage Tank structures also act as sinks and are defined by a single point and name. The Culvert structures route the flow from the culvert inlet to the outlet. The culverts are defined by two points for the inlet and outlet and by a name. The Channel structure is the same as the Culvert except that it can have more than two points to define the flow path. The structure data can be stored to a Watershed Structure File (wst) using the **Save** button. The **Load** button can read the structure data from either a wst file or from a sewer network file (.sew).
Run Off Tracking

This command draws 3D polylines starting at user picked points downhill until they reach a local minimum or the end of the grid or TIN. In effect it simulates the path of a rain drop. The surface is modeled by a grid file as created by Make 3D Grid File or a triangulation file created by Triangulate & Contour. The program also reports the horizontal and slope distances, average slope, maximum slope, and vertical drop. These values can be used for time of concentration calculations. Runoff tracking is a convenient way to identify distinct watershed areas and is an alternative to the automated Watershed Analysis command.

Prompts

Enter the run off path layer <RUNOFF>: press Enter
Select Surface Model dialog box
Choose the grid file or triangulation file that models the surface. If a grid is selected, it will prompt:
Extrapolate grid to full grid size (Yes/<No>)? Yes If the limits of the surface data doesn’t cover the entire grid area, then the values for the grid cells beyond the data limit must be extrapolated in order to compute slopes in that area. This prompt only appears if there are grid cells without values.
Local pond spillover depth <4.80>: press Enter This allows the runoff line to continue past flat or low points in the grid or TIN, by allowing these area to fill up with water, in essence, up to the specified depth, thus letting the runoff polyline continue on.
Draw tracking for all grid cells or pick individuals [All/<Pick>]: press Enter Pressing Enter leads to individual picking of runoff tracking lines, while A for All would fill draw runoff polylines starting from each grid cell or each triangulation triangle.
Pick origin of rain drop: pick a point at the top of the run off polyline
Pick origin of rain drop (Enter to end): press Enter
Pulldown Menu Location: Watershed
Keyboard Command: runoff
Prerequisite: A .grd file created by Make 3D Grid File or a .flt (TIN) file created by Triangulate & Contour.

Cut/Fill Color Map

This command creates a cut/fill color map typically in red and blue in order to show the difference between grid or triangulation surfaces. In the options dialog, the ranges of the cut and fill zones are set along with the colors. The Automatic Colors has several colors styles to choose from for the cut to daylight to fill colors. When not using the Automatic Colors, the Cut/Fill Transition color is used for the zone between the smallest cut and smallest fill. For triangulation surfaces, the Map Subdivisions is how many times the surfaces will be divided in the X and Y directions to make cells for coloring. For example, Map Subdivisions of 50 makes 2500 colors cells from 50x50. The Limit Cut/Fill Map Range option is a way to draw the color map only for a specified range such as only showing the deep cut. The Auto Set function fills out the cut/fill ranges based on the current two surfaces. The Set By Interval function fills out the cut/fill ranges by a user-specified depth interval.

For analyzing using the grid option, you need to already have two existing grid files. If the grids are not visible in plan view, you may want to have them display on-screen using the Draw 3D Grid File command. The grids should overlap with the same location and resolution. The resulting red/blue map with legend is shown below.
No coloring is done on tin or grid cells that extend beyond the extent of the data. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. The prompt *Extrapolate grid to full grid size?* shows when there are grid cells with no elevation in a grid (.GRD) file. Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data.

**Prompts**

For a color map showing differences between two grids:

*Type of surface model source [Tin/<Grid>]?* press T for a Triangulation (.TIN) file, or *press Enter* to accept default choice in brackets.

*Select Base Grid File Dialog* Select an existing .grd file.

*Select Final Grid File Dialog* Select a second existing .grd file.

*Select Inclusion polyline:* pick a closed inclusion perimeter

*Select Exclusion polylines* (Enter for none).

*Select objects:* pick exclusion polylines or press *Enter*

*Cut/Fill Color Map Options Dialog*

*Select point for color legend:* pick a point

*Legend size <10.0>*: press *Enter*

*Label all zones or summary [All/<Summary>]?* press *Enter*
Pulldown Menu Location: Surface >> Cut/Fill Utilities

Keyboard Command: cf_map

Prerequisite: Two grid (.GRD), triangulation mesh (.FLT) or tin (.TIN) files

Cut/Fill Map Legend

This command will draw a Cut/Fill Map Legend on your drawing. It will display the cut/fill amount, color, and range, as seen below.

Prerequisite: Cut/Fill amounts
Keyboard Command: CF_MAP_LEGEND

Cut/Fill Labels

This command displays the design elevation, the existing elevation, and the amount to either cut or fill directly on the screen. The design and existing elevations can be defined by triangulation files, grid files or points.

In the Elevation Difference Label Options dialog, you can customize the Cut/Fill labels. Text can be added either before or after the Cut/Fill amount, the Existing elevation, and the Design elevation with the Prefix and Suffix fields. You can also choose whether or not to display the Existing Surface elevations and the Design Surface elevations. The Draw Marker Symbol option draws the specified symbol block at each label point. The Hide Drawing Under Labels option creates Wipeout entities around the labels so that you can read the labels clearly. Text Size chooses the text size for each line of the label. Text Style allows you change the Font Style displayed in the labels. Decimal Places sets to how many decimal places the labels will report. The Cut/Fill In Inches labels in feet and inches to the specified precision. The Separate Deep Cut/Fill Labels settings allow for highlighting deep areas by making them a darker color or adding prefix/suffix labels. The Label Cut and Label Fill toggles allow you to turn off cut or fill and label only the other.

The Spacing Methods include:
- Fit: Uses an inclusion perimeter and the size of the labels to make a series of rows and columns of labels that fit within the perimeter. The Space Between Labels sets the buffer around labels. The size of each space is determined by the Text Size.
- Grid Interval: Places the labels at the specified Horizontal and Vertical Intervals starting with the specified Northing and Easting coordinate.
- Station Interval: Uses a centerline polyline and places the labels at a station interval along this alignment.
- Screen Pick: Prompts for each label position.
On the Label Colors tab, the Automatic Coloring options choose a color scheme for the Cut-Daylight-Fill colors. The program will use a gradient color for the labels depending on the cut/fill value for the label. The deeper cut/fill values will have a deeper color. The Max Depth sets the value for the deepest color. You can also choose None for the Automatic Coloring and then set fixed colors for the cut and fill. The Custom method lets you specify all the colors and depth ranges.

The following image shows the main dialog box for setting the labeling options. The labeling created with these options looks like this:

![Labeling Options Dialog]

The distribution of the labels on the site looks like this:

- PR117, 00 EX129, 59 -12, 59
- PR117, 00 EX129, 00 -12, 00
- PR117, 00 EX127, 40 -10, 40
- PR117, 00 EX127, 31 -10, 31

The distribution of the labels on the site looks like this:
Cut/Fill Centroids

This command calculates all the areas of cut and fill between two triangulation surfaces. The center of mass or centroid for each area is calculated. The Minimum Region Volume is an optional filter that will skip reporting areas with volumes less than the specified amount. The Generate Labels option draws a symbol at the centroid and text for the region name and volume. The Generate Boundaries option draws closed polylines for the perimeters for each area. The Hatch Regions option is used to visually shows cut/fill areas in your drawing. Separate hatch patterns can be used for cut and fill areas.

The Use Inclusion/Exclusion Areas option will make the program prompt for polyline perimeters for the inclusion and exclusion areas on the site. For example, use an inclusion perimeter to calculate within an area of interest. When this option is off, the program uses the full extent of the surfaces.

A report is generated with the volumes and centroids for all the cut and fill areas. When the Report Optimized Earth Movement option is active, the report includes a list of the earthwork movements between cut and fill areas that minimizes the overall earthwork movement (volume * distance) where the distance is distance between the centroids.
Chapter 14. Surface Menu
Here is the Cut and Fill Centroid Report for the above example. It shows the volumes, the coordinates of the centroids, and the Earth Movement Report. The Earth Movement Report shows the minimal distances for moving Cut to Fill areas.

**Prerequisite:** Existing and Design surfaces  
**Keyboard Command:** tk_cutfillc

### Elevation Zone Analysis

This command can be used to calculate the surface area of a surface in different elevation zone ranges and to analyze a surface by ranges or "zones" of elevation. The program requires 3D Face entities that can be generated by the *Draw 3D Grid File* command. The *Draw Triangulation Faces* option in *Triangulate & Contour* or *Draw Triangular Mesh* routine under Surface >> Draw Surfaces menu can also be used to create triangular 3D Faces. For each elevation zone, the 3D Faces can be hatched with a hatching pattern, solid filled with the SOLID pattern, or left empty with the NONE pattern. The 3D Faces are also placed in a separate layer for each zone.

In the options dialog, the Property Represented By Z Value sets the name used in the reports for the type of surface model. Label Average In Each Grid Cell creates text labels in the center of each 3D Face of the surface with the average surface value. Subdivide Grid Cells at Zone Boundaries gives higher resolution at the transition between zones. Use Report Formatter allows for customized report and different output formats.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the area within the inclusion polyline is calculated. Areas within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the area of each selected 3D Face is used.
Prompts

Elevation Zone Analysis dialog
Select 3D Faces to Analyze...
Select objects: pick the 3D Faces to process

Define Ranges (Lowest to Highest) Dialog
Specify the elevation ranges, colors and patterns.
Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Select point for color legend (Enter for none): pick a point
If a point is picked, a legend showing the color of each range is drawn. The legend is drawn aligned to the current view UCS. For this reason it is best to have the mesh at the Vpoint at which it will be plotted before executing the analysis program.

A report is also generated in the standard report viewer.
Result of Elevation Zone Analysis viewed in 3D and shaded

**Pulldown Menu Location:** Surface  
**Keyboard Command:** elvzone  
**Prerequisite:** displayed 3D Face entities.

---

**Slope Report**

This command calculates the sloped surface area, average slope and average elevation on a site. The surface can be defined by a surface model file, (.GRD, .TIN or .FLT), or generated from 3D entities on the screen. Sloped area information is useful to compute seeding quantities for hillsides, for example.

For the screen method, the surface is modeled from the user-selected entities such as contour polylines. Besides the surface entities, a perimeter polyline is used as the inclusion area for the slope report. If the perimeter polyline is on the PERIMETER layer, the command will locate it automatically.
For area reports, there are options to specify inclusion and exclusion perimeters. When inclusion perimeters are specified, only the area within the inclusion perimeters is calculated. The area within exclusion perimeters is not included in the calculations. Inclusion and exclusion perimeters are represented by closed polylines and must be drawn prior to running this routine.

The option to Report by Cut/Fill Areas will report the slope areas separately for cut and fill areas. When this option is on, the program prompts for a second surface to use as a reference to determine the cut/fill areas.

**Prompts**

For Area report using a File:

Select surface model file.

Select the Inclusion perimeter polylines or ENTER for none: pick any inclusion polylines

Select the Exclusion perimeter polylines or ENTER for none: pick any exclusion polylines

Note: If the surface model file is a grid file (.GRD), you are prompted whether to extrapolate the grid to full grid size.

For Area report by Screen method:

Ignore zero elevations (<Yes>/No)? press Enter

Select surface entities and perimeter.

Select objects: pick the objects

If no polylines are found on layer PERIMETER, you are prompted to: Select Pond/Pit perimeter polyline.

The Make 3D Grid File dialog is presented. Pick OK.
Select the Inclusion perimeter polylines or ENTER for none: *pick any inclusion polylines*
Select the Exclusion perimeter polylines or ENTER for none: *pick any exclusion polylines*

For *Points* method:
**Select surface model file.**
**Pick first point:**
**Pick Second point:**
The slope report is displayed on the command line for the 3D vector, projected on the surface, defined by those 2 picks.

Point 1: 5119.646,5640.322,98.979
Point 2: 4951.964,6022.419,135.546
Horiz Dist: 417.27 Slope Dist: 418.87 Elv Diff: 36.57
Slope: 8.76 Ratio: 11.41:1

**Pulldown Menu Location:** Surface >> Slope Analysis
**Keyboard Command:** sarea
**Prerequisite:** A surface file or screen entities of the surface.

**Slope At Points**

This command reports and labels the slope of a triangulation or grid surface model. The *Link To Surface* option will update the slope label when the triangulation surface model is modified. The *Position Method* for *Surface Points* creates a label at each data point in the surface which can work well on grid files but is typically too much information for triangulated surface files. The Position Method for *Screen Pick* prompts to pick the points where to calculate the slope. For the Screen Pick method, the Define Slope setting allows a couple ways to pick. The *At Single Point* option calculates the slope from the surface model at the point. The *Between Two Points* method calculates the slope using the surface model elevations at two picked points and the horizontal distance between these points. As the crosshairs are moved across the surface, the slope at the current position is displayed in a floating dialog box.

For the slope labels, the dialog has settings for the *Layer, Style, Prefix, Suffix, Decimals, Slope Label Format* and *Size Scaler*. The *Size Scaler* is multiplied by the drawing horizontal scale to calculate the text size in drawing units. The Create Report option uses the *Report Formatter* to make a report of the coordinates, slope amount and slope direction.
The **Label Style** of **Align With Slope** rotates the slope label in the slope direction. The **Horizontal** option creates a horizontal label. The Leader Arrow rotates the slope label in the slope direction and draws a leader arrow for the slope direction either facing uphill or downhill depending on the **Arrow Direction** option.

The **Draw Box Around Label** option draws a polyline box around the slope labels and the **Solid Background** option fills in this box with the specified color.

![Slope At Points Dialog Box](image)

The **Set Layer/Size/Color By Slope Ranges** option invokes the Define Ranges dialog box. Enter slope values in the first column of boxes to set the Ranges.
Prompts

**Slope At Points dialog box**
Adjust settings as desired. Pick OK.

**Select Surface Model.**
Pick Points to label slope.

Draw grid file and Slope At Point labels using Surface Points
Pulldown Menu Location: Surface >> Slope Analysis  
Keyboard Command: ptslope  
Prerequisite: A surface model file (.TIN, .GRD, or .FLT)

Slope Zone Analysis

This command calculates the surface area of a site in different slope zone ranges. This command can use either a surface model file, (.TIN, .GRD, or .FLT), contour polylines, or 3D Face drawing entities which can be generated by the Plot 3D Grid File command, the Draw Triangular Mesh command, or the Draw Triangulation Faces option of Triangulate & Contour. For each slope zone, the 3D Faces can be hatched with any hatch pattern, including the SOLID pattern, or left empty with the NONE pattern. The command reports the area for each slope zone. When using a triangulation surface file, the Save Slope Zone Colors option sets the triangle colors in the TIN file for the slope zones. Then commands like 3D Viewer Surface File can visualize the colored surface. When using the Contours method, the program prompts to select the contour polylines along with optional points to picking up high and low points. Using the Contours method along with the option to Draw Slope Zone Contours with Hatch Slope Zones, the hatch zone boundaries will follow the contours. The Use Report Formatter option allows for customized reports and different output formats.

The Draw Slope Zone Contours option generates contours of the slope zones based on the calculated slope at each point of the 3D Faces. The Output Grid File of Slope option creates a grid file of the slope values.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

Prompts

Slope Zone Options dialog box. Choose whether to Draw Slope Zone Contours, whether to Output Grid File of Slope, and Slope Format. Pick OK
Select surface model file.
Define Ranges dialog. Specify the slope zones, colors and patterns from lowest to highest. Pick OK.
Select the Inclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter
Select the Exclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter
Report is generated.

Slope Report
Surface File: C:sedev\data\SIMO2.grd
Average Slope: 21.6%
Minimum Slope: 0.0%
Maximum Slope: 81.7%

<table>
<thead>
<tr>
<th>Zone</th>
<th>Range</th>
<th>Horizontal Surface</th>
<th>Slope Surface</th>
<th>% of Total</th>
<th>Average Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Area S.F.</td>
<td>Acres</td>
<td>Area S.F.</td>
<td>Acres</td>
</tr>
<tr>
<td>1</td>
<td>20.00%</td>
<td>769,137.1</td>
<td>17.657</td>
<td>775,379.4</td>
<td>17.800</td>
</tr>
<tr>
<td>2</td>
<td>40.00%</td>
<td>583,761.4</td>
<td>13.401</td>
<td>607,257.9</td>
<td>13.941</td>
</tr>
<tr>
<td>3</td>
<td>60.00%</td>
<td>113,978.1</td>
<td>2.617</td>
<td>125,967.2</td>
<td>2.892</td>
</tr>
<tr>
<td>4</td>
<td>80.00%</td>
<td>18,494.6</td>
<td>0.425</td>
<td>22,407.7</td>
<td>0.514</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>1,485,371.1</td>
<td>34.099</td>
<td>1,531,012.2</td>
<td>35.147</td>
</tr>
</tbody>
</table>

If you choose to draw Slope Zone Contours, the Contour Options dialog box is presented. There are settings for the contour layer and whether to label, smooth and reduce the contours. The Hatch Slope Zones option fills in the slope zone areas with colored hatching. The Filter Data to Smooth Contours option applies a filtering algorithm that reduces the noise. The slopes can vary greatly between neighboring points. When contoured directly, these slope data points can produce incoherent contours with the smoothing.

Note: If you choose to use Screen entities instead of a surface model file, you are prompted whether to: **Freeze grid layer after processing [Yes/No]??**
3D Faces from a grid surface model

3D Faces created by *Triangulate & Contour* with the Draw Triangulation Faces option

Slope zone contours
Slope zones that follow the surface contours using the triangulation 3D Faces

Hatched slope zone contours created from the grid 3D Faces

**Pull down Menu Location:** Surface >> Slope Analysis

**Keyboard Command:** szone

**Prerequisite:** Surface model file (.TIN, .GRD, or .FLT), or 3D Faces entities
List

This command lists the object type, object layer, and X, Y, Z position relative to the current user coordinate system (UCS) and whether the object is in model space or paper space.

The List command reports color, linetype, and lineweight information if these items are not set to BYLAYER. The thickness of an object is displayed if it is nonzero. Z coordinate information defines the elevation. If the extrusion direction of the entry differs from the Z axis (0,0,1) of the current UCS, the List command also reports the extrusion direction in UCS coordinates. The List reports additional information related to the specific object selected.

Prompts

Command:
LIST
Select objects: 3 found, 1 group

Select objects:

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F3D
Group = *A1
"SPT4"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F4D
Group = *A1
"SRVPNO1"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

ATTRIBUTE Layer: "PNTNO"
Space: Model space
Handle = 1F4E
Style = "PTXT"
Font file = TXT
center point, X=6135023.7190 Y=2190077.9598 Z= 800.0000
height 5.0000
value 1
tag PT#
rotation angle 0d0'0"
width scale factor 1.0000
obliquing angle 0d0'0"
flags normal
ATTRIBUTE Layer: "PNTELEV"
Space: Model space
Handle = 1F4F
Style = "PTXT"
Font file = TXT
start point, X=6135031.2190 Y=2190071.7098 Z= 800.0000
height 5.0000
value 800

Prerequisite: an entity

Keyboard Command: LIST

Point ID

This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

Prompts

Pick point or point number: 255

PointNo. Northing(Y) Easting(X) Elev(Z) Description
255 4379.83 4265.48 19.01 GROUND/SHOT
N: 4379.83 E: 4265.48 Z: 19.01
PT#: 255 CRD File: c:\Carlson2008\data\mantopo.crd

Pulldown Menu Location: Inquiry
Keyboard Command: PT_ID
Prerequisite: None

Layer ID

This command reports the layer name of the selected entity.

Prompts

Pick entity to read layer: pick an entity
Layer: FINAL
Pick entity to read layer: press Enter to end

Pulldown Menu Location: Inquiry
Keyboard Command: layerid
Prerequisite: None
Calculator

The Carlson Calculator command uses a convenient pop-up calculator with three tabs for a standard calculator, scientific calculator and conversion calculator. The standard calculator does basic math calculations using expressions such as +, -, / and *. The scientific calculator has angle and other functions. The conversion calculator has feet-metric and angle conversions including radians. The standard and scientific calculators support RPN. Here is how RPN works:

1 + 2 = 3
- type value 1 + Enter
- type value 2 + Enter
- type +
X = 3.

Standard Calculator

Most basic calculations can be performed using this tab in the calculator. Memory functions are also available.

Scientific Calculator

Values can be entered on the X register. The values can be rolled up and down with the up and down arrow keys and the Roll and RollD buttons on the dialog. The Enter key finishes the entry of a number and pushes the stack. The C on the touch screen clears an entry. Additional functions on the screen can be obtained through touching the scroll [<] and [>] area of the screen.
Conversion Calculator
This mode provides for conversion between many units. Enter a value in any field and press Enter to find the conversion value. The following units are available in Feet, Meters and International Feet Degrees, Minutes, Seconds and Gons/Grads and Decimal Degrees.

Pulldown Menu Location: Inquiry
Keyboard Command: ccalc
Prerequisite: None

Curve Info
This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts
Define arc by, Points/<select arc or polyline>: select the arc entities
Pulldown Menu Location: Inquiry
Prerequisite: None
Keyboard Command: cinfo

Angle Info

This command reports the interior and exterior angles defined by two joining line segments or by three points. The coordinates, angles and distances of the line segments are also reported. The report is displayed in the standard report viewer.

<table>
<thead>
<tr>
<th>Angle Information</th>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Point</td>
<td>11</td>
<td>4728.73</td>
<td>5660.09</td>
</tr>
<tr>
<td>Corner Point</td>
<td>12</td>
<td>4684.89</td>
<td>5624.99</td>
</tr>
<tr>
<td>End Point</td>
<td>13</td>
<td>4664.02</td>
<td>5690.60</td>
</tr>
<tr>
<td>First Side</td>
<td></td>
<td>S 38°40'56&quot; W 56.16</td>
<td></td>
</tr>
</tbody>
</table>
Prompts

Define angle by, Points/<select line or polyline>: P for points

1st Point?
Pick point or point number: 11

2nd (Corner) Point?
Pick point or point number: 12

3rd Point?
Pick point or point number: 13
Interior: 68°57'18" Exterior: 291°02'42"

Angle Info Report Viewer
1st Point (Enter to end)?
Pick point or point number: press Enter

Pulldown Menu Location: Inquiry
Keyboard Command: ainfo
Prerequisite: None

Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: pick a polyline or line
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Keyboard Command: polylen
Prerequisite: None

Block Data Report

This command reports the number of different types of blocks in the drawing along with the block attributes. After selecting the blocks to report, the program has a dialog with all the block attributes. You can select which attributes
to report. The Details option for the Report Format includes the properties for each block including the northing and
easting. The Summary Report reports the number of each type of block with matching reported attributes. The Only Report Blocks With Attributes chooses whether to report blocks with no attributes.

![Block Data Report dialog]

**Prompts**

Select blocks to report.

Select objects: select blocks

Block Data Report dialog

Report Formatter

Summary Report

COND Count
POOR 1
GOOD 3
FAIR 2
Total 6

Details Report

ID Northing Easting COND
100 2190229.6 6135223.9 GOOD
101 2190224.1 6135171.4 GOOD
102 2190200.4 6135103.4 GOOD
103 2190227.0 6135117.4 FAIR
**Display Last Report**

This brings up the last report generated by any Carlson Takeoff command that uses the standard report viewer.

**Prerequisite:** a previously generated report

**Keyboard Command:** last_report

---

**Text File To Report Formatter**

This command loads data from a comma separated text file into the Report Formatter. The first line in the text file is used for the header names for the report. The rest of the lines in the text file has the field data for the report. Here's an example text file:

```
Point,Northing,Easting,Elevation,Description
11,4684.34317,5652.95193,501.47000,IP
12,4792.02100,5436.00000,505.90000,UP
13,4651.52246,5516.53607,504.03000,BLD
14,4656.32969,5535.94973,504.72000,BLD
```

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** csv_report

**Prerequisite:** Text file

---

**Surface Inspector**

This command allows you to report and optionally label elevations from your drawing. You can analyze all of your different surface files at one time. After running the command, Surface Inspector will begin showing you real-time elevations for each surface as you move the cursor on the screen. If you pick a point or enter coordinates, the elevation will be labeled along with the surface name.
Surface inspector shows you real-time elevations as you move the cursor over your surface.

**Prerequisite:** Surface Model (s)

**Keyboard Command:** survvals

## Surface Report

This command reports a variety of information on each of your different surfaces. This is useful for checking for bad data and the file names of your surfaces. An example is below.

**Surface Report 3/10/2005 15:34**

Max Cut: 18.327 at 409269.984,207196.674  
Max Fill: 1.943 at 409389.586,207248.866

**Original Ground After Topsoil Removal**

File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-ex.flt  
Date Modified: Thu Feb 10 10:02:05 2005  
File Size: 64,028  
Points: 259, Edges: 744, Triangles: 486  
Min Z: 184.000 at 409299.790,206879.287  
Max Z: 210.000 at 409571.562,207177.240

**Design With Subgrade and Topsoil Replacement**

File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-fn.flt  
Date Modified: Thu Feb 10 10:02:08 2005  
File Size: 153,038  
Points: 609, Edges: 1,779, Triangles: 1,171  
Min Z: 176.000 at 409357.096,206821.604  
Max Z: 206.000 at 409551.532,207185.124

**Original Ground Before Topsoil Removal**
Design Without Subgrade or Topsoil Replacement

File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-og.flt
Date Modified: Thu Feb 10 10:02:05 2005
File Size: 64,028
Points: 259, Edges: 744, Triangles: 486
Min Z: 184.000 at 409299.790,206879.287
Max Z: 210.000 at 409571.562,207177.240

Design With Subgrade

File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-zn.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Prerequisites: A Surface
Keyboard Command: SURF STATS

Drawing Inspector

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by pick Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.
In the Drawing Inspector menu, you can choose one or more properties to display.

**Display Layer Name:** displays the layer name of the entity.

**Display Entity Type:** displays the type of the entity (ie. TEXT or POLYLINE).

**Display Elevation:** displays the elevation of the entity.

**Display Azimuth-Distance:** displays the azimuth and distance of a line.

**Display Bearing-Distance:** displays the bearing and distance of a line.

**Display Point Data:** displays the coordinate data of point.

**Display Text Data:** displays the contents of text.

**Display Curve Data:** displays the radius, arc length, chord length and delta angle of a curve.

**Display Polyline Data:** displays the end point elevations, horizontal distance, slope distance and slope ratios.

**Display 3D Face Data:** displays the Z elevations at the face corners.

**Display Polyline Blips:** displays temporary blip plus marks at the vertex locations of polylines.

**Display Polyline Direction:** displays temporary arrows to show the direction of polylines.

**Display Surface Elevation:** prompts for a TIN or grid surface file to load and displays the surface elevation at the current cursor location.

In the Drawing Inspector menu, you can also choose how the property information is reported.

**Enable Highlighting:** Allows you to highlight the object that the Drawing Inspector is reporting.

**Enable Tag Display:** Enables you to view the information next to the cursor on the screen.

**Show Data On Status Bar:** Enables you to view the information on the status bar, in the lower corner of the screen.

**Use Default Cursor:** When enabled, only the drawing cursor shows. When disabled, the mouse pointer is also shown.

**Report In High Precision:** When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.
Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you’d like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.

Layer Report

This command generates a report containing all the layers defined in the drawing. Along with the layer names, the report includes the number of entities on each layer, and the color, linetype and lineweight for each layer.
List Elevation

This command displays the elevation of a polyline or line. With a 3D polyline, the elevation of the 3D polyline at the pick point is reported along with the elevation of each vertex. See also, the Drawing Inspector command on the *Inq-Set* menu.

**Prerequisite:** an entity

**Keyboard Command:** LSTELEV

Distance Report

This command reports the horizontal distance, slope distance, and elevation difference between two points.

**Prompts**

Pick point or enter point number:
(409375.0 207039.0 0.0)
Pick second point or enter point number:
(409400.0 207082.0 0.0)
Horiz Dist: 49.73 Slope Dist: 49.73 Elv Diff: 0.00

**Prerequisite:** none

**Keyboard Command:** distrprt

Angle/Distance

The Angle/Distance sub-menu contains many commands for labeling the angle and/or distance of line segments. The line segments can be defined by picking a line, picking a polyline segment, entering two point numbers or picking two points. The angles can be labeled in bearing, azimuth or gon format. In the command names, the "_" indicates which side of the line label will appear. For example, "Bearing_" will label the bearing above the line and "_Bearing" will label below the line. There is also a Custom Label Formatter option. When this command is used and Option is chosen, there will appear a Custom Line Label dialog with various settings.

**Prompts**

Define bearing by, Points/type in Bearing/<select line or polyline>: P
1st Point ?
Pick point or point number: 11
PtNo. North(y) East(x) Elev(z) Description
11 4869.06 4390.31 0.00
2nd Point?
Pick point or point number: 2
PtNo. North(y) East(x) Elev(z) Description
2 4610.89 4078.44 0.00

Bearing_Distance

Stacked Distance_Bearing

Bearing_Distance

Pulldown Menu Location: Annotate > Angle / Distance

Keyboard Command: Bearing and distance or bearing only or distance only: brg_, bbrg, brg_dis, dis_brg, brgdis_, _brgdis, dis_, bdis, bbrgdis; Stacked labels: stackbd, stackdb2, stackdb3, stackdb4; Azimuth: AZI_, BAZI, AZI2_, AZI3_, azidist2, azidist3, azidist4, dist_azi; Gon: gonlab, gonlab2, gonlab3, gonlab4.
Prerequisite: None
**Inverse**

This command allows you to determine the bearing and distance between the endpoints of a line or a curve by entering the points that define the line or curve.

After choosing the Inverse menu item you are asked to "Enter point sequence". A point sequence is a series of points that define the points being used to calculate the inverse. You may enter one point ID at a time to inverse from point to point. You may enter the two points separated by a dash (5-7), etc.

Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): 5
[cLockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5): 7

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7.
To 'Reset' the last point enter R or "." and <Enter> for Reset. The last point will now be shown as <none>.

**Inversing Around Curves Clockwise**

To inverse around a clockwise curve (one curving to the right), enter the PC point ID then enter "L" or "+" to indicate a clockwise curve. Next enter the point ID of the radius point of the clockwise curve and follow with the PT point ID.

For Example:

First enter the PC of the curve. In this example type or pick point ID 2201
Enter point sequence
[cg-Point-group/Reset/turn-Snap-on] (last point = <none>): 2201

Now type L or "+" and <Enter> for a clockwise curve
Enter point sequence
[clockWise curve/Ccw curve/Point group/Reset] (last point = 2201): L
Next type or pick the radius point ID 2200
Enter radius point for curve [Reset/sNap on]: 2200

You may also use the mouse to pick a C&G Arc. In this case, the arc's radius point will be used
Next type or pick the PT point ID 2202
Enter point of tangency (PT) for curve [Reset/sNap]: 2202

**Inversing Around Curves Counter Clockwise**
To inverse around a curve in a counter-clockwise direction (curving to the left) simply type W or ":" and <Enter> then proceed as with a clockwise curve.

**Inversing between a series of points in the coordinate file**
By entering 2 point numbers separated by a "+" you can inverse through successive point IDs in the order they are found in the coordinate file (either numeric or alphabetic order). For example, if you enter 3+6, inverses will be calculated and displayed from point 3 to 4, 4 to 5 and 5 to 6. You can use the <F2> key to view the information printed at the command line or you can view the print file (CGFile > Print/View Print File).

**Inversing using Point Groups:**
You can use a Point Group to inverse between a series of points specified by the point group. To specify a point group type a P or '*' and <Enter> at the command line. This will display a dialog box showing the Point Groups currently in the default directory.

Prompts

**Enter point sequence**
[Point group/Reset/sNap on] (last point = <none>): Enter or pick the first point on a line or the PC of a curve. Type "P" and Enter to use a point group to specify the inversing sequence. Type "R" and Enter to Reset the last point. Type "N" and Enter to turn on CAD snaps (these are turned off when the command starts).
[Clockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5): Enter or pick the next point ID to inverse to or type "L" and Enter or "W" and Enter to specify the radius point of a curve.
If you are entering a curve:
**Enter radius point for curve [Reset/turn Snap on]:** Enter or pick the radius point for the curve.
**Enter point of tangency (PT) for curve [Reset/turn Snap on]:** Enter or pick the PT point for the curve.
Label Angle

Function

This command will label and report the interior and exterior angles between two directions. The angles can be defined by three points or by two line or polyline segments that have a common endpoint.

Prompts

Define angle by, Points/<select line or polyline>: pick a polyline segment

Select adjoining line or polyline: pick another polyline segment

Interior: 72d39'46'' Exterior: 287d20'14''

Angle to label (<Interior>/Exterior/None)? press Enter

Define angle by, Points/<select line or polyline>: press Enter to end

Pull-Down Menu Location: Annotate

Prerequisite: None

Keyboard Command: labang

Polyline Report

Function
This command generates a report of bearing-distance and curve data for all points along the selected polyline. The closure is reported between the starting and ending points of the polyline. The polyline area is also reported.

After executing the command, by pressing O for options, report deflection angles can be turned on by selecting Y for yes at the prompt. The deflection angle will be displayed in the report along with the bearing and distance of the polyline segments.

**Prompts**

**Starting station** <0.0>: *Press Enter*

**Options/Select polyline to report:** *pick a polyline*

**Standard Report Viewer** Displays the report for the selected polyline.

**Options/Select polyline to report (Enter to End):** *Press Enter*

**Keyboard Command:** preport

**Pull-Down Menu Location:** Tools, Polyline Tools

**Prerequisite:** a polyline

Polyline Report 05/22/2002 13:24 >

**NORTHING EASTING STATION BEARING DISTANCE**

<table>
<thead>
<tr>
<th>Station</th>
<th>Northing</th>
<th>Easting</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>5790.690</td>
<td>4088.812</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N 49°52'11'' E 455.737</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6084.426</td>
<td>4437.259</td>
<td>455.737</td>
<td></td>
</tr>
<tr>
<td>RADIUS: 367.183 LENGTH: 725.711 CHORD: 613.228 DELTA: 113°14'28''</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHORD BRG: S 73°30'35'' E PC-R: S 40°07'49'' E PT-R: S 73°06'39'' W</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

RADIUS POINT: 5803.685,4673.919

<table>
<thead>
<tr>
<th>Station</th>
<th>Northing</th>
<th>Easting</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>5910.360</td>
<td>5025.265</td>
<td>1181.448</td>
<td></td>
</tr>
<tr>
<td>S 16°53'21'' E 851.945</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5095.161</td>
<td>5272.774</td>
<td>2033.393</td>
<td></td>
</tr>
<tr>
<td>S 52°00'05'' W 548.996</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4757.175</td>
<td>4840.152</td>
<td>2582.389</td>
<td></td>
</tr>
<tr>
<td>N 54°19'05'' W 857.964</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5257.614</td>
<td>4143.257</td>
<td>3440.353</td>
<td></td>
</tr>
<tr>
<td>CHORD BRG: N 72°02'46'' W PC-R: S 35°40'55'' W PT-R: S 00°13'33'' W</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

RADIUS POINT: 4692.743,3737.624

<table>
<thead>
<tr>
<th>Station</th>
<th>Northing</th>
<th>Easting</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>5388.163</td>
<td>3740.364</td>
<td>3870.702</td>
<td></td>
</tr>
<tr>
<td>N 40°52'52'' E 532.394</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5790.690</td>
<td>4088.812</td>
<td>4403.097</td>
<td></td>
</tr>
<tr>
<td>Closure Error Distance &gt; 0.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Distance &gt; 4403.097</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Polyline Area: 1201606.5 sq ft, 27.59 acres
Story Stake From Surface Entities

This command creates points with cut/fill information stored in the note fields for the points. Beginning at a point and facing a specified direction, the cut/fill information describes a design surface that is defined by contours and 3D polylines in the drawing.

First, there is a dialog to set the starting point number, setback offset, selection mode and report options. The Automatic selection mode will create a story point for each crossing linework. The Manual mode will show the crossings and let you pick which ones to report.

The program prompts you to pick the starting point followed by a direction point. Then the intersections for all the contours and 3D polylines between these two points are calculated and the resulting horizontal distances and slopes are shown in a dialog. In this dialog, you can edit, add or remove these slopes descriptions. The Point Description can also be specified. When OK is clicked, a point in the coordinate file is created at the starting point with this information stored in the note file. An offset point is also created at the specified offset distance back from the starting point. At the end of Story Stake, a report of all the created points and the corresponding cut/fill data is shown if the Create Report option was set. Story Stake does not draw the points in the drawing. These points can be drawn using the Draw-Locate Points command.
Story Stake By Points/Polyline

Function

This command creates a story stake report of distances, slope and cut/fill between selected points or along a selected 3D polyline.

First, there is an options dialog. The Progressive method reports each distance from the previous point to the next. The non-progressive method reports the distances from the starting point to each point. The report formatter option lets you customize the fields for the report and output the report to Excel.

For the points method, there are prompts at the command line to pick the points. The points should be picked one at a time in series from start to end. The points can be entered by point number from the current coordinate file or by screen pick.

For the polyline method, there is a prompt to select the 3D polyline for the grade. The polyline should be drawn in the order of the story stake.
Area Defaults

This command allows you to specify default settings for area labeling. The Area Defaults dialog is divided into 3 tabs. The first is the Label Fields and Settings tab. The top portion of the Label Fields and Settings tab contains two listboxes which are used to control which of the possible ten area fields will be used for area labeling. You use the Add and Remove buttons to control which fields will be included in area labels. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

When a grid projection is defined in Drawing Setup, the Available Fields with include geodetic areas where the areas are adjusted by the projection. The Base Z from Drawing Setup is used for the elevation factor for this adjustment.
Field Settings Dialog: To control the appearance of the fields in the drawing, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

User Defined: The Field "User Defined" can be added to place a custom fixed label in all areas. To control the value and appearance of the custom label in the drawing, use the Edit button to edit the "User Defined" item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog. In this case the "Value" setting becomes the custom label.

Scaled labels: The "Scaled Sq. Feet", "Scaled Sq. Meters", "Scaled Acres" and "Scaled Perimeter" fields can be used to include area labels that are scaled based on Drawing Setup "Report Scale Factor".

Chapter 15. Inquiry Menu
Text Style: This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

Text Size: This value is multiplied by the horizontal scale to obtain the actual text size.

Text Layer: This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

Text Color: This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

Prefix and Suffix: Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically (see below for example of results of using a prefix with square feet and acres).

Justification: Use this to control whether the label field is left, centered or right justified.

+/-: This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

Precision: Choose precision level for the currently selected field.

Below the Available and Used Fields lists the following items for further controlling area label generation:

Use Commas in Labels: This allows you to use commas in the area labels.

Use MText: Check this box to turn on the use of MText for area labels. If this is checked all area labels will be grouped into as few MText entities as possible. Area labels with different text styles, justification or layers will not be combined into the same MText entity.

Erase Previous Labels: When checked, previous area labels for the area being relabeled will be erased.

Label Placement: When auto placement of area labels is used, the labels can be placed either at the centroid of area or at the rear side. This is accomplished by selecting either the Center or Rear Side radio button, respectively. When Center is selected the user can choose to have the labels oriented according to the side lines of the area by checking the Align By Sides checkbox. When either Align By Sides or Rear Side is selected, the checkbox Flip Text for Twist Screen can be selected to have the label rotated 180 degrees to present it in the best reading orientation relative to the current Twist Screen rotation setting.

Draw Symbol Around Lot Description: When the Lot Description field is included in the Used Fields list, the user can check this checkbox to have a symbol drawn around the Lot Description field. When this box is checked, you specify the symbol name in the Symbol Name field or click on the current symbol (drawn to the right) to graphically choose the desired symbol. You specify the layer by entering the name in the Layer box or by clicking on the Select button to choose from a dialog that presents all known layers.

Symbol Buffer Offset: By default, the symbol will be automatically scaled according to the text length and size of the Lot Description value for the area. For additional control of symbol scaling, the user can enter a number in text size units in the Symbol Buffer Offset box. This value will be added to the automatically generated default scaling value.

Avoid Label Overlap: If this box is checked the area labels will be checked for overlaps after they are generated. Please see the Overlap Manager documentation for more information.

Overlap Settings: Click this button to go to the Avoid Label Overlaps dialog where you can review or modify the Overlap Manager settings. Please see the Overlap Manager documentation for more information.
Table Process Settings Tab:

Use Area Tables: Use this control to determine whether area labels are sent to a table or not. Options are "Never", "Always" or "By Scaler".

To Table Area: When the user has selected "By Scaler" in the "Use Area Tables" list this item is enabled. When "By Scaler" is selected and the area is less than this minimum, the area label is sent to a table.

Area Reference Numbering: There are three different methods for setting the reference number: Next Available will automatically use the lowest available number. Specified With Prompt will prompt you for a number for each area. Specified with Auto Numbering will automatically use the lowest available number starting with the specified number.

Auto Place Table References: When checked, will automatically place the area reference label according to the settings for the area labels as specified in the Label Field and Settings tab (see above). Otherwise you will be prompted to pick each label location manually.
Area Commands Tab:

Max gap to join: You use this option during Area by Lines & Arcs command. When connecting lines and arcs that define the perimeter, the program will join endpoints if the distance between the two points is less than the specified gap. Otherwise the program will report an error and will not report an area.

Prompt whether to retain polylines created by Area by Interior Point: When checked the user will be asked whether to retain the polylines created by the "Area by Interior Point" command.

Polyline Layer: Will be enabled when "Prompt whether to retain polylines created by Area by Interior Point" is checked to allow the user to select the layer that any such created polylines will be placed in.

Load/Save: These buttons save and recall all the Area Default settings to a .ARS settings file.

Tip: Keep in mind that changes in Area Defaults, if changed from the Area/Layout pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.
The results of using a prefix with square feet and acres

**Pulldown Menu Location:** Area/Layout
**Keyboard Command:** defarea
**Prerequisite:** None

**Area by Lines & Arcs**

This command allows you to calculate the area of a perimeter or lot defined by lines, arcs, or polylines. Default settings for this command are set in *Area Defaults*. One of these settings is Max gap to join. If there is a gap greater than this value, the area is not reported, and the program will show where the gap is with a temporary X symbol. The area data shows up on the text screen. You can then choose to plot the area information to the drawing, or, by hitting *Enter*, just read it from the text screen.

**Prompts**

**Select lines & arcs or polylines of perimeter for area calculation.**
**Select Objects:** *select lines and arcs or polylines*
Lines and arcs are then joined together and the area calculated.
**Pick area label centering point (Enter for none):** *pick a point*
The area is then plotted at the point selected.
Area By Inverse

This command generates a report of the angle and horizontal distance between a series of points and calculates the area of the closed figure defined by the points. The points can be entered individually or by selecting a point group or linework entities. To use a point group, type G for Group at the first prompt. To use a linework, type L for Line at the first prompt. For linework, a single closed polyline can be used or a series of connected lines, arcs and polylines that are selected one at a time.

Curve data can also be entered and reported. The points can be either picked on the screen, or entered by point number. You can also enter a range of point numbers (i.e. 1-9). The closure is reported using the total distance inversed, and the difference between the starting and ending points, as the closure error.

At the first command prompt, you can enter O for Options to bring up the command options. The Input Method determines the default input mode for the first command prompt. The Different Radius Tolerance checks that the distance between the PC and radius point and the PT and radius point match for curves. The Linework Snap Tolerance applies to the linework input mode and is used to check the distance between end points when connecting two linework entities. The Report Closed By choosing between using the difference between the starting and ending coordinates to calculate the closure error or angle and distance values in the report. The Apply Compass Rule Adjustment will adjust the perimeter as a closed loop for the closure error. The Label Both Feet And Meters is an option to report the distances in both feet and meters. The Report Stations option adds stations for each point into the report. The Use Report Formatter chooses between the standard report or customizing the report. You can also set the decimal precisions for the report and whether to report stations for the distances along the perimeter. This command creates a polyline of the figure which can be erased or kept in the drawing. The Prompt To Draw Perimeter Polyline and Polyline Layer settings apply to this polyline.
The area can be labeled in the drawing using the settings from the *Area Defaults* command. If you don't want to label the area, press Enter at the pick label point prompt.

**Prompts**

Options/Line/Group/<Pick Starting point or point number>: *pick a point*

Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): *pick a point*

Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): *R* for radius

Radius point number or pick point: *pick a point*

Curve direction [Left/<Right>]<?> *press Enter*

Pick End of Arc or point number (U-Undo,Enter to end): *pick a point*

Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): *pick a point*

Point number (R-RadiusPt,U-Undo,Enter to end): *pick a point*

Point number (R-RadiusPt,U-Undo,Enter to end): *press Enter*

SQ. FEET: 27247.4 SQ. YARDS: 3027.5 SQ. MILES: 0.0

ACRES: 0.63 PERIMETER: 668.35

Pick area label centering point: *pick a point*

Erase Polyline Yes/No <Yes>: *press Enter* The command plots a polyline that represents the figure you defined if you want to keep the polyline respond with No.

![Diagram](https://via.placeholder.com/150)

Inverse with Area

CRD File> *c:\data\newplat.crd*

PNTNO BEARING DISTANCE NORTING EASTING STATION DESC

903 4940.73 2490.40 0.00 StartPt S 48°43'58'' W 136.21 904 4850.89 2388.01 136.21 S 13°07'04'' E 155.56 905 4699.39 ... 714.97 IP N 26°28'57'' W 125.87 909 4923.03 2656.69 840.84 N 83°55'30'' W 167.23 903 4940.73 2490.40 1008.07 StartPt

Closure Error Distance> 0.0000
Total Distance Inversed> 1008.07
AREA: 74664.6 SQ METERS

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** ia

**Prerequisite:** None

---

**Area by Interior Point**

This command calculates and labels the area of the perimeter surrounding a picked interior point. The *Boundary Polyline* command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use *Area by Lines & Arcs* for other applications. The settings for the area label and for whether to prompt to create a closed polyline for the area are under the *Area Defaults* command.
Prompts

Pick point inside area perimeter: *pick a point*
Pick area label centering point (Enter for none): *pick a point*
The area is then plotted at the point selected.

Pulldown Menu Location: Area/Layout
Keyboard Command: ptarea
Prerequisite: Set Area Defaults

Area by Closed Polylines

This command will calculate and report the area of single area and multiple area closed polylines. In the case of multiple areas, the user can choose to have the areas totaled (Total Multiple Areas) into a single result or to generate data for each area separately. Area by Closed Polyline will also automatically find special Carlson attributes attached to the polyline, in addition to capturing the area itself. These attributes will appear in the report, which can be the standard report or which can be presented in the Report Formatter, which itself links to Excel and Access. For example, property names and owner names, as applied to a polyline using the Mine modules, will report out automatically using Area by Closed Polyline. The command "Draw Lots from File..." will apply "extended entity data" to the lot polylines, which includes the lot name, and this will also report out when using Area by Closed Polyline. In addition, lot names, or any interior text whatsoever, can be captured and included in the report. The plot of the area on-screen can be canceled if only the report is desired.
When auto-placing labels at the rear of lots or when aligning labels by the sides of the lot the user will also be prompted to pick one or more centerlines (Select the Centerline Polylines). The routine will find the closest centerline and use this to determine the location of the front and back corners of the area.

When additional interior text is selected, the standard report will include that text:

Polyline Area 11/17/2004 12:49  
Polyline Area: 43560.0 sq ft, 1.00 acres  
Polyline Perimeter: 838.35 ft  
Text: 16 Sf: 43560.0; Ac: 1.00

In this case, the "16" refers to Lot 16, and appears in the report because the lot number and existing area labeling were selected along with the polyline for the lot.

Area Table Defaults

This command allows you to specify table fields and format settings for area tables. Whether the Area Commands create an area table or label within the area is controlled by the Area Defaults command by the Use Area Tables setting. With the Area Defaults and Area Table Settings prepared, the various Area Commands will create tables according to the settings. When the Area By Closed Polylines routine is used to create the area table and the Link Linework With Labels option is on under Configure Carlson->General Settings, then the area table values are automatically updated when the polyline geometry is modified. Also, when using the Area By Closed Polylines command with the Lot Description field active for the table, the program prompts for an area description for each polyline. The rest of the area table fields are calculated from the polyline geometry.
The Area Table Defaults dialog is divided into 2 tabs. The Table Fields tab brings up the Table Settings panel shown below. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the table has the data for one area and includes a reference number. The reference number is also labeled inside the area.

The Table Fields tab contains two listboxes which are used to control which of the area fields will appear in any table rows that are generated for areas. You use the Add and Remove buttons to control which fields will be included in area tables. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area table will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

Field Settings Dialog: To control the appearance of the fields in the table, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings
**Column Title:** This will be the tile name used for the field's column in the area table.

**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.

**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

**Prefix and Suffix:** Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically.

**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/−:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

**Column Width/Auto:** The default behavior is that the column width is automatically set for best fit. The user can override this value by unchecking the Auto checkbox and setting the column with in text size units.

The **Table Settings** tab brings up the Table Settings panel shown above. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the
Table Parameters:

**Total Area on Last Row:** Select this to have a total row placed at the bottom of the table which will contain the sum of all relevant table fields.

**Label Layer:** Use this to control the layer that the area table reference will be placed in. Use the Select button to pick from a list of all known layers.

**Label Color:** Use this to control the color of the area table reference. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the label layer.

**Area Label Prefix:** Use this to control the prefix of the area table references. Add a space after the prefix to have the prefix and the reference number separated by a space if desired.

**Label Text Style:** Use this to set the text style of the area table reference. Use the Select button to pick from a list of all known text styles.

**Table Layer:** This allows the user to set the layer that the table will be placed in. Use the Select button to pick from a list of all known layers.

**Table Color:** This allows the user to set the color of the grid lines of the table. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Area Table Title:** To add a title row as the first row of the area table, enter a table title here.

**Title Text Color:** This allows the user to set the color of the table title. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Title Text Style:** Use this to set the text style of the table title. Use the Select button to pick from a list of all known text styles.

**Title Text Size:** Use this to control the size of the table title text.

**Background Colors:** The area table is broken into 5 zones in respect to background color. Each zone can have its own unique background color. The zones are Title, Header, Contents1, Contents2 and Total. To set a background color for each zone, first the respective "Use Table...Background Color" box must be checked. This enables the Select button, which is used to pick the respective background color from a color picker dialog. For the Contents zone all contents rows can either have the same background color, or by setting up an "Alternating Background Color", rows will have alternating colors.

**Pulldown Menu Location:** Area/Layout->Area Tables

**Keyboard Command:** defatab

**Prerequisite:** None

---

**Area Descriptions**

**Tag Area Descriptions**

This command is used to assign a description to a closed polyline. The description is stored with the polyline in the drawing. This description is used for reports in routines like Area By Closed Polylines.

**Prompts**

**Select polyline for area description:** pick a polyline

**Area description <AREA1>:** West Pond

**Pulldown Menu Location:** Area/Layout > Area Descriptions

**Keyboard Command:** tag_area_desc

**Prerequisite:** A closed polyline.
Identify Area Descriptions

This command reports area descriptions for the selected polylines. There are two methods. The Pick method reports the area description for one selected polyline at a time. The Search method scans the whole drawing and highlights polylines with area descriptions.

Prompts

Pick polylines to check or search drawing [<Pick>/Search]: press Enter
Select area description polyline: pick a polyline
Description: West Pond
Select area description polyline (Enter to end): press Enter

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: id_area_desc
Prerequisite: A polyline with a tagged area description.

Untag Area Descriptions

This command removes an area description that has been assigned to a polyline.

Prompts

Select polylines to remove area description from.
Select entities: pick area polylines
Cleared 10 area descriptions.

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: untag_area_desc
Prerequisite: A polyline with a tagged description.
Drawing Setup

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

- Specify **English 1in=?ft** or **Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
- Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1” = 50’ is your drawing scale.
- The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)
- **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)
- **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)
- **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD **UNITS** command.
- **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection.
system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the Align To Local Coordinates command in the Field Module for more information.

- **Project Scale Factor** is multiplied by the x,y coordinates when converting between drawing and geodetic coordinates.
- **Base Z** is used for calculating the combined scale factor for calculating geodetic areas.

**Projection:** There are several built-in projection including State Plane 83, State Plane 27 and UTM. Also on the Projection list is an item for More Pre-Defined as well as User-Defined projections. This expanded Pre-Defined selection includes the projections used in SurvCE which has hundreds of projections including the US County projections for Indiana INDOT INGCS, Iowa Regional Coordinate System, Minnesota, Oregon and Wisconsin (WCCS and WISCRS) as well as from around the world. When you pick Pre-Defined, a dialog shows a list of recently selected Pre-Defined projections.

You can pick from this recently used list, or pick the Add Pre-Defined to select from the built-in list.
The Add From File button reads in a projection saved to a file by this routine or by SurvCE CSL or ESRI PRJ. The Edit button allows you to change the name or parameters of a projection. The Remove function removes a projection from the list of recently used projections. The Add User-Defined routine defines a projection by setting the ellipsoid, choosing the method and entering the parameters. There are over 25 built-in ellipsoids to choose from such as Clarke 1880. You can also manually enter the ellipsoid values. The projection definition includes the 7 parameter Helmert transformation to go from WGS-84 to the user datum. There are over 20 projection types to choose from such as Transverse Mercator. After selecting the projection type, there are edit fields for each of the parameters for the selected projection. The Test button brings up a calculator to enter a lat/lon and report the projection coordinates as a way to test that the projection parameters are entered correctly and are working.

Besides Drawing Setup, these projection functions are also used in the Coordinate Transformation function in Coordinate File Utilities.

- **Project Name and Job Number** are optional fields that are used in the header for reports.
- **Project Location** is used in the header for reports and used to roughly geolocate the drawing when the Projection isn't set.

- **Report Distance Scale Factor** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be set to a single fixed value or set to go from ground to grid or from grid to ground on-the-fly. The fixed scale factor can be entered directly into the edit box or calculated using the Set button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor. For the on-the-fly factor between grid and ground, the program calculates the combined scale factor for each distance using the two end points for the distance line.

- **Rotation** is used to adjust the bearings and azimuths for labels and reports such as in the Inverse and Auto-Annotate routines.
- The **Set Text Styles** button creates text styles in the drawing for the current drawing Horizontal Scale with the specified Font Name and list of Style Names and Text Size Scalers. For example, when the Horizontal Scale is set to 50 and there is a Style Name of L80 with Text Size Scaler of 0.08 in the list, then this function will create a text style in the drawing called L80 with the text height of 4 (50 * 0.08). Besides the font and size, you can also set the width factor and oblique angle for each style. Use the Save and Load buttons to store and recall these style settings to a .FNT file for sharing with co-workers or your own use.
• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.

  - The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
  - The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.

**Prompts (for Set Paper)**

Pick or Type lower left corner point for border 
＜(5000.00 5000.00 0.0)＞: pick a point
Erase existing Set Paper boundary ［＜Yes＞/No］? Y This prompt only appears if there is an existing paper boundary in this drawing.
Set Limits [Yes/<No>]?  Y If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.

Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

Pulldown Menu Location: Settings
Keyboard Command: setup
Prerequisite: None

Configure

This command allows you to set the default settings that are used each time you start a new drawing or load an existing drawing. These settings are stored in *.ini files in the Carlson TakeOff directory. Configure restores the current drawing settings to these default settings.

1 In the Configure dialog box you choose between General Settings, Takeoff Module, Drawing Setup, and AutoCAD Settings.

2 In the General Settings dialog box you can set options for Carlson Takeoff.
A Under General, you can choose options relevant to points, angles, and start up.

- **Use Startup Wizard**: This option controls whether the wizard appears when you create a new drawing.
- **Generate Report Log**: This option allows output from several commands to be accumulated in a report buffer. Any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar displaying the number of lines in the report buffer. To view the report log, pick the maximize icon on this title bar. You can edit the report log, save it to a file, or print it. To quickly turn the report log on and off, you can type REPORT at the command prompt, which toggles the report log on/off.

- **Use Notepad for Reports**: When this toggle is turned on, whenever a report is generated, it will appear in a Windows Notepad instead of the TakeOff Report Viewer.
- **Save Drawing INI Files**: This option creates an .ini file with the same name as the .dwg file to store the project data files for the drawing.
- **Put Data Files in DWG Directory**: This option sets the Data Path to the directory of the drawing. The Data Path is the default directory for data files such as the coordinate file (.crd).
- **Auto Zoom Center for New Points**: This option will zoom center on new points.
- **Ignore Zero Elevs**: This option causes entities with zero elevations to be excluded from calculations, etc.
- **Use South Azimuth**: This option allows you to use a south azimuth for calculations.
- **Use Dview Twist Angle**: This option keeps text horizontal to a twist screen view.
- **Set Dimscale to Drawing Scale**: This option sets the AutoCAD Dimscale setting to equal the current drawing scale.
- **Set PDSIZE to Symbol Size**: When checked, the system variable PDSIZE will be set to the same size as the symbol size that you set in Drawing Setup. PDSIZE controls the display size of AutoCAD point entities. Normally AutoCAD point entities are displayed as a dot, and the size does not apply. You may modify the point display type by changing the system variable PDMODE. For example, if you set PDMODE to 64, point entities are displayed as a square regardless of the TakeOff symbol type used.

- **Remove Arcs Offset**: This makes arcs into straight lines if the arcs are smaller than the offset.

- **Point Layer**: You can assign a default layer name for points.

- **Date Format**: You can control the display of dates in Carlson TakeOff reports with this popdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

- **Digitizer Puck Layout**: This option sets the layout for the digitizer puck keys. Pick the View button to see a graphic of the different layouts.

B Under Support Paths, you must determine paths for file allocation and retrieval.

- **MS Excel Path**: You determine the path for the *.exe file for MS Excel is located.
• **Coordinate Report Order**: You can choose whether coordinates are reported in northing-easting or easting-northing order.

C Under Object Linking, you can set reactors to the drawing entities.

• **Link Points with CRD File**: This option attaches a reactor to the point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the coordinate file.

• **Link Linework with Points**: This option attaches reactors to line and polyline entities that are drawn by point number so that moving the points automatically moves the linework.

• **Link Labels with Linework**: This option applies to bearing/distance annotation. This link updates the annotation when the linework is modified.

• **Group Point Entities**: This option joins the three entities of a point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point.

D Under CRD File Pt# Format, you can set the point number format for coordinate files.

• **Carlson Numeric Only**: This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 32767.

• **Carlson Alphanumeric**: This native Carlson format allows letters in the point numbers, and the point name can be up to 10 characters. Any combination of letters and numbers is acceptable.

• **C&G Numeric**: This format of the C&G division supports up to 5 digits, with a 65000 point limit.

• **C&G Alphanumeric**: This format of the C&G division supports up to 10 characters, with no limit to the number of points.

• **Simplicity ZAK**: This format is the one used by Simplicity Systems programs. The file uses a Microsoft Access database format.

• **LDD Points.mdb**: This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is found in a projects \Cogo directory. The number limitation is established by the database structure, but is frequently numeric and allows unlimited point numbers.

E Under Database Format you choose between Microsoft Access 97 or 2000 format. This only applies to new .MDB files created by Takeoff.

3 Takeoff Settings
• **Automatic Update Colors**: This refreshes colors in your drawing as they change: i.e. elevating entities, setting layers for different Targets, etc. If your drawing is very large and is slow to automatically refresh you may want to toggle this off and use the **Update Colors For Set Elevations** command under View when you want/need to see the color changes.

• **Assign Colors By Target**: This option allows you to set the Existing, Design, and Other layers to any color you define.

• **Assign Colors By Elevation**: This option allows you to set the color for entities needing elevations.

• **Extrapolate Surface To Boundary Perimeter**: When this is check ON surfaces are extended and volumes are calculated out to your boundary perimeter. When this is checked OFF surfaces and calculations end at the extents of your design data.

• **Use Existing Surface To Extrapolate Design**: When this is checked ON surfaces and volumes are calculated to the extents of your existing data.

• **Use Binary Triangulation File Format**: This option sets the format for the surface model files as either binary or ASCII. The binary format has a .tin file name extension and loads about twice as fast and has about 50% less file size than ASCII. The ASCII format has a .flt extension and is the legacy format used by other Carlson products and Softdesk.

• **Reduce Triangulation Surfaces**: This causes edges within the selected surface Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

  **Reduction Offset Distance**: This setting is used by the Reduce Triangulation Surfaces command to set the reduction tolerance. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

4 This dialog box allows you to set up your **Data Path**. You determine can where data files (*.crd, *.tin, etc.) are stored. Either in defined folders (Project Folder), the same place where your drawing (.dwg) is stored, which is the
default and recommended (Drawing Folder), or in the same folder no matter which drawing you are working on (Fixed Folder).

A Under Scale and Size Settings, you can determine scale and size of drawing entities.

- **English 1in=?)ft**: This option tells the program which unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot.

- **Metric 1m=?m**: This option sets the metric scale to meters only.

- **Horizontal Scale**: This option allows you to set the horizontal scale of the drawing. For example, if the horizontal scale is set to 50, then 1" = 50' in your drawing.

- **Vertical Scale**: This option allows you to set the vertical scale of the drawing.

- **Symbol Size**: This value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Symbol Plot Size is not entered in Drawing Units.

- **Text Size**: This value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In
Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units.

- **Line Type Scaler**: This option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Symbol Name**: This option allows you to set the default symbol name for points.
- **Select Symbol**: Click this button to graphically select the default symbol.

B Under Point Prompt-Label Settings, select the options that determine how the points are to be labeled and how you will be prompted for point entry.

- **Descriptions**: Determines whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.
- **Elevations**: Sets prompting and labeling for point elevations.
- **Locate on Real Z Axis**: Switches between locating points at zero elevation and at the actual stored elevations.
- **Instrument & Rod Height**: Turns on prompting for instrument and rod heights when creating points.
- **Prompt for Symbol Name**: When checked, the program will prompt for a symbol name as each point is drawn. Otherwise, the default symbol name set in this dialog box will be used.

- **Attribute Layout ID**: Controls the location of the point number, elevation, and description. These attribute layouts are defined in drawings that are stored in the TakeOff Support directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then edit the associated SRVPNO drawing.

C Under Angle Mode, you determine how angles are entered and displayed.

- **Bearing**: This option sets reporting to bearing mode for any of the Inquiry commands.
- **Azimuth**: This option sets reporting to north based azimuth mode for any of the Inquiry commands.
- **Gon**: This option sets reporting to gon mode for any of the Inquiry commands.
- **Other**: Allows you to set a custom angle mode by using the Units Control command (described later in this chapter).

D Under Vertical Angle Mode select an option to determine how the vertical angle is calculated. Vertical Angle Prompt applies to creating points with commands such as Traverse.

- **None**: The vertical angle will not be used to calculate point elevations.
- **0 Degrees Level**: The vertical angle is used to calculate elevation and horizontal distance.
- **90 Degrees Level**: The zenith angle is used to calculate elevation and horizontal distance.
- **Elevation Difference**: Use the elevation difference to calculate the elevation.

E Under Point Number Settings, select the options that determine whether you will be prompted for point numbers by the commands that locate points.

- **Point Numbers**: When this toggle is checked on, points that are inserted by TakeOff commands are shown with a point number, and a coordinate is stored in the current coordinate (.crd) file. When this toggle is off, points are shown with no point number plotted and no coordinate is stored in the current coordinate (.CRD) file.
- **Automatic Point Numbering**: If this toggle is checked on, commands that locate a point will automatically insert a point number for each point drawn on the screen. If Automatic Point Numbering toggle is off, commands that locate a point will prompt for a point number.

5 AutoCAD Settings: This command allows the user to set up a number of options, pertaining to the directory file system, color combinations for the display screen, text fonts, workspace utilities like shortcut keys etc. **Keyboard Command**: `preferences`

**Prerequisites**: None

**Keyboard Command**: CONFIG_SCAD
Layer Library

This feature serves as an expanded version of the Layer Manager and also as a layer standards manager. In addition to allowing you to sort layers into easily recognizable groups called Layer Categories, this feature can also be used to import layers from a text file and to compare and match layers in the library to the current drawing.

Once populated, layers from the Library can be called from commands such as 2D Polyline and 3D Polyline for layer and property assignment.

The Layer Library has two areas of the dialog box: the Layer Category List on the left and the Layer List on the right.

Layer Categories: Layer Categories are shown as a list in a tree view in the left-hand pane of the dialog box.

Categories can be re-ordered by dragging and dropping to a different position in the list or by using the Move Up, Move Down, Move Left and Move Right arrow buttons. Other buttons above the Layer Category list also enable you to Add, Remove and Rename Categories.

Also, right-clicking on a Category in the list displays a shortcut menu allowing you to access many of the same commands as the buttons along the top and bottom of the dialog box.

Layers: Layers in a selected Category are shown as a list in spreadsheet view in the right-hand pane of the dialog box.

Layer Properties: Except for Non-Surface, all the layer properties in Layer Library correspond to the layer properties in CAD. The Non-Surface property is a specific flag used by the Triangulate & Contour routine to filter out entities. You can set a layer as Non-Surface when you want to exclude all entities on that layer from surface modeling.

The default column-headings for the Layer List are Name, Description, Color, Line Type, Line Weight, Non-Surface, Transparency, Plot Style and Plot/No Plot. Additional column-headings may be added using the Extra Fields button at the bottom of the dialog. Using the Add Layer (plus) and Delete Layer (minus) buttons, layers can be easily added and removed from a particular Category. The Move To button can also be used to change a layer to a different Category.
Clear All: This button removes all the Layer Category and Layer definitions.

Save As and Load: These buttons can be used to create and restore Layer Library settings using a Layer Library Settings (.LA) file. There are a few default .LA files in the Carlson Projects\Settings folder that you can load for National CAD Standard (NCS) layers and MassDOT standard layers. The current layer library definitions are stored in the USER folder in a file named layerstd.dta.

Extra Fields: This button allows you to define up to ten extra text fields (column headings) for a layer. These fields can then be used as import fields or displayed in a report.

Report: This button uses the Report Formatter to allow you to compile and display a report containing all Layer Categories and Layers in the Library. The Report Formatter can also be used to export the data to a Microsoft Excel (.XLS or .XLSX) file.

Import: This button gives you two options for Importing layers into the Layer Library.

The Drawing Layers option simply copies all layer definitions from the current drawing into the Library after prompting you to select the destination Category.

The Text File option allows you to select an existing Text (.TXT, .DAT, or .CSV) file containing standard layer definitions to populate the Library. Note that Microsoft Excel provides an option to save an Excel (.XLS or .XLSX) file as a Text file. Follow the steps below to Import layers from a text file.

1. Pick the Import button.
2. Pick the Text File (txt;dat;csv) button. This opens the Text File Import Options dialog box.

3. At the top of the Import Options box, select the file format type such as "Comma-Separated" or "Tab Separated".
4. If the top-line of the Text file contains column headings, pick the option to "Use first row for column headers".

Chapter 16. Settings Menu 798
5. If the Text file contains one or more lines of text above the layer and property data, use the text box next to "Skip" to specify the number of rows at the top of the text file to be "Skipped" before importing the list of layers.
6. If headers are not included in the Text file, use the drop-down at the top of each column heading in the spreadsheet view to specify the column's data type such as "Name", "Color" or "Linetype".
7. Pick the Continue button and specify the Category into which the new layers are to be Imported.

**Create:** After selecting a Layer Category, you can pick this button to create all the layers for that Category in the Drawing. When creating the layers, there is an option to create a layer group filter for the CAD Layer command.

![Create Group Filter](image)

**Compare DWG:** This button is used to Compare drawing layers and their associated properties such as color, linetype, linewidth and plot style to the standard Library definition for those layers. This feature will report how many layers matched exactly, how many had a different set of properties and how many non-Standard layers were found. It will also list the non-standard layers which are those defined in the drawing but not in the Library.

**Match DWG:** This button is used to alter the properties of drawing layers to match the properties of layers defined in the library, or vice versa. After picking the Match DWG button, this dialog box displays:

![Layer Standards Library](image)

Pick the Library to DWG button to alter the drawing layers to conform to the Library definitions.

Pick the DWG to Library button to alter the Library definitions of the layers to conform to those set in the drawing.

**Pulldown Menu Location:** Settings → Layer Library

**Keyboard Command:** layerlib

**Prerequisite:** None

2D Linework Library

This command sets lines and polylines on specified layers to zero elevation which helps solve the common drafting problem of linework getting moved to elevation such as with a grip edit snapping to a 3D point. In the dialog, you select which layers to check. When you pick OK, the program checks all linework on those layers and sets their elevations to zero. The Track Linework Edits option checks when the linework is modified to make sure the elevations are zero. When this routine prints a message to the command line whenever it moves the linework elevation to zero.
3D Viewer/Model Library

This command manages a collection of 3D graphic files and defines how to render CAD entities in the 3D Viewer. The CAD to 3D Viewer settings define how to translate different types of selected CAD entities into the 3D Viewer. The Points tab associates a CAD block name with a 3D model. This way you can have a simple symbol when working in CAD that is rendered as a complex 3D model with viewing in the 3D Viewer. The Lines tab defines a 3D model to use for linework on a specified layer. For example, a polyline on a layer of FENCE in CAD can be assigned to render using a fence 3D model. Besides defining the layer and 3D model, there is also a setting for Gap which is the distance between the 3D models along the linework. The Area tab defines textures to apply to the surface model by closed CAD polylines on specified layers. You can have different textures using nested closed polylines on different layers and the texture for the inner polyline is used for that inner area. For example, you can have an outer polyline on a Parking layer for a texture of asphalt and inner polylines for parking lot islands on an Island layer for a texture of grass. The Colors tab applies to TIN surfaces that have colors assigned to the 3D faces. This settings map TIN colors to textures for rendering the TIN.
The Model Library button has the collection of 3D model files which can be assigned to CAD symbols in the Points tab of CAD to 3D Viewer. Also, these 3D Models can be added to the scene by using the Add Model function in commands such as 3D Drive Simulation.

The files are grouped by user-defined categories. The graphic files can be either .dxf, .mdl or .obj format. SketchUp .skp files can also be selected to add to the library. The program will convert these .skp files into .obj format. The SaveAs and Load functions allow you to save the model library to .mlib files for sharing or backup. The current model library data is stored in the Carlson USER folder in models.dta.
The Edit Symbol function brings up another dialog with edit functions. In the edit dialog, the program shows the dimensions of the model and the number of data points.

The Properties tab has controls for the lighting of the object and whether to smooth the 3D faces of the object.

The Rotation function sets the default rotation for when the object is inserted. The Random Rotate option makes the rotation random for each time the object is inserted which applies to objects like trees that are inserted multiple times and look better with different rotations.

The Scale function sets the initial insertion scale. Often a scale factor of 0.08333 is needed to convert a model in inches units into feet for inserting into a scene in feet units. The X/Y/Z axis can be scaled independently or uniformly. The scale can be set directly by factors or by entering the model dimensions which is handy for vehicle models when the dimensions of the vehicle are known.

The Translation settings control the insertion point of the model.

The Orientation setting for Force Vertical Orientation makes the model level when inserted into the scene which applies to objects like trees and buildings. Otherwise the models get inserted at the slope of the surface at their position which is good for objects like vehicles.

**Pulldown Menu Location:** Settings  
**Keyboard Commands:** modellib  
**Prerequisite:** None
Toolbars

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

- **Show**: Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.
- **Hide**: Turns off the selected toolbar. If the toolbars is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.
- **Exit**: Exits this command

**Prerequisite**: None

**Keyboard Command**: TBARCFG

Text Style

This command creates or modifies named styles and sets the current style for text in your drawing.

1. Under Style Name, you can display text style names, add new styles, and rename and delete existing styles. The list contains defined style names and displays the current style by default. To change the current style, select another style from the list, or choose New to create a new style.

- **New**: This option displays the New Text Style dialog box and automatically supplies the name "stylen" (where n is the number of the supplied style) for the current settings. You can accept the default or enter a name and choose OK to apply the current style settings to the new style name.

- **Rename**: This option displays the Rename Text Style dialog box. The text style listed is renamed when you enter a new name and choose OK.

- **Delete**: This option deletes a text style. Select a name from the list to make it current, and then choose Delete.
Under Font you can change the style's font.

- **Font Name**: This field lists the font family name for all registered TrueType fonts and all compiled shape (SHX) fonts in the TakeOff Fonts directory. When you select a name from the list, the program reads the file for the specified font. The file's character definitions are loaded automatically unless the file is already in use by another text style. You can define several styles that use the same font.

- **Font Style**: This field specifies font character formatting, such as italic, bold, or regular. When Use Big Font is selected, this option changes to Big Font Name and is used to select a Big Font file name.

- **Height**: This field sets the text height based on the value you enter. If you enter 0.0, the program prompts for the text height each time you enter text using this style. Entering a height greater than 0.0 sets the text height for this style. TrueType fonts can be displayed at a smaller height than SHX fonts with the same height setting. The text height you specify may not be accurately represented by uppercase letters in TrueType fonts supplied with TakeOff.

- **Use Big Font**: This option specifies an Asian-language Big Font file. Use Big Font is available only if you specify an SHX file under Font Name. Only SHX files are valid file types for creating Big Fonts.

Under Effects, you modify characteristics of the font, such as its height, width factor, and obliquing angle and whether it is displayed upside down, backwards, or vertically aligned. TrueType fonts using the effects described in this section might appear bold on the screen. Onscreen appearance has no effect on plotted output. Fonts are plotted as specified by applied character formatting.

- **Upside Down**: This option displays the characters upside down.

- **Backwards**: This option displays the characters backwards.

- **Vertical**: This option displays the characters aligned vertically. Vertical is available only if the selected font supports dual orientation. Vertical orientation is not available for TrueType fonts.

- **Width Factor**: This option sets the character spacing. Entering a value less than 1.0 condenses the text. Entering a value greater than 1.0 expands it.

- **Oblique Angle**: This option sets the obliquing angle of the text. Entering a value between -85 and 85 makes the text oblique.

Under Preview, you can display sample text that changes dynamically as you change fonts and modify the effects. To change the sample text, enter characters in the box below the character preview image.

- **Preview**: This field updates the sample text in the character preview image according to any changes you've made in the dialog box. Height has no effect in the character preview image because a very large text height might show little or no text.

**Prerequisite**: None

**Keyboard Command**: STYLE

### Units Control

The Drawing Units dialog box controls coordinate and angle display formats and determines precision.
1 Under Length, you specify the current unit of measurement and the precision for the current units.

- **Type**: This field sets the current format for units of measure. The values include Architectural, Decimal, Engineering, Fractional, and Scientific. The Engineering and Architectural formats produce feet-and-inches displays and assume that each drawing unit represents one inch. The other formats can represent any real-world unit.

- **Precision**: This field sets the number of decimal places for the current units display.

2 Under Angle you specify the current angle format and the precision for the current angle display.

- **Type**: This field sets the current angle format.

- **Precision**: This field sets the precision for the current angle display.

TakeOff uses the following conventions for the various angle measures: decimal degrees appear as decimal numbers, grads appear with a lowercase g suffix, and radians appear with a lowercase r suffix. The degrees/minutes/seconds format uses d for degrees, ' for minutes, and " for seconds, for example:

123d45'56.7"  

Surveyor's units show angles as bearings, using N or S for north or south, degrees/minutes/seconds for how far east or west the angle is from direct north or south, and E or W for east or west, for example:

N 45d0'0" E

The angle is always less than 90 degrees and is displayed in the degrees/minutes/seconds format. If the angle is precisely north, south, east, or west, only the single letter representing the compass point is displayed.

- **Clockwise**: This option calculates positive angles in the clockwise direction. The default direction for positive angles is counterclockwise.

When the program prompts for an angle, you can point in the desired direction or enter an angle regardless of the setting specified for Clockwise.

3 Under Drawing Units for TakeOff DesignCenter blocks, you can control the unit of measurement used for block insertions. A block created in units that differ from the units specified in this option is scaled and inserted in the specified units. Select Unitless to insert the block as is and not scale the block to match the specified units. Source content units and Target drawing units settings in the User Preferences tab of the Options dialog box under the Settings menu are used when Insert Units are not defined.

4 Sample Output displays an example of the current settings for units and angles.

Direction displays the Direction Control dialog box described below.
A The Base Angle determines where 0 degrees is located when the program calculates angles. The base angle sets the direction of the base angle. These options affect the entry of angles, object rotation angles, the display format, and the entry of polar, cylindrical, and spherical coordinates. Choose East, North, West, or South, or choose Other to indicate an alternative direction. The default direction for the zero angle is East. In TakeOff, the base angle is relative to the orientation of the user coordinate system.

- **East**: Sets the base angle to east (default is zero degrees).
- **North**: Sets the base angle to 90 degrees north.
- **West**: Sets the base angle to 180 degrees west.
- **South**: Sets the base angle to 270 degrees south.
- **Other**: Sets a direction different from the points of the compass.
- **Angle**: Sets the angle. Available only when Other is selected.
- **Pick an Angle**: Uses the pointing device to define the angle based on the angle of an imaginary line connecting any two points you specify. Available only when Other is selected.

**Prerequisite**: None

**Keyboard Command**: UNITS

**Object Snap**

The Drafting Settings dialog box sets object snap modes.
1 Under Object Snap, you set object snaps.

- **Object Snap On**: This option turns running object snaps on and off. The object snaps selected under Object Snap Modes are active while object snap is on. This setting is also controlled by the OSMODE system variable.

- **Object Snap Tracking On**: This option turns object snap tracking on and off. With object snap tracking the cursor can track along alignment paths based on other object snap points when specifying points in a command. To use object snap tracking, you must turn on one or more object snaps.

2 Under Object Snap Modes, you turn on running object snaps.

- **Endpoint**: Snaps to the closest endpoint of an arc, elliptical arc, line, multiline, polyline segment, spline, region, or ray or to the closest corner of a trace, solid, or 3D face.

- **Midpoint**: Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multiline, polyline segment, solid, spline, or xline.

- **Center**: Snaps to the center of an arc, circle, ellipse, or elliptical arc.

- **Node**: Snaps to a point object.

- **Quadrant**: Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.
• **Intersection**: Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline. Intersection snaps to the edges of regions and curves, but does not snap to the edges or corners of 3D solids. Extended Intersection snaps to the imaginary intersection of two objects that would intersect if the objects were extended along their natural paths. Carlson TakeOff automatically turns on Extended Intersection when you select the Intersection object snap mode. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Intersection and Extended Intersection work with edges of regions and curves, but not with edges or corners of 3D solids.

- **Extension**: Causes a temporary extension line to display when you pass the cursor over the endpoint of objects, so you can draw objects to and from points on the extension line.
- **Insertion**: Snaps to the insertion point of an attribute, a block, a shape, or text.
- **Perpendicular**: Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, solid, spline, or xline. Carlson TakeOff automatically turns on Deferred Perpendicular snap mode when the object you are drawing requires you to complete more than one perpendicular snap. You can use a line, arc, circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular lines between such objects. When the aperture box passes over a Deferred Perpendicular snap point, the program displays a Snaptip and marker.

- **Tangent**: Snaps to the tangent of an arc, circle, ellipse, or elliptical arc. Carlson TakeOff automatically turns on Deferred Tangent snap mode when the object you are drawing requires you to complete more than one tangent snap. For example, you can use Deferred Tangent to draw a line that is tangent to two arcs, polyline arcs, or circles. When the aperture box passes over a Deferred Tangent snap point, the program displays a marker and Snaptip. If you use the From option in conjunction with the Tangent snap mode to draw objects other than lines from arcs or circles, the first point drawn is tangent to the arc or circle in relation to the last point selected in the drawing area.

- **Nearest**: Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multilime, point, polyline, spline, or xline.
- **Apparent Intersection**: Apparent Intersection includes two separate snap modes: Apparent Intersection and Extended Apparent Intersection. You can also locate Intersection and Extended Intersection snap points while running Apparent Intersection object snap mode is on. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multilime, polyline, ray, spline, or xline) that do not intersect in 3D space but may appear to intersect in the drawing display. Extended Apparent Intersection snaps to the imaginary intersection of two objects that would appear to intersect if the objects were extended along their natural paths. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Apparent and Extended Apparent Intersection work with edges of regions and curves but not with edges or corners of 3D solids.

- **Parallel**: Draws a vector parallel to another object whenever Carlson TakeOff prompts you for the second point of a vector. After specifying the first point of a vector, if you move the cursor over a straight line segment of another
object, the program acquires the point. When the path of the object you create is parallel to the line segment, the program displays an alignment path, which you can use to create the parallel object.

- **Clear All**: This option turns off all object snap modes.
- **Select All**: This option turns on all object snap modes.

**Prerequisite**: None

**Keyboard Command**: OSNAP

### Set/Reset X-Hairs

*Set X-Hairs* sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. *Reset X-Hairs* restores the crosshairs alignment to horizontal.

**Pulldown Menu Location**: Settings > Crosshairs

**Keyboard Commands**: setxhairs, resetxhairs

**Prerequisite**: Line entity

### Set UCS to World

This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson TakeOff works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

**Prerequisite**: None

**Keyboard Command**: UCS_WORLD

### Set Environment Variables

The AutoCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.
1 Dialog Fields

- **List Box**: Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- **Edit Field**: When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.

- **Description**: When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

2 Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

- **Integer**: Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.
- **Real**: Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.
- **String**: Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.
- **2D Point**: Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.
- **3D Point**: Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must be used, separating the X and Y and Z values.

3 Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

4 Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.

- **Not Stored**: Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.
- **In Drawing**: Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.
- **In Config**: These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

5 Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

- **Read Only**: Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.
- **Read/Write**: Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

6 Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.
• **Off (0):** Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.

• **On (1):** Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.

7 Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each button's purpose is explained below.

• **OK:** Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.

• **Cancel:** Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.

• **Load:** Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.

• **Save:** Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.

• **Print:** Used to print the current system variables. After choosing this option, you will be prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited, and printed.

8 Variable Buttons - These buttons are used to control the changes in variables while using the Variable Editor. Each button's purpose is explained below.

• **Change:** Used to execute the changes typed into the edit field. You must use this button, simply pressing enter will not make the change.

• **Restore:** Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.

• **Status:** Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also, if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in Chapter 18, which contains a list of supported system variables. Modification of any system variable other than the supported ones found in Chapter 18 is done at your own risk, and may result in program errors requiring a re-installation of Carlson TakeOff.

**Prerequisite:** None

**Keyboard Command:** VAREDIT
Display Menu

The Display menu commands are quick controls for the drawing view.

[Diagram of Display Menu]

- Existing Drawing
- Existing Contours
- Existing Surface
- Design Drawing
- Design Contours
- Design Surface
- Cut/Fill Contours
- Cut/Fill Labels
- Cut/Fill Color Map
- Other Drawing
- Display Options
**Existing Drawing**

This command allows you to display all the entities on the layers that are grouped as part of the Existing Drawing.

Carlson TakeOff allows you to assign layers into three different "Target" surface groups: Existing, Design, and Other. For more about assigning layers to different "Target" surface groups see Define Layer Target/Material/Subgrade under the tools menu. Once layers have been assigned, the display menu allows for easy viewing of each "Target" surface. When Existing Drawing is checked than the existing drawing will be displayed. If it is not checked it will not be displayed. You can check on and off the other "Target" surfaces to view the existing drawing in isolation or in accordance to the other drawings.

**Keyboard Command:** set_display_exist_dwg  
**Prerequisite:** Define Layer Target/Material/Subgrade

---

**Existing Contours**

This command displays all the contours that represent the existing surface (For contouring options see Display Options). Clicking on Cut/Fill Labels from the menu runs the command and puts a check mark on the menu. Picking again turns it off.
When Existing Contours is checked than all the contours for the existing surface will be displayed. If it is not checked they will not be displayed.

**Prerequisite:** existing surface  
**Keyboard Command:** set_display_exist_ctr

### Existing Surface

This command allows you to display the surface triangulation for the existing drawing.

When Existing Surface is checked than all the triangulation for the existing will be displayed. If it is not checked, they will not be displayed.

**Keyboard Command:** set_display_exist_grd  
**Prerequisite:** an existing surface

### Design Drawing

This command allows you to display all the entitles on the layers that are grouped as part of the Design Drawing.
Carlson TakeOff allows you to assign layers into three different "Target" surface groups: Existing, Design, and Other. For more about assigning layers to different "Target" surface groups see Define Layer Target/Material/Subgrade under the tools menu. Once layers have been assigned, the display menu allows for easy viewing of each "Target" surface. When Design Drawing is checked than the design drawing will be displayed. If it is not checked it will not be displayed. You can check on and off the other "Target" surfaces to view the Design drawing in isolation or in accordance to the other drawings.

**Keyboard Command:** set_display_final_dwg  
**Prerequisite:** Define Layer Target/Material/Subgrade

### Design Contours

This command displays all the contours that represents the design surface (For contouring options see Display Options). Clicking on Cut/Fill Labels from the menu runs the command and puts a check mark on the menu. Picking again turns it off.

When Design Contours is checked than all the contours for the design will be displayed. If it is not checked they will not be displayed.

**Keyboard Command:** set_display_final_ctr
Prerequisite: design surface

**Design Surface**

This command allows you to display the surface triangulation for the design drawing.

When Design Surface is checked than all the triangulation for the design will be displayed. If it is not checked, they will not be displayed.

**Keyboard Command:** set_display_final_grd  
**Prerequisite:** a design surface

**Cut/Fill Contours**

This command compares the existing and design surfaces and shows the cut/fill contours in blue for fill and red for cut. There is a Draw Only Cut/Fill Daylight option and Draw Labels option as part of the Display Options command (See Display Options for more information). Clicking on Cut/Fill Contours from the menu runs the command and puts a check mark on the menu. Picking again turns it off.
Keyboard Command: set_display_cf_ctr
Prerequisite: elevation differences between existing and design

Cut/Fill Labels

This command displays the design elevation, the existing elevation, and the amount to either cut or fill right on the screen (See Display Options for information about labeling options). Picking on Cut/Fill Labels from the menu runs the command and puts a check mark on the menu. Picking again turns it off.
**Cut/Fill Color Map**

This command compares the existing and design surfaces and shows the cut/fill regions in blue for fill and red for cut (See Display Options for information on pixel resolution). Clicking on Cut/Fill Color Map from the menu runs the command and puts a check mark on the menu. Picking again turns it off.

**Other Drawing**

This command allows you to display all the entities on the layers that are grouped as part of the Other drawing.
Carlson TakeOff allows you to assign layers into three different "Target" surface groups: Existing, Design, and Other. For more about assigning layers to different "Target" surface groups see Define Layer Target/Material/Subgrade under the tools menu. Once layers have been assigned, the display menu allows for easy viewing of each "Target" surface. Typically, most layers are listed under Other before they are assigned to Existing or Design. Some layers, like perimeter, are neither apart of the Existing or the Design drawing so they remain under Other. When Other Drawing is checked than the entities grouped under Other will be displayed. If it is not checked it will not be displayed. You can check on and off the other "Target" surfaces to view the Other surface in isolation or in accordance to the other surfaces. In this example, Existing, Design, and Other are all shown.

**Keyboard Command:** set_display_other_dwg  
**Prerequisite:** Define Layer Target/Material/Subgrade

### Display Options

This command allows you to change the features of the different display commands. Note: You can toggle on/off the Existing, Design, and Other surfaces by right clicking with your mouse. To activate this feature type in "shortcutmenu" in the command line and then <1>. To turn off the feature type in <0>.
**Display Setup:** Here is the master list for the major things you can display, including: the Entities, Contours, and Surface for both the Existing and Design, Cut/Fill Displays, and Other Drawing Entities.

**Contour Options:** Here you can set the interval, the elevation difference between each contour, for the Existing, Design and Cut/Fill by clicking on their Contour Settings. You can also choose to draw only the daylight line between Existing and Design instead of the Cut/Fill contours at an interval.
**Draw Contours**

When this box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

**Contour by Interval or Contour an Elevation**

Select whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

**Contour Interval**

Specify the interval to contour. Note: If the above option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

**Minimum Contour Length**

Contour lines whose total length is less than this value will not be drawn.

**Reduce Vertices**

This option attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is ON

**Offset Distance**

When the Reduce Vertices option is enabled, This value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

**Hatch Zones**

When activated, this option will allow you to hatch the area between the contours sequentially. A secondary dialog will load allowing the user to specify the hatch type and color.

**Draw Index Contours**
This option creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

**Contour Smoothing Method**

Select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

**Bezier Smoothing Factor**

The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect.

**Subdivisional Surfaces / Subdivisions Generation**

This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance's sake, consider enabling Reduce Vertices.

**Label Tab**

![Image of Label Tab](image_url)

**Label Contours**

When activated, contours will be labeled based on the settings below.

**Label Layer**
Specifies layer name for intermediate contour labels.

**Index Label Layer**
Specifies layer name for index contour labels.

**Label Style**
Specifies the text style that will be used for the contour label text.

**Label Text Size Scaler**
Specifies the size of the contour labels based on a multiplier of the horizontal scale.

**Min Length to Label**
Contours whose length is less than this value will not be labeled.

**Break Contours at Label**
When checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

**Draw Broken Segments**
When checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

**Label Contour Ends**
When checked, contour ends will be labeled.

**Draw Box Around Text**
When checked, a rectangle will be drawn around contour elevation labels.

**Label Index Contours Only**
When checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

**Hide Drawing Under Labels**
This option activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour is fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels, and the contour lines themselves remain contiguous. This feature will also hide other entities that area in the immediate vicinity of the contour label.

**Align Text with Contour**
When checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

**Align Facing Uphill**
When checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the bottom of the text label will always be toward the downhill side of the contours. So as the labels are read right side up, you are always facing uphill.

**Internal Label Intervals**
Choose between label intervals or distance interval. Label intervals will label each contour with a set number of labels. Distance interval lets you specify a distance between labels.

**Cut/Fill Label Options:** Here you can customize the Cut/Fill labels. Text can be added either before or after the Cut/Fill amount, the Existing elevation, and the Design elevation with the Prefix and Suffix fields. You can also choose whether or not to display the Existing Surface elevations, the Design Surface elevations and Strata Cut Thickness. The colors for the Cut, Fill, Existing Elevation, and Design Elevation text are all customizable. Carlson TakeOff gives you the option to draw a marker symbol for where each label represents. You can also hide the drawing under the labels so that you can read the labels clearly. Text Size chooses the text size for each line of the label. Text Style allows you change the Font Style displayed in the labels. Decimal Places sets to how many decimal places the labels will report. The Spacing of the labels can be determined by intervals or by a selected number of spaces. The size of each space is determined by the Text Size.
**Cut/Fill Color Map Options:** Number Of Subdivision Rows is the number of blocks both horizontally and vertically in the Color Map. If the box reads 100 that means 100 blocks left to right and 100 blocks up and down or 10,000 total pixels. A higher the Number Of Subdivision Rows will make the Color Map sharper, however too high number can cause Carlson TakeOff to run slower. Auto Set Range will automatically set the red to blue scale for your cut/fill levels. However, if you desire greater contrast, then use Max Cut/Fill Range to manual set the range. Use lower numbers for greater contrast. There are several coloring schemes with different Cut-Daylight-Fill colors. For example, the Red-White-Blue scheme means red for cut, white for daylight and blue for fill.

**Keyboard Command:** tk_display_options  
**Prerequisite:** a drawing
Project Checklist

This command allows to check the status of steps needed to calculate total volumes.

![Project Checklist](image)

**Prerequisite:** none  
**Keyboard Command:** tk_checklist

---

**Training Movies**

This command opens an application that lets you choose from several training movies. The movies provide instruction for all aspects of Carlson TakeOff.

**Prerequisite:** None  
**Keyboard Command:** RUN_MOVIES

---

**On-Line Help**

This command opens the Carlson TakeOff on-line Help File.

**Prerequisite:** None  
**Keyboard Command:** [F1] or HELP

---

**Carlson WebSite**

This command brings you to the Carlson Home webpage.

**Prerequisite:** an internet connection  
**Keyboard Command:** .\_browser Enter Web location (URL) <http://www.carlsonsw.com>:"http://www.carlsonsw.com/"

---

**About Carlson Takeoff**

Displays the Carlson TakeOff version number, serial number, license information, and copyright information. You can run the registration wizard by clicking the Change Registration button on this dialog.

**Prerequisite:** None  
**Keyboard Command:** ABOUT_SCAD
Takeoff Tutorial: CAD File Takeoff From Start To Finish

Note: Completing these tutorials will alter the drawing files (demo1.dwg, demo2.dwg, demo3.dwg). If you would like to run through the tutorials a second time, copy over the original drawing files (.dwg) into a new folder under C:\Carlson Projects.

**Step 1 (Start Takeoff):**

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog and if so, click Exit.

**Step 2 (Open Drawing):**

From the File menu, choose Open and select demo1.dwg from the Carlson Projects folder.

Now we can begin to process this drawing. The main Takeoff commands are listed in processing sequence in the Takeoff pull-down menu. Many of these commands are also grouped as icons in the toolbar shown here.
Step 3 (Drawing Cleanup):

From the Takeoff pull-down menu, choose Drawing Cleanup. Typically, drawings have lots of drafting fixes that must be done before the surfaces can be modeled. This command will apply the selected cleanup functions on the drawing to help automate the cleanup. Here's a brief description of the most important of these functions:

**Remove Layers With No Entities:** Drawings often have lots of layers. This routine removes layers that have no entities in the drawing so that we don't have to deal with them.

**Join Linework With Same Endpoints:** This routine will take linework that is broken into multiple segments and join them into a single linework entity. For example, it will join together broken segments of a contour polyline into a single polyline.

**Reduce Polyline Vertices:** This routine removes extra vertices from polylines as long as the removing does not shift the polyline more than the specified Offset Cutoff. This will reduce the size and complexity of the drawing.

**Set Elevation Outside Range To Zero:** In case the drawing contains entities that are outside the range of valid elevations for the site, this routine will set them to zero elevation. The program treats zero elevations as "no elevation" and modeling will filter out these zero elevation entities.

For this site, the elevations are around 800. So let's set the Min elevation to 500 and the Max elevation to 1000. The cleanup will set any entities outside this elevation range to zero. With other Takeoff functions, we can later assign proper elevations to any of these zero elevation entities that need to be used in modeling.
Once the Drawing Cleanup options are set as shown, pick OK. When the cleanup is done, the program will show a report of the cleanup results. Pick the Exit button to exit the report viewer.

Step 4 (Layer Targets):

From the Takeoff menu, choose Define Layer Surface/Material/Subgrade. Every entity (line, polyline, point, etc) in the drawing is assigned a layer name. Takeoff uses the entity layer names to define which entities are for the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. The drawing entities are assigned their target surface by their layer name. For example, if polylines representing design contours are on the layer "Final", then "Final" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other.

The Define Layer Targets dialog has three lists of layers: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog.

In this drawing, all the contours are for the existing ground surface. In the layer list, all the layers that start with
INDEX and INTER are for these contours. So highlight these layers and then choose Move To Existing. To highlight multiple layers at a time, hold down the keyboard Ctrl key while picking with the mouse.

Next move the layer names that start with "PR" (for proposed) to the Design surface by highlighting these layers and choosing Move To Design. Also move the layer "PAD" to design.

Next pick the Save button to save our changes and then pick Exit.

There are more tools for assigning layer targets. In the Display menu, you can turn on/off whether to display layer targets by using Existing Drawing, Design Drawing and Other Drawing. For example, when Design Drawing is checked, then picking this menu item will uncheck it and turn off all the layers for the design surface. Likewise, picking Design Drawing when it is unchecked will make it checked and turn on the design surface layers.

Practice turning on/off the Existing, Design and Other Drawing in the Display menu. When only Existing Drawing is on, you should see just the contours. When only Design Drawing is on, you should see just the design polylines and leader labels. When only Other Drawing is on, you should see the entities that are assigned to neither existing nor design.

Some of these layers we do want to assign to existing and design. To better see the entities, zoom in on them using
the View->Zoom->Window command and pick two points that make a window around the entities as shown. Once zoomed in, you can see a text label of "818.70 PAD" which is for the design surface. Labels "817.00", "818.00" and "819.00" are contour labels for the existing contours.

There are a few commands in the Inquiry menu to find out the layer names for these entities: List, Layer ID and Drawing Inspector. Let's run the Layer ID command and pick the "818.70 PAD" label. At the Command line, it reports this layer is "—-TX07". Next pick the "818.00" label and it reports this layer is "TEXTS". Now go up to the Takeoff Menu->Set Layer For Design and pick on label for the Building Pad. You will notice that if Design Drawing was checked off under Display, the Pad label will turn off. This is because the layer "—-TX07" is now apart of the Design Drawing. Go to the Takeoff Menu again and this time pick Set Layer For Existing and select the "TEXTS" layer. Press Enter, this will put the "TEXTS" layer on Existing.

Next run Define Layer/Material/Subgrade and you will notice that "—-TX07" is now under Design and "TEXTS" is under Existing. Check that your Layer Targets match the three lists shown below. Then pick Save and Exit.
## Define Layer Targets

### Existing | Design | Other | Report Depth

<table>
<thead>
<tr>
<th>Layer</th>
<th>Report Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>INDEX_CONTOUR</td>
<td>NO</td>
</tr>
<tr>
<td>INDEX_DEP</td>
<td>NO</td>
</tr>
<tr>
<td>INDEX_LABEL</td>
<td>NO</td>
</tr>
<tr>
<td>INTER_CONTOUR</td>
<td>NO</td>
</tr>
<tr>
<td>INTER_DEP</td>
<td>NO</td>
</tr>
<tr>
<td>TEXTS</td>
<td>NO</td>
</tr>
</tbody>
</table>

### Move To | Other | Edit

- Add Target
- Remove Target
- Save
- Save As
- Load
- Help
- Exit

## Define Layer Targets

### Existing | Design | Other | Report Depth

<table>
<thead>
<tr>
<th>Layer</th>
<th>Report Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>----TX07</td>
<td>NO</td>
</tr>
<tr>
<td>PLD</td>
<td>NO</td>
</tr>
<tr>
<td>PR-ELEV</td>
<td>NO</td>
</tr>
<tr>
<td>PR-PC-CURR</td>
<td>NO</td>
</tr>
<tr>
<td>PRGUTTER</td>
<td>NO</td>
</tr>
<tr>
<td>PRGUTTERFL</td>
<td>NO</td>
</tr>
<tr>
<td>PRGUTTERFLTR</td>
<td>NO</td>
</tr>
<tr>
<td>PRGUTTERFL</td>
<td>NO</td>
</tr>
</tbody>
</table>

### Move To | Other | Edit

- Add Target
- Remove Target
- Save
- Save As
- Load
- Help
- Exit

---

*Chapter 19. Tutorials Menu*
Step 5 (Define Material/SubGrade):

Besides assigning target surfaces by layer, layers are also used to define material names and subgrades depths. By assigning material names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface. The polylines used for subgrade depth must be closed polylines. Takeoff supports nested subgrade polylines for exclusion areas such as islands by counting how many subgrade polylines surround an area. If the number is odd, then the area is inside the subgrade. Otherwise the area is not part of the subgrade.

First, we need to know the layer names for our subgrades. Go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Then run Inquiry->Layer ID and pick the large pad polyline. It reports that this layer is PAD. Next use Layer ID to pick the curb polyline. It reports that this layer is PR-FC-CURB.

Next we need to make sure that these polylines are closed. In this example, the outside curb polyline is open at the top. To close the polylines, run Edit->Polyline Utilities->Edit Polyline->Close Polylines or pick on the Toolbar icon . Then pick each of the pad and curb polylines and press Enter when done selecting. Here are the Command line prompts:

Select Polylines to set closed.
Select objects: 1 found
Select objects: 1 found, 2 total
Select objects: 1 found, 3 total
Select objects: 1 found, 4 total
Select objects: 1 found, 5 total
Select objects: 1 found, 6 total
Select objects: (Press Enter)
5 polylines already closed.
Closed 1 polylines.

Now run Define Layer Surface/Material/Subgrade and pick the Design tab. Highlight layer PAD and pick the Edit Layer button. A dialog appears for defining the pad material properties. Check on the Include In Material Quantities Report option, enter the Material Name as "Pad", set the first subgrade name to "Pad", and set the Depth as 1. Once the dialog is filled out as shown, pick OK.

![Edit Material Dialog](image)

Next pick layer PR-FC-CURB and choose Edit. In the Edit Materials dialog, check on Include In Material Report, set the Material Name to "Pavement", set the first subgrade name to "Pavement", and set the Depth to 1.5. Then pick OK.

<> To save the subgrade changes, pick the Save button on the Define Layer Targets dialog. Then choose Exit.

Now let's visually verify the subgrade areas. In the Takeoff menu, run Subgrade Areas->Hatch Subgrade Areas. There is a dialog to select which subgrade to hatch. Choose the Pavement. Then there is a dialog for the hatch pattern and color. Click OK. Then run Hatch Subgrade Areas again. This time choose Pad and set the hatch pattern to Hex with green color. The resulting hatch areas show where the subgrade is applied. Notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. Also note that the smaller pad area is not hatched because this polyline layer is different than the bigger pad polyline. When finished viewing the subgrade areas, run Takeoff->Subgrade Areas->Erase Subgrade Hatches.
Step 6 (Elevate Drawing - 2D to 3D):

Takeoff will model the existing ground and design surfaces based on points, lines and polylines with elevation. It is essential for these drawing entities to have correct elevations in order to get correct surface models. Often the provided drawings will have the drawing entities at elevation of zero with text labels indicating the true elevation. Takeoff has many tools for assigning elevations to these entities.

<>To help visualize which entities need to be assigned elevation, Takeoff will color entities at zero elevation in grey. As entities get assigned elevation, they return to their original color. This elevation coloring is applied to layers that have been assigned to the existing or design surfaces.

Let's start by working on the existing surface. To isolate the existing entities, go to the Display menu and check on Existing Drawing, uncheck Design Drawing and uncheck Other Drawing. In the Inquiry menu, there are commands for checking elevations. To check the elevation of the contour polyliners, run the Inquiry->List Elevation and pick a contour polyline At the command line, it reports the elevation.

Select Entity: pick pad polyline
Elevation: 816.0000
Select Entity (Enter to end): press Enter

In this example, the existing ground surface is defined by just contour polyliners and these polyliners already have elevation. So there are no changes needed for preparing the existing surface entities. If the contour polyliners were at zero elevation, then you could use the Elevate->Assign Contour Elevation commands.

Next let's prepare the design surface. To isolate the design entities, go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Notice that all the design linework is greyed because it is at zero elevation. Run the List Elevation command and pick the main pad polyline. At the command line, it confirms that the elevation is 0.

To set the pad polyline elevation, run Elevate->Set Polyline To Elevation. Enter an elevation of 818.7 (based on the text label). At the Select objects prompt, pick the bigger pad polyline and press Enter.

New Elevation <0.0000>: 818.7
Select Lines, Arcs, Circles or Polylines for elevation change.

Select objects: (pick the pad polyline) 1 found

Select objects: press Enter

LWPOLYLINE

Number of entities changed> 1

Next let's set the elevation of the smaller pad under the main pad. First, use View->Zoom->Window to zoom in around the smaller pad so that we can read the text label. The label of "17.56" is short for 817.56. In this example, the 800 was dropped from many of the elevation labels to save on label clutter. Run Set Polyline To Elevation again. This time enter an elevation of 817.56 and pick the smaller pad polyline. Then run View->Zoom->Previous to get back to the full view of the site.

Finally, we need to set the elevations for the curb polylines. First, use View->Zoom->Window to zoom in around some of the curb labels below the smaller pad. Then run Elevate->2D to 3D Polyline->Text With Leader. This command will assign the elevations from the labels to the polylines by following the label leader to find the position on the polyline. For polyline vertices without elevation labels, the elevations will be interpolated from the other labels. Before processing, this routine prompts for samples of the elevation label, the leader and the polylines to convert. Then you can select all the entities in the drawing and the routine will sort the labels, leaders and polyline by the sample layers and assign the elevations. For this example, pick one of the labels with a "TC" suffix as the elevation text sample. Then pick the leader line for the annotation leader sample. Then pick the curb polyline for the polyline to convert sample. At the Select objects prompt for processing, type "all" to select all the drawing entities and press Enter. For the elevation to add, enter 800 so that labels like "17.81" get assigned as 817.81.
Next a dialog appears for selecting which labels names to use. When Takeoff detects different text labels within the elevation labels, you need to choose which ones to process. In this case, we only want the labels with "TC". So highlight TC, pick Add and then pick OK.

Select sample of elevation text: pick label
Select sample of an annotation leader: pick leader line
Select sample of a polyline to convert: pick curb polyline
Select polylines to convert, leaders and elevation labels to process.
Select objects: all
Select objects: press Enter
Joining adjacent polylines...
Reading the selection set ...
Enter elevation to add to label values <0.00>: 800
Pre-processing entity #420 of 420
Processing leader #141
Remaking polyline #4
All the curb polylines now have elevations.
<>Now run View->Zoom->Previous to return to the full site view. The design polylines should now have colors because the elevations are assigned.

**Step 7 (Boundary Polyline):**

The limits of the site are defined by a closed polyline. This polyline is used as the boundary for the models and the volumes. In this example, there is a closed polyline on the PERIMETER layer. The layer target for this layer is Other. Go to the Display menu and check on Other Drawing so that the perimeter is displayed. Then run Takeoff->Boundary Polyline->Set Boundary Polyline and pick the perimeter polyline. This selected polyline is now set as the boundary polyline for the rest of the Takeoff routines.

![Boundary Polyline](image)

**Step 8 (Model Existing and Design Surfaces):**

To calculate volumes, Takeoff needs two surfaces: existing ground and design. These surfaces are modeled by triangulation. With the preparation of the previous steps, we're now ready to make the models. The drawing entities have been cleaned up, assigned elevations and assigned target surfaces by layer. Making the models is now a one step process. To make the existing ground surface, run Takeoff->Make Existing Ground Surface. The program
will process the entities and make the triangulation surface. Then to make the design surface, run Takeoff->Make Design Surface.

**Step 9 (3D Drive Simulation):**

As a visual check that the design surface modeled correctly, let's run the View->3D Views->3D Drive Simulation command. This routine shows a 3D view of the site and allows you to drive around. This is a good way to check that the surface modeled correctly. We want to make sure that there are no elevation spikes and that the subgrade depths are modeled. To drive the site, choose a View Direction, View Position and Vehicle. Then pick the Run button and use the arrow keys to turn. Pick the Stop button to pause the moving. You can also try the Surface Shading options for different views of the surface. When done with the 3D Drive Simulation, pick the Exit button (Arrow with door image).

![3D Drive Simulation](image)

**Step 10 (Cut/Fill Color Map):**

Cut/Fill color maps can be used for a visual output of the site cut/fill areas and also serves as another check that the models are correct. In the Display menu, choose Cut/Fill Color Map. Cut areas are drawn in different shades of red for different depths of cut while fill areas are drawn in blue. To change the resolution of the color blocks, run Display->Display Options and change the Cut/Fill Color Map Subdivisions. This parameter is the number of rows and columns of color blocks to create. To turn off the color map, go to the Display menu and pick Cut/Fill Color Map to uncheck it.
Step 11 (Calculate Volumes):

To calculate volumes, run the Takeoff->Calculate Total Volumes command. There is an options dialog for setting the cut swell factor and fill shrink factor. These values get multiplied into the cut/fill volumes. Set these factors as desired and click OK. Then the routine calculates the volumes and display the report which includes the cut/fill volumes and areas. The report can be printed or saved to a file. Pick the Exit button to exit the report viewer.
Step 12 (Material Quantities):

To report the quantities, run the Takeoff->Material Quantities->Standard Report routine. The report includes the count, length, area and volume for each type of material that was assigned for reporting in the Define Layer Target/Material/Subgrade command. The Material Quantities->Custom Report routine can be used to reporting these values with control of the report format and the option to export to Excel.

Takeoff Tutorial: Road Design with Volumes

This lesson takes a drawing file through the steps of road design.

Step 1 (Start Takeoff):

Click the Windows icon for Takeoff to launch the program. You may be presented with a "Startup Wizard" dialog and if so, click Exit.

Step 2 (Open Drawing):

From the File menu, choose Open and select DEMO2.dwg from the Carlson Projects folder (ie. C:\Carlson Projects\DEMO2.dwg).
Step 3 (Existing Ground Surface):

For the road cut/fill slopes to be created, it needs the existing ground surface to tie into. First we need to define the layers of the existing ground surface. Run Takeoff-> Set Layer For Existing, pick on both a light-lined and heavy-lined contour, a spot elevation, and press Enter. This will set the layers CTR, CTRINDEX, and TO-PREM-SPOT-PNT to the existing surface. The limits of the site are defined by a closed polyline. Run Takeoff->Boundary Polyline->Set Boundary Polyline and pick the thick polyline around the perimeter. This selected polyline is now set as the boundary polyline for the existing surface. To make the existing ground surface, run Takeoff->Make Existing Ground Surface.

Step 4 (Creating a Centerline):

Now we will use commands under the Roads menu.
Notice that the Roads menu is broken down into five sections: Centerline commands, Station/Offset commands, Profile commands, Section commands, and Template commands. A road needs design input from the Centerline, Profile and Template sections to be created. It does not matter in what order the commands are run, but in this example we will run the commands in descending order.

A centerline file is necessary for the final road design routine. We will do the simplest variation, which is picking a polyline. There are other methods to design a centerline, and they are documented in the manual. Go to Polyline to Centerline File in the first grouping of commands under Roads. A file selection dialog will appear. Enter a centerline file name of demo2.cl and pick save. Follow the prompting:

Select polyline that represents centerline:  *Pick the polyline that crosses the middle of the site with the layer name CLINE.*

Centerline station [Reverse/Ending/<Beginning: 0+00>]:  *press Enter*

Your Command Line should have the same values as these, as they are from the same line. Hit the F2 key or press Enter to return to the main screen.

**Step 5 (Input-Edit Profile):**

In this routine we will create a Profile file. There are different ways to define a road profile. In this case we will enter values from a given design. Go to Roads-> Input-Edit Profile File, create a new file, and name it Roaddemo. The Input-Edit Profile window will be displayed. Under Type of Profile select Road from the dialog box. In the spreadsheet, you can add design features for the Profile of the road. In this example, enter in the stations 0.0, 1500.0, and 3755.0, with elevations of 2030, 2005, and 2040. Next, set the Vertical Curve for the middle station at 300.0.
The Slope Percentages and the Sight Distances are automatically computed for you. Select Save and Exit.

**Step 6 (Quick Sections):**

Now we will create the cross section file (*.SCT). The cross sections define the existing ground for the road to tie into. Run Roads->Quick Sections. You will be prompted to load a centerline file or to pick a polyline from the screen. Type C for Centerline and select the demo2.cl file we created earlier. Next, fill the dialog as shown, and click OK. Your Offsets should be far enough away to tie in the Cut/Fill slopes.
Your section file is now created, your Command line should read as follows:

Command: quickscct

Pick starting point (CL-Centerline,P-Polyline): c

Polyline should have been drawn in direction of increasing stations.
Loading edges...
Loaded 4244 points and 12207 edges
Created 7964 triangles

Writing section C:\Takeoff_2004\demo2a-og.sct

**Step 7 (Design Template):**

Let's design a wide boulevard with curb and gutter on the outside. The cut slope will be 2:1. In fill, the condition will be 3:1 in all fill under 6' and 2:1 in all fill over 6' in depth. Pavement depths will be 4" of asphalt.

First, select Design Template under Roads, name the .TPL file demo2, and open it. A dialog appears where you enter segments of the template. We will enter a symmetrical template, with 13.5' pavement sections on either side of the centerline, connecting to a 2' curb and gutter, with 18" of gutter and 6" of curb. Then we'll add a 6' shoulder.

For the lanes, click the Grades Icon.
The above 'child' dialog is shown, enter in: Slope: -2, Horizontal Distance: 13.5, and ID: EP. Click OK. You'll note that the lanes draw in the little preview window.

Click on the Curb Icon. Fill out as shown below and click OK.

Next up, we will add a shoulder, going uphill at 4% for 8'. Click on Grades again and enter in a slope of 4, a Horizontal Distance of 8, and the ID as SH.

We are now finished with the surface and can set subgrade. Select the Subgrade icon, second from the right (yellow color). We will create an asphalt subgrade which will run straight out and hit the curb.
Complete as shown and click OK. Here’s what our template looks like so far:

Now we will add the outslope conditions. They are done with the Cut and Fill icons. Click on Fill and make three entries: under LEFT Slope enter in 3 (for 3:1), under Depth enter 6 (up to 6'), then again under LEFT Slope enter in 2 (for 2:1 over 6'). Select OK and click the icon for Cut. Just one entry here: under LEFT Slope enter in 2 (for 2:1 normal cut). Click OK.
Now click Save. The template is complete.

**Step 8 (Process Road Design):**

This is the routine that weaves everything together. Select Process Road Design, the last command in the Roads menu. The Specify Input Files column on the left allows you to choose the files to be used in the road design. We have already created the four needed files, go ahead and select them now and then click OK.
In the next dialog you can select different output features. For 3D viewing in the next step, toggle on Triangulate & Contour. It can be found in the bottom left portion of the Additional Earth Works Parameters dialog. Click OK. Note: To generate a plot of road sections, specify an output section file in the 1st Road Design dialog. Then run Draw Sections in the Roads menu.

The following report listing the total Cut, Fill, Subgrade, and Curb volumes.
Trim existing contours inside disturbed area [Yes/<No>]? Press enter to say no

In the Contour Options dialog change the layer name to FINAL ROAD and make the contour interval 2. Click OK and your Road is complete! Here are the Road Design prompts:

Command: eworks

Initializing EarthWorks ...
Processing station: 3755.680
Drawing offset 3D polylines: TIE
Calculating volumes ...
Trim existing contours inside disturbed area [Yes/<No>]? <Enter>

Reading points... 2631
Inserted 2631 points
Inserted 2618 breakline segments

Drawing Triangulation 3D Faces ...
Contouring elevation 2040
Inserted 811 contour vertices.

**Step 9 (3D Viewer):**

Now that your Road is complete lets view it in 3D. Go to View, 3D Viewer Window, type in ALL, and press enter.
Here is our road with a Vertical Scale of 4. Color By Elevation has also been toggled on. Use the X, Y, and Z control bars at the bottom to rotate the drawing in the 3D viewer.

**Takeoff Tutorial: Drillholes and Strata**

This lesson creates and processes drillhole data.

**Step 1 (Run Tutorial 1 Example):**

This drillhole lesson builds on the resulting drawing called demo1.dwg from the tutorial 1 (CAD File Takeoff). Before continuing with this tutorial, run through and complete this lesson 1 tutorial.

When tutorial 1 is done, let's set the display to show only the design entities. In the Display menu, turn off Existing Drawing and Other Drawing and turn on Design Drawing. Then run, View->Zoom-> Extents. Now we're ready to add drillholes.
Step 2 (Drillhole/Strata Settings):

From the File menu, choose Drillhole/Strata Settings. This command sets the drillhole symbol and the default strata names. For this tutorial, we are interested in rock quantities and we need to define two strata: Dirt (material above the rock) and Rock.

Pick the Add button which brings up another dialog that defines a strata. Enter a strata name of "DIRT" and a density of 125 which will be used to calculate tons in the volume report. You can also have a strata specific cut swell factor. The strata can be modeled either by the elevations from the drillholes or by the depth from the existing ground. In this case, we will model by strata elevation. When the dialog is filled out as shown, pick OK.

Next, pick the Add button again. This time, fill out the dialog with a strata name of "ROCK" and density of 150. Then pick OK.

The Strata Definitions in the main dialog need to be in top to bottom order. To change the order, highlight a strata name and use the Move Up or Move Down buttons. In this case, we want Dirt then Rock. Click OK now from the main dialog.
Step 3 (Input Drillhole Data):

There are two different methods for entering drillhole data into Takeoff: Drillhole Import and Place Drillhole. Drillhole Import reads the drillhole data from a text file. This command supports customizing the sequence of drillhole data fields to match the format of the text file. Place Drillhole creates the drillholes at picked positions in the drawing and enters the data in a dialog. For this tutorial, we will use Place Drillhole.

Run the Drillhole->Place Drillhole command. At the command line, there is a prompt to pick the drillhole location. If you know the coordinates for the drillhole, you can type in the easting,northing instead of picking on the screen. In this case, let's pick a point above the upper right of the main building.

Pick Drillhole Location: pick a point
Then there is a dialog for entering the drillhole data. The surface elevation is automatically filled in using the existing ground surface model. The Drillhole Name and Description are optional. The list of strata defaults to the strata defined in Drillhole/Strata Settings. Each strata defaults to a thickness of zero. To set the strata thickness, highlight the strata and pick the Edit button.

For this case, highlight Dirt and pick Edit. This brings up the Edit Strata dialog. The strata position can be defined by thickness, elevation or depth. Setting any one of these fields will update the other fields. For our dirt strata, fill in a thickness of 2 and then pick Return.

Next, pick Rock from the strata list and pick Edit. For this example, we only know the depth to the top of rock depth and not the total rock thickness. We will treat all cut below the top of rock as rock strata. So we will set the rock thickness deep enough to be lower than the deepest cut on site. In this case, we will use a rock thickness of 15. So in the Edit Strata dialog for rock, enter a thickness of 15 and then pick Return.

After editing the rock strata, we are returned to the main Edit Drillhole dialog. Pick the Save button.
Now let's locate two more drillholes using a different method. Return Drillhole/Strata Settings dialog and change Place Drillhole Prompts to Thickness. Also, check on Default Thickness and set it to 15 feet, Press OK.

Now run Place Drillhole again and for the second drillhole, pick a position in the lower parking lot. The command line will prompt you to enter a dirt thickness, type in 1.5 and your drillhole is created. For the third drillhole, pick a position left of the main building. Enter a dirt thickness of 3.0, save, and enter to end the command.

**Step 4 (Make Strata Surfaces):**

Now that the drillholes are in the drawing, to make the strata triangulation surfaces, run the Drillhole->Make Strata Surfaces command. There are no prompts for this routine. The strata surfaces are modeled from the drillholes and saved with the project. The file names for the strata surfaces use the drawing name plus "-ch#" where the # is the strata sequence number. For this example, the file names will be "takeoffdemo1-ch1" for bottom of dirt and "takeoffdemo1-ch2" for bottom of rock.

Now that the strata surfaces are created, there are several Takeoff routines that will use these surfaces such
as:
- Calculate Total Volumes
- Calculate Volumes Inside Perimeter
- Cut/Fill Labels
- Surface Inspector
- Quick Profile
- Trench Network Quantities

**Step 5 (Draw Strata Cut Color Map):**

From the Drillhole menu, pick Draw Strata Cut Color Map. This command compares the design surface with the strata surface to make a cut color map of the cut depths for the strata. This command is one way to verify that the strata surfaces are modeled correctly.

There is a dialog to select which strata map to draw. Choose Rock and pick OK. Then there is an option to draw a cut depth legend. Pick a position for the legend in the upper left of the site and use the defaults for size and zone summary.

**Step 6 (Calculate Total Volumes):**

Run the Takeoff->Calculate Total Volumes command. When strata surfaces are defined, the volume routine will breakout the cut volume into the different strata. The resulting dirt and rock quantities are shown in the report.
Takeoff Tutorial: Trench Network Quantities

This lesson takes a drawing file through the steps of trench network quantities.

**Step 1 (Start Takeoff):**

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog and if so, click Exit.

**Step 2 (Open Drawing):**

From the File menu, choose Open and select Takeoffdemo2.dwg from the Carlson Projects folder.
**Step 3 (Make Existing and Design Surfaces):**

In order to calculate trench quantities and profiles in this drawing, we need surfaces for the existing ground and design.

First we need to define the layers of the surfaces. Run TakeOff->Define Layer Surface/Material/Subgrade. Then from the tab labeled "Other", highlight "EX_CTR" from the layer list, pick "Existing" from the Move To list and pick the Move To button. Next, highlight "RD RF CONT", choose "Design" from the Move To list and pick the
Move To button. Now choose the Save and then Exit buttons. This assigned layer "EX_CTR" to the existing ground surface and "RD RF CONT" to the design surface.

Next, let’s set the site perimeter. Run TakeOff->Boundary Polyline->Set Boundary Polyline. At the command line, there is a prompt:
Select boundary polyline:
Pick anywhere along the six sided perimeter polyline in the drawing.

Now, to make the existing ground surface, run TakeOff->Make Existing Ground Surface. Then to make the design surface, run TakeOff->Make Design Surface.

**Step 4 (Input Trench Network Data):**

The trench network data consists of linked structures where each structure has a name, location (x,y), invert-in, invert-out and rim elevation. Each structure link has a pipe size. There are two ways of entering the trench data. When the drawing contains polylines for the trench lines and labels with the trench data, then you can use Input Trench Line. Otherwise, there is the Create Trench Network Structure command which let’s you pick the structure locations and enter the data in a dialog.

Method 1 (Input Trench Data From Polyline):
In this example, there is trench data already drawn in the drawing. Zoom in around the upper right area of trench line by running View->Zoom->Window and picking two corner points around this area.

Then run Trench->Input Trench From Polyline and an options dialog appears. In this case, we want Trench Type as Sewer because there are manhole rim elevations. Also Prompt For Invert-In Elevations is active since this example has a manhole with multiple connections with different invert-ins. And Connected Network is used so that the trench data can be used by the rest of the trench routines. The Individual Profile option will only create a profile (.pro) file. Prompt For Pipe Wall Thickness allows you to enter in the pipe thickness that will be added to the interior pipe size for accurate volume calculations. Fill out the dialog as shown and click OK.
The rest of the prompting for this command is on the command line as the program walks through the trench line. For each point in the trench polyline, the program zooms the drawing to that point. The trench data can be picked from labels in the drawing. If the drawing doesn't have labels for the data, then you can enter the values.

Pick a polyline that represents a trench reach: *Pick the trench polyline*
Starting Station of trench reach <0.0>: 0.0
For station 0.00 ...
Enter/Select text of Manhole ID>: *Pick the DCB 368 label.* (If you had a drawing without a manhole ID label, then type E for Enter and enter the ID)
ID: DCB 368
Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=174 label.* (Since this is the upstream starting manhole, there really isn't a separate invert-in. So we are using the invert-out).
Invert-In: 174.000
Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=174 label.*
Invert-Out: 174.000
Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=178.75 label.*
Rim: 178.750
For station 201.44 ...
Enter/Select text of Manhole ID>: *Pick the DCB 367 label.*
ID: DCB 367
Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=172.85 label.*
Invert-In: 172.850
Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=172.35 label.*
Invert-Out: 172.350
Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=178.5 label.*
Rim: 178.500
Undo/Enter/<Select text of pipe size>: *Pick the 15” HDPE label.*
Pipe Size: 15.0
For station 327.09 ...
Enter/Select text of Manhole ID>: *Pick the CB 347 label.*
ID: CB 347
Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=170.540 (CB 367) label.* (This is the invert-in for the connection to the CB 367 structure that this trench line connects to.)
Invert-In: 170.540
Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=166.1 label.*
Invert-Out: 166.100
Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=176.5 label.*
Rim: 176.500
Undo/Enter/<Select text of pipe size>: Pick the 15” HDPE label.
Pipe Size: 15.0
Another Polyline [<Yes>/No]? N for no.

That completes this trench run and Takeoff draws its own trench polyline and labels.

Method 2 (Create Trench Network Structure):
The drawing contains another trench polyline and we could use Input Trench Line again. Instead for practice, let's use the Create Trench Network Structure method. First we need to zoom to the new trench location. Run View->Zoom->Extents and then View->Zoom->Window and pick two points for a window around the lower right trench point (CB 349). Then run Trench->Create Trench Network Structure. At the command line, there is a prompt for how to locate the structure position. Choose Pick.
Locate by pick point, point number or station-offset [<Pick>/Number/CL]? Pick

![Pick Point Diagram]

Next, there is a prompt to pick the position. To get the exact end point of the trench polyline, use the end point snap. The end point snap can be turned on by a number of different ways including the Settings->Object Snap command. In this case, type "end" and then space or enter. This puts the program in end point snap mode. Now move the pointer along the trench polyline until the end point snap icon is at the manhole location and then pick.
Pick structure location: end of (pick point)

Now a dialog appears for entering the structure data. Fill in the Structure Name as CB 349, the Rim Elevation as 187.8, the Invert-Out as 178.3, the Structure Width as 4.00 and then pick OK.
All the structures are now created. The last step is to link this new structure to the network. We need to zoom to the next trench location. Run View->Zoom->Extents and then View->Zoom->Window and pick two points for a window around the left trench point (CB 347). Now run Trench->Edit Trench Network Structure and pick either the symbol for CB 347 or the label. Then a dialog appears with the data for CB 347. From the Available list, highlight CB 349 and pick Add. This creates a link from CB 347 to CB 349 and the link data is shown at the bottom of the dialog. Enter the Invert-In as 171 and the Pipe Size as 24. Then pick OK.

Step 5 (Input-Edit Trench Template):
The Trench Template defines the size of the trench for quantities. Run Trench->Input-Edit Trench Template. You are first prompted for a trench template file name. The Trench Template data is stored in a file that has a .tch extension. Choose the New tab, enter a file name like trench1 and then pick Open.

Next, there is a dialog for entering the trench dimensions. The Bottom Offset is the distance from the bottom of the pipe to the bottom of the trench. The Trench Width is the base width of the trench. The Vertical Side Height is the height from the bottom that the side walls are vertical until switching to the cut slope. If the surface is not reached by the vertical side height, then the cut slope is used for the rest of the distance to the surface. Edit Trench Benches allows you to set up to four benches in your trench. Display Sewer Structure allows you to see your pipe or manhole as part of the trench. Note: This is for display purposes only, calculations will be drawn from the pipe size you set in the Trench Network Structure commands. Add Pipe Diameter To Trench Width will increase the size of your trench by the diameter of your different pipe sizes. The Cut Slope can be entered in slope percent, ratio or degree format. The Backfill materials are optional. Up to three materials can be entered from the bottom.

Fill out the dialog as shown and pick Save and Exit.

Step 6 (Trench Network Quantities):

To calculate and report the trench quantities, run Trench->Trench Network Quantities. A dialog sets the report options. Check on Calculate All Trenches to get the quantities for the whole network. To get the trench cut volume, check Use Trench Template For Quantities and pick Set Trench Template and pick trench1.tch. Also turn on Report Backfill Volumes to use our backfill material settings from the trench template. Finally, fill out the depth zones in the intervals that you are interested in. In this case, use 15, 20 and 25. The depth zones will be colored in the plain view. Once the dialog is filled out as shown, pick Setup Depth Zones.
Fill out the depth zones in the intervals that you are interested in. In this case, use 15, 20 and 25. The depth zones will be colored in the plain view. Finally, click OK and OK in the main dialog and the report is shown.

The report includes:
- The structure names at the start of each trench run included in the report.
- The trench template dimensions.
- The cut volume.
- The backfill volumes.
- The number of manholes and length of trench within each depth zone.
Step 8 (Draw Trench Network Profile):

To draw a profile of the trench line, run the Trench->Draw Trench Network (Profile) command. There is a dialog to select the starting structure for which trench line to process. Choose DCB 368. Also, there are options whether to draw the existing ground, design surface and strata surfaces if available. You can also choose the profile direction to go upstream or downstream. The Save To Profile File will create a profile (.pro) file for the trench. Fill out the dialog as shown and pick OK.
Next the Draw Profile dialog appears. Set the Horizontal Scale and intervals to 50 and the Vertical Scale and intervals to 25. This will make for two to one vertical exaggeration for the profile. When the dialog is filled out as shown, pick OK.

Next there are prompts at the command line for the profile grid elevations and profile location.
Bottom Elevation of Profile Grid <150.0>: Press Enter
Top Elevation of Profile Grid <200.0>: Press Enter
Pick Starting Point for Grid <409458.0, 207303.0>: Pick a point in a blank area off to the side of the drawing.

Next there are two dialogs with lots of settings for how to draw and label the trench profile. Let's go with the defaults except change the Type Of Pipe to HDPE. When the settings are ready, click the OK button for each dialog.
There is a final command line prompt for whether to use the manhole elevations. Enter Yes which will use the rim elevations defined in our trench network.

Use manhole elevations from profile [<Yes>/No]? Y for yes.

The profile shows the existing ground at the top, then the design surface and then the trench.
Takeoff Tutorial: Digitizing

This lesson transfers a paper plan into Carlson Civil.

Step 1 (Setup):

To digitize in Carlson Takeoff, you need to install the Wintab digitizer driver. See Digitizer Setup in the manual if you have not installed or have problems with the Wintab driver. If Wintab is installed, then make sure your drawing board is on and take the paper plan provided with the manual and place it on your drawing board. Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog similar to the one shown below, if so click New.

![Startup Wizard dialog](image)

If a Startup Wizard did not appear, then under File menu, select New to start a new drawing. You will be prompted for a template to use. Templates determine the default settings for your drawing. For this tutorial, select site.dwt and click Open.
Next, the New Drawing Wizard appears for setting the drawing name. Click on the Set button at the top dialog. In the file selection dialog, enter the file name of "digitize" and pick the Save button. Then Exit the New Drawing Wizard. From here, a Data Files dialog appears where no changes are needed. Pick the Exit button.

**Step 2 (Tablet Calibration):**

To start things off, you need to set the coordinate system for the paper plan by running the Calibrate command under Digitize menu and sub-menu Tablet. Calibration is required to let the program know the orientation and scale of the paper plan.
There are two different Calibration Methods: Known Reference Points and Drawing Scale with New Reference Points. Known Reference Points allows you to enter in the coordinates of two marked points on the paper plan. This method applies when you know the coordinates of at least two points on the paper plans. Drawing Scale with New Reference Points allows you to setup a coordinate system for the plans by entering the plan scale and picking any two points from the paper plan with the digitizer puck.

In this case, we will use Drawing Scale with New Reference Points. First, enter in the Drawing Scale listed on the paper plan. On this drawing, the scale is 1:40, so enter in 40. Use the default coordinates for Point 1 and click OK. Now Carlson Takeoff will prompt you for your First and Second Reference points. Generally, you want to pick to points on the drawing that you can find and use again in case you need to recalibrate. Also, the further away the points are from each other, the more accurate the coordinate system will be. With the digitizer puck, pick on the icon in the lower left and upper right of the drawing for the two Reference Points. The first point is assigned the coordinates of 1000,1000 from the dialog and the second point is assigned coordinates to match with the plan scale. From now on, all of your points will be in relation to these two points.
Step 3 (Digitizing Existing Contours):

We will now digitize the existing contours. Under the Digitize menu, click on Existing and then go to Contour Polyline, and this dialog will appear. Enter in a Layer Name of XCONT and select OK. Note: your Elevation Interval should match the intervals marked on your paper drawing. In this drawing, the interval is the same as the default of 1.00.

The rest of the prompting occurs at the command line and starts with the contour elevation. Find the lowest elevation for the existing contours labeled in bottom right corner of the paper plan zoomed in on below. In this example, the lowest elevation is 624 feet. The elevation can be entered either with the digitizer puck keys or with the computer keyboard. The layout of the digitizer keys is set in Digitizing Settings->Puck Layout. Press Enter after you have entered in 624. You want to enter in the lowest contour so that as Carlson Takeoff adds the Elevation Interval, it is from lowest to highest.
Next, you will see the following prompt:

**Sketch[0]/Exit[A]/Pick the first point:**

There are two different ways to digitize: in Pick Mode or Sketch Mode. You can switch between them at anytime. In this tutorial we will run through how to do both. For now, type in [0] and press enter to get into Sketch Mode. In Sketch Mode, you will be prompted to Pick and drag. The point you pick is the starting point of a contour. Drag is asking you to follow that contour with the digitizer puck on the paper plan. Click a second time when you have traced the entire contour and have reached the end of the contour. You will then be prompted as follows:

**Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end):**

Type in [B] for Undo if you made a mistake and need to sketch part of the contour again. [A] will close the contour, and [0] will switch you into Pick Mode. We still have more existing contours to digitize, so press Enter to end and answer yes to the Digitize Another Contour prompt. Takeoff will prompt you to verify the elevation. Remember, we set the Elevation Interval to one, so the default elevation for your next contour line is 625, press Enter. Now, pick the endpoint of the next contour and trace it in the same manner as the previous contour.

Now let's try Pick Mode. Say yes to digitize another contour and check to see if the default elevation corresponds with the contour your about to digitize. If not, simply type in the correct number in the command line. Next, pick [0] to get into Pick Mode. In Pick Mode, you do not have to trace the contour. Rather, pick with the digitizer puck to create points that will make up the contour. Note: Less picks are needed on fairly straight segments. Conversely, more picks will give you a more accurate contour. Press Enter when you have reach the end of the contour. Repeat this until you have digitized all of the existing contours you want to have in Takeoff (see below).
Step 4 (Digitizing the Design):

Now we will digitize the building and curb linework of the Design Surface using the Digitize 2D Polyline and 3D Polyline commands. Besides drawing the linework positions, we will also assign layer names to the linework that we will use later to identify the types of linework. In this example, there are no design contours, only the design building and curb linework and spot elevations.

Let's begin by digitizing the main building. Under Digitize, check on Design and go to 2D Polyline. 2D Polyline is used to digitize linework entities with one elevation. Toggle off the check box Use current drawing layer and name the layer NEW BUILD. Toggle on the Prompt For Polyline Elevation option. Then click OK.

At the command line, enter in the building elevation of 634.41 found labeled in the middle of the building and press Enter. Then pick the points that define the building outline. Start in the upper left corner and pick at every corner around the building. When you have picked around the entire building, type in [A] for close to finish digitizing the building.
Enter polyline elevation <0.00>: 634.41

First point: pick a building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): pick the next building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): pick the next building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): pick the last building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): A to close

Digitize Another NEW_BUILD Polyline [Yes(A)/No(B)]? B for No

Notice that the parking lot linework consists of different elevation levels. To digitize entities with more than one elevation, go to Digitize and select 3D Polyline from the pull-down menu. Make sure that the Prompt For Polyline Elevation option is on, the Use current drawing layer toggle is off and name the layer NEW EDGE ASPH.

Let's start by digitizing the parking lot starting from the zoomed in section below. The edge of asphalt is the inside line. The parking lot elevation labels have been shortened on the paper plan. For example, they read 35.37 and 35.12, when the actual elevations are 635.37 and 635.12. Enter in 600 as the Elevation Adder, then click OK.
Click on the point with the digitizer puck where the 35.37 elevation label points to in the upper left corner of the parking lot. When prompted for Elevation enter in 35.37. Pick below the first point where the linework starts to curve. We do not have an elevation for this point, but we can interpolate the elevation from the two points around it using the interpolate option. Type in I for interpolate or hit the A button on the Puck. Next pick the middle point of the curve and again use Interpolate for the elevation. Next pick the end of the curve at the 35.12 label and enter in the elevation 35.12. Continue digitizing for the rest of the edge of asphalt linework. Digitize each point where there is an elevation label and each point where the curb line changes direction.

The first prompts should resemble these:

**First point:** *pick first point (at 35.37 label)*
*Interpolate[A]/screen Pick/\< Elevation[B]\> \<0.00\> : 35.37* 

**Z:** 635.37  
*Close[A]/Undo[B]/Osnap[].Pick next point (Enter to end): pick next point (start of curve)*
*Slope/Ratio/Interpolate[A]/Degree/screen Pick/\< Elevation[B]\> \<635.37\> : Press the [A] button on the Puck for Interpolate*

*Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[].Next point or elevation\<Interpolate\>: pick next point (middle of curve)*
*This point elevation will be interpolated upon completion.*
*Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[].Next point or elevation\<Interpolate\>: pick next point (end of curve, at 35.12 label)*
*This point elevation will be interpolated upon completion.*

*Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[].Next point or elevation\<Interpolate\>: 35.12 (Enter)*

To check the elevations of the interpolated points go to List under the Inquiry menu and click on the polyline you just created and press Enter. A text window will appear showing you the layer name, coordinates, and elevation of each point. To return to the main graphic screen, press F2.

Use the 3D Polyline command to digitize the rest of the parking lot as seen below.
Step 5 (Area):

Now that we have digitized the Design Surface, let's check the Area of certain sections. Select Area under the Digitize Menu and match the below dialog.

To approximate the area of the main building, pick the points of the building outline.

**Command:** `dig_area`

**Pick starting point:** Pick points as close to the building design linework as you can

Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):
Undo[B]/Pick next point (Enter to end):

Digitize Another Area [<Yes(A) >/No(B)]? B

When finished with the building points, press Enter to end. Then answer no for no more areas. Takeoff will then display an Area report similar to the one shown below.

### Step 6 (Spot Elevations):

In our paper drawing, we have two spot elevations labeled 32.57 and 32.41 shown in the bottom left below.

To digitize these elevations, we can use the Spot Elevation command under the Digitize menu. Fill out the Spot Elevation dialog as shown and pick OK.
In the paper plan, find and click on the spot elevations with the puck. When prompted, enter in their corresponding elevations of 632.57 and 632.41.

**Step 7 (Boundary Polyline):**

The limits of the site are defined by a closed polyline. This polyline is used as the boundary for the models and the volumes. Under the digitize menu, check on Other and then select Perimeter. Type in PERIMETER as the layer name. Now digitize around the bold, outside line shown below.

Say No to the prompt: **Digitize Another PERIMETER Polyline [Yes(A)/<No(B)>]**?

Now run Tools->Boundary Polyline->Set Boundary Polyline and pick the perimeter polyline. This selected polyline is now set as the boundary polyline for the rest of the Takeoff routines.

**Step 8 (Layer Targets):**
From the Tools menu, choose Define Layer Target/Material/Subgrade. Every entity (line, polyline, point, etc) in the
drawing is assigned a layer name. Takeoff uses the entity layer names to define which entities are for the existing
ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. The drawing
entities are assigned their target surface by their layer name. For example, if polylines representing design contours
are on the layer "NEW", then "NEW" will be set as a layer for the design surface. For layers of entities that are for
neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other.

The Define Layer Targets dialog has three lists of layers: Existing, Design and Other. To switch between lists, pick
the tabs at the top of the dialog. We have already defined the layers for their correct targets. We did this by check on
Existing, Design, or Other in the pull-down menu.

Check that your Layer Targets resemble the three lists shown here. If a layer is out of place, highlight it, and hit the
"Move To" button after selecting the correct target to send it to. After reviewing, pick Save and Exit.
Now that the layer targets are defined, there are several commands that can be applied. In the Display menu, you can turn on/off whether to display layer targets by using Existing Drawing, Design Drawing and Other Drawing, or by right-clicking with your mouse. For example, when Design Drawing is checked, then picking this menu item will uncheck it and turn off all the layers for the design surface. Likewise, picking Design Drawing when it is unchecked will make it checked and turn on the design surface layers.

Practice turning on/off the Existing, Design and Other Drawing in the Display menu. When only Existing Drawing is on, you should see just the contours. When only Design Drawing is on, you should see just the design polylines.
and leader labels. When only Other Drawing is on, you should see the entities that are assigned to neither existing nor design.

Step 9 (Define Material/SubGrade):

Besides assigning target surfaces by layer, layers are also used to define material names and subgrade depths. By assigning material names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface. The polylines used for subgrade depth must be closed polylines. Takeoff supports nested subgrade polylines for exclusion areas such as islands by counting how many subgrade polylines surround an area. If the number is odd, then the area is inside the subgrade. Otherwise the area is not part of the subgrade.

First, let's confirm the layer names for our subgrades. Go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Then run Inquiry->Layer ID and pick the large pad polyline. It reports that this layer is NEW BUILD. Next use Layer ID to pick the curb polyline. It reports that this layer is NEW EDGE ASPH.

Now run Define Layer Target/Material/Subgrade and pick the Design tab. Highlight layer NEW BUILD and pick the Edit button. A dialog appears for defining the pad material properties. Check on the Include In Material Report option, enter the Material Name as "Pad", set the first subgrade name to "Pad", and set the Depth as 1. Once the dialog is filled out as shown, pick OK.
Next pick layer NEW EDGE ASPH and choose Edit. In the Edit Materials dialog, check on Include In Material Report, set the Material Name to "Pavement", set the first subgrade name to "Pavement", and set the Depth to 1.5. Then pick OK.

To save the subgrade changes, pick the Save button on the Define Layer Targets dialog. Then choose Exit.
Now let's visually verify the subgrade areas. In the TakeOff menu, run Subgrade Areas->Hatch Subgrade Areas.
There is a dialog to select which subgrade to hatch. Choose the Pavement. Then there is a dialog for the hatch pattern and color. Change the color to green and click OK. Then run Hatch Subgrade Areas again. This time choose Pad and set the hatch pattern to Hex with blue color. The resulting hatch areas show where the subgrade is applied. Notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. When finished viewing the subgrade areas, run TakeOff-Subgrade Areas-Erase Subgrade Hatches.

---

**Step 10 (Model Existing and Design Surfaces):**

To calculate volumes, Takeoff needs two surfaces: existing ground and design. These surfaces are modeled by triangulation. With the preparation of the previous steps, we're now ready to make the models. To make the existing ground surface, run Tools-Make Existing Ground Surface. The program will process the entities and make the triangulation surface. Then to make the design surface, run Tools-Make Design Surface.

**Step 11 (Cut/Fill Color Map):**

Cut/Fill color maps can be used for a visual output of the site cut/fill areas and also serves as a check that the models are correct. In the Display menu, choose Cut/Fill Color Map. Cut areas are drawn in different shades of red for different depths of cut while fill areas are drawn in blue. To change the resolution of the color blocks, run Display-Display Options and change the Cut/Fill Color Map Subdivisions. This parameter is the number of rows and columns of color blocks to create. You can also draw a legend for the Color Map by going to Draw, Cut/Fill Map Legend. Pick a point on your drawing to locate the legend and press Enter. To turn off the color map, go to the Display menu and pick Cut/Fill Color Map to uncheck it.
Step 12 (Calculate Volumes):

To calculate volumes, run the TakeOff->Calculate Total Volumes command. There is an options dialog for setting the cut swell factor and fill shrink factor. These values get multiplied into the cut/fill volumes. Set these factors as desired and click OK. Then the routine calculates the volumes and display the report which includes the cut/fill volumes and areas. The report can be printed or saved to a file. Pick the Exit button to exit the report viewer.
Step 13 (Material Quantities):

To report the material quantities, run the TakeOff -> Material Quantities -> Standard Report routine. The report includes the count, length, area and volume for each type of material that was assigned for reporting in the Define Layer Target/Material/Subgrade command. The Material Quantities -> Custom Report routine can be used to reporting these values with control of the report format and the option to export to Excel.
Index

plus-0.5in
2 Tangents, Arc Length, 199
2 Tangents, Chord Length, 199
2 Tangents, Radius, 199
2D Align, 116
2D Linework Library, 799
2D Polyline, 180, 181, 183, 409, 413, 583, 643, 797
   875
2D to 3D Polyline, 262–264
3 Point, 201
3D Arc, 202
3D Drive Simulation, 159, 317, 801, 841
3D Entity by Surface Model, 270
3D Polyline, 109, 143, 145, 147, 185, 187, 188, 208, 270
   278, 280, 326, 332, 333, 408, 410, 413, 414
   417, 419, 431, 432, 445, 497, 517, 557, 643
   659, 688, 709, 786, 787
3D Polyline Utilities, 141–143, 147
3D Polyline by Slope on Surface, 145
3D Polylines, 143, 147
3D Viewer Window, 161, 162, 349, 379, 388, 572
   619, 621, 623, 627, 717, 718, 852
3D Viewer to 3D PDF, 89, 170
3D Viewer/Model Library, 800
3D Views, 155
3DSolid and Polymesh Converter, 41

AASHTO, 523
About Carlson TakeOff, 28
About Carlson Takeoff, 827
Add Intersection Points, 131
Add Point by Two Slopes, 143
Add Points At Elevation, 147
Add Polyline Arcs, 132
Add Polyline Vertex, 132
Adjust Coordinates, 649
Adjust Image, 251, 252, 254
Adjust Overexcavate Surface, 305
Align, 116, 118, 208, 325, 360, 409, 414, 417, 423
   446, 448, 454, 462, 497, 531, 533, 590, 654
   661, 662, 665, 666, 720, 745, 774, 788, 823

Alphanumeric, 633, 793
Angle/Distance, 649, 764
Angle Info, 756, 757
Angle Mode, 787, 796
Annotation, 7, 212
Arc Length, 184, 189, 199, 400
Area by Closed Polylines, 780
Area by Interior Point, 779
Area By Inverse, 778
Area by Lines & Arcs, 777, 779
Area Defaults, 772, 776, 777, 779, 781
Area Descriptions, 784, 785
Area Label Defaults, 781
Areas Of Interest, 293, 342
Area Table Defaults, 781, 782
Arrowhead, 656
ASCII File, 705
ASE, 27, 102, 332–335
Assign Contour Elevation - From Contour Labels, 282
Assign Contour Elevation - Multiple in Series, 281
Assign Contour Elevation - Single Elevation Group, 282
Assign Template Point Centerline, 532, 540, 554
Assign Template Point Profile, 530, 540
At Intersection, 115
At Selected Point, 115
Attribute Layout ID, 636, 796
Audit, 40
Auto Annotate, 131
Automatic Point Numbers, 636
Average Slope, 748
Backfill, 383, 384, 389, 865
Barscale, 218
Berm Grades, 512
Best Fit Curve, 200
Black/White By Threshold, 253
Blips, 129, 762
Block Data Report, 757, 758
Block Explode, 110
Boundaries, 198, 738, 740
Boundary, 198, 231, 313, 368, 725, 779
Boundary Polyline, 292, 293, 302, 304, 349, 376, 840
   844, 861, 880
Break, 113, 115, 136, 137, 164, 302, 320, 321, 324
   332, 333, 449, 467, 484, 487, 492, 496, 503
   619, 626, 680, 720, 823
Break 3D Polyline by Surface, 146
Brighten/Darken Image, 254
Buffer Offset, 108, 774
Building Envelope Polyline, 210
Building Offset Extensions, 698, 700
By Bearing, 115
by Crossing Polyline, 113
By Points, 264
By Screen Entities, 263
By Slope From Reference, 264
### Index

**By Start-End Elevations**, 268  
**By Surface Model**, 262  
**By Text**, 264  
**By Text With Leader**, 266

**Calculate End Area**: 467, 468  
**Calculate Offsets**: 420  
**Calculate Pond/Pit Volume**: 333, 334  
**Calculate Removables Volumes**: 314  
**Calculate Section Volumes**: 464, 465, 469  
**Calculate Stockpile Volume**: 332  
**Calculate Total Volumes**: 335, 340, 367, 842, 858, 886  
**Calculate Volumes Inside Perimeter**: 340, 858

**Calculator**: 754, 755  
**Carlson Community**: 48–50  
**Carlson File Types**: 7  
**Carlson Points**: 649  
**Carlson Registration**: 2  
**Carlson WebSite**: 827


**Centerline**: 7, 51, 91, 94  
**Centerline conversion**: 404  
**Centerline Report**: 403, 404  
**Centroids**: 466, 545  
**Change Elevations**: 261  
**Change Layer**: 142, 175, 261  
**Change Polyline Linetype**: 214  
**Change Polyline Width**: 134  
**Change Text Font**: 119  
**Channel Sample**: 7  
**Check Elevation Range**: 137, 185  
**Check Polylines**: 137, 139  
**Chord Bearing**: 756

**Closed Polyline By Interior Text**: 206  
**Close Polyline**: 135, 835  
**Closure Error**: 769, 779  
**Color Contours by Elevation**: 721  
**Color Contours by Interval**: 723  
**Color Surface By Layer**: 724  
**Command Entry**: 6  
**Common Format List**: 311, 701  
**Compare Points**: 662, 667, 668  
**Compass**: 778  
**Compound Curve**: 525  
**Configuration**: 7, 9, 10  
**Configure**: 791  
**Configure Carlson**: 781  
**Contour Elevation Label**: 719  

**Convert C&G to Carlson Points**: 705  
**Convert Dashes To Polylines**: 87  
**Convert Eagle Point to Carlson Points**: 706  
**Convert Polylines To Text**: 85  
**Convert Softdesk to Carlson Points**: 706  
**Convert Spot Elev To Points**: 270  
**Convert Wild/Leica to Carlson Points**: 706  
**Coordinate File**: 7, 60, 62, 200, 419, 434, 456, 458, 638, 647, 650, 664, 674, 696, 705  
**CooRDiNate File Utilities**: 661  
**Coordinate File Utilities**: 633, 634, 639, 650, 662, 663, 706, 789  
**Coordinate Transformation**: 8, 662, 666

**Copy**: 104, 105, 477, 514, 662, 667, 675, 686  
**Copy To Layer**: 104  
**Cost Summary Report**: 348  
**CRD File**: 5, 64, 67, 71, 72, 117, 538, 634, 650, 662, 665, 666, 669, 706, 753, 779, 793

**Create Points from Entities**: 656, 658  
**Create Profiles**: 424  
**Create Ridge Polylines From Contours**: 284  
**Create Sections**: 447, 452, 459, 478  
**Create Trench Network Structure**: 372, 861, 863  
**Crop Image**: 251  
**Crosshairs**: 809  
**Cross Sections**: 445, 688  
**CSTYLE**: 7  
**Cul-de-sacs**: 604  
**Curve - Arrow**: 213, 214  
**Curve Edit Mode**: 397  
**Curve Info**: 753  
**Curves**: 199, 393, 397, 410, 417, 454, 523, 659, 766, 767  
**Curve Table**: 407  
**Custom**: 8, 27, 36, 164, 196, 336, 342, 345, 356, 364, 481, 636, 652, 654, 737
Custom Drillhole Report, 365
Cut/Fill Centroids, 738
Cut/Fill Color Map, 733, 734, 818, 825, 841, 885
Cut/Fill Contours, 816
Cut/Fill Labels, 736, 813, 815, 817, 858
Cut/Fill Map Legend, 735, 885
Cut Image, 251
Cut Sheet, 684, 687, 689, 692, 697

Data Collectors, 54, 55
Data Files in DWG Directory, 792
Deed Description, 9
Define Materials, 291, 343, 545
Define Pipe Groups, 385
Delete Layer, 797
Delete Points, 662, 664
Delta Angle, 406, 408, 712
Densify Polyline Vertices, 127
Depth Contours, 367, 368
Description for Points, 662, 666
Design Contours, 815
Design Drawing, 814, 815, 832, 833, 881, 882, 883
Design Pad Template, 10, 432, 500, 708, 711–713, 715, 716
Design Profile, 539
Design Road Profile, 425, 432, 539
Design Surface, 816, 824, 840, 841, 860, 861, 875, 878, 885
Design Surface 3D Viewer, 158
Design Surface Vertical Offset, 317
Design Template, 496, 500, 522, 527, 530, 532, 534, 537, 539, 540, 544, 551, 555, 557, 561, 564, 566, 587, 709, 847
Deskew Image, 252
Digitize 2D Polyline, 227
Digitize 3D Polyline, 228
Digitize Areas, 231
Digitize Contour Polyline, 231
Digitize Design, 224
Digitize End Areas, 236
Digitize Existing, 224
Digitize Menu, 220
Digitize Other, 225
Digitize Perimeter, 230
Digitize Point, 225
Digitize Profiles, 233
Digitize Rectangle, 229, 230
Digitizer Settings, 223, 224, 234
Digitize Sections, 234, 476, 478, 539
Digitize Spot Elevation, 226
Discussion Groups, 2
Display Last Report, 759
Display Menu, 812
Display Options, 819, 841, 885
Display Order, 155
Distance Report, 764
Distance with Leader, 211
Disturbed Area, 538, 547, 548, 573
Ditch, 510, 512, 522, 527
Ditch Grades, 510, 512
Divide Along Entity, 679
Divide Between Points, 678
Dozer, 9, 95, 159
Dozer Push, 8
Dragline, 8, 10
Draw-Locate Points, 637, 648, 665, 770
Draw 3D Poly Base Breakline, 334
Draw 3DPoly Perimeter, 334
Draw Building Envelope Polyline, 274
Draw Centerline File, 402
Draw Curb Ramp, 276, 536
Draw Grid, 492
Drawing Annotation, 211
Drawing Explorer, 93, 497
Drawing Inspector, 634, 761–764, 833
Drawing Setup, 3, 10, 53, 761, 764, 833
Drawing Template, 3
Drawing to 3D PDF, 88, 89
Drawing Utilities, 40, 43
Draw Menu, 179
Draw Model View, 153
Draw Overexcavate Cut Color Map, 306
Draw Overexcavate Surface 3D Faces, 305
Draw Perimeter, 778
Draw Pipe, 497
Draw Polyline Blips, 129
Draw Profile, 9, 377, 380, 460, 868
Draw Raster Image, 241, 242
Draw Removal Breakline, 311
Draw Removal Contours, 314
Draw Removal Field to Finish, 311
Draw Removal Surface, 313
Draw Section File, 478, 479, 498, 537, 538, 541
Draw Strata Cut Color Map, 368, 858
Draw Strata Cut Depth Contours, 367
Draw Strata Surface, 368, 369, 379
Draw Subgrade Hatch Legend, 297
Draw Surface As Grid, 718
Draw Top Surface 3D Faces, 309
Draw Trench Network - Plan, 379
Draw Trench Network - Profile, 379
Draw Trench Network Centerline, 382
Draw Triangular Surface, 777

Index

890
Index

892

Hatch Wizard, 202
HEC-2, 8
HEC-RAS, 447
Help Menu, 826
Highlight Crossing Plines, 139
Highlight Non-Perpendicular Intersections, 138
Highlight Non-Tangent Polylines, 138
Highlight Strata Polylines, 363
Highway Section Staging, 463
Hydrograph, 8
Identify Area Descriptions, 785
Identify Strata Polylines, 363
Image, 120, 121, 171, 204, 205, 233, 235, 241, 242, 244, 245, 248, 252, 254, 256, 350
Image Adjust, 121
Image Clip, 120
Image Frame, 120
Import/Convert Points, 700
Import/Export Carlson Triangulation Files, 51
Import/Export DXF Files, 51
Import/Export LandXML Files, 51
Import/Export Topcon TIN File, 53
Import/Export Trimble TTM File, 53
Import 3D Model File, 84
Import Centerline, 404
Import Google Earth File, 76
Import LandXML File, 77
Import MicroStation DGN, 80
Import PDF File, 80
Import Polyline File, 80
Import Raster To Vector, 255
Import Removal Text ASCII File, 310
Import RoadXML File, 83
Import Sections, 453
Import SketchUp File to Drawing, 85
Import TDS RDS File, 404
Import Text/ASCII File, 61 700, 702
Import Trench Network Data - Sewer Network, 376
Import Trench Network Data - Utility Network, 376
Import Xref to Current Drawing, 47
Import_LDD_MDB_File, 703
INI Files, 4
Input-Edit Centerline File, 393, 585
Input-Edit GIS Data, 98
Input-Edit Point, 647, 669
Input-Edit Profile File, 439, 845
Input-Edit Section Alignment, 445
Input-Edit Section File, 470, 478, 534, 540, 541, 543, 545, 546, 554
Input-Edit Super Elevation, 523, 540, 588
Input-Edit Template Series, 527, 528, 539, 556, 588
Input-Edit Trench Template, 383, 384, 387, 436, 864
Input Trench From Polyline, 383, 384, 387, 436, 864
Inquiry Menu, 751
Insert Drawing, 192
Instruction Manual and Program Conventions, 24
Interior Point, 202, 776
Interpolate Points, 678, 681
Intersections, 567, 568, 572, 581, 597, 598, 616, 625
Interval Along Entity, 680
Introduction, 1
Inverse, 766, 779, 789
Inverse distance, 354
Isolate Layer, 176, 177, 638
Join, 119, 124, 125, 130, 282, 330, 548, 840
Join 3D Polyline, 143
Join Nearest, 81, 124, 126, 129, 130, 402, 432
Join Polyline By Trace, 129, 130
Join Two Polylines, 130
Kriging, 544
Label Angle, 682, 768
Label Arc, 211, 213
Label Contours, 324, 822
Label Coordinates/Elevation, 682, 683
Label Drillhole, 359
Label Elevations, 493
Label Station-Offset, 413
Label Subgrade Areas, 298
Label Zeros, 639
Latitude/Longitude, 163, 703
Layer and Style Defaults, 7
Layer by Description, 638
Layer Control, 172
Layer ID, 753, 835, 883
Layer Inspector, 763
Layer Library, 797, 799
Layer Report, 763
LDD MDB, 703
LDD Points, 793
Least squares, 355
Leica, 54, 67, 71, 706
License Agreement, 25

Index

892
<table>
<thead>
<tr>
<th>Index</th>
<th>893</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line, Polyline or Text</td>
<td>154</td>
</tr>
<tr>
<td>Linework Intersection Points</td>
<td>681</td>
</tr>
<tr>
<td>Linework Length Report</td>
<td>340</td>
</tr>
<tr>
<td>Link Points with Coordinate File</td>
<td>634</td>
</tr>
<tr>
<td>Links Manager</td>
<td>668</td>
</tr>
<tr>
<td>LISCAD</td>
<td>69, 70</td>
</tr>
<tr>
<td>LisCad</td>
<td>706</td>
</tr>
<tr>
<td>List</td>
<td>752, 787, 797, 810, 877</td>
</tr>
<tr>
<td>List Elevation</td>
<td>764, 837</td>
</tr>
<tr>
<td>List Points</td>
<td>634, 646, 647, 662, 663</td>
</tr>
<tr>
<td>Load Tablet Calibration</td>
<td>223</td>
</tr>
<tr>
<td>Locate on Real Z Axis</td>
<td>635, 639, 656, 796</td>
</tr>
<tr>
<td>Locate Point</td>
<td>6, 636, 637, 640</td>
</tr>
<tr>
<td>Lock/Unlock Layers</td>
<td>177</td>
</tr>
<tr>
<td>Lock Layers</td>
<td>153, 177</td>
</tr>
<tr>
<td>Make Combined Removal Surface</td>
<td>315</td>
</tr>
<tr>
<td>Make Design Surface</td>
<td>303, 315, 317, 372, 374, 376</td>
</tr>
<tr>
<td>Make Existing Ground Surface</td>
<td>302, 317, 383, 840</td>
</tr>
<tr>
<td>Make Layout</td>
<td>349</td>
</tr>
<tr>
<td>Make Overexcavate Surface From Existing/Design Surfaces</td>
<td>304</td>
</tr>
<tr>
<td>Make Overexcavate Surface From Screen Entities</td>
<td>305</td>
</tr>
<tr>
<td>Make Strata Surface</td>
<td>367, 369, 544, 857</td>
</tr>
<tr>
<td>Make Top Surface</td>
<td>306, 309</td>
</tr>
<tr>
<td>Manhole</td>
<td>372, 381, 390, 437, 862</td>
</tr>
<tr>
<td>Map Points from</td>
<td>662, 665</td>
</tr>
<tr>
<td>Maps</td>
<td>96</td>
</tr>
<tr>
<td>Maptech</td>
<td>703</td>
</tr>
<tr>
<td>Mass Diagram</td>
<td>460, 467, 469, 542</td>
</tr>
<tr>
<td>Mass Diagram Output File</td>
<td>467</td>
</tr>
<tr>
<td>Mass Haul Analysis</td>
<td>459, 461</td>
</tr>
<tr>
<td>Material Quantities</td>
<td>341, 343, 348, 843, 887</td>
</tr>
<tr>
<td>Measured</td>
<td>70</td>
</tr>
<tr>
<td>Median Offset</td>
<td>107</td>
</tr>
<tr>
<td>Merge Closed Polylines</td>
<td>130, 131</td>
</tr>
<tr>
<td>Merge Crossing 3D Polylines</td>
<td>144</td>
</tr>
<tr>
<td>Merge Existing With Design</td>
<td>318</td>
</tr>
<tr>
<td>Merge PDF Files</td>
<td>38</td>
</tr>
<tr>
<td>Merge Raster Files</td>
<td>249, 250</td>
</tr>
<tr>
<td>MicroStation</td>
<td>80, 95, 96</td>
</tr>
<tr>
<td>Mirror</td>
<td>13, 252</td>
</tr>
<tr>
<td>Mirror Image</td>
<td>252</td>
</tr>
<tr>
<td>Modify Points</td>
<td>647</td>
</tr>
<tr>
<td>Move</td>
<td>104, 112, 156, 159, 180, 288, 298, 308, 348</td>
</tr>
<tr>
<td>Move Point Attributes Single</td>
<td>655</td>
</tr>
<tr>
<td>Move Point Attributes with Leader</td>
<td>655</td>
</tr>
<tr>
<td>Move Points</td>
<td>655</td>
</tr>
<tr>
<td>Multiple Offsets</td>
<td>106</td>
</tr>
<tr>
<td>MXS File</td>
<td>445, 446, 449, 450, 453</td>
</tr>
<tr>
<td>Negative Image</td>
<td>255</td>
</tr>
<tr>
<td>New</td>
<td>31, 32, 47, 70, 116, 120, 125, 134, 135, 145</td>
</tr>
<tr>
<td>Nikon</td>
<td>54, 71, 72</td>
</tr>
<tr>
<td>Nodes</td>
<td>637, 638</td>
</tr>
<tr>
<td>North Arrow</td>
<td>89, 218, 219</td>
</tr>
<tr>
<td>Numeric</td>
<td>256, 257, 793</td>
</tr>
<tr>
<td>Object Linking</td>
<td>42, 793</td>
</tr>
<tr>
<td>Object Snap</td>
<td>806, 807, 863</td>
</tr>
<tr>
<td>Obtaining Technical Support</td>
<td>2</td>
</tr>
<tr>
<td>ODBC</td>
<td>15</td>
</tr>
<tr>
<td>Offset</td>
<td>105, 108, 128, 136, 141, 181, 182, 184, 234</td>
</tr>
<tr>
<td>Offset 3D Polyline</td>
<td>144, 146</td>
</tr>
<tr>
<td>Offset 3D Polyline By Grade Table</td>
<td>516</td>
</tr>
<tr>
<td>Offset Point Entry</td>
<td>418</td>
</tr>
<tr>
<td>Offset Points By Interval</td>
<td>658</td>
</tr>
<tr>
<td>Offset to Area</td>
<td>106</td>
</tr>
<tr>
<td>Offset To Layer</td>
<td>105, 106</td>
</tr>
<tr>
<td>On-Line Help</td>
<td>827</td>
</tr>
<tr>
<td>Open</td>
<td>32, 40, 52, 68, 112, 135, 238, 427, 441, 442</td>
</tr>
<tr>
<td>Open Polyline</td>
<td>135</td>
</tr>
<tr>
<td>Other Drawing</td>
<td>818, 820, 832, 835, 837, 840, 853</td>
</tr>
<tr>
<td>Pad Polyline By Interior Text</td>
<td>268</td>
</tr>
<tr>
<td>Pan</td>
<td>152, 162, 163, 181, 186, 193, 423, 427, 513, 567</td>
</tr>
<tr>
<td>Pad Polyline By Interior Text</td>
<td>268</td>
</tr>
<tr>
<td>Pan</td>
<td>152, 162, 163, 181, 186, 193, 423, 427, 513, 567</td>
</tr>
<tr>
<td>Pad Polyline By Interior Text</td>
<td>268</td>
</tr>
<tr>
<td>Pan</td>
<td>152, 162, 163, 181, 186, 193, 423, 427, 513, 567</td>
</tr>
<tr>
<td>Pad Polyline By Interior Text</td>
<td>268</td>
</tr>
<tr>
<td>Pan</td>
<td>152, 162, 163, 181, 186, 193, 423, 427, 513, 567</td>
</tr>
<tr>
<td>Pad Polyline By Interior Text</td>
<td>268</td>
</tr>
<tr>
<td>Pan</td>
<td>152, 162, 163, 181, 186, 193, 423, 427, 513, 567</td>
</tr>
</tbody>
</table>
Index
Resize Point Attributes, 647
Restore Due North, 154
Restore Layer, 177, 178
Restore Layout Layers, 39, 351
Restore World View, 155
Retaining Wall, 513
Reverse Polyline, 127, 402, 561
Right of Way, 393, 396, 484, 512
Road Design, 9, 10, 478, 500, 502, 503, 510, 512, 520, 528–530, 534, 541, 542
Roadside Ditch, 9
Roads Menu, 392, 411
Rock Surface, 571
Rotate, 115, 162, 394, 634, 651, 652, 670, 802
Rotate Points, 651, 662, 665, 668
Runoff, 9, 725, 728, 729, 732
Run Off Tracking, 732
Save/Restore Layer State, 177
Save As, 32, 86, 255, 514, 798
Save Layout Layers, 39, 350, 351
Save Tablet Calibration, 222
SB-Slope, 10
Scale Point Attributes, 647
Scale Points, 652, 662, 665, 789
Screen Pick Point, 662, 665
SCT File, 464
Section File, 235, 447, 449, 450, 455, 457, 458, 462, 467, 478, 480, 510, 538, 542, 548, 592, 603, 608, 688
Section Report, 456, 458, 549
Sections From Design Surface, 448
Sections From Existing Surface, 447
Sections from Grid or FLT File, 450
Sections from Points, 452, 539
Sections from Polylines, 450
Sections From Polylines On Section Grids - By Layer, 451
Sections from Screen Entities, 448
Sections to 3D Polylines, 454, 455
Sections to Points, 455
Section Utilities, 454, 456
SEDCAD, 8
Select by Area, 124
Select by Block, 123
Select by Elevation, 122
Select by Filter, 122
Select by Length, 123
Selection Sets, 122, 124
Select Object, 122
Select Object, Two Points, 115
Select Similar, 122
Sequential Numbers, 208
Set/Reset X-Hairs, 809
Set Active Surfaces, 317
Set Background Color, 259
Set Coordinate File, 633, 663
Set Data Directory, 5
Set Environment Variables, 809
Set Layer, 41, 175, 573, 574, 579, 745
Set Layer For Design, 292
Set Layer For Existing, 292, 833, 844
Set Layer For Other, 292
Set Point Elevations by 3D Polylines, 275
Set Point Elevations by Surface Model, 275
Set Polyline Origin, 135
Set Polyline to Elevation, 261
Set Raster Image, 222, 244, 247, 252, 255
Set Removal Boundary, 513
Set Text Color, 258
Settings Menu, 786
Setting Up a Project, 3
Set UCS to World, 809
Sewer, 10, 169, 371, 380, 440, 442, 497
Sewer Network, 375, 379
Sewer Structure, 10, 372, 375, 383, 865
Shade, 167, 305
Shrink-Wrap Entities, 206
Shrink Resolution, 253
Sight Distance, 426, 442, 594, 597, 846
Sketch, 85, 231, 232, 323, 801, 874
Slope At Point, 746
Slope At Points, 744, 746
Slope Distance, 73, 435
Slope Ratio, 289, 435, 541
Slope Report, 435, 742, 747
Slope Zone Analysis, 462, 747
Slope Zone Section Analysis, 462
SMI, 8, 54, 66, 67, 545
SMI Chain File, 545
Smooth Contours, 748
Smoothing, 128, 323, 822
Smooth Polyline, 128, 182, 186, 246
Snap Contours to 3D Polylines, 285
Index 895
Index

Trace Rectangle, 247
Training Movies, 827
Transit, 144, 285, 494, 508, 509, 512, 518, 520, 522, 523, 552, 553, 564, 570, 582, 589, 598, 600, 602, 603, 606, 609, 610, 631, 733
Translate Layers, 40
Translate Points, 649, 655, 662, 665
Trench Menu, 370
Trench Network File Backup, 377
Trench Network Quantities, 387, 858, 865
Trench Subgrade Areas, 386
Triangular Mesh, 740, 747
Triangulate and Contour, 318, 571, 573, 609, 622, 627, 643, 712, 713
Triangulation, 8, 10, 110, 268, 450, 572, 573, 609, 621, 623, 627, 688, 862
Triangulation File Utilities, 328
Trim, 110, 268, 548, 703, 712, 714, 852
Trimble, 53, 54, 63, 83, 93
Tutorials Menu, 828
Twist, 154, 417, 648, 774, 792
Twist Point Attributes, 648
Twist screen, 153, 648
Twist To 3D View, 154, 155
Typical Template, 500, 503, 507, 514, 516
Underground Timing, 16
Undo Raster Edit, 255
Units Control, 804
Universal Transverse Mercator, 666
Untag Area Descriptions, 785
Untag Hard Breakline Polylines, 148
Untag Strata Polylines, 363
Update Colors For Set Elevations, 155, 794
Update Drawing from CRD File, 662, 669
Variable Offset, 108
Vector To Text, 257
Ventilation, 9
Vertical Angle, 73, 796
Vertical Angle Mode, 636, 796
Vertical Curve, 233, 426, 594, 596, 597, 607, 845
View Menu, 149
View Overexcavate Surface, 305
Viewpoint 3D, 152, 154, 171, 320, 550, 717
View Top Surface, 307
Volumes By Triangulation, 331
Watershed Analysis, 724, 726, 728, 730, 732
Web Site, 3
Wild, 71, 311, 639, 692, 702, 705
Wildsoft, 69, 71, 670
Write Block, 193
Write Polyline File, 119
Xref Manager, 45, 47
Zeiss, 704
Zone Polylines, 96
Zoom, 150, 151, 162, 181, 186, 227, 229, 246, 250, 303, 312, 393, 446, 473, 513, 593, 594, 596, 691, 763, 791, 861
Zoom In, 151, 303, 358, 359, 442, 596
Zoom Most, 151
Zoom Out, 151, 303, 358, 359
Zoom Points, 151